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• Documentation and Release Notes on page xxi

• Supported Platforms on page xxi

• Documentation Conventions on page xxii

• Documentation Feedback on page xxiv

• Requesting Technical Support on page xxiv

Documentation and Release Notes

To obtain the most current version of all Juniper Networks
®
technical documentation,

see the product documentation page on the Juniper Networks website at

http://www.juniper.net/techpubs/.

If the information in the latest release notes differs from the information in the

documentation, follow the product Release Notes.

Juniper Networks Books publishes books by Juniper Networks engineers and subject

matter experts. These books go beyond the technical documentation to explore the

nuances of network architecture, deployment, and administration. The current list can

be viewed at http://www.juniper.net/books.

Supported Platforms

For the features described in this document, the following platforms are supported:

• JA1500

• ACX1000 and ACX1100

• ACX2000 and ACX2100

• ACX4000

• M7i

• M10i

• M320

• MX80

• MX104

• MX240
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• MX480

• PTX5000

• PTX3000

• SRX100

• SRX240

• SRX220

• SRX210

• SRX110

Documentation Conventions

Table 1 on page xxii defines notice icons used in this guide.

Table 1: Notice Icons

DescriptionMeaningIcon

Indicates important features or instructions.Informational note

Indicates a situation that might result in loss of data or hardware damage.Caution

Alerts you to the risk of personal injury or death.Warning

Alerts you to the risk of personal injury from a laser.Laser warning

Indicates helpful information.Tip

Alerts you to a recommended use or implementation.Best practice

Table 2 on page xxii defines the text and syntax conventions used in this guide.

Table 2: Text and Syntax Conventions

ExamplesDescriptionConvention

To enter configuration mode, type the
configure command:

user@host> configure

Represents text that you type.Bold text like this
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Table 2: Text and Syntax Conventions (continued)

ExamplesDescriptionConvention

user@host> show chassis alarms

No alarms currently active

Represents output that appears on the
terminal screen.

Fixed-width text like this

• A policy term is a named structure
that defines match conditions and
actions.

• Junos OS CLI User Guide

• RFC 1997,BGPCommunities Attribute

• Introduces or emphasizes important
new terms.

• Identifies guide names.

• Identifies RFC and Internet draft titles.

Italic text like this

Configure themachine’s domain name:

[edit]
root@# set system domain-name
domain-name

Represents variables (options for which
you substitute a value) in commands or
configuration statements.

Italic text like this

• To configure a stub area, include the
stub statement at the [edit protocols
ospf area area-id] hierarchy level.

• Theconsoleport is labeledCONSOLE.

Represents names of configuration
statements, commands, files, and
directories; configurationhierarchy levels;
or labels on routing platform
components.

Text like this

stub <default-metricmetric>;Encloses optional keywords or variables.< > (angle brackets)

broadcast | multicast

(string1 | string2 | string3)

Indicates a choice between themutually
exclusive keywords or variables on either
side of the symbol. The set of choices is
often enclosed in parentheses for clarity.

| (pipe symbol)

rsvp { # Required for dynamicMPLS onlyIndicates a comment specified on the
same lineas theconfiguration statement
to which it applies.

# (pound sign)

community namemembers [
community-ids ]

Encloses a variable for which you can
substitute one or more values.

[ ] (square brackets)

[edit]
routing-options {
static {
route default {
nexthop address;
retain;

}
}

}

Identifies a level in the configuration
hierarchy.

Indention and braces ( { } )

Identifies a leaf statement at a
configuration hierarchy level.

; (semicolon)

GUI Conventions

• In the Logical Interfaces box, select
All Interfaces.

• To cancel the configuration, click
Cancel.

Representsgraphicaluser interface(GUI)
items you click or select.

Bold text like this
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Table 2: Text and Syntax Conventions (continued)

ExamplesDescriptionConvention

In the configuration editor hierarchy,
select Protocols>Ospf.

Separates levels in a hierarchy of menu
selections.

> (bold right angle bracket)

Documentation Feedback

We encourage you to provide feedback, comments, and suggestions so that we can

improve the documentation. You can provide feedback by using either of the following

methods:

• Online feedback rating system—On any page at the Juniper Networks Technical

Documentation site at http://www.juniper.net/techpubs/index.html, simply click the

stars to rate the content, anduse thepop-up form toprovideuswith informationabout

your experience. Alternately, you can use the online feedback form at

https://www.juniper.net/cgi-bin/docbugreport/.

• E-mail—Sendyourcommentsto techpubs-comments@juniper.net. Includethedocument

or topic name, URL or page number, and software version (if applicable).

Requesting Technical Support

Technical product support is available through the JuniperNetworksTechnicalAssistance

Center (JTAC). If you are a customer with an active J-Care or Partner Support Service

support contract, or are covered under warranty, and need post-sales technical support,

you can access our tools and resources online or open a case with JTAC.

• JTAC policies—For a complete understanding of our JTAC procedures and policies,

review the JTAC User Guide located at

http://www.juniper.net/us/en/local/pdf/resource-guides/7100059-en.pdf.

• Product warranties—For product warranty information, visit

http://www.juniper.net/support/warranty/.

• JTAC hours of operation—The JTAC centers have resources available 24 hours a day,

7 days a week, 365 days a year.

Self-Help Online Tools and Resources

For quick and easy problem resolution, Juniper Networks has designed an online

self-service portal called the Customer Support Center (CSC) that provides youwith the

following features:

• Find CSC offerings: http://www.juniper.net/customers/support/

• Search for known bugs: http://www2.juniper.net/kb/

• Find product documentation: http://www.juniper.net/techpubs/

• Find solutions and answer questions using our Knowledge Base: http://kb.juniper.net/
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• Download the latest versions of software and review release notes:

http://www.juniper.net/customers/csc/software/

• Search technical bulletins for relevant hardware and software notifications:

http://kb.juniper.net/InfoCenter/

• Join and participate in the Juniper Networks Community Forum:

http://www.juniper.net/company/communities/

• Open a case online in the CSC Case Management tool: http://www.juniper.net/cm/

Toverify serviceentitlementbyproduct serial number, useourSerialNumberEntitlement

(SNE) Tool: https://tools.juniper.net/SerialNumberEntitlementSearch/

Opening a Casewith JTAC

You can open a case with JTAC on theWeb or by telephone.

• Use the Case Management tool in the CSC at http://www.juniper.net/cm/.

• Call 1-888-314-JTAC (1-888-314-5822 toll-free in the USA, Canada, and Mexico).

For international or direct-dial options in countries without toll-free numbers, see

http://www.juniper.net/support/requesting-support.html.
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PART 1

Overview

• Overview on page 3
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Overview

• Pre-Staging Devices Overview on page 3

• Junos Space Layer 2 Services Overview on page 4

• Junos Space Layer 3 Services Overview on page 13

• Provisioning Process Overview on page 15

• Seamless MPLS Support in Junos Space Overview on page 18

• Service Attributes Overview on page 20

• Service Order States and Service States Overview on page 31

• Understanding VLANManipulation (Normalization and VLANMapping) on Ethernet

Services on page 32

• VLAN Pool Profiles Overview on page 37

• Redundant Pseudowires for Layer 2 Circuits and VPLS on page 38

• VPLS over GRE Overview on page 39

• Junos Space Network Topology Overview on page 40
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• Multicast L3VPN Overview on page 42

• Multichassis Link Aggregation Group Overview on page 43

• Multi-Chassis Automatic Protection Switching Overview on page 44

• Inverse Multiplexing for ATMOverview on page 44

• Cross Provisioning Platform Overview on page 45

Pre-Staging Devices Overview

In the Junos Space product, pre-staging takes the devices already under Junos Space

managementandprepares themfor serviceactivation. Thepre-stagingprocessdiscovers

network provider edge (N-PE) devices in the Junos Space database and assigns roles to

those devices and their interfaces. N-PE routers and user-to-network interfaces (UNIs)

are basic building blocks required for Layer 2 and Layer 3 provisioning.

NOTE: The Network Activate application does not support provisioning for
J Series devices.
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The Junos Space software makes it easy to complete all the pre-staging activities you

need for up to several hundred devices.

Pre-staging uses the Network Activate software to automatically determine the role of

a router based on rules that exist in the system. If a router is an N-PE router, the Junos

Spacesoftwareassigns it theN-PE role.The JunosSpacesoftwarequalifieseach interface

on the N-PE router to be a serviceable UNI.

N-PE and UNI recommendationsmade automatically by the Network Activate software

are appropriate formost situations. In some networks, however, youmight need tomake

some exceptions. Youmight have recommended N-PE devices that you don’t want to

assign the N-PE role for provisioning. In addition, youmight want to exclude some

interfaces from qualification as UNIs.

Topre-stagedeviceswhileacceptingall recommendationsmadeby theNetworkActivate

software, see “Discovering and Assigning All N-PE Devices” on page 54. Tomake

exceptions to the Network Activate recommendations, see “Discovering and Assigning

N-PE Devices with Exceptions” on page 56.

Related
Documentation

Discovering and Assigning All N-PE Devices on page 54•

• Discovering and Assigning N-PE Devices with Exceptions on page 56

• Prerequisites for Prestaging Devices in Network Activate on page 52

• Prestaging Devices Process Overview on page 50

• Prestaging Rules on page 67

• Viewing Pre-Staging Rules on page 662

• VLAN Pool Profiles Overview on page 37

Junos Space Layer 2 Services Overview

Junos Space Network Activate software enables you to provision the following types of

services:

• Point-to-point servicesacrossnetworks thatuseLDPorBGPfor signaling in thenetwork

core. These services use directed pseudowire virtual circuits across the network to

establish point-to-point virtual private networks (VPNs). The provisionermust specify

the addresses of the ingress and egress routers of the virtual circuits.

• Multipoint services across networks that use LDP or BGP signaling in the network core.

TheNetworkActivate software supportsmultipoint-to-multipoint (fullmesh) services

and point-to-multipoint (hub and spoke) services.

For details about Juniper Networks Layer 2 technologies, see the Junos OS VPNs

Configuration Guide.

Point-to-point services andmultipoint services support the following interface types:
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• Port-to-port—All traffic is transported across the network.

• 802.1Q (dot1.q)—Supports 802.1Q VLAN-tagged network traffic in a point-to-point or

multipoint Ethernet service. Network traffic is constrained using VLAN IDs.

• Q-in-Q—Supports double-tagged traffic in a point-to-point or multipoint Ethernet

service.

• Asymmetric tag depth—Allows port-based, 802.1Q and Q-in-Q interfaces for UNIs to

coexist in a service.

• ATM—Supports the transmission of ATM cells through point-to-point connections in

an ATM network.

• TDM—Supports configuring SAToP or CESoPSN physical encapsulation of packets

for transmission over the TDM interface.

Table 3 on page 5 provides a guide to selecting the appropriate type of Layer 2 service

for a specific customer need.

Table 3: Selecting a Layer 2 Service

Provision This ServiceCustomer Requirement

Layer 2 VPN port-to-port service

OR

Layer 2 VPNQ-in-Q to Q-in-Q service for all
traffic

Send all VLAN traffic from one site to other sites
in the service.

Layer 2 VPN 802.1Q-to-802.1Q serviceSend traffic associated with one specific VLAN
from one site to other sites in the service.

Layer 2 VPN Q-in-Q to Q-in-Q service for a
range of VLANs

Send traffic associatedwitha rangeofVLANs from
one site to other sites in the service.

Juniper Networks refers to this kind of connection as a Layer 2 circuit. For details about

Layer 2 circuits, see the Junos OS VPNs Configuration Guide.

The Network Activate software enables you to provision a range of services from the

following service families for your enterprise customers:

• Point-to-Point Services on page 5

• VPLS Services on page 9

Point-to-Point Services

Point-to-point services provide transport and encapsulation of Layer 2 Ethernet circuits

between twoendpoints. Toprovisionapoint-to-point service, theprovisionermust select

thenetworkprovider-edge (N-PE) routers thatwill be the serviceendpointsandconfigure

the user-network interfaces (UNIs) at those endpoints. The Junos Space software

automates theend-to-endprovisioningof thepseudowire by establishinga virtual circuit

between the N-PE routers using a unique virtual circuit ID (VC ID).
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The IETF refers to these connections in RFC 4905, Encapsulation Methods for Transport

of Layer 2 Frames over MPLS Networks as emulated virtual circuits, and in RFC 4447,

Pseudowire Setup and Maintenance Using the Label Distribution Protocol (LDP) as

pseudowire emulation (see IETF RFC 4447).

The Metro Ethernet Forum (MEF) refers to these connections as E-Line services. See

Metro Ethernet Services – A Technical Overview by Ralph Santitoro.

The Junos Space software enables you to provision the following point-to-point service

options for your enterprise customers:

• Port-to-Port Service on page 6

• Single VLAN Service Using 802.1Q Interfaces on page 6

• All Traffic Service Using Q-in-Q Interface on page 7

• Range of VLANs Service with Q-in-Q Interfaces on page 7

Port-to-Port Service

A port-to-port service transports all traffic on a port on a provider edge (N-PE) router

across the network to a port of another N-PE router. enterprise customers needs to

purchase only a single physical port for all their traffic. However, a single port might cost

more than the bandwidth for a single VLAN or selected range of VLANs.

The service provider needs no knowledge of the enterprise customer’s VLAN structure,

because all the customer’s traffic is transported.

Figure 1 on page 6 shows an example in which a port-to-port connection transports all

VLAN traffic for an enterprise customer from customer site A to customer site B across

the network.

Figure 1: Point-to-Point LDP Connection Transports Traffic

Single VLAN Service Using 802.1Q Interfaces

802.1Q services transport VLAN traffic from one site to another across the network. The

selected payload is a single VLAN, so the enterprise customer needs to purchase only

the bandwidth necessary to transport that VLAN. To implement this type of service, the

service provider must exchange VLAN information with the enterprise customer.

Consider the example shown in Figure 2 on page 7. VLAN 100might be used for payroll

andspanssitesAandB.VLAN200 isusedbyengineeringandspanssitesAandC.Payroll
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and engineering are securely separated by provisioining separate point-to-point

connections for each VLAN, each on a separate VCID. Service multiplexing at customer

site A allowsmultiple virtual circuits to share the same port, yet provide secure

connections to separate sites.

Figure 2: Point-to-Point Ethernet Services with 802.1Q Interfaces

All Traffic Service Using Q-in-Q Interface

This type of point-to-point Ethernet (LDP) service usesQ-in-Q interfaces and transports

all customer traffic from one site to another across the network. The Q-in-Q interface

adds a service provider tag to the frame, which isolates the enterprise customer’s VLAN

tags. The service provider does not need knowledge of the customer’s VLAN structure

because all traffic is transported to the destination site.

Range of VLANs Service with Q-in-Q Interfaces

This type of point-to-point Ethernet (LDP) service uses Q-in-Q interfaces and carries a

rangeofVLANsacross thenetwork.Theserviceprovidermustestablishwith theenterprise

customer which VLANs are to be transported. The service provider allocates a service

provider VLAN IDas a second tag to the selectedVLAN ID range,which isolates the traffic

on selected VLANs from other traffic.

Figure 3 on page 8 shows an example in which an enterprise customer has six VLANs

with VLAN IDs 100, 200, 300, 400, 500, and 600. The service is provisioned to carry only

VLANs 100, 200, and 300 by tagging themwith the service provider VLAN ID of 2000.

VLANs 400, 500, and 600 do not cross the network.
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Figure3:Point-to-PointEthernetServicewithQ-in-Q Interfaces forRange
of VLANs.

You can use separate service VLAN IDs to segregate traffic into secure groups of VLAN

IDs. For example,VLANs 100, 200, and300mightall bepart of anenterprise’s engineering

organization,whileVLANs400,500, and600mightexchange informationwith suppliers.

In this example, VLANs 100, 200, and 300 can be double-tagged with service VLAN ID

2000 and get transported only to the remote engineering site, while VLANs 400, 500,

and 600might be tagged with the service VLAN ID of 2001 and get transported only to

the supplier’s site along a separate pseudowire, as shown in Figure 4 on page 8.

Figure4:Point-to-PointEthernetServicewithQ-in-Q Interfaces forRange
of VLANs on Separate Service Provider VLANs
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VPLS Services

The Network Activate software supports virtual private LAN service (VPLS), which in

turn provides multipoint-to-multipoint services and point-to-multipoint services.

The Metro Ethernet Forum (MEF) refers to these connections as E-LAN services. See

Metro Ethernet Services – A Technical Overview by Ralph Santitoro.

Figure 5 on page 9 shows an example of a multipoint service connecting four customer

sites.

Figure 5: Multipoint-to-Multipoint VPLS Service—Full Mesh

This full mesh design enables direct communication among all PE routers in the service.

This topology is efficient for services inwhichall sites need to communicatewith all other

sites.

Figure 6 on page 10 shows a point-to-multipoint service with a single hub. The service

provides connectivity between the hub router (PE1) and each of the spokes (PE2, PE3,

and PE4), but no connectivity exists among the spokes.
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Figure 6: Point-to-Multipoint VPLS Service with Single Hub

This kind of topology is effective for services in which one site needs to communicate

with all other sites, but communication among spokes is not required. For example, the

hub site might house corporate headquarters, while each of the spoke sites is a region.

Figure 7 on page 10 shows a point-to-multipoint service with two hubs. In this case, all

spokes connect to both hubs.

Figure 7: Point-to-Multipoint VPLS Service with Multiple Hubs
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Typical use for dual hub routers is to provide redundancy in case of failure. For example,

a data center might be duplicated at customer sites A and B, requiring access to both

sites from each spoke for effective redundancy.

For all VPLS topologies, route targets and route distinguishers designate the multipoint

connectivity among the participating endpoints.

Service Autodiscovery

BGP uses autodiscovery to establish connectivity among the N-PE routers quickly and

efficiently. Figure 8 on page 11 shows an example.

Figure 8: Autodiscovery of Service Connectivity

In this example, deviceN-PE-1 is the first tobeadded to the service. It exports route target

100 and imports route target 100. When N-PE-2 is added to the service, it also exports

and imports route target 100. The Junos OS on the device automatically makes the

association and creates the connectivity path between the two devices. Similarly, when

you add a third device to the service, so long as it exports/imports the same route targets

as the N-PE devices in the existing service, the new device is added to the service and

connectivity with both existing N-PE devices is established automatically.

For a point-to-multipoint service, route target/route distinguisher pairs have different

values for import and export. These values for import and export are the same for all

spokes, but reversed for the hub, thereby enabling communication between each spoke

and the hub, but not among spokes. Figure 9 on page 12 shows an example. In this case,

device N-PE-1 (the hub router) exports route target:route distinguisher pair 100:6 and

imports 100:5. Each spoke imports 100:6 and exports 100:5 enabling communication

with the hub, but not with each other.
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Figure 9: Autodiscovery in a Point-to-Multipoint Service

VPLS and Normalization

Similar topoint-to-point Ethernet services, theUNIsofVPLSservices canbeport-to-port,

802.1Q, or Q-in-Q. The type of VLANmapping—or normalization—is specified in the

service definition. VLAN normalization applies only to MX Series devices.

NormalizationsupportsautomaticmappingofVLANs.Normalizationperformsoperations

onVLAN tags toachieve thedesired translation. TheNetworkActivate software supports

the following forms of VLAN normalization:

• Normalize to VLAN all—The customer VLAN ID is preserved across the network. That

is, the broadcast domain includes the interfaces that have the same VLAN ID across

the VPLS service. For double-tagged packets (Q-in-Q interfaces), a pop operation at

ingress strips the service VLAN ID from the packet. A corresponding push operation at

egress inserts the service VLAN ID known at the local site. Hence, the service VLAN ID

at egress does not have to match the service VLAN ID at ingress.

For single-tagged packets (802.1Q interfaces), “Normalize to VLAN all” has no effect,

because the packet has no service VLAN ID to pop or push.

• Normalize to VLAN none—The customer VLAN ID is not preserved across the network.

The broadcast domain includes all VLANs at any site provisioned in the service. For

single-tagged packets (802.1Q interfaces), a pop operation at ingress removes the

customer VLAN ID from the packet. A corresponding push operation at egress adds a

local customer VLAN ID.

For double-tagged packets (Q-in-Q interfaces), both customer VLAN ID and service

VLAN ID are popped from the packet at ingress and pushed at egress.

• Normalize toDot1q tag—TheVLAN tag is preserved across the network. The broadcast

domain includes all VLANs at any site provisioned in the service. For information about

howframesare translated toprovide the requiredVLANtags for interfaceswithdifferent

tagheights, see thesection “VLANMapping forVPLSServices” in “UnderstandingVLAN

Manipulation (Normalization and VLANMapping) on Ethernet Services” on page 32.

• Normalize toQinQ tags—The inner VLAN tag and outer VLAN tag are preserved across

the network. The broadcast domain includes all VLANs at any site provisioned in the
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service. For information about how frames are translated to provide the requiredVLAN

tags for interfaces with different tag heights, see the section “VLANMapping for VPLS

Services” in “Understanding VLANManipulation (Normalization and VLANMapping)

on Ethernet Services” on page 32.

Normalization works well with automatically assigned VLAN IDs, because the service

provider does not need to specify the VLAN IDs that are popped and pushed. Without

normalization, the service providermust specify explicitly the customer VLAN ID and the

service VLAN ID.

• Normalization not required—If normalization is not used, then all customer VLAN IDs

and all service VLAN IDs must match to be part of the same broadcast domain.

NOTE: For information on the VLAN normalization requirements for each
Ethernet interface option, see the table in the topic“Specifying Connectivity
InformationWhen Signaling Is BGP” on page 116

Related
Documentation

Service Attributes Overview on page 20•

• Provisioning Process Overview on page 15

Junos Space Layer 3 Services Overview

To configure Layer 3 virtual private network (VPN) functionality, you must enable VPN

support on theprovider edge (PE) router. Youmustalsoconfigureanyprovider (P) routers

that service the VPN, and youmust configure the customer edge (CE) routers so that

their routes are distributed into the VPN.

This topic covers:

• Overview on page 13

• Layer 3 VPN Platform Support on page 14

• Layer 3 VPN Attributes on page 14

• Device Configuration for a Layer 3 VPN on page 14

Overview

RFC 4364 VPNs are also known as BGP/MPLS VPNs because BGP is used to distribute

VPN routing information across the provider’s backbone, and MPLS is used to forward

VPN traffic across the backbone to remote VPN sites.

Customer networks, because they are private, can use either public addresses or private

addresses, asdefined inRFC 1918,AddressAllocation forPrivate Internets.Whencustomer

networks that use private addresses connect to the public Internet infrastructure, the

private addressesmight overlap with the same private addresses used by other network

users. MPLS/BGP VPNs solve this problem by adding a VPN identifier prefix to each

address fromaparticular VPNsite, thereby creating anaddress that is uniquebothwithin
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the VPN and within the public Internet. In addition, each VPN has its own VPN-specific

routing table that contains the routing information for that VPN only.

For this release, Junos Space Network Activate software enables you to provision Layer

3 VPN full mesh services.

For more information about Layer 3 VPNs, see the Junos Software VPNs Configuration

Guide.

Layer 3 VPN Platform Support

Layer 3VPNsare supportedonmost combinationsof JuniperNetworks routingplatforms

and PICs that are capable of running the Junos Software.

MX Series routers configured in Ethernet services mode can support some of the Junos

OS Layer 3 VPN features. For Layer 3 VPNs, Ethernet servicesmode supports configuring

a loopback interface for a VPN routing and forwarding (VRF) instance. You can configure

up to two VRF instances in Ethernet servicesmode. Each VRF instance can handle up to

10,000 routes, The pingmpls l3vpn operational mode command is also supported.

Layer 3 VPNAttributes

Network Activate software supports the following Layer 3 VPN attributes. For more

information, see the Junos OS VPNs Configuration technical documentation.

• Target VPN—Identifies a set of siteswith aVPN towhich aPE router distributes routes.

This attributes is also called the route target. A PE egress router uses the route target

to determine whether a received route is destined for a VPN that the router services.

• Route distinguisher—a 6-byte number that you can specify using one of the following

formats:

• as-number:number, where as-number is an AS number (a 2-byte value) and number

is any 4-byte value. The AS number can be in the range 1 through 65,535. We

recommend that you use an Internet AssignedNumbers Authority (IANA)-assigned,

nonprivate AS number, preferably the Internet service provider’s (ISP’s) own or the

customer’s own AS number.

• ip-address:number, where ip-address is an IP address (a 4-byte value) and number

is any 2-byte value. The IP address can be any globally unique unicast address. We

recommend that you use the address that you configure in the router-id statement,

which is a nonprivate address in your assigned prefix range.

Device Configuration for a Layer 3 VPN

To implement Layer 3 VPNs in the JUNOS Software, you configure one routing instance

for each VPN. You configure the routing instances on PE routers only. Each VPN routing

instance consists of the following components:

• VRF table—On each PE router, you configure one VRF table for each VPN.

• Set of interfaces that use the VRF table—The logical interface to each directly

connected CE router must be associated with a VRF table. You can associate more
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than one interface with the same VRF table if more than one CE router in a VPN is

directly connected to the PE router.

• Policy rules—These control the import of routes into and the export of routes from the

VRF table.

• One or more routing protocols that install routes from CE routers into the VRF

table—You can use the BGP and OSPF routing protocols and static routes.

Related
Documentation

Creating a Full Mesh Layer 3 VPN Service Definition on page 257•

• Creating a Full Mesh Layer 3 VPN Ethernet Service Order on page 536

Provisioning Process Overview

Provisioning is a multistep process that makes services available to customers.

The Getting Started panel in the Junos Space user interface provides the steps involved

in provisioning a service, including not only the provisioning work itself (steps 4 through

9), but also the steps that are necessary before you can begin the provisioning process

(steps 1 through 3). The following example shows the Service Provisioning assistant in

the Getting Started panel:

Steps in the sequence are often performed by users with different levels of privilege. The

JunosSpacesoftwareprovidespredefinedadministrator roles thatprovide thenecessary

privilege for each step in the sequence:
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• The Device Manager role allows an administrator to discover devices (step 1).

• TheServiceManager roleallowsanadministrator toperformdevicepre-stagingactions

including discovering and assigning device roles (steps 2 and 3).

• The Service Designer roles allows an administrator to create and publish a service

definition (step 4).

• The Service Activator (less privileged) role allows an administrator to perform

provisioning tasks including creating andmanaging customers, service orders, and

services (steps 5 through 9).

For details about predefined administrator roles, see Predefined Roles Overview in the

Junos Space Network Application Platform User Guide.

Network Operator Tasks—Provisioning Prerequisites

Network operators are usually responsible for performing the prerequisite tasks before

the following service designer or service provisioner can perform their tasks:

• Discovering devices

• Launching role discovery

• Assigning N-PE roles

Discovering devices is the process for bringing your network devices under Junos Space

management. Network operatorswhoare assigned theDeviceManager role canperform

this task. SeeDevice Discovery Overview in the Junos Space Network Application Platform

User Guide for more information about discovering devices.

Launching role discovery and assigning N-PE roles are collectively known as pre-staging

tasks. Pre-staging finds the N-PE devices among those already under Junos Space

management and assigns appropriate MPLS N-PE roles to these devices and

user-to-network interface (UNI) roles to their interfaces.Once these rolesare established,

the devices are ready for provisioning. Users who are assigned the Service Manager role

can perform device role discovery and role assignment. See “Pre-Staging Devices

Overview” on page 3 for more information about pre-staging devices.

Service Designer Tasks

The service designer is responsible for the service definitions that the service provisioner

will use as the basis for creating a service order.

A service definition specifies the attributes that are common among a group of service

orders that have similar service requirements. For example, a service definition might

specify a port-to-port service, whether the associated VCID should be assigned

automatically from a predefined pool or specified by the user, and what range of

bandwidthscanbeassigned in theserviceorder. Theservicedefinitionalsodefineswhich

attributes of the service can be edited in the service order.

The Junos Space product provides several standard service definitions which support

mostneeds. If the standard servicedefinitionsdonot support your needs, then the service

designer needs to create new, customized service definitions.
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Users who are assigned the Service Designer role can create andmanage service

definitions.

Service Provisioner Tasks

Service provisioner tasks include the following:

• Creating the customer.

• Creating the service order.

• Deploying the service.

• Performing a configuration audit.

• Performing a functional audit.

A service order is an instance of the service definition that completes the definition for a

specific customer’suse.Theserviceorderalwaysspecifies thecustomerandtheendpoints

that link the customer sites through the MPLS network. For each endpoint, the service

provisioner specifies the N-PE device and the UNI on that device that connects the

customer site to the N-PE device. The service order can also specify any additional

attributes that are configured in the service definition as editable in the service order.

These attributesmight include theVCID,MTU for theUNI,MTU for the connection across

the network, VLAN-ID, and bandwidth.

Deploymentofaserviceorderpushesaservice to thenetworkdevices.Beforedeployment

completes, a series of pre-validation checks takes place. If the pre-validation checks

indicate that the service is valid, the deployment proceeds. If the pre-validation checks

indicatean invalid service, the serviceprovisionermust re-create theserviceorder correctly

before trying again to deploy it.

After the service is deployed, a functional audit establishes whether the service is up or

down. If the functional audit reports that the service is up, the customer can begin using

the service.

Once the service is active, the service provisioner canmonitor the health of the service

by running a functional audit or a configuration audit.

Users assigned the Service Activator role can perform these service provisioning tasks.

Related
Documentation

Discovering Devices in the Junos Space Network Application Platform User Guide•

• Discovering and Assigning All N-PE Devices on page 54

• Discovering and Assigning N-PE Devices with Exceptions on page 56

• Predefined Point-to-Point Service Definitions on page 333

• Predefined Multipoint-to-Multipoint Ethernet Service Definitions on page 365

• Predefined Point-to-Multipoint Ethernet Service Definitions on page 390

• Creating a Point-to-Point Ethernet Service Definition on page 97

• Creating a Multipoint-to-Multipoint VPLS Service Definition on page 117

• Creating a Point-to-Multipoint VPLS Service Definition on page 138
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• Unpublishing a Custom Service Definition on page 199

• Adding a New Customer on page 709

• Creating a Point-to-Point Service Order on page 438

• Creating a Multipoint-to-Multipoint VPLS Service Order on page 491

• Creating a Point-to-Multipoint VPLS Service Order on page 507

• Deploying a Service on page 467

• Understanding Service Validation on page 753

• Predefined Roles Overview in the Junos Space Network Application PlatformUser Guide

SeamlessMPLS Support in Junos Space Overview

MPLS-based Layer 2 services are growing in demand among enterprise and service

providers, creating new challenges related to interoperability between Layer 2 and Layer

3 services for service providers who want to provide end-to-end value-added services.

Service providers are able to expand service offerings, support multiple Layer 2 services

andprotocols at the same time, and toexpandgeographically by stitchingdifferent Layer

2 services to one another and to Layer 3 services, moving toward a seamless MPLS

environment..

Interconnecting a Layer 2 VPLS network with a Layer 3 network enables the sharing of

a service provider's core network infrastructure between IP andLayer 2 services, reducing

the cost of providing those services. A Layer 2 MPLS circuit allows service providers to

create a Layer 2 circuit service over an existing IP and MPLS backbone.

Service providers do not have to invest in separate Layer 2 equipment to provide Layer

2 services. A service provider can configure a provider edge router to run any Layer 3

protocol in addition to the Layer 2 protocols. Customers who prefer to maintain control

over most of the administration of their own networks want Layer 2 circuit connections

with their service provider instead of a Layer 3 VPN connection.

Using MPLS pseudowires makes it possible to encapsulate Layer 2 packets and extend

Layer 2 services into Layer 3 networks. Junos Space supports the trend toward

accomplishing Seamless MPLS with these two features:

• VPLS Access Into Layer 3 Networks

• Pseudowire Access Into a Layer 3 VPN

VPLS Access Into Layer 3 Networks

IntegratedRouting andBridging (IRB)provides simultaneous support for Layer 2bridging

and Layer 3 routing within the same bridge domain, and as well as in the same routing

instance. If the IRB interface configured as a Layer 3 interface is being used in a routing

instance, that routing instance will specifically declare it as routing-interface rather than

regular VPLS interface (whichacts like the interfaceona specific VPLSSite). This feature

requires a normalized VLAN (vlan-id=xxx which is the same as the unit name on which

the inet4 address is specified)
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L3 Network

PE-2
Site C

PE-0
Site A

PE-3
Site D

PE-1
Site B

IRB

VPLS Network

UNI

UNI

UNI

g0
17

79
5

Junos Space uses the two peer subinterfaces of the IRB to create the link between an

existing VLAN and the Layer 3 network. An extra VPLS node is required to support the

IRB interface which allows the rest of the VPLS nodes to be able to access all Layer 3

networks reachable through that interface. Providing the VPLS access into Layer 3

networks enhances basic VPLS services. Because this feature requires a normalized

VLAN, it is available only on the Juniper Networks MX 3D Router series.

Pseudowire Access Into Layer 3 VPNs

While technically not a VPLS feature, Junos Space uses pseudowires, also known as

pseudowire stitching, to link Layer 2 services together and toLayer 3 services. Pseudowire

access into the L3 VPN enhances the standard Eline LDP and point-to-point services.

The link into the L3VPN network can be port-based or VLAN-based. At least one node

in the peer must be a logical tunnel (LT) interface. The peer must appear in the L3VPN

configuration.

PE-2
BGP group

PE-0
BGP group

PE-1
BGP group L3VPN Network

UNI

UNI

UNI

g0
17

79
4

ge-1/1/1

lt-1/1/1.0

Interface UNI
Interface lt-1/1/1.1

pseudowire

In Junos, this Layer 2 access into Layer 3 VPNs is accomplished by using a tunnel PIC to

create a peer link between pseudowire and a Layer 3 network interface.

Related
Documentation

Creating a Service Definition for VPLS Access into Layer 3 Networks on page 249•
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• Creating a Service Order for VPLS Access into Layer 3 Networks on page 525

• Example: Interconnecting a Layer 2 Circuit with a Layer 3 VPN

Service Attributes Overview

A service is defined by a set of attributes. Some attributes are common to all service

instancescreated fromoneservicedefinition, andare thereforesetduringservicedefinition

time. Other attributes are specific to a service instance andmust be set in the service

order. Some attributes can be set either in the service definition or in the service order; in

such cases it is up to the service designer to determine when the attribute will be set.

The Network Activate user interface groups service attributes as follows:

• General attributes—General informationabout theservice, suchaswhether theservice

is point-to-point, multipoint-to-multipoint (full mesh VPLS), or point-to-multipoint

VPLS,what signalingmechanism isused in thenetworkcore,whetherqualityof service

(QoS) is enabled on the service, and who the enterprise customer is who uses the

service.

• Connectivity settings—Information about connectivity among customer sites through

the network. For point-to-point Ethernet services in a network with LDP switching in

the network core, these settings include the VC ID. For multipoint Ethernet (or VPLS)

services, these settings include the route target and route distinguisher.

• Advanced settings—Information about advanced connectivity among customer sites

through thenetwork. Formultipoint Ethernet (orVPLS) services, these settings include

tunnel services, local switching, fast-reroute-priority, label block size, and connection

type.

• UNI settings—Information about each customer site, including the N-PE device and

interface the site uses to connect to the network, the encapsulation method used

(physical and logical), MTU, customer VLAN ID and range, service VLAN ID, bandwidth

limiting, and so on.

General Attributes

The following general attributes are defined for each service:

• Service Type on page 21

• Signaling on page 21

• Signaling on page 21

• Signaling on page 21

• Signaling on page 21

• Signaling on page 21

• Enabling Additional Features on page 21

• Customer on page 22

• Enable QoS on page 22
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Service Type

TheService typeattribute specifies anetwork topology to include in the servicedefinition.

The service type is the first attribute to be determined during service definition. It can be

one of the following values:

• Point-to-point Ethernet—Virtual circuit between two customer sites in the network

core.

• Multipoint-to-multipoint Ethernet (VPLS)—Virtual private LANservice (VPLS) among

multiple customer sites in the network core to provide full mesh connectivity.

• Point-to-multipoint Ethernet (VPLS) —VPLS amongmultiple customer sites in the

network core to provide connectivity between a hub site andmultiple spoke sites.

Signaling

The Signaling attribute specifies the protocol that controls signaling in the network core.

You can select BGP or LDP.

Signaling

The Comments attribute .

Signaling

The Service Template attribute .

Signaling

The Threshold Alarm Profile attribute.

Signaling

The Interface type attribute . You can specify one of the following:

• Ethernet

• TDM

• ATM

Enabling Additional Features

In addition to the interface type, depending on the Service type topology and Signaling

you specify, you can enable the following features for a service:

• Static pseudowire—For networks that do not support LDP or do not have LDP enabled.

You define pseudowires by configuring static values for the inbound and outbound

labels of the connection.

• Enable PW access to L3 VPN networks

• Enable L3 Access

• Enable PWExtension

21Copyright © 2015, Juniper Networks, Inc.

Chapter 1: Overview



• Enable PWResiliency

• Decouple Service Status fromPort Status—Isolates events related to an interface in

the OpenNMS database. Only traps related to pseudowires are monitored.

Customer

This attribute specifies the enterprise customer who will use the service instance. This

attribute is always specified in the service order.

Enable QoS

Thisattribute specifieswhetherQoS is enabledon theservice todivide traffic intoclasses

and offer various levels of throughput and packet loss when congestion occurs. When

youenableQoS in theservicedefinition, theQoSSettingsboxappearswhenyouconfigure

the service order.

NOTE: When you enable QoS in the service definition, bandwidth settings
are not configurable in the service order.

NOTE: AQoS profile that specifies a level-three scheduler is not supported
on port-to-port services.

UNI Settings

The following attributes are defined for the service endpoints or customer sites that are

connected by the service:

• Ethernet Options on page 23

• Interface on page 23

• MTU on page 23

• Customer Traffic Type on page 23

• Customer VLAN ID on page 24

• Service VLAN ID and VLAN ID Range on page 24

• Physical Encapsulation on page 24

• Logical Encapsulation on page 25

• Rate Limiting and Bandwidth on page 26

• UNI Settings for TDM Interfaces on page 26

• UNI Settings for ATM Interfaces on page 26
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Ethernet Options

This attribute identifies the interface type at the endpoint by defining the level of packet

tagging for the UNI. It can have the following values:

• asymmetric tag depth

Allows port-based, 802.1Q and Q-in-Q interfaces for UNIs to coexist in a service.

• port-port

Transfers all data from the UNI to the other end of the LSP trunk.

• dot1q

An 802.1Q interface that tags each packet with a VLAN ID, thus allowing a specific

VLAN to traverse the network.

• qinq

A Q-in-Q interface that double tags each frame. The inner tag is added by the service

provider. The service provider can use this inner tag to differentiate among services.

For example, you can configure VLANs for a customer’s intranet with a different inner

tag from VLANs used for working with providers or partners.

Interface

Specifies the physical interface on the N-PE device that connects the customer site or

CE device to the N-PE device.

MTU

Themaximum transmission unit (MTU) represents the largest frame size, in bytes, that

passes through the UNI. MTU is configurable.

NOTE: This value is distinct from theMTUassigned to the connectivity in the
network core.

Customer Traffic Type

Thisattributeplaces restrictionson the traffic that canbe transportedacross thenetwork

by the associated service. It can have the following values:

• Transport single VLAN

Restricts the associated service to transporting just one VLANacross the network. You

can use this option with 802.1Q and Q-in-Q interface types.

• Transport VLAN range

Allows the associated service to transport a range of VLANs across the network. You

can use this option with 802.1Q and Q-in-Q interface types.

• Transport all traffic
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Allows the associated service to transport all traffic across the network. You can use

this option with Q-in-Q interface types only.

The traffic typeattribute is not applicable toport-to-port services. Port-to-port services

always transport all traffic.

Customer VLAN ID

Specifies a VLAN ID that is attached to each packet to permit VLANs to be shared across

the network.

This attribute can be used only with 802.1Q and Q-in-Q interface types.

Service VLAN ID and VLAN ID Range

The service VLAN ID (VLAN ID) specifies a second level of tagging to segregate groups

of VLANs.

The VLAN range specifies a range of VLANs to be transported across the network by

associating themwith a service VLAN ID.

These options are configurable only for Q-in-Q interfaces.

Physical Encapsulation

Specifies the physical link-layer encapsulation type.

• flexible-ethernet-services—Offers themost flexibility, dependingon thecharacteristics

of the N-PE device and its line modules.

For Gigabit Ethernet IQ interfaces and Gigabit Ethernet PICs with small form-factor

pluggable transceivers (SFPs) only, use flexible Ethernet services encapsulation when

you want to configure multiple per-unit Ethernet encapsulations. This encapsulation

type allows you to configure any combination of route, TCC, CCC, and VPLS

encapsulations on a single physical port. Aggregated Ethernet bundles cannot use this

encapsulation type. If you configure flexible Ethernet services encapsulation on the

physical interface,VLAN IDs from1 through511 areno longer reserved for normalVLANs.

In the JunosSpaceNetworkActivate product, you can use this encapsulation typewith

802.1Q interfaces and Q-in-Q interfaces in point-to-point Ethernet services and in

multipoint Ethernet services.

• vlan-ccc—You can use Ethernet VLAN encapsulation on CCC interfaces. This option

restricts the range of available VLAN IDs to 512 through 4094. VLAN IDs 1 through 511

are reserved for internal use.

In the JunosSpaceNetworkActivate product, you can use this encapsulation typewith

802.1Q interfaces and Q-in-Q interfaces in point-to-point services.

• extended-vlan-ccc—UseextendedVLANencapsulationonCCC interfaceswithGigabit

Ethernet interfaces that must accept packets carrying 802.1Q values.
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In the JunosSpaceNetworkActivate product, you can use this encapsulation typewith

802.1Q interfaces and Q-in-Q interfaces in point-to-point services.

• ethernet-vpls—Use Ethernet VPLS encapsulation on Ethernet interfaces that have

VPLS enabled and that must accept packets carrying standard TPID values.

In the Junos Space Network Activate product, this encapsulation is used only for

dedicated port interface types in multipoint Ethernet services.

Logical Encapsulation

Specifies the logical link-layer encapsulation type. Logical encapsulation with 802.1Q

interfaces allows you to route multiple services through the same physical interface.

• vlan-ccc—Use Ethernet virtual LAN (VLAN) encapsulation on CCC interfaces. When

you use this encapsulation type, you can configure the family ccc only.

• extended-vlan-ccc—UseextendedVLANencapsulationonCCC interfaceswithGigabit

Ethernet interfaces that must accept packets carrying 802.1Q values.

• vlan-vpls—Use VLAN VPLS encapsulation on Ethernet interfaces with VLAN tagging

and VPLS enabled. Interfaceswith VLANVPLS encapsulation accept packets carrying

standard Tag Protocol (TPID) values only.

Table4onpage25defines the logical encapsulation types thatare valid for eachphysical

encapsulation type in a point-to-point Ethernet service.

Table 4: Physical and Logical Encapsulation Compatibilities in
Point-to-Point Ethernet Services

Valid Interface TypesLogical EncapsulationPhysical Encapsulation

802.1Q and Q-in-Qvlan-cccflexible-ethernet-services

802.1Q and Q-in-Qvlan-cccvlan-ccc

802.1Q and Q-in-Qextended-vlan-cccextended-vlan-ccc

dedicated portnot applicableethernet-ccc

Table5onpage25defines the logical encapsulation types that are valid for eachphysical

encapsulation type in multipoint Ethernet services.

Table5:Physical andLogical EncapsulationCompatibilities inMultipoint
Ethernet (VPLS) Services

Valid Interface TypesLogical EncapsulationPhysical Encapsulation

802.1Q and Q-in-Qvlan-vplsflexible-ethernet-services

dedicated portnot applicableethernet-vpls
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Rate Limiting and Bandwidth

Rate limiting allows you to specify the maximum bandwidth permitted for a service.

The burst rate is automatically calculated as two times the MTU of the UNI.

NOTE: When a service is QoS enabled, you cannot configure rate limiting
and bandwidth in the service.

UNI Settings for TDM Interfaces

The following TDM options are configurable for TDM interfaces:

• Physical IF encapsulation—satop or cesopsn

• Jitter buffer

MSeries: 1 through 340

BX7000 Gateway: 2K through 32K

• Idle pattern—0 through 255

• Excessive packet loss rate—1 through 100%

• Payload size

MSeries: 64 through 1024

BX7000 Gateway: 24 through 1440

UNI Settings for ATM Interfaces

The following ATM options are configurable for ATM interfaces:

• Physical IF encapsulation—The type of encapsulation to apply to the interface. Use

atm-ccc-cell-relay for ATM cell relay encapsulation. Use atm-ccc-cell-mux for ATM

VC for CCC.

• VPI selection—The virtual path identifier

• VCI selection—This integer uniquely identifies the virtual circuit that the service uses.

• Cell bundle size—Cell bundle size can be 1 through 34.

Connectivity Settings

The following attributes are defined for the connectivity among UNI endpoints across

the network:

• Virtual Private LAN Service Identifier (VPLS ID) on page 27

• Auto Discovery on page 27

• Virtual Circuit Identifier (VCID) (Point-to-Point Services Only) on page 27

• Route Targets and Route Distinguishers on page 27
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• Normalized VLAN (Multipoint Services Only) on page 27

• Multihoming on page 28

• MAC Learning on page 28

Virtual Private LAN Service Identifier (VPLS ID)

This VPLS ID is available if the signaling is LDP and the Auto Discovery check box is

disabled. The VPLS ID can be selected automatically ormanually. The VPLS ID identifies

the virtual circuit identifier used for the VPLS routing instance.

Auto Discovery

The Auto Discovery check box is available only if the signaling is LDP. If you enable Auto

Discovery, the attributes Route target, Route distinguisher, and VPN ID appear and are

provisionable.

Virtual Circuit Identifier (VCID) (Point-to-Point Services Only)

This unique identifier can be assigned automatically from a pool of VCIDs or can be

manually specified. It uniquely identifiesapoint-to-point virtual circuit through thenetwork

and is provided for all switched point-to-point services.

Route Targets and Route Distinguishers

Route targets and route distinguishers are applied to point-to-point services in which

BGP controls the connections in the network core.

Route targets and route distinguishers are always automatically generated by the Junos

Space software for multipoint Ethernet (VPLS) services. Route targets and route

distinguishers designate the multipoint connectivity among the participating endpoints

of a multipoint service. They identify the members of the virtual LAN.

Normalized VLAN (Multipoint Services Only)

Similar topoint-to-point Ethernet services, theUNIsofVPLSservices canbeport-to-port,

802.1Q, or Q-in-Q. The type of VLANmapping—or normalization—is specified in the

service definition. VLAN normalization applies only to MX Series devices.

Normalization supports automaticmappingofVLANsandperformsoperationsonVLAN

tags to achieve the desired translation. The Network Activate software supports the

following forms of VLAN normalization:

• Normalize to VLAN all—The customer VLAN ID is preserved across the network. That

is, the broadcast domain includes the interfaces that have the same VLAN ID across

the VPLS service. For double-tagged packets (Q-in-Q interfaces), a pop operation at

ingress strips the service VLAN ID from the packet. A corresponding push operation at

egress inserts the service VLAN ID known at the local site. Hence, the service VLAN ID

at egress does not have to match the service VLAN ID at ingress.

For single-tagged packets (802.1Q interfaces), “Normalize to VLAN All” has no effect,

because the packet has no service VLAN ID to pop or push.

• Normalize to VLAN none—The customer VLAN ID is not preserved across the network.

The broadcast domain includes all VLANs at any site provisioned in the service. For
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single-tagged packets (802.1Q interfaces), a pop operation at ingress removes the

customer VLAN ID from the packet. A corresponding push operation at egress adds a

local customer VLAN ID.

For double-tagged packets (Q-in-Q interfaces), both customer VLAN ID and service

VLAN ID are popped from the packet at ingress and pushed at egress.

• Normalize toDot1q tag—TheVLAN tag is preservedacross thenetwork. Thebroadcast

domain includes all VLANs at any site provisioned in the service. For information about

howframesare translated toprovide the requiredVLANtags for interfaceswithdifferent

tagheights, see thesection “VLANMapping forVPLSServices” in “UnderstandingVLAN

Manipulation (Normalization and VLANMapping) on Ethernet Services” on page 32.

• Normalize toQinQ tags—The inner VLAN tag and outer VLAN tag are preserved across

the network. The broadcast domain includes all VLANs at any site provisioned in the

service. For information about how frames are translated to provide the requiredVLAN

tags for interfaces with different tag heights, see the section “VLANMapping for VPLS

Services” in “Understanding VLANManipulation (Normalization and VLANMapping)

on Ethernet Services” on page 32.

• Normalizationnot required—Forport-to-port servicesonly. Specifies thatnormalization

is not used.

If normalization is not used, then all customer VLAN IDs and all service VLAN IDs must

match to be part of the same broadcast domain. Serviceswith dedicated port interfaces

cannot use normalization.

Normalization works well with automatically assigned VLAN IDs, because the service

provider does not need to specify the VLAN IDs that are popped and pushed. Without

normalization, the service providermust specify explicitly the customer VLAN ID and the

service VLAN ID.

NOTE: For a description of how the Network Activate softwaremanipulates
VLANs, see “Understanding VLANManipulation (Normalization and VLAN
Mapping) on Ethernet Services” on page 32.

Multihoming

Youcanenablemultihoming to connect a customer site tomultiple PEdevices to provide

redundant connectivity while preventing the formation of Layer 2 loops in the service

provider’s network. A VPLS site that is multihomed tomultiple PE devices provides

redundant connectivity in the event of a PE device to CE device link failure or the failure

of a PE device.

MAC Learning

YoucanenableMAC learning for a virtual switch, for abridgedomain, for a specific logical

interface in a bridge domain, or for a set of bridge domains associated with a Layer 2

trunk port. MAC learning is enabled by default.

When MAC learning is enabled, you can configure the following settings:
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Interface MAC Limit

You can specify the maximum number of media access control (MAC) addresses that

can be learned by the VPLS routing instance. You can configure the same limit for all

interfaces configured for a routing instance. You can also configure a limit for a specific

interface. The default is 1024 addresses. The range is 16 through 65,536MAC addresses.

This option is supported for MX-series routers only.

MAC Statistics

You can enable MAC accounting either for a specific bridge domain, or for a set of bridge

domains associated with a Layer 2 trunk port. MAC statistics is disabled by default. This

option is supported for MX-series routers only.

MAC Table Size

You canmodify the size of the MAC address table for the bridge domain, a set of bridge

domains associated with a trunk port, or a virtual switch. The default is 5120 MAC

addresses.

Advanced Settings

The following attributes are defined for advanced connectivity among UNI endpoints

across the network:

• Tunnel Services on page 29

• Local Switching on page 29

• Fast Reroute Priority on page 30

• Label Block Size on page 30

• Connectivity Type on page 30

Tunnel Services

Youcanenable tunnel services tospecify that traffic forparticularVPLS routing instances

be forwarded to specific virtual tunnel (VT) interfaces, allowing you to load-balance

VPLS traffic among all the available VT interfaces on the router.

Tunnel services are disabled by default.

Local Switching

In local switching mode, you can terminate multiple Layer 2 circuit pseudowires at a

single VPLSmesh group.

Local switching is disabled by default.

NOTE: In a point-to-multipoint topology, youmust enable local switching
on the hub router and disable local switching on the spokes.
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Fast Reroute Priority

Specify the fast reroute priority for a VPLS routing instance. You can configure high,

medium, or low fast reroute priority to prioritize specific VPLS routing instances for faster

convergence and traffic restoration. Because the router repairs next hops for high-priority

VPLS routing instances first, the traffic traversing a VPLS routing instance configured

with high fast reroute priority is restored faster than the traffic for VPLS routing instances

configured with medium or low fast reroute priority. The default setting is LOW.

Label Block Size

VPLSMPLS packets have a two-label stack. The outer label is used for normal MPLS

forwarding in the service provider’s network. If BGP is used to establish VPLS, the inner

label is allocated by a PE router as part of a label block. One inner label is needed for

each remote VPLS site. Four sizes are supported. We recommend using the default size

of 8, unless the network design requires a different size for optimal label usage, to allow

the router to support a larger number of VPLS instances.

If youallocatea largenumberof small label blocks to increaseefficiency, youalso increase

the number of routes in the VPLS domain. This has an impact on the control plane

overhead.

Changing the configured label block size causes all existing pseudowires to be deleted.

For example, if you configure the label block size to be 4 and then change the size to 8,

all existing label blocks of size 4 are deleted, which means that all existing pseudowires

aredeleted.Thenew labelblockof size8 is created, andnewpseudowiresareestablished.

Four label block sizes are supported: 2, 4, 8, and 16. Consider the following scenarios:

• 2—Allocate the label blocks in increments of 2. For a VPLS domain that has only two

sites with no future expansion plans.

• 4—Allocate the label blocks in increments of 4.

• 8 (default)—Allocate the label blocks in increments of 8.

• 16—Allocate the label blocks in increments of 16. A label block size of 16 enables you

tominimize thenumberof routes in theVPLSdomain.Use this settingonly if thenumber

of routes is the most important concern.

Connectivity Type

You can configure the VPLS routing instance to take down or maintain its VPLS

connections depending on the status of the interfaces configured for the VPLS routing

instance. By default, the VPLS connection is taken down whenever a customer-facing

interface configured for the VPLS routing instance fails. This behavior is explicitly

configured by specifying the ce option. You can alternatively specify the irb option to

ensure that the VPLS connection remain up so long as an integrated routing and bridging

(IRB) interface is configured for the VPLS routing instance.

Related
Documentation

Junos Space Layer 2 Services Overview on page 4•
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Service Order States and Service States Overview

Service provisioners create service orders which are requests to provision a service,

validate a service, or decommission a service. The service order for provisioning a service

defines all the service attributes.

Service Order States

Before a service order can affect a service, it must transition through several states as

shown in Figure 10 on page 31.

Figure 10: Service Order States and State Transitions

When the service provisioner has created the service order, but has not yet attempted

to deploy it or schedule it for deployment, the service order is in the Requested state.

After the service provisioner has scheduled the service order for deployment, the service

order transitions to the Scheduled state. If the service provisioner schedules the service

order for immediate deployment, then the service order will be in the Scheduled state

only briefly. However, if the service provisioner has scheduled a later deployment, the

service order could be in this state for several hours or days.

When a scheduled service order reaches its time for deployment, it transitions to the

transitory InProgress state. Fromthis state, the JunosSpacesoftwareattempts todeploy

the service. Successful deployment transitions the service order to the Completed state.

If the Junos Space software cannot deploy the service because of invalid information in

the service order itself, the service order enters the Invalid state. The service provisioner

must resolve the issues that cause the failure before re-creating the service order and

rescheduling it for deployment.

If the device is down or the Junos Space software is unable to push the service

configuration to the device, the service order transitions to the Failed Deploy state. A

network operator might need to resolve the problem before the service provisioner

reschedules the service order.

When you cancel a job, the service order may not fail in Cross Provisioning Platform but

changes the service order state to Scheduled. When the job state is In Progress and until

the device responds, the service order state is Scheduled. When the job is Cancelled, the
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job state becomes Cancelled and the service order state is Scheduled. As a result, the

service order cannot be deleted or edited. However, you canmove the service order state

to Requested by right-clicking any service order or by clicking Actions at the header of

thegrid andselectingCancelOrderoption. TheCancelOrderoption is enabledordisabled,

depending on the state of the service order. This option is enabled only when the service

order state is Scheduled and the job state isCancelledwhile it is disabled for all the other

service order states. When the state of the service order is Requested, you canmodify

and deploy or delete the service order.

Service States

A service is created when a service order to provision a service reaches the Completed

state.

If a service exists, it is in the Deployed state. If a new service fails to deploy, the service

does not exist.

If an attempt to modify a service fails, the service enters the Fail Deploy state. When a

service is in the Fail Deploy state, you can attempt to redeploy it, or you can delete it.

The service also has an audit state of Up or Down, depending on whether the service

passed or failed functional audit.

If you modify a service order and successfully redeploy the service, the modified service

will operate according to the updated configuration.

Related
Documentation

Viewing Service Orders on page 765•

• Viewing Services on page 776

• Deploying a Service on page 467

• Understanding Service Validation on page 753

Understanding VLANManipulation (Normalization and VLANMapping) on Ethernet
Services

To effectively manage Ethernet frames that are transported across bridge domains and

VPLS routing instances, frames are processed and, if necessary, translated to provide

the required VLAN tags. When the customer sites participating in a VPLS domain send

traffic of different tag heights (untaggged, single tagged, or dual tagged packets) across

a service, Internet service providers (ISPs) need to provide a network environment to

transport traffic of different tag heights. The Network Activate software supports VLAN

manipulation on VPLS services. VLANmanipulation allows transport of traffic with

different tag heights between different customer access sites while preserving the

customer traffic profiles that are transported over anMPLS core. You can also use VLAN

manipulation for the following purposes:
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• Specifydifferentnormalizedvalues forouter and innerVLANtagswhile troubleshooting

packet captures to identify wrong inner/ outer VLAN tag configuration issues.

• Simplify provisioning across a BGP/LDP scenario because VLAN tagmanipulation is

performed on customer facing interfaces only.

• Simplify the process for troubleshooting predetermined tag values.

• Enable end-to-end communication between clients employing different VLAN

topologies.

• Provide ISPs the flexibility to enforce their own QoS policies throughmetro area and

core networks because customer traffic classification is not impacted.

NOTE: To support all access types (port-based [untagged], single-tag, and
dual-tag) in a VPLS instance, we recommend that normalization is based on
a two-tag operation. However, when only port-based or single-tag access is
required, normalizing traffic to a single tagmight be sufficient.

For Ethernet services and Ethernet services with flexible VLAN tagging (asymmetric tag

height), the type of VLANmanipulation applied depends on the type of device sending

and receiving packets. MX Series devices can use VLANmapping or normalization to

translate VLANs tags. M Series devices use only VLANmapping to translate VLAN tags.

VLAN Translation (Normalization) for VPLS Services

A packet received on a physical port is only accepted for processing if the VLAN tags of

the received packet match the VLAN tags associated with one of the logical interfaces

configured on the physical port. The VLAN tags of the received packet are translated

only if they are different than the normalized VLAN tags. For the translation case, the

VLAN identifier tags specify the normalized VLAN.

The VLAN tags of a received packet are compared with the normalized VLAN tags

specifiedwith either the vlan-id or vlan-tags statements. If the VLAN tags of the received

packetaredifferent fromthenormalizedVLANtags, thenappropriateVLANtagoperations

(such as push-push, pop-pop, pop-swap, swap-swap, swap, and others) are implicitly

made to convert the received VLAN tags to the normalized VLAN tags. Then, the source

MACaddressofa receivedpacket is learnedbasedon thenormalizedVLANconfiguration.

For output packets, if the VLAN tags associated with an egress logical interface do not

match thenormalizedVLANtagswithin thepacket, thenappropriateVLANtagoperations

(such as push-push, pop-pop, pop-swap, swap-swap, swap, and others) are implicitly

made to convert the normalized VLAN tags to the VLAN tags for the egress logical

interface. Formore informationabout theseoperations, see the JunosOSRoutingProtocols

Configuration Guide.

VLANMapping for VPLS Services

For Ethernet services and Ethernet services with flexible VLAN tagging (asymmetric tag

depth), the Network Activate software uses the VLAN configuration data that you

specified in the service order to apply the appropriate VLAN tags to the input and output

VLANmaps for the ingress andegress logical interfaces, respectively. The following steps
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outline the process of bridging a packet received over a Layer 2 logical interface when a

normalizing VLAN identifier (vlan-id number or vlan-tags statement) is specified for a

bridge domain or VPLS routing instance:

1. When a packet is received on a physical port, it is accepted only if the VLAN identifier

of the packet matches the VLAN identifier of one of the logical interfaces configured

on that port.

2. The VLAN tags of the received packet are then compared with the normalizing VLAN

identifier. If the VLAN tags of the packet are different from the normalizing VLAN

identifier, the VLAN tags are rewritten, as described in Table 6 on page 35.

3. If the source MAC address of the received packed is not present in the source MAC

table, it is learned based on the normalizing VLAN identifier.

4. The packet is then forwarded toward one ormore outbound Layer 2 logical interfaces

based on the destination MAC address. A packet with a known unicast destination

MAC address is forwarded only to one outbound logical interface. For each outbound

Layer 2 logical interface, the normalized VLAN identifier configured for the bridge

domainorVPLS routing instance is comparedwith theVLANs tags thatareconfigured

on that logical interface. If theVLANtagsassociatedwithanoutbound logical interface

do notmatch the normalizing VLAN identifier that is configured for the bridge domain

or VPLS routing instance, the VLAN tags are rewritten, as described in

Table 7 on page 35.

Table 6 on page 35 andTable 7 on page 35 showhowVLAN tags are appliedwhen traffic

is sent to and from the bridge domain, depending on how the VLAN IDs and VLAN tags

(inner and outer) are configured for the bridge domain and on how VLAN identifiers are

configured for the logical interfaces in a bridge domain or VPLS routing instance.

Depending on the configuration of the Ethernet services that you create in Network

Activate, the following rewrite operations are performed on VLAN tags:

• pop—Remove the VLAN tag from the top of the VLAN tag stack.

• pop/pop—Remove both the outer and inner VLAN tags of the frame.

• pop/swap—Remove the outer VLAN tag of the frame and replace the inner VLAN tag

of the frame.

• swap—Replace the inner VLAN tag of the frame.

• push—Add a new VLAN tag to the top of the VLAN stack.

• push/push—Push two VLAN tags in front of the frame.

• swap/push—Replace the VLAN tag of the frame and add a new VLAN tag to the top

of the VLAN stack.

• swap/swap—Replace both the outer and inner VLAN tags of the frame.

No operationmeans that the VLAN tags of the inbound or outbound packet are not

translated for the specified output logical interface or input logical interface. NAmeans

not applicable.
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Table 6: VLAN Tag Rewrite Operations at UNI Ingress for Ethernet Services

vlantagsouter 100, inner
300

vlan-id allvlan-id 200vlan-id noneVLAN Identifier of Logical
Interface

push 100, push 300NApush 200no operationnone

swap200to300,push 100no operationno operationpop 200200

swap 1000 to 300, push
100

no operationswap 1000 to 200,pop 10001000

swap 2000 to 100pop 200pop 2000, swap 300
to 200

pop 2000, pop
300

vlan-tags outer 2000, inner
300

NAno operationNANAvlan-id range 10-100

NApop 200NANAvlan-tags outer 200, inner
range 10-100

Table 7: VLAN Tag Rewrite Operations at UNI Egress for Ethernet Services

vlan tags outer 100,
inner 300

vlan-id allvlan-id 200vlan-id noneVLAN Identifier of Logical
Interface

pop 100, pop 300NApop 200no operationnone

pop200, swap300 to200no operationno operationpush 200200

pop 100, swap 300 to
1000

no operationswap 200 to 1000push 10001000

swap 100 to 2000push 2000swap 200 to 300,
push 3000

push 2000, push
300

vlan-tags outer 2000, inner
300

NAno operationNANAvlan-id range 10-100

NApush 200NANAvlan-tags outer 200, inner
range 10-100

Sample VLAN Configuration onMX Series andMSeries PE Routers

MX Series devices can use VLANmapping or normalization to translate VLANs tags. M

Series devices use only VLANmapping to translate VLAN tags. The following sample

configurations show the VLAN and VPLS routing-instance configurations for an MX960

PE interface and M320 PE interface.

M320 PE Interface ConfigurationMX960 PE Interface Configuration
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interfaces {   
 ge-1/1/1 {
    unit 1 {    
            encapsulation vlan-vpls;
            vlan-tags outer 22 inner 2;
## Q-in-Q tags configured on the PE interface ##        

input-vlan-map {
swap-swap;
##normalizing the inner and outer tags towards the core 
by swapping both tags##
  vlan-id 2;
  inner-vlan-id 1;
  }
 output-vlan-map swap-swap; 
## Put the original tags back for the packets towards the
 VPLS CE ##  
  family vpls
 }
  }
   }

interfaces {   
 ge-0/0/0 {
    unit 1 {    
            encapsulation vlan-vpls;
            vlan-tags outer 5 inner 5;
##normalizing the inner and outer tags 
towards the core with Push/Push operations##

 family vpls
  }
   }
    }

Related
Documentation

Service Attributes Overview on page 20•

• Creating a Point-to-Multipoint VPLS Service Order on page 507

• Creating a Multipoint-to-Multipoint VPLS Service Order on page 491
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VLAN Pool Profiles Overview

A VLAN pool profile specifies the ranges of valid VLAN IDs that are available for use on

MX Series devices, on each physical interface. Themaximum theoretical pool of VLAN

IDs contains 4096 VLAN IDs—IDs 0 through 4095.

VLAN ID 0 and VLAN ID 4095 are never valid VLAN IDs.

The Network Activate system provides the following predefined VLAN pool profiles:

• maximum-range—Any VLAN ID pool created using themaximum-range profile allows

any VLAN ID from 1 through 4094. This is the default VLAN profile.

• vlan-ccc—Any VLAN ID pool created using the vlan-ccc profile allows any VLAN IDs

from 512 through 4094 available for use. VLAN IDs 1 through 511 are reserved for use

by Juniper Networks.

For eachphysical interface that JunosSpace recommendsasaUNI, the systemattempts

to determine the best VLAN pool profile. For example, if a UNI has the vlan-ccc

encapsulation setting, the rules recommend the vlan-ccc pool profile for that interface.

When the correct VLAN pool profiles have been assigned to each UNI, Network Activate

creates a VLAN ID pool for each UNI containing only the allowed VLAN IDs specified in

the VLAN pool profile for that UNI.

If the device interface is already running encapsulation before being brought under Junos

Spacemanagement, theNetworkActivatesoftwareassigns theappropriateVLANrange.

For details about encapsulation, see the Junos OS VPNs Configuration Guide.

Related
Documentation

Prestaging Devices Process Overview on page 50•

• Prerequisites for Prestaging Devices in Network Activate on page 52

• Viewing Pre-Staging Rules on page 662

• Discovering and Assigning All N-PE Devices on page 54

• Discovering and Assigning N-PE Devices with Exceptions on page 56
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Redundant Pseudowires for Layer 2 Circuits and VPLS

A redundant pseudowire can act as a backup connection between PE routers and CE

devices, maintaining Layer 2 circuit and VPLS services after certain types of failures. This

feature can help improve the reliability of certain types of networks (metro for example)

where a single point of failure can interrupt service for multiple customers. Redundant

pseudowires cannot reduce traffic loss to zero. However, they provide away to gracefully

recover from pseudowire failures in such a way that service can be restarted within a

known time limit.

When you configure redundant pseudowires to remote PE routers, you configure one to

act as the primary pseudowire over which customer traffic is being transmitted and you

configure another pseudowire to act as a backup in the event the primary fails. You

configure the two pseudowires statically. A separate label is allocated for the primary

and backup neighbors.

The following sections provide an overview of redundant pseudowires for Layer 2 circuits

and VPLS:

• Types of Redundant Pseudowire Configurations on page 38

• Pseudowire Failure Detection on page 39

Types of Redundant Pseudowire Configurations

You can configure redundant pseudowires for Layer 2 circuits and VPLS in either of the

following manners:

• You can configure a single active pseudowire. The PE router configured as the primary

neighbor is given preference and this connection is the one used for customer traffic.

For the LDPsignaling, labels are exchanged for both incomingandoutgoing trafficwith

the primary neighbor. The LDP label advertisement is accepted from the backup

neighbor, but no label advertisement is forwarded to it, leaving the pseudowire in an

incomplete state. The pseudowire to the backup neighbor is completed only when the

primary neighbor fails. The decision to switch between the two pseudowires is made

by the device configured with the redundant pseudowires. The primary remote PE

router is unawareof the redundantconfiguration, ensuring that traffic is alwaysswitched

using just the active pseudowire.

• Alternatively, you can configure two active pseudowires, one to each of the PE routers.

Using this approach, control plane signaling is completed and active pseudowires are

established with both the primary and backup neighbors. However, the data plane

forwarding is done only over one of the pseudowires (designated as the active

pseudowire by the local device). The other pseudowire is on standby. The active

pseudowire is preferably established with the primary neighbor and can switch to the

backup pseudowire if the primary fails.

The decision to switch between the active and standby pseudowires is controlled by the

local device. The remote PE routers are unaware of the redundant connection, and so

both remote PE routers send traffic to the local device. The local device only accepts

traffic from the active pseudowire and drops the traffic from the standby. In addition,
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the local device only sends traffic to the active pseudowire. If the active pseudowire fails,

traffic is immediately switched to the standby pseudowire.

Pseudowire Failure Detection

When a failure is detected, traffic is switched to the redundant pseudowire, which is then

alsodesignatedas theactivepseudowire. The switch is nonreversible,meaning that once

traffic has been switched to the redundant pseudowire, it remains active unless it also

fails unless the switch to the redundant pseudowire is never done unless there is a failure

in the currently active pseudowire. For example, a primary pseudowire has failed and

traffic has been successfully switched to the redundant pseudowire. After a period of

time, the cause of the failure of the primary pseudowire has been resolved and it is now

possible to reestablish the original connection. However, traffic is not switched back to

the original pseudowire unless a failure is detected on the now active pseudowire.

Related
Documentation

Creating a Point-to-Point Ethernet Service Definition on page 97•

• Creating a Multipoint-to-Multipoint VPLS Service Definition on page 117

• Creating a Point-to-Multipoint VPLS Service Definition on page 138

VPLS over GREOverview

Generic routing encapsulation (GRE) is one of the tunnelingmechanisms that uses IP as

the transport protocol. The tunnels behave as virtual point-to-point links that have two

endpoints identified by the tunnel source and tunnel destination addresses at each

endpoint.

Theprimary useofGRE is to carry non-IPpackets throughan IPnetwork. GREalso carries

IP packets such as IP broadcast, IP multicast through an IP cloud. A GRE tunnel has the

following characteristics:

• GRE tunnel is stateless, and offers no flow control mechanisms.

• GRE is multiprotocol and can tunnel any OSI Layer 3 protocol.

• GRE enables routing protocols to travel through the tunnel.

• GRE has weak security features.

• GRE provides no reliability or sequencing. Such features are typically handled by

upper-layer protocols.

• GRE tunnels carry multicast traffic.

TheVPLSoverGRE featureallowsyou tocombine flow-basedandpacket-basedservices

in a single device. You can deploy large-scale VPLS over GRE.

To better understand this configuration, consider the following scenarios:

In the first scenario, pseudowires enable the creation of point-to-point circuits between

two endpoints carried over the MPLS network. Ignoring the signaling protocols for this

discussion, these connections are just point-to-point connections. Using this approach

provides an end-to-end wire between sites. This is beneficial from a traffic processing
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point of view because the gateways do not need to learn MAC addresses; they simply

forward anything they receive to the pseudowire. Deploying this configuration can be

difficult when trying to provide connectivity to multiple branch offices.

In thesecondscenario,VPLSprovidesaLayer2networkabstraction.WithVPLS,endpoints

typically negotiate LSPs and pseudowires with every other endpoint (that is, they are

fully meshed). When a node receives an Ethernet frame from one of its LAN interfaces,

the source MAC address is learned, if it is not already known, and flooded using every

pseudowire connecting to all other branch nodes. However, if the destination has been

previously learned, then the frame is sent to theappropriatedestination.WhenanEthernet

frame is received through one of the pseudowires (that is, from the MPLS network),

source MAC address learning is performed. The next time a frame is sent to that MAC it

does not need to be flooded and the frame is flooded to every single LAN interface in the

node, but not over the pseudowires. The network acts as a distributed Layer 2 switch

providingany-to-anyEthernetconnectivitybetweenthedevicesconnected to thedifferent

nodes in the network.

While the second scenario provides significant advantages (any-to-any connectivity,

automated provisioning, and simple abstraction), it is more complex. Every PE node has

toperformLayer 2 learning and floodingof traffic,which can causeproblemswheneither

multiple broadcast/multicast or frames to unknownMAC addresses are used. For

example, in a topology with a thousand branch offices, each office that receives a

broadcastpacketmust replicate it 999 times, encapsulateeachcopy inGRE, and forward

the resulting traffic. Additionally, because each node performs Layer 2 learning, the

maximum number of MAC addresses that each node can learn is limited, limiting the

total number of nodes in the domain.

Related
Documentation

Creating a GRE Definition•

• Creating a GRE Service Order

Junos Space Network Topology Overview

Network topology is the arrangement of various elements including nodes and links. It

is thegraphical representationofphysical devicesand their interconnection. The topology

has the following three components:

1. Physical topology

2. Link topology

3. IP connectivity

Each application registers itself to the topology framework so that you can view and

change topologyon theapplication layer. Toview thenetwork topology, selectApplication

Network Platform > NetworkMonitoring > Topology.

In a network topology, you can:
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• Monitor the status and configurations of the discovered devices and their

interconnections.

• View source and destination information for the device interconnections that exist

within the discovered topologies.

• Select a service and view all the devices associated with the service.

• Discover IS-IS configuration devices.

The network topology helps you to understand and visualize the physical and logical

interconnection between the network devices and the services. It also enables you to

viewtheend-to-endnetworkandzoominto thesegmentsof thenetwork formanagement

and troubleshooting.

Related
Documentation

Creating a Point-to-Point ATM or TDM Pseudowire Service Order on page 432•

• Creating a Point-to-Point Service Order on page 438

• Creating a Multipoint-to-Multipoint VPLS Service Order on page 491

• Creating a Point-to-Multipoint VPLS Service Order on page 507

• Creating a Full Mesh Layer 3 VPN Ethernet Service Order on page 536

• Creating a Hub-and-Spoke Layer 3 VPN Service Order on page 549

Service Recovery Overview

The Service Recovery operation recovers services that are present on devices that Junos

Space is not managing. Themissing entity can be an entirely new service or the missing

component of an existing service.

The Service Recovery operation has two parts. First, you select one or more devices for

which services are to be recovered. Service Recovery recovers and identifies the missing

services and displays the result. Second, you select a service to bemanaged, providing

any missing information about the recovered service. When you provide missing

information for a service, the recovered service is converted to amanaged service.

The Network Activate application supports Service Recovery for point-to-point services,

VPLS services, and Layer 3 VPN services.

Related
Documentation

Performing a Service Recovery Request on page 81•
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Multicast L3VPNOverview

The JunosSpaceNetworkActivateapplicationusesMultiprotocol-BGP(MBGP)Multicast

L3VPNs(MVPN) to implementMVPNsbecause it is simpler. Thismethoddoesnot require

a service provider to configure multicast in its provider backbone to connect PE routers.

For the control plane, MBGPMVPN uses the intra-autonomous system (AS)

next-generation BGP. The data plane is configured with Protocol Independent Multicast

(PIM) sparse mode. Network Activate maintains PIM state information using the same

architecture that is used for unicast VPNs.

TheMBGPMVPNmethod avoids potential control and data plane scaling problems that

can occur with the requirement to maintain two routing and forwarding mechanisms,

one for VPN unicast and one for VPNmulticast.

The Network Activate application addresses aspects of published standards as follows:

• Layer 3 VPN service, as defined by RFC 4364, is supported to enable service providers

to implement IP multicast for L3VPN services.

• The architecture defined by RFC 4364 for unicast VPNs is supported to enable service

providers to configure BGP for the control plane between PE routers.

• Unicast with extensions for intra-Autonomous System (AS) and inter-AS

communication, as defined by RFC 4364, is supported.

For MVPNs, Network Activate enables you to configure two site sets, a sender site set

and a receiver site set. Site sets have the following properties:

• Hosts within a sender site can originate multicast traffic for receivers in a receiver site

set.

• Receivers outside the receiver site set should not be able to receive traffic sent from

the sender site.

• Hosts within the receiver site set can receivemulticast traffic originated from any host

in the sender site set.

• Hostswithin the receiver site set shouldnotbeable to receivemulticast trafficoriginated

from any host that is not in the sender site set.

A host can be in both the sender site set and the receiver site set. Therefore, such a host

can both originate and receive multicast traffic. For example, the sender site set could

be the sameas the receiver site set. In this case, all hosts could both originate and receive

multicast traffic from one another.

Administrative policies define an MBGPMVPN. The policies define both the sender site

setand receiver site set.Customersestablish thepoliciesbut thepoliciesare implemented

by service providers, which use the existing BGP and MPLS VPN infrastructure.

Related
Documentation

Creating a Multicast VPN Service Definition on page 277•

• Creating a Multicast VPN Service Order on page 568
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Multichassis Link Aggregation Group Overview

Multi-chassis link aggregation group (MC-LAG), is a type of LAGwith constituent ports

that terminate on separate chassis, thereby providing node-level redundancy. MC-LAG

adds node-level redundancy to the normal link-level redundancy that a LAG provides.

This allows two or more nodes to share a common LAG endpoint. Themultiple nodes

present a single logical LAG to the remote end.

TheMC-LAGenablesaclientdevice to forma logical LAG interfacebetween twoMC-LAG

peers. An MC-LAG provides redundancy and load balancing between the twoMC-LAG

peers, multi-homing support, and a loop-free Layer 2 network without running the

Spanning Tree Protocol (STP). It is an HA solution involving multiple protocols: LACP,

ICCP, VRRP, BFD, SNOOPING

On one end of an MC-LAG, there is an MC-LAG client device, such as a server, that has

one or more physical links in a link aggregation group. This client device does not need

to have anMC-LAG configured. On the other side of the MC-LAG, there are twoMC-LAG

peers. Each of the MC-LAG peers has one or more physical links connected to a single

client device.

The MC-LAG peers use the Inter-chassis Control Protocol (ICCP) to exchange control

information and coordinate with each other to ensure that data traffic is forwarded

properly. ICCP runs over TCP and is monitored by Bidirectional Forwarding Detection

(BFD). It requires an Inter-Chassis link (ICL) for L2 connectivity.

Following are the two types of MC-LAG:

• Active-ActiveMode—Inactive-activemode, allmember linksareactiveon theMC-LAG.

In thismode,MACaddresses learned on oneMC-LAGpeer are propagated to the other

MC-LAG peer. Active-active mode is the only mode supported at this time.

• Active-Standby Mode—In active-standbymode, one node is active at any given time.

In this mode, the MC-LAG peers act as virtual routers. The virtual routers share the

virtual IP address that corresponds to thedefault route configuredon thehost or server

connected to the MC-LAG.

You can configure MC-LAG in the following scenarios:

• MC-LAGwith multi-segmented point-to-point service in Active-Standbymode

• MC-LAGwith point-to-point service in Active-Standbymode

• MC-LAGwith multi-segmented Layer 3 VPN in Active-Standbymode

Related
Documentation

Creating a Point-to-Point Service Order on page 438•

• Creating a Full Mesh Layer 3 VPN Ethernet Service Order on page 536
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Multi-Chassis Automatic Protection Switching Overview

Automatic protection switching (APS) is a linear protection scheme designed to protect

VLAN-based Ethernet networks.

With APS, a protected domain is configured with two paths: a working path and a

protection path. Both working and protection paths can bemonitored. Normally, traffic

is carried on the working path (that is, the working path is the active path), and the

protection path is disabled. If the working path fails, its protection status is marked as

degraded (DG) and APS switches the traffic to the protection path, then the protection

path becomes the active path.

APS uses twomodes of operation: linear 1+1 protection switching architecture and linear

1:1 protection switching architecture. The linear 1+1 protection switching architecture

operates with either unidirectional or bidirectional switching. The linear 1:1 protection

switching architecture operates with bidirectional switching.

Related
Documentation

Creating a Point-to-Point ATM or TDM Pseudowire Service Order on page 432•

InverseMultiplexing for ATMOverview

The Inverse multiplexing for ATM (IMA) protocol defines a technique for transporting

ATM traffic over a bundle of T1 or E1 interfaces. IMA processes traffic differently from

multiplexing.Whilemultiplexingcombinesmultiple signals intoasingle signal, IMAdivides

a data stream into multiple concurrent streams that are transmitted at the same time

acrossseparatechannels (suchasT1orE1 interfaces).Thedatastreamsare reconstructed

into the original data stream at the far end. IMA speeds up the flow of data across a

slower interface, such as a T1 or E1 interface, by load balancing the data stream across

multiple T1 or E1 interfaces, which increases the line capacity.

You can deploy IMA on Juniper Networks M7, MX and ACX devices. IMA includes the

following operational features:

• Aggregateddevicecount—Adevicecount is thenumberof IMAgroup interfacescreated

on a CT1 or CE1 interface. As part of an IMA group, a logical ATM interface is identified

by the naming format: “at-fpc/pic/port”. The port number is derived from the last port

on the MIC plus 1.

For example, for an ACX2000 router with a 16-port built-in T1/E1 TDMMIC, IMA group

interface numbering starts with at-0/0/16. That interface number is incremented by

1 to at-0/0/17, and so on. For an ACX1000 router with an 8-port built-in T1/E1 TDM

MIC, IMA group interface numbering starts with at-0/0/8. That interface number is

incremented by 1 to at-0/0/9, and so on.

• Framingmode—An emulation mechanism duplicates the essential attributes of a

service, such as T1 or E1, over a packet-switched network. On the ACX Series routers,

you can configure the built-in channelized T1 and E1 interfaces (CT1 and CE1) to work

in either T1 or E1 mode. You can configure these child T1 and E1 interfaces to carry ATM

services over the packet-switched network.
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• Built-in channelized interface—The Juniper Networks devices that support ATM IMA

are deployed with one full T1 or E1 interface on the channelized CT1 or CE1 interface.

You cannot configure the built-in interface. However, on the built-in interface, you

configure the parameters for a child T1 or E1 interface.

• T1 or E1 interface member of IMA group for IMA link—Each child T1 or E1 interface of a

channelized CT1 or CE1 interface is the physical interface over which the ATM signals

are transmitted. To ensure that the IMA link operates correctly, you specify the T1 or

E1 interface to be amember of an IMA group.

• IMA group interface configuration—To ensure proper operation, youmust configure

each IMA group interface (at-fpc/pic/g) with all ATM properties, which include the

logical link-layer encapsulation type and the circuit cross-connect protocol suite.

Further, youmust dedicate the entire ATM device to the ATM cell relay circuit.

Related
Documentation

Creating an Inverse Multiplexing for ATM Service Order on page 459•

• ViewingFunctionalAuditResults foran InverseMultiplexing forATMServiceonpage764

Cross Provisioning PlatformOverview

TheCrossProvisioningPlatform(CPP)softwareprovidesa real-time, operations support

system (OSS) for creating and deploying multi-vendor LAN/WAN services.

Creating services for cross-platform deployment requires the coordination of tasks

performed in several areas of expertise including script design, system administration,

and service provisioning.

Junos Space Release 13.1P1 includes software modules that manage the essential

interaction between the Juniper Networks devices and the devices of other vendors for

which the cross-platform service will be deployed.

The CPP software manages the interaction of a module called the Service Activation

Director (SAD) with amodule called the Service Activation Manager (SAM). The scripts

that pertain to Juniper Networks devices aremanaged by the SAD. Scripts imported into

the system that pertain to the outside vendor device are managed by the SAM. Another

type of script renders the graphical user interface (GUI) window that enables a service

provisioner to configure the devices for the service.

Before you use Junos Space to provision a service definition upon which to base the

service order, youmust import several required scripts to the system.

An important aspect of creating a cross-platform service definition is using Cross

Provisioning Platform to attach the required scripts to the definition. When you create

the cross-platform service definition, you attach scripts designed for the service for both

the SAM and SAD. The CPP software in Junos Spacemanages the information that

defines the service for the outside vendor device and the information that defines the

service for the Juniper Networks device.

Juniper Networks script designers create the scripts that provide required information

for the Juniper Networks devices. Script designers for the outside vendor must create
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scripts thatprovide required information for their devices. The scripts for JuniperNetworks

devices and third-party devices are all managed by the script manager in the CPP

software.

To enable Cross Provisioning Platform, script designers create the following three types

of scripts and upload them to the local file system.

• JunosXSLT—Provides the code that enablesprovisioningaparticular JuniperNetworks

device.

• SAMXSLT—Provides the code that enables provisioning the device of another vendor.

• GUI JavaScript—Provides the code that renders the Cross Provisioning Platform GUI

window through which a service provisioner enters data to configure a Juniper device.

A system administrator adds the scripts into the local file system using the Junos Space

Cross Provisioning Platform application. Thereafter, the service provisioner uses Cross

Provisioning Platform to attach the scripts to the service definition and service order.

The GUI scripts generate high level service data with service topology embedded. The

transformation code in the CPP software compiles high-level service data into low-level

configuration data, which is pushed to the network devices.

Related
Documentation

• Adding Scripts Created for Cross Provisioning Platform on page 667

• Importing Scripts Created for Cross Provisioning Platform on page 671

• Modifying Scripts Created for Cross Provisioning Platform on page 671

• Deleting Scripts

• Viewing Scripts Created for Cross Provisioning Platform on page 673

• Creating a Cross Provisioning Platform Service Definition on page 192

• Creating a Cross Provisioning Platform Service Order on page 462
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PART 2

Configuration

• Prestaging Devices on page 49

• Prestaging: Creating and Managing Multihomed Groups on page 71

• Prestage Services on page 81

• ServiceDesign:Managing Point-to-Point andMultipoint ServiceDefinitions on page91

• Service Design: Managing VPLS Service Definitions on page 201

• Service Design: Managing Layer 3 VPN Service Definitions on page 257

• Service Design: Predefined Service Definitions on page 283

• Service Design: Working with Service Templates on page 405

• Service Provisioning: Managing Service Orders on page 431

• Service Provisioning: Managing VPLS Service Orders on page 491

• Service Provisioning: Managing Layer 3 VPN Service Orders on page 533

• Device Configuration Prerequisites to Prestaging Examples on page 577

• End-to-End Configuration Examples on page 623
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CHAPTER 2

Prestaging Devices

• Prestaging Devices Process Overview on page 50

• Prerequisites for Prestaging Devices in Network Activate on page 52

• Discovering and Assigning All N-PE Devices on page 54

• Discovering and Assigning N-PE Devices with Exceptions on page 56

• Prestaging ATM and TDM Pseudowire Devices on page 62

• Prestaging Rules on page 67
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Prestaging Devices Process Overview

After Junos Space has discovered the devices, youmust perform a two- or three-stage

process to pre-stage devices:

1. Discover roles. In this stage, the JunosSpace software searches thedatabase forN-PE

devices that have not yet been assigned.

2. Examine the results of the role discovery andmake any exceptions to the system

recommendations. Specifically, you might:

• Exclude specified devices from N-PE role assignment.

Youmight need to exclude a device that you know is not a PE device. For example,

Provider (P) devices that have loopback addresses pass the rules for N-PE role

assignment. For devices that you know are not PE devices, you can edit the

configuration out-of-band, and then run role discovery again.

• Select a different loopback address for a device.

• Exclude interfaces from UNI assignment.

3. Confirm the assignments.

When you confirm device assignments, those devices are removed from the list of

recommendations. If, initially, you exclude devices from assignment, you can return to

the list of recommendations later andmake further assignments.

When youaddmoredevices to your network, you need to run the role discovery operation

again. Running role discovery again overwrites anydevices remaining in the role discovery

results list of recommended assignments, but has no effect on devices with confirmed

assignments.

• TheAssignRoles screenshowsadevice inventoryofN-PE routers thatNetworkActivate

has discovered in its database that have not yet been assigned. You can perform the

following operations from the Assign Roles screen:

• Select multiple devices to assign roles—Themost common and recommended

prestaging workflow is to select all devices in the Assign Roles screen and assign

them all. See “Discovering and Assigning All N-PE Devices” on page 54 for

step-by-step instructions for assigning all Junos Space recommendations.

• Select a single device to assign a role—Youmust select a single device to change

the loopback address or the UNI assignments on that device. For step-by-step

instructions on selecting a different loopback address, see “Changing the Loopback

Address of an N-PE Device” on page 60.

You can also exclude a single device using this screen.

• Exclude specified devices from the N-PE role. See “Discovering and Assigning N-PE

Devices with Exceptions” on page 56 for step-by-step instructions.

• TheManageDeviceUNIs screen isan inventoryofUNI-qualified interfaces for a specific

discovered device. You can view a separate Manage Device UNIs screen for each
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discovered N-PE device. You can also excludemultiple interfaces from qualification

as UNIs. For step-by-step instructions on excluding interfaces from the list of qualified

UNIs, see “Excluding Interfaces from UNI Role Assignments” on page 60.

TheVPLSservice needs tobeenabled in anetworkdevice, tomake the static pseudowire

functionality active in the device. You can activate the static pseudowire functionality

by configuring the network device through the CLI window. You need to enter the CLI

configuration mode of a network element and run the command

set protocols vpls static-vpls no-tunnel-services

commit

If the device is not configured through CLI, awarningmessage appears in the application

server log, that is the JBOSS Log:

<Device name> should be configuredwith static VPLS no tunnel service rule.

To discover the roles of the various network elements configured:

1. Select Network Activate > Prestage Devices >Manage Device Roles.

2. Select Discover Roles to view the relevant window.

3. Click Continue to view the Role Discovery Statuswindow.

TheRoleDiscoveryStatuswindowdisplaysagraphwhichshowsthenumberofunassigned

devices that could be assigned the role of N-PE or PE.

To re-sync the role of the network elements configured:

1. Select Network Activate >Prestage Devices >Manage Device Roles.

2. To re-sync the role capability of a network element, right-click the network element’s

name.

3. Click Re-sync Role Capability. The Re-sync Role Capabilitywindow appears where you

can select the device’s name and click Re-sync.

The role is re-synced with the same device now.

Related
Documentation

Viewing N-PE Devices on page 659•

• Discovering and Assigning All N-PE Devices on page 54

• Discovering and Assigning N-PE Devices with Exceptions on page 56
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Prerequisites for Prestaging Devices in Network Activate
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Before you can perform prestaging on your network devices, each device must meet

specificconfiguration requirements,andmustbebroughtunder JunosSpacemanagement

through device discovery.

The following configuration requirementsmust bemet before beginning the provisioning

process. Otherwise, service deployment fails:

• MPLSmust run on each N-PE device and on each P device.

• LDP signalingmust be established betweenN-PE devices that participate in the same

point-to-point Ethernet (LDP) service.

• MPBGPmust run on eachN-PEdevice that participates in a Layer 2multipoint or Layer

3 full mesh service.

• To runLayer 2, Layer 3, orVPLSservicesonanN-PEdevice, ensure that anautonomous

system (AS) number is configured on the device.

Before you can prestage devices, youmust performdevice discovery to import all Juniper

Networks devices on your network that Junos Space canmanage. The Network Activate

prestagingworkspaceworks on devices that have already been discovered and imported

into the Junos Space database, but have not yet been pre-staged.

TheVPLSservice needs tobeenabled in anetworkdevice, tomake the static pseudowire

functionality active in the device. You can activate the static pseudowire functionality

by configuring the network device through the CLI window. You need to enter the CLI

configuration mode of a network element and run the command

set protocols vpls static-vpls no-tunnel-services

commit

If the device is not configured through CLI, awarningmessage appears in the application

server log, that is the JBOSS Log:

<Device name> should be configuredwith static VPLS no tunnel service rule.

To discover the roles of the various network elements configured:

1. Select Network Activate > Prestage Devices >Manage Device Roles.

2. Select Discover Roles to view the relevant window.

3. Click Continue to view the Role Discovery Statuswindow.

TheRoleDiscoveryStatuswindowdisplaysagraphwhichshowsthenumberofunassigned

devices that could be assigned the role of N-PE or PE.

To re-sync the role of the network elements configured:

1. Select Network Activate >Prestage Devices >Manage Device Roles.

2. To re-sync the role capability of a network element, right-click the network element’s

name.
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3. Click Re-sync Role Capability. The Re-sync Role Capabilitywindow appears where you

can select the device’s name and click Re-sync.

The role is re-synced with the same device now.

For details about bringing devices under Junos Spacemanagement, see Discovering

Devices in the Junos Space Network Application Platform User Guide.

Related
Documentation

Discovering Devices in the Junos Space Network Application Platform User Guide•

Discovering and Assigning All N-PE Devices

Pre-staging all Network Activate assignment recommendations is a powerful yet simple

way to prepare your devices for provisioning. This procedure provides the pre-staging

steps that accept all system recommendations. To pre-stage devices andmake

exceptions to thesystemrecommendations, see “DiscoveringandAssigningN-PEDevices

with Exceptions” on page 56.

Before discovering and assigning N-PE devices, youmust have already run device

discovery. See Discovering Devices in the Junos Space Network Application Platform User

Guide.

Pre-staging has two parts:

1. Discovering Device Roles on page 54

2. Assigning Device Roles on page 56

Discovering Device Roles

To discover the roles of devices found during element discovery:

1. In the Network Activate task pane, select Prestage Devices >Manage Device Roles >

Discover Roles.

The Role Discovery Statuswindow shows the discovery of unassigned devices found

in the database.:
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The graph portion of this example shows howmany of the unassigned devices the

pre-staging rules determined could be assigned the N-PE role and howmany could

be assigned the P role. The UNKNOWN bar indicates devices that had no MPLS role

assigned but for which the Network Activate software was unable to recommend a

role.

NOTE: You cannot discover a device as a PE device if no user-to-network
interfaces (UNIs) are available in the device.

The Network Activate application throws the following error message:

2012-06-08 10:17:23,446 ERROR [PreStageDeviceManagerBean]
(PreStageDeviceManagerBean#savePreStageDeviceList Thread-6894
(group:HornetQ-client-global-threads-1332782448):) No ge/fe/at/t1
interfaces in this PE device: junos-mx480-space; it can only be used for
virtual routers

2. To view the devices for which the Network Activate software recommends the PE

role, click on the N_PE bar.

The Assign Roleswindow appears.

The question mark on each icon indicates that the device role has not yet been

assigned.
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Device role discovery is now complete. To assign device and interface roles, follow the

steps in the next section, “Assigning Device Roles” on page 56.

Assigning Device Roles

If you need to exclude devices from role assignment, or you need to exclude interfaces

from the list of interfaces that can be used as UNIs, use the procedures documented in

“Discovering and Assigning N-PE Devices with Exceptions” on page 56.

To assign all discovered roles and interfaces:

1. In the Network Activate task pane, select Prestage Devices >Manage Device Roles >

Assign Roles.

2. In the Assign Roles page, clickMultiple in the quick view pane and select all devices.

3. Open the Actionsmenu and select Assign NPE Role.

4. In the confirmation window, click Assign.

5. To view the assignment status, in the JobManagementwindow, click the job ID of the

assignment job.

The JobManagement page shows the progress and status of the role assignment job.

See Viewing Jobs in the Junos Space Network Application Platform User Guide for details.

While the job is ongoing, you cannotmake additional assignments from theAssignRoles

page. The Assign NPE Role action is dimmed to indicate you cannot select it.

Related
Documentation

Pre-Staging Devices Overview on page 3•

• Discovering and Assigning N-PE Devices with Exceptions on page 56

• Unassigning N-PE Devices on page 658

• Deleting UNIs on page 655

• Viewing Jobs in the Junos Space Network Application Platform User Guide

• Viewing Pre-Staging Rules on page 662

• Discovering Devices in the Junos Space Network Application Platform User Guide

Discovering and Assigning N-PE Devices with Exceptions

Preparing network devices for service activation is usually a simple processwhich directs

theNetworkActivate software toprepare yourdevicesautomatically.Whenyoupre-stage

devices, theNetwork Activate software scans the database for devices that have already

beendiscoveredbut havenoMPLS role assigned, and recommendsa role for eachdevice

it finds, based on the device configuration data and a set of predefined rules. You can

then display those devices and their recommended settings for:

• MPLS role for the device (PE only)

• Loopback interface
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• UNI interfaces

The Network Activate software allows you to exclude specific recommended devices

from being assigned the N-PE role and to exclude interfaces from use as UNIs during

service provisioning. You can also change the loopback address of a PE device..

For step-by-step instructions on how to prepare devices for network activation using all

the recommendations for N-PE role assignment and UNI assignment that the Network

Activate software makes, see “Discovering and Assigning All N-PE Devices” on page 54.

These topics describe how to pre-stage devices with exceptions:

• Discovering Device Roles on page 57

• Excluding Devices from N-PE Role Assignment on page 59

• Changing the Loopback Address of an N-PE Device on page 60

• Excluding Interfaces from UNI Role Assignments on page 60

• Committing Your Pre-Staging Choices on page 61

Discovering Device Roles

Before discovering device roles, youmust run device discovery. See Discovering Devices

in the Junos Space Network Application Platform User Guide.

To discover unassigned PE devices:

1. In the Network Activate task pane, select Prestage Devices >Manage Device Roles >

Discover Roles.

The Role Discovery Statuswindow shows the discovery of unassigned devices found

in the database.
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NOTE: If this is not the first timeyouhave run thediscover roles operation,
this action overwrites any recommendations remaining from the previous
discover roles operation. Devices with confirmed roles are not affected.

The Targets Processed box contains a progress bar, which when finished, shows how

many unassigned devices the Network Activate software found in its database.

The graph portion of this example shows howmany of the unassigned devices the

pre-staging rules determined could be assigned the N-PE role and howmany could

be assigned the P role. The UNKNOWN bar indicates devices that had no MPLS role

assigned but for which the Network Activate software was unable to recommend a

role.

2. To view the devices for which the Network Activate software recommends the PE

role, click on the N_PE bar.

The Assign Roles page appears.

The question mark on each icon indicates that the device role has not yet been

assigned.
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NOTE: You cannot discover a device as a PE device if no user-to-network
interfaces (UNIs) are available in the device.

The Network Activate application throws the following error message:

2012-06-08 10:17:23,446 ERROR [PreStageDeviceManagerBean]
(PreStageDeviceManagerBean#savePreStageDeviceList Thread-6894
(group:HornetQ-client-global-threads-1332782448):) No ge/fe/at/t1
interfaces in this PE device: junos-mx480-space; it can only be used for
virtual routers

3. Choose your next step:

• Toexcludeadevice, see “ExcludingDevices fromN-PERoleAssignment”onpage59.

• To change the loopback address for specific devices, see “Changing the Loopback

Address of an N-PE Device” on page 60.

• To exclude some UNIs for specific devices, see “Excluding Interfaces from UNI Role

Assignments” on page 60.

Excluding Devices fromN-PE Role Assignment

The rules-driven process that the Network Activate software uses to discover device

roles recommends the correct roles in most cases. To exclude a device from N-PE role

assignment:

1. In the Network Activate task pane, select Prestage Devices >Manage Device Roles >

Assign Roles.

The results of the most recent role discovery operation appear.

2. In the Assign Roles page, select the N-PE device that you want to exclude from role

assignment. To exclude several N-PE devices, use the multiple selection capability.

3. Open the Actionsmenu and select Exclude fromNPE Role.

The Assign Roles page refreshes. The excluded devices are no longer visible.
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Changing the Loopback Address of an N-PE Device

The Network Activate software allows you to change the loopback address of an N-PE

device to that of a different loopback unit.

NOTE: Although Junos software allows you to assignmultiple loopback
addresses to the same loopback unit, the Junos Space software recognizes
only the first address assigned to the loopback unit. Therefore, when you
change the loopback address of an N-PE device, it must be to that of a
different loopback unit.

To change the loopback address of an N-PE device:

1. In the Network Activate task pane, select Prestage Devices >Manage Device Roles >

Assign Roles.

The results of themost recent role discovery operation appear, including any changes

you have subsequently made to your pre-staging data.

Repeat Step 2 through Step 5 for each device for which you want to change the

loopback address.

2. In theAssignRoles page, select the device forwhich youwant to change the loopback

address.

3. Open the Actionsmenu and selectModify Loopback Address.

4. In theModify Loopback Addresswindow, select the loopback address you want to

use.

5. ClickModify.

The new loopback address appears.

Excluding Interfaces fromUNI Role Assignments

To exclude interfaces from the list of interfaces that the pre-staging rules determined

were suitable for use as UNIs:

1. In the Network Activate task pane, select Prestage Devices >Manage Device Roles >

Assign Roles.

The results of themost recent role discovery operation appear, including any changes

you have subsequently made to your pre-staging data.

Repeat Step 2 through Step 7 for each device for which you want to exclude some

recommended UNI selections:

2. In the Assign Roles page, select the device for which you want to manage UNIs.

3. Open the Actionsmenu and selectManage Device UNIs.
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TheManage Device UNIswindow shows all the device interfaces for the selected

device and indicates those that the Network Activate software recommends for use

as UNIs.

4. In theManage Device UNIswindow, select the UNI you want to exclude.

To excludemore than one UNI, use the multiple selection capability.

5. Open the Actionsmenu and select Exclude fromUNI Role.

6. Open theActionsmenu and selectReturn toAssignRoles to return to theAssignRoles

page.

Committing Your Pre-Staging Choices

This procedure provides instructions for assigning the N-PE role to selected devices and

committing all device pre-staging information to the database.

Before performing these steps, youmust complete the following tasks:

• Discover devices that have not yet been assigned an MPLS role.

• Exclude fromthe listofdiscovereddevices thosedevices that youdonotwant toassign

the N-PE role to.

• On each device, exclude the interfaces you do not want used as UNIs.

To commit your pre-staging choices to the database:

1. In the Network Activate task pane, select Prestage Devices >Manage Device Roles >

Assign Roles.

2. Examine the list of devices to be sure these are the devices you want to assign the

N-PE role.

3. Select all devices.

4. Open the Actionsmenu and click Assign NPE Role.

5. In the confirmation screen, click Assign.

6. To view the assignment status, in the Job Management screen, click the job ID of the

assignment job.

The JobManagement page shows the progress and status of the role assignment job.

See Viewing Jobs in the Junos Space Network Application Platform User Guide for

details.

While the job is ongoing, you cannot make additional assignments from the Assign

Roles page. The Assign NPE Role action is dimmed to indicate you cannot select it.
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NOTE: After you pre-stage a device, you can check to see if a particular
device is capable of supporting Layer 2 or Layer 3 services.

In theNetworkActivate taskpane, selectPrestageDevices>ManageDevice

Roles. Double-click the device for which you want to check its service

capability. The NPE Detailswindow appears.

Check the Service capability field to ensure that the values L2, L3 appear,

which indicate that the device can support Layer 2 and Layer 3 services.

NOTE: If youmodify the configuration of a device after the device is
pre-staged, remove the device from pre-staged status and then Discover
Roles and pre-stage the device again.

Related
Documentation

Pre-Staging Devices Overview on page 3•

• Discovering and Assigning All N-PE Devices on page 54

• Unassigning N-PE Devices on page 658

• Adding a UNI on page 654

• Deleting UNIs on page 655

• Viewing Jobs in the Junos Space Network Application Platform User Guide

• Viewing Pre-Staging Rules on page 662

• Viewing N-PE Devices on page 659

• Discovering Devices in the Junos Space Network Application Platform User Guide

Prestaging ATM and TDMPseudowire Devices

Junos Space supports ATM and TDM pseudowires in IP/MPLS networks on BX7000

Multi-Access Gateways and M Series Multiservice Edge Routers with Circuit Emulation

Service (CES) Physical Interface Cards (PICs). The ATM and TDM pseudowires run over

an LSP connection.

Static pseudowires are designed for networks that do not support LDP or do not have

LDP enabled. You define pseudowires by configuring static values for the inbound and

outbound labels of the connection. For details on configuring pseudowire connections

in Junos OS, see the Junos OS VPNs Configuration Guide, the Layer 2 VPN Configuration

Example, and Configuring Layer 2 Circuit and Layer 2 VPN Pseudowires.

Prerequisites for M Series Routers

One of the following CES PICs is required:

• 4-Port ChOC3/STM1 CES PIC
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• 12-Port T1/E1 CES PIC

Prerequisites for the BX Series Gateway

The BX Series devices have a fixed configuration with 3 Gigabit Ethernet (GE) interfaces

and 16 T1/E1 ports that can be used by ATM/TDM pseudowire services. The correct level

of firmware is required. Refer to the release notes that correspond to the release of Junos

Space that you are running for the correct level information.

RFCs Supported

RFC 4553, Structure-Agnostic Time Division Multiplexing (TDM) over Packet (SAToP)

Before discovering and assigning N-PE devices, youmust have already have run device

discovery. See Discovering Devices in the Junos Space Network Application Platform User

Guide.

Whenyou run thediscoveryprocess forATMandTDMdevices, theyneed tobediscovered

as N-PE devices. In addition, the BX Series devices require an additional device role

defined as a cell site router (CSR). This figure shows the discovered devices.

After you discover the devices, use Network Activate Prestaging feature to bring the PE

and CSR devices into Network Activate together with their UNI interfaces. In theNetwork

Activate task pane, select Prestage Devices >Manage Device Roles.
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Double-click a listed device. In this example; you can see that an MPLS role and an

additional device role as a CSR are assigned.
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Double-click another listed device. In this example, the details window shows the

channelized ATM and T1 interfaces.
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Related
Documentation

Creating an RSVP LSP Order•

• Creating an RSVP LSP Definition

• Creating a Single-Hop Static LSP Order

• Creating a Single-Hop Static LSP Definition

• Discovering and Assigning All N-PE Devices on page 54

• Discovering Device Roles on page 54

• Creating a Point-to-Point ATM or TDM Pseudowire Service Definition on page 164

• Creating a Point-to-Point ATM or TDM Pseudowire Service Order on page 432
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Prestaging Rules

Pre-staging rules are predefined. These rules contain criteria for classifying the MPLS

role of each device, in addition to recommending which physical interfaces should be

UNI interfaces. For each recommendedUNI interface, the systemrecommends itsprimary

loopback address and its VLAN pool profile.

Correctly assigning MPLS roles to devices is critical for provisioning the correct MPLS

behavior. Each MPLS role has a different behavior. For example, N-PE is the only role

allowed to terminate MPLS sessions..

The rules used by the Junos Space software to determine the recommended role

assignment are described for devices, UNIs, and VLAN pool profiles in the following

sections:

N-PE Device Classification Rules

The system recommends the N-PE role for devices that satisfy the following criteria:

• The comment field in the device configuration identifies the device as an N-PE device.

• The device role is set to N-PE unless EBGP is enabled for the device. Specifically, the

device role is set to N-PE unless the device configuration has

configuration/protocols/bgp/group/type set to external. IF EBGP is enabled, the device

role is set to P.

• The device is assigned a loopback address. A device that has no loopback address

cannot function as an N-PE device.

• LDP is enabled on the loopback interface for the device. LDPmust be enabled on the

loopback interface if the device is to be a assigned the PE MPLS role. (Required

point-to-point Ethernet services.)

• L2 VPN signaling for BGP is enabled. Specifically, the rule checks whether the device

configuration has configuration/protocols/bgp/family/l2vpn/signaling or

configuration/protocols/bgp/group/l2vpn/signaling set. (Required for Layer 2 Ethernet

services.)

• inet-vpn unicast for BGP is enabled. Specifically, the rule checks whether the device

configuration has configuration/protocols/bgp/family/inet-vpn/unicast set. (Required

for Layer 3 VPN services.)

UNI Classification Rules

Before an interface on an N-PE device can be provisioned as a UNI, it must satisfy the

following criteria:
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• The interface must be Gigabit Ethernet (ge), 10-Gigabit Ethernet (xe), Aggregated

Ethernet (ae), or Fast Ethernet (fe) type.

Fast Ethernet (fe) interfaces are supported for the Ethernet service configurations (on

M Series devices with Junos OS Release 10.2R1.6).

• Checks forGigabitEthernet (ge) interfaceswithinanAggregatedEthernet (ae) interface.

ExcludesGigabitEthernet interfaces thatareconfiguredwithinanAggregatedEthernet

interface from UNI assignment.

• Checks for bridge family on logical interfaces. Excludes interfaces fromUNIassignment

if interface configuration on the device has /interface/unit/family/bridge set.

• Checks for the following configurations on a device interface. An interface is excluded

from UNI assignment when all of the following configurations are present and the

logical interface is Unit 0:

• An IP address is defined on the physical interface. The interface configuration on the

device has interface/unit/name/../family/inet/address/name set. For example:

interfaces {    
 ge-0/1/0 {
    unit 0 {
   family inet {
    address 10.10.30.52;
   } 
   }
 }
}

• MPLS is enabled on the physical port. The interface configuration on the device has

interface/unit/name/../family/mpls set. For example:

interfaces {    
 ge-0/1/0 {
  unit 0 {
   family mpls;
   }
 }
}

• OSPF is running on the logical interface. The interface configuration on the device

has configuration/protocols/ospf/area/interface set. For example:

interfaces {    
 ge-5/0/0 {
    unit 0 {
   family inet {
    address 10.10.34/30;
     } 
    family mpls;
     }
   }
 }
protocols {
 ospf {
  traffic-engineering;
   area 0.0.0.0. {
    interface ge-5/0/0.0;
   }
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  }
 }

• MPLS is running on the physical interface. The interface configuration on the device

has configuration/protocols/mpls/interface set. For example:

interfaces {    
 ge-5/0/0 {
    unit 0 {
   family inet {
    address 10.10.34/30;
   } 
   family mpls;
   }
  }
 }
protocols {
 mpls {
  interface ge-5/0/0.0;
  }
 }

VLAN Pool Profile Classification Rules

The Junos Space software assigns VLAN pool ranges to the UNIs, depending on the

configured encapsulation.

Auto Discovery Only

The Junos Space software enables the router to process only the autodiscovery network

layer reachability information (NLRI) update messages for LDP-based VPLS update

messages.

ASNumber Check

The Junos Space software checks for the Autonomous System (AS) number of a device.

If the AS number is not configured for a device, theServiceCapability is assigned as Layer

2.

Related
Documentation

• Viewing Pre-Staging Rules on page 662
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CHAPTER 3

Prestaging: Creating and Managing
Multihomed Groups

• Multihomed Groups Overview on page 71

• Creating a Multihomed Group on page 74

• Deleting Multihomed Groups on page 76

• Viewing Multihomed Groups on page 77

• Viewing a Sample Connectivity File for Multihomed Groups on page 78

Multihomed Groups Overview

In the Junos Space product, you can create amultihomed group to connect a customer

site to multiple PE routers to provide redundant connectivity across a VPLS site, while

preventing the formation of Layer 2 loops in the service provider’s network. A VPLS site

multihomed to two or more N-PE routers provides redundant connectivity in the event

of aPE-router-to-CE-device link failure or the failure of anN-PE router. Figure 11 onpage 71

shows twomultihomed sites in which each access switch is connected to a primary and

a backup PE router. If the PE router functioning as the primary device fails or the link

connection between the access switch and PE router fails, the backup PE router

automatically takes over the role of primary device.

Figure 11:MultihomedSitesConnectedtoPrimaryandBackupPRRouters
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MPLS core
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This multihomed groups overview includes the following topics:

• Prerequisites to Create Multihomed Groups on page 72

• Required N-PE Device Configuration on page 72
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• Administrator Roles Required to Create Multihomed Groups on page 73

• Creating Multihomed Groups Process Overview on page 73

Prerequisites to CreateMultihomed Groups

The following requirements must bemet before you create amultihomed group:

• Ensure that the N-PE devices included in the multihomed groupmeet the following

requirements:

• The same site ID is assigned to the N-PE devices that are connected to the same CE

devices.

• The same route distinguisher is assigned to the N-PE devices that are connected to

the same CE devices.

• The N-PE device is either designated as a primary interface or allows the router to

select the interface to be used as the primary interface.

If the router selects the interface, the interface that is used to connect the N-PE

device to the site depends on the order in which the interfaces are listed in the N-PE

device’s configuration. The first operational interface in the set of configured

interfaces is selected as the designated interface. If this interface fails, the next

interface in the list is selected to send and receive traffic for the site.

• Perform device discovery to import the N-PE devices that you want to include in the

multihomed group.

• Pre-stage the N-PE devices that you want to include in multihomed groups.

Required N-PE Device Configuration

The configuration for each N-PE device that you include in a multihomed groupmust

include the following statements:

[edit routing-instances routing-instance-name]
instance-type vpls;
interface interface-name;
interface interface-name;
protocols vpls {
site site-name {
active-interface {
any;
primary interface-name;

}
interface interface-name;
interface interface-name;
multihoming;
site-identifier number;

}
}
route-distinguisher (as-number:id |ip-address:id)
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Administrator Roles Required to CreateMultihomed Groups

The steps required to create amultihomed group are performed by users with different

levels of privilege. The Junos Space software provides predefined administrator roles

that provide the necessary privilege for each step in the sequence:

• The Device Manager role allows an administrator to discover the PE devices that you

want to include in the multihomed group.

• TheServiceManager roleallowsanadministrator toperformdevicepre-stagingactions

including discovering and assigning device roles and importing the connectivity file for

the multihomed group.

• The Service Designer roles allows an administrator to create and publish a service

definition.

• The Service Activator (less privileged) role allows an administrator to perform

provisioning tasks, including creating andmanaging customers, service orders, and

services.

For details about predefined administrator roles, see Predefined Roles Overview in the

Junos Space Network Application Platform User Guide.

CreatingMultihomed Groups Process Overview

To create amultihomed group to connect a customer site to multiple PE routers:

1. CreateanXMLconnectivity file tonamethemultihomedgroupandconfigureendpoint

connections between the CE device (access switch) and N-PE devices—Each

multihomed group connects individual customer sites to up to three PE routers to

provide redundant connectivity across a VPLS site. For step-by-step instructions on

creating an XML connectivity file formultihomed groups, see “Creating a Connectivity

File for Multihomed Groups” on page 74.

2. Upload theXMLconnectivity file in JunosSpace—After youcreate theXMLconnectivity

file, you upload it to Junos Space. For step-by-step instructions on uploading an XML

connectivity file for multihomed groups, see “Uploading a Connectivity File to Create

Multihomed Groups” on page 75.

3. Create a VPLS service definition with multihoming enabled.

4. Publish the VPLS service definition.

5. Create a customer for the service.

6. Create a VPLS service order based on a VPLS service definition with multihoming

enabled.

When you create the service order, you select one or more multihomed groups you

want to include in the service from the Select Endpoint PE devices screen.

7. Deploy the service order.

8. Perform a functional audit to determine whether the service is up or down.
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If the functional audit reports that the service is up, the customer(s) can begin using

the service.

NOTE: You are required to create amultihomed group only if you intend
to create redundant VPLS services. For point-to-point LDP services and
Layer 2 VPN services, you can enable the redundant feature when you
create the service order.

Related
Documentation

Creating a Multihomed Group on page 74•

• Deleting Multihomed Groups on page 76

Creating aMultihomed Group

In JunosSpace, youcancreateamultihomedgroup toconnectacustomersite tomultiple

PE routers toprovide redundant connectivity across aVPLSsite. AVPLSsitemultihomed

to two or more N-PE routers provides redundant connectivity in the event of a

PE-router-to-CE-device link failure or the failure of an N-PE router.

To create one or more multihomed groups, complete the following tasks:

1. Creating a Connectivity File for Multihomed Groups on page 74

2. Uploading a Connectivity File to Create Multihomed Groups on page 75

Creating a Connectivity File for Multihomed Groups

The connectivity file can include one or more multihomed groups. Eachmultihomed

group defines an access switch that is connected to one primary PE device and one or

more backup PE devices.

The following requirements must bemet before you create a connectivity file for a

multihomed group:

• Perform device discovery to import the N-PE devices that you want to include in the

multihomed group.

• Pre-stage the N-PE devices that you want to include in the multihomed group.

Youmust create an XML file to define connectivity for the PE devices in a multihomed

group. You can specify any name for the connectivity file, but it must be a valid XML file

that includes the following attributes:

• Name—Multihomed group name.

• Description—Multihomed group description.

• AccessSwitchIP—IP address for the CE device.

• PEHostName—Hostname for the N-PE device. Include two or more hostnames to

identify the primary and secondary PE devices in the multihomed group.
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NOTE: By default, the first PEHostname specifies the primary device.

• PEInterface—UNIon theN-PEdevice that connects to theCEdevice. Eachmultihomed

groupmust specify the interface for the primary and secondary PE devices.

• AccessSwitchInterface—UNIon theCEdevice that connects to theprimaryor secondary

PE device.

The following sampleXML file shows the format youuse toconfiguremultihomedgroups:

<!— List of unmanaged connections for an Access Switch not currently modeled in 
Junos Space
<MultihomedGroups>
     <MultihomedGroup Name="juniper-west" Description="engineering-west" 
AccessSwitchIP="10.157.59.63">
          <MultihomedEndPoint PEHostName="san_jose" PEInterface="ge-2/0/1" 
AccessSwitchInterface="ge-1/0/4"/>
          <MultihomedEndPoint PEHostName=”san_francisco” PEInterface=”ge-2/0/2” 
AccessSwitchInterface=”ge-1/0/5"/>
     </MultihomedGroup>
     <MultihomedGroup Name="juniper-east" Description="engineering-east" 
AccessSwitchIP="10.155.50.60">
          <MultihomedEndPoint PEHostName="boston" PEInterface="ge-2/0/1" 
AccessSwitchInterface="ge-1/0/4"/>
          <MultihomedEndPoint PEHostName=”westford” PEInterface=”ge-2/0/2” 
AccessSwitchInterface=”ge-1/0/5"/>
          <MultihomedEndPoint PEHostName=”baltimore” PEInterface=”ge-3/0/2” 
AccessSwitchInterface=”ge-1/0/6"/>
     </MultihomedGroup>
</MultihomedGroups>

In thepreceding sampleconnectivity file, the firstmultihomedgroup, juniper-west, defines

twoPEdevices inwhich san_jose is theprimaryPEdevice and san_francisco is thebackup

PE device. The secondmultihomed group, juniper-east, defines two PE devices in which

boston is the primary PE device andwestford and baltimore are backup PE devices.

To view a sample connectivity file for multihomed groups, see “Viewing a Sample

Connectivity File for Multihomed Groups” on page 78.

Uploading a Connectivity File to CreateMultihomed Groups

Tocreatemultihomedgroups, youupload theconnectivity file in the JunosSpacesoftware.

You create and upload a single connectivity file for all the multihomed groups you want

to configure in Junos Space. To add additional multihomed groups at a later date, you

can update the connectivity file and then upload the connectivity file in Junos Space

again.

To upload a connectivity file and create amultihomed group:

1. In the Network Activate task pane, click Prestage Devices >ManageMultihomed... >

CreateMultihomed....

The Create Multihomed Groups screen appears.
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2. To upload a Connectivity file for multihomed groups:

a. In the Connectivity File field, click Browse.

b. Navigate to theXMLconnectivity file that youwant touse tocreate themultihomed

group.

c. Click Upload.

d. (Optional) To view job status information, click the Job ID.

e. ClickOK to upload the connectivity file in Junos Space.

Related
Documentation

Viewing Multihomed Groups on page 77•

• Deleting Multihomed Groups on page 76

• Multihomed Groups Overview on page 71

DeletingMultihomed Groups

You can delete amultihomed group if it is not being used in a service.

To delete amultihomed group from the database:

1. In the Network Activate task pane, select Prestage Devices >ManageMulithomed

Groups.

2. In theManageMultihomed Groups inventory page, select the multihomed group(s)

you want to delete.

3. Open the Actionsmenu and select Delete Multihomed Group.

A pop-up window appears requesting confirmation.

4. Click Delete.

TheManageMultihomedGroupspage reappears,whichconfirms that themultihomed

groups were deleted.

Related
Documentation

Viewing Multihomed Groups on page 77•
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• Multihomed Groups Overview on page 71

ViewingMultihomed Groups

Youcanviewmultihomedgroupsand thePEdevices included ineachmultihomedgroup.

1. Viewing Multihomed Groups on page 77

ViewingMultihomed Groups

To viewmultihomed groups:

1. In the Network Activate task pane, select Prestage Devices >ManageMultihomed

Groups.

The Manage Multihomed Groups page appears.

2. The following multihomed group information appears in the main display area:

• Name—The name assigned to the multihomed group

• Device—The name of the PE device in multihomed group

3. Double-click a multihomed group to view additional details.

The detailed view provides the following information:

• Multihomed Group—The name assigned to the multihomed group

• Description—A description for the multihomed group

• Device—The name of the PE device in multihomed group

• Interface—The UNI on the PE device in multihomed group
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Related
Documentation

Creating a Multihomed Group on page 74•

• Deleting Multihomed Groups on page 76

• Multihomed Groups Overview on page 71

Viewing a Sample Connectivity File for Multihomed Groups

You create and upload a single connectivity file for all the multihomed groups you want

to configure in Junos Space. You can view a sample connectivity file that shows the file

format and required elements for creating one or more multihomed groups.

To view a sample connectivity file for multihomed groups:

1. In the Network Activate task pane, select Prestage Devices >ManageMultihomed

Groups > CreateMultihomed Groups.

The CreateMultihomed Groupswindow appears.
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2. Click View Sample File.

A sample connectivity file appears.

3. ClickClose toclose thesample fileand return to theCreateMultihomedGroupswindow.

Related
Documentation

• Creating a Multihomed Group on page 74

• Viewing Multihomed Groups on page 77

• Deleting Multihomed Groups on page 76

• Multihomed Groups Overview on page 71

79Copyright © 2015, Juniper Networks, Inc.

Chapter 3: Prestaging: Creating and Managing Multihomed Groups



Copyright © 2015, Juniper Networks, Inc.80

Junos Space Cross Provisioning Platform



CHAPTER 4

Prestage Services

• Performing a Service Recovery Request on page 81

• Viewing Service Recovery Report on page 85

Performing a Service Recovery Request

The Service Recovery feature functions within the pre-staging operation of the Network

Activate application. Service Recovery has two parts.

First, Service Recovery parses each device’s configuration searching for service

configurations and existing Network Activate service elements (P2P services, Layer 2

circuits, routing instances, firewalls, policy options, routing options, and OAM interface

branches of Junos Space configurations that are being processed).

Second, Service Recovery stitches the service elements by identifying related service

attributesacrossdevices, suchasVCIDs forMartini servicesand route targets forKompella

(L2VPN) services, to form Network Activate services.
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To perform Service Recovery, in the Network Activate task pane, select Prestage Services

> Service Recovery Request. Initially, Service Recovery generates the following Alert

message, which describes the process you are about to start and recommends saving

previously recovered services.

The Service Recovery Profilewindow displays two panels, Published Service Definition

and Devices & Filters.

In the Published Service Definition panel, you can select one or more service types: P2P,

VPLS, and L3VPN.

The Published Service Definition panel also presents a table that lists the names of all

services of the selected Service Type.

The Devices & Filters panel lists devices in the Name column. You can specify a VCID

Range and Route target range to complete the definition of the service recovery profile

search.

To recover services:

1. Fill in the fields as described in the following table.

ActionField
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ActionField

Published Service Definition

Select the service type check boxes based on the service to recover:

• P2P

• VPLS

• L3VPN

Service Type

Select this check box to retrieve service templates attributes attached to the service. Junos Space
supports the templates of the following MPLS VPN-related applications:

• CoS

• IPsec

• Stateful firewall

Service template

Select the check boxes for the service definitions whose services you want to recover.

All the published service definitions based on service type selected are listed.

Name

Devices & Filters

Select the devices whose services you want to recoverDevices

This field is displayed if you have selected the P2P check box.

Specify the VCID range within which services are to be recovered.

NOTE: The VCID Range parameter enables you to change the VCID range for services that had been
configured previously outside of the context of Junos Space.

VCID Range

This field is displayed for all the service types.

Specify the Route target range within which services are to be recovered. You can express the range in
Autonomous System number format or IPv4 format:

• ASnumber format—Autonomoussystem(AS)number format:<l2vpn-id:as-number:2-byte-number>.
For example, 100:200. The AS number can be in the range from 1 through 65,535.

• IPv4 format—<l2vpn-id:ip-address:2-byte-number>. For example, l2vpn-id:10.1.1.1:2. Make sure that
this value is lower than the value specified as the maximum route target allowed.

NOTE: The Route target parameter enables you to change the route target range for services that had
been configured previously outside of the context of Junos Space.

Route target

This field is displayed if you have selected the VPLS check box.

Specify the VPLS ID range.

Range: 1 through 2147483647

VPLS ID range
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ActionField

This field is displayed if you have selected the VPLS or L3VPN check boxes.

Specify the Hub-Route target range within which services are to be recovered. You can express the
range in Autonomous System number format or IPv4 format:

• ASnumber format—Autonomoussystem(AS)number format:<l2vpn-id:as-number:2-byte-number>.
For example, 100:200. The AS number can be in the range from 1 through 65,535.

• IPv4 format—<l2vpn-id:ip-address:2-byte-number>. For example, l2vpn-id:10.1.1.1:2. Make sure that
this value is lower than the value specified as the maximum route target allowed.

Hub-Route target
range

This field is displayed if you have selected the VPLS or L3VPN check boxes.

Specify the Spoke-Route target range within which services are to be recovered. You can express the
range in Autonomous System number format or IPv4 format:

• ASnumber format—Autonomoussystem(AS)number format:<l2vpn-id:as-number:2-byte-number>.
For example, 100:200. The AS number can be in the range from 1 through 65,535.

• IPv4 format—<l2vpn-id:ip-address:2-byte-number>. For example, l2vpn-id:10.1.1.1:2. Make sure that
this value is lower than the value specified as the maximum route target allowed.

Spoke-Route target
range

2. When you complete defining the Service Recovery Profile, click Start.

The Network Activate application fetches the latest device configuration. It then

processes the device configuration to derive the configuration of selected service

types.

The Service Recovery in progress...window appears, which indicates the progress of

the search.

NOTE:
• In case of a Layer 3 VPN service with pseudowire attached, you have to
first recover theLayer3VPNservice, and then thepoint-to-point service.

• In caseof amultihominggroup forBGP-basedVPLSservice, the service
recovery request recovers amultihoming BGP-based VPLS service
regardless of the availability of amultihoming group. Youmust create
amultihoming group before service recovery is performed.

When the service recovery operation completes, the Service Recovery Reportwindow

appears. The service recovery report for each service is displayed in different tabs.

Related
Documentation

Service Recovery Overview on page 41•

• Viewing Service Recovery Report on page 85
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Viewing Service Recovery Report
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When the service recovery operation completes, the Service Recovery Reportwindow

appears.

TheServiceRecoveryReportwindowdisplays the recovered services according to service

type. The service recovery report for each service is displayed in different tabs.

The Service Recovery Reportwindow includes several panels that provide details about

the recovered services: Recovered service instances, Details of the instance (General,

Connectivity, Devices).

The Details of the Instance panel displays information about a service selected in the

Recovered service instances panel. You canmodify the information, and click Save to

save the modification.

The Devices panel lists the endpoints associated with the service instance.

DescriptionColumn

Recovered service instances—Lists the recovered service instances based on the tab you have selected.

Name of the recovered service instance.Instance Name

Name of the service definition attached to a service.Service Definition

One of the following:Service Type

• P2P

• VPLS

• L3VPN

Partial or RecoveredStatus
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DescriptionColumn

Customer for which the service is createdCustomer

Comments to describe the service.Comments

• Ignore

• Recover

Action

Details of the instance—The fields in this section differ for each service.

General

Name of the selected service instanceName

Comments to describe the service.Comments

Connectivity Fault Management

This field is displayed in the P2P tab and the VPLS tab.

CFM

Name of the service definition with which the instance is associatedService definition

Name of the service template with which the instance is associatedService template

Customer for which the service is createdCustomer

Connectivity

Virtual channel identifier number

This field is displayed in the P2P tab only.

VCID

Maximum transmission unit number

This field is displayed in the P2P tab and theVPLS tab.

MTU

Route targetRT

Route distinguisherRD

If the Unmanaged IP field includes a valid IP address, the selected service is valid but the
other end is an ummanaged device. If the field displays Unmanaged IP, the IP address of
the unmanaged device is unknown. Youmust provide the IP address.

NOTE: If Service Recovery finds an endpoint attached to a recovered service for a device
that was not selected for Service Recovery, the endpoint is reported as an Unmanaged IP.
The endpoint is recovered and attached to the service when Service Recovery is executed
on the particular device.

This field is displayed in the P2P tab only.

Unmanaged IP
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DescriptionColumn

If one endpoint is an unmanaged device, the interface information is unknown. Youmust
provide the interface for the endpoint.

This field is displayed in the P2P tab only.

Unmanaged Interface

VPLS ID of the recovered service

This field is displayed in the VPLS tab only.

VPLS ID

Layer 2 VPN ID of the recovered service

This field is displayed in the VPLS tab only.

L2VPN ID

Route target of the hub.

This field is displayed only in the VPLS tab and the L3VPN tab.

Hub RT

Route target of the spoke.

This field is displayed only in the VPLS tab and the L3VPN tab.

Spoke RT

When this check box is selected, the VPN facilitates VRF table lookup, based on MPLS
labels.

This field is displayed in the L3VPN tab only.

VRF Table

Provider edge (PE) and customer edge (CE) routing protocol configured for the service.

This field is displayed in the L3VPN tab only.

Routing Protocol

Hub device for the hub-and-spoke Layer 3 VPN service.

This field is displayed in the L3VPN tab only. This is applicable for hub-and-spoke Layer 3
VPN service only.

Select Hub

Devices

Name of the device on which the service instance was recovered.Device Name

The interfaces on the device on which the service instance was recovered.Interfaces

To view or modify a recovered service:

1. In the Recovered service instances panel, select a service.

The Details of the Instance panel displays information about a service selected in the

Recovered service instances panel.

2. View the information of a recovered service in the Details of the Instance panel. Click

Ignore to close the Service Recovery Report window.

3. If required, modify the fields in the Details of the Instance panel.

4. Click Save to save the modification.
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The Recovered Services Statuswindow displays the status of all the recovered services.

It also indicates the configuration that are converted to service orders. You can view the

status of a recovered service in its corresponding tab. The Recovered Services Status

window displays one of the following status indications:

• Managed–The service is nowmanaged successfully

• Failed–Service Recovery did not convert the service to a service order.

• Partial–The service cannot bemanaged yet.

If you click Cancel, the Network Activate application displays theManage Service Orders

window.

NOTE: You can access the Recovered Service Statuswindowwhenever you

want to attempt to recover additional services.

Related
Documentation

• Service Recovery Overview on page 41

• Performing a Service Recovery Request on page 81
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CHAPTER 5

Service Design: Managing Point-to-Point
and Multipoint Service Definitions

• ChoosingaPredefinedServiceDefinitionorCreatingaNewServiceDefinitiononpage91

• Creating a Point-to-Point ATM or TDM Pseudowire Service Definition on page 164

• Creating a Point-to-Point Ethernet Service Definition on page 172

• Creating a Cross Provisioning Platform Service Definition on page 192

• Creating and Deploying a Device Configlet Order for Cross Provisioning

Platform on page 194

• Preconfiguring theThird-PartyOSSDevice for CrossProvisioningPlatformonpage 196

• Publishing a Custom Service Definition on page 198

• Unpublishing a Custom Service Definition on page 199

• Deleting a Customized Service Definition on page 200

Choosing a Predefined Service Definition or Creating a New Service Definition

The Network Activate software provides a set of predefined service definitions for

point-to-point services, multipoint-to-multipoint (full mesh) services, and

point-to-multipoint (hub and spoke) services. These service definitions are capable of

providing the basis for most of the service orders your organization will need to create.

In case these predefined service definitions are not adequate for all your needs, however,

the Network Activate software enables you to create service definitions of your own.

The following topics review the predefined service definitions and provide instructions

on creating your own.

• Choosing a Predefined Service Definition on page 91

• Creating a Point-to-Point Ethernet Service Definition on page 97

• Creating a Multipoint-to-Multipoint VPLS Service Definition on page 117

• Creating a Point-to-Multipoint VPLS Service Definition on page 138

Choosing a Predefined Service Definition

Table 8 on page 92 lists the predefined service definitions that Junos Space provides for

Ethernet point-to-point services that use LDP in the network core. Table 9 on page 94
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lists the predefined service definitions for multipoint-to-multipoint (full mesh) services.

Table 10 on page 96 lists the predefined service definitions for point-to-multipoint (hub

and spoke) services.

Table 8: Standard Ethernet Point-to-Point Service Definitions

Service Attributes
Standard Service Definition
Name

• Point-to-point service forMSeriesandMXSeriesdevices

• Gigabit Ethernet interfaces

• 802.1Q endpoint circuit types

• Customer traffic is single VLAN

• Flexible-ethernet-services physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

ELine-Dot1q-SingleVLAN

• Point-to-point service for JSeries,MSeries, andMXSeries
devices

• Gigabit Ethernet interfaces

• 802.1Q endpoint circuit types

• Customer traffic is single VLAN

• Vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

ELine-Dot1q-SingleVLAN-CCC

• Point-to-point service for JSeries,MSeries, andMXSeries
devices

• Gigabit Ethernet interfaces

• 802.1Q endpoint circuit types

• Customer traffic is single VLAN

• Extended-vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

ELine-Dot1q-SingleVLAN-Ext-CCC

• Point-to-point service for JSeries,MSeries, andMXSeries
devices

• Gigabit Ethernet interfaces

• 802.1Q endpoint circuit types

• Port-based UNI

• Rate limiting default 10 Mbps

ELine-PortBased

• Point-to-point service forMSeriesandMXSeriesdevices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint circuit types

• All customer traffic

• Flexible-ethernet-services physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

ELine-QinQ-AllVLAN
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Table8:StandardEthernetPoint-to-PointServiceDefinitions (continued)

Service Attributes
Standard Service Definition
Name

• Point-to-point service for JSeries,MSeries, andMXSeries
devices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint circuit types

• All customer traffic

• Vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

ELine-QinQ-AllVLAN-CCC

• Point-to-point service for JSeries,MSeries, andMXSeries
devices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint circuit types

• All customer traffic

• Extended-vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

ELine-QinQ-AllVLAN-Ext-CCC

• Point-to-point service for MX Series devices only

• Gigabit Ethernet interfaces

• Q-in-Q endpoint circuit types

• Customer traffic is range of VLANs

• Flexible-ethernet-services physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

ELine-QinQ-VLANRange

• Point-to-point service for MX Series devices only

• Gigabit Ethernet interfaces

• Q-in-Q endpoint circuit types

• Customer traffic is range of VLANs

• Vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

ELine-QinQ-VLANRange-CCC

• Point-to-point service for MX Series devices only

• Gigabit Ethernet interfaces

• Q-in-Q endpoint circuit types

• Customer traffic is range of VLANs

• Extended-vlan-ccc physical encapsulation

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

ELine-QinQ-VLANRange-Ext-CCC
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Table8:StandardEthernetPoint-to-PointServiceDefinitions (continued)

Service Attributes
Standard Service Definition
Name

• Ethernet service for M/MX/ACX device family

• Gigabit Ethernet interface

• Q-in-Q endpoint interface type

• Transport all traffic

• Flexible-ethernet-services physical encapsulation type

• Rate limit from 10 Mbps to 100Mbps with 10 Mbps
increment

Eline-BGP-QinQ-AllVLAN

• Ethernet service for M/MX/ACX device family

• Gigabit Ethernet interface

• 802.1Q endpoint interface types

• Single VLAN traffic

• Flexible-ethernet-services physical encapsulation type

• Rate limit from 10 Mbps to 100Mbps with 10 Mbps
increment

“Eline-BGP-Dot1q-SingleVLAN” on
page 360

• Ethernet service for M/MX/ACX device family

• Gigabit Ethernet interface

• Port-based UNIs

• Ethernet-ccc physical encapsulation type

• Rate limit from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-BGP-Port-Based” on
page 358

Table 9: StandardMultipoint-to-Multipoint Service Definitions

Service AttributesStandard Service Definition Name

• Multipoint-to-multipoint Ethernet
service for M Series and MX Series
devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs not preserved

• 802.1Q endpoint circuit types

• Customer traffic is single VLAN

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from 10 Mbps to 100
Mbps with 10 Mbps increment

ELAN-BGP-Dot1q-Normalized-VLAN-None
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Table9:StandardMultipoint-to-MultipointServiceDefinitions(continued)

Service AttributesStandard Service Definition Name

• Multipoint-to-multipoint Ethernet
service for M Series and MX Series
devices

• Gigabit Ethernet interfaces

• 802.1Q endpoint circuit types

• Customer traffic is single VLAN

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from 10 Mbps to 100
Mbps with 10 Mbps increment

ELAN-BGP-Dot1Q-SingleVLAN

• Multipoint-to-multipoint Ethernet
service for M series and MX Series
devices

• Gigabit Ethernet interfaces

• Port-based UNIs

• Transports all customer traffic

• Ethernet VPLS as physical
encapsulation type

• Rate limiting from 10 Mbps to 100
Mbps with 10 Mbps increment

ELAN-BGP-PortBased

• Multipoint-to-multipoint Ethernet
service for M Series and MX Series
devices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint circuit types

• All customer traffic

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from 10 Mbps to 100
Mbps with 10 Mbps increment

ELAN-BGP-QinQ-AllVLAN

• Multipoint-to-multipoint Ethernet
service for M Series and MX Series
devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs preserved

• Q-in-Q endpoint circuit types

• All customer traffic

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from 10 Mbps to 100
Mbps with 10 Mbps increment

ELAN-BGP-QinQ-AllVLAN-Normalized-All
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Table9:StandardMultipoint-to-MultipointServiceDefinitions(continued)

Service AttributesStandard Service Definition Name

• Multipoint-to-multipoint Ethernet
service for M Series and MX Series
devices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint circuit types

• VLAN IDs not preserved

• All customer traffic

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from 10 Mbps to 100
Mbps with 10 Mbps increment

ELAN-BGP-QinQ-AllVLAN-Normalized-None-10-100M

• Multipoint-to-multipoint Ethernet
service for M Series and MX Series
devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs preserved

• Q-in-Q endpoint circuit types

• Transports specified VLAN range

• Flexible Ethernet services physical
encapsulation type

• Rate limiting from 10 Mbps to 100
Mbps with 10 Mbps increment

ELAN-BGP-QinQ-Range-Normalized-VLAN

Table 10: Standard Point-to-Multipoint Service Definitions

Service AttributesStandard Service Definition Name

• Point to-multipoint Ethernet service for M Series and
MX Series devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs are not preserved

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-servicesphysicalencapsulation type

• Rate limiting from 10Mbps to 100Mbpswith 10Mbps
increment

ELAN-Hub-Spoke-QinQ-AllVLAN

• Point-to-multipoint Ethernet service for M Series or
MX Series devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs are preserved

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-servicesphysicalencapsulation type

• Rate limiting from 10Mbps to 100Mbpswith 10Mbps
increment

ELAN-Hub-Spoke-QinQ-AllVLAN-No
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Manyof the serviceattributes canbeedited in the serviceorder,whichallows the flexibility

for creating most of the service orders you will need from these predefined service

definitions.

To view the contents of a predefined service definition, follow these steps:

1. In the Network Activate task pane, select ServiceDesign>ManageServiceDefinitions.

TheManage Service Definitions page appears and shows all the service definitions

present on your system.

2. Double click the predefined service definition you want to review.

Details of the service definition replace theManage Service Definitions page.

TIP: If predefined and customized service definitions both exist on your
system, you can easily find the predefined ones in the service definition
inventory page.

3. When you are done reviewing the service definition, clickBack to return to theManage

Service Definitions page.

For detailed descriptions of each of the predefined service definitions and their service

attributes, see “Predefined Service Definitions” on page 283

Creating a Point-to-Point Ethernet Service Definition

Use this procedure to create a definition for a point-to-point VPN service. The standard

service definitions that came with your initial software installation are designed to be

appropriate for most requirements. You can also create a customized service

definition—for example, to setdifferentbandwidth limitson theservice than thoseoffered

in the standard service definitions.

After the new service definition is complete and published, network operators or service

provisioners can use the completed service definition as a base for creating and then

activating point-to-point VPN services on the network.

The windows appear in the order stated. You can, however, perform these steps in any

order by accessing them through the task list in the right panel. If the panel is not visible,

click the snap tool on the right side of the main display area.

To create a point-to-point service definition, complete these tasks, in the order shown:

1. Specifying General Information on page 98

2. Specifying UNI Settings on page 101

3. Specifying Connectivity InformationWhen Signaling Is LDP on page 113

4. Specifying Connectivity InformationWhen Signaling Is BGP on page 116
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Specifying General Information

To specify the general information for a point-to-point Ethernet service definition:

1. In the Network Activate task pane, select Service Design >Manage Service Definitions

> Create P2P Service Definition. The General settings window appears.

2. Fill in the fields in the Generalwindow.

ActionField

Enter a name for the service definition.Name

By default, the service type is Point-to-Point Pseudowire.Service type

Copyright © 2015, Juniper Networks, Inc.98

Junos Space Cross Provisioning Platform



ActionField

Select a signaling type:

• BGP

• LDP

You cannot edit the Signaling type in the service order.

NOTE: If the signaling type is BGP, the Static pseudowire and
the Enable PW access to L3 VPN network check boxes are not
available. You cannot edit the Signaling type in the service
order.

Signaling

Enter a brief description or other comment that you want to
appear in the Service Definition table.

Range: 0 through 200 characters. Spaces and special
characters are allowed.

Comments (Optional)

WhenyouenableQoS in theservicedefinition, youmustspecify
a QoS profile in the service order to classify traffic into defined
servicegroups toprovide the special treatmentof traffic across
the network service. For example, voice traffic can be sent
across certain links, and data traffic can use other links.

Enable QoS

Select the interface type:

• Ethernet

• TDM

• ATM

Interface type

Toenable staticpseudowire, select theStaticpseudowirecheck
box. This check box is disabled if the signaling type is BGP.

Static pseudowire

To enable the pseudowire access to L3 VPN network, select
the EnablePWaccess to L3VPNnetwork check box. This check
box is disabled if the signaling type is BGP, or if you have
selected the interface type as TDM/ATM.

If you select this check box, the Enable Multi Segment
Pseudowire check box is disabled.

Enable PW access to L3 VPN network
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ActionField

Select this check box to enable multi-segment pseudowire.

If you select this check box, the Enable PW access to L3 VPN
network check box is disabled.

A multi-segment pseudowire (MS-PW) is a static or
dynamically configured set of two or more contiguous
pseudowire segments that behave and function as a single
point-to-point pseudowire. Each end of an MS-PW, by
definition, terminates on a T-PE.

NOTE: The number of pseudowire segments that you can
stitch is limited to two.

For more information on point-to-point pseudowire stitching,
see “Stitching Two Point-to-Point Pseudowires” on page 478.

Enable Multi Segment Pseudowire

To enable the pseudowire resiliency, select the Enable PW
Resiliency check box. For more information on pseudowire
redundancy, see “Redundant Pseudowires for Layer 2 Circuits
and VPLS” on page 38.

Enable PWResiliency

Bydefault, all the events are saved in theOpenNMSdatabase.
To isolate the events related to an interface in the OpenNMS,
select theDecoupleServiceStatus FromPort Status check box.

NOTE: When you select this check box, only the pseudowire
traps are monitored, not the jnxVpnIfVpn traps.

Decouple Service Status FromPort Status

(Optional) To include a service template for the service, select
a service template from the Service Template list.

The selected service template appears in the Default Service
Template field.

You can select one or more service templates as the default
service template. By default, the default service templates are
attached to the endpoints.

NOTE: You cannot add or delete a service template while
creating a service order.

The remaining service templates on the Service Template list
are termed as optional service templates. You can attach the
optional service templates to the endpoints on a need basis.

In theViewServiceDefinitionDetailswindow, the value for the
default service template in the Default Service Template
column is True.

For instructions on creating a service template, see “Creating
a Service Template” on page 409.

Service Template

If you intend to run performance tests on services based on
this service definition, select a TCA Profile.

Threshold alarm profile

3. ClickNext to save the information.Continuewith “SpecifyingUNISettings”onpage 101.
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Specifying UNI Settings

In this step, youprovide theUNI serviceattributes for this servicedefinition. Theattributes

you set depend on whether you are setting attributes for a port, an 802.1Q interface, a

Q-in-Q interface, or a flexible VLAN tagging:

• Specifying UNI Settings for Port-to-Port Services on page 101

• Specifying UNI Settings for Services with 802.1Q Interface Types on page 104

• Specifying UNI Settings for Services with Q-in-Q Interface Types on page 107

• UNI Settings for Services with Flexible VLAN Tagging (Asymmetric Interface

Types) on page 110

Specifying UNI Settings for Port-to-Port Services

To set UNI attributes for a port-to-port service, complete the following procedure.

1. Enter information in the UNI Settings window.

2. Fill in the fields in the UNI Settingswindow according to the following table.

ActionField

Traffic Treatment Settings
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ActionField

Select port-port from the list.

The Ethernet option you choose determines the other options you can select and specify on the
page.

Ethernet option

Select N/A. For port-to-port services, all traffic is always transported.Customer traffic type

In port-to-port services, all traffic and all VLANs on one port are transported to all other ports.VLAN ID selection

Select this check box to allow the service provisioner to override the MTU setting.Editable in Service Order

Interface Settings

Selectethernet-vpls, theonly validphysical interfaceencapsulationmethodallowed forport-to-port
services.

Physical IF encapsulation

You cannot change this field because it is not relevant to port-to-port services.Logical IF encapsulation

MTU Settings

You can specify an MTU value in this field. The default value for MTU is 1522 bytes.

To see the permitted range for the MTU value, select the Editable in Service Order check box. The
MTU range is 1522 through 9192.

Default MTU (Bytes)

If you select the check box Editable in Service Order, you can specify a value range for MTU (in
bytes). The permitted range for MTU is 1522 through 9192.

NOTE: Ultimately, the system establishes the MTU bymultiplying the value you specify in the
Default MTU (Bytes) field by the value you specify forMTU Factor.

MTURange (Bytes)

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased

If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 1.

• Line Rate Based

If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limitingcheckbox.

Calculate Burst Size
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ActionField

The following illustration shows the Calculate Burst-Size panel parameters if you select the Line Rate Based option.

Bandwidth Settings

The following illustration shows the Bandwidth Settings panel, which appears if you do not select the Enable QoS check box
in the preceding General settings window.

If you select this check box, you can override the MTU setting.Enable rate limiting (check
box)

Specify the default bandwidth value, in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Defaultbandwidth(Mbps)

To override the default bandwidth value, select the Editable in Service Order check box.

Specify the minimum bandwidth value in Kbps:

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value, in Mbps.

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)
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ActionField

The following table lists theMax Bandwidth (Mbps) for the M Series, MX Series, and ACX Series Routers:

Table 11: MaximumBandwidth for M Series, MX Series, and ACX Series Routers

ACX 2000
MX Series Non-3D
PICMX Series 3D PICM Series IQ2 PICM Series IQ2E PIC

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

100,000
Mbps or
100 Gbps

100,000
Mbps or
100 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

32,000
Mbps or
32 Gbps

32,000
Mbps or
32 Gbps

Specify a value in the range that is made available to the service provisioner.Increment (Kbps)

3. Click Next to continue with Connectivity settings.

Specifying UNI Settings for Services with 802.1Q Interface Types

To set UNI attributes for 802.1Q interfaces complete the following procedure.

1. Enter information in the UNI Settings window.

2. Fill in the fields in the UNI Settingswindow according to the following table:

ActionField

Traffic Treatment Settings
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ActionField

Select dot1q from the list.

The Ethernet option you choose determines the other options
you can select and specify on the page.

Ethernet option

Single VLAN is the only option for 802.1Q interface types.

Select Transport single vlan to transport the traffic for a specific
VLANacross thenetwork.Whenyouselect thisoption, theservice
provisioner is prompted for the VLAN-IDwhen creating a service
order based on this service definition. You need to specify the
Outer Tag protocol ID.

Select Transport VLAN range to limit the traffic across the
network to a specific range of VLANs.

If you select this option, the service provisioner is prompted for
the VLAN-ID range when creating a service order based on this
service definition.

NOTE: Make sure to check Editable in Service Order if you want
the service provisioner to be able to override this setting.

Customer traffic
type

Indicate how the VLAN ID is determined:

• Selectmanually—Allows the service provider to specify the
VLAN ID. This option is normally used when no VLAN
normalization is applied. Specify the VLAN ID range in VLAN
range for manual input.

NOTE: Makesure tocheckEditable inServiceOrder if youwant
the service provisioner to be able to override this setting.

• Auto pick—This option is normally used when VLAN
normalization is applied. Specify the VLAN ID pool in VLAN
range for auto-pick.

NOTE: Makesure tocheckEditable inServiceOrder if youwant
the service provisioner to be able to override this setting.

VLAN ID
selection

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for
auto-pick

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for
manual input
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ActionField

Select the outer tag protocol ID if the Customer traffic type is
Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: For an interface, youmust configure a physical port with
the possible Tag Protocol Identifiers (TPIDs) either manually or
through a template. Otherwise, the service creation fails for all
TPIDs except 0x8100. To configure the TPIDs manually, use the
following commands:

set interfaces ae0 aggregated-ether-options
ethernet-switch-profile tag-protocol-id 0x9100

set interfaces ae0 aggregated-ether-options
ethernet-switch-profile tag-protocol-id 0x88a8

set interfaces ae0 aggregated-ether-options
ethernet-switch-profile tag-protocol-id 0x8100

Outer Tag
protocol ID

To allow the service provisioner to override the MTU setting,
select the check box for those options.

Editable in
Service Order

Interface Settings

Select the default physical encapsulation scheme to be used by
service orders based on this service definition. We recommend
you select flexible-ethernet-services.

Physical IF
encapsulation

Constrained by your selection in the Physical IF encapsulation
box. If you selected the recommended physical encapsulation
mode of flexible-ethernet-services, then your only option is to
select vlan-vpls for the logical encapsulation method.

Logical IF
encapsulation

MTU Settings

You can specify an MTU value in this field. The default value for
MTU is 1522.

To see thepermitted range for theMTUvalue, select theEditable
in Service Order check box. The MTU range is 1522 through 9192.

Default MTU
(Bytes)

If you select the check box Editable in Service Order, you can
specify a value range for MTU (in bytes). The permitted range
for MTU is 1522 through 9192.

NOTE: Ultimately, thesystemestablishes theMTUbymultiplying
thevalue youspecify in theDefaultMTU(Bytes) fieldby thevalue
you specify forMTU Factor.

MTU Range
(Bytes)
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ActionField

Specify the default bandwidth value, in
Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased

If you select the optionMTUBased, you can specify a value for
MTU Factor in the range 1 through 1087902.

The default value forMTU Factor is 1.

• Line Rate Based

If you select theoption LineRateBased, you can specify a value
for Burst Period in the range 1 through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: The Calculate Burst Size list is enabled only when you
select the Enable rate limiting checkbox.

Calculate Burst
Size

The following illustration shows the appearance of the Calculate Burst-Size panel
parameters if you select the Line Rate Based option.

3. Click Next to continue with connectivity settings.

Specifying UNI Settings for Services with Q-in-Q Interface Types

To set UNI attributes for a Q-in-Q service, complete the following procedure.

1. To set UNI attributes for Q-in-Q interfaces:
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2. Fill in the fields in the UNI Settingswindow according to the following table:

ActionField

Traffic Treatment Settings

Select qinq from the list.

The window expands to include options specific to Q-in-Q interfaces.

Ethernet option

Specify the customer traffic type:

• Transport all traffic—Transports the traffic from all VLANs across the network. When you select
this option, the service provisioner is prompted for the VLAN-ID when creating a service order
based on this service definition. You need to specify only theOuter Tag protocol ID.

• Transport single vlan—Transports traffic for a specific VLAN across the network. You need to
specify bothOuter Tag protocol ID and Inner Tag protocol ID.

• Transport VLAN range—Limits the traffic across the network to a specific range of VLANs.

If you select this option, the serviceprovisioner is prompted for theVLAN-ID rangewhencreating
a service order based on this service definition. You need to specify bothOuter Tag protocol ID
and Inner Tag protocol ID.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be able
to override this setting.

Customer traffic type
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ActionField

Indicate how the VLAN ID is selected during service order creation.

• Selectmanually—Allows the service provider to specify the VLAN ID. This option is normally
used when no VLAN normalization is applied.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting. Specify the VLAN ID range in VLAN range for manual input.

• Auto pick—This option is normally used when VLAN normalization is applied. Specify the VLAN
ID pool in VLAN range for auto-pick.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting.

VLAN ID selection

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick:

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input

Select the outer tag protocol ID if the Customer traffic type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPIDs) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x9100

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x88a8

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x8100

Outer Tag protocol ID

Select the inner tag protocol ID:

• 0x88a8

• 0x8100

• 0x9100

NOTE: You cannot specify the Inner Tag protocol ID if the Customer traffic type is Transport single
VLAN.

Inner Tag protocol ID

Select this check box to allow the service provisioner to override the MTU setting.Editable in Service Order

Interface Settings

Select thedefault physical encapsulation scheme tobeusedby serviceordersbasedon this service
definition. We recommend you select flexible-ethernet-services.

Physical IF encapsulation
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ActionField

Constrainedbyyour selection in thePhysical IFencapsulationbox. If you selected the recommended
physical encapsulation mode of flexible-ethernet-services, then your only option is to select
vlan-vpls for the logical encapsulation method.

Logical IF encapsulation

MTU Settings

You can specify an MTU value in this field. The default value for MTU is 1522.

To see the permitted range for the MTU value, select the Editable in Service Order check box. The
MTU range is 1522 through 9192.

Default MTU (Bytes)

If you select the check box Editable in Service Order, you can specify a value range for MTU (in
bytes). The permitted range for MTU is 1522 through 9192.

NOTE: Ultimately, the system establishes the MTU bymultiplying the value you specify in the
Default MTU (Bytes) field by the value you specify forMTU Factor.

MTURange (Bytes)

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased

If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 1.

• Line Rate Based

If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limitingcheckbox.

Calculate Burst Size

The following illustration shows the appearance of the Calculate Burst-Size panel parameters if you select the Line Rate Based
option.

3. Click Next to continue with Connectivity settings.

UNI Settings for Services with Flexible VLAN Tagging (Asymmetric Interface Types)

Youcanspecify theEthernet optionasymmetric tagdepth to createa service that includes

any combination of port-based interfaces, 802.1Q interfaces, and Q-in-Q interfaces.

1. Enter information in the UNI Settings window.
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2. Specify the UNI Settings for asymmetric tag depth according to the following table:

ActionField

Traffic Treatment Settings

Select asymmetric tag depth from the list.Ethernet option

Select the customer traffic type:

• Transport all traffic—Transports the traffic from all VLANs across the network. When you select
this option, the service provisioner is prompted for the VLAN-ID when creating a service order
based on this service definition. You need to specify only theOuter Tag protocol ID and Inner Tag
protocol ID.

• Transport single vlan—Transports traffic for a specific VLAN across the network. You need to
specify bothOuter Tag protocol ID and Inner Tag protocol ID.

• Transport VLAN range—Limits the traffic across the network to a specific range of VLANs. You
need to specify bothOuter Tag protocol ID and Inner Tag protocol ID.

If you select this option, the serviceprovisioner is prompted for theVLAN-ID rangewhencreating
a service order based on this service definition.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be able
to override this setting.

Customer traffic type
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ActionField

Indicate how the VLAN ID is selected during service order creation.

• Selectmanually—Allows the service provider to specify the VLAN ID. This option is normally
usedwhennoVLANnormalization is applied.Specify theVLAN ID range inVLANrangeformanual
input.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting.

• Auto pick—This option is normally used when VLAN normalization is applied. Specify the VLAN
ID pool in VLAN range for auto-pick.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting. Specify the VLAN ID pool in VLAN range for auto-pick.

VLAN ID selection

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick:

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input

Select the outer tag protocol ID if the Customer traffic type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPIDs) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x9100

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x88a8

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x8100

Outer Tag protocol ID

Select the inner tag protocol ID:

• 0x88a8

• 0x8100

• 0x9100

NOTE: You cannot specify the Inner Tag protocol ID if the Customer traffic type is Transport all
traffic.

Inner Tag protocol ID

Toallow the service provisioner to override theMTUsetting, select the check box for those options.Editable in Service Order

Interface Settings

Select thedefault physical encapsulation scheme tobeusedby serviceordersbasedon this service
definition. We recommend you select flexible-ethernet-services.

Physical IF encapsulation
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ActionField

Constrainedbyyour selection in thePhysical IFencapsulationbox. If you selected the recommended
physical encapsulation mode of flexible-ethernet-services, then your only option is to select
vlan-vpls for the logical encapsulation method.

Logical IF encapsulation

MTU Settings

You can specify an MTU value in this field. The default value for MTU is 1522.

To see the permitted range for the MTU value, select the Editable in Service Order check box. The
MTU range is 1522 through 9192.

Default MTU (Bytes)

If you select the check box Editable in Service Order, you can specify a value range for MTU (in
bytes). The permitted range for MTU is 1522 through 9192.

NOTE: Ultimately, the system establishes the MTU bymultiplying the value you specify in the
Default MTU (Bytes) field by the value you specify forMTU Factor.

MTU Range (Bytes)

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased

If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 1.

• Line Rate Based

If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limitingcheckbox.

Calculate Burst Size

The following illustration shows the appearance of the Calculate Burst-Size panel parameters if you select the Line Rate Based
option.

3. Click Next to continue with Connectivity settings.

Specifying Connectivity InformationWhen Signaling Is LDP

The fields displayed in the Connectivitywindow depend on the Signaling type (LDP or

BGP) that you selected in the General settings window.
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To specify connectivity between sites across the network when signaling is LDP:

1. Fill in the fields in the Connectivitywindow.

ActionField

The VC ID selection is available only if the Signaling type is LDP.

In theVCIDselectionbox, specify howyouwant theVC ID tobechosenduring serviceorder creation:

• To allow the service provisioner to enter the VC ID, choose Selectmanually.

• To cause the Junos Space software to assign a VC ID automatically from the VC ID pool, select
Auto pick.

To allow the service provisioner to override the setting in the VC ID box, select Editable in Service
Order.

VC ID selection

In the Default MTU box, specify the MTU across the service provider network.

To allow the service provisioner to override the MTU setting, select Editable in Service Order. In the
MTU range, enter the highest and lowest MTU that the service provisioner can enter.

Default MTU

This field is available if you selected the Enable PWResiliency check box and if the Signaling is LDP
in the General settings.

Revert time (sec)—Revert time for redundant Layer 2 circuits and VPLS pseudowires.

Default: 5 seconds

Range: 0 through 65,535 seconds

Revert time (sec)

This field is available if you selected the EnablePWResiliency check box and if theSignaling is LDP,
in the General settings.

Switch Over Delay (sec)—Delay to wait before the backup pseudowire takes over.

Default: 0 second

Range: 0 through 180 seconds

Switch Over Delay (sec)

Theoptionsavailable in theVLANnormalizationarebasedon thevalueset for theEthernet interface.VLANNormalization

This field is available if you selected the Static pseudowire check box in the General settings. By
default, the outgoing label selection is limited to manual.

Outgoing label selection
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The following table presents the available VLAN normalization options:

VLANNormalizationCustomer Traffic TypeEthernet Option

Normalization not required

Normalization to Dot1q tag

Normalization to QinQ tags

N/Aport-port

Swap

Normalize to None

Normalization to Dot1q tag

Normalization to QinQ tags

Transport single vlandot1q

Normalization not requiredTransport vlan range

Swap

Normalize to None

Normalization to Dot1q tag

Normalization to QinQ tags

Transport all trafficqinq

Swap

Normalize to None

Normalization to Dot1q tag

Normalization to QinQ tags

Transport single vlan

Normalization not requiredTransport vlan range

(Identical to qinq)(Identical to qinq)Asymmetric

2. Click Finish to complete the service definition.
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Specifying Connectivity InformationWhen Signaling Is BGP

To specify connectivity between sites across the network when signaling is BGP, fill in

the fields in the Connectivity window:

1. When the signaling type is BGP, fill in the fields in the Connectivitywindow.

• Route Distinguisher—Identifier attached to a route, enabling you to distinguish to

which VPN the route belongs. Each routing instancemust have a unique route

distinguisher associated with it.

Range: 1.1.1.1:1 through 255.255.255.254:65535, or 1:1 through 65535:4294967295

• Route Target—Allows you to distribute VPN routes to only the routers that need

them.

Range: 1.1.1.1:1 through 255.255.255.254:65535, or 1:1 through 65535:4294967295

• Default MTU (Bytes)—The default MTU established by the system.

• MTU range (Bytes)—Specify the range, in bytes, for the MTU.

• VLANnormalization—Theoptionsavailable in theVLANnormalization fieldarebased

on the value set for the Ethernet interface. The following table presents the options.
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VLANNormalizationCustomer Traffic TypeEthernet Option

Normalization not required

Normalization to Dot1q tag

Normalization to QinQ tags

N/Aport-port

Swap

Normalize to None

Normalization to Dot1q tag

Normalization to QinQ tags

Transport single vlandot1q

Normalization not requiredTransport vlan range

Swap

Normalize to None

Normalization to Dot1q tag

Normalization to QinQ tags

Transport all trafficqinq

Swap

Normalize to None

Normalization to Dot1q tag

Normalization to QinQ tags

Transport single vlan

Normalization not requiredTransport vlan range

(Identical to qinq)(Identical to qinq)Asymmetric

NOTE: For a description of how the Network Activate software
manipulates VLANs, see “Understanding VLANManipulation
(Normalization and VLANMapping) on Ethernet Services” on page 32.

2. Click Finish to complete the service definition.

Creating aMultipoint-to-Multipoint VPLS Service Definition

This procedure provides the steps to create a definition for a multipoint-to-multipoint

VPLS service.

The standard service definitions that came with your initial software installation are

designed to be appropriate for most requirements. You can also create a customized

service definition—for example, to set different bandwidth limits on the service than

those offered in the standard service definitions.
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When the new service definition is complete and published, network operators or service

provisioners can use the completed service definition as a base for creating and then

activating multipoint-to-multipoint Ethernet services on the network.

The windows appear in the order stated. You can, however, perform these steps in any

order by accessing them through the task list in the right panel. If the panel is not visible,

click the snap tool on the right side of the main display area.

To create amultipoint-to-multipoint Ethernet service definition, complete these tasks,

in the order shown. As you finish a section and click Next, the attributes from the current

window are saved and the next window in the sequence appears.

• Specifying General Information for Multipoint-to-Multipoint VPLS Service

Definitions on page 119

• SpecifyingUNISettings forMultipoint-to-MultipointVPLSServiceDefinitionsonpage 122

• UNI Settings for Port-to-Port Interfaces in VPLS Services on page 122

• UNI Settings for 802.1Q Interfaces in VPLS Services on page 124

• UNI Settings for Q-in-Q Interfaces in VPLS Services on page 127

• UNI Settings for Services with Flexible VLAN Tagging (Asymmetric Interface

Types) on page 131

• Specifying Connectivity and MAC Security Information on page 134

• Specifying Advanced Settings on page 137
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Specifying General Information for Multipoint-to-Multipoint VPLS Service
Definitions
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To specify the general information for a multipoint-to-multipoint service definition, in

the Network Activate task pane, select Service Design >Manage Service Definitions >

Create VPLS Service Definition

The Generalwindow appears.

To specify the general information for a multipoint-to-multipoint service definition:

1. Fill in the fields on the Generalwindow.

ActionField

Type a name for the service definition.Name

SelectMultipoint-to-Multipoint Ethernet (VPLS)Service type
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ActionField

Select a signaling type:

• BGP— If BGP signaling is selected, the following fields are available in the Connectivity window:
• Route target

• Route distinguisher

• VLAN normalization

• AllowMultihoming

• Mac Security Settings

• LDP—If LDP signaling is selected, the following fields are available in the Connectivity window:
• Auto Discovery

• Route target, if Auto Discovery is enabled

• Route distinguisher, if Auto Discovery is enabled

• VPLS ID, if Auto Discovery is disabled

• VPN ID, if Auto Discovery is enabled

• VLAN normalization

• Mac Security Settings

NOTE: You cannot edit the Signaling type in the service order.

Signaling

Type a brief description or other comment that you want to appear in the Service Definition table.

Range: 0 through 200 characters. Space and special characters are allowed.

Comments
(Optional)

When you enable QoS in the service definition, youmust specify a QoS profile in the service order to
classify traffic into defined service groups to provide the special treatment of traffic across the network
service. For example, voice traffic can be sent across certain links, and data traffic can use other links.

Enable QoS

Select this check box to create the link into Layer 3. If this check box is selected, the available Ethernet
option in the UNI Settings window are:

• dot1q

• qinq

Enable L3 Access

Select this check box to enable a pseudowire connection by configuring static values.

NOTE: The Enable Static PW Labels check box is enabled only when the signaling type is LDP.

Enable Static PW
Labels

(Optional) To include a service template for the service, select a service template from the Service
Template list.

The selected service template appears in the Default Service Template field.

You can select one or more service templates as the default service template. By default, the default
service templates are attached to the endpoints.

NOTE: You cannot add or delete a service template while creating a service order.

The remaining service templates on the Service Template list are termed as optional service templates.
You can attach the optional service templates to the endpoints on a need basis.

In the View Service Definition Details window, the value for the default service template in the Default
Service Template column is True.

For instructions on creating a service template, see “Creating a Service Template” on page 409.

Service Template
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2. Click Next to save the information and continue with UNI Settings.

Specifying UNI Settings for Multipoint-to-Multipoint VPLS Service Definitions

In this step, you provide the UNI attributes for this service definition. The attributes you

set depend on the type of interface you are using in this VPLS service definition. The

following interface types are supported:

• ports

• 802.1Q interfaces

• Q-in-Q interfaces

• asymmetric interface

UNI Settings for Port-to-Port Interfaces in VPLS Services

TheUNISettingswindowprovides fourexpandingorcollapsingpanels:TrafficTreatment,

Interface Settings, MTU Settings, and Bandwidth Settings.

To specify the UNI Settings for Port-to-Port interfaces:

1. Fill in the fields on the UNI Settingswindow.

ActionField

Traffic Treatment Settings

Select port-port from the list.

The Ethernet option you choose determines the other options you can select and specify on the
page.

Ethernet option
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ActionField

Select N/A. For port-to-port services, all traffic is always transported.Customer traffic type

In port-to-port services, all traffic and all VLANs on one port are transported to all other ports.VLAN ID selection

To allow the service provisioner to override the MTU setting, select the check box.Editable in Service Order

Interface Settings

Selectethernet-vpls, theonly validphysical interfaceencapsulationmethodallowed forport-to-port
services.

Physical IF encapsulation

You can not select a choice in this field because it is not relevant to port-to-port services.Logical IF encapsulation

MTU Settings

The default MTU value is 1522 bytes.Default MTU (Bytes)

Specify the low and high values to define the MTU range that you want to define.

The default range is 1522 through 9192 bytes.

MTURange (Bytes)

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased
If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 1.

• Line Rate Based
If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limitingcheckbox.

Calculate Burst Size

The following illustration shows the Calculate Burst-Size panel parameters if you select the Line Rate Based option.

Bandwidth Settings

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are not available in the service definition when QoS Design software
is installed.

Enable rate limiting
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ActionField

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Default bandwidth (Mbps)

Specify the minimum bandwidth value in Kbps.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 12 on page 124

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Increment (Kbps)

The following table lists theMax Bandwidth (Mbps) for the M Series, MX Series, and

ACX Series Routers:

Table 12: MaximumBandwidth for M Series, MX Series, and ACX Series Routers

ACX 2000
MX Series Non-3D
PICMX Series 3D PICM Series IQ2 PICM Series IQ2E PIC

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

100,000
Mbps or
100 Gbps

100,000
Mbps or
100 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

32,000
Mbps or
32 Gbps

32,000
Mbps or
32 Gbps

2. Click Next to continue with Connectivity settings.

UNI Settings for 802.1Q Interfaces in VPLS Services

To specify the UNI Settings for 802.1Q interfaces:

1. Fill in the fields on the UNI Settingswindow.

ActionField

Traffic Treatment Settings
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ActionField

Select dot1q from the list.

The Ethernet option you choose determines the other options you can select and specify on the
page.

Ethernet option

Single VLAN is the only option for 802.1Q interface types.

Select Transport single vlan to transport the traffic for a specific VLAN across the network. When
you select this option, the service provisioner is prompted for the VLAN-IDwhen creating a service
order based on this service definition. You need to specify theOuter Tag protocol ID.

Select Transport VLAN range to limit the traffic across the network to a specific range of VLANs.

If you select this option, the service provisioner is prompted for the VLAN-ID range when creating
a service order based on this service definition.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be able
to override this setting.

Customer traffic type

Indicate how the VLAN ID is determined.

• Selectmanually Allows the service provider to specify the VLAN ID. This option is normally used
when no VLAN normalization is applied. Specify the VLAN ID range in VLAN range for manual
input.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting.

• Auto pick This option is normally used when VLAN normalization is applied. Specify the VLAN
ID pool in VLAN range for auto-pick.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting.

VLAN ID selection

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input
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ActionField

Select the outer tag protocol ID if the Customer traffic type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPID) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x9100
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x88a8
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x8100

Outer Tag protocol ID

Toallow the service provisioner to override theMTUsetting, select the check box for those options.Editable in Service Order

Interface Settings

Select thedefault physical encapsulation scheme tobeusedby serviceordersbasedon this service
definition. We recommend you select flexible-ethernet-services.

Physical IF encapsulation

Constrainedbyyour selection in thePhysical IFencapsulationbox. If you selected the recommended
physical encapsulation mode of flexible-ethernet-services, then your only option is to select
vlan-vpls for the logical encapsulation method.

Logical IF encapsulation

In the MTU range fields, type the lowest and highest values for MTU for each UNI.

NOTE: To allow the service provisioner to override theMTU setting, select Editable inServiceOrder
and, in the MTU range fields, type the highest and lowest MTU values.

MTUSettings

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased
If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 1.

• Line Rate Based
If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limitingcheckbox.

Calculate Burst Size
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ActionField

The following illustration shows the Calculate Burst-Size panel parameters if you select the Line Rate Based option.

Bandwidth Settings

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are not available in the service definition when QoS Design software
is installed.

Enable rate limiting

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Default bandwidth (Mbps)

Specify the minimum bandwidth value in Kbps.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 12 on page 124

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps/100Gbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Increment (Kbps)

2. Click Next to continue with connectivity settings.

UNI Settings for Q-in-Q Interfaces in VPLS Services

To specify the UNI Settings for q-in-q interfaces:

1. Fill in the fields on the UNI Settingswindow.

ActionField

Traffic Treatment Settings
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ActionField

Select qinq from the list.

The window expands to include options specific to Q-in-Q interfaces

Ethernet option

Transport all traffic Transports the traffic from all VLANs across the network.When you select this
option, the service provisioner is prompted for the VLAN-ID when creating a service order based
on this service definition. You need to specify only theOuter Tag protocol ID.

Transport single vlanTransports traffic for a specific VLAN across the network. You need to specify
bothOuter Tag protocol ID and Inner Tag protocol ID.

Transport VLAN range Limits the traffic across the network to a specific range of VLANs.

If you select this option, the service provisioner is prompted for the VLAN-ID range when creating
a service order based on this service definition. You need to specify bothOuter Tag protocol ID and
Inner Tag protocol ID.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be able
to override this setting.

Customer traffic type

Indicate how the VLAN ID is selected during service order creation.

• Selectmanually Allows the service provider to specify the VLAN ID. This option is normally used
when no VLAN normalization is applied.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting. Specify the VLAN ID range in VLAN range for manual input.

• Auto pick This option is normally used when VLAN normalization is applied. Specify the VLAN
ID pool in VLAN range for auto-pick.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting.

VLAN ID selection

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick:

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input
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ActionField

Select the outer tag protocol ID if the Customer traffic type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPID) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x9100
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x88a8
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x8100

Outer Tag protocol ID

Select the inner tag protocol ID:

• 0x88a8

• 0x8100

• 0x9100

NOTE: You cannot specify the Inner Tag protocol ID if the Customer traffic type is Transport single
VLAN.

Inner Tag protocol ID

Toallow the service provisioner to override theMTUsetting, select the check box for those options.Editable in Service Order

Interface Settings

Select thedefault physical encapsulation scheme tobeusedby serviceordersbasedon this service
definition. We recommend you select flexible-ethernet-services.

Physical IF encapsulation

Constrainedbyyour selection in thePhysical IFencapsulationbox. If you selected the recommended
physical encapsulation mode of flexible-ethernet-services, then your only option is to select
vlan-vpls for the logical encapsulation method.

Logical IF encapsulation

In the MTU range fields, type the lowest and highest values for MTU for each UNI

NOTE: To allow the service provisioner to override theMTU setting, select Editable inServiceOrder
and, in the MTU range fields, type the highest and lowest MTU values that the service provisioner
can type.

MTUSettings

Calculation of Burst-Size
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ActionField

Select the preferred option for calculating the burst size:

• MTUBased
If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 1.

• Line Rate Based
If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limitingcheckbox.

Calculate Burst Size

The following illustration shows the Calculate Burst-Size panel parameters if you select the Line Rate Based option.

Bandwidth Settings

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are not available in the service definition when QoS Design software
is installed.

Enable rate limiting

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Default bandwidth (Mbps)

Specify the minimum bandwidth value in Kbps.

Default: 1000 KbpS

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 12 on page 124

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100000 Kbps

Increment (Kbps)
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2. Click Next to continue with Connectivity settings.

UNI Settings for Services with Flexible VLAN Tagging (Asymmetric Interface
Types)

Youcanspecify theEthernet optionasymmetric tagdepth to createa service that includes

any combination of port-based interfaces, 802.1Q interfaces, and Q-in-Q interfaces.

To specify the UNI Settings for q-in-q interfaces:

1. Fill in the fields on the UNI Settingswindow.

ActionField

Traffic Treatment Settings

Select asymmetric tag depth from the list.Ethernet option

Transport all traffic Transports the traffic from all VLANs across the network.When you select this
option, the service provisioner is prompted for the VLAN-ID when creating a service order based
on this service definition. You need to specify only theOuter Tag protocol ID and Inner Tag protocol
ID.

Transport single vlanTransports traffic for a specific VLAN across the network. You need to specify
bothOuter Tag protocol ID and Inner Tag protocol ID.

Transport VLAN range Limits the traffic across the network to a specific range of VLANs. You need
to specify bothOuter Tag protocol ID and Inner Tag protocol ID.

If you select this option, the service provisioner is prompted for the VLAN-ID range when creating
a service order based on this service definition.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be able
to override this setting.

Customer traffic type

Indicate how the VLAN ID is selected during service order creation.

• Selectmanually Allows the service provider to specify the VLAN ID. This option is normally used
when no VLAN normalization is applied. Specify the VLAN ID range in VLAN range for manual
input.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting.

• Auto pick This option is normally used when VLAN normalization is applied. Specify the VLAN
ID pool in VLAN range for auto-pick.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting. Specify the VLAN ID pool in VLAN range for auto-pick.

VLAN ID selection

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick:

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input
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ActionField

Select the outer tag protocol ID if the Customer traffic type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPID) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x9100
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x88a8
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x8100

Outer Tag protocol ID

Select the inner tag protocol ID:

• 0x88a8

• 0x8100

• 0x9100

NOTE: You cannot specify the Inner Tag protocol ID if the Customer traffic type is Transport all
traffic.

Inner Tag protocol ID

Toallow the service provisioner to override theMTUsetting, select the check box for those options.Editable in Service Order

Interface Settings

Select thedefault physical encapsulation scheme tobeusedby serviceordersbasedon this service
definition. We recommend you select flexible-ethernet-services.

For multipoint-to-multipoint services with Q-in-Q interfaces, the only option is
flexible-ethernet-services

Physical IF encapsulation

Constrainedbyyour selection in thePhysical IFencapsulationbox. If you selected the recommended
physical encapsulation mode of flexible-ethernet-services, then your only option is to select
vlan-vpls for the logical encapsulation method.

Logical IF encapsulation

In the MTU range fields, type the lowest and highest values for MTU that the service provisioner
can type, for each UNI

NOTE: To allow the service provisioner to override theMTU setting, select Editable inServiceOrder
and, in the MTU range fields, type the highest and lowest MTU values that the service provisioner
can type.

MTUSettings

Calculation of Burst-Size
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ActionField

Select the preferred option for calculating the burst size:

• MTUBased
If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 1.

• Line Rate Based
If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limitingcheckbox.

Calculate Burst Size

The following illustration shows the Calculate Burst-Size panel parameters if you select the Line Rate Based option.

Bandwidth Settings

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are not available in the service definition when QoS Design software
is installed.

Enable rate limiting

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Default bandwidth (Mbps)

Specify the minimum bandwidth value in Kbps.

Default: 1000 KbpS

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 12 on page 124

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Increment (Kbps)
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2. Click Next to continue with Connectivity settings.

Specifying Connectivity andMAC Security Information

In this step, you specify the attributes that define the connectivity among remote sites

across the service provider network and the service security. The following is a sample

Connectivitywindow.
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To specify connectivity between sites across the network:

1. Fill in the fields in the Connectivitywindow.

ActionField

Choose one of the following options from the list:Route target

• Auto pick

• Select manually

Select a route distinguisher option:Route distinguisher

• Selectmanually—The service provider specifies the route distinguisher.

• Auto pick—The route distinguisher is selected automatically.

To override this setting in the service order, select the Editable in Service Order check box.

Select a value:VLAN normalization

• Normalize to VLAN all—To preserve customer VLAN IDs (and customer QoS priorities) across
the network.

NOTE: For services that transport a range of VLAN IDs, youmust set VLANNormalization to all.
You cannot transport a range of VLAN IDs without normalization.

• Normalized VLAN none—To preserve no VLAN IDs across the network

• Not normalized—If VLAN IDs are to be providedmanually and are required to match each
endpoint.

• Normalized to Dot1q—To transport only single-tagged frames across the network core. All port,
dot1q , and Q-in-Q traffic is transported across the network.

• Normalized to QinQ—To transport only double-tagged frames across the network core. All port,
dot1q , and Q-in-Q traffic is transported across the network.

• Normalization not required—To specify no normalization for port-to-port services

For more information about VLAN normalization, see “Junos Space Layer 2 Services Overview” on
page 4.

For informationaboutVLANmanipulation, see “UnderstandingVLANManipulation (Normalization
and VLANMapping) on Ethernet Services” on page 32.

This check box is available only if the signaling type is BGP.To enable a service provisioner to define
primary and backupPEdevices in amultihomed group that serves as a single customer site, select
AllowMultihoming.

AllowMultihoming

The Auto Discovery check box is available only if the signaling type is LDP.

NOTE: If theEnableStaticPWLabelscheckbox in theGeneralwindow is selected for LDPsignaling,
then the Auto Discovery check box is disabled in the Connectivity Settings page.

Auto Discovery

The Auto Discovery check box is not available when the signaling type is BGP.

If you select the Auto Discovery check box, the following fields are available:

• Route target

• Route distinguisher

• VPN ID

If you disable the Auto Discovery check box, specify the VPLS ID.
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ActionField

This field is available only if the signaling type is LDP and auto discovery is disabled.

Identifies the virtual circuit identifier used for the VPLS routing instance.

• Autopick

• Select manually

VPLS ID

This field is available only if the signaling type is LDP and auto discovery is enabled.

Identifies the VPN ID associated with the router.

• Autopick

• Select manually

VPN ID

To enableMAC learning, select the check box.MAC learning

Maximum number of MAC addresses learned from an interface.

Range: 1 through 131071 MAC addresses per interface

InterfaceMAC limit

To enableMAC statistic, select the check box.MAC statistics

Modify the size of the MAC address table for the bridge domain.

Range: 16 through 1048575

To allow the service provisioner to override the MAC settings, select Editable in Service Order.

MAC table size
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2. ClickNext to save theconnectivity settings. “SpecifyingAdvancedSettings”onpage 137

Specifying Advanced Settings

In this step, you can specify the parameters that define advanced connectivity between

sites across the service provider network. The following illustration shows the Advanced

window.

To specify advanced settings:

1. Fill in the fields as indicated in the table.

ActionField

Select the Include check box for each advanced setting that you want to include in the service
definition.

NOTE: If you select any advanced parameters for a service definition, youmust also select the
Include check box for the Disable tunnel services parameter, and select or clear the Disable tunnel
services check box.

For MX Series devices, if you deploy a VPLS service without selecting the Include check box for
Disable tunnel services parameter, the VPLS service is down. As a work around, you can push the
configuration to each PE device for the service by running the following command:

root@test_device# set chassis fpc 0 pic 1 tunnel-services bandwidth 1g

Include

Enable or disable tunnel-services to specify that traffic for particular VPLS routing instances be
forwarded to specific virtual tunnel (VT) interfaces.

• To enable tunnel-services, clear the Disable tunnel-services check box.

• To disable tunnel-services, select the Disable tunnel-services check box (default).

Disable tunnel services

Enable or disable local switching. In local switching mode, you can terminate multiple Layer 2
circuit pseudowires at a single VPLSmesh group:

• To enable local switching across the network, clear the Disable local-switching check box.

• To disable local switching across the network, select the Disable local-switching check box
(default).

Disable local-switching

In the fast-reroute-priority, specify the reroute priority for a VPLS routing instance:

• HIGH—Set the fast reroute priority for a VPLS routing instance to high. During a fast reroute
event, the router repairs next hops for high-priority VPLS routing instances first.

• MEDIUM—Set the fast reroute priority for a VPLS routing instance to medium. During a fast
rerouteevent, the router repairs nexthops formedium-priorityVPLS instancesafter high-priority
VPLS routing instances but before low-priority VPLS routing instances.

• LOW—Set the fast reroute priority for aVPLS routing instance to low,which is the default. During
a fast reroute event, the router repairs next hops for low-priority VPLS routing instances last.

fast-reroute-priority
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ActionField

Configure the label block size for VPLS labels by using one of the following values.

• 2—Allocate the label blocks in increments of 2. Use this setting for a VPLS domain that has only
two sites with no future expansion plans.

• 4—Allocate the label blocks in increments of 4.

• 8—Allocate the label blocks in increments of 8. This is the default.

• 16—Allocate the label blocks in increments of 16. A label block size of 16 enables you tominimize
the number of routes in the VPLS domain. Use this setting only if the number of routes is the
primary concern.

NOTE: This field is unavailable if the Signaling type is LDP and the Auto discovery is enabled.

Label block size

Selectaconnection-type tospecifywhenaVPLSconnection is takendown,dependingonwhether
the interface for the VPLS routing instance is customer-facing or integrated routing and bridging
(IRB):

• ce—Require that for the VPLS connection to be up, the customer-facing interface for the VPLS
routing instancemust also be up. If the customer-facing interface fails, the VPLS connection is
taken down. This is the default.

• irb—AllowaVPLSconnection to remain up so long as an IRB interface is configured for theVPLS
routing instance.

NOTE: This field is unavailable if the Signaling type is LDP and the Auto discovery is enabled.

Connectivity type

By default, each advanced setting that you include in the service definition can be edited in the
service order. To prevent the service provisioner from overriding an advanced setting in the service
order, clear the Editable in Service Order check box.

Editable in Service Order

2. Click Finish to save the advanced settings.

The service definition is complete.

Creating a Point-to-Multipoint VPLS Service Definition

Thisprocedureprovides thesteps tocreateadefinition for apoint-to-multipointEthernet

service. Point-to-multipoint services are also known as hub and spoke services.

The standard service definitions that came with your initial software installation are

designed to be appropriate for most requirements. You can also create a customized

service definition—for example, to set different bandwidth limits on the service than

those offered in the standard service definitions.

When the new service definition is complete and published, network operators or service

provisioners can use the completed service definition as a base for creating and then

activating point-to-multipoint Ethernet services on the network.
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The windows appear in the order stated. You can, however, perform these steps in any

order by accessing them through the task list in the right panel. If the panel is not visible,

click the snap tool on the right side of the main display area.

• Specifying General Information for Point-to-Multipoint VPLS Service

Definitions on page 140

• Specifying UNI Settings on page 143

• Specifying Connectivity and MAC Security Information on page 160

• Specifying Advanced Settings on page 163
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Specifying General Information for Point-to-Multipoint VPLS Service Definitions
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In the Network Activate task pane, select Service Design >Manage Service Definitions >

Create VPLS Service Definition. The General settings window appears.

To specify the general information for a point-to-multipoint service definition:

1. Fill in the fields in the Generalwindow.

ActionField

Type a name for the service definition.Name

Select Point-to-Multipoint Ethernet (VPLS)Service type
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ActionField

Select signaling type:

• BGP— If BGP signaling is selected, the following fields are available in the connectivity window:
• Route target

• Route distinguisher

• VLAN normalization

• AllowMultihoming

• Mac Security Settings

• VCID, if Enable PWExtension is enabled

• LDP—If LDP signaling is selected, the following fields are available in the connectivity window:
• Auto Discovery

• Route target, if Auto Discovery is enabled

• Route distinguisher, if Auto Discovery is enabled

• VPLS ID, if Auto Discovery is disabled

• VPN ID, if Auto Discovery is enabled

• VLAN normalization

• Mac Security Settings

NOTE: The Signaling is not editable in the service order.

Signaling

Type a brief description or other comment that you want to appear in the Service Definition table.Comments (Optional)

When you enable QoS in the service definition, youmust specify a QoS profile in the service order to
classify traffic into defined service groups toprovide the special treatment of traffic across the network
service. For example, voice traffic can be sent across certain links, and data traffic can use other links.

Enable QoS

Select this check box to create the link into Layer 3. If you enable the Layer 3 access, the available
Ethernet option in the UNI Settings are:

• port-port

• dot1q

• qinq

• asymmetric tag depth

Enable L3 Access

Select this check box to enable pseudowire extension. You cannot edit this check box in the service
order.

Enable PWExtension

Select this check box to enable resiliency. You cannot edit this field in the service order.

If theSignaling type is BGP, you need to select the EnablePWExtension check box to enable the Enable
PWResiliency check box.

For more information of pseudowire redundancy, see “Redundant Pseudowires for Layer 2 Circuits
and VPLS” on page 38.

Enable PWResiliency

Select this check box to enable a pseudowire connection by configuring static values.

NOTE: The Enable Static PW Labels check box is enabled for both signaling types: LDP and BGP.

When the signaling type is BGP, selection of this checkbox enables the Enable PWResiliency checkbox
and automatically selects the Enable PWExtension checkbox.

Enable Static PW
Labels
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ActionField

(Optional) To include a service template for the service, select a service template from the Service
Template list.

The selected service template appears in the Default Service Template field.

You can select one or more service templates as the default service template. By default, the default
service templates are attached to the endpoints.

NOTE: You cannot add or delete a service template while creating a service order.

The remaining service templates on theServiceTemplate list are termedas optional service templates.
You can attach the optional service templates to the endpoints on a need basis.

In the View Service Definition Details window, the value for the default service template in the Default
Service Template column is True.

For instructions on creating a service template, see “Creating a Service Template” on page 409.

Service Template
Definition

2. ClickNext to save the information.Continuewith “SpecifyingUNISettings”onpage 143.

Specifying UNI Settings

In this step, youprovide theUNI serviceattributes for this servicedefinition. Theattributes

you set depend on whether you are setting attributes for ports, 802.1Q interfaces, or

Q-in-Q interfaces:

• Specifying UNI Settings for Port-to-Port Services on page 143

• Specifying UNI Settings for Services with 802.1Q Interface Types on page 147

• Specifying UNI Settings for Services with Q-in-Q Interface Types on page 151

• SpecifyingUNISettings forServiceswithFlexibleVLANTagging (Asymmetric Interface

Types) on page 156

Specifying UNI Settings for Port-to-Port Services

NOTE: You can select the port-port option only for services that are not
normalized. That is, youmust select Not Normalizedwhen specifying the

connectivity.
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To set UNI attributes for port UNIs:

1. Fill in the fields as indicated in the table.

ActionField

Traffic Treatment Settings

Select port-port from the drop-down list.

The Ethernet option you choose determines the other options you can select and specify on the
page.

Ethernet option

Select N/A. For port-to-port services, all traffic is always transported.Customer traffic type

The VLAN ID cannot be selected. In port-to-port services, all traffic and all VLANs on one port are
transported to all other ports.

VLAN ID selection

To allow the service provisioner to override the MTU setting, select the check box.Editable in Service Order

Interface Settings

In the Physical IF encapsulation box, select ethernet-vpls, which is the only valid physical interface
encapsulation method for port-to-port services.

The Logical IF encapsulation field cannot be selected because it is not relevant to port-to-port
services.

Physical IF encapsulation

You cannot select a choice in this field because it is not relevant to port-to-port services.Logical IF encapsulation
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ActionField

LDP PWExtension Settings

NOTE: The LDP PWExtension Settings is available only if you have selected the Enable PWExtension check box in the General
window.

In the Physical IF encapsulation box, select ethernet-ccc, which is the only valid physical interface
encapsulation method for port-to-port services.

Physical IF encapsulation

You can not select a choice in this field because it is not relevant to port-to-port services.Logical IF encapsulation

In the MTU range boxes, type the lowest and highest values for MTU that the service provisioner
can type.

MTUSettings

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased

If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 1.

• Line Rate Based

If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limitingcheckbox.

Calculate Burst Size

The following illustration shows the Calculate Burst-Size panel parameters if you select the Line Rate Based option.

Bandwidth Settings

The following illustration shows the Bandwidth Settings panel, which appears if you do not select the Enable QoS check box
in the preceding General settings window.
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ActionField

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are not available in the service definition when QoS Design software
is installed.

Enable rate limiting

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Default bandwidth (Mbps)

Specify the minimum bandwidth value in Kbps.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 11 on page 104

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Increment (Kbps)

The following table lists theMax Bandwidth (Mbps) for the M Series, MX Series, and

ACX Series Routers:

Table 13: MaximumBandwidth for M Series, MX Series, and ACX Series Routers

ACX 2000
MX Series Non-3D
PICMX Series 3D PICM Series IQ2 PICM Series IQ2E PIC

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

100,000
Mbps or
100 Gbps

100,000
Mbps or
100 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

32,000
Mbps or
32 Gbps

32,000
Mbps or
32 Gbps

2. Click Next to save the UNI settings. Continue with “Specifying Connectivity and MAC

Security Information” on page 160.
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Specifying UNI Settings for Services with 802.1Q Interface Types

To set UNI attributes for 802.1Q interfaces:

1. Fill in the fields as indicated in the table.

ActionField

Traffic Treatment Settings

Select dot1q from the drop-down list.

The Ethernet option you choose determines the other options you can select and specify on the
page.

Ethernet option
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ActionField

Select a traffic type to restrict the traffic that canbe transportedacross thenetwork for the service:

• SelectTransport singlevlan to transport the traffic for a specificVLANacross thenetwork. Single
VLAN is the only option for 802.1Q interface types. You need to specify theOuter Tag protocol
ID.

NOTE: For an interface, youmust configure a physical port with the possible Tag Protocol
Identifiers (TPID) either manually or through a template. Otherwise, the service creation fails
for all TPIDs except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x9100
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x88a8
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x8100

• Select Transport vlan range to transport the traffic for a range of VLANs across the network.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be able
to override this setting.

Customer traffic type

In the VLAN ID selection box, specify how the VLAN ID is determined:

• To allow the service provider to specify the VLAN ID, chooseSelectmanually. This option is used
typically when no VLAN normalization is applied.

Specify the VLAN ID range in VLAN range for manual input.

Range: 1 through 4094

To enable the service provisioner to override this setting, select Editable in Service Order.

• To cause the VLAN ID to be selected automatically from the VLAN ID pool, select Auto pick.
This option is used typically when VLAN normalization is applied.

Specify the VLAN ID pool in VLAN range for auto-pick

Range: 1 through 4094

To enable the service provisioner to override this setting in a service order, select Editable in
Service Order.

To enable the service provisioner to override this setting in a service order, select Editable in Service
Order.

VLAN ID selection

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input
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ActionField

Select the outer tag protocol ID if the Customer traffic type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPID) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x9100
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x88a8
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x8100

Outer Tag protocol ID

Toallow the service provisioner to override theMTUsetting, select the check box for those options.Editable in Service Order

Interface Settings

In the Physical IF encapsulation box, select the default physical encapsulation scheme to be used
by service orders based on this service definition. For point-to-multipoint services with 802.1Q
interfaces, the only option is flexible-ethernet-services.

Physical IF encapsulation

The Logical IF encapsulation field is constrained by your selection in the Physical IF encapsulation
field. For the physical encapsulation mode of flexible-ethernet-services, your only option is to
select vlan-vpls for the logical encapsulation method.

Logical IF encapsulation

LDP PWExtension Settings

NOTE: The LDP PWExtension Settings is available only if you have selected the Enable PWExtension check box in the General
window.

In the Physical IF encapsulation box, select one of the following options:

• vlan-ccc

• extended-vlan-ccc

• flexible-ethernet-services

Physical IF encapsulation

The Logical IF encapsulation field is constrained by your selection in the Physical IF encapsulation
field.

For the physical encapsulation mode of vlan-ccc or flexible-ethernet-services, your only option is
to select vlan-ccc for the logical encapsulation method.

For the physical encapsulation mode of extended-vlan-ccc, your only option is to select
extended-vlan-ccc for the logical encapsulation method.

Logical IF encapsulation

In the Default MTU box, specify the MTU for each UNI.

To allow the service provisioner to override the MTU setting, select Editable in Service Order and,
in the MTU range boxes, type the highest and lowest MTU values that the service provisioner can
type.

MTUSettings
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ActionField

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased

If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 1.

• Line Rate Based

If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limitingcheckbox.

Calculate Burst Size

The following illustration shows the appearance of the Calculate Burst-Size panel parameters if you select the Line Rate Based
option.

Bandwidth Settings

The following illustration shows the Bandwidth Settings panel, which appears if you do not select the Enable QoS check box
in the preceding General settings window.

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are not available in the service definition when QoS Design software
is installed.

Enable rate limiting

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100000Mbps

Default bandwidth (Mbps)
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ActionField

Specify the minimum bandwidth value in Kbps.

Default: 1000 Kbps

Range: 64 Kbps through 100000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 11 on page 104

Default: 100 Mbps

Range: 1 Mbps through 100000Mbps/100Gbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100000 Kbps

Increment (Kbps)

2. Click Next to save the UNI settings. Continue with“Specifying Connectivity and MAC

Security Information” on page 160.

Specifying UNI Settings for Services with Q-in-Q Interface Types

To set UNI attributes for Q-in-Q interfaces:

1. Fill in the fields as indicated in the table.

ActionField

Traffic Treatment Settings
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ActionField

Select qinq from the drop-down list.

The window expands to include options specific to Q-in-Q interfaces.

Ethernet option

In the Customer traffic type box:

• Select Transport all traffic to transport the traffic from all VLANs across the network. You need
to specify only theOuter Tag protocol ID.

NOTE: For an interface, youmust configure a physical port with the possible Tag Protocol
Identifiers (TPID) either manually or through a template. Otherwise, the service creation fails
for all TPIDs except 0x8100.

• SelectTransport singlevlan to transport the traffic for a specificVLANacross thenetwork. Single
VLAN is the only option for 802.1Q interface types. You need to specify theOuter Tag protocol
ID and the Inner Tag protocol ID.

• Select Transport vlan range to limit the traffic across the network to a specific range of VLANs.

If you select this option, the service provisioner will be prompted for the VLAN-ID range when
creating a service order based on this service definition. You need to specify theOuter Tag
protocol ID and the Inner Tag protocol ID.

Customer traffic type

In the VLAN ID selection box, specify how the service VLAN ID is set during service order creation:

• To cause the provisioning software to automatically select the service VLAN ID from the VLAN
ID pool, select Auto pick. This option is used typically when no VLAN normalization is applied.

Specify the VLAN ID pool in VLAN range for auto-pick

Range: 1 through 4094

• To allow the service provisioner to specify the service VLAN ID, choose Selectmanually. This
option is used typically when VLAN normalization is applied.

Specify the VLAN ID range in VLAN range for manual input.

Range: 1 through 4094

To enable the service provisioner to override this setting, select the Editable in Service Order check
box.

VLAN ID selection

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick:

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input
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ActionField

Select the outer tag protocol ID if the Customer traffic type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPID) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x9100
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x88a8
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x8100

Outer Tag protocol ID

Select the inner tag protocol ID:

• 0x88a8

• 0x8100

• 0x9100

NOTE: You cannot specify the Inner Tag protocol ID if the Customer traffic type is Transport single
VLAN.

Inner Tag protocol ID

Toallow the service provisioner to override theMTUsetting, select the check box for those options.Editable in Service Order

Interface Settings

In the Physical IF encapsulation box, select the default physical encapsulation scheme to be used
by service orders based on this service definition. For point-to-multipoint services with Q-in-Q
interfaces, the only option is flexible-ethernet-services.

Physical IF encapsulation

The Logical IF encapsulation field is constrained by your selection in the Physical Interface
Encapsulation field. For the physical encapsulation mode of flexible-ethernet-services, your only
option is to select vlan-vpls for the logical encapsulation method.

Logical IF encapsulation

LDP PWExtension Settings

NOTE: The LDP PWExtension Settings is available only if you have selected the Enable PWExtension check box in the General
window.

In the Physical IF encapsulation box, select one of the following options:

• vlan-ccc

• extended-vlan-ccc

• flexible-ethernet-services

Physical IF encapsulation
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ActionField

The Logical IF encapsulation field is constrained by your selection in the Physical IF encapsulation
field.

For the physical encapsulation mode of vlan-ccc or flexible-ethernet-services, your only option is
to select vlan-ccc for the logical encapsulation method.

For the physical encapsulation mode of extended-vlan-ccc, your only option is to select
extended-vlan-ccc for the logical encapsulation method.

Logical IF encapsulation

In the Default MTU box, specify the MTU for each UNI.

To allow the service provisioner to override the MTU setting, select the Editable in Service Order
check box and, in the MTU range boxes, type the lowest and highest values for the MTU that the
service provisioner can type.

MTUSettings

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased

If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 1.

• Line Rate Based

If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limitingcheckbox.

Calculate Burst Size

The following illustration shows the Calculate Burst-Size panel parameters if you select the Line Rate Based option.

Bandwidth Settings

The following illustration shows the Bandwidth Settings panel, which appears if you do not select the Enable QoS check box
in the preceding General settings window.
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ActionField

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are not available in the service definition when QoS Design software
is installed.

Enable rate limiting

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100000Mbps

Default bandwidth (Mbps)

Specify the minimum bandwidth value in Kbps.

Default: 1000 Kbps

Range: 64 Kbps through 100000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 11 on page 104

Default: 100 Mbps

Range: 1 Mbps through 100000Mbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100000 Kbps

Increment (Kbps)

2. Click Next to save the UNI settings. Continue with“Specifying Connectivity and MAC

Security Information” on page 160.
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Specifying UNI Settings for Services with Flexible VLAN Tagging (Asymmetric Interface
Types)

Youcanspecify theEthernetoptionasymmetric tagdepth to createaservice that includes

any combination of port-based interfaces, 802.1Q interfaces, and Q-in-Q, interfaces.

To set UNI attributes for asymmetric interfaces:

1. Fill in the fields as indicated in the table.

ActionField

Traffic Treatment Settings

Select asymmetric tag depth from the drop-down list.Ethernet option

In the Customer traffic type box:

• Select Transport all traffic to transport the traffic from all VLANs across the network. You need
to Specify only theOuter Tag protocol ID.

NOTE: For an interface, youmust configure a physical port with the possible Tag Protocol
Identifiers (TPID) either manually or through a template. Otherwise, the service creation fails
for all TPIDs except 0x8100.

• SelectTransport singlevlan to transport the traffic for a specificVLANacross thenetwork. Single
VLAN is the only option for 802.1Q interface types. You need to specify theOuter Tag protocol
ID and the Inner Tag protocol ID.

• Select Transport vlan range to limit the traffic across the network to a specific range of VLANs.

If you select this option, the service provisioner will be prompted for the VLAN-ID range when
creating a service order based on this service definition. You need to specify theOuter Tag
protocol ID and the Inner Tag protocol ID.

Customer traffic type
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ActionField

In the VLAN ID selection box, specify how the service VLAN ID is set during service order creation:

• To cause the provisioning software to automatically select the service VLAN ID from the VLAN
ID pool, select Auto pick. This option is used typically when no VLAN normalization is applied.

Specify the VLAN ID pool in VLAN range for auto-pick

Range: 1 through 4094

• To allow the service provisioner to specify the service VLAN ID, choose Selectmanually. This
option is used typically when VLAN normalization is applied.

Specify the VLAN ID range in VLAN range for manual input.

Range: 1 through 4094

To enable the service provisioner to override this setting, select the Editable in Service Order check
box.

VLAN ID selection

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick:

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input

Select the outer tag protocol ID if the Customer traffic type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPID) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x9100
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x88a8
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x8100

Outer Tag protocol ID

Select the inner tag protocol ID:

• 0x88a8

• 0x8100

• 0x9100

NOTE: You cannot specify the Inner Tag protocol ID if the Customer traffic type is Transport all
traffic.

Inner Tag protocol ID

Toallow the service provisioner to override theMTUsetting, select the check box for those options.Editable in Service Order

Interface Settings
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ActionField

Select thedefault physical encapsulation scheme tobeusedby serviceordersbasedon this service
definition. We recommend you select flexible-ethernet-services.

For multipoint-to-multipoint services with Q-in-Q interfaces, the only option is
flexible-ethernet-services

Physical IF encapsulation

The Logical IF encapsulation field is constrained by your selection in the Physical Interface
Encapsulation field. For the physical encapsulation mode of flexible-ethernet-services, your only
option is to select vlan-vpls for the logical encapsulation method.

Logical IF encapsulation

LDP PWExtension Settings

NOTE: The LDP PWExtension Settings is available only if you have selected the Enable PWExtension check box in the General
window.

In the Physical IF encapsulation box, select one of the following options:

• vlan-ccc

• extended-vlan-ccc

• flexible-ethernet-services

Physical IF encapsulation

The Logical IF encapsulation field is constrained by your selection in the Physical IF encapsulation
field.

For the physical encapsulation mode of vlan-ccc or flexible-ethernet-services, your only option is
to select vlan-ccc for the logical encapsulation method.

For the physical encapsulation mode of extended-vlan-ccc, your only option is to select
extended-vlan-ccc for the logical encapsulation method.

Logical IF encapsulation

In the Default MTU box, specify the MTU for each UNI.

To allow the service provisioner to override the MTU setting, select the Editable in Service Order
check box and, in the MTU range boxes, type the lowest and highest values for the MTU that the
service provisioner can type.

MTUSettings

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased

If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 1.

• Line Rate Based

If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limitingcheckbox.

Calculate Burst Size
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ActionField

The following illustration shows the Calculate Burst-Size panel parameters if you select the Line Rate Based option.

Bandwidth Settings

The following illustration shows the Bandwidth Settings panel, which appears if you do not select the Enable QoS check box
in the preceding General settings window.

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are not available in the service definition when QoS Design software
is installed.

Enable rate limiting

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100000Mbps

Default bandwidth (Mbps)

Specify the minimum bandwidth value in Kbps.

Default: 1000 Kbps

Range: 64 Kbps through 100000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 11 on page 104

Default: 100 Mbps

Range: 1 Mbps through 100000Mbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100000 Kbps

Increment (Kbps)
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2. Click Next to save the UNI settings. Continue with“Specifying Connectivity and MAC

Security Information” on page 160.

Specifying Connectivity andMAC Security Information

In this step, you specify the attributes that define the connectivity among remote sites

across the service provider network and the service security. The following is a sample

Connectivitywindow.
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To configure connectivity between sites across the network:

1. Fill in the fields in the Connectivitywindow.

ActionField

Choose one of the following options from the list:Route target

• Auto pick

• Select manually

This field is available in either of the following cases:

• The Signaling type is BGP.

• The Signaling type is LDP and Auto Discovery is enabled.

Select a route distinguisher option:Route distinguisher

• Selectmanually—The service provider specifies the route distinguisher.

• Auto pick—The route distinguisher is selected automatically.

To override this setting in the service order, select the Editable in Service Order check box.

This field is available in either of the following cases:

• The Signaling type is BGP.

• The Signaling type is LDP and Auto Discovery is enabled.

Select a value:VLAN normalization

• Normalize to VLAN all—To preserve customer VLAN IDs (and customer QoS priorities) across
the network.

NOTE: For services that transport a range of VLAN IDs, youmust set VLANNormalization to all.
You cannot transport a range of VLAN IDs without normalization.

• Normalized VLAN none—To preserve no VLAN IDs across the network

• Notnormalized—IfVLAN IDsare tobeprovidedmanuallyandare required tomatcheachendpoint

• Normalized to Dot1q—To transport only single-tagged frames across the network core. All port,
dot1q , and Q-in-Q traffic is transported across the network.

• Normalized to QinQ—To transport only double-tagged frames across the network core. All port,
dot1q , and Q-in-Q traffic is transported across the network.

• Normalization not required—To specify no normalization for port-to-port services

For more information about VLAN normalization, see “Junos Space Layer 2 Services Overview” on
page 4.

For informationaboutVLANmanipulation, see “UnderstandingVLANManipulation (Normalization
and VLANMapping) on Ethernet Services” on page 32.

This check box is available only if the signaling type is BGP.To enable a service provisioner to define
primary and backup PE devices in a multihomed group that serves a single customer site, select
AllowMultihoming.

AllowMultihoming
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ActionField

You cannot enable or disable the Auto Discovery check box if you have enabled the Enable PW
Extension or the Enable PWResiliency check boxes.

This check box is available only if the signaling type is LDP.

NOTE: If the Enable Static PW Labels checkbox in the Generalwindow is checked for the LDP
signaling, then the Auto Discovery checkbox is disabled in the Connectivity Settings page.

The AutoDiscovery checkbox is not available on the Connectivity Settings pagewhen the signaling
type is BGP.

On enabling the auto discovery, the following fields are available:

• Route target

• Route distinguisher

• VPN ID

On disabling the auto discovery specify the VPLS ID.

Auto Discovery

This field is available only if the signaling type is LDP and auto discovery is disabled.

Identifies the virtual circuit identifier used for the VPLS routing instance.

• Autopick

• Select manually

VPLS ID

This field is available only if the signaling type is LDP and auto discovery is enabled.

Identifies the VPN ID associated with the router.

• Autopick

• Select manually

VPN ID

This field is available only if the Enable PWResiliency is enabled.

Revert time for redundant Layer 2 circuits and VPLS pseudowires.

Default: 5 seconds

Range: 0 through 65,535 seconds

Revert time (sec)

This field is available only if the Enable PWResiliency is enabled.

Specify the delay to wait before the backup pseudowire takes over.

Default: 0 second

Range: 0 through 180 seconds

Switch Over Delay (sec)

This field is available only if the Service type is point-to-multipoint, the Signaling is BGP, and the
Enable PWExtension is enabled.

The VCID can be either set automatically by the Junos Space software, or it can be set manually
by the service provisioner in the service order.

VCID

To enableMAC learning, select the check box.MAC learning
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ActionField

Maximum number of MAC addresses learned from an interface.

Range: 1 through 131071 MAC addresses per interface

InterfaceMAC limit

To enableMAC statistic, select the check box.MAC statistics

Modify the size of the MAC address table for the bridge domain.

Range: 16 through 1048575

To allow the service provisioner to override the MAC settings, select Editable in Service Order.

MAC table size

2. Click Next to save the connectivity settings and continue with “Specifying Advanced

Settings” on page 137.

Specifying Advanced Settings

In this step, you can specify the parameters that define advanced connectivity between

sites across the service provider network. The following illustration shows the Advanced

window.

To specify advanced settings:

1. Fill in the fields as indicated in the table.

ActionField

Select the Include check box for each advanced setting that you want to include in the service
definition.

NOTE: If you select any advanced parameters for a service definition, youmust also select the
Include check box for the Disable tunnel services parameter, and select or clear the Disable tunnel
services check box.

For MX Series devices, if you deploy a VPLS service without selecting the Include check box for
Disable tunnel services parameter, the VPLS service is down. As a work around, you can push the
configuration to each PE device for the service by running the following command:

root@test_device# set chassis fpc 0 pic 1 tunnel-services bandwidth 1g

Include

Enable or disable tunnel-services to specify that traffic for particular VPLS routing instances be
forwarded to specific virtual tunnel (VT) interfaces.

• To enable tunnel-services, clear the Disable tunnel-services check box.

• To disable tunnel-services, select the Disable tunnel-services check box (default).

Disable tunnel services
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ActionField

Enable or disable local switching. In local switching mode, you can terminate multiple Layer 2
circuit pseudowires at a single VPLSmesh group:

• To enable local switching across the network, clear the Disable local-switching check box.

• To disable local switching across the network, select the Disable local-switching check box
(default).

Disable local-switching

In the fast-reroute-priority, specify the reroute priority for a VPLS routing instance:

• HIGH—Set the fast reroute priority for a VPLS routing instance to high. During a fast reroute
event, the router repairs next hops for high-priority VPLS routing instances first.

• MEDIUM—Set the fast reroute priority for a VPLS routing instance to medium. During a fast
rerouteevent, the router repairs nexthops formedium-priorityVPLS instancesafter high-priority
VPLS routing instances but before low-priority VPLS routing instances.

• LOW—Set the fast reroute priority for aVPLS routing instance to low,which is the default. During
a fast reroute event, the router repairs next hops for low-priority VPLS routing instances last.

fast-reroute-priority

Configure the label block size for VPLS labels by using one of the following values.

• 2—Allocate the label blocks in increments of 2. Use this setting for a VPLS domain that has only
two sites with no future expansion plans.

• 4—Allocate the label blocks in increments of 4.

• 8—Allocate the label blocks in increments of 8. This is the default.

• 16—Allocate the label blocks in increments of 16. A label block size of 16 enables you tominimize
the number of routes in the VPLS domain. Use this setting only if the number of routes is the
primary concern.

NOTE: This field is unavailable if the Signaling type is LDP and the Auto discovery is enabled.

Label block size

Selectaconnection-type tospecifywhenaVPLSconnection is takendown,dependingonwhether
the interface for the VPLS routing instance is customer-facing or integrated routing and bridging
(IRB):

• ce—Require that for the VPLS connection to be up, the customer-facing interface for the VPLS
routing instancemust also be up. If the customer-facing interface fails, the VPLS connection is
taken down. This is the default.

• irb—AllowaVPLSconnection to remain up so long as an IRB interface is configured for theVPLS
routing instance.

NOTE: This field is unavailable if the Signaling type is LDP and the Auto discovery is enabled.

Connectivity type

By default, each advanced setting that you include in the service definition can be edited in the
service order. To prevent the service provisioner from overriding an advanced setting in the service
order, clear the Editable in Service Order check box.

Editable in Service Order

2. Click Finish to save the advanced settings.

The service definition is complete.

Creating a Point-to-Point ATM or TDMPseudowire Service Definition

This procedure provides the steps to create a definition for a point-to-point ATM or TDM

service. The standard service definitions that camewith your initial software installation
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are designed to be appropriate formost requirements. You can also create a customized

service definition—for example, to set different bandwidth limits on the service than

those offered in the standard service definitions.

After the new service definition is complete and published, network operators or service

provisioners can use the completed service definition as a base for creating and then

activating point-to-point ATM or TDM services on the network.

The windows appear in the order shown. You can, however, perform these steps in any

order by accessing them through the task list in the right panel. If the panel is not visible,

click the snap tool on the right side of the main display area.

To create a point-to-point service definition, complete these tasks, in the order shown:

1. Specifying General Information for the ATM or TDM Service on page 166

2. Specifying UNI Settings for ATM and TDM Service Definitions on page 168

3. Specifying UNI Settings for ATM Interfaces on page 168

4. Specifying UNI Settings for TDM Interfaces on page 168

5. Specifying Connectivity Information for an ATM or a TDM Service on page 170
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Specifying General Information for the ATM or TDMService

1. In the Network Activate task pane, select Service Design >Manage Service Definitions

> Create P2P Service Definition.

The first Create Service Definitionwindow appears.

2. In the Name box, type a name for the service definition.

3. Select the signaling type:

• LDP

• BGP

NOTE: If the signaling type is BGP, the Static pseudowire, Enable PW

Resiliency, Enable Multi Segment Pseudowire and the Enable PW access to

L3 VPN network check boxes are not available.

4. (Optional) In the Comments box, type a brief description or other comment that you

want to appear in the Service Definition table.

5. (Optional) To include a service template for the service, select a service template

from the Service Template list.

The selected service template appears in the Default Service Template field.
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You can select one or more service templates as the default service template. By

default, the default service templates are attached to the endpoints.

NOTE: Youcannotaddordeleteaservice templatewhilecreatingaservice
order.

The remaining service templates on the Service Template list are termed as optional

service templates. You can attach the optional service templates to the endpoints

on a need basis.

In theViewServiceDefinitionDetailswindow, thevalue for thedefault service template

in the Default Service Template column is True.

For instructions on creating a service template, see “Creating a Service Template” on

page 409.

6. Select the interface type. If you select TDM or ATM as the interface type, the Enable

PW access to L3 VPN network check box is unavailable.

7. Select the Enable Multi Segment Pseudowire check box to enable multi-segment

pseudowire. This check box is available for LDP signaling only

Amulti-segment pseudowire is a static or dynamically configured set of two or more

contiguous pseudowire segments that behave and function as a single point-to-point

pseudowire. Each end of a multi-segment pseudowire, by definition, terminates on a

T-PE.

NOTE: The number of pseudowire segments that you can stitch is limited
to two.

For more information on point-to-point pseudowire stitching, see “Stitching Two

Point-to-Point Pseudowires” on page 478.

8. Select theStatic pseudowire check box to indicatewhether the point-to-point service

definition is a static pseudowire.

9. To enable the pseudowire resilency, select the Enable PWResiliency check box. For

more information on pseudowire redundancy, see “Redundant Pseudowires for Layer

2 Circuits and VPLS” on page 38.

10. By default, all the events are saved in the OpenNMS database. To isolate the events

related to an interface in the OpenNMS, select the Decouple Service Status FromPort

Status check box.

NOTE: When you select this check box, only the pseudowire traps are
monitored, not the jnxVpnIfVpn traps.

11. Click Next to continue to the Connectivity Settingswindow.
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Specifying UNI Settings for ATM and TDMService Definitions

In this step, youprovide theUNI serviceattributes for this servicedefinition. Theattributes

you set depend on whether you are setting attributes for an ATM or for a TDM interface.

Specifying UNI Settings for ATM Interfaces

To specify the UNI settings for ATM interfaces:

1. Fill in the fields as indicated in the table.

ActionField

Select the type of encapsulation to apply to the interface. Use atm-ccc-cell-relay for ATM cell relay
encapsulation. Use atm-ccc-cell-mux for ATM VC for CCC.

Physical IF
encapsulation

Select the virtual path identifier (VPI).

The combination of the VPI and VCID defines the next destination for a cell in the ATM network.

VPI selection

Select the virtual channel identifier (VCID)—This integer uniquely identifies the virtual circuit that the
service uses.

The VCID can be either set automatically by the Junos Space software, or the service provisioner can
set it manually in the service order. The service definition can force the system to pick the VCID, force
the service provisioner to pick the VCID, or allow the service provisioner to override the settings in the
service definition.

We recommend allocating the VCID automatically; however, service providers with their own systems
for allocating VCIDs may choose themanual setting.

In the previous example, by default, the system picks a VCID from its pool automatically, but allows
the service provisioner to override this value in the service order. Clear the check box to override the
servicedefinition setting. The formexpands to includeanadditional field for entering theVCIDmanually.

VCI selection

The range for the cell bundle size can be 1 through 34.Cell bundle size

2. Click Next to go to the Connectivity Settingswindow.

Specifying UNI Settings for TDM Interfaces
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To specify the UNI settings for TDM interfaces:

1. Select the type of Physical IF encapsulation.

• SAToP—Structure-Agnostic time-divisionmultiplexing (TDM)overPacket (SAToP),

as defined in RFC 4553, Structure-Agnostic TDM over Packet (SAToP) is used for

pseudowire encapsulation for TDM bits (T1, E1). The encapsulation disregards any

structure imposed on the T1 and E1 streams, in particular the structure imposed by

standard TDM framing. SAToP is used over packet-switched networks, where the

provider edge (PE) routers do not need to interpret TDM data or participate in the

TDM signaling.

• CESoPSN—Circuit Emulation Service over Packet-Switched Network (CESoPSN)

bundle represents an IP circuit emulation flow. With CESoPSN bundles, you can

groupmultiple DS0s on one IP circuit, and you can havemore than one circuit

emulation IP flow created from a single physical interface. For example, some DS0

channels from a T1 interface can go in an IP flow to destination A, and other DS0

channels from that same T1 interface can go to destination B.

NOTE: The Physical IF encapulsation is not editable in service order.

2. Fill in the SAToP and CESoPSN fields as indicated in the table.

Default ValueValue RangeSAToP Field

5M Series: 1 through 340Jitter buffer

There is no default value for the jitter buffer
on BX7000 Gateway devices. Youmust
specify a value.

BX7000 Gateway: 2K through 32K

2550 through 255Idle pattern

20%1 through 100%Excessive packet loss rate

192

NOTE: For M Series, the value you specify
must be amultiple of 32.

M Series: 64 through 1024Payload size

NOTE: If the Physical IF
encapulsation type is CESoPSN,
the Payload size is unavailable.

BX7000 Gateway: 24 through 1440
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3. Click Next to go to the Connectivity Settingswindow.

Specifying Connectivity Information for an ATM or a TDMService

In this step, you specify the attributes that define the connectivity between remote sites

across the service provider network. A sample window follows.
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1. Provide the following information to create connectivity between sites across the

network:

ActionField

This box is available only if the Signaling is LDP.

Specify how you want the VC ID chosen during service order creation:

VC ID selection

• To allow the service provisioner to type the VC ID, choose Selectmanually.

• To cause the Junos Space software to assign a VC ID automatically from the VC ID pool, select
Auto pick.

To allow the service provisioner to override the setting in the VC ID box, select Editable in Service
Order.

Specify the MTU across the service provider network.

To allow the service provisioner to override the MTU setting, select Editable in Service Order.

Default MTU (Bytes)

Specify the highest and lowest MTU that the service provisioner can type.

Range: 1522 bytes through 9192 bytes

MTU range (Bytes)

This box is available only if the Signaling is LDP.

Revert time for redundant Layer 2 circuits and VPLS pseudowires.

Default: 5 seconds

Range: 0 through 65,535 seconds

Revert time (sec)

This box is available only if the Signaling type is LDP.

Specify the delay to wait before the backup pseudowire takes over.

Default: 0 second

Range: 0 through 180 seconds

Switch Over Delay (sec)

This box is available only if the Signaling type is BGP.

Specifyan identifier attached toa route, enabling you todistinguish towhichVPNthe routebelongs.
Each routing instancemust have a unique route distinguisher associated with it.

Range: 1.1.1.1:1 through 255.255.255.254:65535, or 1:1 through 65535:4294967295

Route Distinguisher

This box is available only if the Signaling is BGP.

Allows you to distribute VPN routes to only the routers that need them.

Range: 1.1.1.1:1 through 255.255.255.254:65535, or 1:1 through 65535:4294967295

Route Target

This field is available only if you have selected the Static pseudowire check box in the General
settings. By default, the outgoing label selection is limited to manual.

Outgoing label selection

2. Click Finish to create a point-to-point ATM/TDM service definition.
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Related
Documentation

Prestaging ATM and TDM Pseudowire Devices on page 62•

• Prestaging ATM and TDM Pseudowire Devices on page 62

• Creating a Point-to-Point ATM or TDM Pseudowire Service Order on page 432

Creating a Point-to-Point Ethernet Service Definition

Use this procedure to create a definition for a point-to-point VPN service. The standard

service definitions that came with your initial software installation are designed to be

appropriate for most requirements. You can also create a customized service

definition—for example, to setdifferentbandwidth limitson theservice than thoseoffered

in the standard service definitions.

After the new service definition is complete and published, network operators or service

provisioners can use the completed service definition as a base for creating and then

activating point-to-point VPN services on the network.

The windows appear in the order stated. You can, however, perform these steps in any

order by accessing them through the task list in the right panel. If the panel is not visible,

click the snap tool on the right side of the main display area.

To create a point-to-point service definition, complete these tasks, in the order shown:

1. Specifying General Information on page 172

2. Specifying UNI Settings on page 175

3. Specifying Connectivity InformationWhen Signaling Is LDP on page 187

4. Specifying Connectivity InformationWhen Signaling Is BGP on page 190

Specifying General Information

To specify the general information for a point-to-point Ethernet service definition:

1. In the Network Activate task pane, select Service Design >Manage Service Definitions

> Create P2P Service Definition. The General settings window appears.
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2. Fill in the fields in the Generalwindow.

ActionField

Enter a name for the service definition.Name

By default, the service type is Point-to-Point Pseudowire.Service type

Select a signaling type:

• BGP

• LDP

You cannot edit the Signaling type in the service order.

NOTE: If the signaling type is BGP, the Static pseudowire and
the Enable PW access to L3 VPN network check boxes are not
available. You cannot edit the Signaling type in the service
order.

Signaling
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ActionField

Enter a brief description or other comment that you want to
appear in the Service Definition table.

Range: 0 through 200 characters. Spaces and special
characters are allowed.

Comments (Optional)

WhenyouenableQoS in theservicedefinition, youmustspecify
a QoS profile in the service order to classify traffic into defined
servicegroups toprovide the special treatmentof traffic across
the network service. For example, voice traffic can be sent
across certain links, and data traffic can use other links.

Enable QoS

Select the interface type:

• Ethernet

• TDM

• ATM

Interface type

Toenable staticpseudowire, select theStaticpseudowirecheck
box. This check box is disabled if the signaling type is BGP.

Static pseudowire

To enable the pseudowire access to L3 VPN network, select
the EnablePWaccess to L3VPNnetwork check box. This check
box is disabled if the signaling type is BGP, or if you have
selected the interface type as TDM/ATM.

If you select this check box, the Enable Multi Segment
Pseudowire check box is disabled.

Enable PW access to L3 VPN network

Select this check box to enable multi-segment pseudowire.

If you select this check box, the Enable PW access to L3 VPN
network check box is disabled.

A multi-segment pseudowire (MS-PW) is a static or
dynamically configured set of two or more contiguous
pseudowire segments that behave and function as a single
point-to-point pseudowire. Each end of an MS-PW, by
definition, terminates on a T-PE.

NOTE: The number of pseudowire segments that you can
stitch is limited to two.

For more information on point-to-point pseudowire stitching,
see “Stitching Two Point-to-Point Pseudowires” on page 478.

Enable Multi Segment Pseudowire

To enable the pseudowire resiliency, select the Enable PW
Resiliency check box. For more information on pseudowire
redundancy, see “Redundant Pseudowires for Layer 2 Circuits
and VPLS” on page 38.

Enable PWResiliency
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ActionField

Bydefault, all the events are saved in theOpenNMSdatabase.
To isolate the events related to an interface in the OpenNMS,
select theDecoupleServiceStatus FromPort Status check box.

NOTE: When you select this check box, only the pseudowire
traps are monitored, not the jnxVpnIfVpn traps.

Decouple Service Status FromPort Status

(Optional) To include a service template for the service, select
a service template from the Service Template list.

The selected service template appears in the Default Service
Template field.

You can select one or more service templates as the default
service template. By default, the default service templates are
attached to the endpoints.

NOTE: You cannot add or delete a service template while
creating a service order.

The remaining service templates on the Service Template list
are termed as optional service templates. You can attach the
optional service templates to the endpoints on a need basis.

In theViewServiceDefinitionDetailswindow, the value for the
default service template in the Default Service Template
column is True.

For instructions on creating a service template, see “Creating
a Service Template” on page 409.

Service Template

If you intend to run performance tests on services based on
this service definition, select a TCA Profile.

Threshold alarm profile

3. ClickNext to save the information.Continuewith “SpecifyingUNISettings”onpage 101.

Specifying UNI Settings

In this step, youprovide theUNI serviceattributes for this servicedefinition. Theattributes

you set depend on whether you are setting attributes for a port, an 802.1Q interface, a

Q-in-Q interface, or a flexible VLAN tagging:

• Specifying UNI Settings for Port-to-Port Services on page 175

• Specifying UNI Settings for Services with 802.1Q Interface Types on page 178

• Specifying UNI Settings for Services with Q-in-Q Interface Types on page 182

• UNI Settings for Services with Flexible VLAN Tagging (Asymmetric Interface

Types) on page 184

Specifying UNI Settings for Port-to-Port Services

To set UNI attributes for a port-to-port service, complete the following procedure.

1. Enter information in the UNI Settings window.
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2. Fill in the fields in the UNI Settingswindow according to the following table.

ActionField

Traffic Treatment Settings

Select port-port from the list.

The Ethernet option you choose determines the other options you can select and specify on the
page.

Ethernet option

Select N/A. For port-to-port services, all traffic is always transported.Customer traffic type

In port-to-port services, all traffic and all VLANs on one port are transported to all other ports.VLAN ID selection

Select this check box to allow the service provisioner to override the MTU setting.Editable in Service Order

Interface Settings

Selectethernet-vpls, theonly validphysical interfaceencapsulationmethodallowed forport-to-port
services.

Physical IF encapsulation

You cannot change this field because it is not relevant to port-to-port services.Logical IF encapsulation
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ActionField

MTU Settings

You can specify an MTU value in this field. The default value for MTU is 1522 bytes.

To see the permitted range for the MTU value, select the Editable in Service Order check box. The
MTU range is 1522 through 9192.

Default MTU (Bytes)

If you select the check box Editable in Service Order, you can specify a value range for MTU (in
bytes). The permitted range for MTU is 1522 through 9192.

NOTE: Ultimately, the system establishes the MTU bymultiplying the value you specify in the
Default MTU (Bytes) field by the value you specify forMTU Factor.

MTURange (Bytes)

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased

If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 1.

• Line Rate Based

If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limitingcheckbox.

Calculate Burst Size

The following illustration shows the Calculate Burst-Size panel parameters if you select the Line Rate Based option.

Bandwidth Settings

The following illustration shows the Bandwidth Settings panel, which appears if you do not select the Enable QoS check box
in the preceding General settings window.

If you select this check box, you can override the MTU setting.Enable rate limiting (check
box)
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ActionField

Specify the default bandwidth value, in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Defaultbandwidth(Mbps)

To override the default bandwidth value, select the Editable in Service Order check box.

Specify the minimum bandwidth value in Kbps:

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value, in Mbps.

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)

The following table lists theMax Bandwidth (Mbps) for the M Series, MX Series, and ACX Series Routers:

Table 14: MaximumBandwidth for M Series, MX Series, and ACX Series Routers

ACX 2000
MX Series Non-3D
PICMX Series 3D PICM Series IQ2 PICM Series IQ2E PIC

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

100,000
Mbps or
100 Gbps

100,000
Mbps or
100 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

32,000
Mbps or
32 Gbps

32,000
Mbps or
32 Gbps

Specify a value in the range that is made available to the service provisioner.Increment (Kbps)

3. Click Next to continue with Connectivity settings.

Specifying UNI Settings for Services with 802.1Q Interface Types

To set UNI attributes for 802.1Q interfaces complete the following procedure.

1. Enter information in the UNI Settings window.
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2. Fill in the fields in the UNI Settingswindow according to the following table:

ActionField

Traffic Treatment Settings

Select dot1q from the list.

The Ethernet option you choose determines the other options
you can select and specify on the page.

Ethernet option

Single VLAN is the only option for 802.1Q interface types.

Select Transport single vlan to transport the traffic for a specific
VLANacross thenetwork.Whenyouselect thisoption, theservice
provisioner is prompted for the VLAN-IDwhen creating a service
order based on this service definition. You need to specify the
Outer Tag protocol ID.

Select Transport VLAN range to limit the traffic across the
network to a specific range of VLANs.

If you select this option, the service provisioner is prompted for
the VLAN-ID range when creating a service order based on this
service definition.

NOTE: Make sure to check Editable in Service Order if you want
the service provisioner to be able to override this setting.

Customer traffic
type
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ActionField

Indicate how the VLAN ID is determined:

• Selectmanually—Allows the service provider to specify the
VLAN ID. This option is normally used when no VLAN
normalization is applied. Specify the VLAN ID range in VLAN
range for manual input.

NOTE: Makesure tocheckEditable inServiceOrder if youwant
the service provisioner to be able to override this setting.

• Auto pick—This option is normally used when VLAN
normalization is applied. Specify the VLAN ID pool in VLAN
range for auto-pick.

NOTE: Makesure tocheckEditable inServiceOrder if youwant
the service provisioner to be able to override this setting.

VLAN ID
selection

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for
auto-pick

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for
manual input

Select the outer tag protocol ID if the Customer traffic type is
Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: For an interface, youmust configure a physical port with
the possible Tag Protocol Identifiers (TPIDs) either manually or
through a template. Otherwise, the service creation fails for all
TPIDs except 0x8100. To configure the TPIDs manually, use the
following commands:

set interfaces ae0 aggregated-ether-options
ethernet-switch-profile tag-protocol-id 0x9100

set interfaces ae0 aggregated-ether-options
ethernet-switch-profile tag-protocol-id 0x88a8

set interfaces ae0 aggregated-ether-options
ethernet-switch-profile tag-protocol-id 0x8100

Outer Tag
protocol ID

To allow the service provisioner to override the MTU setting,
select the check box for those options.

Editable in
Service Order

Interface Settings

Select the default physical encapsulation scheme to be used by
service orders based on this service definition. We recommend
you select flexible-ethernet-services.

Physical IF
encapsulation
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ActionField

Constrained by your selection in the Physical IF encapsulation
box. If you selected the recommended physical encapsulation
mode of flexible-ethernet-services, then your only option is to
select vlan-vpls for the logical encapsulation method.

Logical IF
encapsulation

MTU Settings

You can specify an MTU value in this field. The default value for
MTU is 1522.

To see thepermitted range for theMTUvalue, select theEditable
in Service Order check box. The MTU range is 1522 through 9192.

Default MTU
(Bytes)

If you select the check box Editable in Service Order, you can
specify a value range for MTU (in bytes). The permitted range
for MTU is 1522 through 9192.

NOTE: Ultimately, thesystemestablishes theMTUbymultiplying
thevalue youspecify in theDefaultMTU(Bytes) fieldby thevalue
you specify forMTU Factor.

MTU Range
(Bytes)

Specify the default bandwidth value, in
Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased

If you select the optionMTUBased, you can specify a value for
MTU Factor in the range 1 through 1087902.

The default value forMTU Factor is 1.

• Line Rate Based

If you select theoption LineRateBased, you can specify a value
for Burst Period in the range 1 through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: The Calculate Burst Size list is enabled only when you
select the Enable rate limiting checkbox.

Calculate Burst
Size

The following illustration shows the appearance of the Calculate Burst-Size panel
parameters if you select the Line Rate Based option.

3. Click Next to continue with connectivity settings.
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Specifying UNI Settings for Services with Q-in-Q Interface Types

To set UNI attributes for a Q-in-Q service, complete the following procedure.

1. To set UNI attributes for Q-in-Q interfaces:

2. Fill in the fields in the UNI Settingswindow according to the following table:

ActionField

Traffic Treatment Settings

Select qinq from the list.

The window expands to include options specific to Q-in-Q interfaces.

Ethernet option

Specify the customer traffic type:

• Transport all traffic—Transports the traffic from all VLANs across the network. When you select
this option, the service provisioner is prompted for the VLAN-ID when creating a service order
based on this service definition. You need to specify only theOuter Tag protocol ID.

• Transport single vlan—Transports traffic for a specific VLAN across the network. You need to
specify bothOuter Tag protocol ID and Inner Tag protocol ID.

• Transport VLAN range—Limits the traffic across the network to a specific range of VLANs.

If you select this option, the serviceprovisioner is prompted for theVLAN-ID rangewhencreating
a service order based on this service definition. You need to specify bothOuter Tag protocol ID
and Inner Tag protocol ID.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be able
to override this setting.

Customer traffic type
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ActionField

Indicate how the VLAN ID is selected during service order creation.

• Selectmanually—Allows the service provider to specify the VLAN ID. This option is normally
used when no VLAN normalization is applied.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting. Specify the VLAN ID range in VLAN range for manual input.

• Auto pick—This option is normally used when VLAN normalization is applied. Specify the VLAN
ID pool in VLAN range for auto-pick.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting.

VLAN ID selection

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick:

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input

Select the outer tag protocol ID if the Customer traffic type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPIDs) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x9100

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x88a8

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x8100

Outer Tag protocol ID

Select the inner tag protocol ID:

• 0x88a8

• 0x8100

• 0x9100

NOTE: You cannot specify the Inner Tag protocol ID if the Customer traffic type is Transport single
VLAN.

Inner Tag protocol ID

Select this check box to allow the service provisioner to override the MTU setting.Editable in Service Order

Interface Settings

Select thedefault physical encapsulation scheme tobeusedby serviceordersbasedon this service
definition. We recommend you select flexible-ethernet-services.

Physical IF encapsulation
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ActionField

Constrainedbyyour selection in thePhysical IFencapsulationbox. If you selected the recommended
physical encapsulation mode of flexible-ethernet-services, then your only option is to select
vlan-vpls for the logical encapsulation method.

Logical IF encapsulation

MTU Settings

You can specify an MTU value in this field. The default value for MTU is 1522.

To see the permitted range for the MTU value, select the Editable in Service Order check box. The
MTU range is 1522 through 9192.

Default MTU (Bytes)

If you select the check box Editable in Service Order, you can specify a value range for MTU (in
bytes). The permitted range for MTU is 1522 through 9192.

NOTE: Ultimately, the system establishes the MTU bymultiplying the value you specify in the
Default MTU (Bytes) field by the value you specify forMTU Factor.

MTURange (Bytes)

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased

If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 1.

• Line Rate Based

If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limitingcheckbox.

Calculate Burst Size

The following illustration shows the appearance of the Calculate Burst-Size panel parameters if you select the Line Rate Based
option.

3. Click Next to continue with Connectivity settings.

UNI Settings for Services with Flexible VLAN Tagging (Asymmetric Interface
Types)

Youcanspecify theEthernet optionasymmetric tagdepth to createa service that includes

any combination of port-based interfaces, 802.1Q interfaces, and Q-in-Q interfaces.

1. Enter information in the UNI Settings window.
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2. Specify the UNI Settings for asymmetric tag depth according to the following table:

ActionField

Traffic Treatment Settings

Select asymmetric tag depth from the list.Ethernet option

Select the customer traffic type:

• Transport all traffic—Transports the traffic from all VLANs across the network. When you select
this option, the service provisioner is prompted for the VLAN-ID when creating a service order
based on this service definition. You need to specify only theOuter Tag protocol ID and Inner Tag
protocol ID.

• Transport single vlan—Transports traffic for a specific VLAN across the network. You need to
specify bothOuter Tag protocol ID and Inner Tag protocol ID.

• Transport VLAN range—Limits the traffic across the network to a specific range of VLANs. You
need to specify bothOuter Tag protocol ID and Inner Tag protocol ID.

If you select this option, the serviceprovisioner is prompted for theVLAN-ID rangewhencreating
a service order based on this service definition.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be able
to override this setting.

Customer traffic type
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ActionField

Indicate how the VLAN ID is selected during service order creation.

• Selectmanually—Allows the service provider to specify the VLAN ID. This option is normally
usedwhennoVLANnormalization is applied.Specify theVLAN ID range inVLANrangeformanual
input.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting.

• Auto pick—This option is normally used when VLAN normalization is applied. Specify the VLAN
ID pool in VLAN range for auto-pick.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting. Specify the VLAN ID pool in VLAN range for auto-pick.

VLAN ID selection

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick:

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input

Select the outer tag protocol ID if the Customer traffic type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPIDs) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x9100

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x88a8

set interfaces ae0 aggregated-ether-options ethernet-switch-profile tag-protocol-id 0x8100

Outer Tag protocol ID

Select the inner tag protocol ID:

• 0x88a8

• 0x8100

• 0x9100

NOTE: You cannot specify the Inner Tag protocol ID if the Customer traffic type is Transport all
traffic.

Inner Tag protocol ID

Toallow the service provisioner to override theMTUsetting, select the check box for those options.Editable in Service Order

Interface Settings

Select thedefault physical encapsulation scheme tobeusedby serviceordersbasedon this service
definition. We recommend you select flexible-ethernet-services.

Physical IF encapsulation
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ActionField

Constrainedbyyour selection in thePhysical IFencapsulationbox. If you selected the recommended
physical encapsulation mode of flexible-ethernet-services, then your only option is to select
vlan-vpls for the logical encapsulation method.

Logical IF encapsulation

MTU Settings

You can specify an MTU value in this field. The default value for MTU is 1522.

To see the permitted range for the MTU value, select the Editable in Service Order check box. The
MTU range is 1522 through 9192.

Default MTU (Bytes)

If you select the check box Editable in Service Order, you can specify a value range for MTU (in
bytes). The permitted range for MTU is 1522 through 9192.

NOTE: Ultimately, the system establishes the MTU bymultiplying the value you specify in the
Default MTU (Bytes) field by the value you specify forMTU Factor.

MTU Range (Bytes)

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased

If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 1.

• Line Rate Based

If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limitingcheckbox.

Calculate Burst Size

The following illustration shows the appearance of the Calculate Burst-Size panel parameters if you select the Line Rate Based
option.

3. Click Next to continue with Connectivity settings.

Specifying Connectivity InformationWhen Signaling Is LDP

The fields displayed in the Connectivitywindow depend on the Signaling type (LDP or

BGP) that you selected in the General settings window.
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To specify connectivity between sites across the network when signaling is LDP:

1. Fill in the fields in the Connectivitywindow.

ActionField

The VC ID selection is available only if the Signaling type is LDP.

In theVCIDselectionbox, specify howyouwant theVC ID tobechosenduring serviceorder creation:

• To allow the service provisioner to enter the VC ID, choose Selectmanually.

• To cause the Junos Space software to assign a VC ID automatically from the VC ID pool, select
Auto pick.

To allow the service provisioner to override the setting in the VC ID box, select Editable in Service
Order.

VC ID selection

In the Default MTU box, specify the MTU across the service provider network.

To allow the service provisioner to override the MTU setting, select Editable in Service Order. In the
MTU range, enter the highest and lowest MTU that the service provisioner can enter.

Default MTU

This field is available if you selected the Enable PWResiliency check box and if the Signaling is LDP
in the General settings.

Revert time (sec)—Revert time for redundant Layer 2 circuits and VPLS pseudowires.

Default: 5 seconds

Range: 0 through 65,535 seconds

Revert time (sec)

This field is available if you selected the EnablePWResiliency check box and if theSignaling is LDP,
in the General settings.

Switch Over Delay (sec)—Delay to wait before the backup pseudowire takes over.

Default: 0 second

Range: 0 through 180 seconds

Switch Over Delay (sec)

Theoptionsavailable in theVLANnormalizationarebasedon thevalueset for theEthernet interface.VLANNormalization

This field is available if you selected the Static pseudowire check box in the General settings. By
default, the outgoing label selection is limited to manual.

Outgoing label selection
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The following table presents the available VLAN normalization options:

VLANNormalizationCustomer Traffic TypeEthernet Option

Normalization not required

Normalization to Dot1q tag

Normalization to QinQ tags

N/Aport-port

Swap

Normalize to None

Normalization to Dot1q tag

Normalization to QinQ tags

Transport single vlandot1q

Normalization not requiredTransport vlan range

Swap

Normalize to None

Normalization to Dot1q tag

Normalization to QinQ tags

Transport all trafficqinq

Swap

Normalize to None

Normalization to Dot1q tag

Normalization to QinQ tags

Transport single vlan

Normalization not requiredTransport vlan range

(Identical to qinq)(Identical to qinq)Asymmetric

2. Click Finish to complete the service definition.
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Specifying Connectivity InformationWhen Signaling Is BGP

To specify connectivity between sites across the network when signaling is BGP, fill in

the fields in the Connectivity window:

1. When the signaling type is BGP, fill in the fields in the Connectivitywindow.

• Route Distinguisher—Identifier attached to a route, enabling you to distinguish to

which VPN the route belongs. Each routing instancemust have a unique route

distinguisher associated with it.

Range: 1.1.1.1:1 through 255.255.255.254:65535, or 1:1 through 65535:4294967295

• Route Target—Allows you to distribute VPN routes to only the routers that need

them.

Range: 1.1.1.1:1 through 255.255.255.254:65535, or 1:1 through 65535:4294967295

• Default MTU (Bytes)—The default MTU established by the system.

• MTU range (Bytes)—Specify the range, in bytes, for the MTU.

• VLANnormalization—Theoptionsavailable in theVLANnormalization fieldarebased

on the value set for the Ethernet interface. The following table presents the options.
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VLANNormalizationCustomer Traffic TypeEthernet Option

Normalization not required

Normalization to Dot1q tag

Normalization to QinQ tags

N/Aport-port

Swap

Normalize to None

Normalization to Dot1q tag

Normalization to QinQ tags

Transport single vlandot1q

Normalization not requiredTransport vlan range

Swap

Normalize to None

Normalization to Dot1q tag

Normalization to QinQ tags

Transport all trafficqinq

Swap

Normalize to None

Normalization to Dot1q tag

Normalization to QinQ tags

Transport single vlan

Normalization not requiredTransport vlan range

(Identical to qinq)(Identical to qinq)Asymmetric

NOTE: For a description of how the Network Activate software
manipulates VLANs, see “Understanding VLANManipulation
(Normalization and VLANMapping) on Ethernet Services” on page 32.

2. Click Finish to complete the service definition.

Related
Documentation

Publishing a Custom Service Definition on page 198•

• Predefined Point-to-Point Service Definitions on page 333

• Viewing Service Definitions on page 701

191Copyright © 2015, Juniper Networks, Inc.

Chapter 5: Service Design: Managing Point-to-Point and Multipoint Service Definitions



Creating a Cross Provisioning Platform Service Definition

Before you create a cross-platform service order, youmust complete the following tasks:

• Import into the system the scripts that define the Juniper Networks devices.

• Import into the system the scripts that define the third-party devices.

To create a cross-platform service definition:

1. In the Cross Provisioning Platform task pane, select CPP > Service Definitions.

2. In the CPP > Service Definitionwindow, click on the + button. The Create Service

Definitionwindow appears.

3. Enter information in theCreateServiceDefinitionwindowaccording to thedescriptions

in the following table.

DescriptionParameter

Enter a name for the service.Name
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DescriptionParameter

Enter a unique ID to associate with this service definition in the range 1 through 2147483647.

NOTE: The service definition ID is optional. If you do not provide any value in this field, the default value
is -1. In the service definition selection grid, no value is displayed in the ID column. Each service definition
is assigned a unique ID. If you give an existing ID value while creating a new service definition, exception
occurs.

ID

Enter a description of the service to distinguish its operation from others.Description

Select the service type from the list of available types:

• PW-LDP

• VPLS

• L3VPN

• NPS

• Device

Type

This tab has two colums:

• Select SAM Creation Script—Select a SAM creation script from the list of scripts available in this
section and the samewould be populated in the corresponding text field. If you need to remove the
selected script, deselect the same.

• Select SAMModification Script—Select a SAMmodification script from the list of scripts available in
this section and the samewould be populated in the corresponding text field. If you need to remove
the selected script, deselect the same.

NOTE:

SAMService Scripts

This parameter provides two fields:

• Select Junos Creation Script—Select a Junos creation script from the list of scripts available in this
section and the samewould be populated in the corresponding text field. If you need to remove the
selected script, deselect the same.

• Select Junos Modification Script—Select a Junos modification script from the list of scripts available
in this section and the samewould be populated in the corresponding text field. If you need to remove
the selected script, deselect the same.

Junos Space Service
Scripts

4. Click Create.

5. In the Cross Provisioning Platform task pane, select CPP > Service Definitions.

6. Select the service definition you just created and select Action > Publish Service

Definition. The State column indicates when the service definition is published.

The value in the ID field is associatedwith a service definition. This identifier can be used

when you are searching for a particular service definition while creating a service order.

You can search the service definition by its name, type or unique ID. You canmodify the

ID only during the migration of old service definition IDs.

Duringmigration, thedefault valueof the ID is -1. Youcanmodify this valueusingdatabase

executable scripts during migration.

Themigration scripts enable you to update the existing service definitionswith IDs. A csv
file that contains the service definition names and their unique identifiers is provided as
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an input. Themigration script reads the names of the service definitions and the

corresponding unique identifiers from the file and updates the service definitions in the

database service policy table.

Related
Documentation

Creating a Cross Provisioning Platform Service Order on page 462•

• Viewing Cross Provisioning Platform Service Order Details on page 767

Creating and Deploying a Device Configlet Order for Cross Provisioning Platform

To create a device configlet for Cross Provisioning Platform:

1. In the Cross Provisioning Platform task pane, select CPP > Device Configlets Order.

2. In the Device Configlets Orderwindow, click the Create CPP Device Configlet icon (+).

3. In the Create CPPDevice Configlet Order, select the Service definition using the unique

identifier ID associated with each service definition or name of the service definition.

NOTE: The value in the ID field is associatedwith a service definition. This

identifier can be used when you are searching for a particular service
definitionwhilecreatingadeviceconfigletorder.Youcansearch theservice
definition by its name, type or unique ID. You canmodify the ID only during
themigration of old service definition IDs.

4. In theOrder description field, type a description for the service configlet.

5. Click Next.
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6. Fill in the fields in theCreateDeviceConfigletOrderwindowasdescribed in the following

table.

DescriptionField

Type a name for the configletName

Browse to locate the device upon which you want the configlet to operate.Device

Type the hostname of the device upon which you want the configlet to operate.Host Name

Type the loopback address of the device.Primary Lookback IP

Select the role that you want the device to serve in the network:

• L2E

• Edge

• Trunk

Device Role

Select the region where the device is located.Region

Select an interface connected to the upstream provider-edge device.Uplink Interface 1

Select an interface connected to the upstream provider-edge device.Uplink Interface 2

This field is displayed if you selected L2E as the Device Role.

Select the L2E UNI interface.

L2E UNI Interface

This field is displayed if you selected L2E as the Device Role.

Specify the inner VLAN ID of the L2E UNI interface.

L2E UNI Inner VLAN Id

195Copyright © 2015, Juniper Networks, Inc.

Chapter 5: Service Design: Managing Point-to-Point and Multipoint Service Definitions



DescriptionField

This field is displayed if you selected L2E as the Device Role.

Specify the outer VLAN ID of the L2E UNI interface.

L2E UNI Outer VLAN Id

7. Click Create.

The device configlet order is deployed, and you can view the device configlet order in

the Device Configlet Orders inventory page.

If you want to create and deploy more orders, click CreateMore.

Related
Documentation

Cross Provisioning Platform Overview on page 45•

• Administering a Device Configlet Service Order for Cross Provisioning Platform on

page 663

Preconfiguring the Third-Party OSS Device for Cross Provisioning Platform

To enable Cross Provisioning Platform using the Junos Space Network Activate

application, first youmust preconfigure the third-party OSS device.

To preconfigure the third-party OSS device:

1. In the Network Management Platform, select Administration > Applications.

2. In the Applicationswindow, select Network Activate.

3. From the Actionsmenu, selectModify Application Settings.

4. In theModify Application Settingswindow, selectOSSConfigParameters.
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5. Fill in the fields in theOSSConfigParameters panel as described in the following table.

DescriptionOSS Parameter

IP address of the primary server.Primary Server IP

Port number of the primary server.Primary Server Port

IP address of the backup server.Backup Server IP

Port number of the backup server.Backup Server Port:

Duration of HTTP connection (in milliseconds) before the timeout elapses.HTTPConnectionTimeout (milliseconds)

Maximum number of simultaneous API requests permitted.MaximumAPI Requests

Directory path of the OSS log directory.OSS Log Directory

Filename of the OSS log.OSS Log Filename

Username for accessing the OSS server.OSSUser Name

Hashed password for accessing the OSS server.OSSUser Password

Sets thedaily timeatwhich theCPPsystemsynchronizes third-partydevices, added
or deleted from the CPP system, with the OSS server.

NOTE: The timeatwhich thesynchronization job runs is associatedwith the location
of the browser in which you are using the Junos Space software. That is, the
synchronization job runs according to the browser time where the job is scheduled,
not according to the time where the Junos Space server is located.

Synchronize OSS Inventory daily at given
time

197Copyright © 2015, Juniper Networks, Inc.

Chapter 5: Service Design: Managing Point-to-Point and Multipoint Service Definitions



DescriptionOSS Parameter

If this check box is selected, the CPP system communicates with the primary OSS
server. If the check box is not selected, the system interacts with the backup server.

Use primary server

6. When you are done entering information in theOSSConfigParameters fields, click

Modify.

If you want to modify the application settings of the Cross Provisioning Platform

application, selectAdministration>Applications>CrossProvisioningPlatformand select

Modify Application Settings in the Network Management platform. You can uninstall the

application by selecting Cross Provisioning Platform > Uninstall Application.

NOTE: The OSS configuration values are still retained and reflected in the
corresponding fields even after you uninstall and reinstall the application.

Related
Documentation

Synchronizing Third-Party Devices with the OSS for Cross Provisioning Platform on

page 678

•

• Confirming Communication with the Third-Party OSS Server for Cross Provisioning

Platform on page 681

Publishing a CustomService Definition

The service designer must publish a customized service definition before a service

provisioner can use that definition to create a service request.
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NOTE: Predefined service definitions are already in the Published state.

To publish a service definition:

1. In the Network Activate task pane, select ServiceDesign>ManageServiceDefinitions.

2. In theManageServiceDefinitionspage, select the servicedefinition youwant topublish.

In the table, the State column lists unpublished service definitions.

3. Select the unpublished service definition that you want to publish.

4. Open the Actionsmenu and select Publish Service Definition.

The Publish Service Definitionswindow appears and prompts you to confirm your

action.

5. Click Publish.

TheManageServiceDefinitions page reappears. The selected service definition is now

in the published state.

Related
Documentation

Creating a Point-to-Point Ethernet Service Definition on page 97•

• Unpublishing a Custom Service Definition on page 199

Unpublishing a CustomService Definition

The service designer can unpublish a custom service definition tomake it unavailable to

service provisioners for creating a service request. You cannot unpublish a predefined

service definition.

To unpublish a service definition:

1. In theNetwork Activate task pane, select Service Design >Manage Service Definitions.

2. In theManage Service Definitionswindow, select the service definition you want to

unpublish.

In table, the State column lists published service definitions.

3. Select the published service definition that you want to unpublish.

4. Open the Actionsmenu and select Unpublish Service Definition.

The Unpublish Service Definitionswindow appears and prompts you to confirm your

action.

5. Click Unpublish.

TheManage Service Definitions screen reappears. The selected service definition is

now in the unpublished state.
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Related
Documentation

Publishing a Custom Service Definition on page 198•

Deleting a Customized Service Definition

NOTE: Beforeyoucandeleteaservicedefinition, itmustbe in theunpublished
state.

You cannot delete a predefined service definition.

To delete a customized service definition:

1. In theNetwork Activate task pane, select Service Design >Manage Service Definitions.

In theManage Service Definitionswindow, select the customized service definition

you want to delete.

2. Open the Actionsmenu and select Delete Service Definition.

3. In the confirmation window, click Delete.

TheManage Service Definitionswindow refreshes with the selected service definition

removed.

Related
Documentation

• Unpublishing a Custom Service Definition on page 199
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CHAPTER 6

Service Design: Managing VPLS Service
Definitions

• Creating a Multipoint-to-Multipoint VPLS Service Definition on page 201

• Creating a Point-to-Multipoint VPLS Service Definition on page 222

• Creating a Service Definition for VPLS Access into Layer 3 Networks on page 249

• Creating a VPLS Service Definition in Cross Provisioning Platform on page 254

Creating aMultipoint-to-Multipoint VPLS Service Definition

This procedure provides the steps to create a definition for a multipoint-to-multipoint

VPLS service.

The standard service definitions that came with your initial software installation are

designed to be appropriate for most requirements. You can also create a customized

service definition—for example, to set different bandwidth limits on the service than

those offered in the standard service definitions.

When the new service definition is complete and published, network operators or service

provisioners can use the completed service definition as a base for creating and then

activating multipoint-to-multipoint Ethernet services on the network.

The windows appear in the order stated. You can, however, perform these steps in any

order by accessing them through the task list in the right panel. If the panel is not visible,

click the snap tool on the right side of the main display area.

To create amultipoint-to-multipoint Ethernet service definition, complete these tasks,

in the order shown. As you finish a section and click Next, the attributes from the current

window are saved and the next window in the sequence appears.

• Specifying General Information for Multipoint-to-Multipoint VPLS Service

Definitions on page 203

• SpecifyingUNISettingsforMultipoint-to-MultipointVPLSServiceDefinitionsonpage206

• UNI Settings for Port-to-Port Interfaces in VPLS Services on page 206

• UNI Settings for 802.1Q Interfaces in VPLS Services on page 208

• UNI Settings for Q-in-Q Interfaces in VPLS Services on page 211
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• UNI Settings for Services with Flexible VLAN Tagging (Asymmetric Interface

Types) on page 215

• Specifying Connectivity and MAC Security Information on page 218

• Specifying Advanced Settings on page 221
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Specifying General Information for Multipoint-to-Multipoint VPLS Service Definitions
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To specify the general information for a multipoint-to-multipoint service definition, in

the Network Activate task pane, select Service Design >Manage Service Definitions >

Create VPLS Service Definition

The Generalwindow appears.

To specify the general information for a multipoint-to-multipoint service definition:

1. Fill in the fields on the Generalwindow.

ActionField

Type a name for the service definition.Name

SelectMultipoint-to-Multipoint Ethernet (VPLS)Service type
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ActionField

Select a signaling type:

• BGP— If BGP signaling is selected, the following fields are available in the Connectivity window:
• Route target

• Route distinguisher

• VLAN normalization

• AllowMultihoming

• Mac Security Settings

• LDP—If LDP signaling is selected, the following fields are available in the Connectivity window:
• Auto Discovery

• Route target, if Auto Discovery is enabled

• Route distinguisher, if Auto Discovery is enabled

• VPLS ID, if Auto Discovery is disabled

• VPN ID, if Auto Discovery is enabled

• VLAN normalization

• Mac Security Settings

NOTE: You cannot edit the Signaling type in the service order.

Signaling

Type a brief description or other comment that you want to appear in the Service Definition table.

Range: 0 through 200 characters. Space and special characters are allowed.

Comments
(Optional)

When you enable QoS in the service definition, youmust specify a QoS profile in the service order to
classify traffic into defined service groups to provide the special treatment of traffic across the network
service. For example, voice traffic can be sent across certain links, and data traffic can use other links.

Enable QoS

Select this check box to create the link into Layer 3. If this check box is selected, the available Ethernet
option in the UNI Settings window are:

• dot1q

• qinq

Enable L3 Access

Select this check box to enable a pseudowire connection by configuring static values.

NOTE: The Enable Static PW Labels check box is enabled only when the signaling type is LDP.

Enable Static PW
Labels

(Optional) To include a service template for the service, select a service template from the Service
Template list.

The selected service template appears in the Default Service Template field.

You can select one or more service templates as the default service template. By default, the default
service templates are attached to the endpoints.

NOTE: You cannot add or delete a service template while creating a service order.

The remaining service templates on the Service Template list are termed as optional service templates.
You can attach the optional service templates to the endpoints on a need basis.

In the View Service Definition Details window, the value for the default service template in the Default
Service Template column is True.

For instructions on creating a service template, see “Creating a Service Template” on page 409.

Service Template
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2. Click Next to save the information and continue with UNI Settings.

Specifying UNI Settings for Multipoint-to-Multipoint VPLS Service Definitions

In this step, you provide the UNI attributes for this service definition. The attributes you

set depend on the type of interface you are using in this VPLS service definition. The

following interface types are supported:

• ports

• 802.1Q interfaces

• Q-in-Q interfaces

• asymmetric interface

UNI Settings for Port-to-Port Interfaces in VPLS Services

TheUNISettingswindowprovides fourexpandingorcollapsingpanels:TrafficTreatment,

Interface Settings, MTU Settings, and Bandwidth Settings.

To specify the UNI Settings for Port-to-Port interfaces:

1. Fill in the fields on the UNI Settingswindow.

ActionField

Traffic Treatment Settings

Select port-port from the list.

The Ethernet option you choose determines the other options you can select and specify on the
page.

Ethernet option
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ActionField

Select N/A. For port-to-port services, all traffic is always transported.Customer traffic type

In port-to-port services, all traffic and all VLANs on one port are transported to all other ports.VLAN ID selection

To allow the service provisioner to override the MTU setting, select the check box.Editable in Service Order

Interface Settings

Selectethernet-vpls, theonly validphysical interfaceencapsulationmethodallowed forport-to-port
services.

Physical IF encapsulation

You can not select a choice in this field because it is not relevant to port-to-port services.Logical IF encapsulation

MTU Settings

The default MTU value is 1522 bytes.Default MTU (Bytes)

Specify the low and high values to define the MTU range that you want to define.

The default range is 1522 through 9192 bytes.

MTURange (Bytes)

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased
If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 1.

• Line Rate Based
If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limitingcheckbox.

Calculate Burst Size

The following illustration shows the Calculate Burst-Size panel parameters if you select the Line Rate Based option.

Bandwidth Settings

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are not available in the service definition when QoS Design software
is installed.

Enable rate limiting
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ActionField

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Default bandwidth (Mbps)

Specify the minimum bandwidth value in Kbps.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 12 on page 124

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Increment (Kbps)

The following table lists theMax Bandwidth (Mbps) for the M Series, MX Series, and

ACX Series Routers:

Table 15: MaximumBandwidth for M Series, MX Series, and ACX Series Routers

ACX 2000
MX Series Non-3D
PICMX Series 3D PICM Series IQ2 PICM Series IQ2E PIC

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

100,000
Mbps or
100 Gbps

100,000
Mbps or
100 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

32,000
Mbps or
32 Gbps

32,000
Mbps or
32 Gbps

2. Click Next to continue with Connectivity settings.

UNI Settings for 802.1Q Interfaces in VPLS Services

To specify the UNI Settings for 802.1Q interfaces:

1. Fill in the fields on the UNI Settingswindow.

ActionField

Traffic Treatment Settings

Copyright © 2015, Juniper Networks, Inc.208

Junos Space Cross Provisioning Platform



ActionField

Select dot1q from the list.

The Ethernet option you choose determines the other options you can select and specify on the
page.

Ethernet option

Single VLAN is the only option for 802.1Q interface types.

Select Transport single vlan to transport the traffic for a specific VLAN across the network. When
you select this option, the service provisioner is prompted for the VLAN-IDwhen creating a service
order based on this service definition. You need to specify theOuter Tag protocol ID.

Select Transport VLAN range to limit the traffic across the network to a specific range of VLANs.

If you select this option, the service provisioner is prompted for the VLAN-ID range when creating
a service order based on this service definition.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be able
to override this setting.

Customer traffic type

Indicate how the VLAN ID is determined.

• Selectmanually Allows the service provider to specify the VLAN ID. This option is normally used
when no VLAN normalization is applied. Specify the VLAN ID range in VLAN range for manual
input.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting.

• Auto pick This option is normally used when VLAN normalization is applied. Specify the VLAN
ID pool in VLAN range for auto-pick.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting.

VLAN ID selection

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input
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ActionField

Select the outer tag protocol ID if the Customer traffic type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPID) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x9100
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x88a8
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x8100

Outer Tag protocol ID

Toallow the service provisioner to override theMTUsetting, select the check box for those options.Editable in Service Order

Interface Settings

Select thedefault physical encapsulation scheme tobeusedby serviceordersbasedon this service
definition. We recommend you select flexible-ethernet-services.

Physical IF encapsulation

Constrainedbyyour selection in thePhysical IFencapsulationbox. If you selected the recommended
physical encapsulation mode of flexible-ethernet-services, then your only option is to select
vlan-vpls for the logical encapsulation method.

Logical IF encapsulation

In the MTU range fields, type the lowest and highest values for MTU for each UNI.

NOTE: To allow the service provisioner to override theMTU setting, select Editable inServiceOrder
and, in the MTU range fields, type the highest and lowest MTU values.

MTUSettings

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased
If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 1.

• Line Rate Based
If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limitingcheckbox.

Calculate Burst Size
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ActionField

The following illustration shows the Calculate Burst-Size panel parameters if you select the Line Rate Based option.

Bandwidth Settings

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are not available in the service definition when QoS Design software
is installed.

Enable rate limiting

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Default bandwidth (Mbps)

Specify the minimum bandwidth value in Kbps.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 12 on page 124

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps/100Gbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Increment (Kbps)

2. Click Next to continue with connectivity settings.

UNI Settings for Q-in-Q Interfaces in VPLS Services

To specify the UNI Settings for q-in-q interfaces:

1. Fill in the fields on the UNI Settingswindow.

ActionField

Traffic Treatment Settings
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ActionField

Select qinq from the list.

The window expands to include options specific to Q-in-Q interfaces

Ethernet option

Transport all traffic Transports the traffic from all VLANs across the network.When you select this
option, the service provisioner is prompted for the VLAN-ID when creating a service order based
on this service definition. You need to specify only theOuter Tag protocol ID.

Transport single vlanTransports traffic for a specific VLAN across the network. You need to specify
bothOuter Tag protocol ID and Inner Tag protocol ID.

Transport VLAN range Limits the traffic across the network to a specific range of VLANs.

If you select this option, the service provisioner is prompted for the VLAN-ID range when creating
a service order based on this service definition. You need to specify bothOuter Tag protocol ID and
Inner Tag protocol ID.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be able
to override this setting.

Customer traffic type

Indicate how the VLAN ID is selected during service order creation.

• Selectmanually Allows the service provider to specify the VLAN ID. This option is normally used
when no VLAN normalization is applied.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting. Specify the VLAN ID range in VLAN range for manual input.

• Auto pick This option is normally used when VLAN normalization is applied. Specify the VLAN
ID pool in VLAN range for auto-pick.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting.

VLAN ID selection

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick:

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input
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ActionField

Select the outer tag protocol ID if the Customer traffic type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPID) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x9100
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x88a8
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x8100

Outer Tag protocol ID

Select the inner tag protocol ID:

• 0x88a8

• 0x8100

• 0x9100

NOTE: You cannot specify the Inner Tag protocol ID if the Customer traffic type is Transport single
VLAN.

Inner Tag protocol ID

Toallow the service provisioner to override theMTUsetting, select the check box for those options.Editable in Service Order

Interface Settings

Select thedefault physical encapsulation scheme tobeusedby serviceordersbasedon this service
definition. We recommend you select flexible-ethernet-services.

Physical IF encapsulation

Constrainedbyyour selection in thePhysical IFencapsulationbox. If you selected the recommended
physical encapsulation mode of flexible-ethernet-services, then your only option is to select
vlan-vpls for the logical encapsulation method.

Logical IF encapsulation

In the MTU range fields, type the lowest and highest values for MTU for each UNI

NOTE: To allow the service provisioner to override theMTU setting, select Editable inServiceOrder
and, in the MTU range fields, type the highest and lowest MTU values that the service provisioner
can type.

MTUSettings

Calculation of Burst-Size
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ActionField

Select the preferred option for calculating the burst size:

• MTUBased
If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 1.

• Line Rate Based
If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limitingcheckbox.

Calculate Burst Size

The following illustration shows the Calculate Burst-Size panel parameters if you select the Line Rate Based option.

Bandwidth Settings

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are not available in the service definition when QoS Design software
is installed.

Enable rate limiting

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Default bandwidth (Mbps)

Specify the minimum bandwidth value in Kbps.

Default: 1000 KbpS

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 12 on page 124

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100000 Kbps

Increment (Kbps)

Copyright © 2015, Juniper Networks, Inc.214

Junos Space Cross Provisioning Platform



2. Click Next to continue with Connectivity settings.

UNI Settings for Services with Flexible VLAN Tagging (Asymmetric Interface Types)

Youcanspecify theEthernet optionasymmetric tagdepth to createa service that includes

any combination of port-based interfaces, 802.1Q interfaces, and Q-in-Q interfaces.

To specify the UNI Settings for q-in-q interfaces:

1. Fill in the fields on the UNI Settingswindow.

ActionField

Traffic Treatment Settings

Select asymmetric tag depth from the list.Ethernet option

Transport all traffic Transports the traffic from all VLANs across the network.When you select this
option, the service provisioner is prompted for the VLAN-ID when creating a service order based
on this service definition. You need to specify only theOuter Tag protocol ID and Inner Tag protocol
ID.

Transport single vlanTransports traffic for a specific VLAN across the network. You need to specify
bothOuter Tag protocol ID and Inner Tag protocol ID.

Transport VLAN range Limits the traffic across the network to a specific range of VLANs. You need
to specify bothOuter Tag protocol ID and Inner Tag protocol ID.

If you select this option, the service provisioner is prompted for the VLAN-ID range when creating
a service order based on this service definition.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be able
to override this setting.

Customer traffic type

Indicate how the VLAN ID is selected during service order creation.

• Selectmanually Allows the service provider to specify the VLAN ID. This option is normally used
when no VLAN normalization is applied. Specify the VLAN ID range in VLAN range for manual
input.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting.

• Auto pick This option is normally used when VLAN normalization is applied. Specify the VLAN
ID pool in VLAN range for auto-pick.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be
able to override this setting. Specify the VLAN ID pool in VLAN range for auto-pick.

VLAN ID selection

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick:

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input
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ActionField

Select the outer tag protocol ID if the Customer traffic type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPID) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x9100
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x88a8
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x8100

Outer Tag protocol ID

Select the inner tag protocol ID:

• 0x88a8

• 0x8100

• 0x9100

NOTE: You cannot specify the Inner Tag protocol ID if the Customer traffic type is Transport all
traffic.

Inner Tag protocol ID

Toallow the service provisioner to override theMTUsetting, select the check box for those options.Editable in Service Order

Interface Settings

Select thedefault physical encapsulation scheme tobeusedby serviceordersbasedon this service
definition. We recommend you select flexible-ethernet-services.

For multipoint-to-multipoint services with Q-in-Q interfaces, the only option is
flexible-ethernet-services

Physical IF encapsulation

Constrainedbyyour selection in thePhysical IFencapsulationbox. If you selected the recommended
physical encapsulation mode of flexible-ethernet-services, then your only option is to select
vlan-vpls for the logical encapsulation method.

Logical IF encapsulation

In the MTU range fields, type the lowest and highest values for MTU that the service provisioner
can type, for each UNI

NOTE: To allow the service provisioner to override theMTU setting, select Editable inServiceOrder
and, in the MTU range fields, type the highest and lowest MTU values that the service provisioner
can type.

MTUSettings

Calculation of Burst-Size
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ActionField

Select the preferred option for calculating the burst size:

• MTUBased
If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 1.

• Line Rate Based
If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limitingcheckbox.

Calculate Burst Size

The following illustration shows the Calculate Burst-Size panel parameters if you select the Line Rate Based option.

Bandwidth Settings

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are not available in the service definition when QoS Design software
is installed.

Enable rate limiting

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Default bandwidth (Mbps)

Specify the minimum bandwidth value in Kbps.

Default: 1000 KbpS

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 12 on page 124

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Increment (Kbps)
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2. Click Next to continue with Connectivity settings.

Specifying Connectivity andMAC Security Information

In this step, you specify the attributes that define the connectivity among remote sites

across the service provider network and the service security. The following is a sample

Connectivitywindow.
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To specify connectivity between sites across the network:

1. Fill in the fields in the Connectivitywindow.

ActionField

Choose one of the following options from the list:Route target

• Auto pick

• Select manually

Select a route distinguisher option:Route distinguisher

• Selectmanually—The service provider specifies the route distinguisher.

• Auto pick—The route distinguisher is selected automatically.

To override this setting in the service order, select the Editable in Service Order check box.

Select a value:VLAN normalization

• Normalize to VLAN all—To preserve customer VLAN IDs (and customer QoS priorities) across
the network.

NOTE: For services that transport a range of VLAN IDs, youmust set VLANNormalization to all.
You cannot transport a range of VLAN IDs without normalization.

• Normalized VLAN none—To preserve no VLAN IDs across the network

• Not normalized—If VLAN IDs are to be providedmanually and are required to match each
endpoint.

• Normalized to Dot1q—To transport only single-tagged frames across the network core. All port,
dot1q , and Q-in-Q traffic is transported across the network.

• Normalized to QinQ—To transport only double-tagged frames across the network core. All port,
dot1q , and Q-in-Q traffic is transported across the network.

• Normalization not required—To specify no normalization for port-to-port services

For more information about VLAN normalization, see “Junos Space Layer 2 Services Overview” on
page 4.

For informationaboutVLANmanipulation, see “UnderstandingVLANManipulation (Normalization
and VLANMapping) on Ethernet Services” on page 32.

This check box is available only if the signaling type is BGP.To enable a service provisioner to define
primary and backupPEdevices in amultihomed group that serves as a single customer site, select
AllowMultihoming.

AllowMultihoming

The Auto Discovery check box is available only if the signaling type is LDP.

NOTE: If theEnableStaticPWLabelscheckbox in theGeneralwindow is selected for LDPsignaling,
then the Auto Discovery check box is disabled in the Connectivity Settings page.

Auto Discovery

The Auto Discovery check box is not available when the signaling type is BGP.

If you select the Auto Discovery check box, the following fields are available:

• Route target

• Route distinguisher

• VPN ID

If you disable the Auto Discovery check box, specify the VPLS ID.
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ActionField

This field is available only if the signaling type is LDP and auto discovery is disabled.

Identifies the virtual circuit identifier used for the VPLS routing instance.

• Autopick

• Select manually

VPLS ID

This field is available only if the signaling type is LDP and auto discovery is enabled.

Identifies the VPN ID associated with the router.

• Autopick

• Select manually

VPN ID

To enableMAC learning, select the check box.MAC learning

Maximum number of MAC addresses learned from an interface.

Range: 1 through 131071 MAC addresses per interface

InterfaceMAC limit

To enableMAC statistic, select the check box.MAC statistics

Modify the size of the MAC address table for the bridge domain.

Range: 16 through 1048575

To allow the service provisioner to override the MAC settings, select Editable in Service Order.

MAC table size
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2. ClickNext to save theconnectivity settings. “SpecifyingAdvancedSettings”onpage 137

Specifying Advanced Settings

In this step, you can specify the parameters that define advanced connectivity between

sites across the service provider network. The following illustration shows the Advanced

window.

To specify advanced settings:

1. Fill in the fields as indicated in the table.

ActionField

Select the Include check box for each advanced setting that you want to include in the service
definition.

NOTE: If you select any advanced parameters for a service definition, youmust also select the
Include check box for the Disable tunnel services parameter, and select or clear the Disable tunnel
services check box.

For MX Series devices, if you deploy a VPLS service without selecting the Include check box for
Disable tunnel services parameter, the VPLS service is down. As a work around, you can push the
configuration to each PE device for the service by running the following command:

root@test_device# set chassis fpc 0 pic 1 tunnel-services bandwidth 1g

Include

Enable or disable tunnel-services to specify that traffic for particular VPLS routing instances be
forwarded to specific virtual tunnel (VT) interfaces.

• To enable tunnel-services, clear the Disable tunnel-services check box.

• To disable tunnel-services, select the Disable tunnel-services check box (default).

Disable tunnel services

Enable or disable local switching. In local switching mode, you can terminate multiple Layer 2
circuit pseudowires at a single VPLSmesh group:

• To enable local switching across the network, clear the Disable local-switching check box.

• To disable local switching across the network, select the Disable local-switching check box
(default).

Disable local-switching

In the fast-reroute-priority, specify the reroute priority for a VPLS routing instance:

• HIGH—Set the fast reroute priority for a VPLS routing instance to high. During a fast reroute
event, the router repairs next hops for high-priority VPLS routing instances first.

• MEDIUM—Set the fast reroute priority for a VPLS routing instance to medium. During a fast
rerouteevent, the router repairs nexthops formedium-priorityVPLS instancesafter high-priority
VPLS routing instances but before low-priority VPLS routing instances.

• LOW—Set the fast reroute priority for aVPLS routing instance to low,which is the default. During
a fast reroute event, the router repairs next hops for low-priority VPLS routing instances last.

fast-reroute-priority
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ActionField

Configure the label block size for VPLS labels by using one of the following values.

• 2—Allocate the label blocks in increments of 2. Use this setting for a VPLS domain that has only
two sites with no future expansion plans.

• 4—Allocate the label blocks in increments of 4.

• 8—Allocate the label blocks in increments of 8. This is the default.

• 16—Allocate the label blocks in increments of 16. A label block size of 16 enables you tominimize
the number of routes in the VPLS domain. Use this setting only if the number of routes is the
primary concern.

NOTE: This field is unavailable if the Signaling type is LDP and the Auto discovery is enabled.

Label block size

Selectaconnection-type tospecifywhenaVPLSconnection is takendown,dependingonwhether
the interface for the VPLS routing instance is customer-facing or integrated routing and bridging
(IRB):

• ce—Require that for the VPLS connection to be up, the customer-facing interface for the VPLS
routing instancemust also be up. If the customer-facing interface fails, the VPLS connection is
taken down. This is the default.

• irb—AllowaVPLSconnection to remain up so long as an IRB interface is configured for theVPLS
routing instance.

NOTE: This field is unavailable if the Signaling type is LDP and the Auto discovery is enabled.

Connectivity type

By default, each advanced setting that you include in the service definition can be edited in the
service order. To prevent the service provisioner from overriding an advanced setting in the service
order, clear the Editable in Service Order check box.

Editable in Service Order

2. Click Finish to save the advanced settings.

The service definition is complete.

Related
Documentation

Publishing a Custom Service Definition on page 198•

• Predefined Multipoint-to-Multipoint Ethernet Service Definitions on page 365

• Viewing Service Definitions on page 701

• Creating a Point-to-Point Ethernet Service Definition on page 97

• Creating a Point-to-Multipoint VPLS Service Definition on page 138

Creating a Point-to-Multipoint VPLS Service Definition

Thisprocedureprovides thesteps tocreateadefinition for apoint-to-multipointEthernet

service. Point-to-multipoint services are also known as hub and spoke services.

The standard service definitions that came with your initial software installation are

designed to be appropriate for most requirements. You can also create a customized

service definition—for example, to set different bandwidth limits on the service than

those offered in the standard service definitions.
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When the new service definition is complete and published, network operators or service

provisioners can use the completed service definition as a base for creating and then

activating point-to-multipoint Ethernet services on the network.

The windows appear in the order stated. You can, however, perform these steps in any

order by accessing them through the task list in the right panel. If the panel is not visible,

click the snap tool on the right side of the main display area.

• Specifying General Information for Point-to-Multipoint VPLS Service

Definitions on page 224

• Specifying UNI Settings on page 227

• Specifying Connectivity and MAC Security Information on page 244

• Specifying Advanced Settings on page 247

223Copyright © 2015, Juniper Networks, Inc.

Chapter 6: Service Design: Managing VPLS Service Definitions



Specifying General Information for Point-to-Multipoint VPLS Service Definitions
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In the Network Activate task pane, select Service Design >Manage Service Definitions >

Create VPLS Service Definition. The General settings window appears.

To specify the general information for a point-to-multipoint service definition:

1. Fill in the fields in the Generalwindow.

ActionField

Type a name for the service definition.Name

Select Point-to-Multipoint Ethernet (VPLS)Service type
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ActionField

Select signaling type:

• BGP— If BGP signaling is selected, the following fields are available in the connectivity window:
• Route target

• Route distinguisher

• VLAN normalization

• AllowMultihoming

• Mac Security Settings

• VCID, if Enable PWExtension is enabled

• LDP—If LDP signaling is selected, the following fields are available in the connectivity window:
• Auto Discovery

• Route target, if Auto Discovery is enabled

• Route distinguisher, if Auto Discovery is enabled

• VPLS ID, if Auto Discovery is disabled

• VPN ID, if Auto Discovery is enabled

• VLAN normalization

• Mac Security Settings

NOTE: The Signaling is not editable in the service order.

Signaling

Type a brief description or other comment that you want to appear in the Service Definition table.Comments (Optional)

When you enable QoS in the service definition, youmust specify a QoS profile in the service order to
classify traffic into defined service groups toprovide the special treatment of traffic across the network
service. For example, voice traffic can be sent across certain links, and data traffic can use other links.

Enable QoS

Select this check box to create the link into Layer 3. If you enable the Layer 3 access, the available
Ethernet option in the UNI Settings are:

• port-port

• dot1q

• qinq

• asymmetric tag depth

Enable L3 Access

Select this check box to enable pseudowire extension. You cannot edit this check box in the service
order.

Enable PWExtension

Select this check box to enable resiliency. You cannot edit this field in the service order.

If theSignaling type is BGP, you need to select the EnablePWExtension check box to enable the Enable
PWResiliency check box.

For more information of pseudowire redundancy, see “Redundant Pseudowires for Layer 2 Circuits
and VPLS” on page 38.

Enable PWResiliency

Select this check box to enable a pseudowire connection by configuring static values.

NOTE: The Enable Static PW Labels check box is enabled for both signaling types: LDP and BGP.

When the signaling type is BGP, selection of this checkbox enables the Enable PWResiliency checkbox
and automatically selects the Enable PWExtension checkbox.

Enable Static PW
Labels
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ActionField

(Optional) To include a service template for the service, select a service template from the Service
Template list.

The selected service template appears in the Default Service Template field.

You can select one or more service templates as the default service template. By default, the default
service templates are attached to the endpoints.

NOTE: You cannot add or delete a service template while creating a service order.

The remaining service templates on theServiceTemplate list are termedas optional service templates.
You can attach the optional service templates to the endpoints on a need basis.

In the View Service Definition Details window, the value for the default service template in the Default
Service Template column is True.

For instructions on creating a service template, see “Creating a Service Template” on page 409.

Service Template
Definition

2. ClickNext to save the information.Continuewith “SpecifyingUNISettings”onpage 143.

Specifying UNI Settings

In this step, youprovide theUNI serviceattributes for this servicedefinition. Theattributes

you set depend on whether you are setting attributes for ports, 802.1Q interfaces, or

Q-in-Q interfaces:

• Specifying UNI Settings for Port-to-Port Services on page 227

• Specifying UNI Settings for Services with 802.1Q Interface Types on page 231

• Specifying UNI Settings for Services with Q-in-Q Interface Types on page 235

• SpecifyingUNISettings forServiceswithFlexibleVLANTagging (Asymmetric Interface

Types) on page 240

Specifying UNI Settings for Port-to-Port Services

NOTE: You can select the port-port option only for services that are not
normalized. That is, youmust select Not Normalizedwhen specifying the

connectivity.

227Copyright © 2015, Juniper Networks, Inc.

Chapter 6: Service Design: Managing VPLS Service Definitions



To set UNI attributes for port UNIs:

1. Fill in the fields as indicated in the table.

ActionField

Traffic Treatment Settings

Select port-port from the drop-down list.

The Ethernet option you choose determines the other options you can select and specify on the
page.

Ethernet option

Select N/A. For port-to-port services, all traffic is always transported.Customer traffic type

The VLAN ID cannot be selected. In port-to-port services, all traffic and all VLANs on one port are
transported to all other ports.

VLAN ID selection

To allow the service provisioner to override the MTU setting, select the check box.Editable in Service Order

Interface Settings

In the Physical IF encapsulation box, select ethernet-vpls, which is the only valid physical interface
encapsulation method for port-to-port services.

The Logical IF encapsulation field cannot be selected because it is not relevant to port-to-port
services.

Physical IF encapsulation

You cannot select a choice in this field because it is not relevant to port-to-port services.Logical IF encapsulation
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ActionField

LDP PWExtension Settings

NOTE: The LDP PWExtension Settings is available only if you have selected the Enable PWExtension check box in the General
window.

In the Physical IF encapsulation box, select ethernet-ccc, which is the only valid physical interface
encapsulation method for port-to-port services.

Physical IF encapsulation

You can not select a choice in this field because it is not relevant to port-to-port services.Logical IF encapsulation

In the MTU range boxes, type the lowest and highest values for MTU that the service provisioner
can type.

MTUSettings

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased

If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 1.

• Line Rate Based

If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limitingcheckbox.

Calculate Burst Size

The following illustration shows the Calculate Burst-Size panel parameters if you select the Line Rate Based option.

Bandwidth Settings

The following illustration shows the Bandwidth Settings panel, which appears if you do not select the Enable QoS check box
in the preceding General settings window.
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ActionField

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are not available in the service definition when QoS Design software
is installed.

Enable rate limiting

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

Default bandwidth (Mbps)

Specify the minimum bandwidth value in Kbps.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 11 on page 104

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Increment (Kbps)

The following table lists theMax Bandwidth (Mbps) for the M Series, MX Series, and

ACX Series Routers:

Table 16: MaximumBandwidth for M Series, MX Series, and ACX Series Routers

ACX 2000
MX Series Non-3D
PICMX Series 3D PICM Series IQ2 PICM Series IQ2E PIC

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

100,000
Mbps or
100 Gbps

100,000
Mbps or
100 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

32,000
Mbps or
32 Gbps

32,000
Mbps or
32 Gbps

2. Click Next to save the UNI settings. Continue with “Specifying Connectivity and MAC

Security Information” on page 160.
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Specifying UNI Settings for Services with 802.1Q Interface Types

To set UNI attributes for 802.1Q interfaces:

1. Fill in the fields as indicated in the table.

ActionField

Traffic Treatment Settings

Select dot1q from the drop-down list.

The Ethernet option you choose determines the other options you can select and specify on the
page.

Ethernet option
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ActionField

Select a traffic type to restrict the traffic that canbe transportedacross thenetwork for the service:

• SelectTransport singlevlan to transport the traffic for a specificVLANacross thenetwork. Single
VLAN is the only option for 802.1Q interface types. You need to specify theOuter Tag protocol
ID.

NOTE: For an interface, youmust configure a physical port with the possible Tag Protocol
Identifiers (TPID) either manually or through a template. Otherwise, the service creation fails
for all TPIDs except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x9100
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x88a8
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x8100

• Select Transport vlan range to transport the traffic for a range of VLANs across the network.

NOTE: Make sure to check Editable in Service Order if you want the service provisioner to be able
to override this setting.

Customer traffic type

In the VLAN ID selection box, specify how the VLAN ID is determined:

• To allow the service provider to specify the VLAN ID, chooseSelectmanually. This option is used
typically when no VLAN normalization is applied.

Specify the VLAN ID range in VLAN range for manual input.

Range: 1 through 4094

To enable the service provisioner to override this setting, select Editable in Service Order.

• To cause the VLAN ID to be selected automatically from the VLAN ID pool, select Auto pick.
This option is used typically when VLAN normalization is applied.

Specify the VLAN ID pool in VLAN range for auto-pick

Range: 1 through 4094

To enable the service provisioner to override this setting in a service order, select Editable in
Service Order.

To enable the service provisioner to override this setting in a service order, select Editable in Service
Order.

VLAN ID selection

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input
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ActionField

Select the outer tag protocol ID if the Customer traffic type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPID) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x9100
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x88a8
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x8100

Outer Tag protocol ID

Toallow the service provisioner to override theMTUsetting, select the check box for those options.Editable in Service Order

Interface Settings

In the Physical IF encapsulation box, select the default physical encapsulation scheme to be used
by service orders based on this service definition. For point-to-multipoint services with 802.1Q
interfaces, the only option is flexible-ethernet-services.

Physical IF encapsulation

The Logical IF encapsulation field is constrained by your selection in the Physical IF encapsulation
field. For the physical encapsulation mode of flexible-ethernet-services, your only option is to
select vlan-vpls for the logical encapsulation method.

Logical IF encapsulation

LDP PWExtension Settings

NOTE: The LDP PWExtension Settings is available only if you have selected the Enable PWExtension check box in the General
window.

In the Physical IF encapsulation box, select one of the following options:

• vlan-ccc

• extended-vlan-ccc

• flexible-ethernet-services

Physical IF encapsulation

The Logical IF encapsulation field is constrained by your selection in the Physical IF encapsulation
field.

For the physical encapsulation mode of vlan-ccc or flexible-ethernet-services, your only option is
to select vlan-ccc for the logical encapsulation method.

For the physical encapsulation mode of extended-vlan-ccc, your only option is to select
extended-vlan-ccc for the logical encapsulation method.

Logical IF encapsulation

In the Default MTU box, specify the MTU for each UNI.

To allow the service provisioner to override the MTU setting, select Editable in Service Order and,
in the MTU range boxes, type the highest and lowest MTU values that the service provisioner can
type.

MTUSettings
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ActionField

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased

If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 1.

• Line Rate Based

If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limitingcheckbox.

Calculate Burst Size

The following illustration shows the appearance of the Calculate Burst-Size panel parameters if you select the Line Rate Based
option.

Bandwidth Settings

The following illustration shows the Bandwidth Settings panel, which appears if you do not select the Enable QoS check box
in the preceding General settings window.

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are not available in the service definition when QoS Design software
is installed.

Enable rate limiting

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100000Mbps

Default bandwidth (Mbps)
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ActionField

Specify the minimum bandwidth value in Kbps.

Default: 1000 Kbps

Range: 64 Kbps through 100000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 11 on page 104

Default: 100 Mbps

Range: 1 Mbps through 100000Mbps/100Gbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100000 Kbps

Increment (Kbps)

2. Click Next to save the UNI settings. Continue with“Specifying Connectivity and MAC

Security Information” on page 160.

Specifying UNI Settings for Services with Q-in-Q Interface Types

To set UNI attributes for Q-in-Q interfaces:

1. Fill in the fields as indicated in the table.

ActionField

Traffic Treatment Settings
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ActionField

Select qinq from the drop-down list.

The window expands to include options specific to Q-in-Q interfaces.

Ethernet option

In the Customer traffic type box:

• Select Transport all traffic to transport the traffic from all VLANs across the network. You need
to specify only theOuter Tag protocol ID.

NOTE: For an interface, youmust configure a physical port with the possible Tag Protocol
Identifiers (TPID) either manually or through a template. Otherwise, the service creation fails
for all TPIDs except 0x8100.

• SelectTransport singlevlan to transport the traffic for a specificVLANacross thenetwork. Single
VLAN is the only option for 802.1Q interface types. You need to specify theOuter Tag protocol
ID and the Inner Tag protocol ID.

• Select Transport vlan range to limit the traffic across the network to a specific range of VLANs.

If you select this option, the service provisioner will be prompted for the VLAN-ID range when
creating a service order based on this service definition. You need to specify theOuter Tag
protocol ID and the Inner Tag protocol ID.

Customer traffic type

In the VLAN ID selection box, specify how the service VLAN ID is set during service order creation:

• To cause the provisioning software to automatically select the service VLAN ID from the VLAN
ID pool, select Auto pick. This option is used typically when no VLAN normalization is applied.

Specify the VLAN ID pool in VLAN range for auto-pick

Range: 1 through 4094

• To allow the service provisioner to specify the service VLAN ID, choose Selectmanually. This
option is used typically when VLAN normalization is applied.

Specify the VLAN ID range in VLAN range for manual input.

Range: 1 through 4094

To enable the service provisioner to override this setting, select the Editable in Service Order check
box.

VLAN ID selection

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick:

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input
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ActionField

Select the outer tag protocol ID if the Customer traffic type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPID) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x9100
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x88a8
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x8100

Outer Tag protocol ID

Select the inner tag protocol ID:

• 0x88a8

• 0x8100

• 0x9100

NOTE: You cannot specify the Inner Tag protocol ID if the Customer traffic type is Transport single
VLAN.

Inner Tag protocol ID

Toallow the service provisioner to override theMTUsetting, select the check box for those options.Editable in Service Order

Interface Settings

In the Physical IF encapsulation box, select the default physical encapsulation scheme to be used
by service orders based on this service definition. For point-to-multipoint services with Q-in-Q
interfaces, the only option is flexible-ethernet-services.

Physical IF encapsulation

The Logical IF encapsulation field is constrained by your selection in the Physical Interface
Encapsulation field. For the physical encapsulation mode of flexible-ethernet-services, your only
option is to select vlan-vpls for the logical encapsulation method.

Logical IF encapsulation

LDP PWExtension Settings

NOTE: The LDP PWExtension Settings is available only if you have selected the Enable PWExtension check box in the General
window.

In the Physical IF encapsulation box, select one of the following options:

• vlan-ccc

• extended-vlan-ccc

• flexible-ethernet-services

Physical IF encapsulation
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ActionField

The Logical IF encapsulation field is constrained by your selection in the Physical IF encapsulation
field.

For the physical encapsulation mode of vlan-ccc or flexible-ethernet-services, your only option is
to select vlan-ccc for the logical encapsulation method.

For the physical encapsulation mode of extended-vlan-ccc, your only option is to select
extended-vlan-ccc for the logical encapsulation method.

Logical IF encapsulation

In the Default MTU box, specify the MTU for each UNI.

To allow the service provisioner to override the MTU setting, select the Editable in Service Order
check box and, in the MTU range boxes, type the lowest and highest values for the MTU that the
service provisioner can type.

MTUSettings

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased

If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 1.

• Line Rate Based

If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limitingcheckbox.

Calculate Burst Size

The following illustration shows the Calculate Burst-Size panel parameters if you select the Line Rate Based option.

Bandwidth Settings

The following illustration shows the Bandwidth Settings panel, which appears if you do not select the Enable QoS check box
in the preceding General settings window.

Copyright © 2015, Juniper Networks, Inc.238

Junos Space Cross Provisioning Platform



ActionField

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are not available in the service definition when QoS Design software
is installed.

Enable rate limiting

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100000Mbps

Default bandwidth (Mbps)

Specify the minimum bandwidth value in Kbps.

Default: 1000 Kbps

Range: 64 Kbps through 100000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 11 on page 104

Default: 100 Mbps

Range: 1 Mbps through 100000Mbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100000 Kbps

Increment (Kbps)

2. Click Next to save the UNI settings. Continue with“Specifying Connectivity and MAC

Security Information” on page 160.
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Specifying UNI Settings for Services with Flexible VLAN Tagging (Asymmetric
Interface Types)

Youcanspecify theEthernetoptionasymmetric tagdepth to createaservice that includes

any combination of port-based interfaces, 802.1Q interfaces, and Q-in-Q, interfaces.

To set UNI attributes for asymmetric interfaces:

1. Fill in the fields as indicated in the table.

ActionField

Traffic Treatment Settings

Select asymmetric tag depth from the drop-down list.Ethernet option

In the Customer traffic type box:

• Select Transport all traffic to transport the traffic from all VLANs across the network. You need
to Specify only theOuter Tag protocol ID.

NOTE: For an interface, youmust configure a physical port with the possible Tag Protocol
Identifiers (TPID) either manually or through a template. Otherwise, the service creation fails
for all TPIDs except 0x8100.

• SelectTransport singlevlan to transport the traffic for a specificVLANacross thenetwork. Single
VLAN is the only option for 802.1Q interface types. You need to specify theOuter Tag protocol
ID and the Inner Tag protocol ID.

• Select Transport vlan range to limit the traffic across the network to a specific range of VLANs.

If you select this option, the service provisioner will be prompted for the VLAN-ID range when
creating a service order based on this service definition. You need to specify theOuter Tag
protocol ID and the Inner Tag protocol ID.

Customer traffic type
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ActionField

In the VLAN ID selection box, specify how the service VLAN ID is set during service order creation:

• To cause the provisioning software to automatically select the service VLAN ID from the VLAN
ID pool, select Auto pick. This option is used typically when no VLAN normalization is applied.

Specify the VLAN ID pool in VLAN range for auto-pick

Range: 1 through 4094

• To allow the service provisioner to specify the service VLAN ID, choose Selectmanually. This
option is used typically when VLAN normalization is applied.

Specify the VLAN ID range in VLAN range for manual input.

Range: 1 through 4094

To enable the service provisioner to override this setting, select the Editable in Service Order check
box.

VLAN ID selection

Specify the VLAN ID pool.

Range: 1 through 4094

VLAN range for auto-pick:

Specify the VLAN ID range.

Range: 1 through 4094

VLAN range for manual
input

Select the outer tag protocol ID if the Customer traffic type is Transport single VLAN:

• 0x88a8

• 0x8100

• 0x9100

NOTE: Foran interface, youmust configureaphysical portwith thepossibleTagProtocol Identifiers
(TPID) either manually or through a template. Otherwise, the service creation fails for all TPIDs
except 0x8100. To configure the TPIDs manually, use the following commands:

set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x9100
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x88a8
set interfaces ae0 aggregated-ether-options ethernet-switch-profile
tag-protocol-id 0x8100

Outer Tag protocol ID

Select the inner tag protocol ID:

• 0x88a8

• 0x8100

• 0x9100

NOTE: You cannot specify the Inner Tag protocol ID if the Customer traffic type is Transport all
traffic.

Inner Tag protocol ID

Toallow the service provisioner to override theMTUsetting, select the check box for those options.Editable in Service Order

Interface Settings
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ActionField

Select thedefault physical encapsulation scheme tobeusedby serviceordersbasedon this service
definition. We recommend you select flexible-ethernet-services.

For multipoint-to-multipoint services with Q-in-Q interfaces, the only option is
flexible-ethernet-services

Physical IF encapsulation

The Logical IF encapsulation field is constrained by your selection in the Physical Interface
Encapsulation field. For the physical encapsulation mode of flexible-ethernet-services, your only
option is to select vlan-vpls for the logical encapsulation method.

Logical IF encapsulation

LDP PWExtension Settings

NOTE: The LDP PWExtension Settings is available only if you have selected the Enable PWExtension check box in the General
window.

In the Physical IF encapsulation box, select one of the following options:

• vlan-ccc

• extended-vlan-ccc

• flexible-ethernet-services

Physical IF encapsulation

The Logical IF encapsulation field is constrained by your selection in the Physical IF encapsulation
field.

For the physical encapsulation mode of vlan-ccc or flexible-ethernet-services, your only option is
to select vlan-ccc for the logical encapsulation method.

For the physical encapsulation mode of extended-vlan-ccc, your only option is to select
extended-vlan-ccc for the logical encapsulation method.

Logical IF encapsulation

In the Default MTU box, specify the MTU for each UNI.

To allow the service provisioner to override the MTU setting, select the Editable in Service Order
check box and, in the MTU range boxes, type the lowest and highest values for the MTU that the
service provisioner can type.

MTUSettings

Calculation of Burst-Size

Select the preferred option for calculating the burst size:

• MTUBased

If you select the optionMTUBased, you can specify a value forMTUFactor in the range 1 through
1087902.

The default value forMTU Factor is 1.

• Line Rate Based

If you select the option Line Rate Based, you can specify a value for Burst Period in the range 1
through 7450milliseconds.

The default value for Burst Period is 1.

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limitingcheckbox.

Calculate Burst Size
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ActionField

The following illustration shows the Calculate Burst-Size panel parameters if you select the Line Rate Based option.

Bandwidth Settings

The following illustration shows the Bandwidth Settings panel, which appears if you do not select the Enable QoS check box
in the preceding General settings window.

To enable a service provisioner to limit the available bandwidth, select this check box, and type a
default bandwidth limit.

NOTE: Bandwidth settings are not available in the service definition when QoS Design software
is installed.

Enable rate limiting

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100000Mbps

Default bandwidth (Mbps)

Specify the minimum bandwidth value in Kbps.

Default: 1000 Kbps

Range: 64 Kbps through 100000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value in Mbps. For more information onmaximum bandwidth
see Table 11 on page 104

Default: 100 Mbps

Range: 1 Mbps through 100000Mbps

Max Bandwidth (Mbps)

Specify a value that defines which values in the range is made available to the service provisioner.

Default: 1000 Kbps

Range: 64 Kbps through 100000 Kbps

Increment (Kbps)
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2. Click Next to save the UNI settings. Continue with“Specifying Connectivity and MAC

Security Information” on page 160.

Specifying Connectivity andMAC Security Information

In this step, you specify the attributes that define the connectivity among remote sites

across the service provider network and the service security. The following is a sample

Connectivitywindow.
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To configure connectivity between sites across the network:

1. Fill in the fields in the Connectivitywindow.

ActionField

Choose one of the following options from the list:Route target

• Auto pick

• Select manually

This field is available in either of the following cases:

• The Signaling type is BGP.

• The Signaling type is LDP and Auto Discovery is enabled.

Select a route distinguisher option:Route distinguisher

• Selectmanually—The service provider specifies the route distinguisher.

• Auto pick—The route distinguisher is selected automatically.

To override this setting in the service order, select the Editable in Service Order check box.

This field is available in either of the following cases:

• The Signaling type is BGP.

• The Signaling type is LDP and Auto Discovery is enabled.

Select a value:VLAN normalization

• Normalize to VLAN all—To preserve customer VLAN IDs (and customer QoS priorities) across
the network.

NOTE: For services that transport a range of VLAN IDs, youmust set VLANNormalization to all.
You cannot transport a range of VLAN IDs without normalization.

• Normalized VLAN none—To preserve no VLAN IDs across the network

• Notnormalized—IfVLAN IDsare tobeprovidedmanuallyandare required tomatcheachendpoint

• Normalized to Dot1q—To transport only single-tagged frames across the network core. All port,
dot1q , and Q-in-Q traffic is transported across the network.

• Normalized to QinQ—To transport only double-tagged frames across the network core. All port,
dot1q , and Q-in-Q traffic is transported across the network.

• Normalization not required—To specify no normalization for port-to-port services

For more information about VLAN normalization, see “Junos Space Layer 2 Services Overview” on
page 4.

For informationaboutVLANmanipulation, see “UnderstandingVLANManipulation (Normalization
and VLANMapping) on Ethernet Services” on page 32.

This check box is available only if the signaling type is BGP.To enable a service provisioner to define
primary and backup PE devices in a multihomed group that serves a single customer site, select
AllowMultihoming.

AllowMultihoming
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ActionField

You cannot enable or disable the Auto Discovery check box if you have enabled the Enable PW
Extension or the Enable PWResiliency check boxes.

This check box is available only if the signaling type is LDP.

NOTE: If the Enable Static PW Labels checkbox in the Generalwindow is checked for the LDP
signaling, then the Auto Discovery checkbox is disabled in the Connectivity Settings page.

The AutoDiscovery checkbox is not available on the Connectivity Settings pagewhen the signaling
type is BGP.

On enabling the auto discovery, the following fields are available:

• Route target

• Route distinguisher

• VPN ID

On disabling the auto discovery specify the VPLS ID.

Auto Discovery

This field is available only if the signaling type is LDP and auto discovery is disabled.

Identifies the virtual circuit identifier used for the VPLS routing instance.

• Autopick

• Select manually

VPLS ID

This field is available only if the signaling type is LDP and auto discovery is enabled.

Identifies the VPN ID associated with the router.

• Autopick

• Select manually

VPN ID

This field is available only if the Enable PWResiliency is enabled.

Revert time for redundant Layer 2 circuits and VPLS pseudowires.

Default: 5 seconds

Range: 0 through 65,535 seconds

Revert time (sec)

This field is available only if the Enable PWResiliency is enabled.

Specify the delay to wait before the backup pseudowire takes over.

Default: 0 second

Range: 0 through 180 seconds

Switch Over Delay (sec)

This field is available only if the Service type is point-to-multipoint, the Signaling is BGP, and the
Enable PWExtension is enabled.

The VCID can be either set automatically by the Junos Space software, or it can be set manually
by the service provisioner in the service order.

VCID

To enableMAC learning, select the check box.MAC learning
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ActionField

Maximum number of MAC addresses learned from an interface.

Range: 1 through 131071 MAC addresses per interface

InterfaceMAC limit

To enableMAC statistic, select the check box.MAC statistics

Modify the size of the MAC address table for the bridge domain.

Range: 16 through 1048575

To allow the service provisioner to override the MAC settings, select Editable in Service Order.

MAC table size

2. Click Next to save the connectivity settings and continue with “Specifying Advanced

Settings” on page 137.

Specifying Advanced Settings

In this step, you can specify the parameters that define advanced connectivity between

sites across the service provider network. The following illustration shows the Advanced

window.

To specify advanced settings:

1. Fill in the fields as indicated in the table.

ActionField

Select the Include check box for each advanced setting that you want to include in the service
definition.

NOTE: If you select any advanced parameters for a service definition, youmust also select the
Include check box for the Disable tunnel services parameter, and select or clear the Disable tunnel
services check box.

For MX Series devices, if you deploy a VPLS service without selecting the Include check box for
Disable tunnel services parameter, the VPLS service is down. As a work around, you can push the
configuration to each PE device for the service by running the following command:

root@test_device# set chassis fpc 0 pic 1 tunnel-services bandwidth 1g

Include

Enable or disable tunnel-services to specify that traffic for particular VPLS routing instances be
forwarded to specific virtual tunnel (VT) interfaces.

• To enable tunnel-services, clear the Disable tunnel-services check box.

• To disable tunnel-services, select the Disable tunnel-services check box (default).

Disable tunnel services
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ActionField

Enable or disable local switching. In local switching mode, you can terminate multiple Layer 2
circuit pseudowires at a single VPLSmesh group:

• To enable local switching across the network, clear the Disable local-switching check box.

• To disable local switching across the network, select the Disable local-switching check box
(default).

Disable local-switching

In the fast-reroute-priority, specify the reroute priority for a VPLS routing instance:

• HIGH—Set the fast reroute priority for a VPLS routing instance to high. During a fast reroute
event, the router repairs next hops for high-priority VPLS routing instances first.

• MEDIUM—Set the fast reroute priority for a VPLS routing instance to medium. During a fast
rerouteevent, the router repairs nexthops formedium-priorityVPLS instancesafter high-priority
VPLS routing instances but before low-priority VPLS routing instances.

• LOW—Set the fast reroute priority for aVPLS routing instance to low,which is the default. During
a fast reroute event, the router repairs next hops for low-priority VPLS routing instances last.

fast-reroute-priority

Configure the label block size for VPLS labels by using one of the following values.

• 2—Allocate the label blocks in increments of 2. Use this setting for a VPLS domain that has only
two sites with no future expansion plans.

• 4—Allocate the label blocks in increments of 4.

• 8—Allocate the label blocks in increments of 8. This is the default.

• 16—Allocate the label blocks in increments of 16. A label block size of 16 enables you tominimize
the number of routes in the VPLS domain. Use this setting only if the number of routes is the
primary concern.

NOTE: This field is unavailable if the Signaling type is LDP and the Auto discovery is enabled.

Label block size

Selectaconnection-type tospecifywhenaVPLSconnection is takendown,dependingonwhether
the interface for the VPLS routing instance is customer-facing or integrated routing and bridging
(IRB):

• ce—Require that for the VPLS connection to be up, the customer-facing interface for the VPLS
routing instancemust also be up. If the customer-facing interface fails, the VPLS connection is
taken down. This is the default.

• irb—AllowaVPLSconnection to remain up so long as an IRB interface is configured for theVPLS
routing instance.

NOTE: This field is unavailable if the Signaling type is LDP and the Auto discovery is enabled.

Connectivity type

By default, each advanced setting that you include in the service definition can be edited in the
service order. To prevent the service provisioner from overriding an advanced setting in the service
order, clear the Editable in Service Order check box.

Editable in Service Order

2. Click Finish to save the advanced settings.

The service definition is complete.

Related
Documentation

Publishing a Custom Service Definition on page 198•

• Predefined Point-to-Multipoint Ethernet Service Definitions on page 390

• Viewing Service Definitions on page 701
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• Creating a Point-to-Point Ethernet Service Definition on page 97

• Creating a Multipoint-to-Multipoint VPLS Service Definition on page 117

Creating a Service Definition for VPLS Access into Layer 3 Networks

You can configure an Integrated Routing and Bridging (IRB) interface to provide access

from VPLS Layer 2 networks and services into Layer 3 networks. If the IRB interface

configured as a Layer 3 interface is being used in a routing instance, that routing instance

will specifically declare it as routing-interface rather thana regularVPLS interface (which

acts like the interface on a specific VPLS site). This feature requires a normalized VLAN

(vlan-id=xxxwhich is the sameas the unit nameonwhich the inet4 address is specified)

Junos Space uses the two peer subinterfaces of the IRB to create the link between an

existing VLAN and the Layer 3 network. An extra VPLS node is required to support the

IRB interface which allows the rest of the VPLS nodes to be able to access all Layer 3

networks reachable through that interface. Providing the VPLS access into Layer 3

networks enhances basic VPLS services. Because this feature requires a normalized

VLAN, it is available only on the Juniper Networks MX 3D Router series.

Prerequisites for VPLS Access into Layer 3 Networks

• The PE device with the IRBmust be a Juniper Networks MX 3D Series Router to

accommodate the normalized VLAN requirement.

• In addition to the PE device used for the IRB, 2 or more PEsmust exist on the VPLS

network for a minimum of 3 PE devices.

• A VLANmust already exist to configure this feature.
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To begin the configuration of the IRB interface, in the Network Activate task pane, select

Service Design >Manage Service Definitions > Create VPLS Service Definition.

ActionField

Provide a name for the VPLS service definition you want to create.Name

Select the type of service from themenu list. To create theVPLS into Layer 3 service, use either
of the following service type:

Service Type

• Multipoint-to-Multipoint Ethernet (VPLS)

• Point-to-Multipoint Ethernet (VPLS)

Provide any comments or a description that will help explain the purpose of this definition.Comments

Check the box to create the link into Layer 3.Enable L3 Access

1. Click Next to display the next screen, UNI Settings, and continue creating the service

definition.
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Specifying UNI Settings

ActionUNI Settings Field

Traffic Treatment Settings

Indicate the Ethernet option to use for this VPLS service definition. Choices are qinq or
dot1q.

Ethernet option

The only option for VPLS service definitions is Transport single VLAN.Customer traffic type

The only option for VPLS service definitions is Selectmanually.VLAN ID selection

Interface Settings

The only option for VPLS service definitions is flexible-ethernet-servicesPhysical IF encapsulation

The only option for VPLS service definitions is vlan-vpls.Logical IF encapsulation

MTU Settings

This field is populatedwith the default MTU value of 1522. If you are not using the default
value, enter the MTU value in bytes.

Default MTU (Bytes)

If you are specifying a customMTU value, indicate the range of values in bytes.MTU range (Bytes)

1. ClickNext to continue creating theVPLSservicedefinitionandspecify the connectivity

settings.
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Specifying Connectivity Settings

ActionConnectivity Settings Field

The Route target field is prepopulated with the Auto pick option.Route target

The Route distinguisher field is prepopulated with the Auto pick option.Route distingquisher

All VPLS service definitions require VLAN normalization.VLAN normalization

If you are using multihoming features, check the box.AllowMultihoming

MAC Security Settings

MAC learning is on by default for VPLS service definitions.MAC learning

The default value for InterfaceMAC limit is 1024. If you are using a different value,
enter that value.

InterfaceMAC limit

The table size is predetermined to correspond to the default MAC limit. If you are
using a value other than the default, specify that value.

MAC table size
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1. Click Finish to see the service definition inventory list.

2. Click on the unpublished service definition you just created.

3. Right-click on the selected service definition to choose publishing options.

4. Select the service definition and click Publish to save and publish the definition.

5. The next step is to create the service order. In the Network Activate task pane, select

Service Provisioning.
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Related
Documentation

Seamless MPLS Support in Junos Space Overview on page 18•

• Creating a Service Order for VPLS Access into Layer 3 Networks on page 525

Creating a VPLS Service Definition in Cross Provisioning Platform

Cross Provisioning Platform is an extension of the Network Activate application within

JunosSpace,whichprovidesa single paneof interaction todeploy services across vendor

network devices. This topic discusses how a VPLS service definition is created and

deployed across the devices of Juniper Networks involved in the Cross Provisioning

Platform.

To create a VPLS service definition, you need to create a configuration script in XSLT

format and upload this script to Cross Provisioning Platform from the local system. You

can add the script by selecting Cross Provisioning Platform > CPP > Scripts > Add Script.

NOTE: Junos Space server scripts aremandatory to create a VPLS service
definition.

To create a VPLS service definition:

1. In the Cross Provisioning Platform task pane, select CPP > Service Definitions.

The Service Definitions page that appears displays a list of the existing service

definitions.

2. Click Create CPP Service Definition above the tool grid.
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The Create Service Definition page appears.

3. Perform the following steps:

• In the General section:

a. In the Name field, type 3 through 128 alphanumeric characters to identify the

name of the service definition.

b. In the ID field, type 1 through2147483647 integers to identify the servicedefinition

by a unique value.

NOTE: The service definition ID is optional. If you do not provide any
value in this field, the default value is -1. In the service definition
selection grid, no value is displayed in the ID column. Each service

definition isassignedaunique ID. If yougiveanexisting IDvaluewhile
creating a new service definition, exception occurs.

c. In the Description field, type 3 through 256 alphanumeric characters to further

identify the service definition you named.

d. From the Type drop-down list, select VPLS.

• In the JUNOS Space Service Scripts section:
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a. From theSelect JunosCreationScript column, select a JunosSpace service script

that was written for the creation of the service definition. The script that you

selected is automatically populated in the corresponding Creation text field.

b. From the Select JunosModification Script column, select a Junos Space service

script that was written for the modification of the service definition. The script

that you selected is automatically populated in the correspondingModification

text field.

NOTE: The JunosSpace service scripts aremandatory to create aVPLS
service definition, whereas the SAM service scripts are optional.

• In the SAMService Scripts section:

a. From the Select SAMCreation Script column, select a SAM service script that

waswritten for the creation of the service definition. The script that you selected

is automatically populated in the corresponding Creation text field.

b. From theSelectSAMModificationScript column, select aSAMservice script that

was written for the modification of the service definition. The script that you

selected is automatically populated in the correspondingModification text field.

4. Click Create to create the service definition.

TheServiceDefinitionspage thatappearsdisplays the list of existing servicedefinitions

along with the service definition that you created.

5. Right-click the service definition you created from theServiceDefinitionswindowand

select Publish Service Definition.

The Publish Service Definitions dialog box that appears asks you to confirm the

selection.

6. Click Publish in the Publish Service Definitionswindow.

TheServiceDefinitionspage thatappearsdisplays the list of existing servicedefinitions

along with the service definition that you created.

7. Double-click the service definition to view the details.

The Service Definition Details page that appears displays the details of the service

definition along with the scripts that you uploaded.

Related
Documentation

• Adding Scripts Created for Cross Provisioning Platform on page 667

• Creating a VPLS Service Order in Cross Provisioning Platform on page 530
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CHAPTER 7

Service Design: Managing Layer 3 VPN
Service Definitions

• Creating a Full Mesh Layer 3 VPN Service Definition on page 257

• CreatingaHub-and-Spoke (One Interface) Layer 3VPNServiceDefinitiononpage264

• Creating a Service Definition for Point-to-Point Pseudowire Access into a Layer 3

VPN on page 272

• Creating a Multicast VPN Service Definition on page 277

• CreatingaLayer3VPNServiceDefinition inCross-ProvisioningPlatformforThird-Party

Devices on page 279

Creating a Full Mesh Layer 3 VPN Service Definition

This procedure provides the steps to create a definition for a full mesh Layer 3 VPN

Ethernet service.

You can create a customized service definition—for example, to set a different VLAN ID

range on the service than those offered in the standard service definitions.

When the new service definition is complete and published, network operators or service

provisioners can use the completed service definition as a base for creating and then

activating full mesh Ethernet services on the network.

The screens appear in the order stated. You can, however, perform these steps in any

order by accessing them through the task list in the right panel. If the panel is not visible,

click the snap tool on the right side of the main display area.

To create a full mesh Layer 3 VPN service definition:

1. Specifying General Information on page 257

2. Specifying UNI Settings on page 259

3. Specifying Connectivity Information on page 262

Specifying General Information

In the Network Activate task pane, select Service Design >Manage Service Definitions >

Create L3 VPN Service Definition.
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The Create Service Definitionwindow appears.

To specify general information for a full mesh service definition:

1. Fill in the fields on the General page as indicated in the following table:

ActionField

Type a unique name that identifies the full mesh Layer 3 VPN definition.

Range: 3 through 50 characters

Name

Select L3 VPN (Full Mesh).Service type

Type a comment that identifies or describes the definition.

Range: 1 through 200 characters

Comments

Select this check box to isolate the events related to an interface in OpenNMS.

NOTE: When you select this check box, only theMPLS traps aremonitored, not the jnxVpnIfVpn traps.

By default, all events are saved in the OpenNMS database.

Decouple Service
Status From Port
Status

When you enable QoS in the service definition, youmust specify a QoS profile in the service order to
classify traffic into defined service groups to provide special treatment of traffic across the network
service. For example, voice traffic can be sent across certain links, and data traffic can use other links.

NOTE: The Enable QoS check box appears only if you have installed the QoS Design application.

Enable QoS
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ActionField

(Optional) To include a service template for the service, select a service template from the Service
Template list.

The selected service template appears in the Default Service Template field.

You can select one or more service templates as the default service template. By default, the default
service templates are attached to the endpoints.

NOTE: You cannot add or delete a service template while creating a service order.

The remaining service templates on theServiceTemplate list are termedas optional service templates.
You can attach the optional service templates to the endpoints on a need basis.

In the View Service Definition Details window, the value for the default service template in the Default
Service Template column is True.

For instructions on creating a service template, see “Creating a Service Template” on page 409.

NOTE: To provision a Layer 3 VPN service for QinQ UNI type, you can create a service template with
service variables as interface name and unit name.

Service Template

2. Click Next to save the General page information. Continue with “Specifying UNI

Settings” on page 259.

Specifying UNI Settings

To provide the UNI service attributes for this service definition:
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1. Fill in the fields on the UNI Settings page as indicated in the following table:

ActionField

By default, this check box is unavailable.Ethernet

Specify how the VLAN ID is determined:

• To allow the service provider to specify the VLAN ID, choose Selectmanually. Specify the
range in VLAN range for manual input.

• To cause the VLAN ID to be selected automatically from the VLAN ID pool, select Auto pick.
This option is used typically when VLAN normalization is applied. Specify the range in VLAN
range for auto-pick

NOTE: Select theEditable inServiceOrdercheckbox if youwant tooverride theVLANIDselection
setting in the service order.

VLAN ID selection

Specify the range.

Range: 1 through 4094

VLAN range for auto-pick

Specify the range.

Range: 1 through 4094

NOTE: This parameter reserves a range of VLANs for provisioning Layer 3 VPNs. These VLANs
are not used to transport data from one end of a connection to the other.

VLANrange formanual input

Specify an MTU value in this field.

To see the permitted range for the MTU value, select the Editable in Service Order check box.

Default: 1522 bytes

Range: 1522 bytes through 9192 bytes

For a predefined service definition, the default MTU is 1522 bytes.

Default MTU (Bytes)

If you select the Editable in Service Order check box, you can specify a value range for MTU (in
bytes). .

Default: 1522 bytes

Range: 1522 bytes through 9192 bytes

NOTE: Ultimately, the system establishes the MTU bymultiplying the value you specify in the
Default MTU (Bytes) field by the value you specify for MTU Factor.

MTU Range (Bytes)

The Bandwidth Settings pane, appears if you do not select the Enable QoS check box in the
preceding General settings window. This panel includes the following fields:

• Enable rate limiting

• Default bandwidth (Mbps)

• Min Bandwidth (Kbps)

• Max Bandwidth (Mbps)

• Increment (Kbps)

Bandwidth Settings

If you select this check box, you can override the MTU setting.Enable rate limiting
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ActionField

Specify the default bandwidth value in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

For a predefined service definition, the default bandwidth value is 10 Mbps.

Default bandwidth (Mbps)

To override the default bandwidth value, select the Editable in Service Order check box.

Specify the minimum bandwidth value in Kbps:

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value, in Mbps.

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)

Specify a value in the range that is made available to the service provisioner.

Default: 1000 Kbps

Range: 64Kbps through 100,000 Kbps

Increment (Kbps)

Select the preferred option for calculating the burst size:

• MTUBased

If you select theMTUBased option, you can specify a value forMTU Factor.

Default: 10

Range: 10 through 1,087,902

• Line Rate Based

If you select the Line Rate Based option, you can specify a value for Burst Period.

Default: 5 milliseconds

Range: 5 through 7450milliseconds

NOTE: TheCalculateBurstSize list is enabledonlywhen you select theEnable rate limiting check
box.

Calculate Burst Size

The following table lists theMax Bandwidth (Mbps) for the M Series, MX Series, and

ACX Series routers:

Table 17: MaximumBandwidth for M Series, MX Series, and ACX Series Routers

ACX 2000
MX Series Non-3D
PICMX Series 3D PICM Series IQ2 PICM Series IQ2E PIC

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)
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Table 17: MaximumBandwidth for M Series, MX Series, and ACX Series Routers (continued)

ACX 2000
MX Series Non-3D
PICMX Series 3D PICM Series IQ2 PICM Series IQ2E PIC

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

100,000
Mbps or
100 Gbps

100,000
Mbps or
100 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

32,000
Mbps or
32 Gbps

32,000
Mbps or
32 Gbps

2. ClickNext to save theUNI settings.Continuewith “SpecifyingConnectivity Information”

on page 262.

Specifying Connectivity Information

To specify the attributes that define the connectivity among remote sites across the

service provider network:

1. Fill in the fields on the Connectivity page as indicated in the table.In the PE-Core

Settings box, specify whether to allow the service provider to specify the route target:

ActionField

PE-Core Settings

Select a route target option:

• Selectmanually—Allows the service provider to specify the
route target.

• Auto pick—Route target is selected automatically.

To override this setting in the service order, you can select the
Editable in Service Order check box.

Route target
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ActionField

Select a route distinguisher option:

• Selectmanually—Allows the service provider to specify the
route distinguisher.

• Auto pick—Route distinguisher is selected automatically.

To override this setting in the service order, you can select the
Editable in Service Order check box.

Route distinguisher

Select this check box to configure a separate label for each
VRF to provide double lookup and egress filtering.

To override this setting in the service order, you can select the
Editable in Service Order check box.

VRF Table label

Select this check box to export direct routes.Export Direct Routes

PE-CE Settings

Select an option to use to allow each PE router to distribute
VPN-related routes to and from connected CE routers:

• OSPF/Static Route—OSPF routes IP packets based solely
on the destination IP address contained in the IP packet
header. OSPF quickly detects topological changes, such as
when router interfaces become unavailable, and calculates
new loop-free routes quickly andwith aminimumof routing
overhead traffic. Static routes are routes that are manually
configured and entered into the routing table.

• BGP/Static Route—BGP routing information includes the
complete route to each destination. BGP uses the routing
information tomaintain a database of network reachability
information, which it exchanges with other BGP systems.
BGP uses the network reachability information to construct
a graph of AS connectivity, thus allowing BGP to remove
routing loops and enforce policy decisions at the AS level.
Static routes are routes that are manually configured and
entered into the routing table.

Allowed Routing Protocols

IP Address Settings

Select an option:

• Selectmanually—Allows the service provider to specify the
IP address of a provider edge (PE) interface.

• Auto pick— IP address of a provider edge (PE) interface is
selected automatically.

To override this setting in the service order, you can select the
Editable in Service Order check box.

PE Interface IP Address
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ActionField

Select an IP pool type option:

• Global—A Global IP address pool pertains to the service
provider. There can bemore than one global IPv4 address
pool. However, each global pool must have its own unique
name and its set of IPv4 addresses must not overlap with
those of any other global pool. You can allocate addresses
from global pools across multiple Layer 3 VPNs across
multiple customers.

• Customer—A Customer IP address pool pertains to an
existing customer. These pools are associated with the
corresponding customer. You can associate more than one
customer IPv4 pool with each customer. However, each
customer pool must have its own set of IPv4 addresses
which must not overlap with those of any other pool
belonging to thesamecustomer.Youcanallocateaddresses
from customer pools across multiple Layer 3 VPNs for a
particular customer.

For more information on creation an IP pool, see “Creating an
IP Address Pool” on page 695.

IP pool type

Specify the size of the IPv4 IP addressee block allocated for
each provider edge (PE) or customer edge (CE) link.

Range: 28 through 32

To override this setting in the service order, you can select the
Editable in Service Order check box.

Size of address block

2. Click Finish to save the connectivity settings and create the Layer 3 VPN service

definition.

Related
Documentation

Publishing a Custom Service Definition on page 198•

• Viewing Service Definitions on page 701

• Creating a Full Mesh Layer 3 VPN Ethernet Service Order on page 536

• Junos Space Layer 3 Services Overview on page 13

• Service Templates Overview on page 406

• Creating a Service Template on page 409

• Importing a Service Template on page 416

• Specifying IPv4AddressingAssignment inLayer3VPNServiceDefinitionsonpage699

Creating a Hub-and-Spoke (One Interface) Layer 3 VPN Service Definition

You can create a one-interface hub-and-spoke BGP/static or OSPF/static Layer 3 VPN

service definition, for this version of the Network Activate application, using predefined

service definitions located inServiceDesign>ManageServiceDefinitions>CreateL3VPN

ServiceDefinitions. In aone-interfacehub-and-spoke topology, there is onlyone interface
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using a combination of static routes, BGP, andOSPF routes between CE hub and PE hub

routers. Use a one-interface hub-and-spoke Layer 3 VPN service definition to configure

a service to advertise a default route from a hub to the spokes.

For more information about predefined one-interface hub-and-spoke BGP/static or

OSPF/static Layer 3 VPN service definitions, see “Predefined Hub-and Spoke Layer 3

VPN Service Definitions” on page 403. You can, however create a customized service

definition—for example, to setdifferentbandwidth limitson theservice than thoseoffered

in the standard service definitions.

Youmust have a Service Designer user role to create Layer 3 VPNhub-and-spoke service

definitions. When you create and publish a new service definition, network operators or

service provisionerswith aServiceActivator role canuse the completed service definition

asabase forcreatingandthenactivatinghub-and-spokeEthernet serviceson thenetwork.

You can create a service definition, using the Create L3 VPN Service Definition General,

UNI Settings, or Connectivitywindow in any order by clicking the task links in the right

panel. You can hide the task links by clicking the show/hide button at the top-left of any

of the Create L3 VPN Service Definition windows.

1. Specifying General Information on page 265

2. Specifying UNI Settings on page 266

3. Specifying Connectivity Settings on page 269

Specifying General Information

To specify general information for a hub-and-spoke service definition:

1. Fill in the fields on the General page as indicated in the table.

ActionField

Type a unique name that identifies the hub-and-spoke Layer 3 VPN definition.

Range: 3 through 50 characters.

Name
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ActionField

Select L3 VPN (Hub-Spoke 1 Interface).Service type

Type a comment that identifies or describes the definition.

Range: 1 through 200 characters.

Comments

Select this check box to isolate the events related to an interface in OpenNMS.

NOTE: When you select this check box, only theMPLS traps aremonitored, not the jnxVpnIfVpn traps.

By default, all events are saved in the OpenNMS database.

Decouple Service
Status From Port
Status

When you enable QoS in the service definition, youmust specify a QoS profile in the service order to
classify traffic into defined service groups to provide special treatment of traffic across the network
service. For example, voice traffic can be sent across certain links, and data traffic can use other links.

NOTE: The Enable QoS check box appears only if you have installed the QoS Design application.

Enable QoS

(Optional) To include a service template for the service, select a service template from the Service
Template list.

The selected service template appears in the Default Service Template field.

You can select one or more service templates as the default service template. By default, the default
service templates are attached to the endpoints.

NOTE: You cannot add or delete a service template while creating a service order.

The remaining service templates on theServiceTemplate list are termedas optional service templates.
You can attach the optional service templates to the endpoints on a need basis.

In the View Service Definition Details window, the value for the default service template in the Default
Service Template column is True.

For instructions on creating a service template, see “Creating a Service Template” on page 409.

NOTE: To provision a Layer 3 VPN service for QinQ UNI type, you can create a service template with
service variables as interface name and unit name.

Service Template

2. Click Next to save the General information.

The UNI Settings-Create L3 VPN Service Definition page appears.

Specifying UNI Settings

To specify UNI interface settings for the service definition:
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1. Fill in the fields on the UNI Settings page as indicated in the table as indicated in the

table.

ActionField

By default, this check box is unavailable.Ethernet

Specify how the VLAN ID is determined:

• To allow the service provider to specify the VLAN ID, choose Selectmanually. Specify the
range in VLAN range for manual input.

• To cause the VLAN ID to be selected automatically from the VLAN ID pool, select Auto pick.
This option is used typically when VLAN normalization is applied. Specify the range in VLAN
range for auto-pick

NOTE: Select the Editable in Service Order check box, if you want to override VLAN ID selection
setting in the service order.

VLAN ID selection

Specify the range.

Range: 1 through 4094.

VLAN range for auto-pick

Specify the range.

Range: 1 through 4094.

NOTE: This parameter reserves a range of VLANs for provisioning L3VPNs. These VLANs are
not used to transport data from one end of a connection to the other.

VLANrange formanual input
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ActionField

You can specify an MTU value in this field. The default value for MTU is 1522 bytes.

To see the permitted range for the MTU value, select the Editable in Service Order check box.
The MTU range is 1522 through 9192.

For a predefined service definition, the default MTU is 1522 bytes.

Default MTU (Bytes)

If you select the Editable in Service Order check box, you can specify a value range for MTU (in
bytes). .

Default: 1522 bytes

Range: 1522 bytes through 9192 bytes

NOTE: Ultimately, the system establishes the MTU bymultiplying the value you specify in the
Default MTU (Bytes) field by the value you specify for MTU Factor.

MTU Range (Bytes)

The Bandwidth Settings panel, appears if you do not select the Enable QoS check box in the
preceding General settings window. This panel includes the following fields:

• Enable rate limiting

• Default bandwidth (Mbps)

• Min Bandwidth (Kbps)

• Max Bandwidth (Mbps)

• Increment (Kbps)

Bandwidth Settings

If you select this check box, you can override the MTU setting.Enable rate limiting

Specify the default bandwidth value, in Mbps.

Default: 10 Mbps

Range: 1 Mbps through 100,000Mbps

For a predefined service definition, the default bandwidth value is 10 Mbps.

Default bandwidth (Mbps)

To override the default bandwidth value, select the Editable in Service Order check box.

Specify the minimum bandwidth value in Kbps:

Default: 1000 Kbps

Range: 64 Kbps through 100,000 Kbps

Min Bandwidth (Kbps)

Specify the maximum bandwidth value, in Mbps.

Default: 100 Mbps

Range: 1 Mbps through 100,000Mbps

Max Bandwidth (Mbps)

Specify a value in the range that is made available to the service provisioner.Increment (Kbps)
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ActionField

Select the preferred option for calculating the burst size:

• MTUBased

If you select theMTUBased option, you can specify a value forMTU Factor.

Default: 10

Range: 10 through 1,087,902

• Line Rate Based

If you select the Line Rate Based option, you can specify a value for Burst Period.

Default: 5 milliseconds

Range: 5 through 7450milliseconds

NOTE: TheCalculateBurstSize list is enabledonlywhenyouselect theEnable rate limiting check
box.

Calculate Burst Size

The following table lists theMax Bandwidth (Mbps) for the M Series, MX Series, and

ACX Series routers:

Table 18: MaximumBandwidth for M Series, MX Series, and ACX Series Routers

ACX 2000
MX Series Non-3D
PICMX Series 3D PICM Series IQ2 PICM Series IQ2E PIC

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

XE Port
(10G)

GE Port
(1G)

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

100,000
Mbps or
100 Gbps

100,000
Mbps or
100 Gbps

50,000
Kbps or
50 Gbps

50,000
Kbps or
50 Gbps

32,000
Mbps or
32 Gbps

32,000
Mbps or
32 Gbps

2. Click Next to save the UNI Settings step information.

The Connectivitywindow appears.

Specifying Connectivity Settings

On the Connectivity-Create L3 VPNService Definitionwindow, specify the attributes that

define the connectivity among remote sites across the service provider network.

The Connectivity window includes two setting sections: PE-Core and PE-CE.
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To specify connectivity between sites across the network:

1. Fill in the fields on the Connectivity page as indicated in the table.

ActionField

PE-Core Settings

Select a route target option:

• Selectmanually—Allows the service provider to specify the route target.

• Auto pick—Route target is selected automatically.

To override this setting in the service order, you can select the Editable in Service Order check box.

Route target

Select a route distinguisher option:

• Selectmanually—Allows the service provider to specify the route distinguisher.

• Auto pick—Route distinguisher is selected automatically.

To override this setting in the service order, you can select the Editable in Service Order check box.

Route distinguisher

Select this check box to configure a separate label for each VRF to provide double lookup and egress
filtering.

To override this setting in the service order, you can select the Editable in Service Order check box.

VRF Table label

Select this check box to export direct routes.Export Direct Routes

PE-CE Settings

Copyright © 2015, Juniper Networks, Inc.270

Junos Space Cross Provisioning Platform



ActionField

Select an option to use to alloweachPE router to distribute VPN-related routes to and fromconnected
CE routers:

• OSPF/Static Route—OSPF routes IP packets based solely on the destination IP address contained
in the IP packet header. OSPF quickly detects topological changes, such as when router interfaces
become unavailable, and calculates new loop-free routes quickly and with aminimum of routing
overhead traffic. Static routes are routes that are manually configured and entered into the routing
table.

• BGP/Static Route—BGP routing information includes the complete route to each destination. BGP
uses the routing information to maintain a database of network reachability information, which it
exchanges with other BGP systems. BGP uses the network reachability information to construct a
graph of AS connectivity, thus allowing BGP to remove routing loops and enforce policy decisions
at the AS level. Static routes are routes that are manually configured and entered into the routing
table.

Allowed Routing
Protocols

IP Address Settings

Select an option:

• Selectmanually—Allows the service provider to specify the IP address of a provider edge (PE)
interface.

• Auto pick— IP address of a provider edge (PE) interface is selected automatically.

To override this setting in the service order, you can select the Editable in Service Order check box.

PE Interface IP
Address

Select an IP pool type option:

• Global—AGlobal IP address pool pertains to the service provider. There canbemore than one global
IPv4 address pool. However, each global pool must have its own unique name and its set of IPv4
addresses must not overlap with those of any other global pool. You can allocate addresses from
global pools across multiple Layer 3 VPNs across multiple customers.

• Customer—ACustomer IPaddresspool pertains toanexisting customer. Thesepools areassociated
with the corresponding customer. You can associate more than one customer IPv4 pool with each
customer. However, each customer pool must have its own set of IPv4 addresses which must not
overlap with those of any other pool belonging to the same customer. You can allocate addresses
from customer pools across multiple Layer 3 VPNs for a particular customer.

For more information on creation an IP pool, see “Creating an IP Address Pool” on page 695.

IP pool type

Specify the size of the IPv4 IP addressee block allocated for each provider edge (PE) or customer edge
(CE) link.

Range: 28 through 32

To override this setting in the service order, you can select the Editable in Service Order check box.

Size of address block

2. The VRF Table label option is selected by default .

3. Click Finish to save the connectivity settings and create the Layer 3 VPN service

definition.

Related
Documentation

Viewing Service Definitions on page 701•

• Predefined Hub-and Spoke Layer 3 VPN Service Definitions on page 403

• Publishing a Custom Service Definition on page 198
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• Unpublishing a Custom Service Definition on page 199

• Deleting a Customized Service Definition on page 200

• Predefined Full Mesh Layer 3 VPN Service Definitions on page 403

• Creating a Full Mesh Layer 3 VPN Ethernet Service Order on page 536

• Specifying IPv4AddressingAssignment inLayer3VPNServiceDefinitionsonpage699

Creating a Service Definition for Point-to-Point Pseudowire Access into a Layer 3 VPN

Creating a pseudowire between two terminating PE devices allows you to encapsulate

traffic from the Layer 2 VPN into a Layer 3 VPN, thereby providing access to Layer-3

services. Also known as pseudowire stitching, the benefit of this feature is that devices

running older technologies will continue to function when networks are upgraded and

Layer-3 technologies are in play.

To use this feature, the following prerequisites must bemet:

• An existing Layer 3 VPNmust be used as the target VPN.

• A device with an LT interface must be used to create the pseudowire.
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To create the pseudowire, in the Network Activate task pane, select Service Design >

Create P2P Service Definition.

1. Define the general settings for the service definition.

ActionField

Provide a name for the service definition.Name

The service type is point-to-point pseudowireService type

Enter any comments that will help describe the service definition and its purpose.Comments

Specify the type of interface as Ethernet. Also check the box to enable pseudowire access
into the Layer 3 VPN network.

Interface type

2. Click Next to display the Connectivitywindow.
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ActionField

Choose from Auto pick or Select Manually for VC ID assignment.VC ID selection

Indicate the MTU size or use the default that appears in the field.Default MTU (Bytes)

3. Click Next to display the UNI Settingswindow.

4. Define the UNI settings for the service definition. This definition can be created as a

port-to-port or 802.1q link. This procedure shows the port-to-port Ethernet settings.
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ActionUNI Settings Field

Traffic Treatment Settings

Indicate the Ethernet option to use for this point-to-point service definition. Choices are
port-port or dot1q.

Ethernet option

This field can be left blank.Customer traffic type

This field can be left blank.VLAN ID selection

Interface Settings

The interface encapsulation for the port-to-port link must be specified as ethernet-ccc.Physical IF encapsulation

This field is not used.Logical IF encapsulation

MTU Settings

This field is populatedwith the default MTU value of 1522. If you are not using the default
value, enter the MTU value in bytes.

Default MTU (Bytes)

If you are specifying a customMTU value, indicate the range of values in bytes.MTU range (Bytes)

If you are creating an 802.1q link, use the following settings:
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5. Click Finish and then create the service order.

Related
Documentation

Creating a Point-to-Point ATM or TDM Pseudowire Service Order on page 432•

• Creating a Point-to-Point Service Order on page 438
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Creating aMulticast VPN Service Definition

This topic describes how the Network Activate application enables you to create an

L3VPN service definition preliminary to creating a Multicast VPN (MVPN) service order.

Refer to the topic “Creating a Full Mesh Layer 3 VPN Service Definition” on page 257.

NOTE: MulticastVPNservicesare supportedonLN2600,SRX550/650, and
MX devices only.

To create a L3VPN Service definition upon which to base a MVPN service order, in the

Network Activate task pane, select Service Design >Manage Service Definitions > Create

L3VPN Service Definition.

1. Specify values for theparameters in theGeneral,UNISettings, andConnectivitySettings

windows as described in the following tables.

In the General settings window, add information in the relevant fields as described in

the following table:

DescriptionField

Type a name for this service definition.Name

Select L3VPN (Full Mesh)Service type

Type comments to describe the service definition.Comments

NoneService Template

Select this check box to enable MVPN settings in L3VPN service orders to be
based on this service definition.

Enable MVPN

Do not select this check box.Decouple Service Status fromPort Status

2. Click Next.

3. In the UNI Settingswindow, add information in the relevant fields as described in the

following table:
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DescriptionField

Select this check box.Ethernet

Select Auto pick.VLAN ID selection

N/AVLAN range for auto-pick

N/AVLAN range for manual input

4. Click Next.

5. In theConnectivitySettingswindow, add information in the relevant fieldsasdescribed

in the following table:

DescriptionField

A site within a VPN that a PE router services and to which the PE router will distribute routes.Route target

An identifier attached to a route that distinguishes the VPN to which the route belongs. Each
routing instancemust have a unique route distinguisher associated with it.

Select Auto pick. JUNOS Space selects the route distinguisher automatically.

Router distinguisher

A VRF table label distinguishes one VRF instance from another and enables double lookup and
egress filtering.

Select this check box.

VRF Table label

Select this check box.Export Direct Routes
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DescriptionField

Select BGP/Static RouteAllowed Routing Protocols

The IP address of the interface on the PE device.

Select Auto pick.

PE Interface IP Address

Global—A Global IP address pertains to the service provider. There can bemore than one global
IPv4 address pool. However, each global poolmust have its own unique name and its set of IPv4
addressesmust not overlapwith those of any other global pool. You can allocate addresses from
global pools across multiple Layer 3 VPNs across multiple customers.

Customer—A Customer IP address pool pertains to an existing customer. These pools are
associated with the corresponding customer. You can associate more than one customer IPv4
pool with each customer. However, each customer poolmust have its own set of IPv4 addresses
which must not overlap with those of any other pool belonging to the same customer. You can
allocate addresses from customer pools acrossmultiple Layer 3 VPNs for a particular customer.

IP pool type

The size of the IPv4 addresses block allocated for each PE/CE link.

Range: 28–32

Size of address block

See “Specifying IPv4 Addressing Assignment in Layer 3 VPN Service Definitions” on

page 699.

6. Click Finish.

Related
Documentation

Creating a Full Mesh Layer 3 VPN Service Definition on page 257•

• Specifying IPv4AddressingAssignment inLayer3VPNServiceDefinitionsonpage699

• Multicast L3VPN Overview on page 42

• Creating a Multicast VPN Service Order on page 568

CreatingaLayer3VPNServiceDefinition inCross-ProvisioningPlatformforThird-Party
Devices

Cross Provisioning Platform is an extension of the Network Activate application within

JunosSpace,whichprovidesasinglepaneof interaction todeployservicesacrossvendors.

This topic discusses how a Layer 3 VPN service definition is created and deployed across

third-party devices involved in Cross Provisioning Platform.

To create an Layer 3 VPN service definition, you need to create a configuration script in

XSLT format andGUI script in JS format and upload these scripts from the localmachine

to Cross Provisioning Platform. You can add the scripts by selecting Cross Provisioning

Platform > CPP > Scripts > Add Script.
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To create a Layer 3 VPN service definition:

1. From the Cross Provisioning Platform task pane, select CPP > Service Definitions.

The Service Definitions page that appears displays a list of the existing service

definitions.

2. Click the Create CPP Service Definition icon above the tool grid.

The Create Service Definition page that appears displays General, the SAMService

Scripts and the JUNOS Space Server Scripts sections.

3. On the Create Service Definition page, perform the following steps:

• In the General section:

a. In the Name field, type 3 through 128 alphanumeric characters to identify the

name of the service definition.

b. In the ID field, type 1 through2147483647 integers to identify the servicedefinition

by a unique value.
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NOTE: The service definition ID is optional. If you do not provide any
value in this field, the default value is -1. In the service definition
selection grid, no value is displayed in the ID column. Each service

definition isassignedaunique ID. If yougiveanexisting IDvaluewhile
creating a new service definition, exception occurs.

c. In the Description field, type 3 through 256 alphanumeric characters to further

identify the service definition you named.

d. From the Type drop-down list, select L3VPN.

• In the JUNOS Space Service Scripts section:

a. From theSelect JunosCreationScript column, select a JunosSpace service script

that was written for the creation of the service definition. The script that you

selected is automatically populated in the corresponding Creation text field.

b. From the Select JunosModification Script column, select a Junos Space service

script that was written for the modification of the service definition. The script

that you selected is automatically populated in the correspondingModification

text field.

NOTE: The JunosSpace service scripts aremandatory to create a Layer
3 VPN service definition, whereas the SAM service scripts are optional.

• In the SAMService Scripts section:

a. From the Select SAMCreation Script column, select a SAM service script that

waswritten for the creation of the service definition. The script that you selected

is automatically populated in the corresponding Creation text field.

b. From theSelectSAMModificationScript column, select aSAMservice script that

was written for the modification of the service definition. The script that you

selected is automatically populated in the correspondingModification text field.

4. Click Create to create the service definition.

TheServiceDefinitionspage thatappearsdisplays the list of existing servicedefinitions

along with the service definition that you created.

5. Right-click the servicedefinition that youcreatedandselectPublishServiceDefinition.

The Publish Service Definitions dialog box that appears asks you to confirm the

selection.

6. Click Publish.

The Service Definitions page that appears displays the service definition that you

created along with the existing service definitions.

7. Double-click the service definition that you created to view the details.
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The Service Definition Details page that appears displays the details of the service

definition along with the scripts that you uploaded.

Related
Documentation

• Adding Scripts Created for Cross Provisioning Platform on page 667

• Creating a Layer 3 VPN Service Order in Cross Provisioning Platform for Third-Party

Devices on page 572
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CHAPTER 8

Service Design: Predefined Service
Definitions

• Predefined Service Definitions on page 283

• Predefined Point-to-Point Service Definitions on page 333

• Predefined Multipoint-to-Multipoint Ethernet Service Definitions on page 365

• Predefined Point-to-Multipoint Ethernet Service Definitions on page 390

• Predefined Full Mesh Layer 3 VPN Service Definitions on page 403

• Predefined Hub-and Spoke Layer 3 VPN Service Definitions on page 403

Predefined Service Definitions

Network Activate provides predefined service definitions that a service provisioner can

use when creating a service order.

If none of the predefined service definitions is appropriate for your needs, you can create

a servicedefinitionasdescribed in “CreatingaPoint-to-Point EthernetServiceDefinition”

on page 97, “Creating a Point-to-Multipoint VPLS Service Definition” on page 138, or

“Creating a Multipoint-to-Multipoint VPLS Service Definition” on page 117.

The Junos Space product provides predefined service definitions for Ethernet

point-to-point services and for VPLS services. The following sections describe these

service definitions:

• Ethernet Point-to-Point Predefined Service Definitions on page 283

• Multipoint-to-Multipoint Predefined Service Definitions on page 307

• Point-to-Multipoint Service Definitions on page 331

Ethernet Point-to-Point Predefined Service Definitions

The Ethernet Activator software provides predefined service definitions for Ethernet

point-to-point services that use LDP switching in the network core. These services are

sometimes knows as E-LineMartini services. Figure 12 on page 284 shows an example of

such a service.
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Figure 12: Point-to-Point Service

Information specific to each service instance, such as the device name, endpoint name,

and customer VLAN ID, is provided in the service order. Attributes that can apply across

many service instances are typically defined in the service definition. These attributes

include:

• Ethernet option (dot1.q, port-port, qinq)

• Traffic type (single VLAN, multiple VLAN, all traffic)

• Physical interface encapsulation

• Logical interface encapsulation

• Rate limit range

Table 19onpage284 lists eachof thestandardEthernetpoint-to-point servicedefinitions.

Each standard service definition is then described in detail in the sections that follow.

Table 19: Standard Service Definitions

Service AttributesStandardServiceDefinitionName

• Point-to-point service for M Series and MX Series
devices

• Gigabit Ethernet interfaces

• 802.1Q endpoint interface types

• Customer traffic is single VLAN

• Flexible-ethernet-servicesphysical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-Dot1q-SingleVLAN” on
page 286

• Point-to-point service for J Series, M Series, and MX
Series devices

• Gigabit Ethernet interfaces

• 802.1Q endpoint interface types

• Customer traffic is single VLAN

• Vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-Dot1q-SingleVLAN-CCC” on
page 288
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Table 19: Standard Service Definitions (continued)

Service AttributesStandardServiceDefinitionName

• Point-to-point service for J Series, M Series, and MX
Series devices

• Gigabit Ethernet interfaces

• 802.1Q endpoint interface types

• Customer traffic is single VLAN

• Extended-vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-Dot1q-SingleVLAN-Ext-CCC”
on page 290

• Point-to-point service for J Series, M Series, and MX
Series devices

• Gigabit Ethernet interfaces

• Port-based UNI

• Ethernet-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-PortBased” on page 292

• Point-to-point service for M Series and MX Series
devices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-servicesphysical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-AllVLAN” on page 294

• Point-to-point service for J series, M Series, and MX
Series devices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• All customer traffic

• Vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-AllVLAN-CCC” on
page 296

• Point-to-point service for J Series, M Series, and MX
Series devices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• All customer traffic

• Extended-vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-AllVLAN-Ext-CCC” on
page 298
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Table 19: Standard Service Definitions (continued)

Service AttributesStandardServiceDefinitionName

• Point-to-point service for MX Series devices only

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• Customer traffic is range of VLANs

• Flexible-ethernet-servicesphysical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-VLANRange”onpage300

• Point-to-point service for MX Series devices only

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• Customer traffic is range of VLANs

• Vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-VLANRange-CCC” on
page 302

• Point-to-point service for MX Series devices only

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• Customer traffic is range of VLANs

• Extended-vlan-ccc physical encapsulation

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-VLANRange-Ext-CCC”
on page 304

ELine-Dot1q-SingleVLAN

This service definition provides a base for creating point-to-point services that transport

a single VLAN across an LDP network core using 802.1Q endpoint interface types and

flexible-ethernet-services as the physical encapsulation type. Service provisioners can

limit the bandwidth of services built from this service definition to specific values from

10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 286

• Configuration on Endpoint Z on page 287

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
      flexible-vlan-tagging;
      mtu 1522;
      encapsulation flexible-ethernet-services;
      unit 1 {
        description "Dot1q Eline Martini ";
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        encapsulation vlan-ccc;
        vlan-id 1;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_1;
            }
        }
    }
}

firewall {
   policer policer_in_ge-0/1/1_1 {
    if-exceeding {
        bandwidth-limit 100m;
        burst-size-limit 62500000;
    }               
    then discard;   
} 

family ccc {    
 filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }

protocols {
    l2circuit {
       neighbor 192.168.1.40
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
      flexible-vlan-tagging;
      mtu 1522;
      encapsulation flexible-ethernet-services;
      unit 1 {
        description "Dot1q Eline Martini ";
        encapsulation vlan-ccc;
        vlan-id 1;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_1;
            }
        }
    }
}
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firewall {
   policer policer_in_ge-0/1/1_1 {
    if-exceeding {
        bandwidth-limit 100m;
        burst-size-limit 62500000;
    }               
    then discard;   
} 

family ccc {    
 filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }

protocols {
    l2circuit {
       neighbor 192.168.1.30 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
}

ELine-Dot1q-SingleVLAN-CCC

This service definition provides a base for creating point-to-point services that transport

a single VLAN across an LDP network core using 802.1Q endpoint interface types and

vlan-cccas thephysical encapsulation type. Serviceprovisioners can limit thebandwidth

of services built from this service definition to specific values from 10 Mbps through 100

Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 288

• Configuration on Endpoint Z on page 289

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 { 
     flexible-vlan-tagging;
     mtu 1522;
     encapsulation vlan-ccc;
     unit 513 {
        description VLANCCC-SR;
        encapsulation vlan-ccc;
        vlan-id 513;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_513;
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            }
        }
    }
}

firewall {
    policer policer_in_ge-0/1/1_513 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_513 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_513;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {     
        neighbor 192.168.1.40 {
            interface ge-0/1/1.513 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }

    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

 ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation vlan-ccc;
    unit 513 {
        description VLANCCC-SR;
        encapsulation vlan-ccc;
        vlan-id 513;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_513;
            }
        }
    }
}

firewall {
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    policer policer_in_ge-0/1/1_513 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_513 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_513;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.513 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

ELine-Dot1q-SingleVLAN-Ext-CCC

This service definition provides a base for creating point-to-point services that transport

a single VLAN across an LDP network core using 802.1Q endpoint interface types and

extended-vlan-ccc as the physical encapsulation type. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 290

• Configuration on Endpoint Z on page 291

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation extended-vlan-ccc;
    unit 1 {
        description Extended-SR;
        vlan-id 1;
        family ccc {
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            filter {
                input filter_in_ge-0/1/1_1;
            }
        }
    }           
}               

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
    }
}   

protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation extended-vlan-ccc;
    unit 1 {
        description Extended-SR;
        vlan-id 1;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_1;
            }
        }
    }
}
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firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }           
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
    }
} 

protocols {
   l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

ELine-PortBased

This service definition provides a base for creating point-to-point services that transport

all traffic across an LDP network core using an entire port at each endpoint using

ethernet-ccc as the physical encapsulation type. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

to 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 292

• Configuration on Endpoint Z on page 293

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
    encapsulation ethernet-ccc;
    unit 0 {
        family ccc {
            filter {
                input filter_in_ge-0/1/1;
            }
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        }
    }
}

firewall {
    policer policer_in_ge-0/1/1 {
        if-exceeding {
            bandwidth-limit 10m;
            burst-size-limit 6250000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.40 {     
            interface ge-0/1/1.0 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
        encapsulation ethernet-ccc;
        unit 0 {
            family ccc {
                filter {
                    input filter_in_ge-0/1/1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1 {
        if-exceeding {
            bandwidth-limit 10m;
            burst-size-limit 6250000;
        }
        then discard;
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    }
    family ccc {           
        filter filter_in_ge-0/1/1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1;
                    accept;
                }
            }
        }
    }
}      

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.0 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

ELine-QinQ-AllVLAN

This service definition provides a base for creating point-to-point services that transport

all customer traffic across an LDP network core using Q-in-Q endpoint interface types

and flexible-ethernet-services as the physical encapsulation type. Service provisioners

can limit the bandwidth of services built from this service definition to specific values

from 10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 294

• Configuration on Endpoint Z on page 295

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

 ge-0/1/1 {           
      flexible-vlan-tagging;
      mtu 1522;
      encapsulation flexible-ethernet-services;
      unit 1 {
        description "AllVlanTransport";
        encapsulation vlan-ccc;
        vlan-tags outer 1;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_1;
            }
        }
    }
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protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }

}
firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation flexible-ethernet-services;
    unit 1 {
        description "AllVlanTransport";
        encapsulation vlan-ccc;
        vlan-tags outer 1;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_1;
            }   
        }       
    }           
}

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }           
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        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }       
        }
    }
}

ELine-QinQ-AllVLAN-CCC

This service definition provides a base for creating point-to-point services that transport

all customer traffic across an LDP network core using Q-in-Q endpoint interface types

and vlan-ccc as the physical encapsulation type. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 296

• Configuration on Endpoint Z on page 297

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation vlan-ccc;
        unit 515 {  
            description QinQ-ALLVLAN;
            encapsulation vlan-ccc;
            vlan-tags outer 515;
            family ccc {
                filter {
                    input filter_in_ge-0/1/1_515;
                }
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            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1_515 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }

    family ccc {
        filter filter_in_ge-0/1/1_515 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_515;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.515 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }   
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation vlan-ccc;
    unit 515 {
        description QinQ-ALLVLAN;
        encapsulation vlan-ccc;
        vlan-tags outer 515;
        family ccc {
            filter {
                 input filter_in_ge-0/1/1_515;
            }   
        }
    }
}

firewall {
    policer policer_in_ge-0/1/1_515 {
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        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {    
        filter filter_in_ge-0/1/1_515 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_515;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.515 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }   
    }
}

ELine-QinQ-AllVLAN-Ext-CCC

This service definition provides a base for creating point-to-point services that transport

all customer traffic across an LDP network core using Q-in-Q endpoint interface types

and extended-vlan-ccc as the physical encapsulation type. Service provisioners can limit

the bandwidth of services built from this service definition to specific values from 10

Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 298

• Configuration on Endpoint Z on page 299

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation extended-vlan-ccc;
        unit 1 {
            description Ext-AllVLAN;
            vlan-tags outer 1;
            family ccc {
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                filter {
                    input filter_in_ge-0/1/1_1;
                }
            }       
        }           
    }               

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }               
    family ccc {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
    }

}

protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }

    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation extended-vlan-ccc;
        unit 1 {
            description Ext-AllVLAN;
            vlan-tags outer 1;
            family ccc {
                filter {
                    input filter_in_ge-0/1/1_1;
                }
            }
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        }
    }

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }               
    family ccc {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {     
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

ELine-QinQ-VLANRange

This service definition provides a base for creating point-to-point services that transport

a range of VLANs across an LDP network core usingQ-in-Q endpoint interface types and

flexible-ethernet-services as the physical encapsulation type. Service provisioners can

limit the bandwidth of services built from this service definition to specific values from

10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 300

• Configuration on Endpoint Z on page 301

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {                                    
       flexible-vlan-tagging;
       mtu 1522;
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       encapsulation flexible-ethernet-services;
         unit 2 {
         description "QinQ Eline Martini";
         encapsulation vlan-ccc;
         vlan-tags outer 2 inner-range 100-110;
         family ccc {
            filter {
                input filter_in_ge-0/1/1_2;
            }
        }
    }
}

firewall {
policer policer_in_ge-0/1/1_2 {
    if-exceeding {
        bandwidth-limit 100m;
        burst-size-limit 62500000;
    }

family ccc {
    filter filter_in_ge-0/1/1_2 {
        interface-specific;
        term 1 {
            then {
                policer policer_in_ge-0/1/1_2;
                accept;
            }

protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.2 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }

    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation flexible-ethernet-services;
    unit 2 {
        description "QinQ Eline Martini";
        encapsulation vlan-ccc;
        vlan-tags outer 2 inner-range 100-110;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_2;
            }
        }
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    }
}

firewall {
    policer policer_in_ge-0/1/1_2 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }

    family ccc {
        filter filter_in_ge-0/1/1_2 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_2;
                    accept;
                }   
            }
        }
    }
}

protocols {
    l2circuit {     
            interface ge-0/1/1.2 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

ELine-QinQ-VLANRange-CCC

This service definition provides a base for creating point-to-point services that transport

a range of VLANs across an LDP network core usingQ-in-Q endpoint interface types and

vlan-cccas thephysical encapsulation type. Serviceprovisioners can limit thebandwidth

of services built from this service definition to specific values from 10 Mbps through 100

Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 303

• Configuration on Endpoint Z on page 304
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Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

    ge-0/1/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation vlan-ccc;
        unit 514 {
            description VLANRANGE-SR;
            encapsulation vlan-ccc;
            vlan-tags outer 514 inner-range 600-610;
            family ccc {
                filter {
                    input filter_in_ge-0/1/1_514;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1_514 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_514 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_514;
                    accept;
                }   
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.514 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }

        }
    }
}
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Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

 ge-0/1/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation vlan-ccc;
        unit 514 {
            description VLANRANGE-SR;
            encapsulation vlan-ccc;
            vlan-tags outer 514 inner-range 600-610;
            family ccc {
                filter {
                    input filter_in_ge-0/1/1_514;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1_514 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_514 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_514;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.514 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

ELine-QinQ-VLANRange-Ext-CCC

This service definition provides a base for creating point-to-point services that transport

a range of VLANs across an LDP network core usingQ-in-Q endpoint interface types and
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extended-vlan-ccc as the physical encapsulation type. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 305

• Configuration on Endpoint Z on page 306

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation extended-vlan-ccc;
    unit 2 {    
        description Ext-VLANRange;
        vlan-tags outer 2 inner-range 100-110;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_2;
            }   
        }       
    }           
}   

firewall {          
    policer policer_in_ge-0/1/1_2 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_2 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_2;
                    accept;
                }
            }
        }
    }
}     

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.2 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
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             }
         }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation extended-vlan-ccc;
    unit 2 {
        description Ext-VLANRange;
        vlan-tags outer 2 inner-range 100-110;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_2;
            }   
        }
    }
} 

firewall {
    policer policer_in_ge-0/1/1_2 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }               
    family ccc {
        filter filter_in_ge-0/1/1_2 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_2;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.2 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
             }
         }
    }
}
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Multipoint-to-Multipoint Predefined Service Definitions

TheEthernetActivator softwareprovidespredefinedservicedefinitions forVPLSservices

that use BGP switching in the network core. These services are sometimes knows as

E-LAN services. This section covers multipoint-to-multipoint (or full mesh) service

definitions. Figure 13 on page 307 shows an example of such a service.

Figure 13: Multipoint—to—Multipoint Service

Information specific to each service instance, such as the device name, endpoint name,

and customer VLAN ID, is provided in the service order. Attributes that can apply across

many service instances are typically defined in the service definition. These attributes

include:

• Ethernet option (dot1.q, port-port, qinq)

• Traffic type (single VLAN, VLAN range, all traffic)

• VLAN normalization

• Physical interface encapsulation

• Logical interface encapsulation

• Rate limit range

Table 20 on page 308 lists each of the standard VPLS service definitions. Each standard

service definition is then described in detail in the sections that follow.
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Table 20: Standard Service Definitions

Service AttributesStandard Service Definition Name

• Multipoint Ethernet service forMSeries and
MX Series devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs are not preserved

• 802.1Q endpoint interface types

• Customer traffic is single VLAN

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-Dot1q-Normalized-VLAN-None”on
page 309

• Multipoint Ethernet service for M Series or
MX Series devices

• Gigabit Ethernet interfaces

• 802.1Q endpoint interface types

• Customer traffic is single VLAN

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-Dot1Q-SingleVLAN” on page 313

• Multipoint Ethernet service for M series and
MX Series devices

• Gigabit Ethernet interfaces

• Port-based UNIs

• Transports all customer traffic

• Ethernet VPLS as physical encapsulation
type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-PortBased” on page 316

• Multipoint Ethernet service forMSeries and
MX Series devices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-QinQ-AllVLAN” on page 319
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Table 20: Standard Service Definitions (continued)

Service AttributesStandard Service Definition Name

• Multipoint Ethernet service forMSeries and
MX Series devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs preserved

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-QinQ-AllVLAN-Normalized-All” on
page 322

• Multipoint Ethernet service forMSeries and
MX Series devices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• VLAN IDs not preserved

• All customer traffic

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-QinQ-AllVLAN-Normalized-None”
on page 325

• Multipoint Ethernet service for MX Series
devices only

• Gigabit Ethernet interfaces

• Customer VLAN IDs preserved

• Q-in-Q endpoint interface types

• Transports specified VLAN range

• Flexible Ethernet services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-QinQ-Range-Normalized-VLAN”
on page 328

ELAN-BGP-Dot1q-Normalized-VLAN-None

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport traffic from a single VLAN on an endpoint across a BGP network

core using802.1Qendpoint interface typesand flexible-ethernet-services as thephysical

encapsulation type. VLAN IDs are not preserved across the network—traffic passes from

the single VLAN on an endpoint to any VLANs in the broadcast domain. Service

provisioners can limit thebandwidthof servicesbuilt fromthis servicedefinition to specific

values from 10 Mbps through 100Mbps.
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The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 13 on page 307:

• Configuration on Endpoint A on page 310

• Configuration on Endpoint B on page 311

• Configuration on Endpoint Z on page 312

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

ge-0/0/1 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/1_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/1_1;
                    accept;
                }
            }
        }
    }               
}
routing-instances {
    BestCustomer_ELAN-BGP-Dot1q-Normalized-VLAN-SR {
        instance-type vpls;
        interface ge-0/0/1.1;
        route-distinguisher 65410:1;
        vrf-target target:65410:0;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/0/1.1;
                }
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            }
        }

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

    ge-0/0/1 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/1_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/1_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-Dot1q-Normalized-VLAN-SR {
        instance-type vpls;
        interface ge-0/0/1.1;
        route-distinguisher 65410:0;
        vrf-target target:65410:0;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/0/1.1;
                }
            }
        }           
    }
}
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Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

SJC:

    ge-0/0/1 {      
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/1_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/1_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-Dot1q-Normalized-VLAN-SR {
        instance-type vpls;
        interface ge-0/0/1.1;
        vlan-id none;
        route-distinguisher 65410:2;
        vrf-target target:65410:0;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/1.1;
                }
            }
        }
    }
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ELAN-BGP-Dot1Q-SingleVLAN

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport traffic on a single VLAN across a BGP network core using 802.1Q

endpoint interface types and flexible-ethernet-services as the physical encapsulation

type. No VLANmapping is performed—the VLAN IDmust be the same on all endpoints.

Service provisioners can limit the bandwidth of services built from this service definition

to specific values from 10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 13 on page 307:

• Configuration on Endpoint A on page 313

• Configuration on Endpoint B on page 314

• Configuration on Endpoint Z on page 315

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

    ge-0/0/2 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/2_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/2_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }

        filter filter_in_ge-0/0/2_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/2_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-Dot1Q-SingleVLAN-SR {
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        instance-type vpls;
        interface ge-0/0/2.1;
        route-distinguisher 65410:4;
        vrf-target target:65410:1;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/0/2.1;
                }
            }
        }           
    }

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

    ge-0/0/2 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/2_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/2_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
        filter filter_in_ge-0/0/2_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/2_1;
                    accept;
                }
            }
        }
    }
}

routing-instances {
    BestCustomer_ELAN-BGP-Dot1Q-SingleVLAN-SR {
        instance-type vpls;
        interface ge-0/0/2.1;
        route-distinguisher 65410:3;
        vrf-target target:65410:1;
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        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/0/2.1;
                }
            }
        }
    }

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

    ge-0/0/2 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/2_1;
                }
            }       
        }           
    }               

firewall {
    policer policer_in_ge-0/0/2_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {   
        filter filter_in_ge-0/0/2_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/2_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-Dot1Q-SingleVLAN-SR {
        instance-type vpls;
        interface ge-0/0/2.1;
        route-distinguisher 65410:5;
        vrf-target target:65410:1;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_3 {
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                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/2.1;
                }
            }
        }
    }

ELAN-BGP-PortBased

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport all traffic on an entire port across a BGP network core using

ethernet-vpls as the physical encapsulation type. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 13 on page 307:

• Configuration on Endpoint A on page 316

• Configuration on Endpoint B on page 317

• Configuration on Endpoint Z on page 318

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

 ge-0/1/3 {      
        mtu 1522;
        encapsulation ethernet-vpls;
        unit 0 {
            family vpls {
                filter {
                    input filter_in_ge-0/1/3;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/3 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 15220;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/1/3 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/3;
                    accept;
                }
            }
        }
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    }
}
routing-instances {
    ELAN_BGP_PortBased_10_100M {
        instance-type vpls;
        interface ge-0/1/3.0;
        route-distinguisher 65410:3;
        vrf-target target:65410:1;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/1/3.0;
                }
            }
        }
    }
} 

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

 ge-0/1/3 {
        mtu 1522;   
        encapsulation ethernet-vpls;
        unit 0 {
            family vpls {
                filter {
                    input filter_in_ge-0/1/3;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/3 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 15220;
        }           
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/1/3 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/3;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    ELAN_BGP_PortBased_10_100M {
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        instance-type vpls;
        interface ge-0/1/3.0;
        route-distinguisher 65410:2;
        vrf-target target:65410:1;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/1/3.0;
                }
            }
        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

 ge-0/2/2 {
        mtu 1522;
        encapsulation ethernet-vpls;
        unit 0 {
            family vpls {
                filter {
                    input filter_in_ge-0/2/2;
                }
            }
        }
    }

}
firewall {
    policer policer_in_ge-0/2/2 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 15220;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/2/2 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/2/2;
                    accept;
                }
            }
        }
    }
}

routing-instances {
    ELAN_BGP_PortBased_10_100M {
        instance-type vpls;
        interface ge-0/2/2.0;
        route-distinguisher 65410:4;
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        vrf-target target:65410:1;
        protocols { 
            vpls {
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/2/2.0;
                }
            }
        }
    }

ELAN-BGP-QinQ-AllVLAN

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport all traffic across a BGP network core using Q-in-Q endpoint

interface types and flexible-ethernet-services as the physical encapsulation type. No

VLANmapping is performed—customer VLAN IDs and service provider VLAN IDs must

match on each endpoint that is to send or receive traffic. Service provisioners can limit

the bandwidth of services built from this service definition to specific values from 10

Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 13 on page 307:

• Configuration on Endpoint A on page 319

• Configuration on Endpoint B on page 320

• Configuration on Endpoint Z on page 321

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

ge-0/1/1 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/1/1_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }               
    family vpls {
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        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }           
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-SR {
        instance-type vpls;
        interface ge-0/1/1.1;
        route-distinguisher 65410:13;
        vrf-target target:65410:4;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/1/1.1;
                }
            }
        }
    }
}

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

ge-0/1/1 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/1/1_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
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                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-SR {
        instance-type vpls;
        interface ge-0/1/1.1;
        route-distinguisher 65410:12;
        vrf-target target:65410:4;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/1/1.1;
                }
            }
        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

ge-0/0/5 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/5_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/5_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/5_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/5_1;
                    accept;
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                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-SR {
        instance-type vpls;
        interface ge-0/0/5.1;
        route-distinguisher 65410:14;
        vrf-target target:65410:4;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/5.1;
                }
            }
        }
    }
}

ELAN-BGP-QinQ-AllVLAN-Normalized-All

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport all traffic across a BGP network core using Q-in-Q endpoint

interface types and flexible-ethernet-services as the physical encapsulation type.

Customer VLAN IDs are preserved across the network—traffic passes only among

matching customer VLAN IDs. However, traffic can pass among any service provider

VLAN ID in thebroadcastdomain. Serviceprovisioners can limit thebandwidthof services

built from this service definition to specific values from 10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 13 on page 307:

• Configuration on Endpoint A on page 322

• Configuration on Endpoint B on page 323

• Configuration on Endpoint Z on page 324

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

ge-0/1/0 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {    
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/1/0_1;
                }
            }
        }
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    }

firewall {
    policer policer_in_ge-0/1/0_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/1/0_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/0_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-All-SR {
        instance-type vpls;
        interface ge-0/1/0.1;
        route-distinguisher 65410:10;
        vrf-target target:65410:3;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/1/0.1;
                }
            }
        }
    }

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

ge-0/1/0 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/1/0_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/0_1 {
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        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/1/0_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/0_1;
                    accept;
                }
            }
        }           
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-All-SR {
        instance-type vpls;
        interface ge-0/1/0.1;
        route-distinguisher 65410:9;
        vrf-target target:65410:3;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/1/0.1;
                }
            }
        }
    }

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

ge-0/0/4 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/4_1;
                }
            }
        }
    }
firewall {
    policer policer_in_ge-0/0/4_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
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    }
    family vpls {
        filter filter_in_ge-0/0/4_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/4_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {             
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-All-SR {
        instance-type vpls;
        interface ge-0/0/4.1;
        vlan-id all;
        route-distinguisher 65410:11;
        vrf-target target:65410:3;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/4.1;
                }
            }
        }
    }

ELAN-BGP-QinQ-AllVLAN-Normalized-None

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport all traffic across a BGP network core using Q-in-Q endpoint

interface types and flexible-ethernet-services as the physical encapsulation type. VLAN

IDs are not preserved across the network—traffic passes between any customer VLAN

or service provider VLAN in the broadcast domain. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 13 on page 307:

• Configuration on Endpoint A on page 325

• Configuration on Endpoint B on page 326

• Configuration on Endpoint Z on page 327

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

ge-0/0/3 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
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            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/3_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/3_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/3_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/3_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {          
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-SR {
        instance-type vpls;
        interface ge-0/0/3.1;
        route-distinguisher 65410:7;
        vrf-target target:65410:2;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/0/3.1;
                }
            }
        }
    }
}

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

ge-0/0/3 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
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                filter {
                    input filter_in_ge-0/0/3_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/3_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/3_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/3_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-SR {
        instance-type vpls;
        interface ge-0/0/3.1;
        route-distinguisher 65410:6;
        vrf-target target:65410:2;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/0/3.1;
                }
            }
        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

ge-0/0/3 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/3_1;
                }
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            }
        }
    }

firewall {
    policer policer_in_ge-0/0/3_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }               
    family vpls {
        filter filter_in_ge-0/0/3_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/3_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-SR {
        instance-type vpls;
        interface ge-0/0/3.1;
        vlan-id none;
        route-distinguisher 65410:8;
        vrf-target target:65410:2;
        protocols { 
            vpls {
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/3.1;
                }
            }
        }
    }
}

ELAN-BGP-QinQ-Range-Normalized-VLAN

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport traffic froma rangeofVLANsonanendpointacrossaBGPnetwork

core usingQ-in-Qendpoint interface typesand flexible-ethernet-services as thephysical

encapsulation type. Services built from this service definitionmust useMXSeries devices

on the provider edge. Customer VLAN IDs are preserved across the network—traffic

passes among like customer VLAN IDs on any service provider VLAN in the broadcast

domain. Service provisioners can limit the bandwidth of services built from this service

definition to specific values from 10 Mbps through 100Mbps.
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The following sections show the configuration data for a servicewith only twoendpoints,

SJC and SFO.

• Configuration on Endpoint A on page 329

• Configuration on Endpoint Z on page 330

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device SJC):

ge-0/0/6 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation flexible-ethernet-services;
        unit 2 {    
            encapsulation vlan-vpls;
            vlan-tags outer 2 inner-range 1500-2000;
            family vpls {
                filter {
                    input filter_in_ge-0/0/6_2;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/6_2 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/6_2 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/6_2;
                    accept;
                }
            }       
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-Range-Normalized-VLAN-SR1 {
        instance-type vpls;
        vlan-id all;
        interface ge-0/0/6.2;
        vlan-id all;
        route-distinguisher 65410:19;
        vrf-target target:65410:6;
        protocols {
            vpls {  
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
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                    interface ge-0/0/6.2;
                }
            }
        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SFO):

ge-0/0/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1 inner-range 1500-2000;
            family vpls {
                filter {
                    input filter_in_ge-0/0/1_1;
                }   
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/1_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-Range-Normalized-VLAN-SR1 {
        instance-type vpls;
        vlan-id all;
        interface ge-0/0/1.1;
        route-distinguisher 65410:18;
        vrf-target target:65410:6;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/0/1.1;
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                }
            }
        }
    }

Point-to-Multipoint Service Definitions

TheEthernetActivator softwareprovidespredefinedservicedefinitions forVPLSservices

that use BGP switching in the network core. These services are sometimes knows as

E-LAN services. This section covers point-to-multipoint (or hub and spoke) service

definitions. Figure 14 on page 331 shows an example of such a service.

Figure 14: Point-to-Multipoint Service

Information specific to each service instance, such as the device name, endpoint name,

customer VLAN ID, andwhether a specific endpoint is a hub or a spoke is provided in the

serviceorder. Attributes that canapplyacrossmanyservice instancesare typically defined

in the service definition. These attributes include:

• Ethernet option (dot1.q, port-port, qinq)

• Traffic type (single VLAN, VLAN range, all traffic)

• VLAN normalization

• Physical interface encapsulation

• Logical interface encapsulation

• Rate limit range

Table 20 on page 308 lists each of the standard VPLS service definitions. Each standard

service definition is then described in detail in the sections that follow.
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Table 21: Standard Service Definitions

Service AttributesStandard Service Definition Name

• Multipoint Ethernet service for M Series and MX
Series devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs are not preserved

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-services physical encapsulation
type

• Rate limiting from 10 Mbps to 100Mbps with 10
Mbps increment

“ELAN-Hub-Spoke-QinQ-AllVLAN” on
page 332

• Multipoint Ethernet service forMSeries orMXSeries
devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs are preserved

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-services physical encapsulation
type

• Rate limiting from 10 Mbps to 100Mbps with 10
Mbps increment

“ELAN-Hub-Spoke-QinQ-AllVLAN-No”
on page 333

ELAN-Hub-Spoke-QinQ-AllVLAN

This service definition provides a base for creating point-to-multipoint Ethernet services

that transport all traffic onanendpointacrossaBGPnetworkcoreusingQ-in-Qendpoint

interface types and flexible-ethernet-services as the physical encapsulation type.

CustomerVLAN IDsarepreservedacross thenetwork—trafficpassesamong likecustomer

VLAN IDs on any service provider VLAN in the broadcast domain. Service provisioners

can limit the bandwidth of services built from this service definition to specific values

from 10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 14 on page 331:

• Configuration on Endpoint A on page 332

• Configuration on Endpoint B on page 332

• Configuration on Endpoint Z on page 333

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

Copyright © 2015, Juniper Networks, Inc.332

Junos Space Cross Provisioning Platform



Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

ELAN-Hub-Spoke-QinQ-AllVLAN-No

This service definition provides a base for creating point-to-multipoint Ethernet services

that transport all traffic onanendpointacrossaBGPnetworkcoreusingQ-in-Qendpoint

interface types and flexible-ethernet-services as the physical encapsulation type. VLAN

IDs are not preserved across the network—traffic passes from the single VLAN on an

endpoint to any VLANs in the broadcast domain. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 14 on page 331:

• Configuration on Endpoint A on page 333

• Configuration on Endpoint B on page 333

• Configuration on Endpoint Z on page 333

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A(device IND):

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

Related
Documentation

Creating a Point-to-Point Ethernet Service Definition on page 97•

• Creating a Multipoint-to-Multipoint VPLS Service Definition on page 117

Predefined Point-to-Point Service Definitions

The Network Activate software provides predefined service definitions that a service

provisioner can choose fromwhen creating a service order. This section provides

informationaboutpredefinedservicedefinitionsused for creatingEthernetpoint-to-point

services. For information about predefined service definitions used to create other types

of service, see the following topics:

• Predefined Multipoint-to-Multipoint Ethernet Service Definitions on page 365

• Predefined Point-to-Multipoint Ethernet Service Definitions on page 390
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• Predefined Full Mesh Layer 3 VPN Service Definitions on page 403

• Predefined Hub-and Spoke Layer 3 VPN Service Definitions on page 403

If none of the point-to-point predefined service definitions described here is appropriate

for your needs, you can create a service definition as described in “Creating a

Point-to-Point Ethernet Service Definition” on page 97,

The Network Activate software provides predefined service definitions for Ethernet

point-to-point services that useLDPswitchingorBGP in thenetwork core. TheLDPbased

services are sometimes known as E-Line Martini services, and the BGP based services

aresometimesknownasE-LineKompellaservices.Figure 12onpage284showsanexample

of such a service.

Figure 15: Point-to-Point Service

Information specific to each service instance, such as the device name, endpoint name,

and customer VLAN ID, is provided in the service order. Attributes that can apply across

many service instances are typically defined in the service definition. These attributes

include:

• Ethernet option (dot1.q, port-port, qinq)

• Traffic type (single VLAN, multiple VLAN, all traffic)

• Physical interface encapsulation

• Logical interface encapsulation

• Rate limit range

Table 19 on page 284 lists each of the standard point-to-point service definitions. Each

standard service definition is then described in detail in the sections that follow.
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Table 22: Standard Ethernet Point-to-Point Ethernet Service Definitions

Service AttributesStandardServiceDefinitionName

• Point-to-point service for M Series and MX Series
routers

• Gigabit Ethernet interfaces

• 802.1Q endpoint interface types

• Customer traffic is single VLAN

• Flexible-ethernet-servicesphysical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-Dot1q-SingleVLAN” on
page 286

• Point-to-point service for M Series and MX Series
routers

• Gigabit Ethernet interfaces

• 802.1Q endpoint interface types

• Customer traffic is single VLAN

• Vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-Dot1q-SingleVLAN-CCC” on
page 288

• Point-to-point service for M Series and MX Series
routers

• Gigabit Ethernet interfaces

• 802.1Q endpoint interface types

• Customer traffic is single VLAN

• Extended-vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-Dot1q-SingleVLAN-Ext-CCC”
on page 290

• Point-to-point service for M Series and MX Series
routers

• Gigabit Ethernet interfaces

• Port-based UNI

• Ethernet-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-PortBased” on page 292

• Point-to-point service for M Series and MX Series
routers

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-servicesphysical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-AllVLAN” on page 294
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Table 22: Standard Ethernet Point-to-Point Ethernet Service
Definitions (continued)

Service AttributesStandardServiceDefinitionName

• Point-to-point service for M Series and MX Series
routers

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• All customer traffic

• Vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-AllVLAN-CCC” on
page 296

• Point-to-point service for M Series and MX Series
routers

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• All customer traffic

• Extended-vlan-ccc physical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-AllVLAN-Ext-CCC” on
page 298

• Point-to-point service for MX Series routers only

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• Customer traffic is range of VLANs

• Flexible-ethernet-servicesphysical encapsulation type

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-VLANRange”onpage300

• Point-to-point service for MX Series routers only

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• Customer traffic is range of VLANs

• Vlan-ccc physical encapsulation type

• Rate limiting from 10Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-VLANRange-CCC” on
page 302

• Point-to-point service for MX Series routers only

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• Customer traffic is range of VLANs

• Extended-vlan-ccc physical encapsulation

• Rate limiting from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-QinQ-VLANRange-Ext-CCC”
on page 304

• Point-to-point service for MX Series routers and
BX7000 Gateways only

• T1 interfaces

• satop physical encapsulation

TDM Interface
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Table 22: Standard Ethernet Point-to-Point Ethernet Service
Definitions (continued)

Service AttributesStandardServiceDefinitionName

• Point-to-point service for MX Series routers and
BX7000 Gateways only

• T1 interfaces

• satop physical encapsulation

• Static pseudowire

Static TDM pseudowire

• Point-to-point service for MX Series routers and
BX7000 Gateways only

• ATM/T1interfaces

• atm-cc-cell-relay physical encapsulation

ATM pseudowire

• Point-to-point service for MX Series routers and
BX7000 Gateways only

• ATM/T1interfaces

• atm-ccc-vc-mux/aal5 physical encapsulation

ATM-AAL5 pseudowire

• Point-to-point service for MX Series routers and
BX7000 Gateways only

• ATM/T1 interfaces

• atm-ccc-cell-relay/atm physical encapsulation

• Static pseudowire

Static ATM pseudowire

• Point-to-point service for MX Series routers and
BX7000 Gateways only

• ATM/T1 interfaces

• atm-ccc-vc-mux / aal5 physical encapsulation

• Static pseudowire

Static ATM-AAL5 pseudowire

• Ethernet service forMSeries,MXSeries, andACXSeries
routers

• Gigabit Ethernet interface

• Q-in-Q endpoint interface type

• Transport all traffic

• Flexible-ethernet-servicesphysical encapsulation type

• Rate limit from 10 Mbps to 100Mbps with 10 Mbps
increment

“Eline-BGP-QinQ-AllVLAN” on
page 363

• Ethernet service forMSeries,MXSeries, andACXSeries
routers

• Gigabit Ethernet interface

• 802.1Q endpoint interface types

• Single VLAN traffic

• Flexible-ethernet-servicesphysical encapsulation type

• Rate limit from 10 Mbps to 100Mbps with 10 Mbps
increment

“Eline-BGP-Dot1q-SingleVLAN” on
page 360
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Table 22: Standard Ethernet Point-to-Point Ethernet Service
Definitions (continued)

Service AttributesStandardServiceDefinitionName

• Ethernet service for M Series, MX Series, and ACX
routers

• Gigabit Ethernet interface

• Port-based UNIs

• Ethernet-ccc physical encapsulation type

• Rate limit from 10 Mbps to 100Mbps with 10 Mbps
increment

“ELine-BGP-Port-Based”onpage358

ELine-Dot1q-SingleVLAN Service Definition

This service definition provides a base for creating point-to-point services that transport

a single VLAN across an LDP or BGP network core using 802.1Q endpoint interface types

and flexible-ethernet-services as the physical encapsulation type. Service provisioners

can limit the bandwidth of services built from this service definition to specific values

from 10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 338

• Configuration on Endpoint Z on page 339

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
      flexible-vlan-tagging;
      mtu 1522;
      encapsulation flexible-ethernet-services;
      unit 1 {
        description "Dot1q Eline Martini ";
        encapsulation vlan-ccc;
        vlan-id 1;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_1;
            }
        }
    }
}

firewall {
   policer policer_in_ge-0/1/1_1 {
    if-exceeding {
        bandwidth-limit 100m;
        burst-size-limit 62500000;
    }               
    then discard;   
} 
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family ccc {    
 filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }

protocols {
    l2circuit {
       neighbor 192.168.1.40
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
      flexible-vlan-tagging;
      mtu 1522;
      encapsulation flexible-ethernet-services;
      unit 1 {
        description "Dot1q Eline Martini ";
        encapsulation vlan-ccc;
        vlan-id 1;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_1;
            }
        }
    }
}

firewall {
   policer policer_in_ge-0/1/1_1 {
    if-exceeding {
        bandwidth-limit 100m;
        burst-size-limit 62500000;
    }               
    then discard;   
} 

family ccc {    
 filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
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protocols {
    l2circuit {
       neighbor 192.168.1.30 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
}

ELine-Dot1q-SingleVLAN-CCC Service Definition

This service definition provides a base for creating point-to-point services that transport

a single VLAN across an LDP or BGP network core using 802.1Q endpoint interface types

and vlan-ccc as the physical encapsulation type. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 340

• Configuration on Endpoint Z on page 341

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 { 
     flexible-vlan-tagging;
     mtu 1522;
     encapsulation vlan-ccc;
     unit 513 {
        description VLANCCC-SR;
        encapsulation vlan-ccc;
        vlan-id 513;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_513;
            }
        }
    }
}

firewall {
    policer policer_in_ge-0/1/1_513 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_513 {
            interface-specific;
            term 1 {
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                then {
                    policer policer_in_ge-0/1/1_513;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {     
        neighbor 192.168.1.40 {
            interface ge-0/1/1.513 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }

    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

 ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation vlan-ccc;
    unit 513 {
        description VLANCCC-SR;
        encapsulation vlan-ccc;
        vlan-id 513;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_513;
            }
        }
    }
}

firewall {
    policer policer_in_ge-0/1/1_513 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_513 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_513;
                    accept;
                }
            }
        }
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    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.513 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

ELine-Dot1q-SingleVLAN-Ext-CCC Service Definition

This service definition provides a base for creating point-to-point services that transport

a single VLAN across an LDP or BGP network core using 802.1Q endpoint interface types

and extended-vlan-ccc as the physical encapsulation type. Service provisioners can limit

the bandwidth of services built from this service definition to specific values from 10

Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 342

• Configuration on Endpoint Z on page 343

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation extended-vlan-ccc;
    unit 1 {
        description Extended-SR;
        vlan-id 1;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_1;
            }
        }
    }           
}               

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
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    family ccc {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
    }
}   

protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation extended-vlan-ccc;
    unit 1 {
        description Extended-SR;
        vlan-id 1;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_1;
            }
        }
    }
}

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }           
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
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            }
        }
    }
} 

protocols {
   l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

ELine-PortBased Service Definition

This service definition provides a base for creating point-to-point services that transport

all traffic across an LDP or BGP network core using an entire port at each endpoint using

ethernet-ccc as the physical encapsulation type. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

to 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 344

• Configuration on Endpoint Z on page 345

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
    encapsulation ethernet-ccc;
    unit 0 {
        family ccc {
            filter {
                input filter_in_ge-0/1/1;
            }
        }
    }
}

firewall {
    policer policer_in_ge-0/1/1 {
        if-exceeding {
            bandwidth-limit 10m;
            burst-size-limit 6250000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1 {
            interface-specific;
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            term 1 {
                then {
                    policer policer_in_ge-0/1/1;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.40 {     
            interface ge-0/1/1.0 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
        encapsulation ethernet-ccc;
        unit 0 {
            family ccc {
                filter {
                    input filter_in_ge-0/1/1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1 {
        if-exceeding {
            bandwidth-limit 10m;
            burst-size-limit 6250000;
        }
        then discard;
    }
    family ccc {           
        filter filter_in_ge-0/1/1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1;
                    accept;
                }
            }
        }
    }
}      

protocols {
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    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.0 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

ELine-QinQ-AllVLAN Service Definition

This service definition provides a base for creating point-to-point services that transport

all customer traffic across an LDP or BGP network core using Q-in-Q endpoint interface

types and flexible-ethernet-services as the physical encapsulation type. Service

provisioners can limit thebandwidthof servicesbuilt fromthis servicedefinition to specific

values from 10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 346

• Configuration on Endpoint Z on page 347

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

 ge-0/1/1 {           
      flexible-vlan-tagging;
      mtu 1522;
      encapsulation flexible-ethernet-services;
      unit 1 {
        description "AllVlanTransport";
        encapsulation vlan-ccc;
        vlan-tags outer 1;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_1;
            }
        }
    }

protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }

}
firewall {
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    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation flexible-ethernet-services;
    unit 1 {
        description "AllVlanTransport";
        encapsulation vlan-ccc;
        vlan-tags outer 1;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_1;
            }   
        }       
    }           
}

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }           
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
    }
}
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protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }       
        }
    }
}

ELine-QinQ-AllVLAN-CCC Service Definition

This service definition provides a base for creating point-to-point services that transport

all customer traffic across an LDP or BGP network core using Q-in-Q endpoint interface

types and vlan-ccc as the physical encapsulation type. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 348

• Configuration on Endpoint Z on page 349

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation vlan-ccc;
        unit 515 {  
            description QinQ-ALLVLAN;
            encapsulation vlan-ccc;
            vlan-tags outer 515;
            family ccc {
                filter {
                    input filter_in_ge-0/1/1_515;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1_515 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
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    family ccc {
        filter filter_in_ge-0/1/1_515 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_515;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.515 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }   
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation vlan-ccc;
    unit 515 {
        description QinQ-ALLVLAN;
        encapsulation vlan-ccc;
        vlan-tags outer 515;
        family ccc {
            filter {
                 input filter_in_ge-0/1/1_515;
            }   
        }
    }
}

firewall {
    policer policer_in_ge-0/1/1_515 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {    
        filter filter_in_ge-0/1/1_515 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_515;
                    accept;
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                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.515 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }   
    }
}

ELine-QinQ-AllVLAN-Ext-CCC Service Definition

This service definition provides a base for creating point-to-point services that transport

all customer traffic across an LDP or BGP network core using Q-in-Q endpoint interface

types and extended-vlan-ccc as the physical encapsulation type. Service provisioners

can limit the bandwidth of services built from this service definition to specific values

from 10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 350

• Configuration on Endpoint Z on page 351

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation extended-vlan-ccc;
        unit 1 {
            description Ext-AllVLAN;
            vlan-tags outer 1;
            family ccc {
                filter {
                    input filter_in_ge-0/1/1_1;
                }
            }       
        }           
    }               

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
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            burst-size-limit 62500000;
        }
        then discard;
    }               
    family ccc {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
    }

}

protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }

    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation extended-vlan-ccc;
        unit 1 {
            description Ext-AllVLAN;
            vlan-tags outer 1;
            family ccc {
                filter {
                    input filter_in_ge-0/1/1_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }               
    family ccc {
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        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {     
            interface ge-0/1/1.1 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

ELine-QinQ-VLANRange Service Definition

This service definition provides a base for creating point-to-point services that transport

a range of VLANs across an LDP or BGP network core using Q-in-Q endpoint interface

types and flexible-ethernet-services as the physical encapsulation type. Service

provisioners can limit thebandwidthof servicesbuilt fromthis servicedefinition to specific

values from 10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 352

• Configuration on Endpoint Z on page 353

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {                                    
       flexible-vlan-tagging;
       mtu 1522;
       encapsulation flexible-ethernet-services;
         unit 2 {
         description "QinQ Eline Martini";
         encapsulation vlan-ccc;
         vlan-tags outer 2 inner-range 100-110;
         family ccc {
            filter {
                input filter_in_ge-0/1/1_2;
            }
        }
    }
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}

firewall {
policer policer_in_ge-0/1/1_2 {
    if-exceeding {
        bandwidth-limit 100m;
        burst-size-limit 62500000;
    }

family ccc {
    filter filter_in_ge-0/1/1_2 {
        interface-specific;
        term 1 {
            then {
                policer policer_in_ge-0/1/1_2;
                accept;
            }

protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.2 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }

    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation flexible-ethernet-services;
    unit 2 {
        description "QinQ Eline Martini";
        encapsulation vlan-ccc;
        vlan-tags outer 2 inner-range 100-110;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_2;
            }
        }
    }
}

firewall {
    policer policer_in_ge-0/1/1_2 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
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        then discard;
    }

    family ccc {
        filter filter_in_ge-0/1/1_2 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_2;
                    accept;
                }   
            }
        }
    }
}

protocols {
    l2circuit {     
            interface ge-0/1/1.2 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

ELine-QinQ-VLANRange-CCC Service Definition

This service definition provides a base for creating point-to-point services that transport

a range of VLANs across an LDP or BGP network core using Q-in-Q endpoint interface

types and vlan-ccc as the physical encapsulation type. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 354

• Configuration on Endpoint Z on page 355

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

    ge-0/1/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation vlan-ccc;
        unit 514 {
            description VLANRANGE-SR;
            encapsulation vlan-ccc;
            vlan-tags outer 514 inner-range 600-610;
            family ccc {
                filter {
                    input filter_in_ge-0/1/1_514;
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                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1_514 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_514 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_514;
                    accept;
                }   
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.40 {
            interface ge-0/1/1.514 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }

        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

 ge-0/1/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation vlan-ccc;
        unit 514 {
            description VLANRANGE-SR;
            encapsulation vlan-ccc;
            vlan-tags outer 514 inner-range 600-610;
            family ccc {
                filter {
                    input filter_in_ge-0/1/1_514;
                }
            }
        }
    }
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firewall {
    policer policer_in_ge-0/1/1_514 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_514 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_514;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.514 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
            }
        }
    }
}

ELine-QinQ-VLANRange-Ext-CCC Service Definition

This service definition provides a base for creating point-to-point services that transport

a range of VLANs across an LDP or BGP network core using Q-in-Q endpoint interface

types and extended-vlan-ccc as the physical encapsulation type. Service provisioners

can limit the bandwidth of services built from this service definition to specific values

from 10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 356

• Configuration on Endpoint Z on page 357

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation extended-vlan-ccc;
    unit 2 {    
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        description Ext-VLANRange;
        vlan-tags outer 2 inner-range 100-110;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_2;
            }   
        }       
    }           
}   

firewall {          
    policer policer_in_ge-0/1/1_2 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family ccc {
        filter filter_in_ge-0/1/1_2 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_2;
                    accept;
                }
            }
        }
    }
}     

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.2 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
             }
         }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

ge-0/1/1 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation extended-vlan-ccc;
    unit 2 {
        description Ext-VLANRange;
        vlan-tags outer 2 inner-range 100-110;
        family ccc {
            filter {
                input filter_in_ge-0/1/1_2;
            }   
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        }
    }
} 

firewall {
    policer policer_in_ge-0/1/1_2 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }               
    family ccc {
        filter filter_in_ge-0/1/1_2 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_2;
                    accept;
                }
            }
        }
    }
}

protocols {
    l2circuit {
        neighbor 192.168.1.30 {
            interface ge-0/1/1.2 {
                virtual-circuit-id 786;
                no-control-word;
                mtu 1522;
             }
         }
    }
}

ELine-BGP-Port-Based

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 358

• Configuration on Endpoint Z on page 359

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

routing-instances{
    instance-type l2vpn;
    interface ge-1/0/7.0;
    route-distinguisher 69:27;
    vrf-target target:69:49165;
    protocols {
        l2vpn {
            encapsulation-type ethernet-vlan;
            no-control-word;
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            site L2VPN_Site_1 {
                site-identifier 1;
                mtu 1522;
                interface ge-1/0/7.0 {
                   remote-site-id 2;
                   description P2P-BGP-PortBased;
               }
           }
        }
    }
}

ge-1/0/7 {
    mtu 1522;
    encapsulation ethernet-ccc;
    unit 0 {
        family ccc {
            filter {
                input filter_in_ge-1/0/7;
            }
        }
    }
}

firewall{

    family ccc {

       filter filter_in_ge-1/0/7 {
           interface-specific;
            term 1 {
               then {
                   policer policer_in_ge-1/0/7;
                   accept;
               }
           }
        }
    }
    policer policer_in_ge-1/0/7 {
     if-exceeding {
            bandwidth-limit 10m;
     burst-size-limit 15220;
 }
 then discard;
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

routing-instances{
    instance-type l2vpn;
    interface ge-1/0/8.0;
    route-distinguisher 69:27;
    vrf-target target:69:49165;
    protocols {
        l2vpn {
            encapsulation-type ethernet-vlan;
            no-control-word;
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            site L2VPN_Site_2 {
                site-identifier 2;
                mtu 1522;
                interface ge-1/0/8.0 {
                   remote-site-id 1;
                   description P2P-BGP-PortBased;
               }
           }
        }
    }
}

ge-1/0/8 {
    mtu 1522;
    encapsulation ethernet-ccc;
    unit 0 {
        family ccc {
            filter {
                input filter_in_ge-1/0/8;
            }
        }
    }
}

firewall{

    family ccc {

       filter filter_in_ge-1/0/8 {
           interface-specific;
            term 1 {
               then {
                   policer policer_in_ge-1/0/8;
                   accept;
               }
           }
        }
    }
    policer policer_in_ge-1/0/8 {
     if-exceeding {
            bandwidth-limit 10m;
     burst-size-limit 15220;
 }
 then discard;
    }
}

Eline-BGP-Dot1q-SingleVLAN

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 361

• Configuration on Endpoint Z on page 362
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Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

routing-instances {
    instance-type l2vpn;
    interface ge-0/0/2.823;
    route-distinguisher 69:26;
    vrf-target target:69:49164;
    protocols {
        l2vpn {
            encapsulation-type ethernet-vlan;
            no-control-word;
            site L2VPN_Site_1 {
                site-identifier 1;
                interface ge-0/0/2.823 {
                    remote-site-id 2;
                }
            }
        }
    }
}

ge-0/0/2 {
    enable;
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation flexible-ethernet-services;
    unit 823 {
        description "ELine-BGP-Dot1Q";
        encapsulation vlan-ccc;
        vlan-id 823;
        family ccc {
            filter {
                input filter_in_ge-0/0/2_823;
            }
        }
    }
}

firewall{

    family ccc {

       filter filter_in_ge-0/0/2_823 {
           interface-specific;
            term 1 {
               then {
                   policer policer_in_ge-0/0/2_823;
                   accept;
               }
           }
        }
    }
    policer policer_in_ge-0/0/2_823 {
     if-exceeding {
            bandwidth-limit 10m;
     burst-size-limit 15220;
 }
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 then discard;
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

routing-instances {
    instance-type l2vpn;
    interface ge-0/0/3.823;
    route-distinguisher 69:26;
    vrf-target target:69:49164;
    protocols {
        l2vpn {
            encapsulation-type ethernet-vlan;
            no-control-word;
            site L2VPN_Site_2 {
                site-identifier 2;
                interface ge-0/0/3.823 {
                    remote-site-id 1;
                }
            }
        }
    }
}

ge-0/0/3 {
    enable;
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation flexible-ethernet-services;
    unit 823 {
        description "ELine-BGP-Dot1Q";
        encapsulation vlan-ccc;
        vlan-id 823;
        family ccc {
            filter {
                input filter_in_ge-0/0/3_823;
            }
        }
    }
}

firewall{

    family ccc {

       filter filter_in_ge-0/0/3_823 {
           interface-specific;
            term 1 {
               then {
                   policer policer_in_ge-0/0/3_823;
                   accept;
               }
           }
        }
    }
    policer policer_in_ge-0/0/3_823 {
     if-exceeding {
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            bandwidth-limit 10m;
     burst-size-limit 15220;
 }
 then discard;
    }
}

Eline-BGP-QinQ-AllVLAN

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 12 on page 284:

• Configuration on Endpoint A on page 363

• Configuration on Endpoint Z on page 364

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A:

routing-instances {
    instance-type l2vpn;
    interface ge-0/0/1.981;
    route-distinguisher 69:15;
    vrf-target target:69:49160;
    protocols {
        l2vpn {
            encapsulation-type ethernet-vlan;
            no-control-word;
            site L2VPN_Site_1 {
                site-identifier 1;
                mtu 1522;
                interface ge-0/0/1.981 {
                    remote-site-id 2;
                    description P2P-BGP-QnQAllVLan;
                }
            }
        }
    }
}

ge-0/0/3 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation flexible-ethernet-services;    
    unit 981 {
        description "No description available for selected UNI interface.";
        encapsulation vlan-ccc;
        vlan-tags outer 981;
        family ccc {
            filter {
                input filter_in_ge-0/0/3_981;
            }
        }
    }
}

firewall{
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    family ccc {

       filter filter_in_ge-0/0/3_981;{
           interface-specific;
            term 1 {
               then {
                   policer policer_in_ge-0/0/3_981;
                   accept;
               }
           }
        }
    }
    policer policer_in_ge-0/0/3_981;{
     if-exceeding {
            bandwidth-limit 10m;
     burst-size-limit 15220;
 }
 then discard;
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z:

routing-instances {
    instance-type l2vpn;
    interface ge-0/0/5.981;
    route-distinguisher 69:15;
    vrf-target target:69:49160;
    protocols {
        l2vpn {
            encapsulation-type ethernet-vlan;
            no-control-word;
            site L2VPN_Site_2 {
                site-identifier 2;
                mtu 1522;
                interface ge-0/0/5.981 {
                    remote-site-id 1;
                    description P2P-BGP-QnQAllVLan;
                }
            }
        }
    }
}

ge-0/0/5 {
    flexible-vlan-tagging;
    mtu 1522;
    encapsulation flexible-ethernet-services;    
    unit 981 {
        description "No description available for selected UNI interface.";
        encapsulation vlan-ccc;
        vlan-tags outer 981;
        family ccc {
            filter {
                input filter_in_ge-0/0/5.981 
            }
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        }
    }
}

firewall{

    family ccc {

       filter filter_in_ge-0/0/5.981 {
           interface-specific;
            term 1 {
               then {
                   policer policer_in_ge-0/0/5.981 
                   accept;
               }
           }
        }
    }
    policer policer_in_ge-0/0/5.981 {
     if-exceeding {
            bandwidth-limit 10m;
     burst-size-limit 15220;
 }
 then discard;
    }
}

Related
Documentation

ChoosingaPredefinedServiceDefinitionorCreatingaNewServiceDefinitiononpage91•

• Creating a Point-to-Point Ethernet Service Definition on page 97

• Predefined Multipoint-to-Multipoint Ethernet Service Definitions on page 365

• Predefined Point-to-Multipoint Ethernet Service Definitions on page 390

• Predefined Full Mesh Layer 3 VPN Service Definitions on page 403

• Predefined Hub-and Spoke Layer 3 VPN Service Definitions on page 403

PredefinedMultipoint-to-Multipoint Ethernet Service Definitions

The Network Activate software provides predefined service definitions that a service

provisioner can choose fromwhen creating a service order. This section provides

informationaboutpredefinedservicedefinitionsused forcreatingmutlipoint-to-multipoint

Ethernet services. For information about predefined service definitions used to create

point-to-point service definitions or point-to-multipoint service definitions, see the

following topics:

• Predefined Point-to-Multipoint Ethernet Service Definitions on page 390

• Predefined Point-to-Point Service Definitions on page 333

If none of the multipoint-to-multipoint predefined service definitions described here is

appropriate for your needs, you can create a service definition as described in “Creating

a Multipoint-to-Multipoint VPLS Service Definition” on page 117.
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The Network Activate software provides predefined service definitions for VPLS services

that use BGP switching in the network core. These services are sometimes known as

E-LAN services. This section covers multipoint-to-multipoint (or full mesh) service

definitions. Figure 13 on page 307 shows an example of such a service.

Figure 16: Multipoint-to-Multipoint Service

Information specific to each service instance, such as the device name, endpoint name,

and customer VLAN ID, is provided in the service order. Attributes that can apply across

many service instances are typically defined in the service definition. These attributes

include:

• Ethernet option (dot1.q, port-port, qinq)

• Traffic type (single VLAN, VLAN range, all traffic)

• VLAN normalization

• Physical interface encapsulation

• Logical interface encapsulation

• Rate limit range

Table 20 on page 308 lists each of the standard VPLS service definitions. Each standard

service definition is then described in detail in the sections that follow.

Table 23: StandardMultipoint-to-Multipoint Service Definitions

Service AttributesStandard Service Definition Name

• Multipoint Ethernet service forMSeries and
MX Series devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs are not preserved

• 802.1Q endpoint interface types

• Customer traffic is single VLAN

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-Dot1q-Normalized-VLAN-None”on
page 309

Copyright © 2015, Juniper Networks, Inc.366

Junos Space Cross Provisioning Platform



Table 23: StandardMultipoint-to-Multipoint Service
Definitions (continued)

Service AttributesStandard Service Definition Name

• Multipoint Ethernet service for M Series or
MX Series devices

• Gigabit Ethernet interfaces

• 802.1Q endpoint interface types

• Customer traffic is single VLAN

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-Dot1Q-SingleVLAN” on page 313

• Multipoint Ethernet service for M series and
MX Series devices

• Gigabit Ethernet interfaces

• Port-based UNIs

• Transports all customer traffic

• Ethernet VPLS as physical encapsulation
type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-PortBased” on page 316

• Multipoint Ethernet service forMSeries and
MX Series devices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-QinQ-AllVLAN” on page 319

• Multipoint Ethernet service forMSeries and
MX Series devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs preserved

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-QinQ-AllVLAN-Normalized-All” on
page 322
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Table 23: StandardMultipoint-to-Multipoint Service
Definitions (continued)

Service AttributesStandard Service Definition Name

• Multipoint Ethernet service forMSeries and
MX Series devices

• Gigabit Ethernet interfaces

• Q-in-Q endpoint interface types

• VLAN IDs not preserved

• All customer traffic

• Flexible-ethernet-services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-QinQ-AllVLAN-Normalized-None”
on page 325

• Multipoint Ethernet service for MX Series
devices only

• Gigabit Ethernet interfaces

• Customer VLAN IDs preserved

• Q-in-Q endpoint interface types

• Transports specified VLAN range

• Flexible Ethernet services physical
encapsulation type

• Rate limiting from10Mbps to 100Mbpswith
10 Mbps increment

“ELAN-BGP-QinQ-Range-Normalized-VLAN”
on page 328

ELAN-BGP-Dot1q-Normalized-VLAN-None Service Definition

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport traffic from a single VLAN on an endpoint across a BGP network

core using802.1Qendpoint interface typesand flexible-ethernet-services as thephysical

encapsulation type. VLAN IDs are not preserved across the network—traffic passes from

the single VLAN on an endpoint to any VLANs in the broadcast domain. Service

provisioners can limit thebandwidthof servicesbuilt fromthis servicedefinition to specific

values from 10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 13 on page 307:

• Configuration on Endpoint A on page 368

• Configuration on Endpoint B on page 369

• Configuration on Endpoint Z on page 370

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

ge-0/0/1 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
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        unit 1 {
            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/1_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/1_1;
                    accept;
                }
            }
        }
    }               
}
routing-instances {
    BestCustomer_ELAN-BGP-Dot1q-Normalized-VLAN-SR {
        instance-type vpls;
        vlan-id none;
        interface ge-0/0/1.1;
        route-distinguisher 65410:1;
        vrf-target target:65410:0;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/0/1.1;
                }
            }
        }

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

    ge-0/0/1 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
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                filter {
                    input filter_in_ge-0/0/1_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/1_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-Dot1q-Normalized-VLAN-SR {
        instance-type vpls;
        vlan-id none;
        interface ge-0/0/1.1;
        route-distinguisher 65410:0;
        vrf-target target:65410:0;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/0/1.1;
                }
            }
        }           
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

    ge-0/0/1 {      
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/1_1;
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                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/1_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-Dot1q-Normalized-VLAN-SR {
        instance-type vpls;
        vlan-id none;
        interface ge-0/0/1.1;
        vlan-id none;
        route-distinguisher 65410:2;
        vrf-target target:65410:0;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/1.1;
                }
            }
        }
    }

ELAN-BGP-Dot1Q-SingleVLAN Service Definition

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport traffic on a single VLAN across a BGP network core using 802.1Q

endpoint interface types and flexible-ethernet-services as the physical encapsulation

type. No VLANmapping is performed—the VLAN IDmust be the same on all endpoints.

Service provisioners can limit the bandwidth of services built from this service definition

to specific values from 10 Mbps through 100Mbps.
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The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 13 on page 307:

• Configuration on Endpoint A on page 372

• Configuration on Endpoint B on page 373

• Configuration on Endpoint Z on page 374

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

    ge-0/0/2 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/2_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/2_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }

        filter filter_in_ge-0/0/2_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/2_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-Dot1Q-SingleVLAN-SR {
        instance-type vpls;
        interface ge-0/0/2.1;
        route-distinguisher 65410:4;
        vrf-target target:65410:1;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/0/2.1;
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                }
            }
        }           
    }

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

    ge-0/0/2 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/2_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/2_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
        filter filter_in_ge-0/0/2_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/2_1;
                    accept;
                }
            }
        }
    }
}

routing-instances {
    BestCustomer_ELAN-BGP-Dot1Q-SingleVLAN-SR {
        instance-type vpls;
        interface ge-0/0/2.1;
        route-distinguisher 65410:3;
        vrf-target target:65410:1;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/0/2.1;
                }
            }
        }
    }
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Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

    ge-0/0/2 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-id 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/2_1;
                }
            }       
        }           
    }               

firewall {
    policer policer_in_ge-0/0/2_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {   
        filter filter_in_ge-0/0/2_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/2_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-Dot1Q-SingleVLAN-SR {
        instance-type vpls;
        interface ge-0/0/2.1;
        route-distinguisher 65410:5;
        vrf-target target:65410:1;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/2.1;
                }
            }
        }
    }

Copyright © 2015, Juniper Networks, Inc.374

Junos Space Cross Provisioning Platform



ELAN-BGP-PortBased Service Definition

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport all traffic on an entire port across a BGP network core using

ethernet-vpls as the physical encapsulation type. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 13 on page 307:

• Configuration on Endpoint A on page 375

• Configuration on Endpoint B on page 376

• Configuration on Endpoint Z on page 377

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

 ge-0/1/3 {      
        mtu 1522;
        encapsulation ethernet-vpls;
        unit 0 {
            family vpls {
                filter {
                    input filter_in_ge-0/1/3;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/3 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 15220;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/1/3 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/3;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    ELAN_BGP_PortBased_10_100M {
        instance-type vpls;
        interface ge-0/1/3.0;
        route-distinguisher 65410:3;
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        vrf-target target:65410:1;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/1/3.0;
                }
            }
        }
    }
} 

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

 ge-0/1/3 {
        mtu 1522;   
        encapsulation ethernet-vpls;
        unit 0 {
            family vpls {
                filter {
                    input filter_in_ge-0/1/3;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/3 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 15220;
        }           
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/1/3 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/3;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    ELAN_BGP_PortBased_10_100M {
        instance-type vpls;
        interface ge-0/1/3.0;
        route-distinguisher 65410:2;
        vrf-target target:65410:1;
        protocols {
            vpls {
                no-tunnel-services;
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                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/1/3.0;
                }
            }
        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

 ge-0/2/2 {
        mtu 1522;
        encapsulation ethernet-vpls;
        unit 0 {
            family vpls {
                filter {
                    input filter_in_ge-0/2/2;
                }
            }
        }
    }

}
firewall {
    policer policer_in_ge-0/2/2 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 15220;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/2/2 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/2/2;
                    accept;
                }
            }
        }
    }
}

routing-instances {
    ELAN_BGP_PortBased_10_100M {
        instance-type vpls;
        interface ge-0/2/2.0;
        route-distinguisher 65410:4;
        vrf-target target:65410:1;
        protocols { 
            vpls {
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
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                    interface ge-0/2/2.0;
                }
            }
        }
    }

ELAN-BGP-QinQ-AllVLAN Service Definition

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport all traffic across a BGP network core using Q-in-Q endpoint

interface types and flexible-ethernet-services as the physical encapsulation type. No

VLANmapping is performed—customer VLAN IDs and service provider VLAN IDs must

match on each endpoint that is to send or receive traffic. Service provisioners can limit

the bandwidth of services built from this service definition to specific values from 10

Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 13 on page 307:

• Configuration on Endpoint A on page 378

• Configuration on Endpoint B on page 379

• Configuration on Endpoint Z on page 380

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

ge-0/1/1 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/1/1_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }               
    family vpls {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
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                }
            }
        }           
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-SR {
        instance-type vpls;
        interface ge-0/1/1.1;
        route-distinguisher 65410:13;
        vrf-target target:65410:4;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/1/1.1;
                }
            }
        }
    }
}

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

ge-0/1/1 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/1/1_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/1/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/1_1;
                    accept;
                }
            }
        }
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    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-SR {
        instance-type vpls;
        interface ge-0/1/1.1;
        route-distinguisher 65410:12;
        vrf-target target:65410:4;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/1/1.1;
                }
            }
        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

ge-0/0/5 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/5_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/5_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/5_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/5_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
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    BestCustomer_ELAN-BGP-QinQ-AllVLAN-SR {
        instance-type vpls;
        interface ge-0/0/5.1;
        route-distinguisher 65410:14;
        vrf-target target:65410:4;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/5.1;
                }
            }
        }
    }
}

ELAN-BGP-QinQ-AllVLAN-Normalized-All Service Definition

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport all traffic across a BGP network core using Q-in-Q endpoint

interface types and flexible-ethernet-services as the physical encapsulation type.

Customer VLAN IDs are preserved across the network—traffic passes only among

matching customer VLAN IDs. However, traffic can pass among any service provider

VLAN ID in thebroadcastdomain. Serviceprovisioners can limit thebandwidthof services

built from this service definition to specific values from 10 Mbps through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 13 on page 307:

• Configuration on Endpoint A on page 381

• Configuration on Endpoint B on page 382

• Configuration on Endpoint Z on page 383

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

ge-0/1/0 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {    
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/1/0_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/0_1 {
        if-exceeding {
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            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/1/0_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/0_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-All-SR {
        instance-type vpls;
        vlan-id all;
        interface ge-0/1/0.1;
        route-distinguisher 65410:10;
        vrf-target target:65410:3;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/1/0.1;
                }
            }
        }
    }

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

ge-0/1/0 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/1/0_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/1/0_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
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        then discard;
    }
    family vpls {
        filter filter_in_ge-0/1/0_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/1/0_1;
                    accept;
                }
            }
        }           
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-All-SR {
        instance-type vpls;
        vlan-id all;
        interface ge-0/1/0.1;
        route-distinguisher 65410:9;
        vrf-target target:65410:3;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/1/0.1;
                }
            }
        }
    }

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

ge-0/0/4 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/4_1;
                }
            }
        }
    }
firewall {
    policer policer_in_ge-0/0/4_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/4_1 {
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            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/4_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {             
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-All-SR {
        instance-type vpls;
        vlan-id all;
        interface ge-0/0/4.1;
        vlan-id all;
        route-distinguisher 65410:11;
        vrf-target target:65410:3;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/4.1;
                }
            }
        }
    }

ELAN-BGP-QinQ-AllVLAN-Normalized-None Service Definition

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport all traffic across a BGP network core using Q-in-Q endpoint

interface types and flexible-ethernet-services as the physical encapsulation type. VLAN

IDs are not preserved across the network—traffic passes between any customer VLAN

or service provider VLAN in the broadcast domain. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

service definition to create the service shown in Figure 13 on page 307:

• Configuration on Endpoint A on page 384

• Configuration on Endpoint B on page 385

• Configuration on Endpoint Z on page 386

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device IND):

ge-0/0/3 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
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            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/3_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/3_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/3_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/3_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {          
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-SR {
        instance-type vpls;
        vlan-id none;
        interface ge-0/0/3.1;
        route-distinguisher 65410:7;
        vrf-target target:65410:2;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/0/3.1;
                }
            }
        }
    }
}

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device BLR):

ge-0/0/3 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
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                filter {
                    input filter_in_ge-0/0/3_1;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/3_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/3_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/3_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-SR {
        instance-type vpls;
        vlan-id none;
        interface ge-0/0/3.1;
        route-distinguisher 65410:6;
        vrf-target target:65410:2;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/0/3.1;
                }
            }
        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SJC):

ge-0/0/3 {
        flexible-vlan-tagging;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-0/0/3_1;
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                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/3_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }               
    family vpls {
        filter filter_in_ge-0/0/3_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/3_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-AllVLAN-Normalized-SR {
        instance-type vpls;
        vlan-id none;
        interface ge-0/0/3.1;
        vlan-id none;
        route-distinguisher 65410:8;
        vrf-target target:65410:2;
        protocols { 
            vpls {
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/3.1;
                }
            }
        }
    }
}

ELAN-BGP-QinQ-Range-Normalized-VLAN Service Definition

This service definition provides a base for creating multipoint-to-multipoint Ethernet

services that transport traffic froma rangeofVLANsonanendpointacrossaBGPnetwork

core usingQ-in-Qendpoint interface typesand flexible-ethernet-services as thephysical

encapsulation type. Services built from this service definitionmust useMXSeries devices

on the provider edge. Customer VLAN IDs are preserved across the network—traffic

passes among like customer VLAN IDs on any service provider VLAN in the broadcast

domain. Service provisioners can limit the bandwidth of services built from this service

definition to specific values from 10 Mbps through 100Mbps.
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The following sections show the configuration data for a servicewith only twoendpoints,

SJC and SFO.

• Configuration on Endpoint A on page 388

• Configuration on Endpoint Z on page 389

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device SJC):

ge-0/0/6 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation flexible-ethernet-services;
        unit 2 {    
            encapsulation vlan-vpls;
            vlan-tags outer 2 inner-range 1500-2000;
            family vpls {
                filter {
                    input filter_in_ge-0/0/6_2;
                }
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/6_2 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/6_2 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/6_2;
                    accept;
                }
            }       
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-Range-Normalized-VLAN-SR1 {
        instance-type vpls;
        vlan-id all;
        interface ge-0/0/6.2;
        vlan-id all;
        route-distinguisher 65410:19;
        vrf-target target:65410:6;
        protocols {
            vpls {  
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
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                    interface ge-0/0/6.2;
                }
            }
        }
    }
}

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device SFO):

ge-0/0/1 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1 inner-range 1500-2000;
            family vpls {
                filter {
                    input filter_in_ge-0/0/1_1;
                }   
            }
        }
    }

firewall {
    policer policer_in_ge-0/0/1_1 {
        if-exceeding {
            bandwidth-limit 100m;
            burst-size-limit 62500000;
        }
        then discard;
    }
    family vpls {
        filter filter_in_ge-0/0/1_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/1_1;
                    accept;
                }
            }
        }
    }
}
routing-instances {
    BestCustomer_ELAN-BGP-QinQ-Range-Normalized-VLAN-SR1 {
        instance-type vpls;
        vlan-id all;
        interface ge-0/0/1.1;
        route-distinguisher 65410:18;
        vrf-target target:65410:6;
        protocols {
            vpls {
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-0/0/1.1;
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                }
            }
        }
    }

Related
Documentation

Creating a Multipoint-to-Multipoint VPLS Service Definition on page 117•

• Predefined Point-to-Multipoint Ethernet Service Definitions on page 390

• Predefined Point-to-Point Service Definitions on page 333

Predefined Point-to-Multipoint Ethernet Service Definitions

The Network Activate software provides predefined service definitions that a service

provisioner can choose fromwhen creating a service order. This section provides

information about predefined service definitions used for creating point-to-multipoint

services. For informationaboutpredefinedservicedefinitionsused tocreatepoint-to-point

servicedefinitionsormultipoint-to-multipoint servicedefinitions, see the following topics:

• Predefined Multipoint-to-Multipoint Ethernet Service Definitions on page 365

• Predefined Point-to-Point Service Definitions on page 333

If none of the point-to-multipoint predefined service definitions described here is

appropriate for your needs, you can create a service definition as described in “Creating

a Point-to-Multipoint VPLS Service Definition” on page 138.

The Network Activate software provides predefined service definitions for VPLS services

that use BGP switching in the network core. These services are sometimes known as

E-LAN services. This section covers point-to-multipoint (or hub-and-spoke) service

definitions.

Information specific to each service instance, such as the device name, endpoint name,

customer VLAN ID, andwhether a specific endpoint is a hub or a spoke is provided in the

serviceorder. Attributes that canapplyacrossmanyservice instancesare typically defined

in the service definition. These attributes include:

• Ethernet option (dot1.q, qinq)

• Traffic type (single VLAN, VLAN range, all traffic)

• VLAN normalization

• Physical interface encapsulation

• Logical interface encapsulation

• Rate limit range

Table 24 on page 391 lists each of the standard VPLS service definitions. Each standard

service definition is then described in detail in the sections that follow.
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Table 24: Standard Point-to-Multipoint Service Definitions

Service AttributesStandard Service Definition Name

• Multipoint Ethernet service forMSeries orMXSeries
devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs are preserved

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-services physical encapsulation
type

• Rate limiting from 10 Mbps to 100Mbps with
10 Mbps increment

“ELAN-Hub-Spoke-QinQ-AllVLAN” on
page 332

• Multipoint Ethernet service for M Series and MX
Series devices

• Gigabit Ethernet interfaces

• Customer VLAN IDs are not preserved

• Q-in-Q endpoint interface types

• All customer traffic

• Flexible-ethernet-services physical encapsulation
type

• Rate limiting from 10 Mbps to 100Mbps with
10 Mbps increment

“ELAN-Hub-Spoke-QinQ-AllVLAN-No”
on page 333

ELAN-Hub-Spoke-QinQ-AllVLAN-Normalized-All Service Definition

This service definition provides a base for creating point-to-multipoint Ethernet services

that transport all traffic onanendpointacrossaBGPnetworkcoreusingQ-in-Qendpoint

interface types and flexible-ethernet-services as the physical encapsulation type. VLAN

IDs are not preserved across the network—traffic passes from the single VLAN on an

endpoint to any VLANs in the broadcast domain. Service provisioners can limit the

bandwidth of services built from this service definition to specific values from 10 Mbps

through 100Mbps.

The following sections show the configuration data on each endpoint when you use this

servicedefinition tocreate theserviceshown inFigure 14onpage331—apoint-to-multipoint

service with one hub and two spokes.
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Figure 17: Point-to-Multipoint Service with One Hub

• Configuration on Endpoint A on page 392

• Configuration on Endpoint B on page 394

• Configuration on Endpoint Z on page 395

Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device SFO). This device is configured as the

service hub.

interfaces {
    ge-0/0/2 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation flexible-ethernet-services;
        unit 4 {
            encapsulation vlan-vpls;
            vlan-tags outer 4;
            family vpls {
                filter {
                    input filter_in_ge-0/0/2_4;
                }
            }
        }
    }
policy-options {    
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-hm-export {
        term 1 {
            then {
                community add 
export-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:8;
                accept;
            }
        }
        term 2 {
            then reject;
        }
    }
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-hm-import {
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        term 1 {
            from {
                protocol bgp;
                community [ 
import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:9 
import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:8 ];
            }
            then accept;
        }
        term 2 {
            then reject;
        }
    }
    community export-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:8 
members target:65410:8;
    community import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:8 
members target:65410:8;
    community import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:9 
members target:65410:9;
}
firewall {          
    family vpls {       
        filter filter_in_ge-0/0/2_4 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/2_4;
                    accept;
                }
            }
        }
    }
    policer policer_in_ge-0/0/2_4 {
        if-exceeding {
            bandwidth-limit 10m;
            burst-size-limit 15220;
        }
        then discard;
    }
}
routing-instances {
    ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All {
        instance-type vpls;
        vlan-id all;
        interface ge-0/0/2.4;
        route-distinguisher 65410:15;
        vrf-import ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-hm-import;
        vrf-export ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-hm-export;
        protocols {
            vpls {
                mac-table-size {
                    5120;
                }
                interface-mac-limit {
                    1024;
                }
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/0/2.4;
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                }
            }
        }

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device SJC). This device is a service spoke.

interfaces {
    ge-0/0/4 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation flexible-ethernet-services;
        unit 4 {
            encapsulation vlan-vpls;
            vlan-tags outer 4;
            family vpls {
                filter {
                    input filter_in_ge-0/0/4_4;
                }
            }
        }
    }

policy-options {
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-export {
        term 1 {
            then {
                community add 
export-comm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:9;
                accept;
            }
        }
        term 2 {
            then reject;
        }
    }
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-import {
        term 1 {
            from {
                protocol bgp;
                community 
import-comm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:8;
            }
            then accept;
        }
        term 2 {    
            then reject;
        }
    }
    community export-comm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:9 
members target:65410:9;
    community import-comm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:8 
members target:65410:8;
}

firewall {
    family vpls {
        filter filter_in_ge-0/0/4_4 {
            interface-specific;
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            term 1 {
                then {
                    policer policer_in_ge-0/0/4_4;
                    accept;
                }
            }
        }
    }
    policer policer_in_ge-0/0/4_4 {
        if-exceeding {
            bandwidth-limit 10m;
            burst-size-limit 15220;
        }           
        then discard;
    }
}

routing-instances {
    ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All {
        instance-type vpls;
        vlan-id all;
        interface ge-0/0/4.4;
        route-distinguisher 65410:16;
        vrf-import ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-import;
        vrf-export ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-export;
        protocols {
            vpls {
                mac-table-size {
                    5120;
                }
                interface-mac-limit {
                    1024;
                }
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/4.4;
                }
            }

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device Beijing). Thus device is a service spoke.

interfaces{
 ge-5/0/2 {
        unit 2 {
            encapsulation vlan-vpls;
            vlan-tags outer 2;
            family vpls {
                filter {
                    input filter_in_ge-5/0/2_2;
                }
            }
        }
    }               

policy-options {
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-export {
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        term 1 {
            then {
                community add 
export-comm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:9;
                accept;
            }
        }
        term 2 {
            then reject;
        }
    }
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-import {
        term 1 {
            from {
                protocol bgp;
                community 
import-comm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:8;
            }
            then accept;
        }
        term 2 {
            then reject;
        }
    }
    community export-comm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:9 
members target:65410:9;
    community import-comm-ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-65410:8 
members target:65410:8;
}
firewall {
    family vpls {
        filter filter_in_ge-5/0/2_2 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-5/0/2_2;
                    accept;
                }
            }
        }
    }
    policer policer_in_ge-5/0/2_2 {
        if-exceeding {
            bandwidth-limit 10m;
            burst-size-limit 15220;
        }
        then discard;
    }
}
    ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All {
        instance-type vpls;
        vlan-id all;
        interface ge-5/0/2.2;
        route-distinguisher 65410:14;
        vrf-import ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-import;
        vrf-export ELAN_Hub_Spoke_QinQ_AllVLAN_Normalized_All-export;
        protocols {
            vpls {
                mac-table-size {
                    5120;
                }

Copyright © 2015, Juniper Networks, Inc.396

Junos Space Cross Provisioning Platform



                interface-mac-limit {
                    1024;
                }
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-5/0/2.2;
                }
            }
        }
    }
}

ELAN-Hub-Spoke-QinQ-AllVLAN Service Definition

This service definition provides a base for creating point-to-multipoint Ethernet services

that transport all traffic onanendpointacrossaBGPnetworkcoreusingQ-in-Qendpoint

interface types and flexible-ethernet-services as the physical encapsulation type.

CustomerVLAN IDsarepreservedacross thenetwork—trafficpassesamong likecustomer

VLAN IDs on any service provider VLAN in the broadcast domain. Service provisioners

can limit the bandwidth of services built from this service definition to specific values

from10Mbpsthrough 100Mbps.Figure 18onpage397showsapoint-to-multipoint service

with two hubs.

The following sections show the configuration data on endpoints A, B, and Z when you

use this service definition to create the service shown in Figure 18 on page 397—a

point-to-multipoint service with two service hubs and two spokes. The configuration for

endpoint Y is not described.

Figure 18: Point-to-Multipoint Service with Two Hubs

• Configuration on Endpoint A on page 398

• Configuration on Endpoint B on page 399

• Configuration on Endpoint Z on page 401
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Configuration on Endpoint A

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint A (device SFO). This device is configured as a

service hub.

interfaces {
    ge-0/0/2 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation flexible-ethernet-services;
        unit 3 {
            encapsulation vlan-vpls;
            vlan-tags outer 3;
            family vpls {
                filter {
                    input filter_in_ge-0/0/2_3;
                }
            }
        }
    }

policy-options {
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN-hm-export {
        term 1 {
            then {
                community add export-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:4;

                accept;
            }
        }
        term 2 {    
            then reject;
        }
    }
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN-hm-import {
        term 1 {
            from {
                protocol bgp;
                community [ import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:5 
import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:4 ];
            }
            then accept;
        }
        term 2 {
            then reject;
        }
    }
    community export-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:4 members 
target:65410:4;
    community import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:4 members 
target:65410:4;
    community import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:5 members 
target:65410:5;
}

firewall {
    family vpls {  
        filter filter_in_ge-0/0/2_3 {
            interface-specific;
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            term 1 {
                then {
                    policer policer_in_ge-0/0/2_3;
                    accept;
                }
            }
    }

    policer policer_in_ge-0/0/2_3 {
        if-exceeding {
            bandwidth-limit 10m;
            burst-size-limit 15220;
        }
        then discard;

}

    ELAN_Hub_Spoke_QinQ_AllVLAN {
        instance-type vpls;
        interface ge-0/0/2.3;
        route-distinguisher 65410:9;
        vrf-import ELAN_Hub_Spoke_QinQ_AllVLAN-hm-import;
        vrf-export ELAN_Hub_Spoke_QinQ_AllVLAN-hm-export;
        protocols {
            vpls {
                mac-table-size {
                    5120;
                }
                interface-mac-limit {
                    1024;
                }
                no-tunnel-services;
                site Site_2 {
                    site-identifier 2;
                    site-preference primary;
                    interface ge-0/0/2.3;
                }
            }
        }
    }

Configuration on Endpoint B

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint B (device SJC). This device is configured as a

service hub.

interfaces {
  ge-0/0/4 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation flexible-ethernet-services
        unit 3 {
            encapsulation vlan-vpls;
            vlan-tags outer 3;
            family vpls {
                filter {
                    input filter_in_ge-0/0/4_3;
                }
           }
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 }
policy-options {
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN-hm-export {
        term 1 {
            then {
                community add export-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:4;

                accept;
            }
        }
        term 2 {
            then reject;
        }
    }
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN-hm-import {
        term 1 {
            from {
                protocol bgp;
                community [ import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:5 
import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:4 ];
            }
            then accept;
        }
        term 2 {
            then reject;
        }
    }
    community export-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:4 members 
target:65410:4;
    community import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:4 members 
target:65410:4;
    community import-comm-hm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:5 members 
target:65410:5;

}

firewall {
    family vpls {
        filter filter_in_ge-0/0/4_3 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-0/0/4_3;
                    accept;
                }
            }
        }
 policer policer_in_ge-0/0/4_3 {
        if-exceeding {
            bandwidth-limit 10m;
            burst-size-limit 15220;
        }
        then discard;
    }

    ELAN_Hub_Spoke_QinQ_AllVLAN {
        instance-type vpls;
        interface ge-0/0/4.3;
        route-distinguisher 65410:10;
        vrf-import ELAN_Hub_Spoke_QinQ_AllVLAN-hm-import;
        vrf-export ELAN_Hub_Spoke_QinQ_AllVLAN-hm-export;
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        protocols {
            vpls {
                mac-table-size {
                    5120;
                }
                interface-mac-limit {
                    1024;
                }
                no-tunnel-services;
                site Site_3 {
                    site-identifier 3;
                    site-preference primary;
                    interface ge-0/0/4.3;
                }
            }
        }
    }

Configuration on Endpoint Z

The following statements show the interface configuration, the filter configuration, and

connectivity configuration on endpoint Z (device Beijing). This device is configured as a

service spoke.

interfaces {
    ge-5/0/2 {
        flexible-vlan-tagging;
        mtu 1522;
        encapsulation flexible-ethernet-services;
        unit 1 {
            encapsulation vlan-vpls;
            vlan-tags outer 1;
            family vpls {
                filter {
                    input filter_in_ge-5/0/2_1;
                }
            }
        }
    }

policy-options {
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN-export {
        term 1 {
            then {
                community add export-comm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:5;
                accept;
            }
        }
        term 2 {
            then reject;
        }
    }
    policy-statement ELAN_Hub_Spoke_QinQ_AllVLAN-import {
        term 1 {    
            from {
                protocol bgp;
                community import-comm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:4;
            }
            then accept;
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        }
        term 2 {
            then reject;
        }
    }
    community export-comm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:5 members 
target:65410:5;
    community import-comm-ELAN_Hub_Spoke_QinQ_AllVLAN-65410:4 members 
target:65410:4;
}
firewall {
    family vpls {
        filter filter_in_ge-5/0/2_1 {
            interface-specific;
            term 1 {
                then {
                    policer policer_in_ge-5/0/2_1;
                    accept;
                }
            }
        }
    policer policer_in_ge-5/0/2_1 {
        if-exceeding {
            bandwidth-limit 10m;
            burst-size-limit 15220;
        }
        then discard;
    }
}
routing-instances {
    ELAN_Hub_Spoke_QinQ_AllVLAN {
        instance-type vpls;
        interface ge-5/0/2.1;
        route-distinguisher 65410:8;
        vrf-import ELAN_Hub_Spoke_QinQ_AllVLAN-import;
        vrf-export ELAN_Hub_Spoke_QinQ_AllVLAN-export;
        protocols {
            vpls {
                mac-table-size {
                    5120;
                }
                interface-mac-limit {
                    1024;
                }
                no-tunnel-services;
                site Site_1 {
                    site-identifier 1;
                    site-preference primary;
                    interface ge-5/0/2.1;
                }
            }
        }
    }

Related
Documentation

Creating a Point-to-Multipoint VPLS Service Definition on page 138•

• Predefined Multipoint-to-Multipoint Ethernet Service Definitions on page 365

• Predefined Point-to-Point Service Definitions on page 333
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Predefined Full Mesh Layer 3 VPN Service Definitions

The Network Activate software section provides information about predefined service

definitions used for creating Layer 3 VPN full mesh services.

If neither of thepredefinedservicedefinitionsdescribedhere is appropriate for your needs,

you can create a service definition as described in “Creating a Full Mesh Layer 3 VPN

Service Definition” on page 257.

The Network Activate software provides predefined service definitions for Layer 3 VPN

services that use the BGP or OSPF protocols.

Information specific to each service instance, such as the device name, endpoint name,

VLAN ID, Interface IP, PeerAS (BGP), andwhether youwant to allowaserviceprovisioner

to create static routes on the service, is provided in the service order.

Table 10 on page 96 lists each of the standard VPLS service definitions. Each standard

service definition is then described in detail in the sections that follow.

Table 25: Standard Point-to-Multipoint Service Definitions

Predefined Service AttributesStandardServiceDefinitionName

• VLAN ID selection: Auto pick

• Route target: Auto pick

• Route distinguisher: Auto pick

• Allowed Routing Protocols: OSPF/Static Route

L3VPN-OSPF-STATIC L3 VPN (Full
Mesh)

• VLAN ID selection : Auto pick

• Route target: Auto pick

• Route distinguisher: Auto pick

• Allowed Routing Protocols: BGP/Static Route

L3VPN-BGP-STATIC L3 VPN (Full
Mesh)

Related
Documentation

Creating a Full Mesh Layer 3 VPN Service Definition on page 257•

• Predefined Multipoint-to-Multipoint Ethernet Service Definitions on page 365

• Predefined Point-to-Point Service Definitions on page 333

Predefined Hub-and Spoke Layer 3 VPN Service Definitions

The Network Activate software provides predefined service definitions that use BGP or

OSPF routing protocols that you, the service provisioner, can use to create a service order.

Youmust have a Service Designer user role to use Layer 3 VPN hub-and-spoke service

definitions.

Youviewpredefinedandcustomservicedefinitions in theServiceDesign>ManageService

Definitions inventory page. You can view service definition details or attributes in the

Manage Service Definitions inventory page by double-clicking the service definition.
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You can also view service instance details by selecting Service Provisioning >Manage

Service Orders.

Table26onpage404describes thepredefinedorstandardhub-and-spoke(one interface)

service definitions and their preconfigured service attributes. You can not reconfigure

attributes in these predefined services. However, if you need custom attributes, create

a new hub-and-spoke service definition to use, as described in Creating a Layer 3 VPN

Hub-and-Spoke Service Definition.

Table 26: Standard Hub-and-Spoke Service Definitions

Predefined Service AttributesDescription
Standard Service
Definition Name

• VLAN ID selection: Auto pick

This attribute is editable in the service order.

• Route target: Auto pick

• Pick VLANwithin this range: N/A

• Route target: Auto pick

• Route distinguisher: Auto pick

This attribute is editable in the service order.

The VRF table label option is selected.

• Allowed Routing Protocols: OSPF/Static Route

L3VPN Hub and Spoke 1
interface with OSPF/Static as
PE-CE routing protocol

L3VPN-OSPF-Static
(Hub-Spoke-1-Interface)

• VLAN ID selection: Auto pick

This attribute is editable in the service order.

• Route target: Auto pick

• Pick VLANwithin this range: N/A

• Route target: Auto pick

• Route distinguisher: Auto pick

This attribute is editable in the service order.

The VRF table label option is selected.

• Allowed Routing Protocols: BGP/Static Route

L3VPN Hub and Spoke 1
interface with BGP/Static as
PE-CE routing protocol

L3VPN-BGP-Static
(Hub-Spoke-1-Interface)

Related
Documentation

• Viewing Service Definitions on page 701

• CreatingaHub-and-Spoke (One Interface) Layer 3VPNServiceDefinitiononpage264

• Predefined Full Mesh Layer 3 VPN Service Definitions on page 403

• Creating a Full Mesh Layer 3 VPN Ethernet Service Order on page 536

• Predefined Point-to-Point Service Definitions on page 333

• Predefined Multipoint-to-Multipoint Ethernet Service Definitions on page 365

• Predefined Point-to-Multipoint Ethernet Service Definitions on page 390
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CHAPTER 9

Service Design: Working with Service
Templates

• Service Templates Overview on page 406

• Service TemplatesWorkflow on page 407

• Applying a Service Template to a Service Definition on page 408

• Creating a Service Template on page 409

• Deleting a Service Template on page 411

• Exporting a Service Template on page 412

• Finding Configuration Options on page 413

• Importing a Service Template on page 416

• Modifying a Service Template on page 417

• Specifying Service-Specific Values on page 418

• User Privileges in Service Templates on page 427

• Provisioning Dynamic Attributes to Specify the Device XPath on page 429
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Service Templates Overview

ServiceTemplatesprovidesapowerfulmechanismtoconfigureadvancedservice-related

options that are not exposed via the service order creation workflow. Create and attach

one or more service templates to a service definition to define any provisioning-related

configuration option beyond the current coverage of Network Activate. Using a single

template, the sameparameter values canbepushed toall service instances.Usemultiple

templates to pushdifferent sets of parameters to different endpoints in the same service

order.

The service specific values in service templates enable configuration values to be

automatically resolved at the timeof deployment,without the intervention of the service

provisioner. The template designer can also enable the service provisioner to edit

parameters in the template.

NOTE: Service templates usually contain “Service Specific Values.” These
cannot and should not be edited by service provisioners. The service specific
values are resolved by Network Activate and the device.

As an extension to Device Templates, Service Templates is designed exclusively for the

purpose of service configuration. Configuration of all other options is available through

Device Templates. See Device Templates Overview. The Service Templates workspace

is located under Service Design in Network Activate.

Related
Documentation

Service TemplatesWorkflow on page 407•

• Creating a Service Template on page 409

• Specifying Service-Specific Values on page 418

• Modifying a Service Template on page 417

• Deleting a Service Template on page 411

• Importing a Service Template on page 416

• Exporting a Service Template on page 412

• Creating a Service Order Based on a Service Definition with a Template on page 564
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Service TemplatesWorkflow

A designer, who is typically a network engineer or someone with an equivalent level of

knowledge, uses Service Templates to apply service specific values (service variables)

by creating service templates. The designer then attaches one or more templates to a

service definition.

A serviceprovisioner selectsadefinition tocreatea serviceorder. Any templatesattached

to the definition can be applied and, if required, edited by the provisioner during endpoint

configuration.

Deployment automatically resolves service specific values.

The roles of designer and provisioner require the appropriate user privileges (see “User

Privileges in Service Templates” on page 427).

The service designer’s role in the service template workflow covers the following tasks:

1. Creating a Service Template on page 409

2. Finding Configuration Options on page 413

3. Specifying Service-Specific Values on page 418

4. Applying a Service Template to a Service Definition on page 408

5. Modifying a Service Template on page 417

6. Deleting a Service Template on page 411

7. Exporting a Service Template on page 412

8. Importing a Service Template on page 416

9. Viewing Service Template Inventory on page 706

The service provisioner’s tasks in the service template workflow remain creating and

deploying service orders. “Creating a Service Order Based on a Service Definition with a

Template” on page 564 covers service template handling within a service order.

Related
Documentation

Service Templates Overview on page 406•
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Applying a Service Template to a Service Definition

To deploy a service template, youmust apply it to a service definition. Both templates

and definitions are service type specific. If you have a point-to-point service template in

the system, you can apply it to a definition of the corresponding service type:

point-to-point. You cannot attach it to amultipoint-to-multipoint, or layer 3 VPN service

definition. Service variables in a templatemustbecompatiblewith thedefinition towhich

youattach the template. Each service typehas its ownsetof variables, and if the template

you want to attach contains any service variables not compatible with the service and

definition type, the templatewill not appear in the definition’s list of available templates.

You can apply multiple templates to a single definition.

To apply a service template to a service definition:

1. Create or import a service template. See “Creating a Service Template” on page 409

or “Importing a Service Template” on page 416.

2. In the Network Activate task pane, select Service Design >Manage Service Definitions.

3. Click Create P2P Service Def..., or Create VPLS Service Def..., or Create L3 VPN Service

Def....

The Generalwindow appears.

4. Fromthedropdown list forServiceTemplateDefinition, select thedesired template(s).

The list of templates available is filtered according to the type of service definition.

5. For instructions on filling in the rest of the fields on this page and completing the

definition, see “Creating a Point-to-Point Ethernet Service Definition” on page 97,

“Creating a Multipoint-to-Multipoint VPLS Service Definition” on page 117, “Creating
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a Point-to-Multipoint VPLS Service Definition” on page 138, or “Creating a Full Mesh

Layer 3 VPN Service Definition” on page 257.

Related
Documentation

Service Templates Overview on page 406•

• Service TemplatesWorkflow on page 407

• Viewing Service Template Inventory on page 706

• Service Troubleshooting Overview on page 801

Creating a Service Template

There are two stages in creating a template. This topic deals with the first stage, while

the second stage is covered by “Specifying Service-Specific Values” on page 418.

Service templates are specific to service definitions. Both are specific to service types,

so that if you are dealing with an L3VPN service type, for example, both your service

definition and service template must be of that type. A service template’s type is

determinedby theservicevariables (servicespecific values) it uses.Someservicevariables

are specific to one service type only. A table in “Specifying Service-Specific Values” on

page 418 lists the available variables and their types.

1. Naming a Template and Selecting Configuration Options on page 409

2. Configuration Options, Their Data Types and the Tabs Displayed on page 411

Naming a Template and Selecting Configuration Options

You create configuration pages as part of the process of selecting configuration options,

to organize and group those options.

To name the template :

1. In the Network Activate task pane, select Service Design >Manage Service Templates

> Create Service Template.

The Create Service Template page appears, showing the supported device families

above the Available Configuration panel and the Selected Configuration Layout panel.

2. In the Name field, enter a unique name for the template (limit of 63 alphanumeric

characters without spaces).

3. (Optional) Enter a description of the template in the Description field (limit of 255

characters).

The description is displayed when you double-click the template on the Service

Template inventory page.

The list in the Available Configuration panel displays the Junos OS configuration options

available. In the Selected Configuration Layout panel, construct logical groupings by

putting the options you select into pages.

To select configuration options and create a configuration page:
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5. In the Create Service Template page, in the Available Configuration panel, expand the

list of options by opening the list or searching, as described in “Finding Configuration

Options” on page 413.

6. Select an option in the Available Configurations panel andmove it to a page in the

Selected Configuration Layout panel.

The first page, “Config Page 1,” is available by default.

There are two ways to move an option from the Available Configurations panel to a

page in the Selected Configuration Layout panel:

a) Select an option, and drag it and drop it onto the name of the page or any options

already on a page.

b) Select the nameof a page by clicking on it, then click the desired option, and finally

click the arrow between the panels to transfer the option to the page.

Any sequence is permissible, and there is no limit on the number of options a page

can hold.

NOTE: You cannot put children of the same parent into different pages.

NOTE: Options that are either subsidiary or integral to others bring their
respective parents and children with themwhen youmove them onto a
page. If you drill down and select a parameter deep in the hierarchy, such
as L3 interface, dragging that parameter causes all the other parameters

that require configuration to comewith it. In this example, youget not only
L3 interface, but also Name, both of which are under Vlan. This ensures

that all the parameters required for a particular configuration option are
present in your configuration group.

Conversely, you cannot add an option of the ’choice’ data type directly to
a page. Instead, add a child of the choice to add the choice itself.

7. Select your configuration grouping by double-clicking the placeholder name, Config

page x.

On the right, the General tab appears.

8. (Optional) In the Label field on theGeneral tab, replace the placeholder name (Config

Page x) with amore informative name.

9. (Optional) Enter a description of the page in the Description field.

10. Save your selections by electing another tab or another configuration option or

configuration page.

Clicking Next also saves your settings.

To save and finish the template later, click Finish. To restart work on the template,

youmust modify it.
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Add or remove pages as desired.

To add a page:

• Click the plus icon [+] at the top left of the Selected Configuration Layout panel.

A new page appears: “Config Page x.”

To remove a page or a configuration option from a page:

• Select the page or configuration option and click the X at the top left of the Selected

Configuration Layout panel.

The page disappears.

Configuration Options, Their Data Types and the Tabs Displayed

Table 27 on page 411 lists the possible data types of the configuration options, and the

tabs associated with each type.

Table 27: Data Types and Tabs

Tabs

Data Types AdvancedValidationDescriptionGeneral

**Container

****Table

****String - Key column in a table

****String

****Integer [Number]

***Boolean

***Enumeration

***Choice

• All table configuration options have a key column by default.

• You can use any sequence to move options onto your pages.

The subsequent task is “Specifying Service-Specific Values” on page 418.

Deleting a Service Template

If a service definition is using a template, you cannot delete that template.
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To delete a service template:

1. In the Network Activate task pane, select Service Design >Manage Service Templates.

The Service Template inventory page appears.

2. Select the template you want to delete.

3. Either right-click the selected template or open the Actionsmenu and select Delete

Service Template.

The Delete Templatewindow appears, displaying the following information about it:

• The name of the template,

• The username of the person who last modified it,

• The date when it was last updated,

• Its state.

4. To delete the template, click Delete.

TheManage Service Templates page appears, displaying any remaining templates.

5. To abort deletion, click Cancel.

TheManage Service Templates page appears, displaying all the templates.

Related
Documentation

Modifying a Service Template on page 417•

• Importing a Service Template on page 416

• Exporting a Service Template on page 412

Exporting a Service Template

Exporting a template enables you to transfer it to another Junos Space fabric.

Before you begin, youmust have a template already created.

To export a template:

1. In the Network Activate task pane, select Service Design >Manage Service Templates.

Select the definition to export.

2. OpentheActionsmenuandselectExportor right-click the templateandselectExport.

The Export Template dialog appears.

3. Click Download file for selected templates (tgz format).

TheOpening xxx.tgzwindow appears. (XXX is a placeholder for the name of the

template.)

4. Select Save File and clickOK.

Youmay have to toggle between the radio buttons to activate theOK button.

Copyright © 2015, Juniper Networks, Inc.412

Junos Space Cross Provisioning Platform



The Enter name of file to save to ... dialog appears.

5. Rename the file if desired and save it to the appropriate location.

The Export Template dialog reappears.

6. Click Close.

Although the exported template file is an .xml file, it is saved as a .tgz file, which is the

format the system uses to import xml files.

You can now import the template into another Junos Space fabric.

Related
Documentation

Importing a Service Template on page 416•

• Service Templates Overview on page 406

• Service TemplatesWorkflow on page 407

• Creating a Service Template on page 409

• Specifying Service-Specific Values on page 418

• Modifying a Service Template on page 417

• Deleting a Service Template on page 411

• Creating a Service Order Based on a Service Definition with a Template on page 564

Finding Configuration Options

There are three ways to locate particular configuration options: you can use the search

function, or display the whole list, or use the available service perspectives (P2P, VPLS,

L3VPN).

Searching

To search for a specific configuration option:

1. Click the magnifying glass icon.

The search term bar appears.

2. Enter your search term.

As soon as you enter the first two letters, the bar opens downwards, displaying the

search results.

Search displays only the first ten matches for your term .

TIP: Search results appear while you are typing. You can continue typing
or even delete text. Note that the cursormight not be visible in the search
field if the focus is somewhere within the list of search results.

413Copyright © 2015, Juniper Networks, Inc.

Chapter 9: Service Design: Working with Service Templates



The order of the search results is not dependent on the order of those items in the

AvailableConfigurationpanel. It is basedon thesimilarityof your search termto indexed

fields.

3. While the result list is still visible, select a result by:

• Using the mouse to click on it.

• Pressing the Enter key to select the first result in the list.

• Using theupanddownarrowkeyson thekeyboard tomove through the list, pressing

the Enter key to select a result.

The tree in the Available Configuration panel jumps to the location of the match for

the result you selected and highlights the option. The list of results disappears.

4. (Optional) To review the results that you did not select, either:

• Click the white arrows next to the Search field.

Click the arrow to the left tomove to the result listed previous to the selected result.

Click the arrow to the right to move to the resulted after the selected result.

• Use the left and right arrow keys on the keyboard.

Press thearrow to the left tomove to the result listedprevious to the selected result.

Press the arrow to the right to move to the resulted after the selected result.

5. To close the search bar, click the X in the top right corner of the bar.

Displaying all configuration options: To display the top level configuration options, click
the plus sign [+] or expansion icon at the top of the tree in the Available Configuration
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panel. Many of the options contain further parameters. To display these, click on the plus

sign [+] or expansion icon left of the option.

Service Perspective: The configuration parameters are grouped service wise. In the
NetworkActivateapplication youcanchooseeither of the following serviceperspectives:

• P2P

• VPLS

• L3VPN

TheAvailableConfigurationpanel displays the configuration parameters that are specific

to the selected service.

For example, if you select L3VPN in theAvailableConfiguration the followingconfiguration

parameters are displayed:

• Interface

• Policy statement

• Instance
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Related
Documentation

Creating a Service Template on page 409•

Importing a Service Template

Importing a service template enables you to transfer it from another Junos Space fabric.

Before you begin, make sure you have access to a template file. Although it is an xml file,

the system expects to find it packed into a .tgz file, which is the way the system exports

.xml files.

To import a template :

1. In the Network Activate task pane, select Service Design >Manage Service Templates

> Import Service Template.

The Import Service Template dialog appears.

2. Click Browse.

The File Uploadwindow opens.

3. Navigate to the appropriate file, select it, and clickOpen.

The Import Service Template dialog reappears, displaying the name of the selected

file in the Template File field.
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NOTE: Under some circumstances, when the Import Definition dialog

reappears, it displays amessagebeginningConfirmnamemappingof. This

message serves as a warning that the system has changed the name of
the definition itself. This happens when you import a template with the
same name as an existing template.

4. Click Import.

TheManage Template Definitions page reappears, displaying the newly imported

template definition.

Related
Documentation

Service Templates Overview on page 406•

• Service TemplatesWorkflow on page 407

• Creating a Service Template on page 409

• Specifying Service-Specific Values on page 418

• Modifying a Service Template on page 417

• Deleting a Service Template on page 411

• Exporting a Service Template on page 412

• Creating a Service Order Based on a Service Definition with a Template on page 564

Modifying a Service Template

If a service is using a definition, you cannot modify any template associated with that

definition. Tomodify a template attached to a service definition that is not in use:

1. In the Network Activate task pane, select Service Design >Manage Service Templates.

TheManage Service Templates inventory page appears.

2. Select the template you want to modify.

It is not possible to select multiple templates for simultaneous modification.

3. Right-click the selected template or open theActionsmenu and selectModifyService

Template.

TheModify Service Template page appears. The options selected in the template to

bemodified are not visible initially.

4. To see the options currently selected in the template, click the plus [+] icon(s) next

to the configuration pages in the Selected Configuration Layout panel.

Whenall theplus [+] icon(s) are open, all the currently selected configurationoptions

are visible.

5. Add and/or remove configuration pages and options as required. For instructions on

this, see “Creating a Service Template” on page 409.

417Copyright © 2015, Juniper Networks, Inc.

Chapter 9: Service Design: Working with Service Templates



6. Specify service-specific data with service variables as required. For instructions on

this, see “Specifying Service-Specific Values” on page 418.

7. To finish modifying the template, click Finish.

Related
Documentation

Deleting a Service Template on page 411•

• Importing a Service Template on page 416

• Exporting a Service Template on page 412

• Service Templates Overview on page 406

• Service TemplatesWorkflow on page 407

• Creating a Service Template on page 409

• Specifying Service-Specific Values on page 418

• Creating a Service Order Based on a Service Definition with a Template on page 564

Specifying Service-Specific Values

Using service-specific variables, youcanspecify values thatNetworkActivate can resolve

when the service order is deployed. .

Service definitions filter the service templates available for attachment according to the

set of service variablesassociatedwith each servicedefinition type. If a template contains

any variables that are not in the filter set for that service definition type, the template

does not appear in the selection list, so you cannot attach it to the definition.

You can set multiple variables for a single value.

The following table shows the correlation between service definition types and service

variables:

Table 28: Service Definition Types and Associated Service Variables

L3VPNVPLSPoint-to-Point

$CustomerName$CustomerName$CustomerName

$PEIPAddress--

--$PseudowireNeighborAddress

$RoutingInstanceName$RoutingInstanceName-

$ServiceBGPGroupName--

$ServiceBGPNeighbor--

$ServiceDefinition$ServiceDefinition$ServiceDefinition
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Table 28: Service Definition Types and Associated Service Variables (continued)

L3VPNVPLSPoint-to-Point

$ServiceEndPoint$ServiceEndPoint$ServiceEndPoint

$ServiceOSPFArea--

$ServiceOSPFIntfName--

$ServiceSubInterfaceName$ServiceSubInterfaceName$ServiceSubInterfaceName

$ServiceUnitName$ServiceUnitName$ServiceUnitName

$ServiceVlan$ServiceVlan$ServiceVlan

-$ServiceVlanIdRange$ServiceVlanIdRange

-$SiteName-

--$KompellaServiceSubInterfaceName

$MartiniServiceSubInterfaceName

-$VPLSServiceSubInterfaceName-

--$MartiniServiceLocalSwitchInterfaceName

$VRFExportPolicy--

$VRFImportPolicy--

The following examples show how the service variablesmap to the device configuration

attributes:
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Figure 19: Point-to-Point Example: Device Configuration Deployed Through Network Activate
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Figure 20: VPLS Example: Device Configuration Deployed Through Network Activate
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Figure 21: L3VPN Example:When OSPF Is a CE-PE Protocol
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Figure 22: L3VPN Example:When BGP Is a CE-PE Protocol
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The last two service variables, $ServiceDefinition and $CustomerName, appear in the

Service Provisioning workspace, in Service Order details.
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To specify service specific values in a template:

1. In the Network Activate task pane, selectNetwork Activate > Service Design >Manage

Service Templates > Create Service Template.

The Create Service Templatewindow appears.

2. Add the configuration option forwhich youwant to supply a service specific value (for

instructions on adding an option, see “Creating a Service Template” on page 409).

3. Fill in information in the General tab.

a. (Optional) To rename the selected option, in the Label box, type a name for that

configuration option.

When you save bymoving on to the next page, Specifying default values for service

parameters, the new name appears under Config Page 1 in the Selected

Configuration Layout.

TIP: The default labels are ambiguouswithout the context of the tree.
For example, there aremany options called pool.

TheDataTypeboxdisplays the selected component’s data type,whichdetermines

not only which tabs are displayed, but also the method of validation. For tables

showing the various data types and their tabs, see “Creating a Service Template”

on page 409.

b. (Optional) If the data type of the selected option is String, you can change it to

Enumeration by clicking the String option button while the option is selected.

A box to contain the choices appears, and next to it, plus [+] andminus [-] icons.

c. To specify the enumeration choices, for each one, click the plus [+] icon and type

text in the field that appears (limit 255 alphanumeric characters).
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TIP: Keepyour choices short, otherwise theyarehard to readwhenyou
specify the default values. You can create up to 23 choices.

Click OK to save each entry, or to delete it, click Close.

To close the window, click Close or the X.

d. To save your entries on the General tab, select another tab or another option, or

click Next or Finish.

4. Fill in information in the Description tab.

a. In the Description field, type [additional] descriptive text for the selected

configuration option, or leave the default text, if desired.

b. To save your the description, move to another tab or another option, or click Next.

5. Fill in information in the Validation tab.

a. Specify the parameters for the option in the appropriate fields.

If the fields already display default values and you change them, ensure that your

values do not exceed the default values.

b. To save your entries, select another tab or another option, or click Next or Finish.

6. Fill in information in the Advanced tab.

• (Optional) If you intend to use a service variable, select the Service Specific Value

check box.

Operator visibility changes to hidden. The variable is resolved by Network Activate

at the time the service is deployed. If the operator does change this variable,

deployment fails.

• If you are not using a service variable for this option, leave theService Specific Value

check box unchecked, andmake a selection from the Operator Visibility choices.

Select the Editable option button if you want the service provisioner to be able to

change the value.

7. Click Next.

The Specify default values for configuration parameters page appears.

8. Youmust set all the default values on this page; otherwise, service order deployment

fails.

9. Click Click to configure as often as necessary to reach the point where you can select

a service-specific value,whichappearsasadropdown list containing systemvariables.

10. Click the down arrow at the right of the list to display the available variables.

11. Select the appropriate variable.

If necessary, consult the previous examples to determine which variables to use.
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NOTE: If you use thewrong service-specific variable, service deployment
fails. The value is not resolved, and service deployment is blocked.

If you select the wrong variable by mistake, delete it by clicking the X to the right of

the variable.

NOTE: To create customized service-specific variables:

1. Type the customized name followed by an underscore and dollar
symbol.

2. From the list, select the service-specific variable that you want to
associate.

3. To save the customized service-specific variable, click the Save link.

12. If youmove away from the page to set other parameters by clicking the breadcrumbs

above the panel, a message prompts you to save your work.

• To save your selection, click Save.

• To cancel your selection, click Undo.

• To finish the template, click Finish.

• To abandon the template, click Cancel.

The next task is “Applying a Service Template to a Service Definition” on page 408.

Related
Documentation

Service Templates Overview on page 406•

• Service TemplatesWorkflow on page 407

• Creating a Service Template on page 409

• Modifying a Service Template on page 417

• Importing a Service Template on page 416

• Exporting a Service Template on page 412

• Creating a Service Order Based on a Service Definition with a Template on page 564

User Privileges in Service Templates

In Junos Space Users, the two roles for Service Templates users are predefined: Service

Designer for the template designer and Service Manager for the provisioner. For ease of

use, in this documentation we refer to the Service Designer as the designer, and to the

Service Manager as the provisioner.

Youmust have Service Designer privileges to create, delete, modify, andmanage service

templates and service definitions.
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Youmust have Service Manager privileges to create and deploy service orders. However,

if youwish toedit service templatesoraddordelete them, youmusthaveServiceDesigner

privileges.

Related
Documentation

Service TemplatesWorkflow on page 407•

• Role-Based Access Control Overview
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Provisioning Dynamic Attributes to Specify the Device XPath

You have the flexibility to create and provision a dynamic attribute. You canmark an

attribute of a service template as dynamic, and you can obtain the values for these

dynamic attributes from a specific device. To create a dynamic attribute, youmust first

mark an attribute of a service template as dynamic and then specify the device XPath

for the dynamic attribute.

Tomarkanattributeasdynamic in the service template that youarecreatingormodifying,

set the Data Type as Enumeration. If a service template attribute is dynamic while you

create a service order, all possible values from the device configuration are listed in the

Flexible Service Attributes link.

If you set the Data Type as Enumeration, you need to specify a default value. This default

value is listed if the device configuration contain no values.

To specify the device XPath for dynamic attributes:

1. Select Service Design >Manage Service Templates > Create Dynamic Attributes.

The Create Dynamic Attributes window appears.

The Configuration Pages pane lists all the service templates.

NOTE: The service template in the Configuration Pages pane appears
dimmed if a service template is attached to a service and you cannot set
the dynamic attributes.

2. Select a service template.

The right pane lists all the attributes of the selected service template. If youmouse

over an attribute, the XPath of the attribute is displayed.

3. Select the Dynamic check box to enable the XPath field.
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NOTE: You can enable the Dynamic check box only for the attribute with

Data Type as Enumeration.

4. Specify the device XPath in the XPath field.

NOTE: The device XPathmust start with /device.

From the specified device XPath, all the values from the device configuration are

obtained.

5. ClickOk.

While creating a service order, when you click the Flexible Service Attribute link, the

dynamic service attributes lists the values from a specific device.

Related
Documentation

• ConfiguringFlexibleServiceAttributes toModifyServiceTemplateAttributesonpage484

• Creating a Point-to-Point ATM or TDM Pseudowire Service Order on page 432

• Creating a Point-to-Point Service Order on page 438

• Creating a Multipoint-to-Multipoint VPLS Service Order on page 491

• Creating a Point-to-Multipoint VPLS Service Order on page 507

• Creating a Full Mesh Layer 3 VPN Ethernet Service Order on page 536

• Creating a Hub-and-Spoke Layer 3 VPN Service Order on page 549
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CHAPTER 10

Service Provisioning: Managing Service
Orders

• Creating a Service Order on page 431

• Creating a Point-to-Point ATM or TDM Pseudowire Service Order on page 432

• Creating a Point-to-Point Service Order on page 438

• Cloning Deployed Point-to-Point Services on page 452

• Creating a Bulk-Provisioning Service Order for Pseudowire Services on page 455

• Creating an Inverse Multiplexing for ATM Service Order on page 459

• Creating a Cross Provisioning Platform Service Order on page 462

• Deleting a Partial Configuration on page 466

• Deleting a Service Order on page 466

• Deploying a Service on page 467

• Force-Deploying a Service on page 468

• Viewing the Configuration of a Pending Service Order on page 469

• Provisioning a Single-Ended Point-to-Point Service on page 471

• Selecting Specific LSPs for Network Activate Services on page 472

• Validating a Service Order on page 476

• Stitching Two Point-to-Point Pseudowires on page 478

• Creating a Cross Provisioning Platform Layer 3 VPN Service Order on page 480

• ConfiguringFlexibleServiceAttributes toModifyServiceTemplateAttributesonpage484

• Providing Broadband Network Gateway Service Support in Cross Provisioning

Platform on page 486

Creating a Service Order

A service order is an instance of the service definition that completes the definition for a

specific customer’suse.Theserviceorderalwaysspecifies thecustomerandtheendpoints

that link the customer sites through the MPLS network. For each endpoint, the service

provisioner specifies the N-PE device and the UNI on that device that connects the

customer site to the N-PE device. The service order can also specify any additional

attributes that are configured in the service definition as editable in the service order.
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These attributesmight include theVCID,MTU for theUNI,MTU for the connection across

the network, VLAN-ID, rate limiting bandwidth, and so forth.

To create a point-to-point Ethernet service order, see “Creating a Point-to-Point Service

Order” on page 438

To create a VPLS service order, see “Creating a Multipoint-to-Multipoint VPLS Service

Order” on page 491 or “Creating a Point-to-Multipoint VPLS Service Order” on page 507.

Creating a Point-to-Point ATM or TDMPseudowire Service Order

To create a point-to-point Ethernet service order, complete the following tasks in order:

1. Selecting the Service Definition on page 432

2. Entering General/Connectivity Settings Information on page 433

3. Specifying Endpoint Information on page 435

4. Deploying the New Service on page 438

Selecting the Service Definition

To select a service definition on which to base the new service order:

1. In theNetworkActivate taskpane, selectServiceProvisioning>ManageServiceOrders

> Create P2P Service Order.

TheCreateP2PServiceOrderpagedisplays an inventory of all available point-to-point

service definitions.

2. Select the service definition you want to base your service order on, and click Next.

A graphical image of a service order appears.

The image in the left panel of themain display area hasmultiple selectable elements.

The right panel requests information depending on which element is selected.
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If a templatewasattached to theservicedefinitiononwhich theserviceorder isbased,

the link to invoke the template editor also appears in the bottom of the right panel.

The two router images represent the two endpoints of the point-to-point service. Text

above the cloud image provides general information about the service. The cloud

represents the connectivity across the network between the two endpoints.

When you select the cloud or the text, the right panel requests general information

about the service order as well as connectivity information.

The General/Connectivity Settings panel appears initially in the right panel, as shown

in the example.

Entering General/Connectivity Settings Information

The General Settings panel is displayed on the right side of the service order window.

To configure general settings in theGeneral Settings/Connectivity Settings panel, provide

the following information:

1. In the Name box, enter a unique name for the service.

The service order name can consist of only letters, numbers, and underscores.

NOTE: The name you specify for a service order becomes the
routing-instance name in the device configuration when you deploy the
service. Consequently, you cannot use any Juniper Networks keywords,
for example, “bgp” or “vpls”, as the name of a service order.

2. In the Customer box, select the customer requesting the service.

If the customer is not in the list, you must add the customer to the database before

proceeding. See “Adding a New Customer” on page 709.
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3. In the Comments box, enter a description of the service. This description appears in

information windows about the request or service instance created from the request.

4. In theConnectivitySettingsbox, specify theMTUfor theconnectionacross thenetwork.

The service definition can constrain the MTU to a specific value or allow the service

provisioner to override it in the service order. In this example, the service definition

sets the MTU, but allows the service provisioner to change the value.

Whenyouadvance to thenext step in creating your serviceorder, your newconnectivity

settings appear under the Connectivity image in the main graphic and new general

information is added to the text above the cloud. If you have incomplete or invalid

information in the General/Connectivity Settings panel, a warning icon appears next

to the cloud image.

5. Specify the virtual path identifier (VPI). This field is available only if you have selected

an ATM point-to-point service definition.

The combination of theVPI andVCIDdefines the next destination for a cell in theATM

network.

Range: 0 through 255

6. Specify the virtual channel identifier (VCI). This field is available only if you have

selected an ATM point-to-point service definition.

Range: 0 through 65535

7. Enter the virtual circuit identifier (VCID). This integer uniquely identifies the virtual

circuit that the service uses.

The VCID can be set either automatically by the Junos Space software, or the service

provisioner can set it manually in the service order. The service definition can force

the system to pick the VCID, force the service provisioner to pick the VCID, or allow

the service provisioner to override the settings in the service definition.

We recommend allocating the VCID automatically; however, service providers with

their own systems for allocating VCIDs can choose themanual setting.

By default, the systempicks a VCID from its pool automatically, but allows the service

provisioner to override this value in the service order. The form expands to include an

additional field for typing the VCIDmanually.

This field is displayed only if the selected definition’s signaling type is LDP. You cannot

edit this field if you have not selected the Editable in Service Order in the service

definition.

8. Select theMCAPS check box to add the run show aps extensive command.

NOTE: This check box is available only in an LDP-based point-to-point
service order with PWResilency enabled. The Interface typemust be

ATM/TDM.

Formore informationonMC-APS, see “Multi-ChassisAutomaticProtectionSwitching

Overview” on page 44.
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9. Enter the Route Distinguisher value.

Range: 1.1.1.1:1 through 255.255.255.254:65535, or 1:1 through 65535:4294967295

This field is displayed only if the selected definition’s signaling type isBGP. You cannot

edit this field if you have not selected the Editable in Service Order in the service

definition.

10. Specify the Route Target.

1. Clear the Auto pick Route Target check box.

2. Enter the Route Target value.

Range: 1.1.1.1:1 through 255.255.255.254:65535, or 1:1 through 65535:4294967295

This field is displayed only if the selected definition’s signaling type isBGP. You cannot

edit this field if you have not selected the Editable in Service Order in the service

definition.

11. Provideendpoint information for the first endpoint: click theEndpointAgraphicelement

or click Next.

The Endpoint Settings form appears in the right panel.

Specifying Endpoint Information

OnM Series, MX Series, and ACX routers:

• The ATM interfaces always appear as an AT interface.

• The TDM interfaces with SAToP encapsulation always appear as a T1 interface; TDM

interfaces with CESoPSN encapsulation always appear as a DS interfaces.

The service templates settings are the same for both the endpoints.

To configure the endpoint settings:

1. In the PE Device box, select the N-PE device you want to use for the first endpoint.

If you are unsure about which PE device to choose, go to the Prestaging Devices

workspace landingpage,whichshowscapacity informationaboutUNIsonPEdevices.

Youmust pick a device that has available UNIs.

This step is required for all service orders.

2. In theUNI interfacebox, select aUNI. The list includesallUNIs availableon the selected

device.

You can enter the description of the UNI interface in the UNI description field.

If you have selected the Enable Multi Segment Pseudowire check box in the service

definition, theUNI interfaceof thesecondendpoint lists the interworking (iw) interfaces

only.

For more information on point-to-point pseudowire stitching, see “Stitching Two

Point-to-Point Pseudowires” on page 478.

This step is required for all service orders.
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Youcannot change the typeofPhysical IFencapsulation. This value is set in the service

definition.

Based on the type ofPhysical IF encapsulation, the corresponding fields are displayed.

For example, if the Physical IF encapsulation is CESoPSN, the following fields are

displayed:

• Jitter buffer

• Idle pattern

• Excessive packet loss rate

NOTE: These fields are editable if you have selected the Editable in

Service Order check box in the service definition.

3. Specify the stitching unit.

Default: 0

Range: 0 through 255

NOTE: This field is displayed only in the second endpoint. Youmust have
selected the Enable Multi Segment Pseudowire check box in the service

definition.

4. If the Physical IF encapsulation type is CESoPSN, specify the Packetization Latency.

Packetization latency is the time required to create packets.

Range: 1000 through 8000microseconds

NOTE: Based on the number of time slots, the default Packetization
Latency value is as follows:

• If the number of time slots is equal to 1, the default value is either 5000
microseconds or 8000microseconds.

• If the number of time slots is 2, 3, or 4, the default value is 4000
microseconds.

• If the number of time slots is greater than 4, the default value is 1000
microseconds.

5. In the LSP tunnel name box, select the LSP tunnel you want to use for this device.

Youmust supply an LSP tunnel name for the interface on BX devices. If one is not

defined, youmust first use the Transport Activate application to create an LSP on the

BX7000 Gateway.

On the M Series router, the LSP tunnel is chosen automatically.

This field is displayed only if the selected definition’s signaling type is LDP.
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6. Specify the cell bundle size. The value of the cell bundle size can be from 1 through

34.

7. If you have enabled the Enable PWResiliency check box in the selected service

definition, fill in the following fields in the Backup settings and Resiliency settings:

• Enable

• PE device

• UNI interface

• MTU (Bytes)

• LSP tunnel name

• Revert time (sec)

• Switch Over Delay (sec)

For more information of pseudowire redundancy, see “Redundant Pseudowires for

Layer 2 Circuits and VPLS” on page 38.

8. If you selected the Static pseudowire check box in the selected service definition, you

need to specify theOutgoing label for the static pseudowire.

Range: 1000000 through 1048575

In case of multi-segment pseudowire, you have to specify a new outgoing label for

the second segment. The outgoing label for the second segment is not prepopulated

from the first segment.

NOTE: Youmustmanually compare the encapsulation, TDMbit rate, and
control word of the router with the remote peer router and ensure that
theseparametersmatch;otherwise thestaticpseudowiremightnotwork.

9. Select the Enable send-oamconfig check box to enable the send-oam command. You

can select or clear this check box even in the Modify Service page.

10. If you have attached a service template in the service definition, the Flexible Service

Attributes link appears. To enable this link, select a PE Device. Click the link to modify

the service template attributes. For more information about configuring the flexible

service attributes, see “Configuring Flexible Service Attributes to Modify Service

Template Attributes” on page 484

11. Click Create.

The service order that you have created is graphically represented in the topology. To

view the serviceorder that youhavecreated in the topology, selectPlatform>Network

Monitoring > Topology > Services > NA > service order name.

For more information on topology, see “Junos Space Network Topology Overview” on

page 40.
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Deploying the New Service

To deploy the new service:

1. Perform one of the following actions:

• To save the request without deploying the service, select Save only, then clickOK.

See “Deploying aService” on page 467 for information about how to deploy a saved

service at a later time.

• To deploy the service immediately, select Deploy now, then clickOK.

• To deploy the service later, select Schedule deployment, select a date and time,

then clickOK.

The time field specifies the time kept by the server, but in the time zoneof the client.

2. Tomonitor the progress and status of the deployment, use the Jobs workspace. See

Viewing Jobs in the Junos Space Network Application Platform User Guide for details.

Creating a Point-to-Point Service Order

To create a point-to-point service order, complete the following tasks in order:

1. Selecting the Service Definition on page 438

2. Entering General Settings Information on page 439

3. Specifying the Connectivity on page 440

4. Specifying QoS Settings on page 442

5. Specifying OAM Settings on page 443

6. Specifying Endpoint Information on page 443

7. Specifying Connectivity and Endpoint Information for Managing VLANs on page 448

8. Deploying and Monitoring the Progress of the New Service on page 451

Selecting the Service Definition

To select a service definition on which to base the new service order:

1. In theNetworkActivate taskpane, selectServiceProvisioning>ManageServiceOrders

> Create P2P Service Order.

TheCreateP2PServiceOrderpagedisplays an inventory of all available point-to-point

service definitions.

2. Select the service definition you want to base your service order on, and click Next.

A graphical image of a service order appears.
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The image in the left part of the main display area has multiple selectable elements.

The right panel requests information depending on which element is selected.

If a template is attached to the service definition on which the service order is based,

the link to invoke the template editor also appears in the bottom of the right panel.

The two router images represent the two endpoints of the point-to-point service. Text

above the cloud image provides general information about the service. The cloud

represents the connectivity across the network between the two endpoints.

When you select the cloud or the text, the right panel requests general information

about the service order as well as connectivity information.

The General/Connectivity Settings panel appears initially in the right panel, as shown

in the example.

Entering General Settings Information

To enter General Settings in the General Settings box:

1. In the Name field, enter a unique name for the service.

The service order name can consist of only letters, numbers, and underscores.

NOTE: The name you specify for a VPLS service order becomes the
routing-instance name in the device configuration when you deploy the
service. Consequently, you cannot use any Juniper Networks keywords,
for example, “bgp” or “vpls”, as the name of a service order.

2. In the Customer field, select the customer requesting the service.
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If the customer is not in the list, you must add the customer to the database before

proceeding. See “Adding a New Customer” on page 709.

3. In the Comments field, enter a description of the service that you want to appear in

the request or in a service instance created from the request.

This description is displayed in the Manage Service Order page.

4. Configure connectivity settings. See “Specifying the Connectivity” on page 440.

Specifying the Connectivity

In theConnectivity Settings box of theGeneral/Connectivity Settings panel, specify VCID

and MTU information.

1. Specify the VCID. This is an integer that uniquely identifies the virtual circuit that the

service will use.

The VCID can be either set automatically by the Junos Space software, or it can be

set manually by the service provisioner in the service order. The service definition can

force the system to pick the VCID, force the service provisioner to pick the VCID, or

allow the service provisioner to override the settings in the service definition.

This field is displayed only if the selected definition’s signaling type is LDP. You cannot

edit this field if you have not selected Editable inServiceOrder in the service definition.

We recommend allocating the VCID automatically; however, service providers with

their own systems for allocating VCIDs can choose themanual setting.

In the previous example, by default, the system picks a VCID from its pool

automatically, but allows the service provisioner to override this value in the service

order. Clear the check box to override the service definition setting. The form expands

to include an additional field for entering the VCIDmanually.

2. Specify the MTU for the connection across the network.

The service definition can constrain the MTU to a specific value or allow the service

provisioner to override it in the service order. In this example, the service definition

sets the MTU, but allows the service provisioner to change the value.

Whenyouadvance to thenext step in creating your serviceorder, your newconnectivity

settings appear under the Connectivity image in the main graphic and new general

information is added to the text above the cloud. If you have incomplete or invalid

information in the General/Connectivity Settings panel, a warning icon appears next

to the cloud image.
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3. Select theMC LAG check box if you want the following configuration to be pushed to

the selected endpoint.

set protocols l2circuit neighbor x.x.x.x interface interface name
pseudowire-status-tlv

NOTE: This check box is available only for an LDP-based point-to-point
service order with PWResilency enabled. The Interface typemust be

Ethernet.

For more information onmultichassis link aggregation groups (MC-LAGs), see

“Multichassis Link Aggregation Group Overview” on page 43.

4. Specify the Route Distinguisher value.

Range: 1.1.1.1:1 through 255.255.255.254:65535, or 1:1 through 65535:4294967295

This field is displayed only if the selected definition’s signaling type isBGP. You cannot

edit this field if you have not selected the Editable in Service Order check box in the

service definition.

5. To specify the Route Target, clear the Auto pick Route Target check box.

Range: 1.1.1.1:1 through 255.255.255.254:65535, or 1:1 through 65535:4294967295

This field is displayed only if the selected definition’s signaling type isBGP. You cannot

edit this field if you have not selected the Editable in Service Order check box in the

service definition.

6. TheVLANnormalizationdisplays the informationbasedontheoptionyouhaveselected

in the service definition.

7. If VLAN normalization is Normalize to Dot1q tag, specify the VLAN Tag to stack.

Default: 1

Range: 1 through 4094

8. If VLAN normalization is Normalize to QinQ tags, specify theOuter VLAN Tag to stack

and Inner VLAN Tag to stack fields.

Default: 1

Range: 1 through 4094

9. To provide endpoint information for the first endpoint, click the Endpoint A graphic

element or click Next.

The Endpoint Settings form appears in the right panel.

10. If you have enabled QoS, configure QoS settings. See “Specifying QoS Settings” on

page 442.

If QoS is not enabled, configure endpoint settings. See “Specifying Endpoint

Information” on page 443.
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Specifying QoS Settings

If QoS is enabled on the service definition, configure the QoS Settings of the

General/Connectivity Settings panel.

1. In theQoS profile field, select a profile from the list.

TheQoS profile list displays the QoS profiles that are currently configured in the QoS

Design software.

A QoS profile classifies traffic into defined service groups to provide the special

treatment of traffic across the network service.

NOTE: ForOAMSettings, if you specify aCFMprofile (for example, a CFM
action profile with remote MEP), or an SLA-Iterator profile, first youmust
ensure that the profile is attached to the same device upon which you
intend to deploy the P2P service order. If the profile is not previously
attached (using the OAM Insight application), it is not on the device to
support the service order.

2. In the CIR field, select the committed information rate (CIR) from the list.

The CIR is the guaranteed rate and specifies the minimum bandwidth available if all

sources are active at the same time. Make sure that the CIR value is less than the PIR

value.

NOTE: For bursty traffic, the CIR represents the average rate of traffic per
unit time and the PIR represents themaximumamount of traffic that can
be transmitted in a given interval.

3. In the PIR field, select the peak information rate (PIR) from the list. The PIR is the

shaping rate.

NOTE: If the QoS profile that you selected in Step 1 is configured with a
level-three scheduler and interface oversubscription is enabled, then PIR
is not used.

4. Configure endpoint information. See “Specifying Endpoint Information” on page 443.
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Specifying OAMSettings

If OAM is enabled on the service definition, enter information in the OAM Settings of the

General/Connectivity Settings panel.

1. In the CFMDefinition field, select a profile from the list.

NOTE: ForOAMSettings, if you specify aCFMprofile (for example, a CFM
action profile with remote MEP), or an SLA-Iterator profile, first youmust
ensure that the profile is attached to the same device upon which you
intend to deploy the P2P service order. If the profile is not previously
attached (using the OAM Insight application), it is not on the device to
support the service order.

NOTE: For Juniper Networks PTX3000 Packet Transport Routers, if you
attach a CFMDefinition to the service order, the CFM session operates for
MEPs in either the Up or Down direction when the service is deployed.

2. Configure endpoint information. See “Specifying Endpoint Information” on page 443.

Specifying Endpoint Information

An example Endpoint Settingswindow follows.
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If a service template is attached to the service definition, a link to that template is listed

at the bottom of the Endpoint Settings section of the window. The service templates

settings are same for both the endpoints. For instructions on working with service

templates in service orders, see “Creating a Service Order Based on a Service Definition

with a Template” on page 564.

Some of the fields differ from one interface type to another and also differ depending

on permissions assigned in the service definition.

To specify endpoint information:
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1. In the PE device field, select the N-PE device you want to use for the first endpoint.

If you are unsure about which PE device to choose, go to the Prestaging Devices

workspace landingpage,whichshowscapacity informationaboutUNIsonPEdevices.

Youmust pick a device that has available UNIs.

This step is required for all service orders.

NOTE: If this endpoint is a third-party device, select Unmanaged device

from the PE Device field list. You need to specify only the IP Address and

Unmanaged Interface. For more information, see “Provisioning a

Single-Ended Point-to-Point Service” on page 471.

2. In the UNI interface field, select a UNI.

The list includes all UNIs available on the selected device.

This step is mandatory for all service orders.

If you have selected the Enable Multi Segment Pseudowire check box in the service

definition, theUNI interfaceof thesecondendpoint lists the interworking (iw) interfaces

only.

For more information on point-to-point pseudowire stitching, see “Stitching Two

Point-to-Point Pseudowires” on page 478.

You can enter the description of the UNI interface in the UNI description field.

3. Specify the stitching unit.

Default: 0

Range: 0 through 255

NOTE: This field is displayed only in the second endpoint. Youmust have
selected the Enable Multi Segment Pseudowire check box in the service

definition.

4. In the Traffic type field, designatewhether youwant the service to transport all traffic,

a single VLAN, or multiple VLANs.

Although this field is present for all service orders, the value is predetermined for some

types of interfaces. For example, a port-to-port interface always transports all traffic.

Moreover, for interface types that do support multiple traffic types, you can select

this value only if the service definition allows you to do so.

If you are allowed to select this field, depending on the interface type, you can choose

from the following values:

• Transport single VLAN

• Transport VLAN range

• Transport all traffic

445Copyright © 2015, Juniper Networks, Inc.

Chapter 10: Service Provisioning: Managing Service Orders



NOTE: The Physical IF encapsulation and Logical IF encapsulation fields

are not selectable. These values are set in the service definition.

The Vlan Range formanual input field displays the VLAN range that is specified in the

service definition.

If the Ethernet option is do1q or qinq, and the VLAN selection is Transport single vlan

type, theVlanRange formanual input range is used for validation ofmanually entered

VLAN.

If the Ethernet option is qinq, and the VLAN selection is Transport vlan range type, the

Vlan Range for manual input range is used for validation of manually entered outer

VLAN.

If the Ethernet option is do1q, and the VLAN selection is Transport vlan range type, the

VlanRangeformanual input range isused for validationofmanually enteredcustomer's

VLAN start and VLAN end.

5. In the C-VLAN ID field (or VLAN ID field), enter the customer’s VLAN ID.

This field is mandatory for service orders that transport a single customer VLAN. The

ID is provided by the customer.

6. In the C-Vlan Start and C-Vlan End fields, specify the beginning and end of the range

of customer VLANs that you want the service to transport.

This field is mandatory for all services that transport a specific range of customer

VLANs. These VLAN IDs are provided by the customer.

7. Select the Auto pick VLAN ID check box to have the system choose a service VLAN ID

automatically.

This field is present only for interface types that provide double tagging; that is, only

forQ-in-Qendpoint interface types. If this field is not set, thenyoumust enter a service

VLAN IDmanually.

8. In the VLAN ID field, specify the service VLAN ID that you want be used to provide the

outer tag for the service.

This field is present only for interface types that provide double tagging, and only if

the Auto pick VLAN ID check box is not selected.

9. Specify whether the Autopick UNIT ID can be selected automatically or manually.

• To assign the UNIT ID automatically, select the Autopick UNIT ID check box.

• To assign the UNIT IDmanually, clear the Autopick UNIT ID check box.

The window expands to include the UNIT ID field. In the UNIT ID field, type a value.

Range: 1 through 1073741823

NOTE: You can edit this field only if you have selected the Editable in

Service Order check box for the VLAN ID selection in the service definition.
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10. In theMTU (Bytes) field, specify the maximum transmission unit size for the UNI.

This field is present in all service orders. However, you can set this field only if the

service definition allows you to do so.

11. If you selected the Static pseudowire check box in the selected service definition, you

need to specify theOutgoing label for the static pseudowire.

Range: 1000000 through 1048575

In case of multi-segment pseudowire, you have to specify a new outgoing label for

the second segment. The outgoing label for the second segment is not prepopulated

from the first segment.

NOTE: Youmustmanually compare the encapsulation, TDMbit rate, and
control word of the router with the remote peer router and ensure that
theseparametersmatch;otherwise thestaticpseudowiremightnotwork.

12. In the Bandwidth (Mbps) field, select a value from the list to limit the bandwidth of

the service you are creating.

This field is present only if bandwidth limiting is allowed by the service definition, and

is configurable in the service order only if the service definition allows you to do so.

When you click another graphic element in themain graphic area, the selected device

name and interface name appear beneath the endpoint image in the main graphic.

13. To change the committed information rate (CIR) on an endpoint, click the CIR value

for the endpoint and select another value from the list. Make sure the CIR value is less

than the PIR value.

Only QoS-enabled services specify CIR and PIR values.

14. To change the peak information rate (PIR) on an endpoint, click the PIR value for the

endpoint and select another value from the list. Make sure the CIR value is less than

the PIR value.

Only QoS-enabled services specify CIR and PIR values.

15. If you have enabled theEnablePWaccess toL3VPNnetwork check box in the selected

service definition, fill in the following fields in PW Stitching:

• L3 routing instance name—Specify the name of the Layer 3 routing instance.

• Autopick interface IP—If this field is enabled, specify IP block size and IP address

pool; otherwise specify the Interface IP address.

• Autopick peer unit—To select the logical system unit number automatically, select

the check box; otherwise specify the Peer unit name.

NOTE: These fields are available only if you have selected an LT interface
in the UNI interface.
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16. If you have enabled the Enable PWResiliency check box in the selected service

definition, fill in the following fields in the Backup settings and Resiliency settings:

• Enable

• PE device

• UNI interface

• MTU (Bytes)

• LSP tunnel name

• Revert time (sec)

• Switch Over Delay (sec)

For more information of pseudowire redundancy, see “Redundant Pseudowires for

Layer 2 Circuits and VPLS” on page 38.

17. Select the Enable send-oamconfig check box to enable the send-oam command. You

can enable or disable this check box even in the Modify Service page.

18. If you have attached a service template in the service definition, the Flexible Service

Attributes link appears. To enable this link, select a PE Device. Click the link to modify

the service template attributes. For more information about configuring the flexible

service attributes, see “Configuring Flexible Service Attributes to Modify Service

Template Attributes” on page 484.

19. To provide endpoint information for the second endpoint, click the Endpoint Z graphic

element (or click Next).

The Endpoint Settings form appears in the right panel for the second endpoint.

Complete this form as for the first endpoint (repeat Step 1 through Step 18).

20.Click Create.

The deployment options window appears.

The service order that you have created is graphically represented in the topology. To

view the serviceorder that youhavecreated in the topology, selectPlatform>Network

Monitoring > Topology > Service > NA service order name.

For more information on topology, see “Junos Space Network Topology Overview” on

page 40.

Specifying Connectivity and Endpoint Information for Managing VLANs

The Network Activate application in Junos Space release 14.1 provides greater flexibility

for provisioning VLANs for Point-to-Point service orders.

Network Activate release 14.1 extends the VLAN normalization options.

NOTE: Prior to release 14.1, Network Activate enabled specification of the
VLAN normalization types Swap and Normalize to None only.
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You can create logical interfaces that define both theOuter-VLAN-tag-to-stack protocol

ID and Inner-VLAN-tag-to-stack protocol ID. The following illustration shows the

General/Connectivitywindow. The Connectivity Settings panel displays the

Outer-VLAN-tag-to-stack and Inner-VLAN-tag-to-stack parameters.

Network Activate now enables you to manually select a value for theOuter VLAN tag to

stackand InnerVLANtagtostackparameters for a service that specifies theqinqEthernet

option.
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The following illustration displays the service order Connectivity Settings based upon a

service definition that set the VLAN normalization parameter to Normalize to Dot1q tag.

For service orders that are based on service definitions that set the Ethernet option to

dot1q or qinq, theUnit ID parameter appears in the Logical IF Settings panel in the service

order Endpoint Settingswindow.
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Deploying andMonitoring the Progress of the New Service

To deploy the new service:

1. Perform one of the following actions:

• To save the request without deploying the service, select Save only, then clickOK.

See “Deploying aService” on page 467 for information about how to deploy a saved

service at a later time.
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• To deploy the service immediately, select Deploy now, then clickOK.

• To deploy the service later, select Schedule deployment, select a date and time,

then clickOK.

The time field specifies the time kept by the server, but in the time zoneof the client.

2. Tomonitor the progress and status of the deployment, use the Jobs workspace.

See Viewing Jobs in the Junos Space Network Application Platform User Guide for

details.

Related
Documentation

Viewing Service Orders on page 765•

• Viewing Jobs in the Junos Space Network Application Platform User Guide

• Service Attributes Overview on page 20

• Adding a New Customer on page 709

• Deploying a Service on page 467

• Creating a Point-to-Multipoint VPLS Service Order on page 507

• Creating a Service Order Based on a Service Definition with a Template on page 564

Cloning Deployed Point-to-Point Services

YoucanuseadeployedEline-LDPservice as a template to createmultiple point-to-point

services. Cloning canbeused to create amaximumof fifteen copies of an existing service

Prerequisites for Cloning a Deployed Service

Copyright © 2015, Juniper Networks, Inc.452

Junos Space Cross Provisioning Platform



• At least one deployed point-to-point service with two endpoints defined.

To begin the cloning service order, in the Network Activate task pane, select Service

Provisioning >Manage Services. The service inventory page appears.

1. Locate the entry for a service that has two endpoints defined.

2. Right-click on the service to see the list of available actions, and select Clone Service.

The Clone Servicewindow appears in which youmanage the copied instances of the

service.
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TheCloneServicewindowenables you to specify the number of copies to create from

thesourcedeployedservice. In this case,weare creating3copiesof the source service.

a.

Each row in the clone table represents one point-to-point servicewith two endpoints.

The top row is the deployed service you used to create the copies. The parameters

displayed in the attributes table differ based on the definition of the source deployed

service. For example, if the original service was an ATM interface definition, the

parameters will include VCI and VPI as column headers.

You can edit many of the attribute values of the cloned services as necessary by

clicking on the cells in the table. Oneof the attributes youmust change is the Interface

for each new service. Youmay edit the other fields as necessary. For example, the

Order name is auto-generated from the original service name. If you want to change

it, just click on the cell and enter a new name. The editable attributes are

• Name

• VCID

• Device

• Interface

• Bandwidth

• VLAN ID

All other attributes, such as MTU, are copied from the original service and will not

appear in the attributes table.

Youmay also select one of the copies and create clones from that so that the copies

have the same attributes as the clone that you selected.
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Once you have finished editing the service values, click Create to deploy the cloned

services. You will be given the standard deployment options.

Related
Documentation

Creating a Point-to-Point Service Order on page 438•

• Example: Configuring and Deploying a Point-to-Point Ethernet Service on page 623

Creating a Bulk-Provisioning Service Order for Pseudowire Services

Bulk provisioningallows for deviceswith similar configurations tobedeployedasagroup.

The groups can be defined based on some characteristic common to all of the devices

in a group, such as their functional role. Mobile backhaul deployments, for example, can

run into hundreds of thousands of devices. These devices are commonly grouped

according to their functional rules such as Cell Site Devices, Pre-aggregation or Hub-site

devices, Aggregation Devices, Edge Routers and so on. To use this feature, tags must be

defined and created so that groups can be selected. This feature is intended to simplify

deployments of large groups of devices.

Prerequisites

• Existing point-to-point pseudowire service definitions that will be used for the

bulk-provisioning service order.

• Tags - Youmust have defined tags in the Prestaging workspace that you intend to use

for groups of devices for which you will be creating the bulk service order. If you do not

have tags already created, you can select Prestage Devices >ManageDevice Roles and

either select existing tags to apply to devices or create new tags.
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Tobegin the bulk provisioning process, in theNetworkActivate task pane, selectPrestage

Devices >Manage Device Roles and choose a service definition from the list. Click on the

tag view of the inventory list.

1. Select the tag you want to use from the left Tag panel.

2. Select the devices you want to include in the tagged group.

3. Click, Apply Tag.

4. In the Network Activate task pane, select ServiceDesign>ManageServiceDefinitions.

The Manage Services Definitions page displays a list of service definitions.

5. Right-click on the point-to-point service definition, and selectCreateBulkP2PService

Order.

The Create Bulk P2P Service Order window appears.

6. In the Bulk point-to-point provisioning window, define the settings for the service

order.
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ActionField

Provide a name for the bulk service orderName

Select the customer name from the list of defined customers.Customer

The options available in the VLAN normalization are based on the value set for the
Ethernet interface.

For informationonVLANnormalization, see “CreatingaPoint-to-PointEthernetService
Definition” on page 97.

VLAN normalization

Specify the bandwidth for the endpointsBandwidth

Specify the MTU size in bytes.MTU (Bytes)

Select the service tag from the defined list. This tag will be applied to the services you
create.

Service tag

Provide a description for the service tag.Description
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ActionField

Defining the Endpoint Settings

To define the endpoint settings, you will define both the A endpoint and the Z endpoint.

As an example of how you can use the bulk provisioning and how the endpoints work, if you want to establish a hub-spoke
pseudowire between an Aggregation PE and a set of CSR devices, you can tag all the CSRs with a certain tag in theManage
Device Roles page. You can then select the PE device on the A end and the tag that you have already created for all the CSR
devices on the Z end. If the endpoint is a tag then you can provide a wild-card interface (for example, ge-0/*/*) that matches
all the devices under that tag.

Define the A End Settings

Select the device or tag from the defined list.PE Device/Tag

Select the UNI interface from the listUNI interface

VLANs are created as part of this process. Enter the beginning VLAN ID that you want
to use for creating the new service orders.

VLAN ID

Indicate how the VLAN IDs will be assigned for each of the new services. The number
ofVLANscreateddependson thenumberof newservices youare creating.Oneservice
order will be created for each device in the tag group.

VLAN ID increment

Specify the unit ID.

Range: 1 through 1073741823

UNIT ID

Indicate how the unit IDs are assigned for each of the new services. The number of
units created depends on the number of new services you are creating. One service
order will be created for each device in the tag group.

UNIT ID increment

Define the Z End Settings

Select the device or tag from the defined list.PE Device/Tag

Select the UNI interface from the listUNI interface

Enter the VLAN ID from the list of existing VLANs. VLAN range cannot be used for this
feature.

VLAN ID

Indicate how the VLAN IDVLAN ID increment

Specify the unit ID.

Range: 1 through 1073741823

UNIT ID

Indicate how the unit IDs are assigned for each of the new services. The number of
units created depends on the number of new services you are creating. One service
order will be created for each device in the tag group.

UNIT ID increment

7. When required information has been entered, click Create.
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The service order that you have created is graphically represented in the topology. To

view the serviceorder that youhavecreated in the topology, selectPlatform>Network

Monitoring > Topology > Service > NA service order name. Select the service order to

view its parameters.

For more information on topology, see “Junos Space Network Topology Overview” on

page 40.

8. From the Deploy Servicewindow, select the deployment method you wish to use.

Related
Documentation

Creating a Point-to-Point ATM or TDM Pseudowire Service Definition on page 164•

Creating an InverseMultiplexing for ATMService Order

Beforeyoucancreateaserviceorder that implements InverseMultiplexing forATM(IMA),

youmust preconfigure a T1 or E1 IMA Group interface (at-fpc/pic/g) on the devices upon

which youwant to deploy the service, before you prestage the devices in the JunosSpace

Network Activate application.

To create an Inverse Multiplexing for ATM service order:

1. In theNetworkActivate task pane, selectServiceProvisioning>ManageServiceOrders

> Create P2P Service Orders. The Create P2P Service Orderwindow appears.

2. Select the service definition upon which you want to create the service order. The

Create P2P Service Orderwindow appears. The left panel displays a representation

of theconnectionyouareconfiguring.The rightpaneldisplays theGeneral/Connectivity

Settings.

3. Fill in the fields in the General/Connectivity panel.

4. Click Next. The Endpoint Settings panel for Endpoint A appears.
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5. Fill in the Endpoint A settings. Ensure that you select a device on which a T1 or E1 IMA

Group interface was preconfigured.

6. Click Next. The Endpoint Settings panel for Endpoint Z appears.

7. Fill in the Endpoint Z settings. Ensure that you select a device on which a T1 or E1 IMA

Group interface was preconfigured.

8. Click Create. The Deployment Optionswindow appears.
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9. Select the deployment option you want and clickOK:

• Save only

• Deploy now

• Schedule deployment (Specify the date and time.)

The Network Activate application displays the Job Detailswindow, which includes

a Job Details ID number.

10. In the Network Activate task pane, select Jobs > JobManagement.

11. In the JobManagementwindow, youcanviewthestatusof theservice that corresponds

to the Job Details ID number.

Related
Documentation

Inverse Multiplexing for ATMOverview on page 44•

• ViewingFunctionalAuditResults foran InverseMultiplexing forATMServiceonpage764
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Creating a Cross Provisioning Platform Service Order

Before you create a cross-platform service order, youmust complete the following tasks:

• Import into the system the scripts that define the Juniper Networks devices.

• Import into the system the scripts that define the third-party devices.

• Create the service definition upon which to base the service order.

To create a cross-platform service order:

1. in the Cross Provisioning Platform task pane, select CPP > Service Orders.

2. In theServiceOrderswindow, click the+button. TheCreateCPPServiceOrderwindow

appears.

3. In theGeneralSettings section, select a servicedefinitionbasedon theunique ID, name

or type.
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NOTE: The value in the ID field is associatedwith a service definition. This

identifier can be used when you are searching for a particular service
definitionwhilecreatingadeviceconfigletorder.Youcansearch theservice
definition by its name, type or unique ID. You canmodify the ID only during
themigration of old service definition IDs.

4. In theOrder description field, enter a description of the service that distinguishes its

operation from others.

5. Click Next.

The selected service definition GUI script appears.

NOTE: The following representationofaPoint-to-PointGUI scriptwindow
is a sample only. The appearance of this window is based on the scripts
that are associated with the service definition upon which the service is
based.

6. Enter information for the parameters of the GUI script window according to the

descriptions in the following table:

DescriptionParameter

General

Enter a unique name for the service order to distinguish it from others that operate
differently.

Name

Jumbo
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DescriptionParameter

Sets the MTU frame size to 3900

Sets the MTU frame size to 9000

Default: 1596

Jumbo frame 3900

Jumbo frame 9000

Site B Selector

Customer Facing Port

Network Facing Port

Site B port type

Site A – Customer Facing Port

Select the device from the list of devices displayed.Site name

Resyncs the interface on the selected device.

NOTE: This parameter pertains to third-party devices only.

Resync now

Select a port from the list of ports displayed.Port

Select the appropriate bandwidth for the selected site.Service speed

If you select this check box, the software checks to determine whether the device is a
Canoga device.

Canoga device?

If you select this check box, the software checks to determine whether the device is an
untagged Anda device.

Anda untagged?

Enter an integer, or select the up or down arrow to select a value for the Outer
encapsulation.

Outer encapsulation

If this check box is selected, the system validates the encapsulation value with the
specified site and port.

Validate

If this check box is selected, the software checks to determine whether 802.1q was
specified as the Ethernet option in UNI Settings.

Untagged/802.1q?

Enter an integer, or select the up or down arrow to select a value for the Inner
encapsulation.

Inner encapsulation

L2 Extension

Select the device from the list of devices displayed.Site name

Select a UNI port from the list of ports displayed.UNI port

Select a NNI port form the list of ports displayed.Uplink port
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DescriptionParameter

Enter an integer, or select the up or down arrow to select a value for the UNI
encapsulation.

UNI encapsulation

If this check box is selected, the system validates the encapsulation value with the
specified site and port.

Validate

Site B – Customer Facing Port

Select the device from the list of devices displayed.Site name

Resyncs the interface on the selected device.

NOTE: This parameter pertains to third-party devices only.

Resync now

Select a port from the list of ports displayed.Port

Select the appropriate bandwidth for the selected site.Service speed

If you select this check box, the software checks to determine whether the device is a
Canoga device.

Canoga device?

If you select this check box, the software checks to determine whether the device is an
untagged Anda device.

Anda untagged?

Enter an integer, or select the up or down arrow to select a value for the Outer
encapsulation.

Outer encapsulation

If this check box is selected, the system validates the encapsulation value with the
specified site and port.

Validate

If this check box is selected, the software checks to determine whether 802.1q was
specified as the Ethernet option in UNI Settings.

Untagged/802.1q?

Enter an integer, or select the up or down arrow to select a value for the Inner
encapsulation.

Inner encapsulation

L2 Extension

Select the device from the list of devices displayed.Site name

Select a UNI port from the list of ports displayed.UNI port

Select a NNI port from the list of ports displayed.Uplink port

Enter an integer, or select the up or down arrow to select a value for the UNI
encapsulation.

UNI encapsulation
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DescriptionParameter

If this check box is selected, the system validates the encapsulation value with the
specified site and port.

Validate

7. Click Create or click CreateMore to provision additional endpoints.

Related
Documentation

Creating a Cross Provisioning Platform Service Definition on page 192•

• Viewing Cross Provisioning Platform Service Order Details on page 767

Deleting a Partial Configuration

A failed service order of type Provisioning can leave parts of the service configuration on

the devices. To remove this partial configuration:

1. In theNetworkActivate taskpane, selectServiceProvisioning>ManageServiceOrders.

2. In theManage Service Orders page, select the failed service order for which you want

to delete the partial configuration.

3. Open the Actionsmenu and select Delete Partial Configuration.

4. In the confirmation screen, select Delete.

Related
Documentation

Viewing Service Orders on page 765•

Deleting a Service Order

You can delete a service order that is in the requested state, the scheduled state, the

invalid state, or the failed deployment state. To correct a service order in the invalid state,

youmust delete it and then recreate it; the Network Activate software does not support

modifying the service order directly.

To delete a service order from the database:

1. In the Network Activate task pane, select Service Provisioning >Manage Service

Requests.

2. In theManage Service Orders page, select the service order you want to delete.

3. Open the Actionsmenu and select Delete Service Order.

A pop-up window appears requesting confirmation.

4. Click Delete.

TheManage Service Orders page reappears with the deleted service orders removed.

Related
Documentation

Creating a Point-to-Point Service Order on page 438•

• Creating a Multipoint-to-Multipoint VPLS Service Order on page 491
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• Creating a Point-to-Multipoint VPLS Service Order on page 507

• Viewing Service Orders on page 765

Deploying a Service

This procedure schedules a service for deployment on the network. Use this procedure

to perform the following tasks:

• Deploy a new service.

• Deploy amodified service.

• Redeploy a service order that failed deployment.

You cannot deploy an invalid service order.

To schedule a service for deployment:

1. In the Network Activate task pane, select Service Provisioning.

2. In the Service Order States pie chart, click the Requested segment.

TheManage Service Orders page shows only those service orders in the Requested

state.

3. Select the service order you want to deploy.

4. Open the Actionsmenu and click Deploy Service Order.

The Deploy Servicewindow appears.

5. To deploy the service immediately, select Deploy now, and clickOK.

To deploy the service at a later time, select Deploy later, and select a date and time

for deployment, then clickOK.

The time field specifies the time kept by the server, but in the time zone of the client.

After scheduling the service order for deployment, the provisioning software begins

validating the service order.

6. Use the Jobsworkspace tomonitor the outcomeof the deployment. SeeViewing Jobs

in the Junos Space Network Application PlatformUser Guide for details about the Jobs

workspace.

Related
Documentation

Viewing Jobs in the Junos Space Network Application Platform User Guide•

• Viewing Services on page 776

• Creating a Service Order Based on a Service Definition with a Template on page 564.
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Force-Deploying a Service

When a service fails a configuration audit because configuration changes on a PE device

do notmatch the configuration required for the service, you can force-deploy the service

to push the configuration to the device.

Force deployment pushes the same configuration to the device that was pushed during

thedeployment of the service, thus allowing theoperator to recover fromastate inwhich

the configuration on the device was lost or changed out-of-band.

The validation before generating the configuration for a force-deployed service orderwill

be performed against the current configuration on the device and the configuration is

not pushed if the validation fails. If the forced deployment is unable to push the

configuration again, then youmight need to manually configure the device.

This procedure forces deployment of a service on the network.

You cannot force-deploy an invalid service order.

To schedule a service for forced deployment:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In theManage Services page, select the service you want to force deploy.

3. Open the Actionsmenu and click Force Deploy Service.

The Schedule Force Deploymentwindow appears.

4. To deploy the service immediately, select Force deploy now, and clickOK .

To deploy the service at a later time, select Force deploy later, select a date and time

for deployment, then clickOK.

The time field specifies the time kept by the server, but in the time zone of the client.

Copyright © 2015, Juniper Networks, Inc.468

Junos Space Cross Provisioning Platform



After scheduling the service order for deployment, the provisioning software begins

validating the service order.

5. Use the Jobs workspace to monitor the outcome of the forced deployment. See

Viewing Jobs in the Junos Space Network Application Platform User Guide for details

about the Jobs workspace.

Related
Documentation

Viewing Services on page 776•

• Deploying a Service on page 467

• Creating a Service Order Based on a Service Definition with a Template on page 564.

Viewing the Configuration of a Pending Service Order

You can view the configuration of a service order that is in the requested state, the

scheduled state, the invalid state, or the failed deployment state.

To view the configuration of such service orders:

1. In theNetworkActivate taskpane, selectServiceProvisioning>ManageServiceOrders.

A list of service orders is displayed.

2. Select a service order that is in either of the following states:

• Requested

• Invalid

• Scheduled

• Failed deployment

NOTE: TheOrder State column displays the state of the service order.

3. Right-click the service order and select the View Pending Order Configuration. The

Pending Order Configurationwindow is displayed. The configuration is displayed in

xml format.

469Copyright © 2015, Juniper Networks, Inc.

Chapter 10: Service Provisioning: Managing Service Orders



NOTE: TheViewPendingOrder Configuration appears to be dimmed if the

service order state is Completed.

4. Select a device to view the configuration details. You can also view the template

configuration if a template is attached to the service order.

Based on the application’s settings, the configuration is displayed in xml format or in set

format. To view the configuration in set format:

1. Select Platform > Administration > Applications > Network Activate.

2. Right-click the Network Activate application and selectModify Application Settings.

The Modify Network Activate Settings window is displayed.

3. Select the show configuration in set format check box.

Related
Documentation

Service Order States and Service States Overview on page 31•

• Creating a Service Order on page 431
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Provisioning a Single-Ended Point-to-Point Service

You can create a point-to-point link between the end points of a managed device and

an unmanaged device. An unmanaged device is a third-party device. In cases where

interoperability with a third-party device is necessary, Junos Space allows you to define

the link between a Juniper Networks managed device and the third-party device. You

need to specify the IP address and the end point interface name of the unmanaged

device. The Junos Space does not validates the information of an unmanaged device.

You cannot configure an unmanaged device. The Junos Space pushes the configuration

only to managed device.

To create a point-to-point link to an end point that is not managed by Junos Space, in

the Network Activate task pane, select Service Provisioning>Manage Service Orders>

Create P2P Service Orders. The Create P2P Service Orders page displays an inventory of

all available point-to-point service definitions.

1. Select the service definition uponwhich youwant to base your service order, and click

Next.

2. Specify the general/connectivity settings. For details on creating a point-to-point

service order, see “Creating a Point-to-Point Service Order” on page 438

3. Click Next to specify the endpoint settings.

• If this end point is N-PE device, select a device from the PE Device. Configure the

endpoint settings as mentioned in “Creating a Point-to-Point Service Order” on

page 438

• If this endpoint is a third-party device, selectUnmanageddevice from thePEDevice.
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Fill in the fields as indicated in the table:

ActionsField

Since the endpoint is a third-party device, select Unmanaged device from the list.PE Device

Specify the loopback IP address of the third-party device.

Range: 1.0.0.1 through 223.255.255.254, excluding 127.x.x.x

Loopback IP Address

Specify the end point interface nameof the unmanaged device, which is the third-party
device.

Unmanaged Interface

4. Click Next to specify another endpoint settings.

NOTE: Both the endpoints cannot be a third-party device.

5. To finish creating the service order, click Create.

NOTE: Thefunctionalaudit isperformedonlyontheJuniperNetworksdevices
(managed devices). To perform a successful functional audit of an
unmanaged device, configure the following attributes of an unmanaged
device:

• Neighbor IP

• Virtual circuit ID

• Unit ID

• Encapsulation

• Filter

• Policer

Related
Documentation

Creating a Point-to-Point Service Order on page 438•

Selecting Specific LSPs for Network Activate Services

This feature allows you to associate a policy with a point-to-point service. This in turn

attaches the pseudowire to an LSP, which satisfies the conditions of the policy. The

configuration for the service order includes the LSP name as the Next hop name. The

following topics provide information on attaching an LSP and viewing its details:

• Associating an LSP with a Point-to-Point Service on page 473

• Viewing LSP Details in a Service Order on page 474
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• Viewing LSP Details in a Service on page 475

• Viewing LSP Configuration Details on page 475

Associating an LSPwith a Point-to-Point Service

To associate an LSP with a point-to-point service:

1. Create a point-to-point service order.

a. In the Network Activate task pane, select Service Provisioning >Manage Service

Orders > Create P2P Service Order.

The Create P2P Service Order page displays an inventory of all available

point-to-point service definitions.

b. Select the service definition youwant to base your service order on, and clickNext.

The General/Connectivity Settingswindow is displayed.

c. Specify the general/connectivity settings.

d. ClickNext. The Endpoint Settingswindow is displayed. You can now attach an LSP

tunnel to a service order. To provision the specific LSP, select an LSP tunnel from

the LSP tunnel.

NOTE: The LSP tunnel is not amandatory field. The service order is

created even if you do not specify the LSP tunnel name.

e. Click Next to configure another endpoint. To provision the specific LSP, select an

LSP tunnel from the LSP tunnel

f. To create a point-to-point service order, Click Create.
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For more information on creating a point-to-point service order, see “Creating a

Point-to-Point Service Order” on page 438

2. Deploy the point-to-point service order.

The LSP is now associated with the point-to-point service order.

Viewing LSP Details in a Service Order

In the Network Activate task pane, select Service Provisioning >Manage Service Orders.

To view thedetails of a point-to-point service order, double-click a point-to-point service

order in theManage Service Orders inventory page. If an LSP is associated with a

point-to-point service order, the Endpoint Detailswindow includes the following

information:

• LSP tunnel name—Name of the LSP tunnel attached to the point-to-point service

order.

• Community name—Name of the community. A community is a group of destinations

that share a common property.

• Community member—One or more community members.
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Viewing LSP Details in a Service

In theNetwork Activate task pane, select Service Provisioning >Manage Services. To view

thedetails of apoint-to-point service, double-click apoint-to-point service in theManage

Services inventory page.

If an LSP is associated with a point-to-point service order, the Endpoint Details of a

point-to-point service includes the information on the LSP.

NOTE: You cannot modify the LSP tunnel in a service.

Viewing LSP Configuration Details

In the Network Activate task pane, select Service Provisioning >Manage Services.

Right-click a service and select View Service Configuration Change.

If an LSP selection is provisioned, you can view the LSP selection configuration in the

Service Configurationwindow.
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Related
Documentation

Creating a Point-to-Point Service Order on page 438•

• Viewing Service Orders on page 765

Validating a Service Order

This procedure validatesa serviceorder butdoesnotpush theconfiguration to thedevice.

Use this procedure to perform the following tasks:

• Validate a service request in the REQUESTED state.

• Validate a service request in the INVALID state after making necessary configuration

changes on one or more PE devices associated with the service order.

To schedule a service order for validation, follow these steps:

1. In the Network Activate task pane, select Service Provisioning.

2. In theServiceOrderStatespie chart, click theRequestedorFailedDeployment segment.

TheManage Service Orders page shows only those service orders in the Requested

state.

3. Select the service order you want to validate and save.

4. Open the Actionsmenu and click Validate Service Order.
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The Schedule Service Request Validationwindow appears.

5. You can validate a service now or at some future time:

• To validate the service immediately, select Validate now, and clickOK.

• To validate the service at a later time, select Validate later, select a date and time

for deployment, and then clickOK.

NOTE: When specifying a time to validate the service, the time field
specifies the time kept by the server, but in the time zone of the client.

After scheduling the service order for validation, the provisioning software begins

validating the service order.

6. Click on the Job ID in the JobManagementwindow to view details about the service

validation.

7. Use the Jobs workspace to monitor the outcome of the validation. See Viewing

Scheduled Jobs in the Junos SpaceNetwork Application PlatformUser Guide for details

about the Jobs workspace.

Related
Documentation

Deploying a Service on page 467•

• Viewing Services on page 776

• Service Order States and Service States Overview on page 31

• Modifying a Point-to-Point Ethernet Service on page 750

• Modifying a Point-to-Multipoint Ethernet Service on page 738

• Modifying a Multipoint-to-Multipoint Ethernet Service on page 729

• Creating a Service Order Based on a Service Definition with a Template on page 564.
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Stitching Two Point-to-Point Pseudowires

Amulti-segment pseudowire (MS-PW) is a static or dynamically configured set of two

or more contiguous pseudowire segments that behave and function as a single

point-to-point pseudowire. Each end of an MS-PW, by definition, terminates on a T-PE.

Pseudowiresaredeployed in largenetworks.Suchnetworks typicallyencompasshundreds

or thousands of aggregation devices at the edge, each ofwhichwould be a provider edge

(PE). These networks can be partitioned into separate metro and core pseudowire

domains, with multi-segment pseudowires connecting endpoints across the various

domains. You can stitch two point-to-point pseudowires.

To stitch two point-to-point pseudowires:

1. Create a point-to-point service definition.

In the General tab, youmust select the Enable Multi Segment Pseudowire check box

to enable multi-segment pseudowire.

For more information on creating a point-to-point service definition, see “Creating a

Point-to-Point Ethernet Service Definition” on page 97.

2. Create a point-to-point service order.

The fieldsdisplayed in thepoint-to-point serviceorder arebasedon thepoint-to-point

service definition that you created in Step 1. In the second endpoint settings page,

select an interworking (iw) interface and specify the stitching unit.

For more information on creating a point-to-point service order, see “Creating a

Point-to-Point Service Order” on page 438.

3. Deploy the point-to-point service order.

a. In the Manage Service Orders inventory page, select the point-to-point service

order you created in Step 2.

b. Right-click the point-to-point service order and select Deploy Service Order. The

Schedule Service Order Deployment window appears.

c. Select the Deploy now option button and clickOk.

The service order is deployed.

4. In the Manage Services inventory page, right-click the point-to-point service that you

created and select Service > Stitch PWSegment. The Stitch PW Segment inventory

page is displayed.

TheStitchPWSegment inventorypage listsonly thepoint-to-point servicedefinitions

with the Enable Multi Segment Pseudowire check box enabled. This inventory page

must also list the point-to-point service definition you created in Step 1.

5. Select a point-to-point service definition and click Next.

6. Specify the General Setting, Connectivity Settings, and Endpoints details. For more

informationon these fields, see “CreatingaPoint-to-PointServiceOrder” onpage438.
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NOTE: The fields of the first endpoint are auto-filled. Notice that the
second endpoint fields of the service order you created in Step 2 and the
first endpoint fields of this service order are same.

7. Deploy the stitched service order.

a. In the Manage Service Orders inventory page, select the point-to-point service

order you created in Step 6.

b. Right-click the point-to-point service order and select Deploy Service Order. The

Schedule Service Order Deployment window appears.

c. Select the Deploy now option button and clickOk.

The service order is deployed.

The two point-to-point pseudowires are stitched.

The Manage Services lists both services. The point-to-point Service Details window

displays the Stitch PWSegment details.

NOTE: The number of pseudowire segments that you can stitch is limited to
two.

You can perform a functional audit to the first service only. You can view the details of

the stitched pseudowire in the Functional Audit Results window.
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Related
Documentation

Creating a Point-to-Point ATM or TDM Pseudowire Service Order on page 432•

• Creating a Point-to-Point Service Order on page 438

Creating a Cross Provisioning Platform Layer 3 VPN Service Order

The Cross Provisioning Platform(CPP) feature enables you to create an L3VPN service

to operate across the platforms of different vendors.

Beforecreating theservice, a servicedesigner createsbothaGUI script andaconfiguration

script for the JuniperNetworksdeviceand for thedeviceof theother vendor. Thedesigner

creates the GUI script using JavaScript and the Sencha Architecture tool to build the

sequence of GUI windows to support the service creation procedure. The designer must

also create a configuration script to define the configuration procedure.

To upload the GUI and configuration scripts, in the Network Activate task pane, select

Service Design >Manage Scripts.

1. In theManage Scriptswindow, click the Add Script icon (+) in the command bar.

2. In the Add Scriptwindow, type a name for the L3VPN script, select the Vendor type,

and browse your local system for the Configuration script you want to add.

3. Click Create.
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To create a CPP L3VPN service definition, in the Cross Provisioning Platform pane, select

CPP > Service Definitions.

1. In the CPP > Service Definitionswindow, click the Create CPP Service Definition icon

(+) in the command bar.

2. In the Create Service Definitionwindow, type a name for the service definition in the

Name field.

3. In the ID field, type 1 through 2147483647 integers to identify the service definition by

a unique value.

NOTE: The service definition ID is optional. If youdonot provide any value
in this field, the default value is -1. In the service definition selection grid,
no value is displayed in the ID column. Each service definition is assigned

a unique ID. If you give an existing ID value while creating a new service
definition, exception occurs.

4. In the Description field, enter a description of the service definition to distinguish it

from other service definitions.

5. In the Type field, select L3VPN.

6. Perform the following steps:
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• In the JUNOS Space Service Scripts section:

a. From theSelect JunosCreationScript column, select a JunosSpace service script

that was written for the creation of the service definition. The script that you

selected is automatically populated in the corresponding Creation text field.

b. From the Select JunosModification Script column, select a Junos Space service

script that was written for the modification of the service definition. The script

that you selected is automatically populated in the correspondingModification

text field.

NOTE: The JunosSpace service scripts aremandatory to create a Layer
3 VPN service definition, whereas the SAM service scripts are optional.

• In the SAMService Scripts section:

a. From the Select SAMCreation Script column, select a SAM service script that

waswritten for the creation of the service definition. The script that you selected

is automatically populated in the corresponding Creation text field.

b. From theSelectSAMModificationScript column, select aSAMservice script that

was written for the modification of the service definition. The script that you

selected is automatically populated in the correspondingModification text field.

7. Click Create.

After the service definition is published, you can create the CPP L3VPN service order.

1. In the Cross Provisioning Platform task pane, select CPP > Service Orders.

2. In the CPP Service Orderswindow, click the Create Service Order icon (+) in the

command bar.

3. In the General Settings section ofCreate CPP Service Order, select a service definition

based on the unique ID, name or type.

NOTE: The value in the ID field is associatedwith a service definition. This

identifier can be used when you are searching for a particular service
definitionwhilecreatingadeviceconfigletorder.Youcansearch theservice
definition by its name, type or unique ID. You canmodify the ID only during
themigration of old service definition IDs.

4. In the Description field, enter a description of the service order to distinguish it from

other service orders.

5. Click Next.

The Create L3VPN Servicewindow appears, which the designer created specifically

to support the configuration of the CPP L3VPN service order.

Copyright © 2015, Juniper Networks, Inc.482

Junos Space Cross Provisioning Platform



6. Enter the endpoint information required to complete the service order.

NOTE: The CPP system automatically inserts a value in the Name field

when you click Next in the preceding window.

In the External ID field, enter a unique text value to distinguish this service

from all other services.

7. Click Create.

After you create a CPP L3VPN service order, you can view its details.

1. In the Network Activate task pane, select CPP > Service Orders.

2. In the CPP Service Orderswindow, double-click the listed service order for which you

want to view the details.

3. When you are finished viewing the service details, clickOK.
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Related
Documentation

Adding Scripts Created for Cross Provisioning Platform on page 667•

• Creating a Cross Provisioning Platform Service Definition on page 192

• Creating a Cross Provisioning Platform Service Order on page 462

Configuring Flexible Service Attributes toModify Service Template Attributes

In addition to modifying a default service template attribute, you have the flexibility to:

• Add one or more optional service templates along with the existing default service

template.

• Select a value for the attributes that are marked as dynamic. These values are listed

from the devices.

If you have attached a service template to the service definition, you canmodify the

service template attributes by accessing the Flexible Service Attributes link. This link

appears only in the Create Service Order and Modify Service windows.

NOTE: The Flexible Service Attributes link appears in the Modify Service

window if you have attached a service template to the service definition, and
enabled Allow templatemodification for service in the Junos Space Network

Application Platform.

To enable Allow templatemodification for service:

1. Select NetworkManagement Platform > Administration >Manage

Applications > Network Activate.

2. Right-click theNetworkActivateapplicationandselectModifyApplication

Settings.

The Modify Network Activate Settings window is displayed.

3. Select UI in the left pane.

4. Select the Allow templatemodification for service check box.

Tomodify the service template attributes in the Create Service Order or Modify Service

window:

1. To access the Flexible Service Attributes link in the Create Service Order window,

select Service Provisioning >Manage Service Orders > Create Service Order.

To access the Flexible Service Attributes link in the Modify Service window, select and

right-click a service in Service Provisioning >Manage Service .

2. Click the Flexible Service Attributes link.

The Flexible Services Attributes window appears.
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The Flexible Configuration pane lists all the service templates. The right pane lists the

attributes of the selected template.

To add an optional template, click the plus symbol and select the templates.

3. (Optional) Modify the attributes, if necessary.

NOTE: Only for dynamic attributes, you can select a value from the list.
These values are listed from the devices.

WARNING:

If an attribute is dynamic and the specified XPath contains no values, the
following error message is displayed if you click the warning symbol:

No configuration present on device DeviceName for xpath. Default values
from templates are shown. Please confirm that default configuration is
present on device before deploying.

4. ClickOK.

The service template attributes are modified.

Related
Documentation

Provisioning Dynamic Attributes to Specify the Device XPath on page 429•

• Creating a Point-to-Point ATM or TDM Pseudowire Service Order on page 432

• Creating a Point-to-Point Service Order on page 438

• Creating a Multipoint-to-Multipoint VPLS Service Order on page 491

• Creating a Point-to-Multipoint VPLS Service Order on page 507

• Creating a Full Mesh Layer 3 VPN Ethernet Service Order on page 536
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• Creating a Hub-and-Spoke Layer 3 VPN Service Order on page 549

ProvidingBroadbandNetworkGatewayServiceSupport inCrossProvisioningPlatform

The following are the three kinds of broadband network gateway services(BNG) offered

to the residential subscribers:

• IPTV

• Broadband Remote Access Server (B-RAS)

• Wholesale

The Cross Provisioning Platform(CPP) product provides the capability to provision,

maintain and troubleshoot these services. For example, BNG devices can be added to or

removed from the existing Layer 3 VPN services. You can add or remove underlying

interfaces for anygivenBNGdevice. Also, youcan troubleshoot subscriber issuesbyusing

theReportManagement functionality through JuniperNetworksdevices. TheBNGservice

support is provided only for Juniper Networks devices. CPPmultistaged service support

is provided to all MX Series products of Juniper Networks and to third-party devices. A

test service can be implemented only by using device configlets. The device configlets

of third-party devices are not supported. Hence, you cannot create a test service for

third-party devices through CPP.

Provisioning a BNG service involves multiple steps. For example, the following steps are

involved in provisioning a B-RAS service in third-party devices:

• Create a prefix-list

• Create a community

• Create an export policy

• Create an import policy

• Create a virtual private routed network (VPRN) B-RAS service site

Sending validation or pretesting commandsmay also be included In these steps to

provision the service. If any one of the steps fails, you maymanually intervene to correct

the issueand resumefromthe failedstep.Thiseliminates theneed to repeat thepreviously

completed successful steps. The GUI script controls the provisioning flow internally and

shows the status of each step.

Youcan troubleshoot connectivity andnetworking issues for subscribers availingdifferent

BNG services. To troubleshoot, you can perform any one of the following tasks:

• You can issue RPC commands against the broadband network gateway devices to

query active subscribers and to obtain a history of service utilization for a given BNG

device that includes the number of current, active subscribers and the peak subscriber

amount.

• You can execute operational scripts for all MX Series devices on a daily basis and

generate graphs.
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• Subscribers can launch test commands from their devices at home to determine

whether a physical connection exists from their homes to a BNG device. To enable the

subscribers to launch test commands, you need to create a test virtual routing and

forwarding(VRF) on the MX Series devices.

According to the CPP framework, information about the device and interface is required

at every step to create a service order. The CPPmultistage framework supports only one

device at a time.

TheBNG service type supports all three kinds of BNGservices. In amultistagedworkflow,

all steps involved should include the creation of a new service order and the service

endpoint common attribute.

You need to create a service definition with the BNG type and a service order based on

this BNG service definition. The number of service orders you need to create is equal to

the number of tasks you need to perform to troubleshoot the services.

The procedure to create a service order is the same for Juniper Networks devices and

third-party devices. The initial service order type is ADD and the type of the remaining

service orders isMODIFY. The initial step is defined as INIT and the final step as LAST by

the CPP product.

The following is the workflow for CPP services in a multistaged environment:

1. At the INIT step, theGUI creates and sendsanewServiceRequestwith theMultistaged

tag.

The CPP returns the job information and polls the status of the job.

2. A new ServiceObject is created in the database with the Deploying service state.

3. TheGUI sendsanewModifyServiceRequestalongwith theexistingServiceId to ensure

that the workflow is completed.

TheModify service order is created with the Completed status. The service order type

isModify.

NOTE: If any step fails, the service remains in the Deploying state and the

serviceorder is in theFailed_Deployed state. Youcan fix the issuemanually

andmodify or re-create the service order from the previous successful
service order.

4. The service order state is changed to Completed and the service state is changed to

Deployed.
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NOTE: If you close any page bymistake while performing a step, you can
always go to the Service Orders landing page and perform the remaining

steps by using the Recreate Service Order option. The Recreate Service

Order link is available only in the previous successful service order. If the

service is in theDeploying state, you cannot perform the followingactions:

• Modify

• Configuration Audit

• View Service Configuration

To poll a job, go to the following URL:

’/serviceui/resteasy/cpp-service-order/order-job-status/’+jobId

To delete a service order, go to the following URL:

'/serviceui/resteasy/cpp-service-order/’+serviceRequestId

After you complete all the steps, the servicemodification options are
enabled. The procedure tomodify a BNG service is similar to the one to
modify a CPP service. The troubleshooting procedure, which involves the
execution of operational scripts and CLI configlets, is applicable only to
JuniperNetworksdevices.Theconfigurationaudit function isenabledonly
when the BNG service state is Deployed. The option to decommission is

enabled only when the service state is Deploying or Deployed.

A BNG service is created only with the Common Artifacts and no VPRN
service is associated with it. Hence, the service details are not shown in
CPP. In this case, instead of showing the details of a service, the following
tabs are shown, if available:

• General–Displays theservicename,devicename,artifactandthevendor

type

• Configuration–Not available

• Artifact–Displays the common artifact information from the Simple

Object Access Protocol(SOAP) response.

The Juniper Subscriber Service Details tab shows details of dynamic host

configuration protocols servers, pool, and RADIUS. In the case of IP-TV,
pool informationandRADIUSarenotshown. In thecaseofB-RAS,dynamic
host configuration protocols server details are not shown. All tabs of the
Layer 3 VPN service are displayed in the case of the BNG service too. The
ALU Subcriber Service Details tab shows details of Dynamic Host

Configuration Protocol(DHCP), Internet GroupManagement
Protocol(IGMP), Physical Interface Module(PIM) andmulticast virtual
private network(MVPN).
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Related
Documentation

• Managing Reports for Broadband Network Gateway Services in Cross Provisioning

Platform on page 707
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CHAPTER 11

Service Provisioning: Managing VPLS
Service Orders

• Creating a Multipoint-to-Multipoint VPLS Service Order on page 491

• Creating a Point-to-Multipoint VPLS Service Order on page 507

• Creating a Service Order for VPLS Access into Layer 3 Networks on page 525

• Creating a VPLS Service Order in Cross Provisioning Platform on page 530

Creating aMultipoint-to-Multipoint VPLS Service Order

The Network Activate software implements multipoint-to-multipoint Ethernet services

as virtual private LAN (VPLS) services.

To create amultipoint-to-multipoint Ethernet service order, complete these tasks in

order:

1. Selecting the Service Definition on page 491

2. Entering General Settings Information on page 492

3. Specifying QoS Settings on page 493

4. Specifying OAM Settings on page 493

5. Configuring Connectivity Settings on page 494

6. Setting Attributes for All Endpoints on page 496

7. Selecting N-PE Devices and Multihomed Groups on page 501

8. Modifying Endpoint Settings on page 502

9. Deploying the New Service on page 506

Selecting the Service Definition

To select a service definition on which to base the new service order:

1. In theNetworkActivate taskpane, selectServiceProvisioning>ManageServiceOrders

> Create VPLS Service Order.

The Create VPLS Service Orderwindow appears and shows a filtered inventory view

of only those published service definitions designed to work withmultipoint Ethernet

services. You can select the service definition based on the signaling type.
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2. Select the service definition you want to base your service order on, then click Next.

The Enter Order Informationwindow appears.

Entering General Settings Information

This part of the create multipoint Ethernet service order procedure sets general

information about the service order in the General Settings box of the Enter Order

Information window:

To enter general settings information:

1. In the Name field, type a unique name for the multipoint service.

The service order name can consist of only letters, numbers, and underscores.

NOTE: The name you specify for a VPLS service order becomes the
routing-instance name in the device configuration when you deploy the
service. Consequently, you cannot use any Juniper Networks keywords,
for example, “bgp” or “vpls”, as the name of a service order.

2. In theCustomer field, select the customer requesting the service. To speedyour search,

type the first few letters of the customer name and then select from the list.

If the customer is not in the list, you must add the customer to the database before

proceeding. See “Adding a New Customer” on page 709.

3. In the Comments field, provide a description of the service. This description appears

in informationwindowsabout the requestor service instancecreated fromthe request.

The Customer traffic type is not selectable. Its value is set in the service definition.

The Signaling cannot be changed in the service order.

4. If QoS is enabled, continue with "Specifying QoS Settings" next. Otherwise, skip to

"Setting Attributes for all Endpoints."
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Specifying QoS Settings

If QoS is enabled on the service definition, type information in the QoS Settings box of

the Enter Order Informationwindow.

NOTE: QoS features appear in the Junos Space user interface only if you
deploy the QoS Design application in Junos Space.

To specify QoS settings:

1. In theQoS profile field, select a profile from the list.

The QoS profile list displays the QoS profiles that are currently configured in the QoS

Design software.

A QoS profile classifies traffic into defined service groups to provide the special

treatment of traffic across the network service.

2. In the CIR field, select the committed information rate (CIR) from the list.

The CIR is the guaranteed rate and specifies the minimum bandwidth available if all

sources are active at the same time. The value for CIR should be less than the value

for PIR.

NOTE: For bursty traffic, the CIR represents the average rate of traffic per
unit time, and thePIR represents themaximumamount of traffic that can
be transmitted in a given interval.

3. In the PIR field, select the peak information rate (PIR) from the list. The PIR is the

shaping rate.

NOTE: If the QoS profile that you selected in Step 1 is configured with a
level-three scheduler and interface oversubscription is enabled, then PIR
is not used.

4. Continue with "Setting Attributes for All Endpoints," next.

Specifying OAMSettings

To enable OAM on the service definition, type information in the OAM Settings of the

General/Connectivity Settings panel.

1. In the CFMDefinition field, select a profile from the list.
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NOTE: ForOAMSettings, if you specify aCFMprofile (for example, a CFM
action profile with remote MEP), or an SLA-Iterator profile, first youmust
ensure that the profile is attached to the same device upon which you
intend to deploy the P2P service order. If the profile is not previously
attached (using theOAM Insight application), itwill not be present on the
device to support the service order.

NOTE: For Juniper Networks PTX3000 Packet Transport Routers and
Junos Space Release 13.1P1, if you attach a CFMDefinition to the service
order, the CFM session will operate for MEPs in either the Up or Down
direction when the service is deployed.

2. Continue with configuring the connectivity settings.

Configuring Connectivity Settings

In this procedure, you specify the attributes that define the connectivity among remote

sitesacross the serviceprovider networkand the service security. The following illustration

is a sample Connectivitywindow.
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To configure connectivity settings for connectivity between sites across the network:

1. Specify whether the route distinguisher can be selected automatically or manually.

NOTE: You cannot edit the route distinguisher if you have not selected
the Editable in Service Order check box in the service definition.

• To assign the route distinguisher automatically, select the Autopick Route

Distinguisher check box.

• To assign the route distinguisher manually, clear the Autopick Route Distinguisher

check box.

If you choose to assign the route distinguisher manually, the window expands to

include the Route distinguisher field. In the Route distinguisher field, type a value.

Junos Space accepts either of the following two formats:

• prefix-number: assigned-number

Where prefix-number can be any numeric value from 1 through 65,535, and

assigned-number can be any numeric value from 0 through 2,147,483,647

• IPV4-address: assigned-number

Where IPV4-address can be any valid IPv4 address, and assigned-number can be

any numeric value from 0 through 65,535

NOTE: The Route distinguisher field is available in either of the following

cases:

• The Signaling type is BGP.

• The Signaling type is LDP and Auto Discovery is enabled.

2. Specify whether the route target can be selected automatically or manually.

NOTE: You cannot edit the route target if you have not selected the
Editable in Service Order check box in the service definition.

• To assign the route target automatically, select the Autopick Route target check

box.

• To assign the route target manually, clear the Autopick Route target check box.

If you choose to assign the route target manually, the window expands to include

the Route Target field. In the Route Target field, type a value. Junos Space accepts

either of the following two formats:

• prefix-number:assigned-number
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Where prefix-number can be any numeric value from 1 through 65,535, and

assigned-number can be any numeric value from 0 through 2,147,483,647

• IPV4-address:assigned-number

Where IPV4-address can be any valid IPv4 address, and assigned-number can be

any numeric value from 0 through 65,535

NOTE: The Route Target field is available in either of the following cases:

• The Signaling type is BGP.

• The Signaling type is LDP and Auto Discovery is enabled.

3. In theRevert time (sec) field, specify the revert time for redundant Layer 2 circuits and

VPLS pseudowires.

Default: 5 seconds

Range: 0 through 65,535 seconds

This field is available only if you have enabled the Enable PWResiliency check box in

the selected service definition.

4. In the Switch Over Delay (sec) field, specify the time to wait before the backup

pseudowire takes over.

Default: 0 seconds

Range: 0 through 180 seconds

This field is available only if you have enabled the Enable PWResiliency check box in

the selected service definition.

5. Click Next.

You can edit the VPLS ID field, if you have selected the Selectmanually option for the

VPLS ID field in the service definition.

The Auto Discovery and Autopick VPLS ID fields appears dimmed in the Connectivity

Settings dialog box. These fields are not editable in the service order.

Setting Attributes for All Endpoints

This part of the create multipoint Ethernet service order procedure sets the attributes

that are usually common for all endpoints in the service.

NOTE: If you are using a definition withmultiple templates, you can set
different attributes for the endpoints.

In any case, the values that you typedependon the servicedefinitiononwhich the service

order is based. Follow the steps in one of the following tasks, depending on whether or

not the service provides flexible VLAN tagging. To create a service with flexible VLAN
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tagging, the service definition that you selected for the service order must include the

Ethernet option asymmetric tag depth in the UNI settings step.

• Setting Attributes for Endpoints on a Service on page 497

• Setting Attributes for Endpoints on aServicewith Flexible VLANTagging on page 499

Setting Attributes for Endpoints on a Service

If these attributes are not the same on all endpoints, you can set them to be the same

for now and thenmake changes later, or you can choose to skip this step and apply the

attribute values one at a time later, or use a definition with multiple templates.

This procedure sets the attributes listed in the End Point Settings box of the Enter Order

Informationwindow.Theattributesshowndependon the interface typeand thesignaling

type.

NOTE: When the Allowmultihoming check box is selected for the service

definitiononwhich theserviceorderbased, theEndPointSettingsboxdisplays

theAllowmultihomingonendpoints checkbox to indicate that the service can

includemultihomed groups.

To set attributes common tomost endpoints:

1. In the Bandwidth field, select a value from the drop-down list to limit the bandwidth

of the service you are creating.

This field is present only if bandwidth limiting is allowed by the service definition, and

is configurable in the service order only if the service definition allows it.

2. In theMTU field, type the maximum transmission unit size for the UNI.
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This field is present in all service orders. However, you can set this field only if the

service definition allows it.

3. If the signaling type is LDP and the if the auto discovery is enabled, the Autopick VPN

ID appears dimmed. This field is not editable in the service order.

4. Specify the VPLS ID if the Autopick VPLS ID is disabled.

Range: 1 through 2147483647

5. Specify the VPN ID if the Autopick VPN ID is disabled.

Range: 1 through 65535

The Auto-pick VLAN range constraint field is displayed and validates the VLAN range

specified in the service definition.

6. Specify the Logical If Settings.

NOTE: The Logical If Settings box is not available if you have selected the
Ethernet option as port.

• Specify whether the Autopick UNIT ID can be selected automatically or manually.

• To assign the UNIT ID automatically, select the Autopick UNIT ID check box.

• To assign the UNIT IDmanually, clear the Autopick UNIT ID check box.

Thewindowexpands to include theUNIT ID field. In theUNIT ID field, type a value.

Range: 1 through 1073741823

NOTE: You can edit this field only if you have selected the Editable in

ServiceOrdercheckbox for theVLANIDselection in theservicedefinition.

• Specify whether the Autopick VLAN ID can be selected automatically or manually.

• To assign the VLAN ID automatically, select the Autopick VLAN ID check box.

• To assign the VLAN IDmanually, clear the Autopick VLAN ID check box.

The window expands to include the VLAN ID field. In the VLAN ID field, type a

value.

7. In theCustomer VLANRangeStart andCustomer VLANRange End fields, type the first

and last VLAN ID of the range of customer VLANs to be transported over the network.

These fields are present only for services with UNIs that have Q-in-Q interface types

and allow a range of VLANs to be transported.

8. The Physical IF encapsulation and Logical IF encapsulation fields are not selectable.

These values are set in the service definition.

In the VLAN Tag to stack field, type a value for the customer VLAN.

This field is present only for services that specify Normalize to Dot1q tags.
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9. In the Inner VLAN Tag (for QinQ) field, type a value to provide a default inner VLAN

tag for the UNI endpoints.

This field is present only for services that specify Normalize to QinQ tags.

10. In theOuter VLAN Tag to Stack field, type a value to provide an outer VLAN tag that

matches the Outer VLAN tag of at least one of the UNI endpoints.

11. In the Inner VLAN Tag to Stack field, type a value to provide a default inner VLAN tag

for the UNI endpoints to provide a common inner VLAN tag for the routing instance.

This field is present only for services that specify Normalize to QinQ tags.

12. Click Next.

The Select Endpoint PE Deviceswindow appears.

13. Continue with "Selecting N-PE Devices and Multihomed Groups."

Setting Attributes for Endpoints on a Service with Flexible VLAN Tagging

Aservicewith flexibleVLANtaggingcan includeport-based,802.1Q,andQ-in-Q interfaces.

If these attributes are not the same on all endpoints, you can set them to be the same

for now and thenmake changes later, or you can choose to skip this step and apply the

attribute values one at a time later, or you can use a definition with multiple templates.

If there is a service template attached to the service definition, there is a link to that

template at the bottom of the Endpoint Settings section of the window. For instructions

on working with service templates in service orders, see “Creating a Service Order Based

on a Service Definition with a Template” on page 564.

This procedure sets the attributes listed in the End Point Settings box of the Enter Order

Information window. The attributes shown depend on the signaling type and interface

type. The following example shows the endpoints settings box for a

multipoint-to-multipoint servicewith flexibleVLANtagging that transports a singleVLAN

and specifies Normalize to Dot1Q tag.

NOTE: When the Allowmultihoming check box is selected for the service

definitiononwhich theserviceorderbased, theEndPointSettingsboxdisplays

theAllowmultihomingonendpoints checkbox to indicate that the service can

includemultihomed groups.

To set attributes common tomost endpoints:

1. In theBandwidth field, select a value from the list to limit the bandwidth of the service

you are creating.

This field is present only if bandwidth limiting is allowed by the service definition, and

is configurable in the service order only if the service definition allows it.

2. In theMTU field, type the maximum transmission unit size for the UNI.
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This field is present in all service orders. However, you can set this field only if the

service definition allows it.

3. If the signaling type is LDP and the if the auto discovery is enabled, the Autopick VPN

ID appears dimmed. This field is not editable in the service order.

4. Specify the VPLS ID if the Autopick VPLS ID is disabled.

Range: 1 through 2147483647

5. Specify the VPN ID if the Autopick VPN ID is disabled.

Range: 1 through 65535

6. To configure VLANs, choose from the following options depending on the VLAN

transport type and Normalization that the service specifies:

• If the service transports single VLANs and specifies Normalize to Dot1Q tags:

a. In the Inner VLAN (for Q-in-Q) field, type a VLAN ID to swap.

b. In the VLAN Tag to stack field, type a VLAN ID to push or swap at the relevant

UNI endpoints.

• If the service transports single VLANs and specifies Normalize to QinQ tags:

a. Tomanually assign an VLAN ID:

i. Clear the Autopick VLAN ID check box. The window expands to include the

VLAN ID field.

This field is present in the service order only if the service definition allows it.

ii. In the VLAN ID field, type a value.

This field is configurable in the serviceorder only if the servicedefinitionallows

it.

b. In the Inner VLAN (for Q-in-Q) field, type a VLAN ID to swap.

c. In theOuter VLAN Tag to stack field, type a VLAN ID to push or swap at the

relevant UNI endpoints.

d. In the InnerVLANTagtostack field, typeaVLAN ID topushor swapat the relevant

UNI endpoints.

• If the service transports single VLANs and specifies Normalize to VLAN none:

• In the Inner VLAN (for Q-in-Q) field, type a VLAN ID to swap.

• If the service transports all traffic and specifies Normalize to VLAN all:

a. In the Customer VLAN Range Start and Customer VLAN Range End fields, type

the first and last VLAN ID of the range of customer VLANs to be transported over

the network.
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b. In the VLAN Tag to stack field, type a VLAN ID to push or swap at the relevant

UNI endpoints.

• If the service transports a range of VLANs and specifies Normalize to VLAN all:

a. In the Customer VLAN Range Start and Customer VLAN Range End fields, type

the first and last VLAN ID of the range of customer VLANs to be transported over

the network.

b. In the VLAN Tag to stack field, type a VLAN ID to push or swap at the relevant

UNI endpoints.

NOTE: A service that transports a range of VLANs and specifies
Normalize to VLAN all allows only 802.1Q, and Q-in-Q interfaces for
the UNI endpoints.

7. Click Next.

The Select Endpoint PE Deviceswindow appears.

8. Continue with "Selecting N-PE Devices and Multihomed Groups," next.

Selecting N-PE Devices andMultihomed Groups

This part of the create multipoint Ethernet service order procedure selects the N-PE

devicesand,optionally,multihomedgroups thathosts theserviceendpoints.Theselection

is made from the Select Endpoint PE Deviceswindow.

If there is a service template attached to the service definition, there is a link to that

template at the bottom of the Endpoint Settings section of the window. For instructions

on working with service templates in service orders, see “Creating a Service Order Based

on a Service Definition with a Template” on page 564.

NOTE: Ifmultihoming isenabledontheservicedefinitiononwhich theservice
order is based and you have configured and imported the connectivity file,
you can select one or moremultihomed groups that are configured in the
multihomed groups connectivity file for the service endpoints.

NOTE: The Select Endpoint PE Deviceswindow shows only assigned NPE

devices that have an AS number configured. If you do not see the device you
are looking for, use theCLIon thedevice tocheck forandassignanASnumber.

To select endpoint N-PE devices:

1. In the Select Endpoint PE Deviceswindow, select the devices that you want to

participate in the service. Use the multiple selection feature to select one or more

devices.
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2. Click Next.

The Endpoint Settingswindow appears.

3. Continue with "Modifying Endpoint Settings," next.

Modifying Endpoint Settings

This part of the create multipoint Ethernet service order procedure sets the attributes

for each endpoint in the service. Selection is made using the Endpoint Settingswindow.

This window shows one endpoint for each device that you selected from the Select

Endpoint PE Deviceswindow, as described in “Selecting N-PE Devices and Multihomed

Groups” on page 501.

The interface shown in the UNI Interface field is automatically selected by the Network

Activate software, which chooses theUNI that has the highest available capacity among

interfaces that are in the Up state. To calculate the available capacity of the interface,

the system subtracts the bandwidth reserved for each service deployed on that interface

from the total capacity of the interface.

For each endpoint, the Endpoint Settingswindow shows the following value for eachUNI

attribute:

• For port-to-port services, the displayed values are Bandwidth and MTU.

• For 802.1Q UNIs, the displayed attributes are Bandwidth, Autopick VLAN ID, VLAN ID,

and MTU.

• For Q-in-Q UNIs, the displayed attributes include Bandwidth, AutoPick VLAN ID, and

VLAN ID. For a service with Q-in-Q UNIs that specifies a customer VLAN range, the

displayed attributes also include C-VLAN ID Start and C VLAN End.

For each endpoint on a servicewith flexible VLAN tagging, the Endpoint Settingswindow

shows the following value for each UNI attribute:

• For a service with flexible VLAN tagging that transports a single VLAN and specifies

Normalize to Dot1q tags, the displayed attributes include Ethernet Option, Bandwidth,

AutoPick VLAN ID, Inner VLAN ID, and MTU. For a service with flexible VLAN tagging

that specifies a customer VLAN range, the displayed attributes also include C-VLAN

ID Start and C VLAN End.

• For a service with flexible VLAN tagging that transports a single VLAN and specifies

Normalized to QinQ tags, the displayed attributes include Bandwidth, AutoPick VLAN

ID, and VLAN ID. For a service with flexible VLAN tagging that specifies a customer

VLAN range, the displayed attributes also include C-VLAN ID Start and C VLAN End.
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• For a service with flexible VLAN tagging that transports a VLAN range, the displayed

attributes includeBandwidth,AutoPickVLAN ID, andVLAN ID. For a servicewith flexible

VLAN tagging that specifies a customer VLAN range, the displayed attributes also

include C-VLAN ID Start and C VLAN End.

The values shown are initially the values you set earlier on the Enter Order Information

window, as described in “Setting Attributes for All Endpoints” on page 496.

Tomodify the endpoint settings:

1. For a service with flexible VLAN tagging, set the interface type in the Ethernet Option

column for each endpoint in the service.

2. To select a different UNI on a device, on the Endpoint Settingswindow, click the UNI

name you want to change and choose another interface from the list.

Modified values are indicated by a small red triangle in the corner of the table cell.

3. To enter the description for an UNI interface, click the corresponding Description cell.

4. To change the bandwidth on an endpoint, click the bandwidth value for the endpoint

and select another value from the list.

5. To change the committed information rate (CIR) on an endpoint, click the CIR value

for the endpoint and select another value from the list. Make sure that the CIR value

is less than the PIR value.

Only QoS-enabled services specify CIR and PIR values.

6. To change the peak information rate (PIR) on an endpoint, click the PIR value for the

endpoint and select another value from the list.Make sure that thePIR value is greater

than the CIR value.

Only QoS-enabled services specify CIR and PIR values.

7. The AutoPick UNIT ID and the UNIT ID columns appear, if you have not selected the

Ethernet option as port-to-port.

• To change an automatically selected service UNIT ID tomanual selection, clear the

AutoPick UNIT ID check box, and type a service UNIT ID value in the UNIT ID field.

• To change frommanual selection to automatic selection, select the AutoPick UNIT

ID check box.

• To change the value of amanually selected service UNIT ID, type a new value in the

UNIT ID field.

NOTE: The unit ID value that you have specified in the Enter Order
Information page is displayed in the UNIT ID field.

8. For Q-in-Q interface endpoints, you can change how the service VLAN ID is selected:

• To change an automatically selected service VLAN ID to manual selection, clear

the AutoPick VLAN ID check box, and type an VLAN ID value in the VLAN ID field.
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• To change frommanual selection to automatic selection, select theAutoPickVLAN

ID check box.

• To change the value of a manually selected service VLAN ID, type a new value in

the VLAN ID field.

9. For Q-in-Q interface endpoints with customer VLAN ranges specified, you can also

change the range limits for an endpoint.

10. For 802.1Q interface endpoints, you can change the customer VLAN ID.

11. To change the MTU for the UNI, click the value in theMTU field and type a new value.

12. To add a UNI on a selected device, select AddUNI Interface in the Action column, and

then select the interface you want from the UNI interface list.

13. If the interface you selected in the previous step is already configured (duplicate) you

must either type a different value in theVLAN ID fieldmanually, or check theAutopick

VLAN ID field.

14. To delete a UNI from a device, in the Action column, click Delete UNI Interface.

If the deleted UNI is the only UNI selected from the device, then the device is deleted

form the service configuration.

15. To specify the value ofOutgoing Label for any device, click the Add Label link that is

associated with that device. Specify the value in theOutgoing Label Settingswindow

and clickOK to save the value. All the devices act as hubs and no spoke devices are

present.

16. To view the values of the Incoming Label and theOutgoing Label of any device, use

the following method:

a. SelectManage Service Orders > View Service Order Details.

b. Click the Label Details link associated with any device.

17. To specify a different primary device for a multihomed group:

a. To select a different primary device, in the Endpoint Settings box, click the Edit icon

(indicated by a pencil).

b. From the list of secondary devices, select the radio button for the secondary device

that you want to specify as the primary device in the multihomed group.

c. Click Set As Primary.

d. Click Create.

The secondary device is configured as the primary device in themultihomedgroup.

18. Configuring advanced settings is optional. You can click on the Advanced link to view

the default values for Advanced Settings. If the advanced settings can be edited in
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the service order, you can override the default values. If you do not click the Advanced

link, the default advanced settings are applied to the service order.

To configure advanced settings for a device in the service order:

a. Click Advanced in the Action column.

The Advanced Settingwindow displays the security and advanced settings that

you can configure for a device.

b. In theMACSecurity Settings box, make selections for MAC learning and MAC

statistics and type values for Interface MAC limit, MAC table size, and MAC table

aging time.

c. Enable or disable tunnel services by selecting or clearing thedisable-tunnel-service

check box.

d. Enableor disable local switchingby selectingor clearing thedisable-local-switching

check box.

e. In theFast reroutepriority field, select the reroutepriority for aVPLS routing instance.

f. In the Label block size field, type the label block size for VPLS labels.
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g. In the Connectivity type field, select a connection-type to specify when a VPLS

connection is takendown,dependingonwhether the interface for theVPLS routing

instance is customer-facing or integrated routing and bridging (IRB)

h. ClickOK to save your Advanced Setting changes for the device.

19. To add an endpoint on a device not listed in the Endpoint Settingswindow:

a. Click Add Endpoints.

TheAddEndpoint PEDeviceswindowdisplays the available N-PE devices that you

did not assignwhen you firstmade your device selections from theSelectEndpoint

PE Deviceswindow.

b. Select additional devices, then click Next.

The Endpoint Settingswindow appears with the new devices added.

c. Modify the endpoint settings for this device, as required.

20. If you have attached a service template in the service definition, the Flexible Service

Attributes link appears. Click the link to modify the service template attributes. For

more information about configuring the flexible Service Attributes, see “Configuring

Flexible Service Attributes to Modify Service Template Attributes” on page 484.

21. When you have finishedmodifying the endpoint settings, click Create.

The Deployment Optionswindow appears.

The service order that you have created is graphically represented in the topology. To

view the serviceorder that youhavecreated in the topology, selectPlatform>Network

Monitoring > Topology > Service > NA service order name.

For more information on topology, see “Junos Space Network Topology Overview” on

page 40

22. Continue with "Deploying the New Service," next.

Deploying the New Service

This part of the create multipoint Ethernet service order procedure deploys the service.

To deploy the service from the Deployment Optionswindow:

1. Perform one of the following actions:

• To save the request without deploying the service, select Save only, then clickOK.

See “Deploying aService” on page 467 for information about how to deploy a saved

service at a later time.

• To deploy the service immediately, select Deploy now, then clickOK.

• To deploy the service later, select Schedule deployment, select a date and time,

then clickOK.

The time field specifies the time kept by the server, but in the time zoneof the client.
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2. Tomonitor the status of the deployment, use the Jobs workspace.

The service order is now complete.

TheManage Service Orders page shows the service order you just added. See Viewing

Jobs in the Junos Space Network Application Platform User Guide for details about the

Jobs workspace.

Related
Documentation

Viewing Jobs in the Junos Space Network Application Platform User Guide•

• Viewing Service Orders on page 765

• Service Attributes Overview on page 20

• Adding a New Customer on page 709

• Deploying a Service on page 467

• Force-Deploying a Service on page 468

• Creating a Point-to-Multipoint VPLS Service Order on page 507

• Creating a Point-to-Point Service Order on page 438

• Understanding VLANManipulation (Normalization and VLANMapping) on Ethernet

Services on page 32

• Creating a Service Order Based on a Service Definition with a Template on page 564

Creating a Point-to-Multipoint VPLS Service Order

The Network Activate software implements point-to-multipoint Ethernet services as

virtual private LAN(VPLS) services. These servicesarealso referred toashub-and-spoke

services.

To create a point-to-multipoint Ethernet service order, complete the following tasks in

order:

• Selecting the Service Definition on page 508

• Entering General Settings Information on page 508

• Configuring Connectivity Settings on page 509

• Specifying QoS Settings on page 511

• Specifying OAM Settings on page 512

• Setting Attributes for All Endpoints on page 512

• Setting Attributes for Endpoints on a Service on page 513

• Setting Attributes for Endpoints on a Service with Flexible VLAN Tagging on page 515

• Selecting N-PE Devices and Multihomed Groups on page 517

• Selecting Hubs and Modifying Endpoint Settings on page 518

• Deploying the New Service on page 524
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Selecting the Service Definition

To select a service definition on which to base the new service order:

1. In theNetworkActivate taskpane, selectServiceProvisioning>ManageServiceOrders

> Create VPLS Service Order.

TheCreateVPLSServiceOrderwindowdisplays a filtered inventory view of only those

published service definitions that are designed to work with multipoint Ethernet

services. You can select the service definition based on the signaling type.

2. Select the point-to-multipoint service definition you want to base your service order

on and then click Next.

The Enter Order Informationwindow appears.

Entering General Settings Information

This part of the create point-to-multipoint Ethernet service order procedure sets general

information about the service order in the General Settings box of the Enter Order

Informationwindow:

To specify general settings information:

1. In the Name field, type a unique name for the point-to-multipoint service.

The service order name can consist of only letters, numbers, and underscores.

NOTE: The name you specify for a VPLS service order becomes the
routing-instance name in the device configuration when you deploy the
service. Consequently, you cannot use any Juniper Networks keywords,
for example, “bgp” or “vpls”, as the name of a service order.

2. In the Customer field, select the customer requesting the service.

If the customer is not in the list, you must add the customer to the database before

proceeding. See “Adding a New Customer” on page 709.
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3. In the Comments field, type a description of the service. This description appears in

information window about the request or service instance created from the request.

You cannot select the Customer traffic type. Its value is set in the service definition.

You cannot change the Signaling type in the service order.

The following check boxes are displayed based on the service definition you have

selected:

• Enable PW Extension

• Enable PWResiliency

• Allow access to L3 network

You cannot change these check boxes in the service order.

4. If QoS is enabled, continue with "Specifying QoS Settings," next. Otherwise skip to

"Setting Attributes for all Endpoints."

Configuring Connectivity Settings

In this procedure, you specify the attributes that define the connectivity among remote

sitesacross the serviceprovider networkand the service security. The following illustration

is a sample Connectivitywindow.
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To configure connectivity settings for connectivity between sites across the network:

1. Specify whether the route distinguisher can be selected automatically or manually.

NOTE: You cannot edit the route distinguisher if you have not selected
the Editable in Service Order check box in the service definition.

• To assign the route distinguisher automatically, select the Autopick Route

Distinguisher check box.

• To assign the route distinguisher manually, clear the Autopick Route Distinguisher

check box.

If you choose to assign the route distinguisher manually, the window expands to

include the Route distinguisher field. In the Route distinguisher field, type a value.

Junos Space accepts either of the following two formats:

• prefix-number: assigned-number

Where prefix-number can be any numeric value from 1 through 65,535, and

assigned-number can be any numeric value from 0 through 2,147,483,647

• IPV4-address: assigned-number

Where IPV4-address can be any valid IPv4 address, and assigned-number can be

any numeric value from 0 through 65,535

NOTE: The Route distinguisher field is available in either of the following

cases:

• The Signaling type is BGP.

• The Signaling type is LDP and Auto Discovery is enabled.

2. Specify whether the route target can be selected automatically or manually.

NOTE: You cannot edit the route target if you have not selected the
Editable in Service Order check box in the service definition.

• To assign the route target automatically, select the Autopick Route target check

box.

• To assign the route target manually, clear the Autopick Route target check box.

If you choose to assign the route target manually, the window expands to include

the Route Target field. In the Route Target field, type a value. Junos Space accepts

either of the following two formats:

• prefix-number:assigned-number
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Where prefix-number can be any numeric value from 1 through 65,535, and

assigned-number can be any numeric value from 0 through 2,147,483,647

• IPV4-address:assigned-number

Where IPV4-address can be any valid IPv4 address, and assigned-number can be

any numeric value from 0 through 65,535

NOTE: The Route Target field is available in either of the following cases:

• The Signaling type is BGP.

• The Signaling type is LDP and Auto Discovery is enabled.

3. In theRevert time (sec) field, specify the revert time for redundant Layer 2 circuits and

VPLS pseudowires.

Default: 5 seconds

Range: 0 through 65,535 seconds

This field is available only if you have enabled the Enable PWResiliency check box in

the selected service definition.

4. In the Switch Over Delay (sec) field, specify the time to wait before the backup

pseudowire takes over.

Default: 0 seconds

Range: 0 through 180 seconds

This field is available only if you have enabled the Enable PWResiliency check box in

the selected service definition.

5. Continue with specifying the QoS settings.

You can edit the VPLS ID field, if you have selected the Selectmanually option for the

VPLS ID field in the service definition.

TheAutoDiscovery andAutopickVPLS ID fields appears dimmed inConnectivity Settings

dialog box. These fields are not editable in the service order.

Specifying QoS Settings

If QoS is enabled in the service definition, enter information in the QoS Settings box.

NOTE: QoS features appear in the Junos Space user interface only if you
deploy the QoS Design application in Junos Space.

1. In theQoS profile field, select a profile from the list.

The QoS profile list displays the QoS profiles that are currently configured in the QoS

Design software.
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A QoS profile classifies traffic into defined service groups to provide the special

treatment of traffic across the network service.

2. In the CIR field, select the committed information rate (CIR) from the list.

The CIR is the guaranteed rate and specifies the minimum bandwidth available if all

sources are active at the same time. The value for CIR should be less than the value

for PIR.

NOTE: For bursty traffic, the CIR represents the average rate of traffic per
unit time, and the peak information rate (PIR) represents themaximum
amount of traffic that can be transmitted in a given interval.

3. In the PIR field, select the peak information rate (PIR) from the list. The PIR is the

shaping rate.

NOTE: If the QoS profile that you selected in Step 1 is configured with a
level-three scheduler and interface oversubscription is enabled, then PIR
is not used.

Specifying OAMSettings

To enable OAM on the service definition, enter information in the OAM Settings of the

General/Connectivity Settings panel.

1. In the CFMDefinition field, select a profile from the list.

NOTE: ForOAMSettings, if you specify aCFMprofile (for example, a CFM
action profile with remote MEP), or an SLA-Iterator profile, first youmust
ensure that the profile is attached to the same device upon which you
intend to deploy the P2P service order. If the profile is not previously
attached (using theOAM Insight application), itwill not be present on the
device to support the service order.

NOTE: For Juniper Networks PTX3000 Packet Transport Routers and
Junos Space Release 13.1P1, if you attach a CFMDefinition to the service
order, the CFM session will operate for MEPs in either the Up or Down
direction when the service is deployed.

2. Continue with "Specifying Endpoint Information," next.

Setting Attributes for All Endpoints

This part of the create multipoint Ethernet service order procedure sets the attributes

that are usually common for all endpoints in the service.
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If a template was attached to the service definition on which the service order is based,

the link to invoke the template editor appears on the Endpoint Settings page.

The values that you type varies, depending on the service definition onwhich the service

order is based. Follow the steps in one of the following tasks, depending on whether or

not the service provides flexible VLAN tagging. To create a service with flexible VLAN

tagging, the service definition that you selected for the service order must include the

Ethernet option asymmetric tag depth in the UNI settings step.

If there is a service template attached to the service definition, there is a link to that

template at the bottom of the Endpoint Settings section of the window. For instructions

on working with service templates in service orders, see “Creating a Service Order Based

on a Service Definition with a Template” on page 564.

Setting Attributes for Endpoints on a Service

If these attributes are not the same on all endpoints, you can set them to be the same

for now and thenmake changes later, or you can choose to skip this step and apply the

attribute values one at a time later.

This procedure sets the attributes listed in the End Point Settings box of the Enter Order

Informationwindow.Theattributesshowndependon the interface typeand thesignaling

type. The following example shows the endpoints settings box for a point-to-multipoint

service order with Q-in-Q interfaces, transporting a VLAN range.

NOTE: When the Allowmultihoming check box is selected for the service

definitiononwhich theserviceorderbased, theEndPointSettingsboxdisplays

theAllowmultihomingonendpoints checkbox to indicate that the service can

includemultihomed groups.

To set attributes common tomost endpoints:
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1. In theBandwidth field, select a value from the list to limit the bandwidth of the service

you are creating.

This field is present only if bandwidth limiting is allowed by the service definition, and

is configurable in the service order only if the service definition allows it.

2. In theMTU field, type the maximum transmission unit size for the UNI.

This field is present in all service orders. However, you can set this field only if the

service definition allows it.

The Auto-pick VLAN range constraint field is displayed and validates the VLAN range

specified in the service definition.

3. If Autopick VPLS ID is disabled, specify the VPLS ID.

Range: 1 through 2147483647

NOTE: If thesignaling type isLDPand ifautodiscovery isenabled,Autopick

VPLS ID appears dimmed. This field is not editable in the service order.

If the signaling type is BGP, Autopick VPLS ID is not available.

4. If Autopick VPN ID is enabled, specify the VPN ID.

Range: 1 through 65535

NOTE: If thesignaling type isLDPand ifautodiscovery isenabled,Autopick

VPN ID appears dimmed. This field is not editable in the service order.

If the signaling type is BGP, Autopick VPN ID is not available.

5. In theCustomer VLANRangeStart andCustomer VLANRange End fields, type the first

and last VLAN ID of the range of customer VLANs to be transported over the network.

These fields are present only for services with UNIs that have Q-in-Q interface types

and allow a range of VLANs to be transported.

6. In the VLAN Tag to stack field, type a value for the customer VLAN.

This field is present only for services that specify Normalize to Dot1q tags.

7. In the Inner VLAN Tag (for QinQ) field, type a value to provide a default inner VLAN

tag for the UNI endpoints.

This field is present only for services that specify Normalize to QinQ tags.

8. In theOuter VLAN Tag to Stack field, type a value to provide an outer VLAN tag that

matches the Outer VLAN tag of at least one of the UNI endpoints.

9. In the Inner VLAN Tag to Stack field, type a value to provide a default inner VLAN tag

for the UNI endpoints to provide a common inner VLAN tag for the routing instance.

This field is present only for services that specify Normalize to QinQ tags.
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10. The LDP PWExtension Settings field is available only if you have enabled the Enable

PWExtension check box in the selected service definition.

The Physical IF encapsulation and Logical IF encapsulation fields are not selectable.

These values are set in the service definition.

11. Specify the Logical If Settings:

NOTE: The Logical If Settings box is not available if you have selected the
Ethernet option as Port.

• Specify whether the Autopick UNIT ID can be selected automatically or manually.

• To assign the UNIT ID automatically, select the Autopick UNIT ID check box.

• To assign the UNIT IDmanually, clear the Autopick UNIT ID check box.

Thewindowexpands to include theUNIT ID field. In theUNIT ID field, type a value.

Range: 1 through 1073741823

NOTE: You can edit this field only if you have selected the Editable in

ServiceOrdercheckbox for theVLANIDselection in theservicedefinition.

• Specify whether the Autopick VLAN ID can be selected automatically or manually.

• To assign the VLAN ID automatically, select the Autopick VLAN ID check box.

• To assign the VLAN IDmanually, clear the Autopick VLAN ID check box.

The window expands to include the VLAN ID field. In the VLAN ID field, type a

value.

12. Click Next.

The Select Endpoint PE Deviceswindow appears.

13. Continue with "Selecting N-PE Devices and Multihomed Groups."

Setting Attributes for Endpoints on a Service with Flexible VLAN Tagging

Aservicewith flexibleVLANtaggingcan includeport-based,802.1Q,andQ-in-Q interfaces.

If these attributes are not the same on all endpoints, you can set them to be the same

for now and thenmake changes later, or you can choose to skip this step and apply the

attribute values one at a time later.

This procedure sets the attributes listed in the End Point Settings box of the Enter Order

Informationwindow. The attributes shown depend on the signaling type and interface

type. The following example shows the endpoints settings box for a point-to-multipoint

service order that specifies a service with flexible VLAN tagging that is normalized to

Dot1Q and transports a single VLAN.
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NOTE: When the Allowmultihoming check box is selected for the service

definitiononwhich theserviceorderbased, theEndPointSettingsboxdisplays

theAllowmultihomingonendpoints checkbox to indicate that the service can

includemultihomed groups.

To set attributes common tomost endpoints:

1. In theBandwidth field, select a value from the list to limit the bandwidth of the service

you are creating.

This field is present only if bandwidth limiting is allowed by the service definition, and

can be configured in the service order only if the service definition allows it.

2. In theMTU field, type the maximum transmission unit size for the UNI.

This field is present in all service orders. However, you can set this field only if the

service definition allows it.

3. If the signaling type is LDP and the if the auto discovery is enabled, the Autopick VPN

ID appears dimmed. This field is not editable in the service order,

4. Specify the VPLS ID if the Autopick VPLS ID is disabled.

Range: 1 through 2147483647

5. Specify the VPN ID if the Autopick VPN ID is enabled.

Range: 1 through 65535

6. The LDP PWExtension Settings is available only if you have enabled the Enable PW

Extension check box in the selected service definition.

7. To configure VLANs, choose from the following options depending on the VLAN

transport type and Normalization that the service specifies:

• If the service transports single VLANs and traffic is Normalized to Dot1Q tag:

a. In the Inner VLAN (for Q-in-Q) field, type a VLAN ID to swap.

b. In the VLAN Tag to stack field, type a VLAN ID to push or swap at the relevant

UNI endpoints.

• If the service transports single VLANs and traffic is Normalized to QinQ tags:

a. Tomanually assign an VLAN ID:

i. Clear the Autopick VLAN ID check box. The window expands to include the

VLAN ID field.

This field is present in the service order only if the service definition allows it.

ii. In the VLAN ID field, type a value.
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This field is configurable in the serviceorder only if the servicedefinitionallows

it.

b. In the Inner VLAN (for Q-in-Q) field, type a VLAN ID to swap.

c. In theOuter VLAN Tag to stack field, type a VLAN ID to push or swap at the

relevant UNI endpoints.

d. In the InnerVLANTagtostack field, typeaVLAN ID topushor swapat the relevant

UNI endpoints.

• If the service transports single VLANs and traffic is Normalized to VLAN none:

• In the Inner VLAN (for Q-in-Q) field, type a VLAN ID to swap.

• If the service transports all traffic and specifies Normalize to VLAN all:

a. In the Customer VLAN Range Start and Customer VLAN Range End fields, type

the first and last VLAN ID of the range of customer VLANs to be transported over

the network.

b. In the VLAN Tag to stack field, type a VLAN ID to push or swap at the relevant

UNI endpoints.

• If the service transports a range of VLANs and specifies Normalized VLAN all:

a. In the Customer VLAN Range Start and Customer VLAN Range End fields, type

the first and last VLAN ID of the range of customer VLANs to be transported over

the network.

b. In the VLAN Tag to stack field, type a VLAN ID to push or swap at the relevant

UNI endpoints.

NOTE: A service that transports of a range of VLANs and specifies
Normalized VLAN all allows only 802.1Q, and Q-in-Q interfaces for
the UNI endpoints.

8. Click Next.

The Select Endpoint PE Deviceswindow appears.

9. Continue with "Selecting N-PE Devices and Multihomed Groups," next.

Selecting N-PE Devices andMultihomed Groups

This part of the create point-to-multipoint Ethernet service order procedure selects the

N-PE devices and, optionally, multihomed groups that hosts the service endpoints. The

selection is made from the Select Endpoint PE deviceswindow.

517Copyright © 2015, Juniper Networks, Inc.

Chapter 11: Service Provisioning: Managing VPLS Service Orders



NOTE: Ifmultihoming isenabledontheservicedefinitiononwhich theservice
order is based and you have configured and imported the connectivity file,
you can select PE devices andmultihomed groups that are specified in the
multihomed groups connectivity file for the service endpoints.

NOTE: The Select Endpoint PE deviceswindow shows only assigned N-PE

devices that have an AS number configured. If you do not see the device you
are looking for, use theCLIon thedevice tocheck forandassignanASnumber.

To select endpoint N-PE devices andmultihomed groups:

1. In the Select Endpoint PE deviceswindow, select the devices andmultihomed groups

that youwant to participate in the service. Use themultiple selection feature to select

one or more devices.

2. Click Next.

The Endpoint Settingswindow appears.

Selecting Hubs andModifying Endpoint Settings

This part of the create point-to-multipoint Ethernet service order procedure selects the

devices that are service hubs and sets the attributes for each endpoint in the service.

Selection is made using the Endpoint Settingswindow.
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This window shows one endpoint for each device that you selected from the Select

Endpoint PE deviceswindow, as described in “Selecting N-PE Devices and Multihomed

Groups” on page 517.

The interface shown in the UNI Interface field is automatically selected by the Network

Activate software, which chooses theUNI that has the highest available capacity among

interfaces that are in the Up state. To calculate the available capacity of the interface,

the system subtracts the bandwidth reserved for each service deployed on that interface

from the total capacity of the interface.

For each endpoint, the Endpoint Settingswindow shows the value for eachUNI attribute.

• For port-to-port services, the displayed values are for Bandwidth and MTU.

• For 802.1Q UNIs, the displayed attributes are for Bandwidth, Autopick VLAN ID, VLAN

ID, and MTU.

• For Q-in-Q UNIs, the displayed attributes include Bandwidth, AutoPick VLAN ID, and

VLAN ID. For a service with Q-in-Q UNIs that specifies a customer VLAN range, the

displayed attributes also include C-VLAN ID Start and C VLAN End.

The values shown are initially the values you set earlier on the Enter Order Information

window, as described in “Setting Attributes for Endpoints on a Service” on page 513.

Tomodify the endpoint settings:

1. For a service with flexible VLAN tagging, set the interface type in the Ethernet Option

column for each endpoint in the service.

2. To select a hub, choose the device you want to serve as a hub and, above the device

name, select Hub. The Neighbor Hub link is not applicable for hub devices.

To provide a higher level of availability, you can select multiple hubs.

3. To fill in the neighbor hub details for a spoke device, click the Neighbor Hub link. The

Neighbor Hub Settingwindow is displayed.

For spoke devices you can update the Neighbor Hub details only if:

• The Signaling type is LDP and the Auto discovery check box is disabled

• The Signaling type is BGP and the Enable PWExtension check box is enabled

Fill in the following information:

• Enable P2P-Spoke—If selected, the spoke acts as a stitched point-to-point

pseudowire. This check box is available only if you have enabled the Enable PW

Extension in the selected service definition. If you have addedmore than one UNI

interface for a spoke device, you cannot select this check box.

• NeighborHub—Select the neighbor hub device from the list. If the Signaling type is

BGP, enable the Enable P2P-Spoke check box to select the neighbor hub.

• Backup neighbor—Select the backup neighbor hub device from the list. This field is

available if the Enable PWResiliency check box is enabled in the selected service
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definition. If the Signaling type is BGP, enable the Enable P2P-Spoke check box to

select the backup neighbor.

NOTE: You cannot select the same device forNeighborHub and Backup

neighbor.

• PW-Hub Connectivity name— If the Signaling type is BGP and if you have enabled

the Enable P2P-Spoke check box, select or type themesh group name from other

pseudowire spoke.

Range: 1 through 32 characters

If theSignaling type isLDP, thepseudowire-hubconnectivityname isautogenerated.

• Auto pick VC ID—This field is available if the Signaling type is BGP and if you have

enabled the Enable P2P-Spoke.

If the Signaling type is LDP, the VPLS ID of the routing instance is used.

• VC ID—If the Signaling type is BGP and if you have enabled Enable P2P-Spoke,

specify the VC ID.

You can also modify the VCID field in the Modify Service Order window.

Range: 1 through 2147483647

If the Signaling type is LDP, the VPLS ID of the routing instance is used.

4. To select a different UNI on a device, on the Endpoint Settingswindow, click the UNI

name you want to change and choose another interface from the list.

Modified values are indicated by a small red triangle in the corner of the table cell.

5. To enter the description for an UNI interface, click the corresponding Description cell.

6. To change the bandwidth on an endpoint, click the bandwidth value for the endpoint

and select another value from the list.

7. To change the committed information rate (CIR) on an endpoint, click the CIR value

for the endpoint and select another value from the list. The value for CIR should be

less than the value for PIR.

Only QoS-enabled services specify CIR and PIR values.

8. To change the peak information rate (PIR) on an endpoint, click the PIR value for the

endpoint and select another value from the list. The value for PIR should be greater

than the value for CIR.

Only QoS-enabled services specify CIR and PIR values.

9. The AutoPick UNIT ID and the UNIT ID columns appear, if you have not selected the

Ethernet option as port-to-port.

• To change an automatically selected service UNIT ID tomanual selection, clear the

AutoPick UNIT ID check box, and type a service UNIT ID value in the UNIT ID field.
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• To change frommanual selection to automatic selection, select the AutoPick UNIT

ID check box.

• To change the value of amanually selected service UNIT ID, type a new value in the

UNIT ID field.

NOTE: The unit ID value that you have specified in the Enter Order
Information page is displayed in the UNIT ID field.

10. For Q-in-Q interface endpoints, you can change how the service VLAN ID is selected:

• To change an automatically selected service VLAN ID to manual selection, clear

the AutoPick VLAN ID check box, and type a service VLAN ID value in the VLAN ID

field.

• To change frommanual selection to automatic selection, select theAutoPickVLAN

ID check box.

• To change the value of a manually selected service VLAN ID, type a new value in

the VLAN ID field.

11. For Q-in-Q interface endpoints with customer VLAN ranges specified, you can also

change the range limits for an endpoint.

12. For 802.1Q interface endpoints, you can change the customer VLAN ID.

13. To change the MTU for the UNI, click the value in the MTU field and type a new value.

14. To add a UNI on a selected device, select Add UNI Interface in the Action column, and

then select the interface you want from the UNI interface list.

You can add only one UNI interface for the point-to-point spoke device. If more than

one UNI interface exists for a spoke device, you cannot select the Enable P2P-Spoke

check box in the Neighbor Hub link.

15. If the interface you selected in the previous step is already configured (duplicate) you

must either type a different value in the service VLAN ID field manually, or select the

Autopick VLAN ID check box.

16. To delete a UNI from a device, in the Action column, click Delete UNI Interface.

If the deleted UNI is the only UNI selected from the device, then the device is deleted

from the service configuration.

If a hub device is neighbor of a point-to-point spoke device, you cannot delete the

device. To delete such device, youmust delete the point-to-point spoke device, or

change the point-to-point spoke to VPLS spoke.

17. To enter the value ofOutgoing Label for any device, click the Add Label link that is

associated with that device. You can enter the value in theOutgoing Label Settings

window and clickOK to save the value. Select the hub and spoke devices in the

Endpoint Settingswindow.

18. To view the values of the Incoming Label,Outgoing Label and the Neighboring Device

of any device, use the following method:
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a. SelectManage Service Orders > View Service Order Details

b. Click the Label Details link associated with any device.

NOTE: When the signaling type is BGP and the service type is
Point-to-Multipoint Ethernet VPLS, the Label Details link is not available

under theEndpointSettings linkwhen you createormodify a service order.

In the Endpoint Settingswindow, you need to select the devices that are

going to act as hub because some devices act as hub and some act as
spokewhen the service type isPoint-to-Multipoint. Nowclick theNeighbor

Hub link that is associated with the devices acting as spokes. The

Neighborhub Settingwindow that appears for the selected spoke device

allows you to enter the details of the outgoing label values of
P2P-Spokeand neighbor hub. The window displays details about the

Neighborhubdevice, theBackupNeighborhubdevice,HubConnectivityName

andVC ID. To specify and view these details, you need to select the Enable

P2P-Spoke checkbox. If the Enable P2P-Spoke checkbox is not selected,

you cannot specify any of these values.

19. To specify a different primary device for a multihomed group in the service:

a. From the list of secondary devices, select a secondary device that you want to

specify as the primary device in the multihomed group.

b. Click Set As Primary.

c. Click Create.

The secondary device is configured as the primary device in themultihomedgroup.

20.For spoke devices, in the Neighbor Hub select the hub device.

21. Click on the Advanced link to view the default values for Advanced Settings. If the

advanced settings can be edited in the service order, you can override the default

values. If you do not click theAdvanced link, the default advanced settings are applied

to the service order.

Copyright © 2015, Juniper Networks, Inc.522

Junos Space Cross Provisioning Platform



NOTE: The Advanced link is not available for a point-to-point spoke.

To change settings on an endpoint that has editable advanced settings:

a. Click Advanced in the Action column.

The Advanced Settingwindow displays the security and advanced settings that

you can configure for a device.

See “ServiceAttributesOverview”onpage20 for complete informationaboutMAC

security settings and advanced settings.

b. In theMACSecurity Settings box, make selections for MAC learning and MAC

statistics and type values for Interface MAC limit, MAC table size, and MAC table

aging time.

c. Enable or disable tunnel services by selecting or clearing thedisable-tunnel-service

check box.

d. Enableor disable local switchingby selectingor clearing thedisable-local-switching

check box.

e. In the Fast reroute priority field, specify the reroute priority for a VPLS routing

instance.

f. In the Label block size field, specify the label block size for VPLS labels.
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g. In the Connectivity type field, select a connection-type to specify when a VPLS

connection is takendown,dependingonwhether the interface for theVPLS routing

instance is customer-facing or integrated routing and bridging (IRB)

h. ClickOK to save your changes in the Advancedwindow.

22. To add an endpoint on a device not listed in the Endpoint Settings window:

a. Click Add Endpoints.

TheAddEndpoint PEDeviceswindowdisplays the available N-PE devices that you

did not assignwhen you firstmade your device selections from theSelectEndpoint

PE deviceswindow.

b. Select additional devices, then click Next.

The Endpoint Settingswindow appears with the new devices added.

c. Modify the endpoint settings for this device, as required.

23. If you have attached a service template in the service definition, the Flexible Service

Attributes link appears. Click the link to modify the service template attributes. For

more information about configuring the flexible service attributes, see “Configuring

Flexible Service Attributes to Modify Service Template Attributes” on page 484.

24.When you have finishedmodifying the endpoint settings, click Create.

The Deployment Optionswindow appears.

The service order that you have created is graphically represented in the network

topology. In the network topology, to view the service order that you have created ,

select Platform > NetworkMonitoring > Topology > Service > NA service order name.

For more information on network topology, see “Junos Space Network Topology

Overview” on page 40.

25.Continue with "Deploying the New Service," next.

Deploying the New Service

This part of the create multipoint Ethernet service order procedure deploys the service.

To deploy the service from the Deployment Optionswindow:

1. Perform one of the following actions:

• To validate and save the request without deploying the service, select the Validate

check box, select Save only, then clickOK.

See “Deploying aService” on page 467 for information about how to deploy a saved

service at a later time.

• To save the request without validating the service, clear the Validate check box,

select Save only, then clickOK.

See “Deploying aService” on page 467 for information about how to deploy a saved

service at a later time.
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• To deploy the service immediately, select Deploy now and then clickOK.

• To deploy the service later, select Schedule deployment, select a date and time,

and then clickOK.

The time field specifies the time kept by the server, but in the time zoneof the client.

2. Monitor the status of the deployment using the Jobsworkspace.

The service order is now complete.

TheManage Service Orders page shows the service order you just added. See Viewing

Jobs in the Junos Space Network Application Platform User Guide for details about the

Jobs workspace.

Related
Documentation

Viewing Jobs in the Junos Space Network Application Platform User Guide•

• Viewing Service Orders on page 765

• Service Attributes Overview on page 20

• Adding a New Customer on page 709

• Deploying a Service on page 467

• Force-Deploying a Service on page 468

• Creating a Multipoint-to-Multipoint VPLS Service Order on page 491

• Creating a Point-to-Point Service Order on page 438

• Understanding VLANManipulation (Normalization and VLANMapping) on Ethernet

Services on page 32

• Creating a Service Order Based on a Service Definition with a Template on page 564

Creating a Service Order for VPLS Access into Layer 3 Networks

To select a service definition on which to base the new service order:

1. In theNetworkActivate task pane, selectServiceProvisioning>ManageServiceOrders

> Create VPLS Service Order.

The Create VPLS Service Orderwindow appears and shows a filtered inventory view

of only those published service definitions designed to work withmultipoint Ethernet

services.
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2. Select the service definition you want to base your service order on, then click Next.

The Enter Order Informationwindow appears.
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General Settings

ActionField

Enter a unique name for the VPLSmultipoint service.Name

The service order name can consist of only letters, numbers, and underscores.

NOTE: The name you specify for a VPLS service order becomes the routing-instance name in
thedeviceconfigurationwhenyoudeploy the service.Consequently, youcannotuseany Juniper
Networks keywords, for example, “bgp” or “vpls”, as the name of a service order.

Select the customer requesting the service. To speed your search, enter the first few letters
of the customer name and then select from the list.

Customer

If the customer is not in the list, youmust add the customer to thedatabasebeforeproceeding.
See “Adding a New Customer” on page 709.

Enter a description of the service. This description appears in the information screens about
the request or service instance created from the request.

Comments

The Customer traffic type field is not selectable. Its value is set in the service definition.

The Autopick Route Target field cannot be changed. Route targets are always selected
automatically.

Check the box if you are allowing the system to choose the VPLS routing instance.Autopick route target

NOTE: The Autopick route target is not editable in service order. By default, the check box is
always selected.

527Copyright © 2015, Juniper Networks, Inc.

Chapter 11: Service Provisioning: Managing VPLS Service Orders



ActionField

Check this box to create the access path into the Layer 3 network.

Required for VPLS service orders with access into Layer 3 networks.

NOTE: The Allow access to L3 network is not editable in service order. By default, the check
box is always selected.

Allow access to L3 network

1. Continue with the End Point Settings panel.

End Point Settings

ActionField

Check this box if you want these settings applied to all end points for this VPLS service order.Apply to all

Specify the bandwidth or use the default that appears in the field.Bandwidth

Specify the MTU value or use the default that appears in the field.MTU (Bytes)

Specify the VLAN ID associated with the IRB subinterface that will provide the link into the
Layer 3 network. This must be a VLAN that already exists.

VLAN ID

The VPLS service definition requires a normalized VLAN. Indicate the VLAN to push at the
relevant end points. This should be the same VLAN specified as the VLAN ID.

VLAN Tag to stack
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1. Click Next to display the device list where you will select the end point devices.

2. Select the devices you will use for this Layer 3 access.

3. The VPLS service order requires three interface: One IRB interface for the tunnel and

twoendpoints topingend-to-end.Addyour three interfacesusing theEndpointSettings

panel.

4. Select the IRB interface and click Create. You will be prompted to deploy the service

with the standard Deploy Service. panel.
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Verify the Service Order Results

After you have created the VPLS service order, return to theManage Service screen.

1. Select the service you just deployed and right-click to display the action menu.

2. Select View Service Configuration Change to display the service configuration.

Related
Documentation

Creating a Service Definition for VPLS Access into Layer 3 Networks on page 249•

• Performing a Functional Audit on page 805

Creating a VPLS Service Order in Cross Provisioning Platform

Cross Provisioning Platform is an extension of the Network Activate application within

JunosSpace,whichprovidesa single paneof interaction todeploy services across vendor

network devices. This topic discusses how to create and deploy a VPLS service order

across the devices of Juniper Networks involved in Cross Provisioning Platform.

You need to create VPLS service definition before you can create VPLS service order.

Refer to “Creating a VPLS Service Definition in Cross Provisioning Platform” on page 254

for information about how to create a VPLS service definition.
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To create a VPLS service order:

1. In the Cross Provisioning Platform task pane, select CPP > Service Orders.

The Service Orders page that appears displays a list of the existing service orders.

2. Click the Create Service Order icon above the tool grid.

The Create CPP Service Order page that appears contains the General section.

3. In the General Settings section, perform the following steps:

a. In the Select Service Definition section, select a service definition based on the

unique ID, name or type.

NOTE: The value in the ID field is associated with a service definition.

This identifier can be used when you are searching for a particular
servicedefinitionwhile creatingadeviceconfigletorder. Youcansearch
the service definition by its name, type or unique ID. You canmodify
the ID only during themigration of old service definition IDs.

b. In theOrder description field, type 3 through 256 alphanumeric characters to

describe the service order.

4. Click Create.
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The VPLS service order page appears.

NOTE: The name of the page depends according to the details of the
service definition.

5. In the VPLS service order page, enter the General, Jumbo, Site B selector, Site A -

Customer Facing Port, and Site B - Customer Facing Port details.

NOTE: Thefields thatappearontheEndpointSettingspagearedetermined

by the information that you provide while creating the VPLS service
definition that you attach with this service order.

6. Enter theSite name,Port,Service speed,Outer encapsulation, and Inner encapsulation

details in the customer-facing port section of site A and site B.

7. Enter the details of Site name, UNI port, Uplink port, and UNI encapsulation in the

customer-facing port section of site A and site B if the L2 Extension check box is

selected for both the sections.

Related
Documentation

• Creating a VPLS Service Definition in Cross Provisioning Platform on page 254
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CHAPTER 12

Service Provisioning: Managing Layer 3
VPN Service Orders

• Stitching a Pseudowire to an L3VPN Service on page 533

• Creating a Full Mesh Layer 3 VPN Ethernet Service Order on page 536

• Creating a Hub-and-Spoke Layer 3 VPN Service Order on page 549

• Selecting a Published L3VPN Service Definition for a Service Order on page 561

• Entering Layer 3 VPN Order Information on page 561

• Selecting Endpoint PE Devices on page 563

• Creating a Service Order Based on a Service Definition with a Template on page 564

• Deploying a Layer 3 VPN Service Order on page 566

• Creating a Multicast VPN Service Order on page 568

• Creating a Layer 3 VPN Service Order in Cross Provisioning Platform for Third-Party

Devices on page 572

Stitching a Pseudowire to an L3VPN Service

You can terminate a point-to-point pseudowire service into an existing Layer 3 VPN,

thereby providing access to Layer 3 services. The benefit of the pseudowire stitching

feature is that devices runningonLayer 2 technology continue to functionwhennetworks

are upgraded and Layer 3 technologies are used. In order to stitch Layer 2 services to one

another and to Layer 3 services, Junos Space utilizes tunnel PICs to peer up a pseudowire

and a Layer 3 VPN.

To stitch a pseudowire to a Layer 3 VPN service:

1. Create a point-to-point service definition.

In theGeneral tab, select theEnablePWaccess toL3VPNnetwork checkbox to enable

pseudowire access to the Layer 3 VPN network.

For more information on creating a point-to-point service definition, see “Creating a

Point-to-Point Ethernet Service Definition” on page 97.

2. Create a Layer 3 VPN service definition.
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For informationabout creatinga fullmeshLayer 3VPNservicedefinition, see “Creating

aFullMeshLayer 3VPNServiceDefinition”onpage257. For informationabout creating

a hub-and-spoke service definition, see “Creating a Hub-and-Spoke (One Interface)

Layer 3 VPN Service Definition” on page 264.

3. Create and deploy a Layer 3 VPN service order.

For information about creating a full mesh Layer 3 VPN service order, see “Creating a

Full Mesh Layer 3 VPN Ethernet Service Order” on page 536. For information about

creating a hub-and-spoke service order, see “Creating a Hub-and-Spoke Layer 3 VPN

Service Order” on page 549.

4. In the Manage Services inventory page, right-click a Layer 3 VPN service that you

created and select Service > Extend PWService.

The Extend PWService inventory page lists the point-to-point service definitions that

are enabled for Layer 3 access. This inventory pagemust also list the point-to-point

service definition you created in Step 1.

5. Select the point-to-point service definition and click Next.

6. Create a point-to-point service order.

Thestitchedendof thepoint-to-point service isprepopulatedwithLayer 3VPNservice

details.

The fieldsdisplayed in thepoint-to-point serviceorder arebasedon thepoint-to-point

service definition selected in Step 5. For example, in the point-to-point service

definition, when pseudowire resiliency is enabled, then the Revert time (sec) and the

Switch Over Delay (sec) fields are available in the service order.

You can select any one of the devices from the PE device field. Only the devices with

logical tunnel interfaces are listed. These devices are associatedwith the Layer 3 VPN

service.

Specify the following information in the PW Stitching box:

• L3 routing instance name—Name of the Layer 3 routing instance

NOTE: This field isprepopulated forastitchedendof thepoint-to-point
service.

• Autopick interface IP—If enabled, specify IPblocksizeand IPaddresspool; otherwise

specify the Interface IP address.

• Autopick peer unit—To peer logical system unit number, select the check box;

otherwise specify the Peer unit name.

For more information on creating a point-to-point service order, see “Creating a

Point-to-Point Service Order” on page 438.

The Layer 3 VPN Service Details window now displays the PWExtension details.

When you perform a functional audit for a Layer 3 VPN service with pseudowire

termination, by default the functional audit is applicable only to the Layer 3 VPN service.
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Toperforma functional audit for the pseudowires, select the Includeall extensions check

box in the Schedule Functional Audit window.

NOTE: For pseudowires, the functional audit is launched as a separate job.

Similarly, to performa Force Deploy for the pseudowires, select the Includeall extensions

check box in the Schedule Force Deployment window.

You can view the details of the stitched pseudowire in the Functional Audit Results

window.
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Related
Documentation

Creating a Point-to-Point ATM or TDM Pseudowire Service Order on page 432•

• Creating a Point-to-Point Service Order on page 438

Creating a Full Mesh Layer 3 VPN Ethernet Service Order

You can use the Network Activate software to implement Layer 3 VPN Ethernet services.

To create a Layer 3 VPN full mesh Ethernet service order, complete the following tasks

in order:

1. Selecting the Service Definition on page 536

2. Configuring Order Information on page 536

3. Selecting N-PE Devices on page 542

4. Setting Attributes for UNI Endpoints on page 542

5. Adding, Deleting, and Modifying Endpoints on page 547

6. Deploying the New Service on page 548

Selecting the Service Definition

To select a service definition on which to base the new service order:

1. Select Service Provisioning >Manage Service Orders > Create L3 VPN Service Order.

TheSelect ServiceDefinition page appears and shows a filtered inventory view of only

those published service definitions designed to work with Layer 3 VPN full mesh

Ethernet services.

2. Select the service definition on which you want to base your service order, and then

click Next.

The Enter Order Informationwindow appears.

Configuring Order Information

You can configure general settings, VPN settings that can be applied to all end points,

and routing protocol settings for provider edge (PE) and customer edge (CE) devices.

• Specifying General Settings on page 536

• Specifying QoS Settings on page 537

• Specifying VPN Settings and PE-CE Settings Information on page 538

Specifying General Settings

You configure general information about the service order in theGeneral Settings section

of the Enter Order Information window.

If a service template is attached to the servicedefinition, a link to that template is provided

at thebottomof theEndpointSettings sectionof thewindow.For instructionsonworking
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with service templates in service orders, see “Creating aServiceOrder Based on aService

Definition with a Template” on page 564.

Youmust add the customer to the database before proceeding. See “Adding a New

Customer” on page 709.

To enter general settings information:

1. In the Name field, type a unique name for the full mesh service.

The service order name can consist of only letters, numbers, periods, hyphens, and

underscores.

NOTE: Thenameyou specify for a Layer 3VPNservice order becomes the
routing-instance name in the device configuration when you deploy the
service.Consequently, youcannotuseany JuniperNetworkskeywords—for
example, “bgp” or “ospf”—as the name of a service order.

2. In the Customer field, select the customer who is requesting the service.

3. In the Comments field, type a description of the service.

Thisdescriptionappears in informationwindowsabout the requestor service instance

created from the request.

4. Select theEnableMVPNcheckbox toenablemulticast virtualprivatenetwork (MVPN).

5. Select theEnableMCLAGcheckbox toenable themultichassis linkaggregationgroup.

If you select this check box, the Enable MVPN check box is disabled.

For more information about multichassis link aggregation groups (MC-LAGs), see

“Multichassis Link Aggregation Group Overview” on page 43.

Specifying QoS Settings

If you have selected the Enable QoS check box in the selected service definition, you

must configure QoS settings.

537Copyright © 2015, Juniper Networks, Inc.

Chapter 12: Service Provisioning: Managing Layer 3 VPN Service Orders



To configure QoS settings:

1. In theQoS profile field, select a profile from the list.

TheQoS profile list displays the QoS profiles that are currently configured in the QoS

Design software.

AQoSprofile classifies traffic into defined service groups to provide special treatment

of traffic across the network service.

2. In the CIR field, select the committed information rate (CIR) from the list.

The CIR is the guaranteed rate, which specifies the minimum bandwidth available if

all sources are active at the same time. Make sure that the CIR value is less than the

PIR value.

NOTE: For bursty traffic, the CIR represents the average rate of traffic per
unit time and the PIR represents themaximumamount of traffic that can
be transmitted in a given interval.

3. In the PIR field, select the peak information rate (PIR) from the list. The PIR is the

shaping rate.

NOTE: If the QoS profile that you selected in Step 1 is configured with a
level-three scheduler and interface oversubscription is enabled, then PIR
is not used.

Specifying VPN Settings and PE-CE Settings Information

You configure VPN attributes that are usually common for all endpoints in the service.

The values that youprovide vary, dependingon the service definition onwhich the service

order is based.

If you do not expect these attributes to be the same on all endpoints, you can set them

to be the same for now and thenmake changes later, or you can skip this step and apply

the attribute values one at a time later.
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To set attributes common tomost endpoints on a service:

1. In theMTU (Bytes) field, specify the maximum transmission unit size for the UNI.

This field is present in all service orders. However, you can set this field only if the

service definition allows you to do so.

2. Specify theMTU Factor or Burst Period, based on the Calculate Burst Size you have

selected in the service definition.

NOTE: You cannot edit these fields if you have not selected the Editable

in Service Order check box in the service definition.

3. Select the bandwidth from the Bandwidth list. The Bandwidth Range and Bandwidth

fields appear only if you have cleared theEnableQoS check box in the selected service

definition:

NOTE: You cannot edit these fields if you have not selected the Editable

in Service Order check box in the service definition.

4.

NOTE: The fields specified in the Logical IF Settings section are based on
the Ethernet option type. The Logical IF Settings section is not available if

you have selected the Ethernet option as Port.
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Specify whether the Autopick UNIT ID can be selected automatically or manually.

• To assign the UNIT ID automatically, select the Autopick UNIT ID check box.

• To assign the UNIT IDmanually, clear the Autopick UNIT ID check box.

The window expands to include the UNIT ID field. In the UNIT ID field, type a value.

Range: 1 through 1073741823

NOTE: You can edit this field only if you have selected the Editable in

Service Order check box for the VLAN ID selection in the service definition.

5. Specify whether the Autopick VLAN ID can be selected automatically or manually.

• To assign the VLAN ID automatically, select the Autopick VLAN ID check box.

• To assign the VLAN IDmanually, clear the Autopick VLAN ID check box.

Thewindow expands to include the VLAN ID field. In the VLAN ID field, type a value.

NOTE: You cannot edit this field if you have not selected the Editable in

Service Order check box in the service definition.

6. Specifywhether theAutopickRoute target canbe selected automatically ormanually.

• To assign the Route Target automatically, select the Autopick Route target check

box.

• To assign the Route Target, clear the Autopick Route target check box.

The window expands to include the Route Target field. In the Route Target field,

type a value.

NOTE: For Hub-and-Spoke service order, clear the Autopick Hub Route

Target andAutopick SpokeRoute Target check boxes to activate theHub

Route Target and Spoke Route Target fields, respectively.

When youmanually type a route target, JunosSpace accepts either of the following

two formats:

• prefix-number:assigned-number

Where prefix-number can be any numeric value from 1 through 65,535. The

assigned-number can be any numeric value from 0 through 2,147,483,647.

• IPV4-address:assigned-number

Where IPV4-address can be any valid IPv4 address, and assigned-number can be

any numeric value from 0 through 65,535.
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NOTE: You cannot edit this field if you have not selected the Editable in

Service Order check box in the service definition.

7. Specify whether the Autopick VLAN ID can be selected automatically or manually.

• To assign the Route distinguisher automatically, select the Autopick Route

Distinguisher check box.

• To assign the Route distinguishermanually, clear the Autopick Route Distinguisher

check box.

The window expands to include the Route distinguisher field. In the Route

distinguisher field, type a value.

When youmanually type route distinguishers, Junos Space accepts either of the

following two formats:

• prefix-number: assigned-number

Where prefix-number can be any numeric value from 1 through 65,535. The

assigned-number can be any numeric value from 0 through 2,147,483,647.

• IPV4-address: assigned-number

Where IPV4-address can be any valid IPv4 address, and assigned-number can be

any numeric value from 0 through 65,535.

NOTE: You cannot edit this field if you have not selected the Editable in

Service Order check box in the service definition.

8. To configure a separate label for each VRF to provide double lookup and egress

filtering, select the VRF Table label check box.

NOTE: You cannot edit this field if you have not selected the Editable in

Service Order check box in the service definition.

The Export Direct Routes check box is not editable in the service order.

9. Specify whether a service provider can create static routes on the service.

• To allow the service provisioner to create static routes on the service, select the

Static Route check box.

• To prevent the service provisioner from creating static routes on the service, clear

the Static Route check box.

10. IfBGProutingprotocol is specified in the service definition, specifywhether the service

provider can override the AS number.

• To allow the service provisioner to override the AS number, select the AS override

check box.
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• To prevent the service provisioner from overriding the AS number, clear the AS

override check box.

IfOSPF routing protocol is specified in the service definition, in theOSPF domain ID

field, specify any valid IPv4 address.

Range: 1.0.0.1 through 223.255.255.254, excluding 127.x.x.x

11. Click Next.

The Select Endpoint PE Deviceswindow appears.

Selecting N-PE Devices

In this topic you select theN-PE devices that youwant to host the service endpoints. The

selection is made from the Select Endpoint PE Deviceswindow.

NOTE: The Select Endpoint PE Deviceswindow shows only assigned N-PE

devices that have an AS number configured. If you do not see the device you
are looking for, use theCLIon thedevice tocheck forandassignanASnumber.

N-PE devices that have L2VPN only do not appear.

To select endpoint N-PE devices:

1. In the Select Endpoint PE devices window, select the devices that you want to

participate in the service. You can select more than one device.

2. Click Next.

The Endpoint Settingswindow appears.

Setting Attributes for UNI Endpoints

If a service template is attached to the service definition, there is a link to that template

at thebottomof theEndpointSettings sectionof thewindow.For instructionsonworking

with service templates in service orders, see “Creating aServiceOrder Based on aService

Definition with a Template” on page 564.

You set attributes for each endpoint in the service from the Endpoint Settings window.
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The interface shown in the UNI Interface field is automatically selected by the Network

Activate software, which chooses theUNI that has the highest available capacity among

interfaces that are in the Up state. To calculate the available capacity of the interface,

the system subtracts the bandwidth reserved for each service deployed on that interface

from the total capacity of the interface.

For each endpoint, the Endpoint Settingswindowshows the value for eachUNI attribute.

If you have selected the Enable MC- LAG check box in the General Settings section, the

Stitching point check box is available for each endpoint. If you select this check box, all

the parameters of that endpoint are disabled.

To configure or change the endpoint settings:

1. Make sure the Stitching point check box is not selected.

2. Toadd the loopback interface for a Layer 3 VPN service, select theSet loopback check

box.

NOTE: If you provision a loopback interface for an L3VPN service, an
operator is able to identify a VRF routing instance. Thereafter, an operator
canmanually ping a remote CE router from a local PE router.

3. Select a value for Ethernet option:

• Port

• Dot1Q

Specifying the Dot1Q Ethernet option enables you to apply a Unit ID, a single VLAN

ID, a VLAN Range, or a VLAN list to the service order.

• QinQ
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Specifying theQinQ Ethernet option enables you to apply a single VLAN, a VLAN

Range, or a VLAN list to the service order. For an L3VPN service deployed on a dual

tagged interface, the inner tag determines the VPN routing and forwarding

instance(VRF).

• Flexible UNI

Specifying the Flexible UNI Ethernet option enables you to apply different values

for the Unit ID and vlan-tags.

NOTE: Prior to release 13.1P6.1,NetworkActivate set theunit andvlan-id
parameters to the same value.

To create a service order that specifies the Flexible UNI Ethernet option, youmust

complete two preliminary tasks. First youmust create a service template in which

you specify both outer and inner vlan tags. Then youmust create a service definition

that associates the service template with the service definition.

See “Creating a Service Template” on page 409

When you create a service order based on a service definition with which a service

template is associated, the Add Endpoints window includes a link labeled Flexible

Service Attributes. If you click the link, the you can specifyOuter and Inner vlan-tags

in the Flexible Service Attributeswindow.

4. To select a different UNI on a device, click the UNI name you want to change and

choose another interface from the list.
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NOTE: If you have selected the Enable MC-LAG check box in the General

Settings window, the UNI interface field displays integrated routing and

bridging (IRB) interfaces along with the other interfaces.

5. In the UNI interface, if you select the integrated routing and bridging (IRB) interface

theMC LAG Interface field is displayed. Select an interface for MC LAG.

6. In the UNI Description, provide a description for the selected UNI interface.

The Description field is displayed in Modify Service Order, View Service Order Details,

Modify Service, and View Service windows. You can edit this field while modifying a

Layer 3 VPN service order or service.

Range: 0 through 128 characters

7. Specifying the Logical IF Settings:

NOTE: The fields specified in the Logical IF Settings section are based on
the Ethernet option type. The Logical IF Settings section is not available if

you have selected the Ethernet option as Port.

• If you have selected the Ethernet option as Dot1Q, or,QinQ, or Flexible UNI, specify

whether the Autopick UNIT ID can be selected automatically or manually.

• To assign the UNIT ID automatically, select the Autopick UNIT ID check box.

• To assign the UNIT IDmanually, clear the Autopick UNIT ID check box.

Thewindowexpands to include theUNIT ID field. In theUNIT ID field, type a value.

Range: 1 through 1073741823

NOTE: The unit ID value that you have specified in the Enter Order
Information page is displayed in the UNIT ID field.

• If you have selected the Ethernet option as Dot1Q, or,QinQ, or Flexible UNI, specify

whether the Autopick VLAN ID can be selected automatically or manually.

• To assign the VLAN ID automatically, select the Autopick VLAN ID check box.

• To assign the VLAN IDmanually, clear the Autopick VLAN ID check box.

The window expands to include the VLAN ID field. In the VLAN ID field, type a

value.

NOTE: The unit ID value that you have specified in the Enter Order
Information page is displayed in the UNIT ID field.

• If you have selected the Ethernet option asQinQ, select the Customer VLAN Type.
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If the Customer VLAN type is Transport all traffic, selectOuter Tag Protocol ID.

If the Customer VLAN type is Transport single vlan, select Customer VLAN, Inner Tag

Protocol ID, andOuter Tag Protocol ID.

NOTE: You can optionally specify Inner Tag Protocol ID andOuter Tag

Protocol ID.

8. Clear or select the Autopick interface IP check box.

• To specify the Interface IP address, clear the Autopick interface IP check box.

• To specify the IP address pool and IP block size, select the Autopick interface IP

check box.

If you have selected the EnableMC- LAG check box in the General Settings window,

the maximum andminimum values for IP block size are 29 and 28 respectively.

NOTE: You cannot edit the Autopick interface IP check box if you have

not selected the Editable in Service Order check box in the service

definition.

9. Clear the Autopick VLAN ID check box to specify VLAN ID.

10. Select Routing protocol type.

• If Routing protocol type is BGP, specify the following information:

• Neighbor IP address

NOTE: Youneed toclear theAutopickneighbor IPcheckbox to specify

Neighbor IP address.

• Peer AS

• If Routing protocol type isOSPF, specify the following information:

• OSPF area ID—Specify any valid IPv4 address.

Range: 0.0.0.0 through 225.255.255.255

• OSPF version—Select the OSPF version from the list.

11. If you have attached a service template to the service definition, the Flexible Service

Attributes link appears. Click the link to modify the service template attributes. For

more informationabout configuring flexible serviceattributes, see “ConfiguringFlexible

Service Attributes to Modify Service Template Attributes” on page 484.

12. If you have selected the Enable QoS check box in the service definition, specify the

following fields:
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• CIR

• PIR

• MTU(Bytes)

• QoS Profile

If you have cleared the Enable QoS check box in the service definition, specify the

following fields:

• Bandwidth

• Default MTU

Formore informationabout these fields, see “CreatingaFullMeshLayer3VPNService

Definition” on page 257.

13. When you have finished configuring the endpoint settings, click Create.

The Deployment Options window appears.

Adding, Deleting, andModifying Endpoints

You can add or delete UNI interfaces on the PE devices that participate in a service:

To add a UNI interface on a selected device:

1. Select the AddUNI Interface icon in the Actions column, and then select the interface

you want from the UNI interface list.

2. If the interface you selected in the previous step is already configured (duplicate),

either type a different value in theVLAN ID fieldmanually or select theAutopick VLAN

ID check box.

To delete a UNI interface from a selected device:

• In the Actions column, click the Delete UNI Interface icon in the Actions column.

If the deleted UNI is the only UNI selected from the device, then the device is deleted

from the service configuration.

You can set or modify attributes for a UNI endpoint.

Tomodify a UNI interface for a selected device:

1. Select the row for the UNI endpoint that you want to modify.

UNI Settings appears on the right side of the window.

2. Modify the UNI Settings fields in the right pane.

3. Either apply the attributes you already specified ormodify the attributes for other UNI

endpoints:

• To apply the attributes to the UNI interface, select Save.
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• To save your changes andmodify attributes for other UNI endpoints on the service,

select AddMore.

4. When you have finishedmodifying the endpoint settings, click Create.

The Deployment Optionswindow appears.

The service order that you have created is graphically represented in the topology. To

view the service order that you have created in the topology, select Platform > Network

Monitoring > Topology > Service > NA service order name.

For more information on topology, see the “Junos Space Network Topology Overview”

on page 40.

Deploying the New Service

To deploy the service:

1. From the Deployment Optionswindow, perform one of these actions:

• To save the request without deploying the service, select Save only and then click

OK.

See “Deploying aService” on page 467 for information about how to deploy a saved

service at a later time.

• To deploy the service immediately, select Deploy now and then clickOK.

• To deploy the service later, select Schedule deployment, select a date and time,

and then clickOK.

The time field specifies the time kept by the server, but in the time zoneof the client.

• To validate the service, click Validate.

The Job ID dialog box appears.

2. Click the Job ID link to monitor the status of the service deployment.

The Deployment Service job appears on the Platform > Jobs > JobManagement

inventory page.

3. To view the Deploy Service Order username, user IP address, task, timestamp,

description, and job ID, selectPlatform>Audit Logs>Audit Log inventory page to view

the Deploy Service Order username, user IP address, task, timestamp, description,

and job ID.

The service order is now complete.

TheManage Service Orders inventory view shows the service order you just added. See

Viewing Jobs in the JunosSpaceNetworkApplicationPlatformUserGuide for details about

the Jobs workspace.

Related
Documentation

Viewing Jobs in the Junos Space Network Application Platform User Guide•

• Viewing Service Orders on page 765

• Service Attributes Overview on page 20
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• Adding a New Customer on page 709

• Deploying a Service on page 467

• Force-Deploying a Service on page 468

• Creating a Service Order Based on a Service Definition with a Template on page 564

Creating a Hub-and-Spoke Layer 3 VPN Service Order

The Network Activate Service can configure and deploy Layer 3 VPN hub-and-spoke

service orders. Creating a service order involves the following tasks:

1. Selecting the Service Definition on page 549

2. Entering Order Information on page 549

3. Selecting Endpoint PE Devices on page 555

4. Configuring Endpoint Settings on page 555

5. Setting Attributes for UNI Endpoints on page 555

6. Adding, Deleting and Modifying Endpoints on page 560

7. Deploying the New Service on page 560

Selecting the Service Definition

To select a service definition on which to base the new service order:

1. Select Service Provisioning >Manage Service Orders > Create L3 VPN Service Order.

TheSelect ServiceDefinition page appears and shows a filtered inventory view of only

thosepublishedservicedefinitionsdesigned toworkwithLayer3VPNhub-and-spoke

Ethernet services.

2. Select the service definition you want to base your service order on, and then click

Next.

Youmust select only thosepublished servicedefinitions configured toworkwith Layer

3 VPN hub-and-spoke services. See “Selecting a Published L3VPN Service Definition

for a Service Order” on page 561.

The Enter Order Information screen appears.

Entering Order Information

Thispart of the createaLayer 3VPNhub-and-spoke serviceorder procedure sets general

settings, VPN settings that can be applied to all end points, and routing protocol settings

for the PE and CE devices.
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Youmust enter the service order general settings, VPN settings, and PE-CE settings on

the Enter Order Information page. See “Entering Layer 3 VPN Order Information” on

page 561.

• Entering General Settings Information on page 550

• Specifying QoS Settings on page 550

• Entering VPN Settings and PE-CE Settings Information on page 551

Entering General Settings Information

This part of the create Layer 3VPNhub-and-spoke Ethernet service order procedure sets

general informationabout the serviceorder in theGeneral Settingsboxof theEnterOrder

Information screen.

Enter the following information:

1. In the Name field, enter a unique name for the hub-and-spoke service.

The service order name can consist of only letters, numbers, periods, hyphens, and

underscores.

NOTE: Thenameyou specify for a Layer 3VPNservice order becomes the
routing-instance name in the device configuration when you deploy the
service.Consequently, youcannotuseany JuniperNetworkskeywords—for
example, “bgp” or “ospf”—as the name of a service order.

2. In the Customer field, select the customer who is requesting the service.

If the customer is not in the list, you must add the customer to the database before

proceeding. See “Adding a New Customer” on page 709.

3. In the Comments field, enter a description of the service. This description appears in

information screens about the request or service instance created from the request.

You cannot change the Route Target field. Route targets are always selected

automatically.

Specifying QoS Settings

If you have selected theEnableQoS check box in the selected service definition, youmust

configure QoS settings.
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To configure QoS settings:

1. In theQoS profile field, select a profile from the list.

TheQoS profile list displays the QoS profiles that are currently configured in the QoS

Design software.

AQoSprofile classifies traffic into defined service groups to provide special treatment

of traffic across the network service.

2. In the CIR field, select the committed information rate (CIR) from the list.

The CIR is the guaranteed rate, which specifies the minimum bandwidth available if

all sources are active at the same time. Make sure that the CIR value is less than the

PIR value.

NOTE: For bursty traffic, the CIR represents the average rate of traffic per
unit time and the PIR represents themaximumamount of traffic that can
be transmitted in a given interval.

3. In the PIR field, select the peak information rate (PIR) from the list. The PIR is the

shaping rate.

NOTE: If the QoS profile that you selected in Step 1 is configured with a
level-three scheduler and interface oversubscription is enabled, then PIR
is not used.

Entering VPN Settings and PE-CE Settings Information

This part of the create Layer 3 VPN full mesh Ethernet service order procedure sets VPN

attributes that are usually common for all endpoints in the service. The values that you

enter will vary, depending on the service definition on which the service order is based.

If these attributeswill not be the sameon all endpoints, you can set them to be the same

for now and thenmake changes later, or you can choose to skip this step and apply the

attribute values one at a time later.
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To set attributes common tomost endpoints on a service:

1. In theMTU (Bytes) field, specify the maximum transmission unit size for the UNI.

This field is present in all service orders. However, you can set this field only if the

service definition allows you to do so.

2. Specify theMTU Factor or Burst Period, based on the Calculate Burst Size you have

selected in the service definition.

NOTE: You cannot edit these fields if you have not selected the Editable

in Service Order check box in the service definition.

3. Select the bandwidth from the Bandwidth list. The Bandwidth Range and Bandwidth

fields appear only if you have cleared theEnableQoS check box in the selected service

definition:

NOTE: You cannot edit these fields if you have not selected the Editable

in Service Order check box in the service definition.
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4.

NOTE: The fields specified in the Logical IF Settings box are based on the
Ethernet option type. The Logical IF Settings box is not available if you

have selected the Ethernet option as Port.

Specify whether the Autopick UNIT ID can be selected automatically or manually.

• To assign the UNIT ID automatically, select the Autopick UNIT ID check box.

• To assign the UNIT IDmanually, clear the Autopick UNIT ID check box.

The window expands to include the UNIT ID field. In the UNIT ID field, type a value.

Range: 1 through 1073741823

NOTE: You can edit this field only if you have selected the Editable in

Service Order check box for the VLAN ID selection in the service definition.

5. Clear the Autopick VLAN ID check box if you want the VLAN ID chosen automatically

by the Network Activate software. Select the check box to have the ID assigned

manually.

NOTE: You cannot edit this field if you have not selected the Editable in

Service Order check box in the service definition.

Tomanually assign a VLAN ID:

1. Clear the Autopick VLAN ID check box. The screen expands to include the VLAN ID

field.

2. In the VLAN ID field, enter a value.

6. Select the Autopick Hub Route Target and Autopick Spoke Route Target check boxes

if you want the Route target chosen automatically by the Network Activate software.

NOTE: You cannot edit this field if you have not selected the Editable in

Service Order check box in the service definition.

Tomanually assign a Route target:

1. Clear theAutopickHubRoute Target andAutopick SpokeRoute Target check boxes

to activate the Hub Route Target and Spoke Route Target fields respectively.

2. In the Route Target field, enter a value.

When youmanually enter route target, JunosSpace accepts either of the following

two formats:

• <prefix-number>: <assigned-number>
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Where <prefix-number> can be any numeric value from 1 to 65535, inclusive.

The <assigned-number> can be any numeric value from 0 to 2,147,483,647,

inclusive.

• <IPV4-address>: <assigned-number>

Where<IPV4-address>canbeanyvalid IPV4address (inW.X.Y.Z "dot"notation),

and <assigned-number> can be any numeric value from 0 to 65535, inclusive.

7.

8. Select theAutopickHubRouteDistinguisherand theAutopickSpokeRouteDistinguisher

check boxes if youwant the Route distinguisher chosen automatically by theNetwork

Activate software.

Tomanually assign a Route distinguisher:

1. Clear the Autopick Hub Route Distinguisher and the Autopick Spoke Route

Distinguisher check boxes to activate theHubRoute distinguisher and SpokeRoute

distinguisher fields respectively.

2. In the Route distinguisher field, enter a value.

When youmanually enter route distinguishers, Junos Space accepts either of the

following two formats:

• <prefix-number>: <assigned-number>

Where <prefix-number> can be any numeric value from 1 to 65535, inclusive.

The <assigned-number> can be any numeric value from 0 to 2,147,483,647,

inclusive.

• <IPV4-address>: <assigned-number>

Where<IPV4-address>canbeanyvalid IPV4address (inW.X.Y.Z "dot"notation),

and <assigned-number> can be any numeric value from 0 to 65535, inclusive.

9. To configure a separate label for each VRF to provide double lookup and egress

filtering, select the VRF Table label check box

NOTE: You cannot edit this field if you have not selected the Editable in

Service Order check box in the service definition.

The Export Direct Routes check box is not editable in service order.

10. In the PE-CE Settings box, select the Static Route check box if you want to allow a

service provisioner to create static routes on the service. Clear the Static Route check

box to prevent a service provisioner from creating static routes on the service.

11. IfBGProutingprotocol is specified in theservicedefinition, select theASoverridecheck

box to allow a service provisioner to override the AS number. Clear the AS override

check box to prevent a service provisioner from overriding the AS number.

IfOSPF routing protocol is specified in the service definition, in theOSPF domain ID

field, specify any valid IPV4 address inW.X.Y.Z "dot" notation.
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Range: 1.0.0.1 through 223.255.255.254, excluding 127.x.x.x

12. Click Next.

The Select Endpoint PE Devices screen appears.

Selecting Endpoint PE Devices

Youmust select the endpoint PE devices that you want to participate in the service. See

“Selecting Endpoint PE Devices” on page 563.

Configuring Endpoint Settings

This part of the create multipoint Ethernet service order procedure selects the N-PE

devices thatwill host theserviceendpoints.Theselection ismade fromtheSelectEndpoint

PE Devices screen.

NOTE: The Select Endpoint PE Devices screen shows only assigned NPE

devices that have an AS number configured. If you do not see the device you
are looking for, use theCLIon thedevice tocheck forandassignanASnumber.

N-PE devices that have L2VPN only will not appear.

To select endpoint N-PE devices: For instructions on working with service templates in

service orders, see “Creating a Service Order Based on a Service Definition with a

Template” on page 564.

1. In theSelectEndpointPEdevices screen, select thedevices that youwant toparticipate

in the service. Use the multiple selection feature to select more than one device.

2. Click Next.

The Endpoint Settings screen appears.

Setting Attributes for UNI Endpoints

If there is a service template attached to the service definition, there is a link to that

template at the bottom of the Endpoint Settings section of the screen. For instructions

on working with service templates in service orders, see “Creating a Service Order Based

on a Service Definition with a Template” on page 564.
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This part of the create Ethernet service order procedure sets the attributes for each

endpoint in the service. Selection is made using the Endpoint Settings screen.

The interface shown in the UNI Interface field is automatically selected by the Network

Activate software, which chooses theUNI that has the highest available capacity among

interfaces that are in the Up state. To calculate the available capacity of the interface,

the system subtracts the bandwidth reserved for each service deployed on that interface

from the total capacity of the interface.

For each endpoint, the Endpoint Settings screen shows the value for each UNI attribute.

To configure or change the endpoint settings:

1. Toadd the loopback interface for a Layer 3 VPN service, select theSet loopback check

box.

NOTE: If you provision a loopback interface for an L3VPN service, an
operator is able to identify a VRF routing instance. Thereafter, an operator
canmanually ping a remote CE router from a local PE router.

2. Select a value for Ethernet option.

• Port

• Dot1Q

Specifying the Dot1Q Ethernet option enables you to apply a Unit ID, a single VLAN

ID, a VLAN Range, or a VLAN list to the service order.

• QinQ

Specifying theQinQ Ethernet option enables you to apply a single VLAN, a VLAN

Range, or a VLAN list to the service order. For an L3VPN service deployed on a dual
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tagged interface, the inner tag determines the VPN routing and forwarding

instance(VRF).

• Flexible UNI

Specifying the Flexible UNI Ethernet option enables you to apply different values

for the Unit ID and vlan-tags.

NOTE: Prior to release 13.1P6.1,NetworkActivate set theunit andvlan-id
parameters to the same value.

To create a service order that specifies the Flexible UNI Ethernet option, youmust

complete two preliminary tasks. First youmust create a service template in which

you specify both outer and inner vlan tags. Then youmust create a service definition

that associates the service template with the service definition.

See “Creating a Service Template” on page 409

When you create a service order based on a service definition with which a service

template is associated, the Add Endpoints window includes a link labeled Flexible

Service Attributes. If you click the link, the you can specifyOuter and Inner vlan-tags

in the Flexible Service Attributeswindow.

3. To select a different UNI on a device, click the UNI interface and choose another

interface from the list.

4. In the UNI Description, you can enter the description for the selected UNI interface.

The Description field is displayed in Modify Service Order, View Service Order Details,
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Modify Service, and View Service windows. You can edit this field while modifying a

Layer 3 VPN service order or service.

Range: 0 through 128 characters

5. Specifying the Logical IF Settings:

NOTE: The fields specified in the Logical IF Settings box are based on the
Ethernet option type. The Logical IF Settings box is not available if you

have selected the Ethernet option as Port.

• If you have selected the Ethernet option as Dot1Q, or,QinQ, or Flexible UNI, specify

whether the Autopick UNIT ID can be selected automatically or manually.

• To assign the UNIT ID automatically, select the Autopick UNIT ID check box.

• To assign the UNIT IDmanually, clear the Autopick UNIT ID check box.

Thewindowexpands to include theUNIT ID field. In theUNIT ID field, type a value.

Range: 1 through 1073741823

NOTE: The unit ID value that you have specified in the Enter Order
Information page is displayed in the UNIT ID field.

• If you have selected the Ethernet option as Dot1Q, or,QinQ, or Flexible UNI, specify

whether the Autopick VLAN ID can be selected automatically or manually.

• To assign the VLAN ID automatically, select the Autopick VLAN ID check box.

• To assign the VLAN IDmanually, clear the Autopick VLAN ID check box.

The window expands to include the VLAN ID field. In the VLAN ID field, type a

value.

NOTE: The unit ID value that you have specified in the Enter Order
Information page is displayed in the UNIT ID field.

• If you have selected the Ethernet option asQinQ, select the Customer VLAN Type.

If the Customer VLAN type is Transport all traffic, select theOuter Tag Protocol ID.

If the Customer VLAN type is Transport single vlan, select the Customer VLAN, Inner

Tag Protocol ID, andOuter Tag Protocol ID.

NOTE: You can optionally specify Inner Tag Protocol ID andOuter Tag

Protocol ID.

6. Clear the Autopick interface IP check box to specify the Interface IP address.
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Select the Autopick interface IP check box to specify the IP address pool and IP block

size.

NOTE: You cannot edit the Autopick interface IP check box if you have not

selected the Editable in Service Order check box in the service definition.

7. Select the Routing protocol type.

If the Routing protocol type is BGP, specify the following information:

• Neighbor IP address

NOTE: You need to clear the Autopick neighbor IP check box to specify

the Neighbor IP address.

• Peer AS

If the Routing protocol type isOSPF, specify the following information:

• OSPF area ID-–Specify any valid IPV4 address inW.X.Y.Z "dot" notation.

Range: 0.0.0.0 through 225.255.255.255

• OSPF version-–Select the OSPF version from the list.

8. If you have attached a service template in the service definition, the Flexible Service

Attributes link appears. Click the link to modify the service template attributes. For

more information about configuring the flexible service attributes, see “Configuring

Flexible Service Attributes to Modify Service Template Attributes” on page 484.

9. If you have selected the Enable QoS check box in the service definition, specify the

following fields:

• CIR

• PIR

• MTU(Bytes)

• QoS Profile

If you have cleared the Enable QoS check box in the service definition, specify the

following fields:

• Bandwidth

• Default MTU

For more information about these fields, see “Creating a Hub-and-Spoke (One

Interface) Layer 3 VPN Service Definition” on page 264.

10.When you have finished configuring the endpoint settings, click Create.

The Deployment Options window appears.
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Adding, Deleting andModifying Endpoints

You can add or delete UNI interfaces on the PE devices that participate in a service.

1. To add a UNI on a selected device, select the Add UNI Interface icon in the Actions

column, and then select the interface you want from the UNI interface list.

2. If the interface you selected in the previous step is already configured (duplicate) you

must either enter adifferent value in theVLAN ID fieldmanually, or check theAutopick

VLAN ID field.

3. To delete a UNI from a device, in the Actions column, click the Delete UNI Interface

icon in the Actions column.

If the deleted UNI is the only UNI selected from the device, then the device is deleted

form the service configuration.

4. To set or modify attributes for a UNI endpoint:

a. Select the row for the UNI endpoint that you want to modify.

A UNI Settings dialog box appears on the right side of the screen.

b. Modify the fields in right pane.

c. Select Save to apply the attributes to the UNI interface, or select AddMore to save

your changes andmodify attributes for other UNI endpoints on the service.

5. When you have finishedmodifying the endpoint settings, click Create.

The Deployment Optionswindow appears.

The service order that you have created is graphically represented in the topology. To

view the serviceorder that youhavecreated in the topology, selectPlatform>Network

Monitoring > Topology > Service > NA service order name.

For more information on topology, see “Junos Space Network Topology Overview” on

page 40

Deploying the New Service

This part of the create multipoint Ethernet service order procedure deploys the service.

To deploy the service, make selections from the Deployment Optionswindow.

1. Perform one of these actions:

• To save the request without deploying the service, select Save only and then click

OK.

See “Deploying aService” on page 467 for information about how to deploy a saved

service at a later time.

• To deploy the service immediately, select Deploy now and then clickOK.

• To deploy the service later, select Schedule deployment, select a date and time,

and then clickOK.
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The time field specifies the time kept by the server, but in the time zoneof the client.

• To validate the service, click Validate.

The Job ID dialog box appears.

2. Click the Job ID link to monitor the status of the service deployment.

The Deployment Service job appears on the Platform > Jobs > JobManagement

inventory page.

3. You can also view the Platform > Audit Logs > Audit Log inventory page to view the

Deploy Service Order username, user IP address, task, timestamp, description, and

job ID.

The service order is now complete.

TheManage Service Orders inventory view shows the service order you just added. See

Viewing Jobs in the JunosSpaceNetworkApplicationPlatformUserGuide for details about

the Jobs workspace.

Selecting a Published L3VPN Service Definition for a Service Order

To select a service definition on which to base the new service order:

1. In theNetworkActivate task pane, selectServiceProvisioning>ManageServiceOrders

> Create L3 VPN Service Order.

The Select Service Definition inventory page displays a view of only those published

service definitions designed to work with Layer 3 VPN Ethernet services you need.

2. Select the service definition you want to base your service order on, then click Next

to display the Enter Order Informationwindow.

Related
Documentation

Entering Layer 3 VPNOrder Information

You, the Service Activator must set settings for a L3 VPN service order, including general

settings, VPN settings that are applied to all end points, and routing protocol settings

for the PE and CE devices.

1. Setting General Settings on page 561

2. Entering VPN Settings Information on page 562

3. Entering PE-CE Settings on page 563

Setting General Settings

Before You Begin
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• Youmust add the customer to the database that requested the service order before

proceeding. See “Adding a New Customer” on page 709.

Youmust specify the following general informationabout the service order in theGeneral

Settings box of the Enter Order Information page:

1. In the Name field, enter a unique name for the Layer 3 VPN service.

The service order name can consist of only letters, numbers, and underscores. It must

be no longer than 50 characters.

NOTE: Thenameyou specify for a Layer 3VPNservice order becomes the
routing-instance name in the device configuration when you deploy the
service. Consequently, you cannot use any Juniper Networks keywords,
for example, “bgp” or “ospf”, as the name of a service order.

2. In the Customer drop-down list box, select the customer who requested the service.

If the customer is not in the list, you must add the customer to the database before

proceeding. See “Adding a New Customer” on page 709.

3. In theComments field, enter adescriptionof the serviceno longer than200characters.

This description appears in information screens about the request or service instance

created from the request.

You cannot change the Route Target field. Route targets are always selected

automatically.

Entering VPN Settings Information

Youmust set VPNattributes that are usually common for all the endpoints in the service.

The values that you enter vary, depending on the service definition on which the service

order is based.

If these attributeswill not be the sameon all endpoints, you can set them to be the same

for now and thenmake changes later, or you can choose to skip this step and apply the

attribute values one at a time later.

To set attributes common tomost endpoints on a service:

1. In the VPN Settings box, the Apply to all check box is selected by default. If the Apply

to all option is selected, you enter the endpoint parameter values only once. If you

clear the Apply to all check box and enter all the endpoint attributes individually later.

2. The Autopick VLAN ID option is automatically selected for Network Activate to

automatically chose the VLAN ID. Deselect the check box if you want to manually

assigned the VLAN ID.

The VLAN ID text box appears.

3. If you deselected the Autopick VLAN ID option, enter a value in the VLAN ID field.
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4. The Autopick Route Target option is selected, and you cannot deselect it. Network

Activate automatically selects the route target.

5. The Autopick Route Distinguisher option is selected, and you cannot deselect it.

6. The Autopick Interface IP Address option is selected, and you cannot deselect it.

Network Activate automatically selects the interface IP address.

7. The VRF Table label option is selected, and you cannot deselect it. Network Activate

automatically selects the interface IP address.

Entering PE-CE Settings

In thePE-CESettings box, depending on the PE-CE routing protocol—OSPF/Static Route

or BGP/Static Route—do one of the following:

• If BGP/Static Route routing protocol is specified in the service definition:

a. The AS override option is selected to allow a service provisioner to override the AS

number. Clear the AS override check box to prevent a service provisioner from

overriding the AS number.

b. Enter a value for the maximum number of prefixes accepted by a PE router from a

CE router.

• IfOSPF/Static Route routing protocol is specified in the service definition, in theOSPF

domain ID field, enter a IP address.

You can enter from 1.0.0.1 to 223.255.255.254. excluding 127.x.x.x.

1. Click Next.

The Select Endpoint PE Deviceswindow appears.

Selecting Endpoint PE Devices

NOTE: The Select Endpoint PE Deviceswindow shows only assigned NPE

devices that have an AS number configured. If you do not see the device you
are looking for, use theCLIon thedevice tocheck forandassignanASnumber.

N-PE devices that are L2VPN-only will not appear.

To select endpoint N-PE devices:

1. In the Select Endpoint PE Devices inventory list, select the devices that you want to

participate in the service. Use the multiple selection feature to select more than one

device.

2. Click Next to display the Endpoint Settings page.

The
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Related
Documentation

Creating a Service Order Based on a Service Definition with a Template

Creating a service order using a service definition with service templates attached to it

facilitates endpoint configuration.

Bymeansof a template, a number of service attributes identifiedby the service definition

designer can be not only applied as a group to one or more endpoints in a service order,

but also, in some cases, edited. Some attributes can only be set by service provisioners.

For this reason, servicedefinitiondesigners canmake these values editableby the service

provisioner during service order creation.

A service definition can havemultiple templates attached to it. If you use a definition

with more than one template, you are not obliged to apply the same settings to all

endpoints. You can create a service order in which each endpoint is configured using a

different template. In other words, each endpoint can use a subset of templates defined

in the service definition, and there, template choice is per service order.

Fromaserviceprovisioner’sperspective, theservice template takes the formofacollection

of flexible service attributes accessible through a link in the service order.

This topic describes how toworkwith a service template fromwithin a service order, that

is, while creating the service order.

These instructions assume that the service order is based on a service definition that has

at least one template attached to it. The instructions apply to a definition with multiple

templates, because the procedure for a definition with a single template is simpler.

To see if a definition has any templates before you begin creating a service order, view

thedetails of the definition on theSelectServiceDefinitionpageofCreate... ServiceOrder.

The presence or absence of an attached Service Template is indicated below Name and

Type.

To configure a service order based on a service definition with multiple templates:

1. To start creating a service order, follow the instructions in the topic listed below that

is relevant to your service order type :

• Creating a Point-to-Point Service Order on page 438

• Creating a Multipoint-to-Multipoint VPLS Service Order on page 491

• Creating a Point-to-Multipoint VPLS Service Order on page 507

• Creating a Full Mesh Layer 3 VPN Ethernet Service Order on page 536

• Creating a Hub-and-Spoke Layer 3 VPN Service Order on page 549

2. At the Endpoint Settings page, with an endpoint selected, make the appropriate

selection or enter the appropriate data (guidelines for this are in “Creating a

Point-to-Point Service Order” on page 438).
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3. Click Flexible Service Attributes.

TheFlexibleServiceAttributeswindowopens.On the left, underFlexibleConfiguration,

at the top level, are the names of the templates attached to the service definition.

Each template contains at least one page, which appears below the name of the

template. By default, such pages are called “Config Page 1.”

NOTE: We recommend you avoid using this default name: if multiple
pages all share the same name, the template editor could save the page
data wrongly.

Since template designers should group configuration options logically in pages, the

designer can also name a pagemore usefully, for example, “UNI Description.”

4. (Optional for a service definition containing multiple templates). Examine all the

attributes in all the templates to determine whether to apply all templates to all

endpoints. You can delete templates and add templates back at will.

5. To display and, if necessary, edit the attributes a page contains, select the page in the

panel on the left.

On the right, underneath the name of the page, appear the attributes on the selected

page of the template.

Usually the names of the attributes are ambiguous (for example, “description,”),

therefore youmustmouse over the field next to the name to see its context in the DMI

schema hierarchy.

6. For each page in each applicable template, make the appropriate changes in the field

on the right.

7. (Optional) If you determine that one of the templates contained in the definition is

superfluous, select it in the panel on the left.

The name of the first page of the template appears at the top of the panel on the

right.

8. Click the red “X” icon near the top of the panel on the left.

The template disappears.

NOTE: If you delete a template bymistake, you can add it again. Click the
green “+” icon.

The Add Template window appears, displaying a list of all the templates
previously deleted from the current endpoint’s group of flexible service
attributes.

Select the templates you want to add, and click Add Template.

The Flexible Service Attributes window reappears, displaying the newly
added templates
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9. When you have finished configuring the current endpoint’s group of flexible service

attributes, clickOK.

The Endpoint Settings page reappears.

10. (Optional) Repeat the preceding steps for other endpoints.

NOTE: Once a set of flexible service attributes has been deployed, it cannot
bemodified. However, you canmodify that set of flexible service attributes
toaddanewendpoint if youmodify the service (see, for example, “Modifying
a Point-to-Point Ethernet Service” on page 750 Find references to the other
topics relevant tomodifying under the rubric Related Documentation).

To verify your work:

1. Navigate toManageServices, select the service you deployed, and selectViewService

Configuration Change either from the Actions drawer, or from the right mouse-click

menu.

The Service Configurationwindow opens.

2. Select the appropriate device from the panel on the left.

If a template was deployed to the device, the Template Configuration tab appears to

the right of the Service Configuration tab.

3. Click the Template Configuration tab to display the configlet that was deployed as a

result of the template.

Related
Documentation

Service Templates Overview on page 406•

• Service TemplatesWorkflow on page 407

• Creating a Service Template on page 409

• Specifying Service-Specific Values on page 418

• Modifying a Service Template on page 417

• Modifying a Multipoint-to-Multipoint Ethernet Service on page 729

• Modifying a Point-to-Multipoint Ethernet Service on page 738

Deploying a Layer 3 VPN Service Order

Youmust deploy a service for it to run on devices in the network.

To deploy the service, make selections from the Deployment Optionswindow.

1. Perform one of these actions:
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• To save the request without deploying the service, select Save only and then click

OK.

See “Deploying aService” on page 467 for information about how to deploy a saved

service at a later time.

• To deploy the service immediately, select Deploy now and then clickOK.

• To deploy the service later, select Schedule deployment, select a date and time,

and then clickOK.

The time field specifies the time kept by the server, but in the time zoneof the client.

• To validate the service, click Validate.

The Job ID dialog box appears.

2. Click the Job ID link to monitor the status of the service deployment.

The Deployment Service job appears on the Platform > Jobs > JobManagement

inventory page.

3. You can also view the Platform > Audit Logs > Audit Log inventory page to view the

Deploy Service Order username, user IP address, task, timestamp, description, and

job ID.

Related
Documentation

Creating a Full Mesh Layer 3 VPN Ethernet Service Order on page 536•

• Creating a Hub-and-Spoke Layer 3 VPN Service Order on page 549
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Creating aMulticast VPN Service Order

This topic describes how to use the Network Activate application to create a Multicast

VPN (MVPN) service order.

NOTE: MulticastVPNservicesare supportedonLN2600,SRX550/650, and
MX devices only.

1. To select a service definition on which to base the new service order, in the Network

Activate taskpane, selectServiceProvisioning>ManageServiceOrders>CreateL3VPN

Service Order.

2. In the Select Service Definitionwindow, select the service definition upon which you

want to base your service order, then click Next.
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3. In the Enter Order Informationwindow, enter information in the relevant fields as

described in the following table:

DescriptionField

The service definition upon which this service order is based.Service Definition

Type a name for the service order.Name

Enter the customer for which you are creating the service order.Customer

Enter comments to describe the service order (optional).Comments

If selected, this check box indicates that the service order is intended to function in a
Multicast VPN. This check box is selected if it was selected in the service definition upon
which this service order is based.

MVPN

The VPN settings listed in this panel correspond to the settings selected in the service
definition upon which this service order is based.

VPN Settings

This check box is selected automatically if it was selected in the service definition upon
which this service order is based.

Autopick VLAN ID

This check box is selected automatically if it was selected in the service definition upon
which this service order is based.

Autopick Hub Route Target

This check box is selected automatically if it was selected in the service definition upon
which this service order is based.

Autopick Spoke Route Target

This check box is selected automatically if it was selected in the service definition upon
which this service order is based.

Autopick Hub Route Distinguisher

This check box is selected automatically if it was selected in the service definition upon
which this service order is based.

Autopick SpokeRouteDistinguisher

This check box is selected automatically if it was selected in the service definition upon
which this service order is based.

Autopick Interface IP Address

This check box is selected automatically if it was selected in the service definition upon
which this service order is based.

VRF Table Label

This check box is selected automatically if it was selected in the service definition upon
which this service order is based.

Export Direct Routes

PE-CE Settings

OSPF/Static Route–This routing protocol corresponds to the protocol selected in the
service definition upon which this service order is based.

Routing Protocol

This field is optional.

Range: 1.0.0.1 to 223.255.255.254 (excluding 127.x.x.x)

OSPF domain ID
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4. Click Next.

5. Select the device for which you want to implement the service order.

6. Click Next.

7. In theEndpointSettingswindow, enter informationasdescribed in the following table:

DescriptionField

Add Endpoints

Add the devices for which you intend to implement this service order.Device

Select the interface on each device for which you intend to implement this service order.UNI Interface

Enter the description for the selected UNI interface. The Description field is displayed in Modify
Service Order, View Service Order Details, Modify Service, and View Service windows. You can
edit this field while modifying a Layer 3 VPN service order or service.

Range: 0 through 128 characters

UNI Description

Select this check box to create a loopback interface for the service order.

NOTE: If youprovision a loopback interface for an L3VPNservice, anoperator is able to identify
a VRF routing instance. Thereafter, an operator canmanually ping a remote CE router from a
local PE router.

Set loopback
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DescriptionField

VLAN

This field displays the value specified in the service definition upon which you are basing this
service order.

Ethernet option

Select the interface on the device for which you intend to implement this service order.UNI interface

This check box is selected automatically if it was selected in the service definition upon which
this service order is based.

Autopick interface IP

Global

This field displays the value specified in the service definition upon which this service order is
based.

IP pool type

Select the IP address pool from the list.IP address pool

This field displays the value specified in the service definition upon which this service order is
based.

IP block size

This check box is selected automatically if it was selected in the service definition upon which
this service order is based.

Autopick VLAN ID

BGP

This field displays the value specified in the service definition upon which this service order is
based.

Routing protocol

This check box is selected automatically if it was selected in the service definition upon which
this service order is based.

Autopick neighbor IP

The peer autonomous system number.

Select a Peer AS from the list.

Peer AS

8. Click Create.

Related
Documentation

Creating a Full Mesh Layer 3 VPN Service Definition on page 257•

• Multicast L3VPN Overview on page 42

• Creating a Multicast VPN Service Definition on page 277
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Creating a Layer 3 VPN Service Order in Cross Provisioning Platform for Third-Party
Devices

Cross Provisioning Platform is an extension of the Network Activate application within

JunosSpace,whichprovidesa single paneof interaction todeploy services across vendor

network devices. This topic discusses how Layer 3 VPN service order is created and

deployed across third-party devices involved in Cross Provisioning Platform.

You need to create a Layer 3 VPN service definition before you create a Layer 3 VPN

service order. Refer to “Creating a Layer 3 VPN Service Definition in Cross-Provisioning

Platform forThird-PartyDevices” onpage279 for informationabouthowtocreateaLayer

3 VPN service definition.

To create a Layer 3 VPN service order:

1. From the Cross Provisioning Platform task pane, select CPP > Service Orders.

The Service Orders page that appears displays a list of the existing service orders.

2. Click the Create CPP Service Order icon above the tool grid.

TheCreateCPPServiceOrderpage thatappears contains theGeneralSettings section.

3. In the General Settings section, perform the following steps:

a. In the Select Service Definition section, select a service definition based on the

unique ID, name or type.

NOTE: The value in the ID field is associated with a service definition.

This identifier can be used when you are searching for a particular
servicedefinitionwhile creatingadeviceconfigletorder. Youcansearch
the service definition by its name, type or unique ID. You canmodify
the ID only during themigration of old service definition IDs.
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b. In theOrder description field, type 3 through 256 alphanumeric characters to

describe the service order.

4. Click Next.
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The Create L3VPN Service page that appears contains the General , RD/RT,MVPN

Settings, Step:1 Select Site, Step:2 Select Site Interface, and Step:3 Enter Staged

Interface Details sections.

5. On the Create L3VPN Service page, perform the following steps:

• In the General section:

The Name field is filled by default with the name of the service order.

a. In the External ID field, type 3 through 128 alphanumeric characters to specify

the external ID.

b. In the Customer ID section, click View to view and select a customer ID from the

list of customer IDs.

• In the RD/RT section:

• Select theManual RT/RD check box to enter the route target (RT) and route

distinguisher (RD) values manually.

a. From the RD spin box, select any value.

b. From the RT spin box, select any value.

• In theMVPNSettings section:

• Select the Enable MVPN check box to enable multicast VPN (MVPN) settings.

• In the Step:1 Select Site section:
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• Select any site from the list of available sites.

The site interfaces for the selected site automatically appear in the Step:2 Select

Site Interface section.

• In the Step:2 Select Site Interface section:

• Select one or more site interfaces from the list of available site interfaces.

• Click Add to Staged Interfaces.

The site interfaces that you selected are added to the staged interfaces and appear

in the Step:3 Enter Staged Interface Details section.

• In the Step:3 Enter Staged Interface Details section, perform the following steps for

all staged interfaces:

The Site Name and Port fields are automatically populated as soon as you add the

site interfaces to the staged interfaces. Because the validation of VLAN is also done

automatically, the Validate VLAN field is also filled.

a. From the Ethernet Option spin box, select any Ethernet switching option.

b. From the VLAN ID spin box, select any VLAN ID.

c. Select the IP Address field to enter the corresponding IP address of the staged

interface.

d. Select the Subnet field to enter the subnet range.

e. Select the Settings field to access the Advanced Settings page.

NOTE: The Advanced Settings page contains the routing protocol

and L2 extension field sets that are UNI specific. If you select the
MVPN check box, you can view and edit the MVPN settings. You can

add or remove a UNI interface in the Action column. The option to

delete thepreviouslyaddedsites is alsooffered in theActioncolumn.

6. Click Create.

The Job Details dialog box that appears displays the job ID. You can click the Job ID

link to view the job details.

NOTE: Click CreateMore to further modify the service order settings. The

details that youprovideon theCreateL3VPNServicepagedeterminewhich

fields are displayed to help you further modify the service order settings.

Related
Documentation

• CreatingaLayer3VPNServiceDefinition inCross-ProvisioningPlatformforThird-Party

Devices on page 279
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CHAPTER 13

Device Configuration Prerequisites to
Prestaging Examples

• Example: Base Configuration for N-PE Device in a Multipoint Service on page 577

• Example: Base Configuration for N-PE Device in a Point-to-Point Ethernet (LDP)

Service on page 579

• Example: Base Configuration for a P Router on page 580

• Example: Base Configuration for BX7000Multi-Access Gateway Supporting ATM and

TDM Pseudowires on page 582

• Example: Creating Cross Provisioning Platform Services on page 585

Example: Base Configuration for N-PE Device in aMultipoint Service

An N-PE device to be used in a multipoint service must have the following entities

configured before you assign the N-PE role to the device:

• Gigabit Ethernet interfaces to the network core

• Loopback interface

• Routing options

• MPLS protocol

• BGP protocol

• OSPF protocol

• LDP protocol

TheN-PE device in this configuration example has just one interface to the network core.

In amore complexnetwork inwhich theN-PEdevice connects tomore thanonePdevice,

you need to configure multiple interfaces.

interfaces {
    ge-0/0/0 {
        unit 0 {
            family inet {
                address 10.1.22.2/30;
            }
            family mpls;
        }
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    }

    }
    lo0 {
        unit 0 {
            family inet {
                address 192.168.1.30/32;
            }
        }           
    }

}
routing-options {
    autonomous-system 65410;
}
protocols {
    mpls {
        interface ge-0/0/0.0;
        interface lo0.0;
    }
    bgp {
        group CA-Peer {
            type internal;
            local-address 192.168.1.30;
            family l2vpn {
                signaling;
            }
            neighbor 192.168.1.40;
            neighbor 192.168.1.10;
            neighbor 192.168.1.20;
            neighbor 192.168.1.50;
            neighbor 192.168.1.60;
        }
    }
    ospf {
        traffic-engineering;
        area 0.0.0.0 {
            interface lo0.0 {
                passive;
            }       
            interface ge-0/0/0.0;
    }
    ldp {
        interface ge-0/0/0.0;
        interface lo0.0;
    }
}

Related
Documentation

Example:BaseConfiguration forN-PEDevice inaPoint-to-PointEthernet (LDP)Service

on page 579

•

• Example: Base Configuration for a P Router on page 580

• Example: Base Configuration for BX7000Multi-Access Gateway Supporting ATM and

TDM Pseudowires on page 582
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Example:BaseConfigurationforN-PEDevice inaPoint-to-PointEthernet(LDP)Service

An N-PE device to be used in a point-to-point service must have the following entities

configured before you assign the N-PE role to the device:

• Gigabit Ethernet interfaces to the network core

• Loopback interface

• MPLS protocol

• OSPF protocol

• LDP protocol

TheN-PE device in this configuration example has just one interface to the network core.

In amore complexnetwork inwhich theN-PEdevice connects tomore thanonePdevice,

you need to configure multiple interfaces.

interfaces {
    ge-0/0/0 {
        unit 0 {
            family inet {
                address 10.1.18.2/30;
            }
            family mpls;
        }           
    }

   }
    lo0 {
        unit 0 {
            family inet {
                address 192.168.1.20/32;
            }
        }
    }

}
protocols {
    mpls {
        interface ge-0/0/0.0;
        interface lo0.0;
    }
     ospf {
        traffic-engineering;
        area 0.0.0.0 {
            interface lo0.0 {
                passive;
            }       
            interface ge-0/0/0.0;
    }
    ldp {
        interface ge-0/0/0.0;
        interface lo0.0;
    }
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NOTE: If the N-PE router will also be used inmultipoint services, do not use
this base configuration. Instead, use the base configuration for multipoint
services.

Related
Documentation

Example: Base Configuration for N-PE Device in a Multipoint Service on page 577•

• Example: Base Configuration for a P Router on page 580

• Example: Base Configuration for BX7000Multi-Access Gateway Supporting ATM and

TDM Pseudowires on page 582

Example: Base Configuration for a P Router

P routers in your MPLS networkmust have the following entities configured before these

devices are prestaged:

• A Gigabit Ethernet interface to each router in the network

• Loopback interface

• MPLS protocol

• OSPF protocol

• LDP protocol

Figure 23 on page 580 shows a simple network with one P router connecting five N-PE

routers.

Figure 23: Connectivity in a Simple Network

Copyright © 2015, Juniper Networks, Inc.580

Junos Space Cross Provisioning Platform



The following example shows a P router configuration for the simple network shown in

Figure 23 on page 580.

interfaces {
        ge-0/0/2 {
        unit 0 {
            family inet {
                address 10.1.14.1/30;
            }
            family mpls;
        }
    }
    ge-0/0/3 {
        unit 0 {
            family inet {
                address 10.1.15.2/30;
            }
            family mpls;
        }
    }
    ge-5/0/0 {
        unit 0 {
            family inet {
                address 10.1.17.1/30;
            }
            family mpls;
        }
    }
    ge-5/0/1 {
        unit 0 {
            family inet {
                address 10.1.18.1/30;
            }
            family mpls;
        }
    }
    lo0 {
        unit 0 {
            family inet {
                address 192.168.1.1/32;
            }
        }
    }
}

}
protocols {
    mpls {
        interface ge-0/0/2.0;
        interface ge-0/0/3.0;
        interface ge-5/0/0.0;
        interface ge-5/0/1.0;
        interface lo0.0;
    }
    ospf {
        traffic-engineering;
        area 0.0.0.0 {
            interface ge-0/0/2.0;
            interface ge-0/0/3.0;
            interface ge-5/0/0.0;
            interface ge-5/0/1.0;
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            interface lo0.0 {
                passive;
            }
        }
    }               
    ldp {
        interface ge-0/0/2.0;
        interface ge-0/0/3.0;
        interface ge-5/0/0.0;
        interface ge-5/0/1.0;
    }
}

Related
Documentation

Example: Base Configuration for N-PE Device in a Multipoint Service on page 577•

• Example:BaseConfiguration forN-PEDevice inaPoint-to-PointEthernet (LDP)Service

on page 579

• Example: Base Configuration for BX7000Multi-Access Gateway Supporting ATM and

TDM Pseudowires on page 582

Example: Base Configuration for BX7000Multi-Access Gateway Supporting ATMand
TDMPseudowires

The configuration shown here is the base configuration required for a BX7000

Multi-Access Gateway to support ATM and TDM Pseudowires. This configuration shows

3 Gigabit Ethernet interfaces and 16 T1 interfaces that can be used for ATM or TDM

pseudowires.

root@bx-csr0> show configuration
system { 
    host-name bx-csr0;
    services ntp ;
    framer-mode t1;
    manual-mode config disable;
    zerotouch config disable;
    ssh protocol-version both;
    services ssh enabled;
} 
interface {
    ge-1/0/0 {                      #ge interfaces are NNI interfaces
        admin-state enable;
        unit 0 {
            family inet address 192.168.183.138/25;
        }
    }
    ge-1/0/1 {
        admin-state enable;
        unit 0 {
            family inet address 10.10.183.138/25;
        }
    }
    ge-1/0/2 {
        admin-state enable;
        unit 0 {
            family inet address 10.0.88.2/30;
        }
    }
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    lo0 {                                #lookback 
        admin-state enable;
        unit 0 {
            family inet address 100.100.200.1/32;
        }
    }
    t1-0/0/0 { #t1-0/0/0, t1-0/0/1,t1-0/0/10-t1-0/0/15 here are for TDM P/W service
 deployment
        admin-state enable;
    }
    t1-0/0/1 {
        admin-state enable;
    }
    t1-0/0/10 {
        admin-state enable;
    }
    t1-0/0/11 {
        admin-state enable;
    }
    t1-0/0/12 {
        admin-state enable;
    }
    t1-0/0/13 {
        admin-state enable;
    }
    t1-0/0/14 {
        admin-state enable;
    }
    t1-0/0/15 {
        admin-state enable;
    }
    t1-0/0/2 { #t1-0/0/2 -t1-0/0/9 here are for ATM P/W service deployment
        admin-state enable;
        encapsulation atm;
    }
    t1-0/0/3 {
        admin-state enable;
        encapsulation atm;
    }
    t1-0/0/4 {
        admin-state enable;
        encapsulation atm;
    }
    t1-0/0/5 {
        admin-state enable;
        encapsulation atm;
    }
    t1-0/0/6 {
        admin-state enable;
        encapsulation atm;
    }
    t1-0/0/7 {
        admin-state enable;
        encapsulation atm;
    }
    t1-0/0/8 {
        admin-state enable;
        encapsulation atm;
   }
    t1-0/0/9 {
        admin-state enable;
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        encapsulation atm;
    }
}
protocols {
    ospf {
        admin-state enable;
        spf-delay 200;
        traffic-engineering enable;
        area 0.0.0.0 {
            interface ge-1/0/2 {
                admin-state enable;
            } 
            interface lo0 {
                admin-state enable;
                mode passive;
            } 
        }
    }
    ldp {
        admin-state enable;    
        mpls ldp targeted-hello send remote-peer-ip; #this needs to be added 
manually 
   interface ge-1/0/2 {
            admin-state enable;
        } 
        interface ge-1/0/1 {
            admin-state enable;
        } 
        interface ge-1/0/0 {
            admin-state enable;
        } 
}

rsvp {
        admin-state enable;
        interface ge-1/0/2 {
            admin-state enable;
            reliable enable;
            hello-interval 20;
        }
}
mpls {
        label-switch-path p2pdbx1_32793 { #existing LSP is optional; one may use
 Space Transport Activate to create such
            to-address 192.168.5.1;
            from-address 100.100.200.1;
            primary p2pdbx1_32793 {
                priority 7 0;
            } 
            path 10.100.200.100 loose;
        }

        static-path-inet st1_32770 { #existing static LSP is optional; one may 
use Space Transport Activate to create such
            push 3;
            next-hop-address 10.0.88.1;
            out-interface ge-1/0/2;
            ingress-address 100.100.200.1;
            egress-address 192.168.5.1;
        }

Copyright © 2015, Juniper Networks, Inc.584

Junos Space Cross Provisioning Platform



        interface ge-1/0/2 {
            admin-state enable;
        } 
        interface ge-1/0/1 {
            admin-state enable;
        } 
        interface ge-1/0/0 {
            admin-state enable;
        }
}
    snmp { 
        community-name public
        contact bx-admin;
    }
} 
connection { 
} 
policy-options {
} 
bridge-domains {
} 
static-route {
    route 0.0.0.0/0 {
        next-hop 192.168.183.254;
    }
} 
routing-options {
    autonomous-system 65410;
}

Related
Documentation

Pre-Staging Devices Overview on page 3•

• Creating a Point-to-Point Service Order on page 438

• Discovering and Assigning All N-PE Devices on page 54

• Prestaging ATM and TDM Pseudowire Devices on page 62

• Prestaging ATM and TDM Pseudowire Devices on page 62

• Creating a Point-to-Point ATM or TDM Pseudowire Service Order on page 432

• Creating a Point-to-Point ATM or TDM Pseudowire Service Definition on page 164

Example: Creating Cross Provisioning Platform Services

TheCrossProvisioningPlatform(CPP) isanextension to theNetworkActivateapplication,

which provides a real-time, operations support system (OSS) for creating and deploying

services across multi-vendor devices. The CPP software manages the interaction of

Service Activation Director (SAD) with amodule called the Alcatel-Lucent 5620 Service

Activation Manager (SAM). With the Cross Provisioning Platform application, you can:

• Provision services between Juniper Networks devices and Alcatel-Lucent devices.

• Manage Services Activation Director services and Alcatel-Lucent 5620 Service

Activation Manager services
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• Use the REST APIs to manage services through Services Activation Director

• Use SOAP API to manage Alcatel-Lucent 5620 Service Activation Manager

The Cross Provisioning Platform application uses Network Activate as the underlying

framework and adds flexibility in designing services. You can:

• Create a data model for a new service

• Create user interface to define new service

• Define business logic to deploy the new service on Juniper Networks devices and

Alcatel-Lucent devices.

Creating services for Cross Provisioning Platform requires the coordination of tasks

performed in several areas of expertise including script design, system administration,

and service provisioning. When you create the cross-platform service definition, you can

attach scripts designed for the service.

This guide describes the process youmust follow to create scripts for the Cross

Provisioning Platform (CPP) system and the steps required to provision the scripts.

• Requirements on page 586

• Overview on page 587

• Developing Scripts on page 587

• Debugging a Cross Provisioning Platform Script on page 606

• Provisioning the Services Using the Scripts on page 608

Requirements

This example uses the following hardware and software components:

• Sencha Ext-JS 4.1.x JavaScript library for RIA (which is included in Junos Space)

• Sencha Architect

• XSLT 2.0 and XPath 2.0

• Junos Space Network Management Platform

• Junos Space Cross Platform Orchestrator application

NOTE: You can acquire Sencha Architect software through
http://www.sencha.com/products/architect/

Before you begin to develop the scripts, must be able to:

• Proficiently use JavaScript and Cascading style sheets (CSS)

• Use Sencha Ext-JS 4.1.x JavaScript library for RIA (which is included in Junos Space)

• Use Sencha Architect

• Develop scripts proficiently using XSLT 2.0 and XPath 2.0
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• Develop XML scripts that can be processed correctly with the third-party SOAP API

• Develop a Junos configuration script using the Juniper XML API

Overview

To deploy services to run across both Juniper Networks platforms and the devices of

third-party vendors, youmust perform the following steps:

1. Create the following types of scripts

• GUI script

• Third-party (SAM)Flex scripts

• Juniper Networks Flex Scripts

NOTE: The Flex scripts are also termed as configuration scripts.

2. Provision the scripts in the Cross Provisioning Platform application.

Developing Scripts

Youmust create the following scripts:

• Creating the GUI Scripts on page 588

• Creating the Flex Scripts for Juniper Network on page 595

• Creating the Flex Scripts for Third-party Vendors (SAM) on page 600
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Creating the GUI Scripts

Step-by-Step
Procedure

In the JunosSpaceCPPcontext, theGUI script generates theuser interface for interacting

with the Cross Provisioning Platform service. The GUI defines the parameters for which

a user specifies values. The GUI can define hidden fields and values that are passed to

the server. The GUI also guides a user to enter valid values for the parameters to define

a service order. In addition, the GUI script can provide some client-side validation.

To develop the GUI scripts that render the CPP windows through which you can enter

information to define a service, youmust be able to:

• Develop scripts proficiently using JavaScript and Cascading style sheets (CSS)

• Use Sencha Ext-JS 4.1.x JavaScript library for RIA (which is included in Junos Space)

• Use Sencha Architect

To develop the GUI Scripts:
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1. Use the Sencha Architect to build the GUI.

The Sencha EXT-JS library supplies a set of widgets that the script designer can

use to develop the GUI forms.

The following illustration shows a typical GUI designer’s view of a Sencha Architect

Project page.

The following illustration showsgeneratedcodedisplayedwithinaSenchaArchitect

project page.

NOTE: As an alternative to using the Sencha Architect to build the GUI,
you can hand-code the GUI forms. If you decides to hand-code the GUI,
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you can access one of the following development resources, which are
available online at no cost:

• An online GUI development environment at :
https://fiddle.sencha.com/

• An online API reference and code examples at:
http://docs.sencha.com/extjs/4.1.1/

2. Use the CPP Script Utilities that provide hooks into a Juniper Networks platform to

obtain device and interface information.

The script utilities provides helper functions which are exposed by application,

intended to be used by designers who creates a GUI script for CPP service

provisioning

You can choose to assign a short variable to these classes prototype for making it

easier to access functions.

DescriptionFunction

This function returns the form, from themain popup window, assuming the user layout is
such that the form is inserted directly inside the window as first child.

getMainForm (window)

This function gets all the user filled input form data values within a window.getFormValues (window)

This function gets any components inside a window dialog by any custom or predefined
property. If more than one component match is found, then it returns an array of all
matched components.

getFieldsByProperty
(property,name)

This function returns any field or component inside the form, based on its name. This
returns fields fromwithin field sets. If more than onematch is found it returns the first
match always. Typically field are never same, to avoid getting more than one result you
should always assign unique names to fields.

getFieldByName (name)

This function makes a connection to devices resource and get all the Junos devices and
autoloads into thedevice store. This functionpass the commondata fromprevious screen
to determine if the service definition selected has a SAM script attached. If data is not
specified, then only Juniper Networks devices are returned from server by default.

getDeviceStore (data)

This function makes a connection to the devices resource and get all the Junos devices
which have L2E role and autoload into the device store.

getL2ExtDeviceStore ()

This function gets all the interfaces based on the selected devices. This is not autoloaded,
loads only when the device is selected. Therefore the store loadmust be handled in the
device combo box select listener.

getInterfaceStore ()

This function gets all the interfaces based on the selected devices which have L2E role.
This is not autoloaded, and loads only when the device is selected. Therefore the store
loadmust be handled in the device combo box select listener.

getL2ExtInterfaceStore ()

This function populates the data coming from server and show it into the form.setFieldValues (window,data)
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DescriptionFunction

This function gets the data from user dialog and send it to the back end for persistence
and validation. Any server error or information is shown as popup dialog. If all validation
goes well, the job link dialog is displayed for the user to either exit or go to job page for a
status check.

saveForm (window,data)

This function gets user data and save the form in bulk. No job dialogs are shown. You need
to manually close the dialog after saving the data.

saveBulkForm (window,data)

This function gets the data from user dialog and send it to back end for persistence and
validation.Any server error or information is shownaspopupdialogand the screen is ready
for another input from user.

saveAndCreateMore
(window,data)

This function is called when you try to modify a service. This function receives the data
from the user dialog and send it to the back end for persistence and validation. Any server
error or information is shown as a popup dialog. If all validation goes well, the job link
dialog is displayed for the user to either exit or go to job page for a status check.

saveModifyForm (window,data)

TheUI designermust call this event handling function, to validate the encapsulation field.
This can be added as a callback for any change event (text field change or check box).
The objective is to send siteId, port, encap to validate from the back end. The result is
shown in a pop-up dialog. Pass "null" if you are not using a check box, otherwise it will be
unchecked.

validateVLAN
(siteId,port,encap,checkbox)

Based on the site and port, this function fetches the port details and show it to user in a
pop up dialog. the vendor can be either Junos Space or Alcatel.

showInterfaceDetails
(siteId,port,vendor)

This function groups grid from the user GUI script, params :- name : grid name, height :
grid height, store : grid store, window : reference of the user script main window.

You should implement addSiteHandler and deleteUNIInterfaceHandler and
addUNIInterfaceHandler in their respective script for addsite, addport, deleteport button
actions.

createGroupingGridPanel
(name,height,store,window)

This function creates grouping grid store from the user GUI script, params :- fields : fields
used in grid store - should be array of fields, groupField : group Name

createStore (fields,groupField)

This function creates a field of form, from the user GUI script, params:- initialConfig -
configurations like name, height, default, layout, bodyPadding, title and so on.

createForm (initialConfig,items)

This function creates default service order name and set to service order name text field,
params:- field :service order name textfield component return current Time with prefixed
with 'SO' string.

createDefaultServiceOrderName
(field)

This function returns the inventory in Stringified JSON format. Based on device ID, vendor
type, inventory Type, XPath, param deviceid - Id of the device, param vendor - Default to
Juniper, param inventoryType -the inventorytype is the string value from the following
DeviceInventoryXMLTypeenum, INTERFACES("interface-information"),CONFIGURATION
("configuration"), SOFTWARE_INVENTORY("software-inventory"),
HARDWARE_INVENTORY ("chassis-inventory"), SYSTEM_INVENTORY
("system-information"), LICENSE_INVENTORY("license-inventory"),DEVICE("device"),
param xpath - the xpath to apply For configuration, use Xpath starting with
"/device/configuration", For hardware inventory, use Xpath starting with
"/device/chassis-inventory"

getNodeList
(deviceId,vendor,inventoryType,xpath)
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DescriptionFunction

This function navigates other tasks using the task name, params:- taskName :name of
the task

navigateTo (taskName)

This function retrieves the advanced attributes for the service endpoints.getEndpointAdvanceSettings
(String deviceId, String portName,
String customerId)

The following code fragment is a sample of the importation or declaration of the

CPP ScriptUtils.

The following two code fragments are samples of script utility function calls:

getDeviceStore()

getInterfaceStore()

3. The CPP software populates values for the attributes policy, bundleName,

samScriptBundleName, and the description. The script populates values for the

remaining attributes. The script designer determines values for attributes within

ServiceCommonAttributesandServiceEndpointAttributes.TheattributespedeviceId

and vendorType aremandatory. All of the attributes are converted directly into XML

and passed to ServiceRequest.xml.

The script designer can use the attribute children to nest ServiceEndpointAttributes

to represent topologystructure.Theattribute topologyIndex isoptional. Thedesigner

can use it to describe the topology structure of service endpoints.

The following parameters are the mandatory parameters that must be present in

the ServiceRequest.xml:
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NOTE: These parameters are case sensitive.

DescriptionParameters

PE Device ID

Youobtain this valueby fetchingall thedevices fromthedatabase through theScriptUtil
helper functions.

pedeviceId

Vendor type

The vendor type can be Juniper, or Alcatel, or SpacePlatform.

NOTE: SpacePlatform is used only while writing Device Order Configlet scripts, that is,
Flex script with Service Type as Device.

vendorType

Interface Name

You can obtain this value by fetching all the interfaces from the database through the
ScriptUtil helper functions.

Interface

Outer encapsulation of the VLAN ID.outerEncap

Service Element ID.

This value should be not set while creating a service.

This value ismandatory whilemodifying a service. This value is populated usingModify
APIs defined to retrieve all the endpoints.

seId

Record operation type

The record operation type can be ADD, orMODIFY, or DELETE.

For Create Default the value is ADD.

For Modify the value can be ADD, orMODIFY, or DELETE.

recordOPType

The user defined attributes of the service endpoint. You can provide any valid JSON
data to this attribute. This is specific to each service endpoint

ServiceEndpointAttributes

The attributes that are common for all the service endpoints or services.ServiceCommonAttributes

The following illustration displays sample code of aServiceRequest.xml document.

Within the sample:

• TheelementServiceEndpointAttributes is themandatoryattributeofany individual

ServiceElement. Note that pedeviceId and vendorType are mandatory items of

a ServiceRequest.xml document.

• The element ServiceCommon Attributes is the common attribute of a service.
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• Both elements, ServiceEndpointAttributes and ServiceCommonAttributes, are

converted from the JSON data derived from the GUI script.

ServiceEndpointAttributes andServiceCommonAttributes are artifacts that pass

information from GUI scripts to the XSLT Flex scripts.

• The CPP service activation engine generates the other part of a

ServiceRequest.xml file.
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Every ServiceRequest must have an OpType under the ServiceRequest, which

indicates the type of operation defined.

The OpType under each ServiceElement specifies whether the ServiceElement is

to be added or modified when the ServiceRequest is deployed.

4. The output of GUI scripts is presented in JSON format. JSON data is rendered into

anXMLdocumentknownasServiceRequest.xml.TheServiceRequest.xmldocument

is the input to the JUNOS and SAM Flex XSLT transformations.

Designers develop Extensible Stylesheet Language Transformations (XSLT) scripts

to transform one XML document into one or more other XML documents.

For Cross Provisioning Platform, an XSLT script transforms the ServiceRequest.xml

document into two new XML documents:

• A SOAP XML document for the third-party (SAM) device

• A Juniper device configuration XML document

Results WhenyouhavecreatedGUIandconfigurationscriptsandaddedthemtotheCPPsystem,

you can create a service definition to which you associate specific scripts. Thereafter,

you can create and deploy a service order based on a particular service definition.

While creating a service order, the Endpoint Settingswindow appears. The appearance

of the Endpoint Settingswindow is based on the GUI scripts that are associatedwith the

service definition upon which the service is based.

Creating the Flex Scripts for Juniper Network

Step-by-Step
Procedure

To develop the Juniper Flex scripts that transform a service request into an XML

configuration script that is sent to a Juniper device, youmust be able to:

• Develop scripts proficiently using XSLT 2.0 and XPath 2.0

• Develop a Junos configuration script using the Juniper XML API

To develop the XSLT Flex script for a Juniper device:

1. The Juniper Networks XSLT Flex script derives input variables from the

ServiceRequest.xml document, which is created from data a user inputs into the
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Junos Space CPP GUI, and generates JUNOS XML configuration that is passed to

the intended Juniper Networks device.

2. An XSLT Flex script for a Juniper device has twomajor components:

• Derivations Logic—In this section of code, input variables are extracted and

additional parameters are derived.

• Configuration Logic—In this section of the code, parameters derived from the

derivation logic are used to construct the XML configuration that activates the

service on a Juniper Networks device.

The following illustrations show the transformation from a Juniper Networks XSLT

Flex script to a JUNOS XML configuration.
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JUNOS XML Configuration
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An XSLT Flex script for a Juniper Networks device includes an OpType to specify

when the script is used:

• Creation—Used to create a new service and to decommission a previous service

• Modification—Used tomodify an existing service

The following illustration shows the presence of OpTypes in a ServiceRequest.
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Results WhenyouhavecreatedGUIandconfigurationscriptsandaddedthemtotheCPPsystem,

you can create a service definition to which you associate specific scripts. Thereafter,

you can create and deploy a service order based on a particular service definition.
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Creating the Flex Scripts for Third-party Vendors (SAM)

Step-by-Step
Procedure

To develop third-party(SAM) Flex scripts that transform a service request into a Simple

Object Access Protocol (SOAP) script that is sent to theAlcatel-Lucent device, youmust

be able to:

• Develop scripts proficiently using XSLT 2.0 and XPath 2.0

• Develop XML scripts that can be processed correctly with the third-party SOAP API

To develop the XSLT Flex script for SAM:

1. The third-party (SAM) XSLT Flex script derives input variables from the

ServiceRequest.xml document, which is created from data a user inputs into the

JunosSpaceCPPGUI, andgeneratesaSOAPmessage that ispassed to the intended

third-party vendor’s device.

2. The third-party XSLT Flex script includes twomajor components:

• Derivations Logic—In this section of code, input variables are extracted and

additional parameters are derived.

• Configuration Logic—In this section of the code, parameters derived from the

derivation logic are used to construct the third-party(SAM) SOAP call that

activates the service on a third-party vendor’s (SAM) device.

The following illustration includes sample code fragments that present the

derivations logic and configuration logic sections of a XSLT Flex script for a

third-party (SAM) device.
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The configuration logic in the third-party XSLT script converts to XSLT format the

SOAPmessage generated by the third-party(SAM) service script. The following

pseudo code sample demonstrates the logic to accomplish the conversion.

To work with the third-party (SAM) XSLT script, login to the third-party (SAM)

server. The following illustration presents a third-party(SAM) GUI window that

enables entering data for third-party (SAM) XSLT Flex script.
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The following illustration shows a sample of the corresponding code that is

generated when a user requests to preview the SOAP code from the GUI window.

The following illustration shows a sample of the code that results when the script

designer substitutes variables included in the SOAP code with variable names

obtained from the XSLT Flex script derivation logic.

Copyright © 2015, Juniper Networks, Inc.602

Junos Space Cross Provisioning Platform



The following illustration demonstrates the process of converting SOAP code

variables in the third-party (SAM) XSLT Flex script code. The script designer adds

logic to define the variables Default MTU and JumboMTU. The code also indicates

how Canoga or L2E is selected.

NOTE: Most of the logic that the designer adds is reused for all scripts.
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The following illustrations show the transformation from a third-party XSLT Flex

script to a SOAPMessage.
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SOAPmessage
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The SOAP script communicates directly with the third-party vendor’s service

activation module (SAM) by way of a SAM adaptor plugin. The third-party vendor

forwards the configuration to a device using its chosen communication protocol.

Debugging a Cross Provisioning Platform Script

In releases prior to Cross Provisioning Platform Release 14.3R1, you can identify

script-related issues only after you create a service. You cannot preview the XML

configuration that is being pushed to the device.

With Cross Provisioning Platform Release 14.3R1, you can debug both the configuration

script and the GUI script while you are still creating a service. This enables you to identify

and rectify all script-related issues before you create a service. You can debug both

Juniper Networks and Alcatel-Lucent scripts.
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You can debug a Cross Provisioning Platform script by performing the following tasks:

• Modifying a Cross Provisioning Platform Script on page 607

• Previewing a Cross Provisioning Platform Script on page 607

• Verifying a Cross Provisioning Platform Script on page 607

• [xref target has no title]

Modifying a Cross Provisioning Platform Script

Step-by-Step
Procedure

In releases prior to Cross Provisioning Platform Release 14.3R1, you need to upload the

modified script from your local file system. In Cross Provisioning PlatformRelease 14.3R1,

you canmodify the script directly in the text area included in the Modify Script window.

By default, the latest version of the script is populated in the text area.

Tomodify a Cross Provisioning Platform script, perform one of the following tasks:

• Browse the local file system to upload the script that you havemodified in your local

file system.

The uploaded script is displayed in the text area, included in theModify Script window.

• Modify the script directly in the text area.

NOTE: In the text area in the Modify Script window, you can alsomodify
the script that you have uploaded from your local file system. For more
information about modifying an existing script, see “Modifying Scripts
Created for Cross Provisioning Platform” on page 671.

Use the Preview option in the Modify Script window to preview the script output. In the

script output, use the Verify option to verify the script output.

Previewing a Cross Provisioning Platform Script

Step-by-Step
Procedure

WithCrossProvisioningPlatformRelease 14.3R1, youcanpreviewthescriptoutputbefore

you create a service.

To preview the output of a GUI script, perform one of the following tasks:

• On the Scripts inventory page, right-click a script and select Preview.

• In the Modify Script window, click the Preview option.

Verifying a Cross Provisioning Platform Script

Step-by-Step
Procedure

Verify the script output to identify and troubleshoot issues, if any. The Cross Provisioning

Platform application provides you with the option to specify real-time data while you

preview the script output.

1. In the Modify Script window, click the Preview option.

607Copyright © 2015, Juniper Networks, Inc.

Chapter 13: Device Configuration Prerequisites to Prestaging Examples



You can preview the script output.

2. In the script output window, specify real-time data.

3. Click Verify.

NOTE: For the Verify option to appear in the script output window and

to generate the required XML output, youmust append the GUI script
with the newly created script utility function,
scriptUtils.verifyForm(this,data).

Following is the code snippet to add the Verify option:

{
xtype: 'button',
handler: function(button, event) {

var data = this.getDataJSON();
this.scriptUtils.verifyForm(this,data)

},
scope: this,
text: 'Verify'
}

All necessary information required for debugging the Cross Platform Provisioning

script is displayed in a newwindow.

Provisioning the Services Using the Scripts

The following steps are involved in provisioning the services:

• Configuring Alcatel-Lucent Devices on page 608

• Adding a Third-Party Device to the Cross Provisioning Platform System on page 610

• Adding Scripts Created for Cross Provisioning Platform on page 611

• Creating a Cross-Platform Service Definition on page 614

• Creating a Cross-Platform Service Order on page 616

• Deploying Services on page 620

Configuring Alcatel-Lucent Devices

Step-by-Step
Procedure

To preconfigure the third-party OSS device:

1. In the Network Management Platform, select Administration > Applications.

2. In the Applicationswindow, select Network Activate.
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3. From the Actionsmenu, selectModify Application Settings.

4. In theModify Application Settingswindow, selectOSSConfigParameters.

5. Fill in the fields in theOSSConfigParameters panel as described in the following

table.

DescriptionOSS Parameter

IP address of the primary server.Primary Server IP

Port number of the primary server.Primary Server Port

IP address of the backup server.Backup Server IP

Port number of the backup server.Backup Server Port:

Duration of HTTP connection (in milliseconds) before the timeout elapses.HTTPConnectionTimeout (milliseconds)

Maximum number of simultaneous API requests permitted.MaximumAPI Requests

Directory path of the OSS log directory.OSS Log Directory

Filename of the OSS log.OSS Log Filename
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DescriptionOSS Parameter

User name for accessing the OSS server.OSSUser Name

Hashed password for accessing the OSS server.OSSUser Password

Sets thedaily timeatwhich theCPPsystemsynchronizes third-partydevices, added
or deleted from the CPP system, with the OSS server.

NOTE: The timeatwhich thesynchronization job runs is associatedwith the location
of the browser in which you are using the Junos Space software. That is, the
synchronization job runs according to the browser time where the job is scheduled,
not according to the time where the Junos Space server is located.

Synchronize OSS Inventory daily at given
time

If this check box is selected, the CPP system communicates with the primary OSS
server. If the check box is not selected, the system interacts with the backup server.

Use primary server

6. When you are done entering information in theOSSConfigParameters fields, click

Modify.

Adding a Third-Party Device to the Cross Provisioning Platform System

Step-by-Step
Procedure

To add a third-party device to the Cross Provisioning Platform system:

1. In the Network Activate task pane, select CPP > Third-Party Devices.

2. In the Third-Party Deviceswindow, click the Add Third-Party Device icon (+).

Copyright © 2015, Juniper Networks, Inc.610

Junos Space Cross Provisioning Platform



3. In the AddOSSDevicewindow, click the Host Name or IP Address button and then

enter the hostname or IP address of the device.

4. Click Add.

The device is displayed in the Third-Party Deviceswindow.

Adding Scripts Created for Cross Provisioning Platform

Step-by-Step
Procedure

Before you can create a cross-platform service definition, youmust add scripts to the

system that enable management of the Juniper Networks devices and the devices of

another vendor.

To enable Cross Provisioning Platform, you add three types of scripts:

• JunosXSLT—Provides the code that enablesprovisioningaparticular JuniperNetworks

device.

• SAMXSLT—Provides the code that enables provisioning the device of another vendor.

• GUI JavaScript—Provides the code that renders the Network Activate GUI window

required for provisioning a Juniper Networks device.

To view the scripts that have been loaded into the system:

1. In the Network Activate task pane, select Service Design >Manage Scripts.

2. In theManageScriptswindow, select theAddScripts icon on the command bar (+).
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3. In the Add Script(s)window, select a feature type and its corresponding vendor

type froma list of features in theFeatureTypedrop-down list. These features require

scripts in CPP.

4. In the Add Script(s)window, you can browse your local client file system for the

scripts you want to be available to the Network Activate application. You can add

scripts for Juniper Networks devices and for the devices of other vendors. If you

select Junos Space in the Vendor type field, the window displays fields for selecting

both Configuration script and GUI script.

NOTE: If youwant to do service interfacemigration, you need to upload
both Configuration script and the GUI script.

If you select a third-party in the Vendor type field, the window displays a field for

selecting a Configuration script only.
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NOTE: If you access the server on which the Junos Space software is
installed as a remote client, youmust copy the scripts you intend to add
to the CPP system to your local client file system. That is, when you
click on Browse to select a script, which you want to add, Junos Space

opens the local client file system, not the file system of the server on
which Junos Space is installed.

5. For each script, add the appropriate information for each field and click Create.
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Creating a Cross-Platform Service Definition

Step-by-Step
Procedure

Before you create a cross-platform service order, youmust complete the following tasks:

• Import into the system the scripts that define the Juniper Networks devices.

• Import into the system the scripts that define the third-party devices.

To create a cross-platform service definition:

1. In the Network Activate task pane, select CPP > Service Definitions.

2. In the CPP > Service Definitionwindow, click on the + button. The Create Service

Definitionwindow appears.
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3. Enter information in the Create Service Definitionwindow according to the

descriptions in the following table.

DescriptionParameter

Enter a name for the service.Name

Enter a description of the service to distinguish its operation from others.Description

Select the service type from the list of available types:

• PW-LDP

• VPLS

• L3VPN

• NPS

• Device—If youselectDevice, theSAMServiceScriptsparameterdisappears. This type is for Juniper
Networks devices only.

Type

This parameter provides two fields:

• Creation—One at a time, browse for the scripts you want to attach to the service definition.

• Modification—Browse for a modified version of a script of the same name that was initially
attached to the service definition. Junos Space compares the two scripts and generates a script
that includes the new information.

SAMService Scripts
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DescriptionParameter

This parameter provides two fields:

• Creation—One at a time, browse for the scripts you want to attach to the service definition.

• Modification—Browse for a modified version of a script of the same name that was initially
attached to the service definition. Junos Space compares the two scripts and generates a script
that includes the new information.

Junos Space Service
Scripts

4. Click Create.

5. In the Network Activate task pane, select CPP > Service Definitions.

6. Select the service definition you just created and select Action > Publish Service

Definition. The State column indicates when the service definition is published.

Creating a Cross-Platform Service Order

Step-by-Step
Procedure

Before you create a cross-platform service order, youmust complete the following tasks:

• Import into the system the scripts that define the Juniper Networks devices.

• Import into the system the scripts that define the third-party devices.

• Create the service definition upon which to base the service order.

To create a cross-platform service order:

1. in the Network Activate task pane, select CPP > Service Orders.

2. In theCPP>ServiceOrderswindow, click the+button. TheCreateCPPServiceOrder

window appears.
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3. In theServicedefinition field, browse for thenameof thepublishedservicedefinition

upon which you want to base the service order.

4. In theOrder description field, enter a description of the service that distinguishes its

operation from others.

5. Click Next. The Endpoint Settingswindow appears.

NOTE: The following representation of an Endpoint Settingswindow is

asampleonly.Theappearanceof theEndpointSettingswindow isbased

on the scripts that areassociatedwith the servicedefinitionuponwhich
the service is based.
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6. Enter information for the parameters of the Endpoint Settingswindow according

to the descriptions in the following table.

DescriptionParameter

General

Enter a unique name for the service order to distinguish it from others that operate
differently.

Name

Jumbo

Sets the MTU frame size to 3900

Sets the MTU frame size to 9000

Default: 1596

Jumbo frame 3900

Jumbo frame 9000

Site B Selector

Customer Facing Port

Network Facing Port

Site B port type

Site A – Customer Facing Port

Select the device from the list of devices displayed.Site name

Resyncs the interface on the selected device.

NOTE: This parameter pertains to third-party devices only.

Resync now

Select a port from the list of ports displayed.Port
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DescriptionParameter

Select the appropriate bandwidth for the selected site.Service speed

If you select this check box, the software checks to determine whether the device is a
Canoga device.

Canoga device?

If you select this check box, the software checks to determine whether the device is an
untagged Anda device.

Anda untagged?

Enter an integer, or select the up or down arrow to select a value for the Outer
encapsulation.

Outer encapsulation

If this check box is selected, the system validates the encapsulation value with the
specified site and port.

Validate

If this check box is selected, the software checks to determine whether 802.1q was
specified as the Ethernet option in UNI Settings.

Untagged/802.1q?

Enter an integer, or select the up or down arrow to select a value for the Inner
encapsulation.

Inner encapsulation

L2 Extension

Select the device from the list of devices displayed.Site name

Select a UNI port from the list of ports displayed.UNI port

Select a NNI port form the list of ports displayed.Uplink port

Enter an integer, or select the up or down arrow to select a value for the UNI
encapsulation.

UNI encapsulation

If this check box is selected, the system validates the encapsulation value with the
specified site and port.

Validate

Site B – Customer Facing Port

Select the device from the list of devices displayed.Site name

Resyncs the interface on the selected device.

NOTE: This parameter pertains to third-party devices only.

Resync now

Select a port from the list of ports displayed.Port

Select the appropriate bandwidth for the selected site.Service speed

If you select this check box, the software checks to determine whether the device is a
Canoga device.

Canoga device?
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DescriptionParameter

If you select this check box, the software checks to determine whether the device is an
untagged Anda device.

Anda untagged?

Enter an integer, or select the up or down arrow to select a value for the Outer
encapsulation.

Outer encapsulation

If this check box is selected, the system validates the encapsulation value with the
specified site and port.

Validate

If this check box is selected, the software checks to determine whether 802.1q was
specified as the Ethernet option in UNI Settings.

Untagged/802.1q?

Enter an integer, or select the up or down arrow to select a value for the Inner
encapsulation.

Inner encapsulation

L2 Extension

Select the device from the list of devices displayed.Site name

Select a UNI port from the list of ports displayed.UNI port

Select a NNI port from the list of ports displayed.Uplink port

Enter an integer, or select the up or down arrow to select a value for the UNI
encapsulation.

UNI encapsulation

If this check box is selected, the system validates the encapsulation value with the
specified site and port.

Validate

7. Click Create or click CreateMore to provision additional endpoints.

Deploying Services

Step-by-Step
Procedure

To schedule a service for deployment:

1. Select > CPP > Service Orders.

The Service Orders page displays the list of service orders.

2. Select the service order you want to deploy.

3. Open the Actionsmenu and click Deploy Service Order.

The Deploy Servicewindow appears.

4. To deploy the service immediately, select Deploy now, and clickOK.

To deploy the service at a later time, select Deploy later, and select a date and time

for deployment, then clickOK.

The time field specifies the time kept by the server, but in the time zoneof the client.

Copyright © 2015, Juniper Networks, Inc.620

Junos Space Cross Provisioning Platform



After scheduling theserviceorder fordeployment, theCPPsoftwarebeginsvalidating

the service order.

Related
Documentation

•
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CHAPTER 14

End-to-End Configuration Examples

• Example: Configuring and Deploying a Point-to-Point Ethernet Service on page 623

• Example:ConfiguringandDeployingaMultipoint-to-MultipointVPLSServiceonpage632

• Example: Configuring and Deploying a Layer 3 VPN Full-Mesh Service on page 642

Example: Configuring and Deploying a Point-to-Point Ethernet Service

This example deploys and verifies a point-to-point Ethernet service startingwith twoMX

Series devices. Figure 24 on page 623 shows the service.

Figure 24: Simple Point-to-Point Service

This service provides connectivity for one VLAN, using 802.1Q interface endpoints.

Customer siteAconnects to thenetwork throughUNIge-0/0/2onanN-PEdevicenamed

SJC. Customer site B connects to the network through UNI ge-0/0/3 on an N-PE device

named SFO.

The bandwidth for each UNI is limited to 1000Mbps.

You can create this service by performing the following tasks, in order:

• Preparing Devices for Discovery on page 624

• Discovering Devices on page 624

• Preparing Devices for Prestaging on page 625

• Discovering and Assigning N-PE Roles on page 626

• Choosing or Creating a Service Definition on page 627

• Creating a Customer on page 629
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• Creating and Deploying a Point-to-Point Service Order on page 629

• Performing a Functional Audit and a Configuration Audit on page 630

Preparing Devices for Discovery

Before you can add a device using device discovery, the following conditions must be

met:

• SSH v2 is enabled on the device. To enable SSH v2 on a device, issue the following CLI

command:

set system services ssh protocol-version v2

• The NETCONF protocol over SSH is enabled on the device. To enable the NETCONF

protocol over SSH on a device, issue the following CLI command:

set system services netconf ssh

• The device is configured with a static management IP address that is reachable from

the Junos Space server. The IP address can be in-band or out-of-band.

• A user with full administrative privileges is created on the device for the Junos Space

administrator.

• If youplan to useSNMP toprobedevices as part of device discovery, ensure that SNMP

is enabled on the device with appropriate read-only V1/V2C/V3 credentials.

Discovering Devices

Device discovery is a process that Junos Space uses to bring network devices under its

control. This example brings two MX Series routers under Junos Spacemanagement:

1. Log in to Junos Space using your credentials.

2. In theNetworkActivate taskpane, selectDevices>DiscoverDevices>DiscoverTargets.

3. In the Discover Targetswindow, click +.

The Add Device Targetwindow appears.

4. Select IP range.

5. Enter the IP address information. This example uses a range of two addresses.

6. Click Add, and then click Next.

7. In the Devices: Specify Probeswindow, select both Ping and SNMP as probes.

8. Click Next.
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9. In theDevices:SpecifyCredentialswindow,click+andenter thedevice logincredentials.

10. Click Finish.

Device discovery begins. It displays a graph showing the status of the discovery

operation. Initially, two devices are discovered.When Junos Space has accessed both

devices and brought them under its management, both devices move from the

Discovered column of the graph to the Managed column.

11. To check the results of the device discovery operation, select the Devicesworkspace

again, then select DeviceManagement. TheManage Devices page shows the added

devices.

Preparing Devices for Prestaging

Before prestaging devices for point-to-point services, the following entities must be

configured:

• MPLSmust run on each N-PE device.

• LDP signalingmust be established betweenN-PE devices that youwant to participate

in the same point-to-point service.

To satisfy these configurations, ensure that the following configuration exists on each

N-PE device:

interfaces {
    ge-0/0/0 {
        unit 0 {
            family inet {
                address 10.1.18.2/30;
            }
            family mpls;
        }           
    }
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   }
    lo0 {
        unit 0 {
            family inet {
                address 192.168.1.20/32;
            }
        }
    }

}
protocols {
    mpls {
        interface ge-0/0/0.0;
        interface lo0.0;
    }
     ospf {
        traffic-engineering;
        area 0.0.0.0 {
            interface lo0.0 {
                passive;
            }       
            interface ge-0/0/0.0;
    }
    ldp {
        interface ge-0/0/0.0;
        interface lo0.0;
    }

NOTE: The OSPF configuration is not required in prestaging.

Discovering and Assigning N-PE Roles

Before you can provision services, youmust prestage the devices. Prestaging includes

assigning device roles and designating interfaces on those devices asUNIs. This example

provides the steps to accept the recommendations of the Network Activate software

for N-PE devices and UNIs.

1. In the Network Activate task pane, select Prestage Devices >Manage Device Roles.

This action launches the rolediscoveryprocess inwhich theNetworkActivate software

examines thedevicesunder JunosSpacemanagement looking for devices thatmatch

predefined rules that identify N-PEdevices. In this example, the RoleDiscovery Status

graph shows that the Network Activate software has discovered two such devices.

2. In the Assign Roleswindow, switch to multiple selection mode and select both N-PE

devices.

3. Open the Actionsmenu and select Assign NPE role.

4. In the Assign NPEwindow, click Assign to confirm the assignment.

5. To view the assignment status, in the Job Detailswindow, click the job ID of the

assignment job.
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The JobManagement page shows the progress and status of the role assignment job.

6. To verify the result, in the Network Activate task pane, select Prestage Devices >

Manage Device Roles.

TheManageDeviceRoleswindowshowstwodevices thatcanbeused forprovisioning.

Choosing or Creating a Service Definition

A service definition provides a template uponwhich services are built. It specifies service

attributes that are not specific to a service instance. In our example, the service definition

provides all service attributes except the N-PE devices, the UNIs, and bandwidth.

The Network Activate software ships with standard service definitions. First, we check

the standard service definitions to determine whether one already exists that will work.

1. In the Network Activate task pane, select ServiceDesign>ManageServiceDefinitions.

TheManageServiceDefinitionspage lists all service definitions in the system. In a new

system, the screen lists only predefined service definitions.

This example requires a service definition with UNIs that use 802.1Q interfaces and

allowyou tosetabandwidthof25Mbps.Thestandardservicedefinitionshaveseveral

examples for provisioning 802.1Q UNIs, but none that allow the setting of a 25 Mbps

bandwidth limit. You need to create a new service definition.

2. In the Network Activate task pane, select Service Design >Manage Service Definitions

> Create P2P Service Definition.

The General window appears.

3. Enter a name for the service definition. For this example, enter p2p-dot1q-sd-1.

4. Click Next.

The UNI Settingswindow appears.

5. In the Connectivity Settingswindow, to pick the default connectivity settings, click

Next.

6. In the UNI Settingswindow, in the Ethernet option field, select dot1q.

7. In the Customer traffic type field, select Transport single VLAN.

8. In the VLAN ID selection field, select Selectmanually.

9. In the VLAN range for manual input field, specify the range.

10. In theOuter Tag protocol ID field, select 0x88a8
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11. In the Physical IF encapsulation field, select flexible-ethernet-services.

12. In the Logical IF encapsulation field, select vlan-ccc.

13. In the Bandwidth Settings panel, select the Enable rate limiting check box.

14. In the Default Bandwidth field, enter 10, for a default bandwidth of 10 Mbps.

15. To the right of the value you just entered, select the Editable in service order check

box.

TheMin Bandwidth (Kbps), Max Bandwidth (Mbps), and Increment (Kbps) become

active.

16. In theMin Bandwidth (Kbps) field, enter 100.

17. In theMax Bandwidth (Mbps) field, enter 10000.

18. In the increment field, enter 64.

These settings of the Bandwidth range and Increment fields allow the bandwidth to

beset in theservice toany64-Kbps increment in the rangeof 100Kbps through 10000

Mbps.

19. To save and complete the service definition, click Finish.

TheManage Service Definitions page includes the new service definition.

You have created a customized Service Definition, but it has not yet been published.

Before a service definition can be used in provisioning, it must be published.

20.To publish the service definition, in theManage Service Definitions page, select the

p2p-dot1q-sd-1 service definition; then in the Actionsmenu, select Publish Service

Definition.
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The Publish Service Definitionwindow appears.

21. To confirm that you want to publish this service definition, click Publish.

In theManage Service Definitions page, the symbol in the upper left corner of the

service definition changes to a check mark, indicating that the status has changed to

Published.

The service definition is now ready for use in provisioning.

Creating a Customer

Beforeyoucanprovision theservice, customerdetailsmustbepresent in the JunosSpace

database. To add a customer:

1. In the Network Activate task pane, select Service Provisioning >Manage Customers >

Create Customer.

2. In the Name field, enter Best Customer.

3. In the Account number field, enter 1234.

4. Click Create.

TheManage Customers page shows the new customer.

Creating and Deploying a Point-to-Point Service Order

Now that you have prestaged your devices, created a suitable service definition, and

added the customer information to the database, you are ready to create and deploy a

service order. To create and deploy a service order:

1. In theNetworkActivate task pane, selectServiceProvisioning>ManageServiceOrders

> Create P2P Service Order.

2. In the Create P2P Service Orderwindow, select the service named p2p-dot1q-sd-1.

This is the customized service definition you created earlier.

3. Click Next.

4. In the General/Connectivity Settingswindow, in the Name field, enter so_1.

5. In the Customer field, select Best Customer.

6. Click Next.

The Endpoint Settingswindow appears.

7. For endpoint A, in the PE device field, select SJC.

8. In the UNI interface field, select ge-0/0/2.
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9. In the VLAN-ID field, enter 100.

10. Click Next.

11. In the Endpoint Settingswindow for endpoint Z, in the PE device field, select SFO.

12. In the UNI interface field, select ge-0/0/3.

13. In the Bandwidth field, select 25.

14. Click Create.

15. In the Deployment Optionswindow, select Deploy now.

16. ClickOK to start the deployment.

17. Tomonitor theprogressandstatusof thedeployment, in theOrder Informationwindow,

click the job ID. The JobManagement page shows the status of the job.

18. When you see in the JobManagementwindow that the deployment is successful, in

the Network Activate task pane, select Service Provisioning >Manage Services.

TheManage Services page shows the new service.

Performing a Functional Audit and a Configuration Audit

Nowthat yournewservice isdeployed, youshouldvalidate its configurationand functional

integrity. A functional audit runs operational commands on the device to verify that the

service is up or down. A configuration audit verifies whether the configuration that was

pushed to the device during deployment is actually on the device.

To perform a configuration audit and a functional audit of the service:

1. In theManage Services page, select the service instance you just deployed.

2. Right-click on the service instance or open the Actionsmenu and select Perform

Functional Audit.

3. In the Schedule Functional Auditwindow, you can choose to perform the audit now

or schedule it for later. Select Audit now, then clickOK.
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4. In theOrder Information screen, clickOK.

5. Right-click on the service instance or open the Actionsmenu and select Perform

Configuration Audit.

6. In theScheduleConfigurationAuditwindow, you can choose to perform the audit now

or schedule it for later. Select Audit now, and then clickOK.

7. In theOrder Informationwindow, clickOK.

When the audit jobs have finished, success is indicated by an up arrow in the top right

corner of the service.

8. To view the functional audit results:

a. In theManage Services page, select the so_1 service instance.

b. Open the Actionsmenu and select View Functional Audit Results.

c. In the Functional Audit Resultswindow, select each device to view the results.

9. To view the results of the configuration audit:

a. Open the Actions menu and select View Configuration Audit Results.

b. In the Configuration Audit Resultswindow, select each device in turn and review

the results. This report indicatesanypart of theserviceconfiguration that ismissing

on the device, or is inconsistent with the Junos Space database.

Following successful audit, the service is deployed and ready to be used.

Related
Documentation

Device Discovery Overview in the Junos Space Network Application Platform User Guide•

• Discovering Devices in the Junos Space Network Application Platform User Guide

• Pre-Staging Devices Overview on page 3

• Discovering and Assigning All N-PE Devices on page 54

• Discovering and Assigning N-PE Devices with Exceptions on page 56

• Predefined Point-to-Point Service Definitions on page 333

• Creating a Point-to-Point Ethernet Service Definition on page 97

• Publishing a Custom Service Definition on page 198

• Adding a New Customer on page 709

• Creating a Point-to-Point Service Order on page 438

• Performing a Functional Audit on page 805

• Deploying a Service on page 467

• Understanding Service Validation on page 753

• Deploying a Service on page 467

• Monitoring Performance Management Statistics on page 787
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• Viewing Performance Management Statistics on page 790

Example: Configuring and Deploying aMultipoint-to-Multipoint VPLS Service

This example shows how to deploy and verify a multipoint-to-multipoint VPLS service

starting with three MX Series routers. Figure 25 on page 632 shows the service.

Figure 25: SimpleMultipoint-to-Multipoint Service

This service provides connectivity for one VLAN, using 802.1Q interface endpoints.

Customer site A connects to the network through anN-PEdevice namedSJC (IP address

1.1.1.1). Customer site B connects to the network through an N-PE device named SFO (IP

address 1.1.1.2). Customer site C connects to the network through an N-PE device named

BLR (IP address 1.1.1.3). In this example, we allow Network Activate to select each UNI

automatically.

Each UNI is to have its bandwidth limited to 25 Mbps.

You can create this service by performing the following tasks:

• Preparing Devices for Discovery on page 633

• Discovering Devices on page 633

• Preparing Devices for Prestaging on page 634

• Discovering and Assigning N-PE Roles on page 636

• Choosing or Creating a Service Definition on page 637

• Creating a Customer on page 639

• Creating and Deploying a Multipoint-to-Multipoint Service Order on page 639

• Performing a Functional Audit and a Configuration Audit on page 640
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Preparing Devices for Discovery

Before you can add a device using device discovery, the following conditions must be

met:

• SSH v2 is enabled on the device. To enable SSH v2 on a device, issue the following CLI

command:

set system services ssh protocol-version v2

• The NETCONF protocol over SSH is enabled on the device. To enable the NETCONF

protocol over SSH on a device, issue the following CLI command:

set system services netconf ssh

• The device is configured with a static management IP address that is reachable from

the Junos Space server. The IP address can be in-band or out-of-band.

• A user with full administrative privileges is created on the device for the Junos Space

administrator.

• If youplan to useSNMP toprobedevices as part of device discovery, ensure that SNMP

is enabled on the device with appropriate read-only V1/V2C/V3 credentials.

Discovering Devices

Device discovery is a process that Junos Space uses to bring network devices under its

control. This example brings two MX Series routers under Junos Spacemanagement.

1. Log in to Junos Space using your credentials.

2. In the Applications Chooser, select Platform > Devices > Discover Devices > Discover

Targets.

3. In the Discover Targetswindow, click +.

The Add Device Targetwindow appears.

4. Select IP range.

5. Enter the IP address information. This example uses a range of three addresses.

6. Click Add, and then click Next.

7. In theDevices>DiscoverDevices>SpecifyProbeswindow, select bothPingandSNMP

as probes.

8. Click Next.
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9. In the Devices > Discover Devices > Specify Credentialswindow, click + and enter the

device login credentials.

10. Click Finish.

Device discovery begins. It displays a graph showing the status of the discovery

operation. Initially, three devices are discovered. When the Junos Space software has

accessed all three devices and brought themunder itsmanagement, all three devices

move from the Discovered column of the graph to the Managed column.

11. To check the results of the device discovery operation, select the Devicesworkspace

again, then select DeviceManagement. TheManage Devices page shows the added

devices.

Preparing Devices for Prestaging

Before prestaging devices for multipoint-to-multipoint services, the following entities

must be configured:

• MPLSmust run on each N-PE device.

• MPBGPmust run on each N-PE device that you want to participate in a

multipoint-to-multipoint service.

To satisfy the preceding criteria, ensure that the following configuration exists on each

N-PE device:

interfaces {
    ge-0/0/0 {
        unit 0 {
            family inet {
                address 10.1.22.2/30;
            }
            family mpls;
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        }
    }

    }
    lo0 {
        unit 0 {
            family inet {
                address 192.168.1.30/32;
            }
        }           
    }

}
routing-options {
    autonomous-system 65410;
}
protocols {
    mpls {
        interface ge-0/0/0.0;
        interface lo0.0;
    }
    bgp {
        group CA-Peer {
            type internal;
            local-address 192.168.1.30;
            family l2vpn {
                signaling;
            }
            neighbor 192.168.1.40;
            neighbor 192.168.1.10;
            neighbor 192.168.1.20;
            neighbor 192.168.1.50;
            neighbor 192.168.1.60;
        }
    }
    ospf {
        traffic-engineering;
        area 0.0.0.0 {
            interface lo0.0 {
                passive;
            }       
            interface ge-0/0/0.0;
    }
    ldp {
        interface ge-0/0/0.0;
        interface lo0.0;
    }
}

NOTE: The OSPF configuration is not required in prestaging.

TheVPLSservice needs tobeenabled in anetworkdevice, tomake the static pseudowire

functionality active in the device. You can activate the static pseudowire functionality

by configuring the network device through the CLI window. You need to enter the CLI

configuration mode of a network element and run the command

set protocols vpls static-vpls no-tunnel-services
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commit

If the device is not configured through CLI, awarningmessage appears in the application

server log, that is the JBOSS Log:

<Device name> should be configuredwith static VPLS no tunnel service rule.

To discover the roles of the various network elements configured:

1. Select Network Activate > Prestage Devices >Manage Device Roles.

2. Select Discover Roles to view the relevant window.

3. Click Continue to view the Role Discovery Statuswindow.

TheRoleDiscoveryStatuswindowdisplaysagraphwhichshowsthenumberofunassigned

devices that could be assigned the role of N-PE or PE.

To re-sync the role of the network elements configured:

1. Select Network Activate >Prestage Devices >Manage Device Roles.

2. To re-sync the role capability of a network element, right-click the network element’s

name.

3. Click Re-sync Role Capability. The Re-sync Role Capabilitywindow appears where you

can select the device’s name and click Re-sync.

The role is re-synced with the same device now.

Discovering and Assigning N-PE Roles

Before you can provision services, youmust prestage the devices. prestaging includes

assigning device roles and designating interfaces on those devices asUNIs. This example

provides the steps to accept the recommendations of the Network Activate software

for N-PE devices and UNIs.

1. In the Application Chooser, select Network Activate:

2. In the Network Activate task pane, select Prestage Devices >Manage Device Roles >

Discover Roles.

This action launches the rolediscoveryprocess inwhich theNetworkActivate software

examines thedevicesunder JunosSpacemanagement looking for devices thatmatch

predefined rules that identify N-PE devices. The Role Discovery Status graph shows

that, in this case, the Network Activate software has discovered three such devices.

3. In the Assign Roleswindow, switch to multiple selection mode and select both N-PE

devices.

4. Open the Actionsmenu and select Assign NPE role.

5. In the Assign NPEwindow, click Assign to confirm the assignment.

6. To view the assignment status, in the Job Detailswindow, click the job ID of the

assignment job.

Copyright © 2015, Juniper Networks, Inc.636

Junos Space Cross Provisioning Platform



The JobManagement page shows the progress and status of the role assignment job.

7. To verify the result, in the task pane, select Prestage Devices >Manage Device Roles.

TheManage Device Roles page shows devices you can use for provisioning.

Choosing or Creating a Service Definition

A service definition provides a template uponwhich services are built. It specifies service

attributes that are not specific to a service instance. In this example, the service definition

provides all service attributes except the N-PE devices, the UNIs, and bandwidth.

The Network Activate software ships with standard service definitions. First, we check

the standard service definitions to determine whether one already exists that can work.

1. In the Network Activate task pane, select ServiceDesign>ManageServiceDefinitions.

TheManageServiceDefinitionspage lists all service definitions in the system. In a new

system, the page lists only predefined service definitions.

This example requires amultipoint-to-multipoint service definitionwithUNIs that use

802.1Q interfaces and allow you to set a bandwidth of 25Mbps. The standard service

definitions have several examples for provisioning 802.1Q UNIs, but none that allow

the setting of a 25Mbps bandwidth limit. You need to create a new service definition.

2. In the Network Activate task pane, select Service Design>Manage Service Definitions

> Create VPLS Service Definition.

The Generalwindow appears.

3. Enter a name for the service definition.

4. Click Next.
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5. In the Connectivity Settingswindow—becausewe intend to select a specific VLAN for

each endpoint in the service—leave the Normalized VLAN setting as the default

Normalize to VLAN none, and then click Next.

6. In the UNI Settingswindow, in the Ethernet option field, select dot1q.

7. In the Customer traffic type field, select Transport single VLAN.

8. In the VLAN ID selection field, choose Selectmanually.

9. In the VLAN range for manual input, specify the range.

10. In theOuter Tag protocol ID, select 0x8100

11. In the Physical IF encapsulation field, select flexible-ethernet-service.

12. In the Logical IF encapsulation field, select vlan-vpls.

13. In the Bandwidth Settings panel, select the Enable rate limiting check box.

14. In the Default Bandwidth field, enter 10, for a default bandwidth of 10 Mbps.

15. To the right of the value you just entered, select the Editable in service order check

box.

The Default Bandwidth (Mbps) field becomes active.

16. Select the Enable in Service Order check box for the Default Bandwidth (Mbps) field.

The Min Bandwidth (Kbps), Max Bandwidth (Mbps), and Increment (Kbps) fields

become active.

17. In the Bandwidth range fields, enter 10 and 64 respectively.

18. In the Increment field, enter 64.

19. To save and complete the service definition, click Finish.
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TheManage Service Definitions page includes the new service definition.

You have created a customized Service Definition, but it has not yet been published.

Before a service definition can be used in provisioning, it must be published.

20.To publish the service definition, in theManage Service Definitions page, select the

vpls-dot1q-sd-1 servicedefinition, and then in theActionsmenu, selectPublishService

Definition.

The Publish Service Definitionwindow appears.

21. To confirm that you want to publish this service definition, click Publish.

In theManage Service Definitions page, the State column changes to Published.

The service definition is now ready for use in provisioning.

Creating a Customer

Beforeyoucanprovision theservice, customerdetailsmustbepresent in the JunosSpace

data base. To add a customer:

1. In the Network Activate task pane, select Service Provisioning >Manage Customers >

Create Customer.

2. In the Name field, enter Best Customer.

3. In the Account number field, enter 1234.

4. Click Create.

TheManage Customers page shows the new customer.

Creating and Deploying aMultipoint-to-Multipoint Service Order

Now that you have prestaged your devices, created a suitable service definition, and

added the customer information to the database, you are ready to create and deploy a

service order.

1. In theNetworkActivate taskpane, selectServiceProvisioning>ManageServiceOrders

> Create VPLS Service Order.

2. In theManage Service Definitions page, select the service definition named

vpls-dot1q-sd-1.

This service definition is the customized service definition you created earlier.

3. Click Next.

4. In theGeneralSettingsboxof theEnterOrderwindow, in theName field, entervpls_so_1.

5. In theCustomer field, select the customer forwhich you are creating the service order..

6. In the Endpoint Settings box of the Enter Order Informationwindow, in the Bandwidth

field, select 25.
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7. Clear the Autopick VLAN ID check box.

The End Point Settings box expands to include the VLAN ID field.

8. In the VLAN ID field, enter 600.

9. Click Next.

10. In the Select Endpoint PE Deviceswindow, select BLR, SFO, and SJC.

11. Click Create.

12. In the Endpoint Settingswindow click Next to accept the system-selected endpoints.

In theDeploymentOptionswindow, youcansave theserviceorder for laterdeployment,

schedule the serviceorder for later deployment, or deploy the serviceorder now.Select

Deploy now.

13. ClickOK to start the deployment.

14. Tomonitor theprogressandstatusof thedeployment, in theOrder Informationwindow,

click the job ID. The JobManagement page shows the status of the job.

15. When you see in the JobManagementwindow that the deployment is successful, in

the Network Activate task pane, select the Service Provisioningworkspace again.

16. In the task pane, selectManage Services.

TheManage Services page shows the new service.

Performing a Functional Audit and a Configuration Audit

Nowthat your newservice is deployed,we recommend that you validate its configuration

and functional integrity. A functional audit runs operational commands on the device to

verify that the service is up or down. A configuration audit verifies whether the

configuration thatwas pushed to the device during deployment is actually on the device.
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To perform a configuration audit and a functional audit of the service:

1. In theManage Services page, select the service instance you just deployed.

2. Open the Actionsmenu and select Perform Functional Audit.

3. In the Schedule Functional Auditwindow, you can choose to perform the audit now

or schedule it for later. Select Audit now, and then clickOK.

4. In theOrder Informationwindow, clickOK.

5. Open the Actionsmenu and select Perform Configuration Audit.

6. In theScheduleConfigurationAuditwindow, you can choose to perform the audit now

or schedule it for later. Select Audit now, and then clickOK.

7. In theOrder Informationwindow, clickOK.

8. To view the functional audit results,

• In theManage Services page, select the vpls_so_1 service instance.

• Right-click or open theActionsmenu to see the list of tasks available for this device,

and select View Functional Audit Results.

• In the Functional Audit Resultswindow, select each device to view the results.

9. To view the results of the configuration audit,

• Right-click or open theActionsmenu to see the list of tasks available for this device,

and select View Configuration Audit Results.

• In the ConfigurationAudit Resultswindow, select each device in turn and review the

results. This report indicates any part of the service configuration that is missing on

the device, or inconsistent with the Junos Space database.

Following a successful audit, the service is deployed and ready to be used.

Related
Documentation

Device Discovery Overview in the Junos Space Network Application Platform User Guide•

• Discovering Devices in the Junos Space Network Application Platform User Guide

• Pre-Staging Devices Overview on page 3

• Discovering and Assigning All N-PE Devices on page 54

• Discovering and Assigning N-PE Devices with Exceptions on page 56

• Predefined Multipoint-to-Multipoint Ethernet Service Definitions on page 365

• Creating a Multipoint-to-Multipoint VPLS Service Definition on page 117

• Publishing a Custom Service Definition on page 198

• Adding a New Customer on page 709

• Creating a Multipoint-to-Multipoint VPLS Service Order on page 491

• Deploying a Service on page 467

• Understanding Service Validation on page 753
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Example: Configuring and Deploying a Layer 3 VPN Full-Mesh Service

This example showshowtoset upasimple full-meshserviceproviderVPNconfiguration,

as shown in Figure 26 on page 642.

Figure 26: Simple Layer 3 VPN Full-Mesh Service

This service provides connectivity for one VLAN, (VLAN ID = 600). Customer site A

connects to thenetwork throughanN-PEdevicenamedSJC (IPaddress 1.1.1.1). Customer

site B connects to the network through an N-PE device named SFO (IP address 1.1.1.2).

Customer siteCconnects to thenetwork throughanN-PEdevicenamedBLR(IPaddress

1.1.1.3).

• Preparing Devices for Discovery on page 642

• Discovering Devices on page 643

• Preparing Devices for Prestaging on page 644

• Discovering and Assigning N-PE Roles on page 645

• Choosing or Creating a Service Definition on page 645

• Creating a Customer on page 647

• Creating and Deploying a Layer 3 VPN Service Order on page 647

• Performing a Functional Audit and a Configuration Audit on page 648

Preparing Devices for Discovery

Before you can add a device using device discovery, the following conditions must be

met:

• SSH v2 is enabled on the device. To enable SSH v2 on a device, issue the following CLI

command:

set system services ssh protocol-version v2
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• The NETCONF protocol over SSH is enabled on the device. To enable the NETCONF

protocol over SSH on a device, issue the following CLI command:

set system services netconf ssh

• The device is configured with a static management IP address that is reachable from

the Junos Space server. The IP address can be in-band or out-of-band.

• A user with full administrative privileges is created on the device for the Junos Space

administrator.

• If youplan to useSNMP toprobedevices as part of device discovery, ensure that SNMP

is enabled on the device with appropriate read-only V1/V2C/V3 credentials.

Discovering Devices

Device discovery is a process that Junos Space uses to bring network devices under its

control. This example brings two MX Series routers under Junos Spacemanagement.

1. Log in to Junos Space using your credentials.

2. In theNetworkActivate task pane, selectDevices>DiscoverDevices>DiscoverTargets.

3. In the Discover Targetswindow, click +.

The Add Device Targetwindow appears.

4. Select IP range.

5. Enter the IP address information. This example uses a range of three addresses.

6. Click Add, and then click Next.

7. In the Devices: Specify Probeswindow, select both Ping and SNMP as probes.

8. Click Next.

9. In the Devices: Specify Credentialswindow, click + and enter the device login

credentials.

10. Click Finish.

Device discovery begins. It displays a graph showing the status of the discovery

operation. Initially, three devices are discovered. When the Junos Space software has
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accessed all three devices and brought themunder itsmanagement, all three devices

move from the Discovered column of the graph to the Managed column.

11. To check the results of the device discovery operation, select the Devicesworkspace

again, then select DeviceManagement. TheManage Devices page shows the added

devices.

Preparing Devices for Prestaging

Before prestaging devices for multipoint-to-multipoint services, the following entities

must be configured:

• MPLSmust run on each N-PE device.

• MPBGPmust run on each N-PE device that you want to participate in a Layer 3 full

mesh service.

To satisfy the preceding criteria, ensure that the following configuration exists on each

N-PE device:

interfaces {
    ge-0/0/0 {
        unit 0 {
            family inet {
                address 10.1.22.2/30;
            }
            family mpls;
        }
    }

    }
    lo0 {
        unit 0 {
            family inet {
                address 192.168.1.30/32;
            }
        }           
    }

}
routing-options {
    autonomous-system 65410;
}
protocols {
    mpls {
        interface ge-0/0/0.0;
        interface lo0.0;
    }
    bgp {
        group IBGP {
            type internal;
            local-address 192.168.10.1;
            family inet-vpn {
      unicast; 
            }
            peer-as 65410;
            neighbor 192.168.10.4;
        }
    }
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    ospf {
        traffic-engineering;
        area 0.0.0.0 {
            interface lo0.0 {
                passive;
            }       
            interface ge-0/0/0.0;
    }
    ldp {
        interface ge-0/0/0.0;
        interface lo0.0;
    }
}

Discovering and Assigning N-PE Roles

Before you can provision services, youmust prestage the devices. prestaging includes

assigning device roles and designating interfaces on those devices asUNIs. This example

provides the steps to accept the recommendations of the Network Activate software

for N-PE devices and UNIs.

1. In the Network Activate task pane, select Prestage Devices >Manage Device Roles >

Discover Roles.

This action launches the rolediscoveryprocess inwhich theNetworkActivate software

examines thedevicesunder JunosSpacemanagement looking for devices thatmatch

predefined rules that identify N-PE devices. The Role Discovery Status graph shows

that, in this case, the Network Activate software has discovered three such devices.

2. In the Assign Roleswindow, switch to multiple selection mode and select both N-PE

devices.

3. Open the Actionsmenu and select Assign NPE role.

4. In the Assign NPEwindow, click Assign to confirm the assignment.

5. To view the assignment status, in the JobManagementwindow, click the job ID of the

assignment job.

The JobManagement page shows the progress and status of the role assignment job.

6. Toverify the result, in theNetworkActivate taskpane, selectPrestageDevices>Manage

Device Roles.

TheManage Device Roleswindow shows three devices that can be used for

provisioning.

Choosing or Creating a Service Definition

A service definition provides a template uponwhich services are built. It specifies service

attributes that are not specific to a service instance. In this example, the service definition

provides all service attributes except the N-PE devices, the UNIs, and bandwidth.

The Network Activate software ships with standard service definitions. First, we check

the standard service definitions to determine whether one already exists that will work.
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1. In the Network Activate task Pane, select ServiceDesign>ManageServiceDefinitions.

TheManageServiceDefinitionspage lists all service definitions in the system. In a new

system, the page lists only predefined service definitions.

This example requires a L3 VPN full mesh service definition with OSPF/Static routing

to allow each PE router to distribute VPN-related routes to and from connected CE

routers.

2. In the Network Activate task pane, select Service Design >Manage Service Definitions

> Create L3 VPN Service Definition.

The Generalwindow appears.

3. In the name field, enter the name “l3vpn-ospf-static-full-mesh-sd” for the service

definition.

4. In the Service type field, select L3 VPN (Full Mesh).

NOTE: Thisservicedefinitiondoesnot includeaservice templatedefinition
for the service, so the Service Template Definition field is left blank.

5. Click Next to save the General step information.

Continue with “UNI Settings” next.

6. In the VLAN ID selection field, select Selectmanually to have the service provisioner

select a VLAN ID for the service.

7. To enable the service provisioner to override this setting in a service order, select the

Editable in service order check box.

8. In the VLAN range for manual input, enter “500” and “700” for VLAN ID start and end

values to restrict the range of VLANs to this pool.

9. Click Next to save the UNI settings.

Continue with “Connectivity” next.

10. In the PE-Core Settings box, select Auto pick to allow the Network Activate software

to automatically select the route distinguisher.

11. In the PE-CE Settings box, select theOSPF/Static Route radio button for Allowed

RoutingProtocols touseOSPF/Static toalloweachPE router todistributeVPN-related

routes to and from connected CE routers.

12. Click Finish to save and create the Layer 3 VPN service definition.

13. To save and complete the service definition, click Finish.

TheManage Service Definitions page includes the new service definition.

You have created a customized Service Definition, but it has not yet been published.

Before a service definition can be used in provisioning, it must be published.
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14. To publish the service definition, in theManage Service Definitions page, select the

vpls-dot1q-sd-1 servicedefinition, and then in theActionsmenu, selectPublishService

Definition.

The Publish Service Definitionwindow appears.

15. To confirm that you want to publish this service definition, click Publish.

In theManage Service Definitions page, the State column changes to Published.

The service definition is now ready for use in provisioning.

Creating a Customer

Beforeyoucanprovision theservice, customerdetailsmustbepresent in the JunosSpace

data base. To add a customer:

1. In the Network Activate task pane, select Service Provisioning >Manage Customers >

Create Customer.

2. In the Name field, enter Best Customer.

3. In the Account number field, enter 1234.

4. Click Create

TheManage Customerswindow shows the new customer.

Creating and Deploying a Layer 3 VPN Service Order

Now that you have prestaged your devices, created a suitable service definition, and

added the customer information to the database, you are ready to create and deploy a

service order.

1. In theNetworkActivate task pane, selectServiceProvisioning>ManageServiceOrders

> Create L3 VPN Service Order.

2. In the Create L3 VPN Service Orderwindow, select the service definition named

l3vpn-ospf-static-full-mesh-sd.

This service definition is the customized service definition you created earlier.

3. Click Next.

4. In the General Settings box of the Enter Orderwindow, in the Name field, enter

l3vpn_ospf_full_mesh_so.

5. In the Customer field, select Best Customer.

6. In the VPNSettings box of the Enter Order Informationwindow, select the Apply to All

check box.

7. In the VLAN ID field, enter “600”.

8. Click Next.

9. In the Select Endpoint PE Deviceswindow, select BLR, SFO, and SJC.
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10. In the Endpoint Settingswindow, in the Interface IP field, enter an IP address/subnet

for the device, for example, 10.255.245.68/28.

11. In the Endpoint Settings window, in theOSPF area ID field, enter an IP address for the

OSPF area.

12. Click Save.

13. Repeat Step 10 through Step 12, for each endpoint device that you want to include in

the service.

14. In the Endpoint Settingswindow, clickNext to accept the system-selected endpoints.

15. ClickCreate todisplay theDeploymentOptionswindowwhereyoucansave theservice

order to deploy it later, schedule the deployment for a specific time, or deploy the

service now. Select Deploy now and clickOK to start the deployment.

16. Tomonitor the progress and status of the deployment, in the Order Information

window, click the job ID. The JobManagement page shows the status of the job.

17. When you see in the JobManagement page that the deployment is successful, in the

Network Activate task pane, select the Service Provisioning >Manage Services.

TheManage Services page shows the new Layer 3 VPN full mesh service.

Performing a Functional Audit and a Configuration Audit

Nowthat your newservice is deployed,we recommend that you validate its configuration

and functional integrity. A functional audit runs operational commands on the device to

verify that the service is up or down. A configuration audit verifies whether the

configuration thatwas pushed to the device during deployment is actually on the device.

To perform a configuration audit and a functional audit of the service:

1. In theManage Services page, select the service instance you just deployed.

2. Right-click or open the Actionsmenu and select Perform Functional Audit.

3. In the Schedule Functional Auditwindow, you can choose to perform the audit now

or schedule it for later. Select Audit now, and then clickOK.

4. In theOrder Informationwindow, clickOK.

5. Right-click or open the Actionsmenu and select Perform Configuration Audit.

6. In theScheduleConfigurationAuditwindow, you can choose to perform the audit now

or schedule it for later. Select Audit now, and then clickOK.

7. In theOrder Informationwindow, clickOK.

8. When the audit jobs have finished, success is indicated by an up arrow in the top right

corner of theManage Services page.

To view the functional audit results:

a. In theManage Services page, select the l3vpn_ospf_full_mesh_so service instance.

b. Right-click or open the Actionsmenu and select View Functional Audit Results.
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c. In the Functional Audit Resultswindow, select each device to view the results.

To view the results of the configuration audit:

a. Right-click or open the Actionsmenu and select View Configuration Audit Results.

b. In the Configuration Audit Resultswindow, select each device in turn and review

the results. This report indicatesanypart of theserviceconfiguration that ismissing

on the device, or inconsistent with the Junos Space database.

Following a successful audit, the service is deployed and ready to be used.

Related
Documentation

• Junos Space Layer 3 Services Overview on page 13

• Creating a Full Mesh Layer 3 VPN Service Definition on page 257

• Creating a Full Mesh Layer 3 VPN Ethernet Service Order on page 536
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PART 3

Administration

• Prestaging: Managing Devices and Device Roles on page 653

• Prestaging: Managing IP Addresses on page 695

• Service Design: Monitoring and Reporting on page 701

• Service Provisioning: Managing Customers on page 709

• Service Provisioning: Managing Deployed Services on page 715
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CHAPTER 15

Prestaging: Managing Devices andDevice
Roles

• Adding a UNI on page 654

• Assigning Device Roles on page 654

• Deleting UNIs on page 655

• Discovering Device Roles on page 655

• Changing the Loopback Address of an N-PE Device on page 657

• Excluding Devices from N-PE Role Assignment on page 657

• Excluding Interfaces from UNI Role Assignments on page 658

• Unassigning N-PE Devices on page 658

• Viewing N-PE Devices on page 659

• Viewing Pre-Staging Statistics on page 660

• Viewing Pre-Staging Rules on page 662

• Administering a Device Configlet Service Order for Cross Provisioning

Platform on page 663

• Administering a Device Configlet Service for Cross Provisioning Platform on page 664

• Decommissioning Bulk Device Configlet Services in Cross Provisioning

Platform on page 665

• Modifying a Device Configlet Service in Cross Provisioning Platform on page 666

• Adding Scripts Created for Cross Provisioning Platform on page 667

• Exporting Scripts Created for Cross Provisioning Platform on page 669

• Importing Scripts Created for Cross Provisioning Platform on page 671

• Modifying Scripts Created for Cross Provisioning Platform on page 671

• Viewing Scripts Created for Cross Provisioning Platform on page 673

• Adding a Third-Party Device to the Cross Provisioning Platform System on page 676

• Viewing Third-Party Device Details for Cross Provisioning Platform on page 677

• Synchronizing Third-Party Devices with the OSS for Cross Provisioning

Platform on page 678
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• Confirming Communication with the Third-Party OSS Server for Cross Provisioning

Platform on page 681

• Migrating Service Interfaces in Cross Provisioning Platform on page 682

• Modifying Bulk Services and Devices in Cross Provisioning Platform on page 687

• Viewing Script Version Support for Cross Provisioning Platform on page 692

Adding a UNI

To add a UNI to the list of UNIs that can be assigned to a service on a specific device:

1. In theNetwork Activate task pane, select the PrestageDevices >ManageDevice Roles.

2. In theManage Device Roleswindow, select the device on which you want to add an

interface to the list of potential UNIs.

3. Open the Actionsmenu and select Add Device UNIs.

4. The Assign Device UNIswindow appears, displaying all interfaces on the device that

have not been assigned.

5. Select the interface you want to make available for assignment as a UNI. To select

multiple interfaces, use the multiple selection feature.

6. Open the Actionsmenu and select Assign UNI.

7. In the Assign UNI rolewindow, click Confirm to assign the UNI.

Related
Documentation

Viewing N-PE Devices on page 659•

• Deleting UNIs on page 655

Assigning Device Roles

If you need to exclude devices from role assignment, or you need to exclude interfaces

from the list of interfaces that can be used as UNIs, use the procedures documented in

“Discovering and Assigning N-PE Devices with Exceptions” on page 56.

To assign all discovered roles and interfaces:

1. In the Network Activate task pane, select Prestage Devices >Manage Device Roles >

Assign Roles.

2. In the Assign Roles page, clickMultiple in the quick view pane and select all devices.

3. Open the Actionsmenu and select Assign NPE Role.

4. In the confirmation window, click Assign.

5. To view the assignment status, in the JobManagementwindow, click the job ID of the

assignment job.

The JobManagement page shows the progress and status of the role assignment job.

See Viewing Jobs in the Junos Space Network Application Platform User Guide for details.
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While the job is ongoing, you cannotmake additional assignments from theAssignRoles

page. The Assign NPE Role action is dimmed to indicate you cannot select it.

Deleting UNIs

After performing the initial assignment of N-PE devices and UNIs, you can still exclude

additional interfaces from the list of UNIs so long as those UNIs are not assigned to

services.

To remove an interface from consideration as a UNI:

1. In theNetwork Activate task pane, select thePrestageDevices >ManageDevice Roles.

2. In theManage Device Roles page, select the device you want to work on.

3. Open the Actionsmenu and selectManage Device UNIs.

TheManage Device UNIswindow appears, showing all interfaces assigned the UNI

role.

4. Select the interface you no longer want to have the UNI role. To unassign multiple

interfaces, use the multiple selection feature.

5. Open the Actionsmenu and select Delete UNI.

6. In the Exclude fromUNI Role confirmation window, click Exclude.

Related
Documentation

Viewing N-PE Devices on page 659•

• Adding a UNI on page 654

Discovering Device Roles

To discover the roles of devices found during element discovery:

1. In the Network Activate task pane, select Prestage Devices >Manage Device Roles >

Discover Roles.

The Role Discovery Statuswindow shows the discovery of unassigned devices found

in the database.:
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The graph portion of this example shows howmany of the unassigned devices the

pre-staging rules determined could be assigned the N-PE role and howmany could

be assigned the P role. The UNKNOWN bar indicates devices that had no MPLS role

assigned but for which the Network Activate software was unable to recommend a

role.

NOTE: You cannot discover a device as a PE device if no user-to-network
interfaces (UNIs) are available in the device.

The Network Activate application throws the following error message:

2012-06-08 10:17:23,446 ERROR [PreStageDeviceManagerBean]
(PreStageDeviceManagerBean#savePreStageDeviceList Thread-6894
(group:HornetQ-client-global-threads-1332782448):) No ge/fe/at/t1
interfaces in this PE device: junos-mx480-space; it can only be used for
virtual routers

2. To view the devices for which the Network Activate software recommends the PE

role, click on the N_PE bar.

The Assign Roleswindow appears.

The question mark on each icon indicates that the device role has not yet been

assigned.
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Device role discovery is now complete. To assign device and interface roles, follow the

steps in the next section, “Assigning Device Roles” on page 56.

Changing the Loopback Address of an N-PE Device

The Network Activate software allows you to change the loopback address of an N-PE

device to that of a different loopback unit.

NOTE: Although Junos software allows you to assignmultiple loopback
addresses to the same loopback unit, the Junos Space software recognizes
only the first address assigned to the loopback unit. Therefore, when you
change the loopback address of an N-PE device, it must be to that of a
different loopback unit.

To change the loopback address of an N-PE device:

1. In the Network Activate task pane, select Prestage Devices >Manage Device Roles >

Assign Roles.

The results of themost recent role discovery operation appear, including any changes

you have subsequently made to your pre-staging data.

Repeat Step 2 through Step 5 for each device for which you want to change the

loopback address.

2. In theAssignRoles page, select the device forwhich youwant to change the loopback

address.

3. Open the Actionsmenu and selectModify Loopback Address.

4. In theModify Loopback Addresswindow, select the loopback address you want to

use.

5. ClickModify.

The new loopback address appears.

Related
Documentation

Excluding Devices from N-PE Role Assignment on page 59•

Excluding Devices fromN-PE Role Assignment

The rules-driven process that the Network Activate software uses to discover device

roles recommends the correct roles in most cases. To exclude a device from N-PE role

assignment:

1. In the Network Activate task pane, select Prestage Devices >Manage Device Roles >

Assign Roles.

The results of the most recent role discovery operation appear.

2. In the Assign Roles page, select the N-PE device that you want to exclude from role

assignment. To exclude several N-PE devices, use the multiple selection capability.
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3. Open the Actionsmenu and select Exclude fromNPE Role.

The Assign Roles page refreshes. The excluded devices are no longer visible.

Related
Documentation

Changing the Loopback Address of an N-PE Device on page 60•

Excluding Interfaces fromUNI Role Assignments

To exclude interfaces from the list of interfaces that the pre-staging rules determined

were suitable for use as UNIs:

1. In the Network Activate task pane, select Prestage Devices >Manage Device Roles >

Assign Roles.

The results of themost recent role discovery operation appear, including any changes

you have subsequently made to your pre-staging data.

Repeat Step 2 through Step 7 for each device for which you want to exclude some

recommended UNI selections:

2. In the Assign Roles page, select the device for which you want to manage UNIs.

3. Open the Actionsmenu and selectManage Device UNIs.

TheManage Device UNIswindow shows all the device interfaces for the selected

device and indicates those that the Network Activate software recommends for use

as UNIs.

4. In theManage Device UNIswindow, select the UNI you want to exclude.

To excludemore than one UNI, use the multiple selection capability.

5. Open the Actionsmenu and select Exclude fromUNI Role.

6. Open theActionsmenu and selectReturn toAssignRoles to return to theAssignRoles

page.

Related
Documentation

Excluding Devices from N-PE Role Assignment on page 59•

Unassigning N-PE Devices

To unassign an N-PE device so that it can no longer be assigned to a service:

NOTE: Before you an unassign an N-PE device, it must not be assigned to
any deployed service.

1. In the Network Activate task pane, select Prestage Devices > Manage Device Roles.

2. In theManage Device Roles page, select the N-PE device you want to unassign.

3. Open the Actionsmenu and select Unassign NPE Role.
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NOTE: If services are deployed on this device, the Unassign NPE Role
action will be dimmed and not selectable.

4. TheManageDeviceRolespage refreshes and shows that the selecteddevice has been

removed.

Related
Documentation

Viewing N-PE Devices on page 659•

• Discovering and Assigning All N-PE Devices on page 54

• Discovering and Assigning N-PE Devices with Exceptions on page 56

Viewing N-PE Devices

You can view network devices that have been assigned the N-PE role.

The following topic provides a procedure for viewing N-PE devices:

• Viewing N-PE Devices in a Table on page 659

Viewing N-PE Devices in a Table

To view N-PE devices in a table:

1. In the Network Activate task pane, select Prestage Devices >Manage Device Roles.

TheManage Device Roles page displays the following information about all N-PE

devices on your network:

• Name—The assigned device name.

• Management address—The IP address to which the Junos Space fabric connects

to the device.

• Loopback address—The IP address type used by a device to send a packet to itself.

2. To viewmore device details and UNI information, double-click the table row for the

device. The NPE Detailswindow appears. The detailed view lists all UNIs discovered

on the device with the applied VLAN pool profile and includes the following device

information:

• Name—The name assigned to the device

• MPLS role—The assigned MPLS role for the N-PE device

• Management address—The IP address to which the Junos Space fabric connects

to the device

• Loopback address—The IP address type used by a device to send a packet to itself.

• Connection status—up or down.

• Service capability—N-PE device role: L2 or L3.

• UNI Interfaces—All assignedUNIs on the devicewith the applied VLAN pool profile.
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Related
Documentation

Pre-Staging Devices Overview on page 3•

• Viewing Pre-Staging Statistics on page 660

• Viewing Pre-Staging Rules on page 662

• Adding a UNI on page 654

• Unassigning N-PE Devices on page 658

• Deleting UNIs on page 655

• Discovering Devices in the Junos Space Network Application Platform User Guide

Viewing Pre-Staging Statistics

The landing page for the Prestage Devices workspace contains charts and graphs that

provide information about available capacity on discovered N-PE devices. You can

determine which devices have UNIs available, or which devices have plenty of available

capacity for routing services.

The following topicsdescribeviewingstatistics in thePrestageDevicesworkspace landing

page:

• Viewing Available UNIs on N-PE Devices on page 660

• Viewing Services on N-PE Devices on page 661

Viewing Available UNIs on N-PE Devices

To view the number of available UNIs on each device allocated an N-PE role:

1. In the Network Activate task pane, select Prestage Devices.

The Junos Space software displays the chart named List of Available UNI Interfaces

per Device.
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Each vertical bar represents an N-PE device. The number of UNIs is shown on the Y

axis. If more than four devices on your network have been assigned the N-PE role,

drag the slider across the bottom of the graph to view all devices.

2. To list the UNIs configured on a specific N-PE device:

a. Click on the bar that represents the device.

b. In theManage Device Roles page, double-click the device.

TheManage Device Roles page shows only the data for the selected device.

Viewing Services on N-PE Devices

To view the number of services provisioned on each N-PE device in your network:

1. In the Network Activate task pane, select Prestage Devices.

The Junos Space software displays the chart named Number of Services per Device.
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2. Each vertical bar represents an N-PE device. The number of services provisioned on

each device is shown on the Y axis. If more than four devices on your network have

been assigned the N-PE role, drag the slider across the bottom of the graph to view

all devices.

3. To find outmore information about the services provisioned on a specific device, click

on the bar that represents the device.

TheManage Services page displays only those services provisioned on that device.

Related
Documentation

Pre-Staging Devices Overview on page 3•

• Viewing Services on page 776

• Viewing Managed Devices

Viewing Pre-Staging Rules

Pre-staging rules contain criteria for classifying the MPLS role of each device and

recommendingwhichphysical interfacesshouldbeUNI interfaces.Foreach recommended

UNI interface, the system recommends its primary loopback address.

These pre-staging rules are predefined and cannot be configured. They are neither

selectable nor configurable. However, you canmodify the results of the rules before

committing the recommended assignments to the database.
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The following topic shows how to view pre-staging rules. You can view a summary of all

pre-staging rules, see a summary, or view details of a specific pre-staging rule.

• Viewing Pre-Staging Rules in a Table on page 663

Viewing Pre-Staging Rules in a Table

To view pre-staging rules in a tabular format:

1. In the Network Activate task pane, select Prestage Devices >Manage Device Roles >

Rules.

The Ruleswindow appears.

The Ruleswindow lists all the pre-staging rules by type, along with the name and a

brief description of each rule.

2. To view rule details, including a sample configuration, double-click the table row.

Related
Documentation

Pre-Staging Devices Overview on page 3•

• Viewing N-PE Devices on page 659

• Discovering and Assigning All N-PE Devices on page 54

• Discovering and Assigning N-PE Devices with Exceptions on page 56

Administering a Device Configlet Service Order for Cross Provisioning Platform

To administer a device configlet service order for cross provisioning platform:

1. In the Cross Provisioning Platform task pane, select CPP > Device Configlet Orders.

2. In the Device Configlet Orders inventory page, display or delete a device configlet

order, as indicated in the following table.

ProcedureAction

To view the configuration of a device configlet order, do one of the following:

• Select and right-click a device configlet order, and then select ViewOrder Configuration.

• Select a device configlet order and then click the View CPPDevice Configlet icon.

ViewOrder Configuration

To delete a device configlet order:

1. Select and right-click a device configlet order.

2. Select Delete Device Configlet.

Delete Device Configlet

Related
Documentation

Creating and Deploying a Device Configlet Order for Cross Provisioning Platform on

page 194

•

663Copyright © 2015, Juniper Networks, Inc.

Chapter 15: Prestaging: Managing Devices and Device Roles



Administering a Device Configlet Service for Cross Provisioning Platform

To administer a device configlet service for cross provisioning platform:

1. In the Cross Provisioning Platform task pane, select CPP > Device Configlet Services.

2. In the Devices Configlet Services inventory page, display or decommission a device

configlet service, performaconfiguration audit onadevice configlet service, or display

service configuration changes, as indicated in the following table:

ProcedureAction

To view the device configlet service details:

1. Select a device configlet service.

2. Click the View CPPDevice Configlet icon.

Viewing the Device
Configlet Service details

To decommission a device configlet service:

1. Select a device configlet service.

2. Right-click the device configlet service, and select Service > Decommission Device Configlet.

3. Do one of the following:

• To decommission the service immediately, select Decommission now, and clickOK.
In theOrder Informationwindow, click the job ID of the decommission job.

The JobManagement page appears and shows a filtered view of the job inventory, showing
only the decommission job.

• To deploy the service at a later time, select Decommission later, select a date and time, then
clickOK.

Decommissioning a Device
Configlet Service

To perform a configuration audit on a device configlet service:

1. Select a device configlet service.

2. Right-click the device configlet service, and select Audit > Perform Configuration Audit.

3. In the Schedule Configuration Auditwindow, do one of the following:

• To audit the service configuration immediately, select Audit Now, then clickOK.
An Audit Informationwindow appears, providing a link to details about the audit in the Job
Managementworkspace, and anOK button.

• To audit the service configuration at a later time, select Audit Later, enter a date and time,
then clickOK.

PerformingaConfiguration
Audit

To view the service configuration changes:

1. Select a device configlet service.

2. Right-click the device configlet service, and select Audit > Service Configuration Changes.

The Service Configuration window displays the list of devices and its configuration.

Viewing the Service
Configuration Changes

Related
Documentation

Creating and Deploying a Device Configlet Order for Cross Provisioning Platform on

page 194

•
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Decommissioning Bulk Device Configlet Services in Cross Provisioning Platform

Use theDeviceConfigletServicespage todecommissionmultipledeviceconfiglet services

of Cross Provisioning Platform in bulk. You can select the number of services that a single

page displays, by selecting one of the following values from the Show items drop-down

list at the bottom of the page:

• 10

• 20

• 40

• 60

• 80

• 100

• 200

To decommission device configlet services in bulk:

1. FromtheCrossProvisioningPlatform taskpane, selectCPP>DeviceConfigletServices.

The Device Configlet Services page that appears displays a list of existing services.

2. Select the check boxes against the device configlet services that you want to

decommission.

3. Either right-click and select Service > Decommission or click the Decommission icon

on thegrid tool bar. Youcanalsodecommissiona serviceby selectingActions>Service

> Decommission.

TheScheduleDecommission page appearswhere the selected services are listed. You

can schedule the decommissioning to happen immediately or later at a scheduled

time.

NOTE: You cannot decommission a service that has beenmodified on
the Services page unless the value of theOrder State field of the

corresponding service is Completed. You can decommission only 25

services at a time. If the count exceeds 25, the following error message
appears:

Service decommissioning cannot be scheduled if the selected services count

is greater than 25.
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4. Select theDecommissionnowoptionbuttontodecommission theservices immediately.

You canalsodecommission the selected services later by selecting theDecommission

later option button and setting the preferred date and time.

5. ClickOK to decommission the selected device configlet services.

The Job Details dialog box appears with a list of job IDs.

NOTE: For every device configlet service that is selected to be
decommissioned, a unique job ID is assigned. You can view the details of
each job on the JobManagement page by clicking the corresponding job

ID.

For every device configlet service that is decommissioned, a message is logged on the

Audit Logpage. To view theAudit Logpage, selectNetworkManagementPlatform>Audit

Logs > Audit Log.

Related
Documentation

Decommissioning a Service on page 716•

Modifying a Device Configlet Service in Cross Provisioning Platform

Use the Device Configlet Services landing page to modify a device configlet service in

Cross Provisioning Platform. You canmodify a device configlet service only if a

modification script is attached to the device configlet service.

Tomodify a device configlet service:

1. FromtheCrossProvisioningPlatform taskpane, selectCPP>DeviceConfigletServices.

The Device Configlet Services page that appears displays a list of existing device

configlet services.

2. Select and right-click a device configlet service that you want to modify.
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3. Either right-click a device configlet service and select Service >Modify or select a

service and click theModify icon on the grid tool bar. You can alsomodify a service by

selecting the service and then selecting Actions >Modify.

TheModify Service page appears.

NOTE: TheModify Service page details vary according to the type of the

selected device configlet service.

4. Modify the device configlet service details and clickModify.

The Job Details dialog box appears along with a job ID link.

5. Click the Job ID link to view the job details.

The JobManagement page that appears contains a list of the jobs, along with the

status of the jobs.

Related
Documentation

Modifying Bulk Services and Devices in Cross Provisioning Platform on page 687•

Adding Scripts Created for Cross Provisioning Platform

Before you can create a cross-platform service definition, youmust add scripts to the

system that enable management of the Juniper Networks devices and the devices of

another vendor.

To enable cross provisioning platform, you add three types of scripts:

• JunosXSLT—Provides the code that enablesprovisioningaparticular JuniperNetworks

device.

• SAMXSLT—Provides the code that enables provisioning the device of another vendor.

• GUI JavaScript—Provides the code that renders the Cross Provisioning Platform GUI

window required for provisioning a Juniper Networks device.
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To view the scripts that have been loaded into the system:

1. In the Cross Provisioning Platform task pane, select CPP > Scripts.

2. In the Scriptswindow, select the Add Scripts icon on the command bar (+).

3. In the Add Script(s)window, select a feature type and its corresponding vendor type

froma list of features in theFeatureTypedrop-down list. These features require scripts

in the cross provisioning platform.

4. In theAddScript(s)window, you canbrowse your local client file system for the scripts

you want to be available to the Cross Provisioning Platform application. You can add

scripts for Juniper Networks devices and for the devices of other vendors. If you select

Junos Space in the Vendor type field, the window displays fields for selecting both

Configuration script and GUI script.

NOTE: If you want to do service interfacemigration, you need to upload
both Configuration script and the GUI script.

If you select a third-party in the Vendor type field, the window displays a field for

selecting a Configuration script only.
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NOTE: If you access the server on which the Junos Space software is
installed as a remote client, youmust copy the scripts you intend to add
to the CPP system to your local client file system. That is, when you click
on Browse to select a script, which you want to add, Junos Space opens

the local client file system,not the file systemof the server onwhich Junos
Space is installed.

5. For each script, add the appropriate information for each field and click Create.

Related
Documentation

Importing Scripts Created for Cross Provisioning Platform on page 671•

• Modifying Scripts Created for Cross Provisioning Platform on page 671

• Exporting Scripts Created for Cross Provisioning Platform on page 669

• Viewing Scripts Created for Cross Provisioning Platform on page 673

Exporting Scripts Created for Cross Provisioning Platform

To export scripts created for cross provisioning platform:

1. In the Cross Provisioning Platform task pane, select CPP > Scripts.

2. In the Scripts inventory page, select the script that you want to export and click the

Export Script icon in the command bar.
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3. In the Export Scriptwindow, click the link that enables you to bundle scripts into a ZIP

file for exporting to a local file system.

4. In theOpen exportscript_name.zipwindow, browse to the location in the local file

system to which you want to export the script bundle.

5. ClickOK.

Related
Documentation

Importing Scripts Created for Cross Provisioning Platform on page 671•

• Modifying Scripts Created for Cross Provisioning Platform on page 671

• Adding Scripts Created for Cross Provisioning Platform on page 667

• Viewing Scripts Created for Cross Provisioning Platform on page 673
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Importing Scripts Created for Cross Provisioning Platform

To import scripts created for cross provisioning platform:

1. In the Cross Provisioning Platform task pane, select CPP > Scripts.

2. In the Scripts inventory page, click the Import Script icon in the command bar.

3. In the Import Scriptswindow, browse the local file system to locate the script you

want to import into the CPP system.

4. Click Import.

The imported script is displayed in theManage Scriptswindow.

NOTE: The IE browser enables importing only a single script at time.

Related
Documentation

Exporting Scripts Created for Cross Provisioning Platform on page 669•

• Modifying Scripts Created for Cross Provisioning Platform on page 671

• Adding Scripts Created for Cross Provisioning Platform on page 667

• Viewing Scripts Created for Cross Provisioning Platform on page 673

Modifying Scripts Created for Cross Provisioning Platform

The Cross Provisioning Platform application allows you to modify an existing script.

To modify an existing configuration or GUI script:

1. In the Cross Provisioning Platform task pane, select CPP > Scripts.

The Scripts inventory page appears.

2. Select a script from the list of displayed scripts and click theModify Script icon in the

command bar.

The Modify Script window appears.
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3. In theModify Scriptwindow, modify the script by performing one of the following

tasks:

• Browse the local file system to upload the script that you havemodified in your

local file system.

• Modify the script directly in the text area.

The fields in the Modify Script window are described in Table 29 on page 672.

Table 29: Fields in theModify ScriptWindow

DescriptionField

The Name field displays the name of the selected script.Name

If you have entered a description while creating a script, the Description field displays the
description of the selected script.

Description

The Version list displays the latest version number of the script. You can select the preferred
version from the list. For more information about the script version, see “Viewing Script
Version Support for Cross Provisioning Platform” on page 692.

NOTE: By default, the latest version of the script is populated in the text area.

Version

The Vendor Type field displays the name of the vendor.

• Junos Space

• Alcatel SAM

Vendor Type

On clicking the Configuration Script tab, you can browse and upload the configuration script
fromyour local file system.After uploading theconfiguration script fromyour local file system,
the newly uploaded script is displayed in the text area.

If you prefer to make changes to the existing configuration script, the Cross Provisioning
Platform application provides you with the option tomodify the configuration script directly
in the text area.

Configuration Script
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Table 29: Fields in theModify ScriptWindow (continued)

DescriptionField

On clicking the GUI Script tab, you can browse and upload the GUI script from your local file
system. After uploading the GUI script from your local file system, the newly uploaded script
is displayed in the text area.

If you prefer to make changes to the existing configuration script, the Cross Provisioning
Platform application provides you with the option tomodify the configuration script directly
in the text area.

NOTE: If the vendor type is Alcatel SAM, the GUI Script tab is not displayed.

GUI Script

To save the changes, click Save.Save

To preview the changes, click Preview. You can preview the GUI script output before creating
a service.

Preview

To discard the changes, click Cancel.Cancel

4. Click Save.

The systemmodifies the script and updates the version number.

Related
Documentation

Importing Scripts Created for Cross Provisioning Platform on page 671•

• Exporting Scripts Created for Cross Provisioning Platform on page 669

• Adding Scripts Created for Cross Provisioning Platform on page 667

• Viewing Scripts Created for Cross Provisioning Platform on page 673

• Debugging a Cross Provisioning Platform Script on page 799

Viewing Scripts Created for Cross Provisioning Platform

To view the details of the scripts added to the system to enabled cross provisioning

platform:

1. In the Cross Provisioning Platform task pane, select CPP > Scripts.

2. In the Scripts inventory page, double-click the script for which you want to view its

details.

The Script Detailswindow displays a Configuration Script tab and a GUI Script tab.
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The Configuration Script tab displays the script for the particular Juniper Networks

device.

NOTE: If you select a script that was created for managing the device of
another vendor, theScriptDetailswindowdisplays theConfigurationScript

tab only.

3. Click the GUI Script tab to display the code that generates the GUI window for

configuring the associated Juniper Networks device.
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4. Click Preview to display the Endpoint Settingswindow that is generated by the GUI

script.

Related
Documentation

Importing Scripts Created for Cross Provisioning Platform on page 671•

• Modifying Scripts Created for Cross Provisioning Platform on page 671

• Exporting Scripts Created for Cross Provisioning Platform on page 669
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• Adding Scripts Created for Cross Provisioning Platform on page 667

Adding a Third-Party Device to the Cross Provisioning Platform System

To add a third-party device to the cross provisioning platform system:

1. In the Cross Provisioning Platform task pane, select CPP > Third-Party Devices.

2. In the Third-Party Deviceswindow, click the Add Third-Party Device icon (+).

3. In the AddOSSDevicewindow, click the Host Name or IP Address button and then

enter the hostname or IP address of the device.

4. Click Add.

The device is displayed in the Third-Party Deviceswindow.

Related
Documentation

Viewing Third-Party Device Details for Cross Provisioning Platform on page 677•

• Synchronizing Third-Party Devices with the OSS for Cross Provisioning Platform on

page 678
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Viewing Third-Party Device Details for Cross Provisioning Platform

To view the details of a device added for cross provisioning platform:

1. In the Cross Provisioning Platform task pane, select CPP > Third-Party Devices.

2. In theThird-PartyDevicewindow, select adevice fromthe list andclick theViewDevice

Details icon in the command bar.

3. When you are done viewing the device details, clickOK.

Related
Documentation

Adding a Third-Party Device to the Cross Provisioning Platform System on page 676•

• Synchronizing Third-Party Devices with the OSS for Cross Provisioning Platform on

page 678
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Synchronizing Third-Party Devices with the OSS for Cross Provisioning Platform

TheCrossProvisioningPlatform(CPP) featureenables you tosynchronize the third-party

devices added to the CPP systemwith the Operations Support System (OSS) of the

third party.

You can set a synchronization job to run daily at a time you specify (default 5:00 AM).

The job synchronizes the following data with the CPP system:

• The job synchronizes devices newly added to the SAM server.

• The job synchronizes ports newly added or deleted from existing devices.

• Devices deleted from the SAM server are deleted from the CPP system if the device is

no longer associated with an active service that was created in CPP.

To set the time at which you want the synchronization job to run:

1. In theNetworkManagementPlatform taskpane, selectAdministration>Applications.

2. In the Applicationswindow, select Network Activate.

3. From the Actionsmenu, selectModify Application Settings.

4. In theModify Application Settingswindow, selectOSSConfigParameters.
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NOTE: The HTTP Connection Timeout parameter is measured in

milliseconds.

5. In the Synchronize OSS Inventory daily at given time field of theOSSConfigParameters

panel, set the time at which you want the synchronization job to run.

NOTE: The time at which the synchronization job runs is associated with
the location of the browser in which you are using the Junos Space
software. That is, the synchronization job runs according to the browser
timewhere the job is scheduled,notaccording to the timewhere the Junos
Space server is located.

You can also manage synchronization operations from the CPP feature in the Cross

Provisioning Platform application.

In the Cross Provisioning Platform task pane, select CPP > Third-Party Devices.

The CPP > Third-Party Deviceswindow displays four icons in the command bar, which

enable you to run the following synchronization operations:
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• Synchronize all the devices with OSS.

This operation displays a message that requests confirmation.

• Synchronize selected device with OSS.

This operation displays a message that requests confirmation.

• Schedule OSS synchronization job.

This operationdisplays amessage that provides the status of thedaily synchronization

job.

• Cancel OSS synchronization job.

This operation displays a message that confirms cancellation of the daily

synchronization job.
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Related
Documentation

Adding a Third-Party Device to the Cross Provisioning Platform System on page 676•

• Viewing Third-Party Device Details for Cross Provisioning Platform on page 677

Confirming Communication with the Third-Party OSS Server for Cross Provisioning
Platform

To confirm that the cross provisioning platform system can communicate with the OSS

server:

1. In the Cross Provisioning Platform task pane, select CPP > Third Party Devices.

2. In the Third-PartyDeviceswindow, click thePingOSSServer icon in the command bar.

The Ping OSS – Statuswindow indicates whether or not the CPP system has access

to the OSS server.

Related
Documentation

Synchronizing Third-Party Devices with the OSS for Cross Provisioning Platform on

page 678

•

• Preconfiguring theThird-PartyOSSDevice for CrossProvisioningPlatformonpage 196
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Migrating Service Interfaces in Cross Provisioning Platform

When an interface becomes faulty or needs to bemigrated to a higher-capacity port,

youmustmigrate all services deployedona specific interface to thedestination interface

on the samedevice. In all thedevicesof JuniperNetworks, theCrossProvisioningPlatform

application actually modifies the device configuration to migrate all the services. The

Cross Provisioning Platform application deletes the source interface and adds the

destination interface to the service. A migration XSLT script is required to generate the

configuration changes to delete or add an interface from or to a service. The script is

independent of the service type and attached to the device configlet definition.

Before you canmigrate the service interfaces in Cross Provisioning Platform, make sure

that the configuration script and the GUI script are present in the local machine.

Tomigrate interfaces on third-party devices, a third-party networkmanagement product

is required to modify the device configuration.

To perform service interface migration on Juniper Networks devices:

1. From the Cross Provisioning Platform task pane, select CPP > Scripts.

TheScriptspage that appearsdisplaysa list of existing scripts in theCrossProvisioning

Platform application.

2. Click Add Script above the tool grid.

The Add Script(s) page appears.

3. In the Name field, type 3 through 128 alphanumeric characters to identify the name

of the script.

4. In theDescription field, type 3 through 128 alphanumeric characters to further identify

the script you named.

5. From the Vendor Type drop-down list, select Junos Space.

6. Click Browse and select the configuration script and the GUI script from the local

machine to add them to the Cross Provisioning Platform application.

7. Click Create to add the scripts that you uploaded.

A confirmation dialog box appears with the Scripts added successfullymessage.

8. ClickOK.

9. From the Cross Provisioning Platform task pane, select CPP > Service Definition.

TheServiceDefinitionpage thatappearsdisplaysa list of theexisting servicedefinitions

in the Cross Provisioning Platform application.

10. Click the Create CPP Service Definition icon above the tool grid.

The Create Service Definition dialog box appears with the General, the SAMService

Scripts, and the JUNOS Space Service Scripts sections.

11. On the Create Service Definition page, perform the following steps:

Copyright © 2015, Juniper Networks, Inc.682

Junos Space Cross Provisioning Platform



• In the General section:

a. In the Name field, type 3 through 128 alphanumeric characters to identify the

name of the service definition.

b. In the Description field, type 3 through 128 alphanumeric characters to further

identify the service definition you named.

c. From the Type drop-down list, select Device.

• In the SAMService Scripts section:

a. From the Creation drop-down list, select the appropriate SAM service script.

b. From theModification drop-down list, select the appropriate SAM service script.

• In the JUNOS Space Service Scripts section:

a. From the Creation drop-down list, select the appropriate Junos Space service

script.

b. FromtheModificationdrop-down list, select theappropriate JunosSpace service

script.

12. Click Create.

The Service Definition page appears with the existing service definitions along with

the service definition that you created.

13. From the Cross Provisioning Platform task pane, select CPP > InterfaceMigration.

The page that appears has two tabs: Juniper Devices and Third-party Devices. The

Juniper Devices tab displays a list of Juniper Networks devices onwhich themigration

of service interfaces can be performed. The Third-party Devices tab displays a list of

Alcatel devices on which the migration of service interfaces can be performed.

14. Select the Juniper Devices tab.

15. Select a device to view the interfaces corresponding to that device.

The Select From Interface page appears with a list of interfaces and the operation

status of all the interfaces.

16. Right-click any interface and selectMigrate Services.

The InterfaceMigration page appears, where the Name, Device, and From Interface

fields are already populated on the basis of the interface that you selected.
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17. Perform the following steps on the InterfaceMigration page:

a. From the To Interface drop-down list, select an interface to which you want to

migrate the services.

b. From the Service Definition drop-down list, select the service definition that you

created.

c. In the Description field, type 3 through 128 alphanumeric characters to identify the

service interface migration.

18. ClickMigrate to initiate the service interface migration.

A job is triggered to show themigration status.

NOTE: When youmigrate one service interface, the configuration of all
the services present in that interface from the device CLI, irrespective of

the services present on the Junos Space server, are alsomigrated. You
can do the service interfacemigration only for one device at a time.
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Perform the following steps to migrate services to third-party devices:

1. Select CPP > InterfaceMigration.

The page that appears has two tabs: Juniper Devices and Third-party Devices. The

Juniper Devices tab displays a list of Juniper Networks devices onwhich themigration

of service interfaces can be performed. The Third-party Devices tab displays a list of

Alcatel devices on which the migration of service interfaces can be performed.

2. Select the Third-party Devices tab.

A list of all the third-party devices linked to Cross Provisioning Platform is shown.

3. Select a device to view the interfaces corresponding to that device.

The Select From Interface page appears with a list of interfaces and the operation

status of all the interfaces.
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4. Right-click any interface and selectMigrate Services.

The InterfaceMigration page appears. The fields Name and Device are already

populated.

5. Perform the following steps:

• In the To Interface field, click the drop-down to select an interface to which you

want to migrate the services.

• In theServiceDefinition field, click thedrop-down field to select the servicedefinition

associated with this migration.

• In theDescription field, type 3 through 128 alphanumeric characters to describe this

service interface migration.

6. ClickMigrate to initiate the service interface migration.

A job is triggered to show themigration status.

NOTE: If you have createdmulti-vendor services, i.e. JNPR-ALU and need to
migrate the end point of both Juniper Networks and the third-party devices,
then you need to perform themigration on the third-party devices using a
third-partynetworkmanagementproduct firstandthenperformthemigration
on Juniper Networks devices and third party devices in Cross Provisioning
Platform in the samemanner as above. This records all the changes related
to this migration in the Cross Provisioning Platform database.
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Related
Documentation

Adding Scripts Created for Cross Provisioning Platform on page 667•

Modifying Bulk Services and Devices in Cross Provisioning Platform

Cross Provisioning Platform is an extension of the Network Activate application within

JunosSpace,whichprovidesa single paneof interaction todeploy services across vendor

network devices. You canmodify the device and the service configuration in bulk on the

basis of the service definition. This feature is applicable only to Juniper Networks devices

and supports LDP and Layer 3 VPN services.

With this feature, you canmodify all the services on the basis of a particular service

definition or all the devices within a particular service definition. Tomodify services or

devices in bulk, you need to create a configuration script in XSLT format and a GUI script

in JS format.

NOTE: Bulk modification cannot be applied on services and devices
simultaneously.

Make sure that you have the configuration and the GUI scripts present on the local

machine.

Tomodify and deploy services and devices in bulk:

• Modifying Bulk Services in Cross Provisioning Platform on page 687

• Modifying Bulk Devices in Cross Provisioning Platform on page 689

Modifying Bulk Services in Cross Provisioning Platform

Tomodify services in bulk based on a service definition:

1. In the Cross Provisioning Platform task pane, select CPP > Scripts.

The Scripts page that appears displays a list of the existing scripts.

2. Click the Add Script icon above the tool grid.

The Add Script(s) page that appears contains the Script Settings section.

3. In the Script Settings section, perform the following steps:

• In theName field, type 3 through 128 alphanumeric characters to identify the script

that you are creating.

• In theDescription field, type3 through 128alphanumeric characters to further identify

the script.

• Select Junos Space from the Vendor Type drop-down list, because this feature

supports only Juniper Networks devices.
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NOTE: The GUI Script field appears only when the Vendor Type is Junos

Space. If the vendor type is third-party, the GUI Script field does not

appear.

• In theConfigurationScript field, clickBrowse to upload the configuration script from

the local machine.

• In theGUI Script field, click Browse to upload the GUI script from the local machine.

• Click Create to add the uploaded scripts to the Cross Provisioning Platform

application.

The Status dialog box that appears confirms the successful addition of scripts.

NOTE: The default value of the Version field is 1.

4. ClickOK.

You are redirected to the Scripts page.

5. In the Cross Provisioning Platform task pane, select CPP > Service Definitions > Create

CPP Service Definition.

The Create Service Definition page appears.

6. Perform the following steps in the Create Service Definition page:

a. In theName field, type3 through 128alphanumeric characters to identify the service

definition that you are creating.

b. In the Description field, type 3 through 128 alphanumeric characters to further

identify the service definition.

c. From the Type drop-down list, select the type of the service definition.

d. In the Creation field of the JUNOS Space Service Scripts section, click Browse to

upload the script.

NOTE: TheModification script for JUNOS Space Service Scripts is

optional. You do not have to upload the SAMService Scripts because

this feature is applicable to Juniper Networks devices.

7. Click Create.

The Service Definitions page that appears displays a list of the existing service

definitions along with the one that you created.

8. Right-click the service definition you created and click Attach Scripts.

The Attach Scripts page appears.

9. Perform the following steps:
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a. In theBulkservicemodify field, clickBrowseandupload thebulk servicemodification

script.

b. In theBulkdevicemodify field, clickBrowseandupload thebulkdevicemodification

script.

c. Click Attach.

A confirmationdialogboxappears toconfirm thesuccessful attachmentof the scripts.

10. ClickOK.

11. In the Cross Provisioning Platform, select CPP > Service Definitions.

The Service Definitions page that appears displays a list of the existing service

definitions.

12. Right-click the service definition that you created and select Bulk Modify.

The Bulk Modify page appears.

NOTE: The Service option is selected by default in the Apply to section on

the Bulk Modify page.

13. Select the services that you want to modify and click Deploy.

The Job Details dialog box that appears contains the Job ID. You can click the Job ID

to view the status of the modified services on the JobManagement page.

Modifying Bulk Devices in Cross Provisioning Platform

Tomodify devices in bulk within a service definition:

1. In the Cross Provisioning Platform task pane, select CPP > Scripts.

The Scripts page that appears displays a list of the existing scripts.

2. Click the Add Script icon above the tool grid.

The Add Script(s) page that appears contains the Script Settings section.

3. In the Script Settings section, perform the following steps:
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• In theName field, type 3 through 128 alphanumeric characters to identify the script

that you are creating.

• In theDescription field, type3 through 128alphanumeric characters to further identify

the script.

• Select Junos Space from the Vendor Type drop-down list, because this feature

supports only Juniper Networks devices.

NOTE: The GUI Script field appears only when the Vendor Type is Junos

Space. If the vendor type is third-party, the GUI Script field does not

appear.

• In theConfigurationScript field, clickBrowse to upload the configuration script from

the local machine.

• In theGUI Script field, click Browse to upload the GUI script from the local machine.

• Click Create to add the uploaded scripts to the Cross Provisioning Platform

application.

The Status dialog box that appears confirms the successful addition of scripts.

NOTE: The default value of the Version field is 1.

4. ClickOK.

You are redirected to the Scripts page.

5. In the Cross Provisioning Platform task pane, select CPP > Service Definitions > Create

CPP Service Definition.

The Create Service Definition page appears.

6. Perform the following steps in the Create Service Definition page:

a. In theName field, type3 through 128alphanumeric characters to identify the service

definition that you are creating.

b. In the Description field, type 3 through 128 alphanumeric characters to further

identify the service definition.

c. From the Type drop-down list, select the type of the service definition.

d. In the Creation field of the JUNOS Space Service Scripts section, click Browse to

upload the script.

NOTE: TheModification script for JUNOS Space Service Scripts is

optional. You do not have to upload the SAMService Scripts because

this feature is applicable to Juniper Networks devices.

7. Click Create.
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The Service Definitions page that appears displays a list of the existing service

definitions along with the one that you created.

8. Right-click the service definition you created and click Attach Scripts.

The Attach Scripts page appears.

9. Perform the following steps:

a. In theBulkservicemodify field, clickBrowseandupload thebulk servicemodification

script.

b. In theBulkdevicemodify field, clickBrowseandupload thebulkdevicemodification

script.

c. Click Attach.

A confirmationdialogboxappears toconfirm thesuccessful attachmentof the scripts.

10. ClickOK.

11. In the Cross Provisioning Platform, select CPP > Service Definitions.

The Service Definitions page that appears displays a list of the existing service

definitions.

12. Right-click the service definition and select Bulk Modify.

The Bulk Modify page appears.

13. Select the Device option in the Apply to section to modify the devices in bulk.

14. Select the devices that you want to modify and click Deploy.

The Job Details dialog box that appears contains the Job ID. You can click the Job ID

to view the status of the modified devices on the JobManagement page.

Related
Documentation

Adding Scripts Created for Cross Provisioning Platform on page 667•
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• Importing Scripts Created for Cross Provisioning Platform on page 671

Viewing Script Version Support for Cross Provisioning Platform

The script version support in Cross Provisioning Platform enables you to view the older

versions of the script and set the preferred version to active while creating the service

order.

To view script version support for Cross Provisioning Platform:

1. From the Cross Provisioning Platform task pane, select CPP > Scripts.

The page that appears displays a list of the existing scripts.

2. Double-click any script from the list of the existing scripts.

The Script Details page that appears provides information on the script that you

selected. You can also click the View Script icon above the tool grid to view the Script

Details page.

3. From the Version# drop-down list, select the preferred version.

4. Click Set as default to set the selected version as default.

A confirmation dialog box that appears asks you to confirm the selection.

5. ClickOK.
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A dialog box that appears confirms the selection of the new version of the script.

NOTE: If a service definition has already been created with a particular
version, the script contents of the service order will point to the same
version.

On the Script Details page, you can see a list of script versions on the drop-down list,

fromwhich you can select a version to view its contents and set it as the active version.

Internally, a new version is created, pointing to the selected older version and the same

version contents are effective while creating the Cross Provisioning Platform service

order.

For example, if you change the version number from3 to 2 and set it as the active version,

a new version number 4 is created internally, pointing to the contents of version 2 and

making this the active version.

After you set the script version, you are redirected to the landing page of Scripts.

Related
Documentation

• Viewing Scripts Created for Cross Provisioning Platform on page 673

• Creating a Cross Provisioning Platform Service Definition on page 192
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CHAPTER 16

Prestaging: Managing IP Addresses

• Creating an IP Address Pool on page 695

• Managing IPv4 Addresses for Layer 3 VPNs on page 697

• Specifying IPv4AddressingAssignment inLayer3VPNServiceDefinitionsonpage699

Creating an IP Address Pool

You, the Service Designer, can create consistent IP address pools for Layer 3 VPNs from

Prestage Devices >Manage IP Addresses > Create IP Address Pools. The IP addresses

assigned to each PE/CE link need to allow routing across the customer’s entire Layer 3

VPN, as long as the PE/CE addresses are not exposed outside of that VPN. If the PE/CE

link addresses are accessible from outside the customer’s VPN, then those IP addresses

may also need to be globally unique across the internet, instead of just within the

customer’s VPN.

When you create an IP address pool, it appears in the Prestage Devices >Manage IP

Addresses inventory page. See “Managing IPv4Addresses for Layer 3 VPNs” on page 697

NOTE: Preferably, create all IPv4 address pools at the beginning of the
pre-staging process (see “Pre-Staging DevicesOverview” on page 3), before
you run Role Discovery (see “Discovering andAssigning All N-PEDevices” on
page 54), so that any IPv4 IP addresses found on devices during the role
discovery process can bemarked as already allocated in the corresponding
IPv4 IP address pools.

To create an IPv4 IP address pool:

1. In the Network Activate task pane, select Navigate to Prestage Devices >Manage IP

Addresses > Create IP Address Pools.

The Create IP Address Poolwindow appears.

2. In the IP pool type drop-down list box, select either Global or Customer.

• A Global IP address pool pertains to the service provider. There can bemore than

one global IPv4 address pool. However, each global pool must have its own unique

name and its set of IPv4 addressesmust not overlapwith those of any other global
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pool. You can allocate addresses from global pools across multiple Layer 3 VPNs

across multiple customers.

• A Customer IP address pool pertains to an existing customer. These pools are

associated with the corresponding customer. You can associate more than one

customer IPv4 pool with each customer. However, each customer pool must have

its own set of IPv4 addresses which must not overlap with those of any other pool

belonging to the same customer. You can allocate addresses from customer pools

across multiple Layer 3 VPNs for a particular customer.

3. In the Pool name field, enter a unique name.

An IP address Pool name can be nomore than 50 characters.

4. In the Pool description field, enter a helpful description.

The Pool Description can be no longer than 200 characters.

5. In the IP address pool field, enter an IPv4 IP address pool.

Any IPv4 address pool in Junos Spacemaps directly onto the Classless Interdomain

Routing (CIDR) notation for IPv4 network addresses. The CIDR network address,

192.168.1.0/24 is a contiguous block of 256 individual IPv4 addresses: 192.168.1.0/32

through 192.168.1.255/32, inclusive. Thenetworkaddress 10.0.99.20/30 isacontiguous

block of 4 individual IPv4 addresses: 10.0.99.20/32 through 10.0.99.23/32, inclusive.

As a consequence, any Junos Space IPv4 address pool directly maps to (and is

identified by) its CIDR network address. The Junos Space IPv4 address pool,

192.168.1.0/24, contains all of the addresses from 192.168.1.0/32 to 192.168.1.255/32,

while the IPv4 address pool, 10.0.99.20/30 contains all of the addresses from

10.0.99.20/32 to 10.0.99.23/32.

6. If youarecreatingaCustomer IPaddresspool, theAssociatewithcustomerdrop-down

list box appears. Select an existing customer name. To create a customer, see “Adding

a New Customer” on page 709.

7. Click Create.

Junos Space saves the IP address pool information in the database. The IP address

pool appears in theManage IP Address inventory page. The Pool Type column

differentiates global from customer IP address pools.

NOTE: You need to create IP address pools only if the operation of your
network requires it. Alternatively, you can use the global IP pools provided
by the Network Activate software for Layer 3 VPN services.

Related
Documentation

Managing IPv4 Addresses for Layer 3 VPNs on page 697•
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Managing IPv4 Addresses for Layer 3 VPNs

You, the Service Designer, can specify the IPv4 IP addressing to include in Layer 3 VPN

service definitions. Use the Prestage Devices > Managing IP Addresses inventory page

to view existing IP Address pools that you created globally or for specific existing

customers. For more information about creating an IPv4 IP address pool, see “Creating

an IP Address Pool” on page 695.

Viewing IP Address Pools

TheManage IP Addresses inventory page lists pool information in a table by name, pool

type, and IP address pool.

Viewing Detail IP Address Pool Information

To view IP address details double-click an IP address pool row.

Table 30 on page 697 defines the IP address pool detailed information.

Table 30: IP Address Pool Details

DescriptionDetail

Themnemonicnameof the IPAddresspool youcreateusingPrestageDevices>Create IPAddresses.

An IP address Pool Name can be nomore than 50 characters.

Pool Name

An optional description of the IP address pool name.

The Pool Description can be no longer than 200 characters.

Pool Description

Either:

• Global: Pools of IPv4 addresses pertaining to the Service Provider. There can bemore than one
global IPv4 address pool. However, each global pool must have its own unique name and its set
of IPv4 addresses must not overlap with those of any other global pool. Addresses from global
pools can be allocated across multiple L3VPNs, across multiple customers.

• Customer: Pools of IPv4 addresses pertaining to a particular customer. These pools will be
associated with the corresponding customer. There can bemore than one customer IPv4 pool
associated with each customer. However, each customer pool must have its own set of IPv4
addresseswhichmust not overlapwith those of any other pool belonging to the same customer.
Addresses from customer pools can be allocated across multiple L3VPNs, for a particular
customer.

Pool Type

A block of IPv4 addresses in CIDR notation (for example, 10.0.77.0/24 which identifies a pool of
256 IPv4 addresses, 192.168.0.0/16, and do forth.

IP Address Pool

The existing customer name for which you created the IP address pool.Customer

Performing Actions
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You can perform the following actions on IP address pools.

• Delete Address Pool—Removes the selected IP address pool from the Junos Space

database. Junos Spacewill not allow you to deleted an IP address pool to if it contains

any addresses that are still in use.

• Tag It—See Viewing Tags for a Managed Object.

• View Tags—Viewing Tags for a Managed Object

• Untag It—Untagging Objects

Related
Documentation

Creating an IP Address Pool on page 695•

• Creating a Tag
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Specifying IPv4 Addressing Assignment in Layer 3 VPN Service Definitions

You, the Service Designer, can specify the IPv4 IP address settings to use for PE/CE link

when provisioning Layer 3 VPN service definitions.

When configuring Layer 3 VPNs, it is necessary to assign consistent IP addresses to the

logical interfaces on both sides of each PE/CE link. The IP addresses assigned to each

PE/CE link need to allow routing across the customer’s entire Layer 3 VPN, and only need

to be unique within the confines of the customer’s VPN, as long as the PE/CE addresses

are not exposed outside of that VPN. If the PE/CE link addresses are accessible from

outside of the customer’s VPN, then those IP addresses may also need to be globally

unique across the Internet, instead of just within the customer’s VPN.

The Network Activate application automatically assigns IPv4 addresses to both sides of

each PE/CE link, as well as keeps track of which IPv4 addresses are already in use. It

ensures the correct assignment of IP addresses and prevents the reuse of IP addresses.

To specify auto-assigning of the PE/CE link addresses from IPv4 pools, you select the

Auto Pick option, the IP pool type—global or customer, and the number of contiguous

IPv4 addresses—size of the IPV4 address block that is allocated for each PE/CE link.

Which particular global or customer IPv4 address pool to use is chosen during service

provisioning when filling out the L3VPN Service Order.

For auto-assignment scenarios, the service designer can always select the Allow editing

in Service Order option at the right of each service definition setting to allow the

corresponding IPv4pool setting to beoverridden laterwhen filling out the L3VPNService

Order.

To specify manual assignment of PE/CE link addresses, the designer simply selects the

manual-assignment option.

To specify IP address settings in a Layer 3 VPN service definition:

1. In the IP Address Settings area PE Interface IP Address drop-down list box, select one

of the following:

• AutoPick—SpecifieswhetherPE/CE linkaddressesareautomatically assigned from

an IPv4 IP address pool.

• Select Manually—Specifies whether the service designer manually assigns PE/CE

link addresses from the same IPv4 IP address pool.

2. In the IP pool types drop-down list box, select one of the following:

• Global—Pools of IPv4 addresses pertaining to the Service Provider. There can be

more than one global IPv4 address pool. However, each global pool must have its

own unique name and its set of IPv4 addressesmust not overlap with those of any

other global pool. You can allocate addresses from global pools across multiple

Layer 3 VPN across multiple customers.

• Customer—Poolsof IPv4addressespertaining toaparticular customer.Thesepools

are associated with the corresponding customer. There can bemore than one

699Copyright © 2015, Juniper Networks, Inc.

Chapter 16: Prestaging: Managing IP Addresses



customer IPv4 pool associated with each customer. However, each customer pool

must have its own set of IPv4 addresses which must not overlap with those of any

other pool belonging to the same customer. Addresses from customer pools can

be allocated across multiple Layer 3 VPNs for a particular customer.

3. In the Size of address block field, enter the size of the IPv4 IP addresse block allocated

for each PE/CE link.

4. Select the Editable in service order check box on the right of each IP address setting

to overwrite the corresponding IPv4 IP address pool settingwhen creating the service

order.

5. Click another Layer 3 VPN Settings link to continue specifying settings or click Finish.

If you click Finish, the custom Layer 3 VPN service definition appears on theManage

Service Definitions inventory page.

Related
Documentation

• Creating a Full Mesh Layer 3 VPN Service Definition on page 257
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CHAPTER 17

Service Design: Monitoring and Reporting

• Viewing Service Definitions on page 701

• Viewing Service Design Statistics on page 704

• Viewing Service Template Inventory on page 706

• Managing Reports for Broadband Network Gateway Services in Cross Provisioning

Platform on page 707

Viewing Service Definitions

The Manage Service Definitions inventory page allows you, the Service Designer, to view

the status of service definitions and list of service definitions that you have created to

include in service orders.

Service definitions are listed by name.

SelectServiceDesign>ManageServiceDefinitions to viewandperformactionsonservice

definitions. From the Manage Service Definitions inventory page, you can publish,

unpublish, and delete service definitions. You can tag a service definition to categorize

or filter it, view tags, and untag.

• Tabular View on page 701

• Searching for Service Definitions on page 702

• Viewing Service Definition Details on page 702

• Performing Actions on Service Definitions on page 703

Tabular View

In tabular view, service definition information appears in table rows and columns.

Table 31 on page 701 describes the information presented in the table.

Table 31: Service Definition Table Fields

MeaningColumn

The unique name assigned to the service definition.Name
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Table 31: Service Definition Table Fields (continued)

MeaningColumn

One of the following values:

• Published—The service definition is available for use by service
provisioners.

• Unpublished—The service definition is not yet available for use by
service provisioners.

State

One of the following:

• Point-to-point pseudowire (LDP)

• Point-to-point pseudowire (BGP)

• VPLS (MultiPoint-to-MultiPoint)

• VPLS (Point-to-MultiPoint)

• L3VPN (Full Mesh)

• L3VPN (Hub-Spoke 1 Interface)

Service Type

One of the following values:

• BGP

• LDP

Signaling

The screen name of the user who created the service definition.Created By

The date and Pacific Daylight Time (PDT) time when you created the
service definition.

Created Date

Searching for Service Definitions

To search for a specific service definition, start typing it’s name in the Search field. The

service definition name(s) starting with the letters you type are listed in the Search

drop-down list box.

If you create tags to categorize service definitions, start typing the tag name in theSearch

field. Service definitions with the tag you type appears.

Viewing Service Definition Details

To view service definition detailed information, double-click the service definition row.

The Service Definition Details page displays a summary of the service definition settings:

General, Connectivity, and UNI settings. The following example shows a summary of the

settings for a point-to-point Ethernet service definition.
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For information about the meaning of each attribute, see “Service Attributes Overview”

on page 20.

Performing Actions on Service Definitions

From the Manage Service Definitions inventory page you can perform the following

actions:

• Publish Service Definition—See “Publishing a Custom Service Definition” on page 198.

• Unpublish Service Definition—See “Unpublishing a Custom Service Definition” on

page 199.

• DeleteServiceDefinition—See “Deleting aCustomizedServiceDefinition” onpage 200.

• Tag It—See Tagging an Object.

• View Tags—See Viewing Tags for a Managed Object.

• Untag It—See Untagging Objects.
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Related
Documentation

Predefined Point-to-Point Service Definitions on page 333•

• Predefined Multipoint-to-Multipoint Ethernet Service Definitions on page 365

• Predefined Point-to-Multipoint Ethernet Service Definitions on page 390

• Predefined Hub-and Spoke Layer 3 VPN Service Definitions on page 403

• Creating a Point-to-Point Ethernet Service Definition on page 97

• Creating a Multipoint-to-Multipoint VPLS Service Definition on page 117

• Creating a Point-to-Multipoint VPLS Service Definition on page 138

• CreatingaHub-and-Spoke (One Interface) Layer 3VPNServiceDefinitiononpage264

Viewing Service Design Statistics

The following topics describe viewing statistics in the Service Design workspace:

• Viewing Services Created from a Service Definition on page 704

• ViewingHowManyServiceDefinitionsAre inEachServiceDefinitionStateonpage705

Viewing Services Created from a Service Definition

You can view the services that are associated with a service definition.

To view the number of services made from each service definition:

1. In the Network Activate task pane, select Service Design.

The JunosSpacesoftwaredisplays theNumberofServicesperServiceDefinitionchart.

Copyright © 2015, Juniper Networks, Inc.704

Junos Space Cross Provisioning Platform



Each vertical bar represents a service definition. The number of services is shown on

the Y axis. Drag the slider across the bottom of the graph to display all service

definitions. This example shows that 7 services have been created from the service

definition named ELAN-QinQ-AllVLAN, and 2 services have been created from the

service definition name L3VPN-OSPF-Static(Hub-Spoke-1-Interface).

2. To see which services have been created from a specific service definition, click on

the bar that represents the service definition.

TheManageServicespageshowsonly the services created fromthat servicedefinition.

Viewing HowMany Service Definitions Are in Each Service Definition State

To view the percentage or number of service definitions that are in each service definition

state:

1. In the Network Activate task pane, select Service Design.

The Junos Space software displays the Service Definition States chart.
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Each segment of the pie chart represents the proportion of service definitions in the

indicated state. In this example, 90.9 percent of all completed service definitions are

in the Published state.

To view the number of service definitions in a state, move themouse cursor over the

segment.

2. To see which service definitions are in each state, click a segment in the pie chart.

TheManage Service Definitions page shows only those service definitions from the

selected segment.

Related
Documentation

Junos Space User Interface Overview•

• Viewing Service Definitions on page 701

• Viewing Services on page 776

Viewing Service Template Inventory

TheManage Service Templates inventory page enables you to view andmanipulate

templates individually or collectively. Youcanbrowse, zoom, filter, tag, andsort templates.

You can select one, several, or all templates and perform actions on them using the

actions in the Actionsmenu or by right-clicking a template.

To view theManage Service Templates page, in the Network Activate task pane, select

Service Design >Manage Service Templates. TheManage Service Templates inventory

page appears.
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You can do the following:

• Use the Search function to find a particular template.

• Select all templates on a page, or you can deselect them.

• You can refresh the page by clicking on the Refresh icon in the status bar.

• You can use the Actionsmenu tomodify, delete, export, and tag templates.

Related
Documentation

Service Templates Overview on page 406•

• Modifying a Service Template on page 417

• Deleting a Service Template on page 411

• Exporting a Service Template on page 412

• Tagging an Object

• Viewing Tags for a Managed Object

• Untagging Objects

Managing Reports for Broadband Network Gateway Services in Cross Provisioning
Platform

The report management functionality is used to query live data from a device by using

RPC commands. The output of the RPC commands can be represented in the following

ways:

• Chart

• HTML

• Text

This data is used to troubleshoot configurations and view device statistics. The script

designers determine the format in which the output of the RPC calls is represented. One

of the major features of the report management functionality is the generation of live

reports.

To activate this functionality, you need to upload the report-based parser XSLT and the

GUI script by using the script management functionality. Also, create a service definition

of the Report type by combining the GUI script and the XSLT parsing script.

The report management functionality is supported only on Juniper Networks devices.

To generate live reports:

1. In the Cross Provisioning Platform task pane, select CPP > Report Management.

The Report Management page that appears consists of the following tab:
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• Generate Live Reports

NOTE: TheGenerate Live Reports tab is pre-selected and displays a list of

existing report definitions.

2. Right-click any report definition and select Run Report.

The GUI scripts of the associated service definitions appear. For example, the

getsubscriberinfo script is attached to display the subscriber information on the

Subscribers Summary page.

3. Selectanydevicebyclicking thecorrespondingcheckboxandclick theGenerateReport

link.

The adjacent sections of the page displays Subscribers Summary and the Subscribers

Count details in any of the following formats: graph, HTML or text.

You can also add a new report definition from theCrossProvisioningPlatform>CPP task

pane on the Scripts page.

Related
Documentation

• ProvidingBroadbandNetworkGatewayServiceSupport inCrossProvisioningPlatform

on page 486
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CHAPTER 18

ServiceProvisioning:ManagingCustomers

• Adding a New Customer on page 709

• Deleting Customers on page 711

• Editing an Existing Customer on page 711

• Viewing Customers on page 712

Adding a NewCustomer

New customers must be identified to the system before you can provision and activate

a service order for them.

To add a customer to the database:

1. In the Network Activate task pane, select Service Provisioning >Manage Customers >

Create Customer.

2. On the Create Customerwindow, provide the information requested for the customer,

similar to the following example.
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Fill out the fields in the form.

The Name and Account number fields are required. All other fields are optional.

3. Optionally, use the Image File field to upload a graphical image of the customer. This

image will represent the customer in Junos Space windows to easily identify

information about that customer. For example, the imagemight use the customer’s

corporate logo.

To upload an image file for the customer:

4. Click Create.

TheManage Customers page shows the new customer.

To upload an image file for the customer:

1. In the Image File field, click Browse.

2. Select the file that contains the image you want to use for this customer.

3. Click Upload.

4. Click Create.

TheManage Customers page shows the new customer.
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Related
Documentation

Viewing Customers on page 712•

• Editing an Existing Customer on page 711

• Deleting Customers on page 711

Deleting Customers

You cannot delete a customer from the database if an active service exists for that

customer. Youmust decommission all such services before you can delete the customer.

To delete a customer from the database:

1. In the Network Activate task pane, select Service Provisioning >Manage Customers.

TheManage Customers page shows the customers in the database.

2. Select the customer you need to delete. To delete several customers at the same

time, use the multiple selection capability in the quick-look panel.

3. Open the Actionsmenu and click Delete Customer.

If the Delete Customer option is dimmed, drag your mouse over Delete Customer to

displaya tool tip that lists customers thatmustbecleared for theoperation to succeed.

After successfully selecting the Delete Customer action, a pop-up window appears

requesting confirmation.

4. Click Delete.

TheManage Customers page no longer lists the deleted customer.

Related
Documentation

Viewing Customers on page 712•

• Adding a New Customer on page 709

• Editing an Existing Customer on page 711

• Decommissioning a Service on page 716

Editing an Existing Customer

To edit the information about an existing customer:

1. In the Network Activate task pane, select Service Provisioning >Manage Customers >

Service Provisioning.

TheManage Customers page shows the customers already added to the system.

2. In theManage Customers page, select the customer whose information you want to

edit.

3. Open the Actionsmenu and clickModify Customer.
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4. Make the required changes to the customer information.

5. ClickModify.

TheManage Customers page shows themodified information.

Related
Documentation

Viewing Customers on page 712•

• Adding a New Customer on page 709

• Deleting Customers on page 711

Viewing Customers

The following topics describe how to view customer information either as graphics or in

a table.

• Viewing Customers as Graphics on page 712

• Viewing Customers in a Table on page 712

Viewing Customers as Graphics

To view your customers:

1. In the Network Activate task pane, select Service Provisioning >Manage Customers.

2. To restrict the display of customers, enter a search criterion of one ormore characters

in the Search bar and press Enter. All customer names thatmatch the search criterion

are shown in the main display area.

3. For details about a specific customer, double-click the listed customer.

The Detailswindow displays the customer name, account number, contact name,

contact e-mail address, and contact information.

Viewing Customers in a Table

To view a list of your customers in a table:

1. In the Network Activate task pane, select Service Provisioning >Manage Customers.

A list of customers appears in a table in the main display area of the page. The table

includes the customer name, account number, contact name, and e-mail address.
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2. To restrict the display of customers, enter a search criterion of one ormore characters

in the Search bar and press Enter. All customer names thatmatch the search criterion

are shown in the main display area.

Related
Documentation

• Adding a New Customer on page 709

• Editing an Existing Customer on page 711

• Deleting Customers on page 711
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CHAPTER 19

Service Provisioning: Managing Deployed
Services

• Editing a Service Name on page 715

• Decommissioning a Service on page 716

• Decommissioning Bulk Services in Cross Provisioning Platform on page 718

• Deleting Bulk Service Orders in Cross Provisioning Platform on page 720

• Deleting Bulk Device Configlet Orders in Cross Provisioning Platform on page 722

• Modifying a Full Mesh Layer 3 VPN Ethernet Service on page 724

• Modifying a Multipoint-to-Multipoint Ethernet Service on page 729

• Modifying a Point-to-Multipoint Ethernet Service on page 738

• Modifying a Point-to-Point Ethernet Service on page 750

• Modifying a Service in Cross Provisioning Platform on page 752

• Understanding Service Validation on page 753

Editing a Service Name

You can edit the name of a deployed service. This is applicable only to LDP based

pseudowires.

To rename a service:

1. Select Network Activate > Service Provisioning >Manage Services.

2. In the Manage Services inventory page, select the service you want to rename.

3. Open the Actions drawer and select Service > Edit Name. The Edit Service Name

window appears.

NOTE: TheEditNameappears tobedimmed if the service selected isBGP

based point-to-point service, or VPLS service or L3VPN service.

4. Type the new name in the Enter New name fields and click Save.

The service is renamed.
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Related
Documentation

Decommissioning a Service on page 716•

• Modifying a Full Mesh Layer 3 VPN Ethernet Service on page 724

• Modifying a Multipoint-to-Multipoint Ethernet Service on page 729

• Modifying a Point-to-Multipoint Ethernet Service on page 738

• Modifying a Point-to-Point Ethernet Service on page 750

Decommissioning a Service

You can decommission a service that a customer no longer needs.

You cannot decommission a service if a service order requesting action on that service

is in the Requested, Scheduled, In Progress, or Invalid state.

To decommission a service:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In theManage Services page, select the service you want to decommission.

3. Open the Actionsmenu and click Decommission Service.

The Schedule Decommissionwindow appears.

4. Do one of the following:

• To decommission the service immediately, selectDecommission now, and clickOK.

In theOrder Informationwindow, click the job ID of the decommission job.

The JobManagement page appears and shows a filtered view of the job inventory,

showing only the decommission job. See Viewing Jobs in the Junos Space Network

Application Platform User Guide for details.

• To deploy the service at a later time, select Decommission later, select a date and

time to perform the operation, then clickOK.
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NOTE: The following error message is displayed if you decommission a
service that hasmore number of devices or endpoints than the specified
limit:

Decommissionofservicecannotbeperformedduetomorenumberofdevices

or endpoints. Pleasemodify the service and remove fewdevicesor endpoints

before decommissioning thewhole service. (Maximumof 100devices or 250

endpoints are only allowed)

If you decommission a service and the device confirms the deletion, the resources

associatedwith the service are immediately released and are available for reusewithout

waiting for the device synchronization. If you want the synchronization to happen before

the resources are released, you need to configure the decommissioning settings.

To configure the service decommissioning settings:

1. SelectNetworkManagementPlatform>Administration>Applications. TheApplications

page displays the list of applications.

2. Right-click the Network Activate row and selectModify Applications Settings. The

Modify Network Activate Settings page displays the list of parameters that can be

modified.

3. Select ServiceDecommission.

4. Specify values for the parameters in the Service Decommission page as described in

the following tables.

ActionField

Select this check box to wait for the device synchronization before resources are released.
To revert the decommissioning to the normal behavior clear this check box.

Wait for Device Sync Before
Releasing Resource

Specify thedevice synchronizationwaiting time.This is themaximumwait time tocomplete
thedevicesynchronization.After this timeduration, irrespectiveof thedevicesynchronization
status, the resources are released.

Default: 60 seconds

Range: 30 seconds to 300 seconds

Device sync wait time

5. ClickModify.

The service decommissioning settings are configured.

Related
Documentation

Viewing Jobs in the Junos Space Network Application Platform User Guide•

• Viewing Services on page 776
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Decommissioning Bulk Services in Cross Provisioning Platform

Use the Services page to decommissionmultiple services of Cross Provisioning Platform

in bulk. You can select the number of services that a single page displays, by selecting

one of the following values from the Show items drop-down list at the bottom of the

page:

• 10

• 20

• 40

• 60

• 80

• 100

• 200

To decommission services in bulk:

1. From the Cross Provisioning Platform task pane, select CPP > Services.

The Services page that appears displays a list of existing services.

2. Select the check boxes against the services that you want to decommission.

3. Either right-click and select Service > Decommission or click the Decommission icon

on thegrid tool bar. Youcanalsodecommissiona serviceby selectingActions>Service

> Decommission.

TheScheduleDecommission page appearswhere the selected services are listed. You

can schedule the decommissioning process to happen immediately or later.

NOTE: You cannot decommission a service that has beenmodified in the
Servicespageunless thevalueof theOrderState fieldof thecorresponding

service is Completed. You can decommission only 25 services at a time. If

the count exceeds 25, the following error message appears:

Service decommissioning cannot be scheduled if the selected services count

is greater than 25.

4. Select theDecommissionnowoptionbuttontodecommission theservices immediately.

You canalsodecommission the selected services later by selecting theDecommission

later option button and setting the preferred date and time.
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5. ClickOK to decommission the selected services.

The Job Detailswindow appears with a list of job IDs.

NOTE: For every service that is selected to be decommissioned, a unique
job ID is assigned. You can view the details of each job on the Job

Management page by clicking the corresponding job ID.

For every service that is decommissioned, a message is logged on the Audit Log page.

To view the Audit Log page, select NetworkManagement Platform > Audit Logs > Audit

Log.

Related
Documentation

Decommissioning a Service on page 716•
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Deleting Bulk Service Orders in Cross Provisioning Platform

Use the ServiceOrders landing page to select and deletemultiple device configlet orders

in bulk. You can select the number of services that a single page displays, by selecting

one of the following values from the Show items drop-down list at the bottom of the

page:

• 10

• 20

• 40

• 60

• 80

• 100

• 200

To delete service orders of Cross Provisioning Platform in bulk:

1. From the Cross Provisioning Platform task pane, select CPP > Service Orders.

The Service Orders page that appears displays a list of existing service orders.

2. Select the check boxes against the service orders that you want to delete.

3. Right-click and select Delete Service Order or click the Delete Service Order icon on

the grid tool bar.

The Delete Service Orders page appears asking you to confirm the selection of the

service orders to be deleted.
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NOTE: When you select multiple service orders, the Delete Service Order

option is enabled only if the order state of the selected service orders is
either Failed_Deployed, Requested or Invalid.

When the order state is Completed, the following points hold true:

• You cannot delete a service order if its order state is Completed and the

related service is listed on the Services landing page.

• Youcannotdelete the first and the last serviceorder created fora service
if their order state is Completed and the related service is listed on the

Services landing page.

• The service orders that are in the Completed state for a service can be

deleted only if the related service is not listed on the Services landing

page.

You can delete 25 service orders at a time. If the count exceeds 25, the
following error message appears:

Service orders cannot be deleted if the selected service order count is greater

than 25.

4. Click Delete to delete the selected service orders.

The selected service orders are deleted and the landing grid is refreshed. For every

service order that is deleted, a message is logged on the Audit Log page. To view the

Audit Log page, select NetworkManagement Platform > Audit Logs > Audit Log.

Related
Documentation

Deleting Bulk Device Configlet Orders in Cross Provisioning Platform on page 722•
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Deleting Bulk Device Configlet Orders in Cross Provisioning Platform

Use theDeviceConfigletOrders landingpage to select anddeletemultipledevice configlet

orders in bulk. You can select the number of services that a single page displays, by

selecting one of the following values from the Show items drop-down list at the bottom

of the page:

• 10

• 20

• 40

• 60

• 80

• 100

• 200

To delete device configlet orders of Cross Provisioning Platform in bulk:

1. From the Cross Provisioning Platform task pane, select CPP > Device Configlet Orders.

TheDeviceConfigletOrderspage thatappearsdisplaysa list of existingdeviceconfiglet

orders.

2. Select the check boxes against the device configlet orders that you want to delete.

3. Right-click any device configlet order and select Delete Device Configlet or click the

Delete Device Configlet icon on the grid tool bar.

The Delete Device Configlet page appears asking you to confirm the selection of the

device configlet orders to be deleted.
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NOTE: Whenyouselectmultipledeviceconfiglet orders, theDeleteDevice

Configlet option is enabled only if the order state of the selected device

configlet orders is either Failed_Deployed, Requested or Invalid.

When the order state is Completed, the following points hold true:

• You cannot delete a device configlet order if its order state isCompleted

and the related service is listed on the Device Configlet Services landing

page.

• You cannot delete the first and the last device configlet order created
for a service if their order state is Completed and the related service is

listed on the Device Configlet Services landing page.

• The device configlet orders that are in the Completed state for a service

can be deleted only if the related service is not listed on the Device

Configlet Services landing page.

You can delete 25 device configlet orders at a time. If the count exceeds
25, the following error message appears:

Device configlet orders cannot be deleted if the selected device configlet

order count is greater than 25.

4. Click Delete to delete the selected device configlet orders.

The selected device configlet orders are deleted and the landing grid is refreshed. For

every device configlet order that is deleted, amessage is loggedon theAudit Logpage.

To view theAudit Logpage, selectNetworkManagementPlatform>Audit Logs>Audit

Log.

Related
Documentation

Deleting Bulk Service Orders in Cross Provisioning Platform on page 720•
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Modifying a Full Mesh Layer 3 VPN Ethernet Service

For a full mesh Layer 3 VPN service, you can add a new device endpoint, add or delete a

UNI, change routing protocol parameters, remove or add static routes, change IP

addresses, swapbetweenBGPand static routing protocols (if service definition specifies

BGP and Static), swap between OSPF and static routing protocols (if service definition

specifies OSPF and Static).

NOTE: You cannot change the interface of an existing UNI. To perform the
equivalent of changing the interface on an existing UNI, add a newUNI with
the desired interface, and then delete the old UNI.

After modifying a service, the configuration audit and functional audit information is

cleared and the functional audit status is set to pending.

If there is a service template attached to the service definition, there is a link to that

template at the bottom of the Endpoint Settings section of the window. For instructions

on working with service templates in service orders, see “Creating a Service Order Based

on a Service Definition with a Template” on page 564.

Modifying a service creates a new service order based on the attribute settings of the

existing service.

• Adding an Endpoint on page 724

• Adding a UNI Interface on page 727

• Deleting a UNI Interface and Deleting an Endpoint on page 729

Adding an Endpoint

To add an endpoint to amultipoint-to-multipoint Ethernet service:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In theManageServices page, select the service towhich youwant to add an endpoint.

3. Open the Actionsmenu and selectModify Service.
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TheModify Service page appears.

Current service settings appear in themain display area. The General Information box

contains a unique name for the service order that will request the change.

4. In theOrder name field, change the name of themodification service order, if desired.

5. In the Add Endpoints table, click Add Endpoints.
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Whenyouclick adeviceUNI interface, you see thedeviceand routingprotocol settings

in the right Device pane. The Add Endpoint PE Devices inventory page shows the

available N-PE devices that are not part of the service.

6. Select the devices on which you want to add new endpoints, and then click Next.

Theservicemodificationwindowshowstheaddeddeviceswithsystemrecommended

choices for UNI. To select a different UNI, see “Adding a UNI Interface” on page 727.

7. ClickModify.

The Deployment Options dialog box appears.

8. In the Deployment Options dialog box, select one of the following:

• Save only and check Validate to save the service modification and validate it.

• Deploy now to deploy modified service immediately when you click, OK
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• Schedule deployment to specify a date and time to deploy the modified service

later. The default time is the current date and time when you select the option.

9. ClickOK.

The service modification deployment Job ID link appears.

10. Click the Job ID.

You see the servicemodificationdeployment jobdetails in the Jobs>JobManagement

page.The JobManagementpagepresents the job informationby job ID,Name,Percent

complete, State, Job Type, Summary, Scheduled Start, Username, and Recurrence.

The State column indicates whether the modified service deployment is successful.

Adding a UNI Interface

To add a UNI on a device that is already part of a multipoint-to-multipoint Ethernet

service:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In theManage Services page, select the service to which you want to add a UNI.

3. Open the Actionsmenu and selectModify Service.

Current service settings appear in the main display area. The General Settings box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. In the Action column of the Endpoint Settings table, click the green plus sign for the

device that you want. An additional UNI appears in the endpoint table for the device.

The UNI interface settings fields appear in the Device pane on the right.
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6. In the Device pane, select an Ethernet option from the drop-down list box.

7. Select a UNI interface from the drop-down list box.

8. The Interface IP field displays the interface IP address.

9. The Autopick VLAN ID check box is selected by default to allow Network Activate to

select a VLAN ID. If you deselect the Autopick VLAN ID check box, youmust either

enter a different value in the service VLAN ID field manually.

10. Select a routing protocol from the drop-down list box.

11. ClickModify.

12. ClickModify.

The Deployment Options dialog box appears.

13. In the Deployment Options dialog box, select one of the following:

• Save only and Validate to save the service modification and validate it.

• Deploy now to deploy modified service immediately when you click, OK

• Schedule deployment to specify a date and time to deploy the modified service

later. The default time is the current date and time when you select the option.

14. ClickOK.

The service modification deployment Job ID link appears.

15. Click the Job ID.

You see the servicemodificationdeployment jobdetails in the Jobs>JobManagement

page.The JobManagementpagepresents the job informationby job ID,Name,Percent

complete, State, Job Type, Summary, Scheduled Start, Username, and Recurrence.

The State column indicates whether the modified service deployment is successful.
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Deleting a UNI Interface and Deleting an Endpoint

To delete a UNI from amultipoint-to-multipoint Ethernet service:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In theManage Services page, select the service fromwhich you want to delete a UNI.

3. Open the Actionsmenu and selectModify Service.

Current service settings appear in the main display area. The General Settings box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. In the Action column of the Endpoint Settings table, find the UNI you want to delete

and click the red delete button for that table

The selected UNI is removed from the table. If the deleted UNI was the only UNI

selected on that device, then the device is deleted from the Endpoint Settings table.

6. ClickModify.

The Deployment Options dialog box appears.

7. In the Deployment Options dialog box, select one of the following:

• Save only and Validate to save the service modification and validate it.

• Deploy now to deploy modified service immediately when you click, OK

• Schedule deployment to specify a date and time to deploy the modified service

later. The default time is the current date and time when you select the option.

8. ClickOK.

The service modification deployment Job ID link appears.

9. Click the Job ID.

You see the servicemodificationdeployment jobdetails in the Jobs>JobManagement

page.The JobManagementpagepresents the job informationby job ID,Name,Percent

Complete, State, Job Type, Summary, Scheduled Start, Username, and Recurrence.

The State column indicates whether the modified service deployment is successful.

Toviewthemodifiedservice in thenetwork topology, selectPlatform>NetworkMonitoring

> Topology > Service > NA. The parameters of the selected service is displayed.

For more information on topology, see “Junos Space Network Topology Overview” on

page 40.

Modifying aMultipoint-to-Multipoint Ethernet Service

Foramultipoint-to-multipoint service, youcanchange thebandwidthorMTUofaspecific

UNI, add or delete a UNI, change C-VLAN range values, and change advanced settings

for a device endpoint or add a new device endpoint.
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You cannot change the interface of an existing UNI. Neither can you change the

service VLAN ID.

To perform the equivalent of changing the interface on an existing UNI, add a new UNI

with the desired interface, and then delete the old UNI.

After modifying a service, the configuration audit and functional audit information is

cleared and the functional audit status is set to pending.

Modifying a service creates a new service order based on the attribute settings of the

existing service.

The following topics provide instructions for modifying amultipoint-to-multipoint (full

mesh) Ethernet service:

• Adding an Endpoint on page 730

• Adding a UNI Interface on page 732

• Deleting a UNI Interface and Deleting an Endpoint on page 733

• Changing the Endpoint Bandwidth on page 734

• Changing the Primary Device in a Multihomed Group on page 735

• Changing Advanced Settings for an Endpoint on page 736

Adding an Endpoint

To add an endpoint to amultipoint-to-multipoint Ethernet service:

1. In the Network Activate Task pane, select Service Provisioning >Manage Services.

2. In theManageServices page, select the service towhich youwant to add an endpoint.

3. Open the Actionsmenu and selectModify Service.

Current service settings appear in themain display area. The General Information box

contains a unique name for the service order that will request the change.
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4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. If you have configured the CFM, the General Information panel provides an option to

disable the CFM service. You can select theDisableCFM check box to disable the CFM

service, if desired.

If you have not configured the CFM, the General Information panel provides an option

to enable the CFM service. You can select the CFM definition from the CFMDefinition

list, if desired.

6. In the Add Endpoints table, click Add Endpoints.

The Add Endpoint PE Deviceswindow shows available N-PE devices that are not part

of the service.

7. Select the devices on which you want to add new endpoints, then click Next.

Theservicemodificationwindowshowstheaddeddeviceswithsystemrecommended

choices for UNI. To select a different UNI, see “Adding aUNI Interface” on page 732. To

select a different bandwidth than the applied default, see “Changing the Endpoint

Bandwidth” on page 734.

8. ClickModify.

9. In the Deployment Optionswindow, select one of the following:

• Save the change without scheduling it.

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.
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10. ClickOK.

11. Use the JobManagementworkspace to monitor the progress and status of the

deployment. See Viewing Jobs in the Junos Space Network Application Platform User

Guide for details.

Adding a UNI Interface

To add a UNI on a device that is already part of a multipoint-to-multipoint Ethernet

service:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In theManage Services page, select the service to which you want to add a UNI.

3. Open the Actionsmenu and selectModify Service.

Current service settings appear in themain display area. The General Information box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. In the Action column of the Add Endpoints table, click UNI Interface for the device, as

shown in the following example, which adds a UNI to the device.

An additional UNI appears in the endpoint table.

6. If the interface you selected in the previous step is already configured (duplicate) you

must eithermanually enter a different value in the service VLAN ID fields, or check the

Autopick VLAN ID field.

7. Select an interface from the UNI Interface column.

8. ClickModify.
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9. In the Deployment Optionswindow, select one of the following options:

• Save the change without scheduling it.

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.

10. ClickOK.

11. Use the JobManagementworkspace to monitor the progress and status of the

deployment. See Viewing Jobs in the Junos Space Network Application Platform User

Guide for details.

Deleting a UNI Interface and Deleting an Endpoint

To delete a UNI from amultipoint-to-multipoint Ethernet service:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In theManage Services page, select the service fromwhich you want to delete a UNI.

3. Open the Actionsmenu and selectModify Service.

Current service settings appear in themain display area. The General Information box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. In the Action column of the Endpoint Settings table, find the UNI you want to delete

and click Delete UNI Interface for that table row.

The selected UNI is removed from the table. If the deleted UNI was the only UNI

selected on that device, then the device is deleted from the Endpoint Settings table.

6. ClickModify.

7. In the Deployment Optionswindow, select one of the following:

• Save the change without scheduling it.
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• Schedule the change for immediate deployment.

• Schedule the change for later deployment.

8. ClickOK.

9. Use the JobManagementworkspace to monitor the progress and status of the

deployment. See Viewing Jobs in the Junos Space Network Application Platform User

Guide for details.

Changing the Endpoint Bandwidth

To change the rate limit or bandwidth for an endpoint of a multipoint-to-multipoint

Ethernet service:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In theManage Services page, select the service on which you want to change the

bandwidth of an endpoint.

3. Open the Actionsmenu and selectModify Service.

Current service settings appear in themain display area. The General Information box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. In the Action column of the Endpoint Settings table, click on the Bandwidth entry for

the UNI on which you want to change the bandwidth.

6. Fromthe list of validbandwidth settings, select the setting youwant, thenclickModify.

7. In the Deployment Optionswindow, select one of the following:

• Save the change without scheduling it.

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.
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8. ClickOK.

9. Use the JobManagementworkspace to monitor the progress and status of the

deployment. See Viewing Jobs in the Junos Space Network Application Platform User

Guide for details.

Changing the Primary Device in aMultihomed Group

To change the primary device in a multihomed group in a multipoint-to-multipoint

Ethernet service:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In theManage Services page, select the service on which you want to change the

primary device in a multihomed group.

3. Open the Actionsmenu and selectModify Service.

Current service settings appear in themain display area. The General Information box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modified service order, if

desired.

5. Toselect adifferent primary device for themultihomedgroup, in theEndpointSettings

box, click theEdit icon (indicatedbyapencil), located to the left of the current primary

device for the multihomed group.

6. Select the radiobutton for thesecondarydevice that youwant to specifyas theprimary

device in the multihomed group.

7. Click Set As Primary.

8. ClickModify.

The secondary device is configured as the primary device in the multihomed group.

9. In the Deployment Optionswindow, select one of the following:

• Save the change without scheduling it.

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.
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10. ClickOK.

11. Use the JobManagementworkspace to monitor the progress and status of the

deployment. See Viewing Jobs in the Junos Space Network Application Platform User

Guide for details.

Changing Advanced Settings for an Endpoint

To change advanced settings for an endpoint of a multipoint-to-multipoint Ethernet

service:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In theManage Services page, select the service on which you want to change one or

more advanced settings for an endpoint.

3. Open the Actionsmenu and selectModify Service.

Current service settings appear in the main display area. The General Settings box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modified service order, if

desired.

5. In theAction columnof theEndpointSettings table, find the device endpoint youwant

to modify, and click Advanced for that table row.

The Advanced Settingwindow displays the security and advanced settings that you

can configure for a device.
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See the “Service Attributes Overview” on page 20 for more information about

configuring MAC security settings and advanced settings.

6. In theMACSecuritySettingsbox,make selections forMAC learning andMACstatistics

and enter values for Interface MAC limit, MAC table size, and MAC table aging time.

7. Enable or disable tunnel services by selecting or clearing the disable-tunnel-service

check box.

8. Enable or disable local switching by selecting or clearing the disable-local-switching

check box.

9. In the Fast reroutepriority field, specify the reroute priority for a VPLS routing instance.

10. In the Label block size field, specify the label block size for VPLS labels.

11. In the Connectivity type field, select a connection-type to specify when a VPLS

connection is taken down, depending on whether or not the interface for the VPLS

routing instance is customer-facing or integrated routing and bridging (IRB)

12. ClickOK to save all your changes in the Advanced Setting window.

13. ClickModify.

14. In the Deployment Optionswindow, select one of the following:

• Save the change without scheduling it.

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.
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15. ClickOK.

16. Use the JobManagementworkspace to monitor the progress and status of the

deployment. See Viewing Jobs in the Junos Space Network Application Platform User

Guide for details.

To view themodified service in the topology, select Platform > NetworkMonitoring >

Topology > Service > NA. The parameters of the selected service is displayed.

For more information on topology, see “Junos Space Network Topology Overview” on

page 40

Related
Documentation

Creating a Multipoint-to-Multipoint VPLS Service Order on page 491•

• Deploying a Service on page 467

• Viewing Jobs in the Junos Space Network Application Platform User Guide

• Viewing Services on page 776

• Modifying a Point-to-Point Ethernet Service on page 750

• Modifying a Point-to-Multipoint Ethernet Service on page 738

Modifying a Point-to-Multipoint Ethernet Service

For a point-to-multipoint service, you can add a spoke or a hub, change the role of a

device from hub to spoke or spoke to hub, change the bandwidth or MTU of a specific

UNI, or add or delete a UNI.

You cannot change the interface of an existing UNI or the service VLAN ID.

To perform the equivalent of changing the interface on an existing UNI, add a new UNI

with the desired interface, and then delete the old UNI.

After modifying a service, the configuration audit and functional audit information is

cleared and the functional audit status is set to pending.

Modifying a service creates a new service order based on the attribute settings of the

existing service.

The following topics provide instructions for modifying amultipoint Ethernet (VPLS)

service:

• Adding a Spoke on page 739

• Adding a Hub on page 740

• Changing a Spoke to a Hub on page 742

• Changing a Hub to a Spoke on page 742

• Adding a UNI Interface on page 743

• Deleting a UNI Interface or Deleting an Endpoint on page 745

• Changing the Endpoint Bandwidth on page 746
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• Changing the Primary Device in a Multihomed Group on page 747

• Changing Advanced Settings for an Endpoint on page 748

Adding a Spoke

To add an endpoint configured as a spoke to amultipoint Ethernet service:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In theManageServicespage, select the point-to-multipoint service towhich youwant

to add a spoke.

3. Open the Actionsmenu and selectModify Service.

Current service settings appear in the main display area. The General Settings box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. If you have configured the CFM, the General Settings panel provides an option to

disable the CFM service. You can select theDisableCFM check box to disable the CFM

service, if desired.

If you have not configured the CFM, the General Settings panel provides an option to

enable the CFM service. You can select the CFM definition from the CFMDefinition

list, if desired.

6. In the Endpoint Settings table, click Add Endpoints.
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The Add Endpoint PE Deviceswindow shows available N-PE devices that are not part

of the service.

7. Select the devices on which you want to add new endpoints, and then click Next.

Theservicemodificationwindowshowstheaddeddeviceswithsystemrecommended

choices for UNI. To select a different UNI, see “Adding aUNI Interface” on page 743. To

select a different bandwidth than the applied default, see “Changing the Endpoint

Bandwidth” on page 746.

8. ClickModify.

9. In the Deployment Optionswindow, select one of the following:

• Save the change without scheduling it.

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.

10. ClickOK.

11. Use the JobManagementworkspace to monitor the progress and status of the

deployment. See Viewing Jobs in the Junos Space Network Application Platform User

Guide for details.

Adding a Hub

To add an endpoint to amultipoint Ethernet service:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In theManage Services page, select the service to which you want to add a hub.

3. Open the Actionsmenu and selectModify Service.

Current service settings appear in themain display area. The General Information box

contains a unique name for the service order that will request the change.
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4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. In the Endpoint Settings table, click Add Endpoints.

The Add Endpoint PE Deviceswindow shows available N-PE devices that are not part

of the service.

6. Select the devices on which you want to add new endpoints, and then click Next.

Theservicemodificationwindowshowstheaddeddeviceswithsystemrecommended

choices for UNI. To select a different UNI, see “Adding aUNI Interface” on page 743. To

select a different bandwidth than the applied default, see “Changing the Endpoint

Bandwidth” on page 746.

7. In the Endpoint Settings table, check Hub for the device you just added.

8. ClickModify.

9. In the Deployment Optionswindow, select one of the following:

• Save the change without scheduling it.

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.

10. ClickOK.

11. Use the JobManagementworkspace to monitor the progress and status of the

deployment. See Viewing Jobs in the Junos Space Network Application Platform User

Guide for details.
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Changing a Spoke to a Hub

To change a spoke to a hub in a point-to-multipoint Ethernet service:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In theManageServicespage, select thepoint-to-multipoint service forwhichyouwant

to change a spoke to a hub.

3. Open the Actionsmenu and selectModify Service.

Current service settings appear in the main display area. The General Settings box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. In theDevice columnof the Endpoint Settings table, find the spoke endpoint youwant

to change to a hub and select the Hub check box.

6. ClickModify.

7. In the Deployment Optionswindow, select one of the following:

• Save the change without scheduling it.

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.

8. ClickOK.

9. Use the JobManagementworkspace to monitor the progress and status of the

deployment. See Viewing Jobs in the Junos Space Network Application Platform User

Guide for details.

Changing a Hub to a Spoke

NOTE: You cannot change the only hub of a point-to-multipoint service to
a spoke. Youwill receiveanerrormessagewhenyou try to save sucha service
configuration.
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To change a hub to a spoke in a point-to-multipoint Ethernet service:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In theManageServicespage, select thepoint-to-multipoint service forwhichyouwant

to change a hub to a spoke.

3. Open the Actionsmenu and selectModify Service.

Current service settings appear in the main display area. The General Settings box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. In the Device column of the Endpoint Settings table, find the hub endpoint you want

to change to a spoke and clear the Hub check box.

6. ClickModify.

7. In the Deployment Optionswindow, select one of the following:

• Save the change without scheduling it.

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.

8. ClickOK.

9. Use the JobManagementworkspace to monitor the progress and status of the

deployment. See Viewing Jobs in the Junos Space Network Application Platform User

Guide for details.

Adding a UNI Interface

To add a UNI on a device that is already part of a multipoint Ethernet service:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In theManage Services page, select the service to which you want to add a UNI.

3. Open the Actionsmenu and selectModify Service.

Current service settings appear in the main display area. The General Settings box

contains a unique name for the service order that will request the change.
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4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. In the Action column of the Endpoint Settings table, click Add UNI Interface for the

device, as shown in the following example, which adds a UNI to the device named

SanFrancisco.

An additional UNI appears in the endpoint table.

6. Select an interface from the UNI Interface column.

7. If the interface you selected in the previous step is already configured (duplicate) you

must either enter a different value in the service VLAN ID field manually, or check the

Autopick VLAN ID field.

8. ClickModify.

9. In the Deployment Optionswindow, select one of the following:

• Save the change without scheduling it.
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• Schedule the change for immediate deployment.

• Schedule the change for later deployment.

10. ClickOK.

11. Use the JobManagementworkspace to monitor the progress and status of the

deployment. See Viewing Jobsin the Junos Space Network Application Platform User

Guide for details.

Deleting a UNI Interface or Deleting an Endpoint

NOTE: You cannot delete the last endpoint on the only hub device in the
service. Youwill receive an errormessagewhen you try to save such a service
configuration.

To delete a UNI from amultipoint Ethernet service:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In theManage Services page, select the service fromwhich you want to delete a UNI.

3. Open the Actionsmenu and selectModify Service.

Current service settings appear in the main display area. The General Settings box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. In the Action column of the Endpoint Settings table, find the UNI you want to delete

and click Delete UNI Interface for that table row.

The selected UNI is removed from the table. If the deleted UNI was the only UNI

selected on that device, then the device is deleted from the Endpoint Settings table.

6. ClickModify.
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7. In the Deployment Optionswindow, select one of the following:

• Save the change without scheduling it.

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.

8. ClickOK.

9. Use the JobManagementworkspace to monitor the progress and status of the

deployment. See Viewing Jobs in the Junos Space Network Application Platform User

Guide in the Junos Space Network Application Platform User Guide for details.

Changing the Endpoint Bandwidth

To change the rate limit or bandwidth for an endpoint of a multipoint Ethernet service:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In theManage Services page, select the service on which you want to change the

bandwidth of an endpoint.

3. Open the Actionsmenu and selectModify Service.

Current service settings appear in the main display area. The General Settings box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modification service order, if

desired.

5. In the Action column of the Endpoint Settings table, click on the Bandwidth entry for

the UNI on which you want to change the bandwidth.

6. From the list of valid bandwidth settings, select the one you want, then clickModify.

7. In the Deployment Optionswindow, select one of the following:

• Save the change without scheduling it.

• Schedule the change for immediate deployment.
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• Schedule the change for later deployment.

8. ClickOK.

9. Use the JobManagementworkspace to monitor the progress and status of the

deployment. See Viewing Jobs in the Junos Space Network Application Platform User

Guide in the Junos Space Network Application Platform User Guide for details.

Changing the Primary Device in aMultihomed Group

To change the primary device in a multihomed group in a point-to-multipoint Ethernet

service:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In theManage Services page, select the service on which you want to change the

primary device in a multihomed group.

3. Open the Actionsmenu and selectModify Service.

Current service settings appear in the main display area. The General Settings box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modified service order, if

desired.

5. Toselect adifferent primary device for themultihomedgroup, in theEndpointSettings

box, click theEdit icon (indicatedbyapencil), located to the left of the current primary

device for the multihomed group.

6. Select the radiobutton for thesecondarydevice that youwant to specifyas theprimary

device in the multihomed group.

7. Click Set As Primary.

8. ClickModify.

The secondary device is configured as the primary device in the multihomed group.

9. In the Deployment Optionswindow, select one of the following:

• Save the change without scheduling it.

• Schedule the change for immediate deployment.
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• Schedule the change for later deployment.

10. ClickOK.

11. Use the JobManagementworkspace to monitor the progress and status of the

deployment. See Viewing Jobs in the Junos Space Network Application Platform User

Guide for details.

Changing Advanced Settings for an Endpoint

To change advanced settings for an endpoint of a point-to-multipoint Ethernet service:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In theManage Services page, select the service on which you want to change one or

more advanced settings for an endpoint.

3. Open the Actionsmenu and selectModify Service.

Current service settings appear in the main display area. The General Settings box

contains a unique name for the service order that will request the change.

4. In the serviceOrder name field, change the name of the modified service order, if

desired.

5. In theAction columnof theEndpointSettings table, find the device endpoint youwant

to modify, and click Advanced for that table row.

The Advanced Settingwindow displays the security and advanced settings that you

can configure for a device.
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See the “Service Attributes Overview” on page 20 for more information about

configuring MAC security settings and advanced settings.

6. In theMACSecuritySettingsbox,make selections forMAC learning andMACstatistics

and enter values for Interface MAC limit, MAC table size, and MAC table aging time.

7. Enable or disable tunnel services by selecting or clearing the disable-tunnel-service

check box.

8. Enable or disable local switching by selecting or clearing the disable-local-switching

check box.

9. In the Fast reroutepriority field, specify the reroute priority for a VPLS routing instance.

10. In the Label block size field, specify the label block size for VPLS labels.

11. In the Connectivity type field, select a connection-type to specify when a VPLS

connection is taken down, depending on whether the interface for the VPLS routing

instance is customer-facing or integrated routing and bridging (IRB)

12. ClickOK to save all your changes in the Advanced Settingwindow.

13. In the Deployment Optionswindow, select one of the following:

• Save the change without scheduling it.

• Schedule the change for immediate deployment.

• Schedule the change for later deployment.
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14. ClickOK.

15. Use the JobManagementworkspace to monitor the progress and status of the

deployment. See Viewing Jobs in the Junos Space Network Application Platform User

Guide for details.

To view themodified service in the topology, select Platform > NetworkMonitoring >

Topology > Service > NA.

For more information on topology, see “Junos Space Network Topology Overview” on

page 40

Related
Documentation

Creating a Point-to-Multipoint VPLS Service Order on page 507•

• Deploying a Service on page 467

• Viewing Jobs in the Junos Space Network Application Platform User Guide

• Viewing Services on page 776

• Modifying a Point-to-Point Ethernet Service on page 750

• Modifying a Multipoint-to-Multipoint Ethernet Service on page 729

Modifying a Point-to-Point Ethernet Service

You canmodify the following entities of a point-to-point Ethernet service:

• MTU across the network

• Rate limiting bandwidth of an endpoint

• MTU of an endpoint

After modifying a service, the configuration audit and functional audit information is

cleared and the functional audit status is set to pending.

Tomodify the attributes of a service:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In theManage Services page, select the service you want to modify.

3. Open the Actionsmenu and selectModify Service.

A graphical image of the service appears, showing device images that represent the

service endpoints and a cloud image that represents the network core. By default, the

cloud image is selected, which displays general settings and connectivity information

in the right panel. The General Settings box contains a unique name for the service

order that will request the change.
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4. In the Name field, change the name of the modification service order, if desired.

5. Change the MTU setting, as required.

6. If you have configured the CFM, the General/Connectivity Settings panel provides an

option todisable theCFMservice. You can select theDisableCFM checkbox todisable

the CFM service, if desired.

If you have not configured the CFM, the General/Connectivity Settings panel provides

an option to enable the CFM service. You can select the CFM definition from the CFM

Definition list, if desired.

7. Click Next.

The service order endpoint settings information for endpoint A appears in the right

panel.

8. Change the bandwidth or MTU setting as required.

9. Change the Revert time (sec) and Switch Over Delay (sec) as required.

10. Select or clear the Enable send-oam config check box.

11. Click Next andmake any required changes to endpoint Z.

12. ClickModify.

The Network Activate software modifies the service.

13. Use the JobManagementworkspace to check for successful completion of the action.

See Viewing Jobs in the Junos Space Network Application Platform User Guide for

details.

To view themodified service in the topology, select Platform > NetworkMonitoring >

Topology > Service > NA.
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For more information on topology, see “Junos Space Network Topology Overview” on

page 40

Related
Documentation

Viewing Services on page 776•

• Deploying a Service on page 467

• Creating a Point-to-Point Service Order on page 438

• Modifying a Multipoint-to-Multipoint Ethernet Service on page 729

• Modifying a Point-to-Multipoint Ethernet Service on page 738

Modifying a Service in Cross Provisioning Platform

Use the Device Configlet Services landing page to modify a device configlet service in

Cross Provisioning Platform. You canmodify a device configlet service only if a

modification script is attached to the device configlet service.

Tomodify a service in Cross Provisioning Platform:

1. From the Cross Provisioning Platform task pane, select CPP > Services.

The Services page that appears displays a list of existing services.

2. Either select Service >Modify or select a service and click theModify icon on the grid

tool bar. You can also modify a service by selecting the service and then selecting

Actions >Modify.

TheModify Service page appears.

NOTE: TheModify Service page details vary according to the type of the

selected service.

3. Modify the service details and clickModify.
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The Job Details dialog box appears along with a job ID link.

4. Click the Job ID link to view the job details.

The JobManagement page that appears contains a list of the jobs, along with the

status of the jobs.

Related
Documentation

Modifying Bulk Services and Devices in Cross Provisioning Platform on page 687•

Understanding Service Validation

Youcanusea functional audit andaconfigurationaudit tomonitor thehealth of a service

for any of the following reasons:

• You have just deployed a service andwant to verify that it works before your customer

starts to use it.

• You want to perform periodic verification that a service is functioning correctly.

• A customer has reported that a service is not functioning correctly and you need to

find out what the problem is and fix it.

The following sections provide instructions for functional audit and configuration audit:

• Performing a Functional Audit on page 805

• Performing a Configuration Audit on page 803

Related
Documentation

• Viewing Functional Audit Results on page 760

• Viewing Configuration Audit Results on page 757

• Service Troubleshooting Overview on page 801

753Copyright © 2015, Juniper Networks, Inc.

Chapter 19: Service Provisioning: Managing Deployed Services



Copyright © 2015, Juniper Networks, Inc.754

Junos Space Cross Provisioning Platform



PART 4

Troubleshooting

• Service Provisioning: Monitoring Services and Service Orders on page 757

• Troubleshooting Devices and Services on page 785
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CHAPTER 20

Service Provisioning: Monitoring Services
and Service Orders

• Viewing Configuration Audit Results on page 757

• Viewing Functional Audit Results on page 760

• ViewingFunctionalAuditResults foran InverseMultiplexing forATMServiceonpage764

• Viewing Service Orders on page 765

• Viewing Cross Provisioning Platform Service Order Details on page 767

• Service Lock for Cross Provisioning Platform on page 769

• Modifying a Saved Service Order on page 771

• Viewing Service Provisioning Statistics on page 774

• Viewing Services on page 776

• Viewing Service-Level Alarms in Network Activate on page 777

• Creating a Threshold Alarm Profile on page 780

• Viewing Threshold Alarm Profile Performance Parameters on page 781

• Attaching a Threshold Alarm Profile to a Service Definition on page 782

• Viewing Threshold Alarm Profile Performance Status on page 783

• Editing a Threshold Alarm Profile on page 784

Viewing Configuration Audit Results

After performing a configuration audit, check the detailed results of the audit:
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1. In the Network Activate task pane, select Service Provisioning >Manage Services.a.

b. In theManage Services page view, select the service you are investigating.

c. Open the Actionsmenu and select View Configuration Audit Results.

Examine the audit results for missing configuration information, and keep the

windowopen for later comparisonwith the service configuration in the JunosSpace

database.

You can validate policies for the hub and spoke (1 interface).

2. Toview the service configuration in the JunosSpacedatabase, double click the service

icon in theManage Services page, then in the Actionsmenu, select View Service

Configuration.

A newwindow opens and shows the service configuration.
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If a CFM is configured in P2P service or VPLS service, the configuration audit result

displays the CFM configuration details.
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3. Compare the contents of the Service Configuration with those of the Configuration

Audit Resultswindow for each device in turn. If you see discrepancies, then it is likely

that the service configuration wasmodified out-of-band. If so, youmight need to

synchronize the device with the Junos Space database.

For step-by-step instructions about synchronizing devices, see Resynchronizing

Managed Devices with the Network for details.

Related
Documentation

Performing a Configuration Audit on page 803•

• Performing a Functional Audit on page 805

• Viewing Functional Audit Results on page 760

Viewing Functional Audit Results

To view the results of a functional audit of a service, follow this procedure:

After performing a functional audit on a service (see “Performing a Functional Audit” on

page 805), look at the functional audit results:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In the Manage Services screen, select the service for which you want to view the

functional audit results.
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3. Either open the Actions drawer and select View Functional Audit Results, or select the

same command from the right mouse-click menu.

The Functional Audit Resultwindow appears, displaying Service Status in the right

panel.

If a CFM is configured in a P2P service or VPLS service, the functional audit results

includes the result of both Network Activate and CFM service.

Agreenup-arrow in theServiceStatusheaderbar indicates that the servicehaspassed

the functional audit in both the control plane and the data plane. A red down-arrow

indicates that the service failed either or both the control plane validation and the

data plane validation.
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Depending on the type of service, the left panel lists

• The name of the service

• Each endpoint in the service

Icons representing the endpoint indicate its role in the service and its up or down

state. Table 32 on page 762 describes these icons for a point-to-multipoint service.

Table 32: Point-to-Multipoint Service Endpoint Icons

MeaningIcon

Hub in a point-to-multipoint service. Endpoint state is up.

Hub in a point-to-multipoint service. Endpoint state is down.

Spoke in a point-to-multipoint service. Endpoint state is up.

Spoke in a point-to-multipoint service. Endpoint state is down.

• Interface name

• A numeric value indicating the subinterface name: the VLAN-ID for an 802.1Q

interface, the service VLAN-ID for a Q-in-Q interface, or 0 for a dedicated port.

• Device name

4. To show all endpoints in the service, in the left panel header, select All. To display

only the endpoints indicating failed validation, select Failed. Failed is dimmed if the

functional audit returned no validation errors.

5. To view details for an individual interface or endpoint, select it in the left panel. The

header bar on the right panel changes to End Point or Interface Status, and details

for the selected item are displayed below.

6. Expand each device to show the link from that device to the other N-PE device in the

service.

An icon next to each link indicates whether the functional audit commands reported

correct functioningof thecontrol planeanddataplane.Table33onpage762describes

these icons.

Table 33: Functional Audit Success Status Icons

MeaningIcon

Control plane and data plane function correctly.

Errors were reported in the functioning of either the control plane or the data
plane.

7. In the left panel, select a link.
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Thepanel to the right shows the validation results for the control plane validation and

data plane validation for the selected link. Icons indicate the success or failure of each

set of tests.

The panel to the right shows the validation results for the control plane validation and

data plane validation for the selected link. Icons indicate the success or failure of each

of these setsof tests. Table34onpage763describes iconsand the textual information

provided in the box beside the icon.

Table 34:Multipoint-to-Multipoint Service Control Plane andDataPlane
Validation Icons

ExplanationMeaningIcon

The text box shows the name
of the remoteN-PEdeviceand
confirms that the data plane
is operational.

Control plane up

The text box shows the name
of theconfigured remoteN-PE
device and, in the Command
status field, explains why the
test failed.

Control plane down

The text box indicates the
nameof theconfigured remote
N-PE device and, in the Result
field, an explanation as towhy
the functional audit operation
was unable to test the control
plane—for example,
configuration wasmissing on
the device.

Control plane status unknown

The text box indicates the
numberofpackets transmitted
and received, and confirms
that no data packetswere lost
during the audit.

Data plane up

The text box indicates that
data packets were lost during
the audit.

Data plane down

The functional audit was
unable to complete the data
plane test. The Result field in
the text box indicates the
reason—for example, the
platform does not support
data plane testing, or the
connection to the remoteN-PE
device is down.

Data plane status unknown
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The control plane and data plane validation checks must both show operational

status for the link to be considered operational.

8. To troubleshoot a service, open the Troubleshooting tab. To select the status you

want to check, click the device from the device list on the left, and select the show

command from the Command list.

An iconnext toeachcommand indicateswhether thecommandexecution is successful

or failed. Table 35 on page 764 describes these icons.

Table 35: Command Status Icons

MeaningIcon

Command execution is successful and the command status is up.

• Command execution is failed, or,

• In case of multiple rows, one of the status value is down

NOTE:

• Dataplane informationbetweentwoendpoints inaVPLSservice isprovided
only for MX Series devices. This information is not provided for M Series
devices.

• JunosOSRelease 9.3 and JunosOSRelease 9.4 do not support data plane
validation. The Functional Audit Results screens do not display data plane
validation information if any device in the service is running one of these
Junos OS releases.

Related
Documentation

Performing a Functional Audit on page 805•

• Performing a Configuration Audit on page 803

• Viewing Configuration Audit Results on page 757

Viewing Functional Audit Results for an InverseMultiplexing for ATMService

To view functional audit results for an Inverse Multiplexing for ATM Service:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In theManage Services screen, select the service for which you want to view the

functional audit results.

3. Right-click the service, or click the Actionsmenu, and select View Functional Audit

Results.

4. In the Functional Audit Resultswindow, click the Troubleshooting tab.
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In the Troubleshooting tab, when you select a show interfaces command for a UNI

interface that is configured as an IMA Group Link, the command displays details for

the IMA group interface.

Related
Documentation

Inverse Multiplexing for ATMOverview on page 44•

• Creating an Inverse Multiplexing for ATM Service Order on page 459

Viewing Service Orders

The following topic describes how you can view service orders.

• Viewing Service Orders in a Table on page 765

Viewing Service Orders in a Table

To view and determine the status of service orders in a tabular form:

1. In the Network Activate task pane, select Service Provisioning >Manage Service
Orders.

2. In the filter bar, click the table view icon.

A table of service orders on the system appears in the main display area.

Table 36 on page 765 describes the fields in the service orders table.

Table 36: Fields in the Service Orders Table

DescriptionField

Name of the service order assigned during service creation or edit.Name
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Table 36: Fields in the Service Orders Table (continued)

DescriptionField

Status of the service order:

• Completed—Service order has been successfully deployed.

• Deploy failed—Device is down or the Network Activate software was
unable to push the service configuration to a device configured for the
service.

• In-progress—Network Activate software is in the process of deploying
the service.

• Requested—Service provisioner has created the service order, but has
not yet attempted to deploy it or schedule it for deployment.

• Scheduled—Service provisioner has scheduled the service order for
deployment.

• Invalid—Service order contains invalid data.

Order State

Name of the enterprise customer who placed an order for the service.Customer

One of the following:

• Point-to-Point Ethernet (LDP)

• VPLS—Either amultipoint-to-multipoint service or a point-to-multipoint
service

Service Type

Type of signaling:

• BGP

• LDP

Signaling

Date that the service provisioner created the request.Created Date

Screen name of the service provisioner who created the service order.Created By

3. To view details of a specific service order, double-click the table row that summarizes

the service order.

For a point-to-point service order, a graphical illustration of the service order appears.

See “Creating a Point-to-Point Service Order” on page 438 for information about

interpreting this graphic.

For amultipoint service order, a table of information about the service order appears.

See “Creating a Point-to-Multipoint VPLS Service Order” on page 507 for information

about interpreting this graphic.

Related
Documentation

Deploying a Service on page 467•

• Deleting a Service Order on page 466

• Viewing Services on page 776

Copyright © 2015, Juniper Networks, Inc.766

Junos Space Cross Provisioning Platform



Viewing Cross Provisioning Platform Service Order Details

To view the details of a cross-platform service order:

1. In theCrossProvisioningPlatformtaskpane, selectCPP>Services. TheCPP>Services

windowappears,whichdisplaysa list of theprovisionedcross-platformserviceorders.

2. Double-click a listed service order, or select a service order and click on the View

Service Details icon. The CPP > Service Detailswindow appears, which displays the

details of the service.

Anew fieldServiceVersion is added in theViewServiceOrderDetails andViewService

Details windows. This field indicates the total number of times a service order or a

service ismodified. Each time you successfullymodify a service order or a service, the

service version number is incremented by one.

The Advanced Details For Device pane includes four tabs, which provide details on

additional parts of the device configuration:
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• General (See previous illustration.)—The General tab displays theMtu and Vcid values

for the device selected in the left panel.

• Interface—The Interface tab displays theMtu,OuterTag and VlanType values for the

device selected in the left panel.

• Firewall—The Firewall tab displays the Ingress-filter value for the device selected in

the left panel.

• Configuration—The Configuration tab displays the configuration code for the device

selected in the left panel.
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Related
Documentation

Creating a Cross Provisioning Platform Service Definition on page 192•

• Creating a Cross Provisioning Platform Service Order on page 462

Service Lock for Cross Provisioning Platform

Multiple users might attempt to modify the same service at the same time. This conflict

might causeanother user'smodifications tobeoverwritten. Toovercomesuchascenario,

theCrossProvisioningPlatform’s service lock featureprovides you the flexibility to serialize

the service order creation, and allow only one operator to modify a service at any given

time.

To enable the service lock feature:

1. Select NetworkManagement Platform > Administration > Applications.

The Applications page displays the list of applications.

2. Right-click the Network Activate row and selectModify Applications Settings.

The Modify Network Activate Settings page displays the list of parameters that can

bemodified.

3. Select Deployment.
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4. Select the Check service version check box.

5. ClickModify.

To identify the service order that is blocking you frommodifying a service:

1. Select Cross Provisioning Platform > CPP > Services.

The Cross Provisioning Platform Services inventory page displays the list of services.

2. Right-click a service, and select View Service Order.

You are directed to the Cross Provisioning Platform Service Orders inventory page.

The Service Orders inventory page displays the list of service orders.

The Order State column helps you to decide if that service order is blocking you from

modifying a service. If necessary, you can delete the failed or invalid service orders.

The Service Version field in the View Service Order Details and View Service Details

windows indicates the totalnumberof timesaserviceorderoraservicehasbeenmodified.

Each time you successfullymodify a service order or a service, the service versionnumber

increases by one.

NOTE: For failedmodifications the Service Version field does not increase.

When you create a service order, the View Service Order Details window displays the

Service Version number as zero. When youmodify a service, the Service Version in View

Service Order Details window increases by one.

When you perform a configuration audit or view the service configuration changes, the

service version in the View Service Details window does not change.

The following error messages are displayed whenmultiple operators attempt to modify

a service at same time:

• There aremultiple users trying tomodify the current service concurrently. Please close

the current window and try again.

• Thereareoneormorependingservice request(s) for thisservice.Pleasecheckthepending

service order(s) for this service and take appropriate action as necessary.

• The service version in current service request is older/outdated than the latest service

version. Please close the current window and try again.

Related
Documentation

Creating a Cross Provisioning Platform Service Order on page 462•

• Viewing Cross Provisioning Platform Service Order Details on page 767
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Modifying a Saved Service Order

Before a service order can affect a service, itmust transition through the following states:

• Requested—When the service provisioner has created the service order, but has not

yet attempted to deploy it or schedule it for deployment, the service order is in the

Requested state.

• Scheduled—After the service provisioner has scheduled the service order for
deployment, the service order transitions to the Scheduled state.

• In Progress—When a scheduled service order reaches its time for deployment, it

transitions to the transitory InProgress state. Fromthis state, the JunosSpacesoftware

attempts to deploy the service.

• Validated—When all the information in the service order is successfully validated, the

service order transitions to the Validated state.

• Completed—Successful deployment transitions the service order to the Completed
state.

• Invalid—If the Junos Space software cannot deploy the service because of invalid
information in the service order itself, the service order enters the Invalid state. The

service provisioner must resolve the issues that cause the failure before re-creating

the service order and rescheduling it for deployment.

• Failed Deploy—If the device is down or the Junos Space software is unable to push
theservice configuration to thedevice, the serviceorder transitions to theFailedDeploy

state.

Figure 27 on page 771 illustrates the service order states.

Figure 27: Service Order States

To view the state of a service order, select Network Activate > Service Provisioning >

ManageServiceOrders. TheManageServiceOrders inventorypage lists the serviceorders

and their state.
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The JunosSpaceNetworkActivateapplicationprovides the flexibility tomodifyanexisting

serviceorder. Youcanmodify a serviceorderwhen theorder state isRequested,Validated,

or Invalid. You cannot modify a service order when the order state is Scheduled,

Completed, or Failed Deploy.

Tomodify a service order:

1. Select Network Activate > Service Provisioning >Manage Service Orders.

2. Right-click an existing service order, and then select Service >Modify.

The Modify Service Order window appears.

NOTE: Themodifyoption isunavailable if theserviceorder is inScheduled,
or Completed, or Failed Deployed state.

3. Modify the fields as needed.

The following table lists the fields that you canmodify in a point-to-point service

order, VPLS service order, and Layer 3 VPN service order.

Layer 3 VPN Service OrderVPLS Service OrderPoint-to-Point Service Order

NameNameName

CustomerCustomerCustomer

CommentsCommentsComments

VLAN IDVLAN IDVLAN ID

Route TargetInner VLAN IDVCID

Hub Route TargetVLAN Tag to stackCFM

Spoke Route TargetPE devicePE device

UNI InterfaceUNI interfaceUNI interface

Route DistinguisherUNI descriptionUNI description

Hub Route DistinguisherMTUMTU (Bytes)

Spoke Route DistinguisherBandwidthBandwidth

Autopick Interface IP AddressEnable P2P-SpokeRSVP LSP name

VRF Table labelEthernet Option in case of AsymmetricPWbackup settings

Export Direct RoutesNeighbor HubVPI
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Layer 3 VPN Service OrderVPLS Service OrderPoint-to-Point Service Order

AS overrideBackup NeighborHubVCI

HubHubOutgoing label

MaximumprefixesCustomer VLAN Range Start-

IP address pool

NOTE: While modifying a Layer 3 VPN
service order, youmust select the IP
address pool.

Customer VLAN Range End-

Peer ASMAC learning-

-InterfaceMAC limit-

-MAC statistics-

-MAC table size-

-Disable tunnel services-

-Disable local switching-

-Fast reroute priority-

-Label block size-

-Connectivity type-

NOTE: You can change amanaged device to an unmanaged device, and
an unmanaged device to amanaged device. You can also change a local
switching service order to a normal point-to-point service order.

4. Click Save.

The service order is modified. You can now deploy the service order with modified

parameters to the device.

Related
Documentation

Creating a Point-to-Point ATM or TDM Pseudowire Service Order on page 432•

• Creating a Point-to-Point Service Order on page 438

• Creating a Multipoint-to-Multipoint VPLS Service Order on page 491

• Creating a Point-to-Multipoint VPLS Service Order on page 507

• Creating a Full Mesh Layer 3 VPN Ethernet Service Order on page 536
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• Creating a Hub-and-Spoke Layer 3 VPN Service Order on page 549

Viewing Service Provisioning Statistics

The Service Provisioning workspace provides a visual overview of customers and service

orders on your network, andenables you toquickly access relatedandcommonly needed

information.

The following topics describe viewing statistics in the Service Provisioning workspace:

• Viewing Service Orders by Customer on page 774

• Viewing the Percentage of Service Orders in Each Service Order State on page 775

Viewing Service Orders by Customer

To view the number of service orders created for each customer:

1. In the Network Activate task pane, select Service Provisioning.

The system displays the chart named Services by Customer.

Each vertical bar represents a customer. The number of service orders is shown on

the Y axis. In this example, three service orders has been issued on behalf of Best

Customer.

2. To list the serviceorders created for a specific customer, clickon thebar that represents

the customer.

TheManage Service Orders page shows only those service orders made on behalf of

the selected customer.
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Viewing the Percentage of Service Orders in Each Service Order State

You can view service orders in a specific state. For example, you can check for failed

service orders and then access a list of failed requests so you can begin to take corrective

action.

To view service orders by service order state:

1. In the Network Activate task pane, select Service Provisioning.

The system displays the chart named Service Order States.

Each segment of the pie chart represents the proportion of service orders in a specific

service order state:

• Completed—The service order has been successfully deployed.

• Scheduled for deployment—Theserviceprovisioner has scheduled the serviceorder

for deployment.

• Deployment Failed—An attempted service deployment was not successfully

completed or failed an audit.

• In Progress—The Network Activate software is in the process of deploying the

service.

• Requested—The service provisioner has created the service order, but has not yet

attempted to deploy it or schedule it for deployment.

• Invalid—The service order is not valid.

2. To list the service orders in a specific state, click on the state’s segment of the pie

chart.

TheManage Service Orders page shows only those services in the specified state.
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Related
Documentation

Junos Space User Interface Overview•

• Viewing Services on page 776

• Viewing Service Orders on page 765

Viewing Services

The following topic describes how to view services:

• Viewing Services in a Table on page 776

Viewing Services in a Table

To view the services inventory in a table:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

The Mange Services page presents information on existing services in a table.

TheManage Services page provides the following information about each service:

• Name—Unique name assigned to the service.

• Customer—Name of the customer for which the service is provided.

• State:

• Deployed—Service does not exist until it is deployed.

• Failed Deploy—An attempt to modify the service failed.

• Status:

• Up—Service passed functional audit.

• Down—Service failed functional audit.

• Definition—Service definition on which the service is based.

• Activation Date—Date and time the service was activated.

• Last Modified Date—Date and time at which the service was last modified.
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2. To restrict the display of services, enter a search criterion of one or more characters

in the search bar and press Enter. All services that match the search criterion are

shown in the main display area.

3. To view details of a specific service, double-click the table row that summarizes the

service. For a point-to-point Ethernet service, a graphical illustration of the service

appears. See “Creating a Point-to-Point Service Order” on page 438 for information

about interpreting this graphic and obtaining additional information.

For aVPLSservice (point-to-multipoint ormultipoint-to-multipoint), a tableof service

details appears. See “CreatingaPoint-to-MultipointVPLSServiceOrder” onpage507

and “Creating a Multipoint-to-Multipoint VPLS Service Order” on page 491 for

information about interpreting this graphic.

Related
Documentation

Understanding Service Validation on page 753•

• Decommissioning a Service on page 716

• Modifying a Point-to-Point Ethernet Service on page 750

• Modifying a Multipoint-to-Multipoint Ethernet Service on page 729

• Modifying a Point-to-Multipoint Ethernet Service on page 738

• Viewing Service Orders on page 765

• Deploying a Service on page 467

Viewing Service-Level Alarms in Network Activate

The Junos Space Network Application Platform has integrated a third party tool,

OpenNMS, to provide network monitoring capabilities. The OpenNMS network

management application platform provides solutions for enterprises and carriers.
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OpenNMS is installedaspartofPlatform,whichexposessomeofOpenNMS’ functionality

through the Network Monitoring workspace. The default performancemanagement

configuration of OpenNMS for Space supports generic counters, CPU, memory,

temperature, and Mobility counters. For information on this default configuration, see

the subset of the OpenNMS documentation included in this Junos Space Network

Application Platform User Guide.

CAUTION: Although additional OpenNMS functionality can be accessed by
customizing its XML files, editing these files can affect the functionality of
the Network Monitoring workspace. Juniper Networks does not support
changes to OpenNMS.

To access the OpenNMS tool, in Network Activate task pane, select Service Provisioning

>Manage Services.

1. When theManage Services page appears, select the entry for the service you want to

look at.

2. Right-click or open the Actionsmenu.

3. Select View Service Alarms.

4. From the actions list, select View Service Alarms.

The OpenNMS NetworkMonitoringwindow appears.
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From this window you can view the alarms associatedwith the service and search for

specific alarms.

NOTE: The events listed here are based on the status of the Decouple

Service Status FromPort Status check box in the Point-to-Point and the

Layer 3 Virtual Private Network service definition window.

Related
Documentation

Viewing Services on page 776•

• SNMPMIBs and Traps Reference

• Junos Space Network Monitoring Reference

779Copyright © 2015, Juniper Networks, Inc.

Chapter 20: Service Provisioning: Monitoring Services and Service Orders

http://www.juniper.net/techpubs/en_US/junos12.1/information-products/pathway-pages/mibs-and-traps-ref/mibs-and-traps-ref.html
http://www.juniper.net/techpubs/en_US/junos-space11.4/information-products/pathway-pages/platform-network-monitoring-pwp.html#opennms


Creating a Threshold Alarm Profile

To create a Threshold Alarm Profile, in the Network Activate task pane, select Service

Design >Manage Threshold Alarm Profile > Create Threshold Alarm Profile.

The Create Threshold Alarm Profilewindow appears.

1. Enter information in the relevant fields of the Create Threshold Alarm Profilewindow:

ActionField

Type a name for the Threshold Alarm Profile.Name

Select the service type:

• P2P

• VPLS

Service type

Select the performance parameters that you want to include in the profile.

The available parameters depend on the Service type selected.

Perf Parameters

Type comments to describe the Threshold Alarm Profile.Comments

This column displays the names of the parameters selected in the Perf Parameters field.Perf Parameter Name
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ActionField

Thisparameter is configuredautomatically, dependingon theperformanceparameters selected.
You cannot edit this field. The possible values are:

• Absolute

• Relative

Data Type

Specify the maximum duration during which threshold crossing is allowed.Observation Interval(s)

Specify a threshold value. If the performance data exceeds the value specified in the Threshold
field, the Junos Space application or OpenNMS software generates a threshold alarm for the
selected service.

Threshold

Specify the conditional status bywhich youwant the performance data to be evaluated relative
to the specified threshold.

Condition

Specify the relative severity of the performance test results, which determines when an alarm
is raised:

• Critical

NOTE: Currently, you can specify Critical only.

Severity

This column displays a message generated by the application according to the test being
performed. This message is updated in the threshold alarm.

Message

2. When you complete entering information in the Threshold AlarmProfilewindow, click

Create.

Related
Documentation

Creating a Point-to-Point Ethernet Service Definition on page 97•

• Performance Management Overview on page 785

• Monitoring Performance Management Statistics on page 787

• Viewing Performance Management Statistics on page 790

• Viewing Threshold Alarm Profile Performance Parameters on page 781

• Attaching a Threshold Alarm Profile to a Service Definition on page 782

• Viewing Threshold Alarm Profile Performance Status on page 783

Viewing Threshold Alarm Profile Performance Parameters

To view a list of existing Threshold Alarm Profiles, in the Network Activate task pane,

select Service Design >Manage Threshold Alarm Profile. TheManage Threshold Alarm

Profilewindowappears. To view theperformanceparameters that are set for a particular

Threshold Alarm Profile:

1. Double-click the selected profile.

The View Threshold Alarm Profile Detailswindow displays the profile parameter

settings.
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2. Whenyou finishviewingThresholdAlarmProfileperformanceparameters, clickClose.

Related
Documentation

Performance Management Overview on page 785•

• Monitoring Performance Management Statistics on page 787

• Viewing Performance Management Statistics on page 790

• Creating a Threshold Alarm Profile on page 780

• Attaching a Threshold Alarm Profile to a Service Definition on page 782

• Viewing Threshold Alarm Profile Performance Status on page 783

Attaching a Threshold Alarm Profile to a Service Definition

To attach a Threshold Alarm Profile to a service definition, in the Network Activate task

pane, select thepathappropriate for the typeof servicedefinition that youwant tocreate,

as follows:

• Service Design >Manage Service Definitions > Create P2P Service Definition

• Service Design >Manage Service Definitions > Create VPLS Service Definition

1. In the Generalwindow, as you enter information for the service definition, in the

Threshold Alarm Profile field, select the Threshold Alarm Profile that you want to

attach to this service definition.

2. When you complete entering information for the service definition, click Create.
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Related
Documentation

Creating a Point-to-Point Ethernet Service Definition on page 97•

• Creating a Point-to-Multipoint VPLS Service Definition on page 138

• Creating a Multipoint-to-Multipoint VPLS Service Definition on page 117

• Creating a Service Definition for VPLS Access into Layer 3 Networks on page 249

• Performance Management Overview on page 785

• Creating a Threshold Alarm Profile on page 780

• Viewing Threshold Alarm Profile Performance Parameters on page 781

• Viewing Threshold Alarm Profile Performance Status on page 783

Viewing Threshold Alarm Profile Performance Status

When you successfully attach aThresholdAlarmProfile to a service definition and create

an associated and functioning service order, you can check the performance status of

the service.To run performancemanagement for a service:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. Right-click the service youwant to check and selectAudit > PerformFunctional Audit.

3. When the functional audit is running, to runperformancemanagement, right-click the

service and select PMStatistics > Start.

The system begins to collect performance data pertaining to the parameters you

specified in the Threshold Alarm profile: for example, Average-Two-Way-Delay,

Best-Two-Way-Delay, or Average-One-Way-Delay.

If dataexceeds the threshold value specified in theThresholdAlarmProfile, the system

generatesa thresholdalarm.Thevalue in theSLAStatuscolumn in theManageServices

window changes to SLA Violated. If the data does not cross the threshold value

specified in the Threshold Alarm Profile, the value in the SLA Status column changes

to SLA Violation Cleared.

NOTE: To viewPMstatistics, the functional audit status (FAStatus)must

be Up.
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Related
Documentation

Creating a Threshold Alarm Profile on page 780•

• Viewing Threshold Alarm Profile Performance Parameters on page 781

• Attaching a Threshold Alarm Profile to a Service Definition on page 782

Editing a Threshold Alarm Profile

To edit an existing Threshold Alarm Profiles, in the Network Activate task pane, select

Service Design >Manage Threshold Alarm Profile. TheManage Threshold Alarm Profile

window appears. To edit a particular Threshold Alarm Profile:

1. Right-click the selected profile.

The Edit Threshold Alarm Profilewindow is displayed.

2. Modify the parameters. You will be able to modify the following fields only:

• Comments

• Performance parameters

• Performance Parameters Details

3. When you finish editing Threshold Alarm Profile, click Update.

The Threshold Alarm Profile is modified.

NOTE: You cannot modify the threshold alarm profile if it is associated with
a service.

Related
Documentation

• Creating a Threshold Alarm Profile on page 780

• Attaching a Threshold Alarm Profile to a Service Definition on page 782

• Viewing Threshold Alarm Profile Performance Status on page 783
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Troubleshooting Devices and Services

• Performance Management Overview on page 785

• Monitoring Performance Management Statistics on page 787

• Viewing Performance Management Statistics on page 790

• Monitoring Performance Statistics Derived fromMIB Objects on page 794

• Viewing Performance Statistics Collected According to SLAX Scripts on page 796

• Debugging a Cross Provisioning Platform Script on page 799

• Service Troubleshooting Overview on page 801

• Performing a Configuration Audit on page 803

• Performing a Functional Audit on page 805

• Troubleshooting N-PE Devices Before Provisioning a Service on page 814

• Modifying the Application Settings of Network Activate on page 816

• Troubleshooting Services in Cross Provisioning Platform on page 820

• Downloading the Collection of Cross Provisioning Platform Log Files on page 825

PerformanceManagement Overview

In performancemanagement (PM), theNetwork Activate application provides an option

to measure the frame delay, frame loss, frame delay variation, and service availability.

These measurements are achieved in either of the following ways:

• Triggering a one-way delay

• Triggering a two-way delay

• Loss

The performancemeasurement is useful for generating periodic service level agreement

conformance reports from the deployed network and for studying traffic patterns in the

network over a period of time. The iterator profiles are configured on remote MEP for

measurement of framedelay (ETH-DM), frame loss (ETH-LM) and statistical frame loss

(SFL).

Monitoring Performance Statistics

The PM statistics can be collected in the following two ways:
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1. On-DemandMode

2. Proactive Mode

NOTE: TheNetworkActivateapplicationsupportsonly theon-demandmode.

On-DemandMode

In on-demandmode, you can trigger the measurements. You can also collect loss

measurement (ETH-LM) and delay measurements (ETH-DM).

Loss Measurement

The frame loss is calculated by collecting the counter values applicable for ingress and

egress service frames. The counters maintain a count of transmitted and received data

frames between a pair of MEPs. The loss measurement statistics are retrieved as the

output of themonitor ethernet loss-measurement commandand are also stored at the
initiator. The frame counts are stored at both the initiator and the receiver MEPs for later

retrieval.

The on-demand lossmeasurement statistics is collected for point-to-point service only.

There are two linear charts: Near-End-CIR and Far-End-CIR. For each interval, the graph

plots three values: Average case, best case, and worst case frame loss.

Delay Measurement

To start an ethernet frame delay measurement session, the router initiates an exchange

of frames carrying one-way or two-way frame delay measurement protocol data units

(PDUs)betweenthe localand remoteMEPs.Ethernet framedelaymeasurementstatistics

are measured and stored at only one of the MEPs.

For one-way ethernet frame delay measurement, only the receiver MEP (on the remote

system) collects statistics. For two-way Ethernet frame delay measurement, only the

initiator MEP (on the local system) collects statistics.

Theon-demanddelaymeasurement statistics are collected for point-to-point andVPLS

services. Either the one-way or two-way delaymeasurements statistics are collected for

the servicesat agivenpoint of time. For each interval, the graphplots three value: Average

delay, best case delay and worst case delay.

Proactive Mode

In this mode SLAmeasurements are triggered by an iterator application. The proactive

performancemonitoring is supported only on VPWS and VPLS.

PerformanceManagement of Test Traffic

The Network Activate application enables you to create Threshold Crossing Alert (TCA)

Profiles to apply service level agreement (SLA) parameters to test traffic as defined by

the following standards:

• L2 Ethernet OAM/ ITU-T Y.1731
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• RFC2544

Specifically, the parameters are:

• Bandwidth Utilization

• Delay

• Delay Variation—Jitter

• Frame Loss

• Throughput

See Creating a TCA Profile.

Related
Documentation

Viewing Performance Management Statistics on page 790•

• Monitoring Performance Management Statistics on page 787

Monitoring PerformanceManagement Statistics

The following topics show how tomonitor the performance statistics for point-to-point

and VPLS services:

• Monitoring Statistics for Point-to-Point Service on page 787

• Monitoring Statistics for VPLS Service on page 788

Monitoring Statistics for Point-to-Point Service

In the Network Activate task pane, select Service Provisioning >Manage Services.

To monitor the statistics for the point-to-point service:

1. Right-click a point-to-point service and select Start PM Statistics. TheMonitor

Performance Statisticswindow is displayed.
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NOTE: TheStart PMStatistics action is enabled only if the CFM is enabled

in the selected point-to-point service. Always perform a functional audit
beforemonitoring the statistics. The Start PMStatistics action is disabled

if the functional audit status of a service is Down.

2. Fill in the fields as indicated in the table.

ActionField

Select a local device from the list.Local Device

Select a remote device from the list.Remote Device

Specify the number of frames to be sent to a specific peer MEP.

Range: 1 through 65,535 frames

Default: 10 frames

Count

Specify the wait interval for the frame transfer.

Range: 1 through 255 seconds

Default: 1 second

Wait Interval

Select the 802.1p priority of continuity-check and link-trace packet.

Range: 0 through 7

Default: 0

Priority (dot1p)

Select one of the following:

• Two-Way delay

• One-Way delay

• Loss

Monitor Statistics

3. ClickOK.

This action initiates a statistics collection on the endpoint device. TheViewPMStatistics

action is enabled on successful initiation of the statistics.

Monitoring Statistics for VPLS Service

In the Network Activate task pane, select Service Provisioning >Manage Services.

To monitor the statistics for the VPLS Service:

1. Right-click a VPLS service and select Start PM Statistics. TheMonitor Performance

Statisticswindow is displayed.
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NOTE: TheStart PMStatistics action is enabled only if the CFM is enabled

in the selected VPLS service. Always perform a functional audit before
monitoring the statistics. The Start PM Statistics action is disabled if the

functional audit status of a service is Down.

2. Fill in the fields as indicated in the table.

ActionField

Select a local device from the list.Local Device

Select a remote device from the list.Remote Device

Specify the number of frames to be sent to a specific peer MEP.

Range: 1 through 65,535 frames

Default: 10 frames

Count

Specify the wait interval for the frame transfer.

Range: 1 through 255 seconds

Default: 1 second

Wait Interval

Select the 802.1p priority of continuity-check and link-trace packet.

Range: 0 through 7

Default: 0

Priority (dot1p)

Select Two-Way delay.Monitor Statistics

3. ClickOK.
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This action initiates a statistics collection on the endpoint device. TheViewPMStatistics

action is enabled on successful initiation of the statistics.

Related
Documentation

Performance Management Overview on page 785•

• Viewing Performance Management Statistics on page 790

Viewing PerformanceManagement Statistics

The following topics show how to view the performance statistics for point-to-point and

VPLS services:

• Viewing Statistics for Point-to-Point Service on page 790

• Viewing Statistics for VPLS Service on page 792

Viewing Statistics for Point-to-Point Service

In the Network Activate task pane, select Service Provisioning >Manage Services.

To view the statistics for the point-to-point service:

1. Right-click a point-to-point service and select View PMStatistics.

NOTE: TheViewPMStatistics action is enabled only after performing the
Start PM Statistics.

2. View and analyze the respective graph.

The Delay Measurement graph displays a real-time linear plot of delay value with

respect to the time. The x-axis represents the time and the y-axis represent frame

delay in microseconds.

The Delay Variation graph displays the difference between the consecutive frame

delay values. The x-axis represents the time and the y-axis represent delay variation

in microseconds.

If the delay measurement is one-way, the following graph is displayed.
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If the delay measurement is two-way, the following graph is displayed.
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The Loss tab is displayed only if you have selected the Loss check box. It displays two

real-time linear plots: Near End (CIR) andFar End (CIR). The threeparameters in each

graph plot are average case, best case, and worst case of frame-loss.

The graph is plotted in real-time. By default, the total time duration is ten minutes. If

the duration of statistics collection exceeds tenminutes, the graph scrolls and shows

the data of latest ten minutes. To stop the data collection, click Stop.

To return to theManage Services Landing page, click Return to Landing page.

Viewing Statistics for VPLS Service

In the Network Activate task pane, select Service Provisioning >Manage Services.

To view the statistics for the VPLS Service:

1. Right-click a VPLS service and select View PMStatistics. TheMonitor Performance

Statisticswindow appears.

NOTE: The View PMStatistics action is enabled only after performing the

Start PM Statistics.

2. View and analyze the graphs.

The Delay Measurement graph displays a real-time linear plot of delay value with

respect to the time. The x-axis represents the time and the y-axis represent frame

delay in microseconds.
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The Delay Variation graph displays the difference between the consecutive frame

delay values. The x-axis represents the time and the y-axis represent delay variation

in microseconds.

By default, the total timeduration is tenminutes. If the duration of statistics collection

exceeds tenminutes, the graph scrolls and shows the data of latest ten minutes. To

stop the data collection, click Stop.

To return to theManage Services Landing page, click Return to Landing page.

Related
Documentation

Performance Management Overview on page 785•

• Monitoring Performance Management Statistics on page 787
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Monitoring Performance Statistics Derived fromMIB Objects

Junos Space Release 13.1P1 enables you to collect and display performance data derived

fromMIB objects. The instructions for deriving theMIB data are contained in aStylesheet

Language Alternative Syntax (SLAX) script. The Network Activate application

automatically editsapredefinedSLAXscript todetectpolicies thatare specific todifferent

point-to-point pseudowire or VPLS services.

To configure Junos Space to monitor service performance based on an SLAX script, you

perform tasks in both the Network Management Platform application and Network

Activate application.

Before you can view performance statistics collected according to SLAX scripts, you

must complete somepreparatory tasks.On the server onwhich youare running the Junos

Space software, modify files in the existing directories as described in the following list:

• In thedirectory/home/admin/opennmspatch, copy the filecollectd-configuration.xml
and replace the existing version of the file in the directory /opt/opennms/etc/.

• In thedirectory/home/admin/opennmspatch, copy the filedatacollection-config.xml
and replace the existing version of the file in the directory /opt/opennms/etc/.

• In the directory /home/admin/opennmspatch, copy the file JNX-Util.xml and add it
to the directory /opt/opennms/etc/datacollection/.

• In the directory /home/admin/opennmspatch, copy the file jnxutil-graph.properties
and replace the existing version of the file in the directory

/opt/opennms/etc/snmp-graph.properties.d/.

• In thedirectory/home/admin/opennmspatch, copy the fileeventconf.xmland replace
the existing version of the file in the directory /opt/opennnms/etc/.

• In the directory /home/admin/opennmspatch, copy the file JNX-Util-TCA.xml and
add it to the directory /opt/opennms/etc/events/JuniperEvents/.

• In thedirectory/home/admin/opennmspatch, copy the file threshd-configuration.xml
and replace the existing version of the file in the directory /opt/opennnms/etc/.

• In the directory /home/admin/opennmspatch, copy the file thresholds.xml and
replace the existing version of the file in the directory /opt/opennnms/etc/.

To collect performance data based on an SLAX script:

1. In the Network Management Platform task pane, select Images and Scripts > Scripts.

2. In the Scriptswindow, click the Import Script icon in the command bar.

3. In the Import Scriptwindow, click the + button.

4. In the Add Device Scriptswindow, browse your local file system for the SLAX script

PM.slax.
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NOTE: If you access the server on which the Junos Space software is
installed as a remote client, youmust copy the PM.slax script from the
directory /home/admin/opennmspatch/ to your local client file system.
That is, when you click on Browse to select the PM.slax script, which you
want to import, Junos Space opens the local client file system, not the file
system of the server on which Junos Space is installed.

5. When the script is added successfully, in theScriptswindow, right-click the script and

select Stage Scripts on Devices.

6. In theStageScripts onDeviceswindow, select the device onwhich youwant the script

to manage the collection of performance data.

7. Click the Enable Scripts on Device check box.

8. When you complete staging scripts, in the NetworkManagement Platform task pane,

select Administration.

9. In theAdministrationwindow, right-clickNetworkActivateandselectModifyApplication

Settings.

10. In theModify Application Settings panel, select PerformanceMonitoring.

In the PerformanceMonitoringwindow, the Enable performancemonitoring through

scripts check box should be enabled.

NOTE: Bydefault, theEnableperformancemonitoringthroughscriptscheck

box is disabled. When the check box is enabled, the performance data is
collected according to the SLAX scripts. If the check box is not enabled,
the performance data is collected according to the Y.1731 OAMmethod.

After you configure Junos Space to collect performance data according to SLAX scripts,

go to the Network Activate application.

1. Create a point-to-point or VPLS service on which you attach a CFM profile.

2. Perform a Functional Audit on the service.

3. After the Functional Audit completes successfully, select PM statistics > Start.

At this point, the system checks to determine whether the statistics will be collected

according to scripts or by theY.1731OAMmethod. If data collectionby script is enabled,

the system pushes a policy to the device upon which the performance will be

monitored. The script runs every 5minutes to collect data from updated MIB objects.

To see graphs for the collected performance data, see “Viewing Performance

Management Statistics” on page 790.

Related
Documentation

Performing a Functional Audit on page 805•

• Viewing Performance Statistics Collected According to SLAX Scripts on page 796

795Copyright © 2015, Juniper Networks, Inc.

Chapter 21: Troubleshooting Devices and Services



Viewing Performance Statistics Collected According to SLAX Scripts

Junos Space Release 13.1P1 enables you to display performance statistics derived from

MIBobjects. Theperformancestatisticsarecollectedaccording to instructionscontained

in SLAX scripts. By default, data collection occurs once every 5 minutes (300 seconds).

To view the graphs for the collected data:

1. In theNetworkManagementPlatform taskpane, selectNetworkMonitoring>Reports.

2. In the Reportswindow, select Resource Graphs.

3. Select the node (local device) on which you have deployed a service.
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4. Select jnxUtilIntegerName, under which instances are displayed. Each instance is the

service name.

5. Select the instance (that is, the service name) for which you want to view the graph.

6. To stop the gathering of performance statistics, right-click the service and select PM

Stats > Stop.
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Threshold crossing alarms are generated when the value of collected data exceeds the

specified threshold value. Toview thresholdcrossingalarms, in theNetworkManagement

task pane, select NetworkMonitoring > Alarms.

You can edit the specified values for the various threshold performance parameters such

as TwoWayDelayAvg, TwoWayDelayBest, TwoWayDelayWorst, and so on. Tomodify a

threshold performance parameter value:

1. In the Network Management Platform task pane, select NetworkMonitoring > Admin.

2. SelectManage Thresholds.

3. Select JNX-Util > Edit.
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4. Click the Edit column for the threshold expression you want to modify.

5. Modify the threshold Expression and Re-armed UEI values according to your

requirements.

6. Click Save.

Related
Documentation

Monitoring Performance Statistics Derived fromMIB Objects on page 794•

Debugging a Cross Provisioning Platform Script

In releases prior to Cross Provisioning Platform Release 14.3R1, you can identify

script-related issues only after you create a service. You cannot preview the XML

configuration that is being pushed to the device.

With Cross Provisioning Platform Release 14.3R1, you can debug both the configuration

script and the GUI script while you are still creating a service. This enables you to identify

and rectify all script-related issues before you create a service. You can debug both

Juniper Networks and Alcatel-Lucent scripts.

You can debug a Cross Provisioning Platform script by performing the following tasks:

• Modifying a Cross Provisioning Platform Script on page 800

• Previewing a Cross Provisioning Platform Script on page 800

• Verifying a Cross Provisioning Platform Script on page 800
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Modifying a Cross Provisioning Platform Script

In releases prior to Cross Provisioning Platform Release 14.3R1, you need to upload the

modified script from your local file system. In Cross Provisioning PlatformRelease 14.3R1,

you canmodify the script directly in the text area included in the Modify Script window.

By default, the latest version of the script is populated in the text area.

Tomodify a Cross Provisioning Platform script, perform one of the following tasks:

• Browse the local file system to upload the script that you havemodified in your local

file system.

The uploaded script is displayed in the text area, included in theModify Script window.

• Modify the script directly in the text area.

NOTE: In the text area in the Modify Script window, you can alsomodify
the script that you have uploaded from your local file system. For more
information about modifying an existing script, see “Modifying Scripts
Created for Cross Provisioning Platform” on page 671.

Use the Preview option in the Modify Script window to preview the script output. In the

script output, use the Verify option to verify the script output.

Previewing a Cross Provisioning Platform Script

WithCrossProvisioningPlatformRelease 14.3R1, youcanpreviewthescriptoutputbefore

you create a service.

To preview the output of a GUI script, perform one of the following tasks:

• On the Scripts inventory page, right-click a script and select Preview.

• In the Modify Script window, click the Preview option.

Verifying a Cross Provisioning Platform Script

Verify the script output to identify and troubleshoot issues, if any. The Cross Provisioning

Platform application provides you with the option to specify real-time data while you

preview the script output.

To verify the Cross Provisioning Platform script output:

1. In the Modify Script window, click the Preview option.

You can preview the script output.

2. In the script output window, specify real-time data.

3. Click Verify.
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NOTE: For the Verify option to appear in the script output window and to

generate the required XML output, youmust append the GUI script with
the newly created script utility function, scriptUtils.verifyForm(this,data).

Following is the code snippet to add the Verify option:

{
xtype: 'button',
handler: function(button, event) {

var data = this.getDataJSON();
this.scriptUtils.verifyForm(this,data)

},
scope: this,
text: 'Verify'
}

All necessary information required for debugging the Cross Platform Provisioning script

is displayed in a newwindow.

Related
Documentation

Importing Scripts Created for Cross Provisioning Platform on page 671•

• Exporting Scripts Created for Cross Provisioning Platform on page 669

• Adding Scripts Created for Cross Provisioning Platform on page 667

• Viewing Scripts Created for Cross Provisioning Platform on page 673

Service Troubleshooting Overview

Common reasons for the failure of a service are that a PE device configured for that

service is down, or that device has had its service configuration changed so that it no

longer matches the service configuration in the Junos Space database.

The primary tools in Junos Space for troubleshooting service problems are:

• Functional audit

See “Performing a Functional Audit” on page 805

• Configuration audit

See “Performing a Configuration Audit” on page 803

• Job Management

See Viewing Jobs in the Junos Space Network Application Platform User Guide

If the functional audit shows the service to be running, the next step is to perform a

configuration audit to see whether the service configuration has been changed out of

band, and is no longer consistent with the service configuration in the Junos Space

database.
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You can view the results of both configuration and functional audits from theManage

Services page. You can also view the service configuration from theManage Services

page.

In the JobManagementpage, use theSummarycolumntoobtain informationabout failed

deploymentsand failedaudits. Fordeployments ingeneral, theSummarycolumncontains

useful service information such as the VC ID and endpoint information. For some failed

deployments, this column also contains information about why the deployment failed.

The following is an example of a failed deployment in the JobManagement page.

Related
Documentation

Viewing Configuration Audit Results on page 757•

• Viewing Functional Audit Results on page 760

• Resynchronizing Managed Devices with the Network

• Understanding Service Validation on page 753

• Canceling a Job
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Performing a Configuration Audit

A configuration audit can help you determine whether the service configuration on the

device has been changed out of band. To this end, you can compare the results of a

configuration audit with the service configuration in the Junos Space database. The

following example shows a sample comparison.

To perform a configuration audit:

1. In the Network Activate task pane, select Service Provisioning >Manage Services.

2. In theManage Services page, select the service you want to investigate.

3. Open the Actionsmenu and select Perform Configuration Audit.

4. In the Schedule Configuration Auditwindow, either:

• Select Audit Now, then clickOK.

An Audit Informationwindow appears, providing a link to details about the audit in

the JobManagementworkspace, and anOK button.

• Select Audit Later, enter a date and time, then clickOK.

5. Tomonitor the progress of an audit after selecting Audit Now, click the Job ID in the

Audit Informationwindow. The JobManagement page shows information about the

functional audit job.

The State field indicates whether the service passed or failed the audit. If the service

failed the audit, then the Summary field provides information about the failure.

Tomonitor the progress of an audit after selecting Audit Later, after the scheduled

time of the audit:

a. In the Network Activate task pane, select Jobs .

b. In the Job Types chart, select the Configuration Audit segment of the pie chart.

c. Select theconfigurationaudit of interest fromthe list on the JobManagementpage.
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Summary information about the audit appears in the quick look panel.

d. In the filter bar, select the table view icon to see additional information about the

job. If the service failed the audit, information about the failure appears in the

Summary field.

6. In the Audit Informationwindow, click the job ID of the configuration audit.

The JobManagementwindow appears and shows a filtered view of the job inventory,

showing only the configuration audit job.

NOTE: If a resynchronization between a device and the Junos Space
database is ongoing when the configuration audit job starts, the
configuration audit job suspends until the resynchronization job finishes.
If the resynchronization job fails tocomplete, theaudit couldbesuspended
indefinitely. To allow the audit to proceed, go to the JobManagement

workspaceandcancel the resynchronization job, asdescribed inCanceling
a Job.

7. In the State column, check the status of the audit to determine whether it succeeded

or failed.

Check the Summary column, which contains useful service information such as the

VC ID and endpoint information. For some failed deployments, this column also

contains information about why the deployment failed.

For details about using the JobManagementworkspace, see Viewing Jobs in the Junos

Space Network Application Platform User Guide.

Related
Documentation

Viewing Configuration Audit Results on page 757•

• Performing a Functional Audit on page 805

• Viewing Functional Audit Results on page 760

• Canceling a Job
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Performing a Functional Audit

A functional audit determines whether a deployed service instance is functioning. It

checks the control plane to ensure connectivity among endpoints and that the UNIs are

functioning correctly. It also checks the data plane to verify packet transmission between

each valid pair of endpoints in the service.

The functional audit provides both a CLI verification and a troubleshooting feature that

allows you to check the status of interfaces, LDP sessions, neighbor links, and endpoints

ofpoint-to-point services.TheFunctionalAudit tabon theFunctionalAuditResultswindow

displays information about the service statistics for the link you are monitoring. The

Troubleshooting tab displays status of the interfaces, LDP sessions, neighbor links, and

endpoints.

Performing the Functional Audit

To perform a functional audit:

1. In the Network Activate task pane, select Service Provisioning >Manage Services to

display theManage Services inventory page.

2. On theManage Services page, select the service you want to audit.

3. Right-click a service or open theActionsmenu to display the list of possible functions.
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Select Perform Functional Audit. From theMonitoringwindow youmay choose either

the functional audit or troubleshooting.

4. In the Schedule Functional Audit dialog box, do one of the following:

a. Select Audit Now, then clickOK.

The Job Details dialog box appears for you to click the Job ID link to see the

functional results. The JobManagement page displays the functional audit details

by job ID, name, percentage complete, state, job type, summary, scheduled start

time, user, and recurrence.

b. Select Audit Later, enter a date and time, then clickOK.

Tomonitor the progress of an audit after selecting Audit Later, after the scheduled

time of the audit:

a. In the Network Activate task pane, select Jobs.

b. Onthe Jobs statisticspage, select theFunctionalAudit segmentof the JobTypes

pie chart.

The JobManagement page appears filtered by functional audit jobs.

c. Select the functional audit job that you want.

Summary information about the audit appears in the quick look panel.

d. In the filter bar, select the table view icon to see additional information about

the job. If the service failed the audit, information about the failure appears in

the Summary field.

5. Click the Job ID link in theAudit Informationwindow.The JobManagementpage shows

information about the functional audit job.
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The State field indicates whether the service passed or failed the audit. If the service

failed the audit, then the Summary field provides information about the failure.

6. To view additional details about the functional audit, including results from checking

the control plane and the data plane, see “Viewing Functional Audit Results” on

page 760 .

CLI Verification

TheCLI verification featureofa functional auditworksby runningcommands thatperform

verification and reporting relevant information.

The following table shows the commands that are used for each service type.

CLI CommandsXML Commands

Data PlaneControl PlaneData PlaneControl Plane

Service
Type/

Device Type

ping mpls l2circuit
virtual-circuit VCID
neighbor neighborIP

show l2circuit
connections neighbor
neighborIP interface
interfaceName

show ppp interface
mlppp group1 members

<request-ping-l2circuit-virtual-circuit>

<neighbor>neighborIP</neighbor>

<virtual-circuit-id>VCID</virtual-circuit-id>

</request-ping-l2circuit-virtual-circuit>

<get-l2ckt-connection-information>

<neighbor>neighborIP</neighbor>

<interface>interfaceName </interface>

</get-12-ckt-connection-information>

ELINE
Martini/

M Series and
MX Series

Where:

neighborIP = Address of remote neighbor

VC ID = Virtual Circuit ID

interfaceName = Name of interface

show l2circuit name
brief

Not supported.<get-l2circuit-information> <l2circuit-name>
name<l2circuit-name> <brief/>
</get-l2circuit-information>

Not supported.BX Series

Where:

Name = name of the l2 circuit ID
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CLI CommandsXML Commands

Data PlaneControl PlaneData PlaneControl Plane

Service
Type/

Device Type

ping vpls instance
routing_instance_name
destination-mac
destMacValue
source-ip
sourceIpValue
learning-vlan-id
learningVlanID

show vpls connections
instance
routing_instance_name
local-site local-siteID
remote-site
remote-siteID

<request-ping-vpls-instance>
<instance-name> routing_instance_name

</instance-name> <destination-mac>
destMacValue

</destination-mac> <source-ip> sourceIp

</source-ip> <learning-vlan-id>
learning-vlan-id

< /learning-vlan-id>
</request-ping-vpls-instance>

<get-vpls-connection-information><instance>
routing_instance_name

</instance> <local-site> local-siteID
</local-site> <remote-site> remote-siteID

</remote-site>
</get-vpls-connection-information>

VPLS/

M Series

Where:

routing_instance_name = Routing instance name

destMacValue = Destination MAC address

sourceIP = Source IP address

local-SiteID = Name or ID of VPLS local site

remote-SiteID = ID of VPLS remote site

learning-vlan-id = Learning VLAN identifier

ping routing-instance
routiingInstanceValue
count

show route table
bgp.l3vpn.0 rd-prefix
destinationRDprefix

<ping><routing-instance> routingInstanceValue
</routing-instance> <count>5 </count>

<get-route-information> <table>
bgp.l3vpn.0</table>
<rd-prefix>destinationRDprefix</rd-prefix>
</get-route-information>

L3VPN/

Junos

Where:

routingInstanceValue = Routing instance name

destinationRDprefix = Route Distinguisher: remote UNI IP address

destinationUniInterfaceIP = Destination UNI IP address

For the data plane, the Junos Space software places a static MAC address in the

forwarding table of the remote endpoint, which it uses to verify correct packet transfer.

NOTE: Data plane validation of a VPLS service works for MX Series devices
running Junos Release 9.4 or later. If the service under audit contains anM
Series device or an N-PE device running Junos Release 9.2 or 9.3, the
functional audit does not complete successfully and generates amessage
stating that functional audit is not supported on that platform.
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The following table shows the commands for VPLS service type:

CategoryCLI CommandsXML CommandsDevice
Family

Service
Type

Routeshow vpls connection instance
instanceValue

<get-vpls-connection-information>
<instance>instanceValue</instance>
</get-vpls-connection-information>

M
Series

VPLS

MPLSshowmpls lsp ingress<get-mpls-lsp-information> <ingress/>
</get-mpls-lsp-information>

MPLSshowmpls lsp egress<get-mpls-lsp-information> <egress/>
</get-mpls-lsp-information>

MPLSshowmpls static-lsp ingress<get-mpls-static-lsp-information><ingress/>
</get-mpls-static-lsp-information>

Routeshow rsvp session<get-rsvp-session-information>
</get-rsvp-session-information>

Routeshow route table inet.3<get-route-information><table>inet.3</table>
</get-route-information>

UNIshow interface interfaceValue terse<get-interface-information>
<terse/><interface-name>interfaceValue</interface-name>
</get-interface-information>

UNIshow interface interfaceValue statistics<get-interface-information> <statistics/>
<interface-name>interfaceValue</interface-name>
</get-interface-information>

Routeshow route protocol bgp table
instanceValue.l2vpn.0

<get-route-information>
<table>instanceValue</table>
<protocol>bgp</protocol>
</get-route-information>

Where:

instanceValue= Name of the service

neighborIP= Address of the remote neighbor

interfaceValue= Name of the interface

The following table shows the commands for L3VPN service type:

CategoryCLI CommandsXML CommandsDevice
Family

Service
Type
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MPLSshowmpls lsp ingress<get-mpls-lsp-information>
<ingress/>
</get-mpls-lsp-information>

M
Series

L3VPN

MPLSshowmpls lsp egress<get-mpls-lsp-information>
<egress/>
</get-mpls-lsp-information>

Routeshow interfaces
instancevalue.initvalue terse

<get-interface-information>
<terse/>
<interface-name>interfaceValue</interface-name>
</get-interface-information>

Routeshow route forwarding-table vpn
instance

<get-forwarding-table-information>
<vpn>instance </vpn>
</get-forwarding-table-information>

Routeshow rsvp session<get-rsvp-session-information>
</get-rsvp-session-information>

UNIshow interfaces instance statistics<get-interface-information>
<statistics/>
<interface-name>instance</interface-name>
</get-interface-information>

MPLSshowmpls static-lsp<get-mpls-static-lsp-information>
<ingress/>
</get-mpls-static-lsp-information>

Routeshow ospf neighbor<get-ospf-neighbor-information>
</get-ospf-neighbor-information>

Routeshow route table bgp.l3vpn.0<get-route-information>
<table>bgp.l3vpn.0 </table>
<rd-prefix>destinationRDprefix</rd-prefix>
</get-route-information>

UNIshow lacp interfaces<get-lacp-interface-information>
<interface-name>
lagInterface
</interface-name>
</get-lacp-interface-information>

UNIshow interfaces mc-ae<get-mc-ae-interface-information>
</get-mc-ae-interface-information>

UNIshow iccp<get-inter-chassis-control-protocol-information>
</get-inter-chassis-control-protocol-information>

UNIShow vrrp interfaceName<get-vrrp-interface-information>
<interface-name>
lnterface
</interface-name>
</get-vrrp-interface-information>
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<get-bridge-instance-information>
<bridge-domain-name>
domainName
</bridge-domain-name>
</get-bridge-instance-information>

UNIShow bridge domain domainName

Where:

instanceValue= Name of the service

neighborIP= Address of the remote neighbor

interfaceValue= Name of the interface

Troubleshooting Point-to-Point Service

From the Troubleshooting tab you can check status of the interfaces, LDP sessions,

neighbor links, and endpoints of a point-to-point service. To select the status you want

to check, clickon thedevice fromthedevice list on the left, andselect the showcommand

from the Command list. This figure shows the routing table for the selected device in the

Point-to-Point service.

The following figure shows the interface status window. The status shows that the

interface is up.
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The following figure shows the status of the LDP session for the selected device.

The following figure shows the LDP neighbor status.
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Troubleshooting VPLS Service

From the Troubleshooting tab you can check status of the interfaces, LDP sessions,

neighbor links, connection instances, and endpoints of a VPLS service. To select the

status you want to check, click on the device from the device list on the left, and select

the show command from the Command list. This figure shows the routing table for the

selected device in the VPLS service.

Troubleshooting L3VPN Service

From the Troubleshooting tab you can check status of the interfaces, LDP sessions,

neighbor links, and endpoints of a L3VPN service. To select the status youwant to check,
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click on the device from the device list on the left, and select the show command from

theCommand list. This figure shows the routing table for theselecteddevice in theL3VPN

service.

Related
Documentation

Viewing Functional Audit Results on page 760•

• Performing a Configuration Audit on page 803

• Viewing Configuration Audit Results on page 757

Troubleshooting N-PE Devices Before Provisioning a Service

Youcanuse theTroubleshootoption inNetworkActivate tocheckPE router configurations

before youdeployanewserviceor troubleshootPE router configurations if youareunable

to deploy a new service.

To check the configuration on a PE router, follow these steps:

1. In the Network Activate task pane, select Prestage Devices >Manage Device Roles

TheManageDevice Roles page appears displaying all devices on the network that are

assigned the N-PE role

2. Select the device that you want to troubleshoot.

3. In the Actionsmenu, select Troubleshoot.

The Troubleshoot Devicewindow appears. The table here describes the show

commands that you can run to check the configuration on a N-PE device.

Table 37: Commands Available in the Troubleshoot DeviceWindow

Fields DisplayedDescriptionCommand
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Table 37: Commands Available in the Troubleshoot DeviceWindow (continued)

• Device name

• LSP State

• Destination Address

Display whether ingress LSP is up
and running.

showmpls lsp ingress

• Device name

• LSP State

• Destination Address

Display whether egress LSP is up
and running.

showmpls lsp egress

• Peer Address

• Peer State

Display summary information
about BGP and its neighbors to
determine if routes are received
from peers in the autonomous
system (AS). When a BGP session
is established, the peers exchange
update messages.

show bgp summary

• Interface Name

• Neighbor Address

• OSPF Neighbor State

Display information about OSPF
neighbors.

show ospf neighbor

• Peer Address

• Peer State

• Local AS

Display information about all BGP
peers.

show bgp neighbor

• Interface Name

• LDP Neighbor Count

Display standard status
informationaboutall LDP-enabled
interfaces for all routing instances.

show ldp interface

• Interface Name

• Neighbor Address

• Remaining Time—remaining hold time before the
neighbor expires, in seconds.

Displaystandard informationabout
LDP neighbors for all routing
instances.

show ldp neighbor

• Name

• LSP State

• Destination Address

For complete information about the fields displayed for
the show rsvp session command, see the Junos Software
Routing Protocols and Policies Command Reference.

Display information about
Resource Reservation Protocol
(RSVP) sessions.

show rsvp session

• Interface Name

• RSVP Status

• Static Bandwidth

• Available Bandwidth

• Total Reserved Bandwidth

Display the status of Resource
Reservation Protocol
(RSVP)-enabled interfaces and
packet statistics.

show rsvp interface
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Table 37: Commands Available in the Troubleshoot DeviceWindow (continued)

• Interface Name

• Adjacency State

• System Name

For complete information about the fields displayed for
theshow isisadjacencycommand, see the JunosSoftware
Routing Protocols and Policies Command Reference.

Display information about
intermediate
System-to-Intermediate System
(*IS-IS) neighbors.

show isis adjacency

4. Select on any show command to view device-specific configuration information.

NOTE: For additional information about a PE device configuration, you
canexplicitly runashowcommandwith theextensiveoption, for example,
showmpls lsp extensive.

Related
Documentation

Performing a Configuration Audit on page 803•

• Viewing Configuration Audit Results on page 757

• Performing a Functional Audit on page 805

• Viewing Functional Audit Results on page 760

• Canceling a Job

Modifying the Application Settings of Network Activate

In Network Management platform, you canmodify the configuration settings for the

Network Activate application.

Tomodify the configuration settings of Network Activate, perform the following steps:

1. From the NetworkManagement Platform task pane, select Administration >

Applications.

The Applications page that appears displays a list of the applications in the Network

Management platform.

2. Right-click Network Activate and selectModify Applications Settings.

TheModify Application Settings page that appears displays a list of the parameters

that can bemodified.

3. Click any parameter to modify it.

NOTE: You cannot modify the application settings if another user is
currently modifying them.

4. ClickModify to save the changes that youmade in the Network Activate application

or click Cancel to retain the original settings.

Copyright © 2015, Juniper Networks, Inc.816

Junos Space Cross Provisioning Platform



To understand the parameters of the Network Activate application settings, refer to

Table 38 on page 817.

Table 38: Parameters in Network Activate Application Settings

DESCRIPTIONFIELDS

DEPLOYMENT

Select this check box to deploy the configuration to the device.Deployconfiguration to thedevice

Select this check box to enable the service alarms. Enabling the service alarms causes a
GUI impact on theNetwork Activate application.When you select the check box anddeploy
the service, the interface goes down, resulting in the failure to update the fault status.When
you right-click Service and select View Service Alarms, the latter does not appear in the
results.

Enable service alarms

Select this check box to save the configuration of the device in XML format.Save configuration in XML format

Select this check box to display the configuration in set format.Show configuration in set format

Select this check box to push the configuration on all the network elements automatically,
making either one or all successful.

Usetwo-phasecommit for service
provisioning

Select this check box to use vlanmaps for flexible tagged services, instead of normalization.
VLANmapping refers to the swapping of the incoming VLAN ID to a new VLAN ID.

Use vlanmaps for flexible tagged
services

AUDIT

Select this check box to perform the functional audit automatically, after the service is
deployed successfully. By default, the functional audit is not checked. Extra time is taken
to complete both the functional audit and deployment.

Enable Functional Audit after
deployment

Specify the initial wait time to auto-schedule a functional audit job after deployment.

If the entered value is greater than 30minutes, it is reset to 30minutes. If the entered value
is less than 1 minute, the wait time is ignored.

The range is from 1 minute through 30minutes.

Functional AuditWaiting Time
after deployment

Select this check box tomake the functional audit ignore the data plane verification and to
consider only the control plane.

Perform Functional Audit on
Control plane only

UI

Select this check box to allow the templates to be changed during the servicemodification.Allow templatemodification for
service

Specify the bandwidth combo items count.

In Create P2P service order page, if the bandwidth range exceeds the bandwidth combo
items count, then the bandwidth input is taken in text field.

The default value is 100.

Bandwidth Combo Items Count
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Table 38: Parameters in Network Activate Application Settings (continued)

DESCRIPTIONFIELDS

MONITORING

Select this check box to performmonitoring if the functional audit fails.PerformMonitoring on Failed
Functional Audit

Select this check box to dump the configuration files.

Specify the timedelay to issue the remote procedure call (RPC) call for redundancy service.
Since there is no support for the fault management for redundancy service, it should not
update the fault statusasdown,when the interfacegoesdownas the servicewill be running
with the help of backup device. The RPC is issued to check the status of the service. If the
value of this time delay is 2 seconds and the interface goes down, it waits for 2 seconds to
check whether the service is up, with the help of the backup device and correspondingly
updates the fault status.

The default value is 2 seconds.

Pseudo-wire Redundancy
Transition TimeDelay

LOGGING

By default, the configuration files are not dumped into the log directory. This is enabled, if
there is a need to provide troubleshooting to Juniper Networks Technical Assistance Center
(JTAC).

DumpConfiguration Files

Select this check box to write the configlets and error response from the JUNOS devices
into the log directory..

DumpDeployment Data

Specify the default path of the log directory: /var/tmp/jbossLog Directory

ROUTE TARGET

Specify the least value in the preferred range of numbers, among which a certain number
is assigned for each BGP service. Route target allows you to distribute VPN routes to only
the routers that need them.When a route target value is enteredmanually, it should be
either of the following two formats: Autonomous System number format or IPv4 format.
For Autonomous System number format, the pattern is as-number:2-byte-number. For
example, target:100:200.

Range: TheAutonomousSystemnumber format number can be in the range from 1 through
65,535.

The IPv4 format is ip-address:2-byte-number. For example, target:10.1.1.1:2.

BeginIndex

Copyright © 2015, Juniper Networks, Inc.818

Junos Space Cross Provisioning Platform



Table 38: Parameters in Network Activate Application Settings (continued)

DESCRIPTIONFIELDS

Specify thegreatest value in thepreferred rangeofnumbers, amongwhichacertainnumber
is assigned for each BGP service. Route target allows you to distribute VPN routes to only
the routers that need them.When a route target value is enteredmanually, it should be
either of the following two formats: Autonomous System number format or IPv4 format.
For Autonomous System number format, the pattern is as-number:2-byte-number. For
example, target:100:200.

Range: TheAutonomousSystemnumber format number can be in the range from 1 through
65,535.

The IPv4 format is ip-address:2-byte-number. For example, target:10.1.1.1:2. The EndIndex
value should be lesser than themaximum assigned value.

EndIndex

VIRTUAL CIRCUIT ID

Specify the least value in the preferred range of numbers, among which a certain number
is assigned as the VirtualCircuitID to the new circuit created. This VCID can bemanually
chosen by the customer or auto-generated by the system. For example, if BeginIndex = 100
and EndIndex = 200, then the VCID would be somewhere between 100 and 200.

Minimum: 1

The value of BeginIndex should be less than or equal to EndIndex value.

The range is from 0 through 200000.

BeginIndex

Specify thegreatest value in thepreferred rangeofnumbers, amongwhichacertainnumber
is assigned as the VirtualCircuitID to the new circuit created. This VCID can bemanually
chosen by the customer or auto-generated by the system. For example, if BeginIndex = 100
and EndIndex = 200, then the VCID would be somewhere between 100 and 200.

Maximum: 2147483647.

The range is from 0 through 200000.

EndIndex

PERFORMANCEMONITORING

DataSetSize is the size of the performancemonitoring data set in days. This field indicates
the number of days of performancemonitoring data could be stored for display.

The default value is 2880.

DataSetSize

Select the check box to collect the performance data through scripts and opennms will
store the data in its database. If this check box is not selected, then performance data such
as one-way delay, two-way delay, and frame loss are collected through RPC and stored in
the application database.

Enable PerformanceMonitoring
through scripts

OSSCONFIGPARAMETERS

Specify the IP address of the primary server.Alcatel Primary Server IP

Specify the port number of the primary server.Alcatel Primary Server Port

819Copyright © 2015, Juniper Networks, Inc.

Chapter 21: Troubleshooting Devices and Services



Table 38: Parameters in Network Activate Application Settings (continued)

DESCRIPTIONFIELDS

Specify the IP address of the backup server.Backup Server IP

Specify the port number of the backup server.Backup Server Port

Specify the duration of HTTP connection before the time-out elapses.HTTP Connection Timeout

Specify the maximum number of simultaneous API requests permitted.MaximumAPI Requests

Specify the directory path of the OSS log directory.OSS Log Directory

Specify the OSS log filename.OSS Log Filename

Specify the user name for accessing the OSS server.OSSUser Name

Specify the hashed password for accessing the OSS server.OSSUser Password

Sets the daily time at which the CPP system synchronizes third-party devices, added or
deleted from the CPP system, with the OSS server.

Synchronize OSS Inventory daily
at given time

If the check box is enabled, the CPP system communicates with the primary OSS server.Use primary server

SERVICE DECOMMISSION

Specify thedevice synchronizationwaiting time.This is themaximumwait time tocomplete
thedevice synchronization.After this timeduration, irrespectiveof thedevice synchronization
status, the resources are released.

The default value is 60 seconds.

The range is from 30 seconds through 300 seconds.

Device SyncWait Time

Select this check box to wait for the device synchronization before resources are released.
To revert the decommissioning to the normal behavior, clear this check box.

Wait for Device Sync Before
Releasing Resource

Troubleshooting Services in Cross Provisioning Platform

The troubleshooting featureprovidesaneasyanduniqueway to troubleshoot the services

in Cross Provisioning Platform. You do not have to manually login to a device to check

the status of services in the Cross Provisioning Platform application, but you can do the

same using the functionality of operational scripts and CLI configlet scripts. You do have

the flexibility of writing your own scripts to view the results.

Only JuniperNetworksdevicesare supportedby this functionalityand this isnotapplicable

to the third-party devices.

The operational scripts and the CLI configlet scripts need to be created or imported to

the platform from the local machine before you start troubleshooting the services in the

Cross Provisioning Platform application.
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The following table lists the context inwhich theOPscripts andCLI configlets arewritten

for different types of services:

Table 39: OP Scripts and CLI Configlets Contexts for Different Service Types

ContextService Type

@CONTEXT = "/device/configuration/protocols/l2circuit/neighbor/interface"

Example :
/device[name="MX80-NGCE-1"]/configuration/protocols/l2circuit/neighbor[name="30.1.2.8"]/interface[name="ge-0/1/5.784"]

P2P

/*@CONTEXT = "/device/configuration/routing-instances/instance/interface" */

Example : /device[name="kochin"]/configuration/routing-instances/instance[name="SO62441630"
and instance-type="vrf"]/interface[name="ge-0/1/3.934"]

L3VPN

/*@CONTEXT = "/device/configuration/routing-instances/instance/interface" */

Example : /device[name="kochin"]/configuration/routing-instances/instance[name="SO62441630"
and instance-type="vpls"]/interface[name="ge-0/1/3.945"]

VPLS

/*@CONTEXT = "/device/configuration/protocols/connections/interface-switch/interface" */
Example:
/device[name="MX80-1"]/configuration/protocols/connections/interface-switch/interface[name="ge-1/0/0.1801"]

P2P or L3VPNwith L2E

/*@CONTEXT="/device/configuration/protocols/l2circuit/local-switching/interface/end-interface"
*/ Example
/device[name="MX80-1"]/configuration/protocols/l2circuit/local-switching/interface[name="ge-1/0/0.1801"]/end-interface[interface="ge-1/2/2.1881"]

P2P (Local switching)

/*@CONTEXT = "/device/configuration/protocols/bgp/group" */ Example
/device[name="MX80-1"]/configuration/protocols/bgp/group[type="external"]

NPS (Network peering)

The following are the options to troubleshoot the services in the Cross Provisioning

Platform application:

• Troubleshooting Cross Provisioning Platform Services Using Operational

Scripts on page 821

• Troubleshooting Cross Provisioning Platform Services Using CLI Configlet

Scripts on page 824

Troubleshooting Cross Provisioning Platform Services Using Operational Scripts

The operational scripts or the OP scripts are written to view the statistics of a service in

the Cross Provisioning Platform application. All the commands in the OP scripts are

user-defined. To view the contexts for writing OP scripts for different service types, refer

Table 39 on page 821.

To execute the OP scripts and view the status of any service:
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1. FromtheNetworkManagementPlatform taskpane, select ImagesandScripts>Scripts.

The Scripts page that appears displays a list of the existing scripts.

2. From the list of the scripts available in the SLAX format, right-click a script and click

Stage Scripts on Devices to push the script onto a device.

The Stage Scripts on Device(s) page that appears displays a list of the devices

associated with the script that you selected.

3. Select the Select DeviceManually option and select any number of devices to which

you want to push the script.

NOTE: The Enable Scripts on Devices check box is selected by default.

4. Click Stage to stage the script on all the devices that you selected.

The Stage Scripts Information dialog box confirms the successful staging of scripts

onto the selected devices along with the Job ID.

5. Click Job ID to view the status of the job on the JobManagement page.

You are redirected to the Scripts page.

6. From the Cross Provisioning Platform task pane, select CPP > Services.

The Services page that appears displays a list of the services in Cross Provisioning

Platform.

7. Double-click any service.

The CPP Services Details page that appears displays a list of the devices associated

with the service you selected.

You can view the advanced details of any device in the Advanced Details For Device

section by clicking the device from the list.

8. Right-click any device from the list and select the Execute OP Scripts option.
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9. Select an OP script on the Execute OP Scripts page.

10. Click the Value column to enter any additional parameter for the selected OP script,

besides the ones coded in the script.

NOTE: Theselectionofparameters isentirelydependentontheOPscripts.
If the OP scripts support parameters, then all the parameters are listed
andyouneed toenter thevalues.Parameterscanbeoptional, on thebasis
of the OP scripts.

11. Click Execute to execute the selected OP scripts with the newly added parameters,

if any.

A dialog box confirms the execution of the OP scripts along with the Job ID.

12. ClickOK.

You are redirected to the Execute OP Scripts page.

13. Click View Last Result to view the previous OP scripts execution results.

NOTE: This is an optional step.
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Troubleshooting Cross Provisioning Platform Services Using CLI Configlet Scripts

The CLI configlet scripts are written to set the user-defined configuration to a device in

which the cross provisioning platform services are installed. The commands in the CLI

configlet scripts are user-defined. To view the contexts for writing CLI configlet scripts

for different service types, refer Table 39 on page 821. For more information on applying

CLI configlet to devices, see Junos Space Network Management Platform User Guide.

Theprocess of providing troubleshooting support toCrossProvisioningPlatformservices

using the CLI configlet scripts is similar to that of the operational scripts. To execute the

CLI configlet script and set the configuration to any device:

1. From theCrossProvisioningPlatform task pane, selectCPP>Services to view theCPP

Service Details page.

The CPP Service Details page appears.

2. Right-click any device and select the Execute CLI Configlet option.

The Apply CLI Configlet page appears.

3. Select the Select DeviceManually option.

4. Select the devices onto which you need to apply the CLI configlet script.

5. Enter the required parameters in the Value column, besides the ones coded in the CLI

configlet script.

Copyright © 2015, Juniper Networks, Inc.824

Junos Space Cross Provisioning Platform



6. Click Next.

A preview of the CLI configlet script is shown.

7. Click Validate to validate the CLI configlet script.

The Validation Result page appears showing the status of the validation.

Related
Documentation

Importing Scripts Created for Cross Provisioning Platform on page 671•

• Adding Scripts Created for Cross Provisioning Platform on page 667

Downloading the Collection of Cross Provisioning Platform Log Files

You can download the collection of Cross Provisioning Platform log files with a single

link. The collection of log files is packaged into a single zip file that can be downloaded

and saved to your local machine. This feature proves beneficial especially, for

troubleshooting purposes.

To download the collection of log files related to Cross Provisioning Platform:

1. In the Cross Provisioning Platform task pane, select CPP > Log Collection.

The Log Collection dialog box that appears the Download button.

2. Click the Download button.

The Download Troubleshooting dialog box that appears shows a progress bar.

NOTE: In amultinode setup, all log files related to different nodes are
present in the same zip file. However, they are available within their
respective directories along with their specific node names.

3. After the download process is completed, you can save the zip file to your local

machine.
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The following files are packaged, zipped, and downloaded as part of the collection of

log files:

Location (by default)File/Folder

/var/tmp/jboss/debug/FLEX/*

The Application Settings determine the location of the debug folder. You can
navigate to ApplicationSettings by selecting NetworkManagement Platform >
Administration>Applications>CrossProvisioningPlatform>ModifyApplication
Settings > Logging > Log Directory.

All Deployment Files under FLEX directory

/var/tmp/jboss/oss.log

The logger setting specific to theOSS log determines the location of the debug
folder.

OSS log file (includes requests and responses
to and from the Service Aware Manager
server)

/var/log/jboss/servers/*Server logs

The Role-Based Access Control option is provided along with this feature to control

access to the collection of log files. For more information about Role-Based Access

Control, see the Junos Space Network Management Platform User Guide.
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